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About this topic collection

This PDF has been created from the WebSphere Message Broker Version 6.1
(December 2007) information center topics. Always refer to the WebSphere Message
Broker online information center to access the most current information. The
information center is periodically updated on the [document update]site and this
PDF and others that you can download from that Web site might not contain the
most current information.

The topic content included in the PDF does not include the "Related Links”
sections provided in the online topics. Links within the topic content itself are
included, but are active only if they link to another topic in the same PDF
collection. Links to topics outside this topic collection are also shown, but these
attempt to link to a PDF that is called after the topic identifier (for example,
ac12340_.pdf) and therefore fail. Use the online information to navigate freely
between topics.

Feedback: do not provide feedback on this PDF. Refer to the online information to
ensure that you have access to the most current information, and use the Feedback
link that appears at the end of each topic to report any errors or suggestions for
improvement. Using the Feedback link provides precise information about the
location of your comment.

The content of these topics is created for viewing online; you might find that the
formatting and presentation of some figures, tables, examples, and so on are not
optimized for the printed page. Text highlighting might also have a different
appearance.
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Developing message flows

A message flow is a sequence of processing steps that run in the broker when an
input message is received. The topics in this section describe how to create and
maintain message flows.

Concept topics:

* [“Message flows overview” on page 4|

* ["Message flow projects” on page 5|

* ["“Message flow nodes” on page 5|

* ["Message flow version and keywords” on page 46|

+ [“Message flow connections” on page 48|

[“Threading” on page 49|

* [“Execution model” on page 49|

* [“The message tree” on page 49|

+ [“Parsers” on page 69|

* |“Properties” on page 104|

* ["Message flow transactions” on page 107]

* |[“Broker schemas” on page 108|

* ["“Message flow accounting and statistics data” on page 110

. essage flow agegregation” on page
"M fl ion” 115

* [“Message collection” on page 117

* |“Converting data with message flows” on page 119

* [“User exits” on page 121|

Task topics:

+ |“Getting started with Quick Start wizards” on page 122

* |“Designing a message flow” on page 130|

+ ["Managing message flows” on page 205|

* [“Defining message flow content” on page 218§|

* |“Developing message flow applications using WebSphere Adapters” on page 235|
+ ["“Developing ESQL” on page 245|

[“Using XPath” on page 395

[‘Developing Java” on page 406|

+ [“Developing message mappings” on page 429

* |“Defining a promoted property” on page 507

[‘Collecting message flow accounting and statistics data” on page 515

+ [“Developing a user exit” on page 521|

+ |“Configuring aggregation flows” on page 523|

+ [“Configuring flows for message collection” on page 544|

* [“Configuring timeout flows” on page 554|

See also a section of topics that contain [reference| information about message flows.
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The workbench provides a set of toolbar icons that invoke wizards that you can
use to create any of the resources associated with message flows, for example,
message flow projects and ESQL files. Hover your mouse pointer over each icon to
see its function.

The workbench lets you open resource files with other editors. Use only the
workbench message flow editor to work with message flow files, because this
editor correctly validates all changes that you make to these files when you save
the message flow.

When you have completed developing your message flow, |[deploy it to a broker] to
start its execution.

Tip: You can debug your message flow using the [flow debugge

For a basic introduction to developing message flows, see the IBM Redbooks
publication [WebSphere Message Broker Basics}

Message flows overview

4 Message Flows

A message flow is a sequence of processing steps that run in the broker when an
input message is received.

You define a message flow in the workbench by including a number of message
flow nodes, each of which represents a set of actions that define a processing step.
The connections in the flow determine which processing steps are carried out, in
which order, and under which conditions. A message flow must include an input
node that provides the source of the messages that are processed. You must then
deploy the message flow to a broker for execution.

When you want to exchange messages between multiple applications, you might
find that the applications do not understand or expect messages in exactly the
same format. You might need to provide some processing between the sending and
receiving applications that ensures that both can continue to work unchanged, but
can exchange messages successfully.

You define the processing that is required when you create and configure a
message flow. The way that you do this determines what actions are performed on
a message when it is received, and the order in which the actions are completed.

You can create a message flow using the built-in nodes, nodes that you or a vendor
have created (user-defined nodes), or other message flows (known as subflows).
When you want to invoke a message flow to process messages, you deploy it to a
broker, where it is executed within an execution group.

The following topics describe the concepts that you need to understand to design,
create, and configure a message flow and its associated resources:
* [Projects

* [Nodes

+ [Version and keywords|

+ ["Message flow connections” on page 48|

* [“Execution model” on page 49|

* [“Threading” on page 49|

+ [“Parsers” on page 69

* [“Logical tree structure” on page 55|

s [“Properties” on page 104]



http://www.redbooks.ibm.com/abstracts/sg247137.html

* |Accounting and statistics datal

+ ["“Message flow transactions” on page 107]

+ [Aggoregation]

+ [“Converting data with message flows” on page 119
* ["Message flows, ESQL, and mappings” on page 45|
* [“Broker schemas” on page 10|

+ ["Message mappings overview” on page 430|

+ ["ESQL overview” on page 246|

For a basic introduction to developing message flows, see the IBM® Redbooks
publication [WebSphere Message Broker Basics|

Message flow projects

A message flow project is a specialized container in which you create and maintain
all the resources associated with one or more message flows.

You can create a message flow project to contain a single message flow and its
resources, or you can group together related message flows and resources in a
single message flow project to provide an organizational structure to your message
flow resources.

Message flow project resources are created as files, and are displayed within the
project in the Broker Development view. These resources define the content of the
message flow, and additional objects that contain detailed configuration
information, in the form of ESQL modules and mappings, for one or more nodes
within the message flow.

Import one of the following samples from the Samples Gallery (see related links) to
see how the sample’s message flow resources are stored in a Message Flow project.
If the sample has a message set, its message set resources are stored in a Message
Set project.

+ |Video Rental sample|
* |Comma Separated Value (CSV) sample|

You can view samples only when you use the information center that is integrated
with the Message Broker Toolkit.

Message flow nodes

A message flow node is a processing step in a message flow.

A message flow node receives a message, performs a set of actions against the
message, and optionally passes the message on to the next node in the message
flow. A message flow node can be a built-in node, a user-defined node, or a
subflow node.

A message flow node has a fixed number of input and output points known as
terminals. You can make connections between the terminals to define the routes
that a message can take through a message flow.

Built-in node
A built-in node is a message flow node that is supplied by WebSphere
Message Broker. The built-in nodes provide input and output,
manipulation and transformation, decision making, collating requests, and
error handling and reporting functions.

Developing message flows 5
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For information on all the built-in nodes supplied by WebSphere Message
Broker, see [“Built-in nodes” on page 762

User-defined node

A user-defined node is an extension to the broker that provides a new
message flow node in addition to those supplied with the product. It must
be written to the user-defined node API provided by WebSphere Message
Broker for both C and Java™ languages. The following sample
demonstrates how you can write your own nodes in both C and Java
languages.

+ [User-defined Extension sample|

You can view samples only when you use the information center that is
integrated with the Message Broker Toolkit.

Subflow

A subflow is a directed graph that is composed of message flow nodes and
connectors and is designed to be embedded in a message flow or in
another subflow. A subflow must include at least one Input node or one
Output node. A subflow can be executed by a broker only as part of the
message flow in which it is embedded, and therefore cannot be
independently deployed.

A message is received by an Input node and processed according to the
definition of the subflow. That might include being stored through a
Warehouse node, or delivered to another message target, for example
through an MQOutput node. If required, the message can be passed
through an Output node back to the main flow for further processing.

The subflow, when it is embedded in a main flow, is represented by a
subflow node, which has a unique icon. The icon is displayed with the
correct number of terminals to represent the Input and Output nodes that
you have included in the subflow definition.

The most common use of a subflow is to provide processing that is
required in many places within a message flow, or is to be shared between
several message flows. For example, you might code some error processing
in a subflow, or create a subflow to provide an audit trail (storing the
entire message and writing a trace entry).

The use of subflows is demonstrated in the following samples:

e [Error Handler sample
[E p

* |Coordinated Request Reply sample|

The Error Handler sample uses a subflow to trap information about errors
and store the information in a database. The Coordinated Request Reply
sample uses a subflow to encapsulate the storage of the ReplyToQ and
ReplyToQMgr values in a WebSphere MQ message so the processing logic
can be reused in other message flows and to allow alternative
implementations to be substituted. You can view samples only when you
use the information center that is integrated with the Message Broker
Toolkit.

A node does not always produce an output message for every output terminal:
often it produces one output for a single terminal based on the message received
or the result of the operation of the node. For example, a Filter node typically
sends a message on either the true terminal or the false terminal, but not both.
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If more than one terminal is connected, the node sends the output message on
each terminal, but sends on the next terminal only when the processing has
completed for the current terminal. Updates to a message are never propagated to
previously-executed nodes, only to nodes following the node in which the update
has been made. The order in which the message is propagated to the different
output terminals is determined by the broker; you cannot change this order. The
only exception to this rule is the FlowOrder node, in which the terminals indicate
the order in which the message is propagated to each.

The message flow can accept a new message for processing only when all paths
through the message flow (that is, all connected nodes from all output terminals)
have been completed.

The following sample uses Environment variables in the XML_Reservation sample
to store information that has been taken from a database table and to pass that
information to a node downstream in the message flow.

+ |Airline Reservations sample]

You can view samples only when you use the information center that is integrated
with the Message Broker Toolkit.

WebSphere Adapters nodes
Use WebSphere Adapters nodes to communicate with Enterprise Information
Systems (EIS).

SAP, Siebel, and PeopleSoft adapters are supported by the following nodes in
WebSphere Message Broker:

* SAPInput node

* SAPRequest node

¢ Siebellnput node

* SiebelRequest node

¢ PeopleSoftInput node

* PeopleSoftRequest node

The Twineballlnput and TwineballRequest nodes are sample nodes with their own
sample EIS. You can use the TwineBall nodes to see how adapters nodes work. You
cannot use the TwineBall nodes to connect to the external SAP, Siebel, and
PeopleSoft EIS systems.

The following terms are associated with WebSphere Adapters:

EIS Enterprise Information Systems. This term is used to describe systems such
as Enterprise Resource Planning (ERP) and Customer Relationship
Management (CRM).

EMD Enterprise Metadata Discovery. A specification that you can use to examine
an EIS and get details of business object data structures and APIs. An EMD
stores the definitions as XML schemas by default, and builds components
that can access the EIS. In WebSphere Message Broker you use the Adapter
Connection wizard to examine an EIS. EMD can also be known as ESD
(Enterprise Service Discovery) or ODA (Object Discovery Agent).

Business object
A set of attributes that represent a business entity (such as Employee), an
action on the data (such as a create or update operation), and instructions
for processing the data. Components of the business integration system use
business objects to exchange information and trigger actions.

Developing message flows 7
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The WebSphere Adapters support two modes of communication:

* Inbound: An event is generated on the EIS and the adapter responds to the
event by sending a message to the message broker. The WebSphere Adapters
input nodes support inbound communication. When the EIS sends an event to
the adapter, a message is propagated from the WebSphere Adapters input node.

* Outbound: The message broker uses the adapter to send a request to the EIS.
The WebSphere Adapters request nodes support outbound communication.
When a message is propagated to the WebSphere Adapters request node, the
adapter sends a request to the EIS.

The WebSphere Adapters nodes need an adapter component in order to access the
EIS. The input nodes need an inbound adapter component, which allows the EIS to
invoke the message flow when an event occurs. The request nodes need an
outbound adapter component, which is used by the message flow to invoke a
service in the EIS.

The WebSphere Adapters nodes also need a message set to ensure that the
WebSphere Message Broker messages that are propagated to and from the nodes
reflect the logical structure of the data in the EIS.

The following topics provide an overview of the WebSphere Adapters:
* [“Overview of WebSphere Adapter for SAP Software”]
* “Overview of WebSphere Adapter for Siebel Business Applications” on page 32|

e [“Overview of WebSphere Adapter for PeopleSoft Enterprise” on page 39
P p P P pag

Overview of WebSphere Adapter for SAP Software:

WebSphere® Adapter for SAP Software provides you with a way to create
integrated processes that include the exchange of information with an SAP server.

Using the adapter, an application component (the program or piece of code that
performs a specific business function) can send requests to the SAP server (for
example, to query a customer record in an SAP table or to update an order
document) or receive events from the server (for example, to be notified that a
customer record has been updated). The adapter creates a standard interface to the
applications and data on the SAP server, so that the application component does
not have to understand the lower-level details (the implementation of the
application or the data structures) on the SAP server.

WebSphere Adapter for SAP Software complies with the Java Connector
Architecture (JCA), which standardizes the way application components,
application servers, and enterprise information systems, such as an SAP server,
interact with each other.

The adapter, which you generate with the Adapter Connection wizard, uses a
standard interface and standard data objects. The adapter takes the standard data
object sent by the application component and calls the SAP function. The adapter
then returns a standard data object to the application component. The application
component does not have to deal directly with the SAP function; it is the SAP
adapter that calls the function and returns the results.

For example, the application component that needed the list of customers would
send a standard business object with the range of customer IDs to the SAP adapter.
The application component would receive, in return, the results (the list of
customers) in the form of a standard business object. The application component



would have no need to know how the function worked or how the data was
structured. The adapter would perform all the interactions with the actual SAP
function.

Similarly, the client application might want to know about a change to the data on
the SAP server (for example, a change to a particular customer). You can generate
an adapter component that listens for such events on the SAP server and notifies
client applications with the update. In this case, the interaction begins at the SAP
server.

For more information, see [“Technical overview of Adapter for SAP Software.”|

Technical overview of Adapter for SAP Software:

IBM WebSphere Adapter for SAP Software connects to SAP systems running on
SAP Web application servers. The adapter supports Advanced Event Processing
(AEP) and Application Link Enabling (ALE) for inbound processing, and the
Business Application Programming Interface (BAPI), AEP, ALE, and Query
Interface for SAP Systems (QISS) for outbound processing. You set up the adapter
to perform outbound and inbound processing by using the Adapter Connection
wizard to generate business objects based on the services it discovers on the SAP
server.

For outbound processing, the adapter client invokes the adapter operation to
create, update, or delete data on the SAP server or to retrieve data from the SAP
server.

For inbound processing, an event that occurs on the SAP server is sent from the
SAP server to the adapter. The ALE inbound interface to the adapter starts event
listeners that detect the events. Conversely, the advanced event processing interface
polls the SAP server for events. The adapter then delivers the event to an
endpoint, which is an application or other consumer of the event from the SAP
server.

You configure the adapter to perform outbound and inbound processing by using
the Adapter Connection wizard to create a message set that includes the interface
to the SAP application as well as business objects based on the functions or tables
it discovers on the SAP server.

Overview of the outbound processing interfaces

WebSphere Adapter for SAP Software provides multiple interfaces to the SAP
server for outbound processing.

* Through its BAPI interfaces, the adapter issues remote function calls (RFCs) to
RFC-enabled functions, such as a Business Application Programming Interface
(BAPI) function. These remote function calls create, update, or retrieve data on
an SAP server and return the results to the calling application.

— The BAPI interface works with individual BAPIs. For example, you might
want to check to see whether specific customer information exists in an SAP
database.

— The BAPI work unit interface works with ordered sets of BAPIs. For example,
you might want to update an employee record. To do so, you use three BAPIs
to lock the record (to prevent any other changes to the record), update the
record, and have the record approved.
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— The BAPI Result Set interface uses two BAPIs to select multiple rows of data
from an SAP database.

BAPI calls are useful when you need to perform data retrieval or manipulation
and a BAPI or RFC function that performs the task already exists.

* The Query interface for SAP Software retrieves data from specific SAP
application tables. It can return the data or check for the existence of the data.
You can use this type of interaction with SAP if you need to retrieve data from
an SAP table without using an RFC function or a BAPIL

* With the Application Link Enabling (ALE) interface, you exchange data using
SAP Intermediate Data structures (IDocs). For outbound processing, you send an
IDoc or a packet of IDocs to the SAP server.

The ALE interface, which is particularly useful for batch processing of IDocs,
provides asynchronous exchange. You can use the queued transactional (qQRFC)
protocol to send the IDocs to a queue on the SAP server. The gRFC protocol
ensures the order in which the IDocs are received. It is often used for system
replications or system-to-system transfers.

* With the advanced event processing interface, you send data to the SAP server.
The data is then processed by an ABAP handler on the SAP server.

Overview of the inbound processing interfaces

WebSphere Adapter for SAP Software provides two interfaces to the SAP server for
inbound processing.

* With the ALE inbound processing interface, the adapter listens for events and
receives one or more IDocs from the SAP server. As with ALE outbound
processing, ALE inbound processing provides asynchronous exchange.

You can use the qRFC interface to receive the IDocs from a queue on the SAP
server, which ensures the order in which the IDocs are received.

The adapter uses a data source to persist the event data, and event recovery is
provided to track and recover events in case of abrupt termination.

* The advanced event processing interface polls the SAP server for events. It
discovers events waiting to be processed. It then processes the events and sends
them to the endpoint.

How the adapter interacts with the SAP server

The adapter uses the SAP Java Connector (SAP JCo) API to communicate with SAP
applications. An application sends a request to the adapter, which uses the SAP
JCo API to convert the request into a BAPI function call. The SAP system processes
the request and sends the results to the adapter. The adapter sends the results in a
response message to the calling application.

For more information, see the following topics.

* [“The Adapter Connection wizard (SAP)”|

* |“The BAPI interface” on page 11|

* ["The ALE interface” on page 14|

* |“Query interface for SAP Software” on page 25|

* |“The advanced event processing interface” on page 27|

The Adapter Connection wizard (SAP):

Use the Adapter Connection wizard to configure your adapter. The Adapter
Connection wizard establishes a connection to the SAP server, discovers services



(based on search criteria you provide), and generates business objects and
interfaces based on the services discovered.

Using WebSphere Message Broker, you establish a connection to the SAP server to
browse the metadata repository on the SAP server. The SAP metadata repository,
which is a database of the SAP data, provides a consistent and reliable means of
access to that data.

You specify connection information (such as the user name and password needed
to access the server), and you specify the interface you want to use (for example,
BAPI). The service metadata associated with that interface is displayed. You can
then provide search criteria and select the information (for example, you can list all
BAPIs that relate to "CUSTOMER" by using the search filter with
"BAPI_CUSTOMER*", then select one or more BAPISs).

The result of running the Adapter Connection wizard is an adapter connection
project and a message set project that contain the interfaces and business objects
along with the adapter.

The BAPI interface:

The BAPI interface of the WebSphere Adapter for SAP Software provides a way for
client applications to call BAPIs and other RFC-enabled functions on the SAP
server.

The adapter models SAP BAPI function calls as business objects. These function
calls create, delete, update, or retrieve data on an SAP system. You can work with
individual BAPI functions (simple BAPIs), BAPI units of work (ordered sets of
BAPI functions), or BAPI result sets (which return a set of data).

Simple BAPIs

A simple BAPI performs a single operation, such as retrieving a list of customers.
The adapter supports simple BAPI calls by representing each with a single
business object schema.

BAPI units of work

A BAPI unit of work consists of a set of BAPIs that are processed in sequence to
complete a task. For example, to update an employee record in the SAP system,
the record needs to be locked before being updated. This is accomplished by
calling three BAPIs, in sequence, in the same unit of work. The following three
BAPIs illustrate the kind of sequence that forms such a unit of work:

* BAPI_ADDRESSEMP_REQUEST
* BAPI_ADDRESSEMP_CHANGE
* BAPI_ADDRESSEMP_APPROVE

The first BAPI locks the employee record, the second updates the record, and the
third approves the update. The advantage of using a BAPI unit of work is that the
client application can request the employee record change with a single call, even
though the unit of work consists of three separate functions. In addition, if SAP
requires that the BAPIs be processed in a specific sequence for the business flow to
complete correctly, the unit of work supports this sequence.
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You can manage the units of work using the capabilities of the application server,
or you can manage them locally. If the BAPI unit of work is managed by a local
transaction, use the CWYAP_SAPAdapter_Tx.rar file. Make sure you issue a
COMMIT call when the unit of work is complete, and issue a ROLLBACK call if
you need to undo the effects of a partially completed unit of work.

BAPI result sets

BAPI result sets use the GetList and GetDetail functions to retrieve an array of
data from the SAP server. The information returned from the GetList function is
used as input to the GetDetail function.

For example, if you want to retrieve information on a set of customers, you use
BAPI_CUSTOMER_GETLIST, which acts as the query BAPI, and
BAPI_CUSTOMER_GETDETAIL, which acts as the result BAPI. The BAPIs perform
the following steps:

1. The BAPI_CUSTOMER_GETLIST call returns a list of keys (for example,
CustomerNumber).

2. Each key is mapped dynamically to the business object for
BAPI_CUSTOMER_GETDETAIL.

3. BAPI_CUSTOMER_GETDETAIL is processed multiple times, so that an array of
customer information is returned.

You use the Adapter Connection wizard to build the key relationship between the
two BAPIs.

For more information, see the following topics.

+ “Outbound processing”|

» |“Business objects for the BAPI interface”|

Outbound processing:

You use the BAPI interface for outbound processing, in which a broker sends a
request to the SAP server. The SAP server processes the request and returns the
response to the broker. Outbound processing can be used with simple BAPI
functions, BAPI units of work, or BAPI result sets.

The following list describes the sequence of processing actions that result from an
outbound request using the BAPI interface.

Note: The broker that makes the BAPI call uses the interface information that was
generated by the Adapter Connection wizard.

1. The adapter receives a request from a broker. The request includes a BAPI
business object.

2. The adapter converts the BAPI business object to an SAP JCo function call.

3. The adapter uses the Remote Function Call (RFC) interface to process the BAPI
or RFC function call in the SAP application.

4. After passing the data to the SAP server, the adapter handles the response from
SAP and converts it back into the business object format required by the broker.

5. The adapter then sends the response back to the broker.

Business objects for the BAPI interface:



A business object is a structure that consists of data, the action to be performed on
the data, and additional instructions for processing the data.

The adapter uses business objects to send data to or obtain data from the SAP
server. A BAPI business object, which is generated by the Adapter Connection
wizard, is modeled on the BAPI function interface in SAP.

The adapter uses the BAPI metadata that is generated by the Adapter Connection
wizard to construct the business objects. This metadata contains BAPI-related
information such as the operation of the business object, import parameters, export
parameters, table parameters, transaction information, and dependent or grouped
BAPIs.

How business objects are created

You create business objects by using the Adapter Connection wizard. The wizard
connects to the application, discovers data structures in the application, and
generates business objects to represent them. It also generates other artifacts
needed by the adapter, such as the interface information that indicates the input
and output parameters.

Business object structure

The structure of a BAPI business object depends on the interface type (simple
BAPI, BAPI unit of work, or BAPI result set).

For more information, see the following topics.

» |“Business object structure for a simple BAPI"]

+ |“Business object structure for a nested BAPI”|

* |“Business object structure for a BAPI transaction” on page 14|

+ [“Business object structure for a BAPI result set” on page 14

Business object structure for a simple BAPI:

A business object for a simple BAPI call reflects a BAPI method or function call in
SAP. Each business object property maps to a BAPI parameter. The metadata of
each business-object property indicates the corresponding BAPI parameter. The
operation metadata determines the correct BAPI to call.

For a simple BAPI that performs Create, UpdateWithDelete, Retrieve, and Delete
operations, each operation is represented by a business object, with the business
objects being grouped together within a wrapper.

Note: The object definition can be associated with multiple operations, but only
one operation is processed at run time. Each business object is a child of the
wrapper and represents a complex property of the wrapper object.

The BAPI business objects are children of the business object wrapper, and,
depending on the operation to be performed, only one child object in this wrapper
needs to be populated at run time in order to process the simple BAPI call. Only
one BAPI, the one that is associated with the operation to be performed, is called
at a time.

Business object structure for a nested BAPI:
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A nested BAPI business object contains structure parameters that can contain one
or more other structures as components.

The SapLinesDescr business object contains simple parameters and a business
object.

Business object structure for a BAPI transaction:

A business object that represents a BAPI unit of work (also known as a BAPI
transaction) is actually a wrapper object that contains multiple child BAPI objects.
Each child BAPI object within the wrapper object represents a simple BAPL

The adapter supports a BAPI unit of work using a top-level wrapper business
object that consists of multiple child BAPIs, each one representing a simple BAPI
in the sequence. The BAPI wrapper object represents the complete unit of work,
while the child BAPI objects contained within the BAPI wrapper object represent
the individual operations that make up the unit of work.

Business object structure for a BAPI result set:

The top-level business object for a result set is a wrapper that contains a GetDetail
business object. The GetDetail business object contains the results of a query for
SAP data. The GetDetail business object also contains, as a child object, the query
business object. The query business object represents a GetList BAPIL. These two
BAPIs work together to retrieve information from the SAP server.

The ALE interface:

The SAP Application Link Enabling (ALE) interface enables business process
integration and asynchronous data communication between two or more SAP
systems or between SAP and external systems. Application systems are loosely
coupled in an ALE integrated system and the data is exchanged asynchronously.

Intermediate Documents (IDocs) are containers for exchanging data in a predefined
(structured ASCII) format across system boundaries. The IDoc type indicates the
SAP format that is to be used to transfer the data. An IDoc type can transfer
several message types (the logical messages that correspond to different business
processes). IDocs can be used for outbound and inbound processing.

The adapter supports outbound and inbound processing by enabling the exchange
of data in the form of business objects. The data exchange includes the following
activities:

* SAP IDoc exchange for inbound and outbound events.
— The IDocs can be exchanged either as individual documents or in packets.

— From the SAP application, IDocs can be sent as parsed or unparsed
documents. Unparsed IDocs are passed through, with no conversion of the
data.

* Transaction ID (TID) management.

The adapter uses tRFC (transactional RFC) to guarantee delivery and to ensure
that each IDoc is exchanged only once with SAP. The tRFC component stores the
called RFC function together with the corresponding data in the database of the
SAP system, including a unique transaction identifier (TID)

* Queueing of IDocs.



The adapter uses qRFC (queued transactional RFC) to ensure that IDocs are
delivered in sequence to a queue on the SAP server or are received in sequence
from the SAP server.

For inbound processing, the adapter is able to listen to and deliver events from
multiple SAP systems.

The adapter is also able to deliver events to multiple endpoints. You enable
delivery to multiple endpoints by configuring multiple activation specifications.

* If the endpoints subscribe to the same events from the same SAP system, all
properties in the individual activation specifications must be identical.

* Endpoints that subscribe to different activation specifications receive events that
match the criteria for the activation specification.

Define a separate activation specification for each endpoint to which events need
to be delivered, except when the adapter delivers events only to those endpoints
that are active.

Note: If an endpoint is not active when an event is triggered, the adapter skips the
endpoint and delivers the event only to the active endpoints. This could
happen if the endpoint is deactivated after the adapter is started. You cannot
resubmit events to these inactive endpoints at a later point.

To use the ALE inbound interface, you must make sure that your SAP server is
properly configured (for example, you must set up a partner profile and register a

program ID to listen for events).

For more information, see the following topics.

+ [“Outbound processing”|

* [“Inbound processing for the ALE interface” on page 16|

* [“ALE business objects” on page 22|

* [“Passthrough support for IDocs, and MQSeries link for R/3 link migration” onl|

page 24|

Outbound processing:

The adapter supports outbound processing (from the adapter to the SAP server)
for the ALE interface. ALE uses IDocs for data exchange, and the adapter uses
business objects to represent the IDocs.

The following list describes the sequence of processing actions that result from an
outbound request using the ALE interface.

Note: The client application that makes the request uses the interface information
that was generated by the Adapter Connection wizard.

1. The adapter receives a request, which includes an IDoc business object, from a
client application.

2. The adapter uses the IDoc business object to populate the appropriate
RFC-enabled function call used by the ALE interface.

3. The adapter establishes an RFC connection to the ALE interface and passes the
IDoc data to the SAP system. If you are using the gRFC protocol, the adapter
passes the IDoc data in the order specified in the business graph to the
specified queue on the SAP server.

4. After passing the data to SAP, the adapter performs one of the following steps:
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e If the call is not managed by a J2C local transaction, the adapter releases the
connection to SAP and does not return any data to the caller. When no
exceptions are raised, the outbound transaction is considered successful. You
can verify whether the data is incorporated into the SAP application by
inspecting the IDocs that have been generated in SAP.

e If the call is managed by a J2C local transaction, the adapter returns the
transaction ID.

The adapter uses the tRFC protocol to support J2C local transactions.
Inbound processing for the ALE interface:

The adapter supports inbound processing (from the SAP server to the adapter) for
the ALE interface. The adapter can process events as individual IDocs or as an
IDoc packet. Additionally, the IDoc can be sent in a parsed format or it can be sent
directly (without conversion).

During configuration, you indicate whether the IDocs are sent as a packet and
whether they are sent parsed or unparsed. You make these selections in the
Adapter Connection wizard.

The following list describes the sequence of processing actions that result from an

inbound request using the ALE interface.

1. The adapter starts event listeners to the SAP server.

2. Whenever an event occurs in SAP, the event is sent to the adapter by way of
the event listeners.

3. The adapter converts the event into a business object before sending it to the
endpoint.

The adapter uses the event recovery mechanism to track and recover events in case
of abrupt termination. The event recovery mechanism uses a data source for

persisting the event state.

For more information, see the following topics.

* |“Event error handling”]|

+ [“Event recovery” on page 17

* |“Event processing for parsed IDoc packets” on page 18|

+ [“Event processing for unparsed IDocs” on page 20|

* [“IDoc status updates” on page 21|

Event error handling:

WebSphere Adapter for SAP Software provides error handling for inbound ALE
events by logging the errors and attempting to restart the event listener.

When the adapter detects an error condition, it performs the following actions:
1. The adapter logs the error information in the event log or trace file.

Log and trace files are in the /profiles/profile_name/logs/server_name path of
the folder in which WebSphere Message Broker is installed.

2. The adapter attempts to restart the existing event listeners.

The adapter uses the activation specification values for RetryLimit and
RetryInterval.

* If the SAP application is not active, the adapter attempts to restart the
listeners for the number of times configured in the RetryLimit property.
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¢ The adapter waits for the time specified in the RetryInterval parameter
before attempting to restart the event listeners.

3. If the attempt to restart the event listeners fails, the adapter performs the
following actions:

* The adapter logs the error condition in the event log or trace file.
* The adapter cleans up the existing ALE event listeners.
* The adapter starts new event listeners.

Note: The adapter uses the values of the RetryLimit and RetryInterval
properties when starting the new event listeners.

4. If all the retry attempts fail, the adapter logs the relevant message and CEI
events and stops trying to recover the ALE event listener.

Note: You must restart the adapter or SCA application in this case.
Event recovery:
The adapter supports event recovery for ALE inbound processing in case of abrupt
termination. During event processing, the adapter persists the event state in an
event recovery table that resides on the data source. You must set up this data
source before you can create the event recovery table.

Data source

ALE inbound scenarios require a JDBC data source to be configured. The data
source is used for event tracking and recovery.

You configure the data source in the administrative console. You select a JDBC
provider (for example, Derby) and then create a new data source.

Event recovery table
The EP_CreateTable configuration property in the activation specification
properties determines whether the event recovery table is created automatically.

The default value of this property is True (create the table automatically).

To create the table manually, use the information provided in the following table.

Table 1. Event recovery table fields

Table field name Type Description

EVNTID VARCHAR(255) | Transaction ID for the tRFC (Transactional
Remote Function Call) protocol.

The tRFC protocol significantly improves the
reliability of the data transfer, but it does not
ensure that the order of ALE transactions
specified in the application is observed. Event
ordering is also affected by the number of event
listeners. However, at some point all ALE
transactions are transferred.
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Table 1. Event recovery table fields (continued)

Table field name Type Description

EVNTSTAT INTEGER Event processing status. Possible values are:
* 0 (Created)

* 1 (Executed)

* 3 (In Progress)

e -1 (Rollback)

XID VARCHAR(255) | An XA resource keeps track of transaction IDs
(XIDs) in the event recovery table. The adapter
queries and updates that XID field.

Note: The XA resource is used to enable
assured once delivery. Make sure the activation
specification property Assured Once Delivery is

set to true.
BQTOTAL INTEGER Total number of IDocs in the packet.
BQPROC INTEGER Sequence number of the IDoc in the packet that
the adapter is currently processing.
EVNTDATA VARCHAR(255) | Not used.

You must configure a separate event recovery table for each endpoint. although
you can use the same data source (for example, Derby) to hold all the event
recovery tables.

Event processing for parsed IDoc packets:

An inbound event can contain a single IDoc or multiple IDocs, with each IDoc
corresponding to a single business object. The multiple IDocs are sent by the SAP
server to the adapter in the form of an IDoc packet. You can specify, during
adapter configuration, whether the packet can be split into individual IDocs or
whether it must be sent as one object (non-split).

Event processing begins when the SAP server sends a transaction ID to the
adapter. The following sequence occurs.

1. The adapter checks the status of the event and takes one of the following
actions:

* If this is a new event, the adapter stores an EVNTID (which corresponds to
the transaction ID) along with a status of 0 (Created) in the event recovery
table.

e If the event status is -1 (Rollback), the adapter updates the status to 0
(Created).

¢ If the event status is 1 (Executed), the adapter returns an indication of
success to the SAP system.

2. The SAP system sends the IDoc to the adapter, where it is stored in memory as
an IDoc cursor. A cursor is a pointer to the top-level object in the data
structure.

* For a single IDoc, the adapter converts the IDoc to a record object and sends
it to the endpoint. When the endpoint begins to access the record, the
adapter parses and converts it to a business object and returns it to the
endpoint.



For split packets, the adapter stores the packet as an IDoc cursor. Each time a
next call is received from the endpoint, the cursor pointer moves to the next
IDoc cursor, and the corresponding IDoc business object is returned to the
endpoint.

For non-split packets, the adapter stores the packet as an IDoc cursor. When
the first next call is received from the endpoint, the cursor pointer reads and
converts all the IDocs into an array and sends that array to the endpoint.

Note: For single IDocs and non-split IDoc packets, the adapter can deliver
objects to endpoints that support transactions as well as to endpoints
that do not support transactions.

— For endpoints that support transactions, the adapter delivers the
object as part of a unique XA transaction. When the endpoint
processes the event and the transaction is committed, the status of
the event is updated to 1 (Executed).

Note: The endpoint must be configured to support XA transactions.

— For endpoints that do not support transactions, the adapter delivers
the object to the endpoint and updates the status of the event to 1
(Executed). The adapter delivers the business object without the
quality of service (QOS) that guarantees once only delivery.

3. For split packets only, the adapter performs the following tasks:
a. The adapter updates the BQTOTAL column (or table field) in the event

C.

f.

recovery table to the number of IDocs in the packet. This number is used
for audit and recovery purposes.

The adapter sends the business objects to the message endpoint, one after
the other, and updates the BQPROC property to the sequence number of the
IDoc it is working on. The adapter delivers the objects to the appropriate
endpoint as part of a unique XA transaction (a two-phase commit
transaction) controlled by the application server.

When the endpoint receives the event and the transaction is committed, the
adapter increments the number in the BQPROC property.

Note: The message endpoint must be configured to support XA

transactions.

If the adapter encounters an error while processing a split IDoc packet, it

can behave in one of two ways, depending on the IgnorelDocPacketErrors

configuration property:

* If the IgnorelDocPacketErrors property is set to false, the adapter stops
processing any additional IDocs in the packet and reports errors to the
SAP system.

* If the IgnorelDocPacketErrors property is set to true, the adapter logs an
error and continues processing the rest of the IDocs in the packet. The
status of the transaction is marked 3 (InProgress). In this case, the adapter
log shows the IDoc numbers that failed, and you must resubmit those
individual IDocs separately. You must also manually maintain these
records in the event recovery table.

This property is not used for single IDocs and for non-split IDoc packets.
The SAP system sends a COMMIT call to the adapter.

After the adapter delivers all the business objects in the IDoc packet to the
message endpoint, it updates the event status to 1 (Executed).

In case of abrupt interruptions during IDoc packet processing, the adapter
resumes processing the IDocs from the current sequence number. The
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adapter continues updating the BQPROC property, even if
IgnorelDocPacketErrors is set to true. The adapter continues the processing
in case you terminate the adapter manually while the adapter is processing
an IDoc packet.

4. If an exception occurs either while the adapter is processing the event or if the
endpoint generates an exception, the event status is updated to -1 (Rollback).

5. If no exception occurs, the SAP server sends a CONFIRM call to the adapter.

6. The adapter deletes the records with a 1 (Executed) status and logs a common
event infrastructure (CEI) event that can be used for tracking and auditing
purposes.

Event processing for unparsed IDocs:

Unparsed IDocs are passed through, with no conversion of the data (that is, the
adapter does not parse the data part of the IDoc). The direct exchange of IDocs in
the adapter enables high-performance, asynchronous interaction with SAP, because
the parsing and serializing of the IDoc occurs outside the adapter. The consumer of
the IDoc parses the IDoc.

The adapter processes the data based on whether the packet IDoc is split or
non-split and whether the data needs to be parsed.

* The adapter can process packet IDocs as a packet or as individual IDocs. When
an IDoc is received by the adapter from SAP as a packet IDoc, it is either split
and processed as individual IDocs, or it is processed as a packet. The value of
the SplitIDocPacket metadata at the business-object level determines how the
IDoc is processed.

In the case of split IDocs, the wrapper contains only a single, unparsed IDoc
object.

* The Type metadata specifies whether the data should be parsed. For unparsed

IDocs, this value is UNPARSEDIDOC; for parsed IDocs, the value is IDOC. This value
is set by the Adapter Connection wizard.

Unparsed data format

In the fixed-width format of an unparsed IDoc, the segment data of the IDoc is set
in the IDocData field of the business object. It is a byte array of fixed-length data.

The entire segment length might not be used. The adapter pads spaces to the fields
that have data; the rest of the fields are ignored, and an end of segment is set. The
end of segment is denoted by null.

The following figure shows a segment with fields demarcated by the “ I’
reference.

symbol for

F, FOB WAT REG

Figure 1. Example of a segment before processing

ITA | |

When the adapter processes this segment into unparsed data, it takes into account
only those fields that have data in them. It maintains the field width for each
segment field. When it finds the last field with data, it appends a null to mark the
end of segment.
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Figure 2. Example of a segment after processing

The next segment data processed as unparsed data would be appended after the
null.

Limitations

The unparsed event feature introduces certain limitations on the enterprise
application for a particular IDoc type.

* The enterprise application supports either parsed or unparsed business-object
format for a given IDoc type or message type.

* For a given IDoc type, if you select unparsed business-object format for inbound,
you cannot have inbound and outbound interfaces in the same EAR file, because
outbound is based on parsed business objects.

IDoc status updates:

To monitor IDoc processing, you can configure the adapter to update the IDoc
status.

When the adapter configuration property ALEUpdateStatus is set to true
(indicating that an audit trail is required for all message types), the adapter
updates the IDoc status of ALE business objects that are retrieved from the SAP
server. After the event is sent to the message endpoint, the adapter updates the
status of the IDoc in SAP to indicate whether the processing succeeded or failed.
Monitoring of IDocs applies only to inbound processing (when the IDoc is sent
from the SAP server to the adapter).

The adapter updates a status IDoc (ALEAUD) and sends it to the SAP server.

An IDoc that is not successfully sent to the endpoint is considered a failure, and
the IDoc status is updated by the adapter. Similarly, an IDoc that reaches the
endpoint is considered successfully processed, and the status of the IDoc is
updated.

The status codes and their associated text are configurable properties of the
adapter, as specified in the activation specification properties and shown in the
following list:

* ALESuccessCode
* ALEFailureCode
* ALESuccessText
* ALEFailureText

Perform the following tasks to ensure that the adapter updates the standard SAP
status code after it retrieves an IDoc:

* Set the AleUpdateStatus configuration property to true and set values for the
AleSuccessCode and AleFailureCode configuration properties.

* Configure the inbound parameters of the partner profile of the logical system in
SAP to receive the ALEAUD message type. Set the following properties to the
specified values:
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Table 2. Inbound properties of the logical system partner profile

SAP property Value

Basic Type ALEAUDO1

Logical Message Type ALEAUD

Function module IDOC_INPUT_ALEAUD
Process Code AUD1

ALE business objects:

A business object is a structure that consists of data, the action to be performed on
the data, and additional instructions for processing the data.

WebSphere Adapter for SAP Software depends on the IDoc metadata that is
generated by the Adapter Connection wizard to construct business objects. This
metadata contains ALE-related information such as segment information, field
names, and an indication of whether the business object handles a single IDoc or
an IDoc packet.

How data is represented in business objects

The business object represents an IDoc.

How business objects are created

You create business objects by using the Adapter Connection wizard. The wizard
connects to the application, discovers data structures in the application, and
generates business objects to represent them. It also generates other resources that
are needed by the adapter, such as the interface information that indicates the

input and output parameters.

For more information, see the following topics.

* |“ALE business object structure”|

* [“Transaction ID support” on page 23|

 ["Dummy keys” on page 23|

ALE business object structure:

During ALE processing, the adapter exchanges business objects with the SAP
application. The business object represents an individual IDoc or an IDoc packet.
This business object is a top-level wrapper object that contains one or more IDoc
child objects, each one corresponding to a single IDoc. The same business object
format is used for inbound and outbound processing.

The wrapper business object contains a transaction ID, a queue name, and one or
more IDoc business objects. The transaction ID (SAPTransactionID) is used to
ensure once-only delivery of business objects, and the queue name
(qQRFCQueueName) specifies the name of the queue on the SAP server to which
the IDocs should be delivered. If you are not using transaction IDs or queues,
these properties are blank.

For individual IDocs, the wrapper business object contains only one instance of an
IDoc business object. For IDoc packets, the wrapper business object contains
multiple instances of an IDoc business object.



The IDoc business object contains the following objects:

* The control record business object contains the metadata required by the adapter
to process the business object.

¢ The data record business object contains the actual business object data to be
processed by the SAP application and the metadata required for the adapter to
convert it to an IDoc structure for the RFC call.

Transaction ID support:

An SAP transaction ID is contained within the ALE wrapper business object. You
can use transaction ID support to ensure once-only delivery of ALE objects.

The most common reason for using transaction ID support is to ensure once and
only once delivery of data. To make sure of this feature, select the transaction RAR
file (CWYAP_SAPAdapter_Tx.rar) when you configure the adapter..

Note: The SAP transaction ID property is always generated by the Adapter
Connection wizard; however, it is supported only for outbound operations
when the CWYAP_SAPAdapter_Tx.rar version of the adapter is used.

The client application must determine how to store the SAP transaction ID and
how to relate the SAP transaction ID to the data being sent to the adapter. When
the events are successful, the client application should not resubmit the event
associated with this TID again to prevent the processing of duplicate events.

* If the client application does not send an SAP transaction ID with the business
object, the adapter returns one after executing the transaction.

* If the client application has an SAP transaction ID, it needs to populate the SAP
transaction ID property with that value before executing the transaction.

The SAP transaction ID can be used for cross-referencing with a global unique ID
that is created for an outbound event. The global unique ID is something you can
create for managing integration scenarios.

Dummy keys:

You use a dummy key to map a key field from an IDoc control or data record
business object to the dummyKey property of the top-level business object. The
dummyKey property is used for flow control and business process logic. You can
use the dummyKey when you need the top-level business object to participate in a
relationship.

The adapter supports dummy key mapping in the following manner:

* You must configure the property-level application-specific information of the
dummyKey property as the path to the property from which the value should
be set. For example: dataRecord /SapOrders05e2edk01005/idocDocumentNumber

* Multiple cardinality objects are not supported. If the path contains a multiple
cardinality object, the value is ignored and the default first index is used.

e If the application-specific information is incorrect or if the mapped property
value is empty, the adapter causes the event to fail. This is also the case when
the application-specific information is configured to set an object type value as
the dummyKey.

Note: The dummyKey property can contain only a simple type.
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Dummy key processing is not supported for unparsed IDocs.
Passthrough support for IDocs, and MQSeries link for R/3 link migration:

Both the inbound and outbound SAP adapters support a passthrough mode for
IDocs.

In this mode, the bit stream for the IDoc is provided without any form of parsing.
The bit stream can then be used directly in a message flow, and parsed by other
parsers, or sent unchanged over transports.

Use the Adapter Connection wizard to select passthrough support: on the
Configure settings for adapter pane, select ALE pass-through IDoc as the interface

type.

A business object is created that contains one field, which is the bit stream of the
IDoc. You can transform this business object in a Compute node to an MQSeries®
link for R/3 format message, as shown in the following example.

DECLARE ns NAMESPACE
"http://www.ibm.com/xmIns/prod/websphere/j2ca/sap/sapmatmas05';

CREATE COMPUTE MODULE test4 Compute
CREATE FUNCTION Main() RETURNS BOOLEAN
BEGIN
CALL CopyMessageHeaders();
-- CALL CopyEntireMessage();
set QutputRoot.MQSAPH.SystemNumber = '00';
set QutputRoot.BLOB.BLOB =
InputRoot.DataObject.ns:SapMatmas05.IDocStreamData;
RETURN TRUE;
END;

CREATE PROCEDURE CopyMessageHeaders() BEGIN
DECLARE I INTEGER 1;
DECLARE J INTEGER;
SET J = CARDINALITY(InputRoot.*[]);
WHILE I < J DO
SET OQutputRoot.*[I] = InputRoot.*[I];

SETI =1+1;
END WHILE;
END;

CREATE PROCEDURE CopyEntireMessage() BEGIN
SET OQutputRoot = InputRoot;

END;

END MODULE;

You can also create a request business object from an MQSeries link for R/3
message, as shown in the following example.

CREATE COMPUTE MODULE test4_Compute

CREATE FUNCTION Main() RETURNS BOOLEAN

BEGIN

set
QutputRoot.DataObject.ns:SapMatmas05.IDocStreamData =
InputRoot.BLOB.BLOB;

RETURN TRUE;

END;
END MODULE;

The name of the SapMatmas(05 element depends on selections that you make when
you run the Adapter Connection wizard.



Query interface for SAP Software:

The Query interface for SAP Software (QISS) provides you with the means to
retrieve data from application tables on an SAP server or to query SAP application
tables for the existence of data. The adapter can perform hierarchical data retrieval
from the SAP application tables.

Query interface for SAP Software supports outbound interactions for read
operations (RetrieveAll and Exists) only. You can use this interface in local
transactions to look up records before write operations (Create, Update, or Delete).
For example, you can use the interface as part of a local transaction to do an
existence check on a customer before creating a sales order. You can also use the
interface in non-transaction scenarios.

Query interface for SAP Software supports data retrieval form SAP application
tables, including hierarchical data retrieval from multiple tables. The interface
supports static as well as dynamic specification of where clauses for the queries.

The Adapter Connection wizard finds the application data tables in SAP, interprets
the hierarchical relationship between tables, and constructs a representation of the
tables and their relationship in the form of a business object. The wizard also
builds a default where clause for the query.

You can control the depth of the data retrieval as well as the amount of
information using the maxRow and rowsSkip properties.

For more information, see the following topics.

* [“Outbound processing for the query interface for SAP Software”]

* |“Business objects for the query interface for SAP Software” on page 26|

Outbound processing for the query interface for SAP Software:
You use the Query interface for SAP Software for outbound processing only.

Note: The client application that makes the request uses the interface information
that was generated by the Adapter Connection wizard.

The following list describes the sequence of processing actions that result from an
outbound request using the query interface for SAP Software.

1. The adapter receives a request, which includes a table object, from a client
application.

The query business object can be within a container business object, or it can be
received as a table business object.

2. The adapter determines, from the table object sent with the query, the name of
the table to examine.

3. The adapter determines the columns to retrieve or examine.
4. The adapter determines the rows to retrieve or examine.
5. The adapter responds.

* In the case of a RetreiveAll operation, the adapter returns a result set in the
form of a container of query business objects, which represent the data for
each row retrieved from the table. If the query is received as a table business
object (not inside a container), the rows are returned one at a time, as they
are retrieved.
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* In the case of the Exists operation, the adapter returns an indication of
whether the data exists in the SAP table.

* If no data exists, the adapter generates an exception.
Business objects for the query interface for SAP Software:

A business object is a structure that consists of data, the action to be performed on
the data, and additional instructions, if any, for processing the data. The input to
the Query interface for SAP Software is a table business object. The table business
object represents the columns in a table on the SAP server. The adapter uses the
table business object to obtain data from tables on the SAP server.

How data is represented in business objects

The data in the business object represents the columns of the associated table in
SAP.

How business objects are created

You create business objects by using the Adapter Connection wizard. The wizard
connects to the application, discovers data structures in the application, and
generates business objects to represent them. It also generates other resources that
are needed by the adapter, such as the interface information that indicates the
input and output parameters.

Business object structure
The table business object can be part of a container.
The table business object contains columns selected from the specified SAP table.

In addition to column information, the table business object also contains a query
business object as the last parameter.

The properties of the query business object are sapWhereClause, sapRowsSkip, and
sapMaxRows:

* The sapWhereClause property retrieves information from SAP tables. The
default value is populated by the Adapter Connection wizard. The space
character is used as the delimiter to parse the sapWhereClause.

¢ The sapMaxRows property is the maximum number of rows to be returned. The
default value is 100.

¢ The sapRowsSkip property is the number of rows to skip before retrieving data.
The default value is 0.

The tables can be modeled as hierarchical business objects. You specify the
parent-child relationship of the tables in the Adapter Connection wizard.

Tables are linked by a foreign key to form parent-child relationships. The child
table business object has a foreign key that references a property in the parent
query business object.

In the KNA1 business object, notice the reference to SapAdrc, a child business
object. The SapAdrc table object, shown in the following figure, has a column
named AddressNumber. This column has an associated property (ForeignKey) that
contains a reference to the parent business object.



The return from the Query interface for SAP Software call for a RetrieveAll
operation is a container of table objects.

The advanced event processing interface:

The advanced event processing interface of the WebSphere Adapter for SAP
Software is used for both inbound and outbound processing. For inbound
processing, it polls for events in SAP, converts them into business objects, and
sends the event data as business objects to WebSphere Message Broker. For
outbound processing, the adapter processes events sent from an application to
retrieve data from or update data in the SAP server.

For more information, see the following topics.

* [“Outbound processing”|

+ |“Inbound processing for the advanced event processing interface” on page 30|

+ [“Business objects” on page 32|

Outbound processing:

During outbound processing, business object data is converted into an ABAP
handler function, which is called on the SAP server. When the data is returned by
the ABAP handler function, the data is converted to a business object, and the
business object is returned as a response.

The following list describes the sequence of processing actions that result from an

outbound request using the advanced event processing interface.

1. The adapter receives the advanced event processing record, which contains
business data along with the metadata.

2. The ABAP component of the adapter uses the metadata of the business object
to obtain the type of IDoc specified and to reformat the business object data
into the structure of that IDoc.

3. After it reformats the data, the adapter passes the business object data to an
object-specific ABAP handler (based on the operation), which handles the
integration with an SAP native APL

4. The adapter converts the business data to handler data format and passes it
along with the ABAP handler information to the SAP adapter infrastructure
component in the SAP application.

5. After the object-specific ABAP handler finishes processing the business object
data, it returns the business object data in IDoc format to the ABAP component,
which converts the business object data back to its original format and returns
it to the adapter.

6. The adapter returns the results to the caller.

For more information, see the following topics.

* |[“ABAP handler overview”|

+ [“ABAP handler creation” on page 28§|

+ [“Call Transaction Recorder wizard” on page 29

ABAP handler overview:
An ABAP handler is a mechanism that gets data into and out of the SAP

application database. For each business object definition that you develop, you
must support it by developing a custom ABAP handler.
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ABAP handlers reside in the SAP application as ABAP function modules. ABAP
handlers are responsible for adding business object data into the SAP application
database (for Create, Update, and Delete operations) or for using the business
object data as the keys to retrieving data from the SAP application database (for
the Retrieve operation).

You must develop operation-specific ABAP handlers for each hierarchical business
object that needs to be supported. If you change the business object definition, you
must also change the ABAP handler.

An ABAP handler can use any of the SAP native APIs for data operations within
the SAP application. ABAP SQL, Call Transaction, Batch Data Communication
(BDC), or a call to another REC or ABAP program can be used to handle data in
the ABAP handler.

The adapter provides the following tools to help in the development process:

* The adapter includes the Call Transaction Recorder Wizard to assist you in
developing the ABAP Handlers that use call transactions or BDC sessions.

e The Adapter Connection wizard generates the required business objects and
other artifacts for advanced event processing. The business objects are based on
IDocs, which can be custom or standard.

* The adapter provides samples that you can refer to for an understanding of the
advanced event processing implementation.

ABAP handler creation:

For each business object definition that you develop, you must support it
developing a custom ABAP handler.

You can use either standard IDocs or custom IDocs for the advanced event
processing interface. After defining the custom IDoc for an integration scenario,
create an ABAP handler (function module) for each operation of the business object
that needs to be supported.

Each function should have the following interface to ensure that adapter can call it:

*" IMPORTING

*"  VALUE(OBJECT_KEY_IN) LIKE /CWLD/LOG_HEADER-OBJ_KEY OPTIONAL
*"  VALUE(INPUT_METHOD) LIKE BDWFAP_PAR- NPUTMETHD OPTIONAL

*"  VALUE(LOG_NUMBER) LIKE /CWLD/LOG_HEADER-LOG_NR OPTIONAL

*" EXPORTING

*"  VALUE(OBJECT_KEY_OUT) LIKE /CWLD/LOG_HEADER-0BJ_KEY

*"  VALUE(RETURN_CODE) LIKE /CWLD/RFCRC_STRU-RFCRC

*"  VALUE(RETURN_TEXT) LIKE /CWLD/LOG_HEADER-0BJ_KEY

*" TABLES

x" IDOC_DATA STRUCTURE EDID4

The ABAP handler can use any of the SAP native APIs for handling the data. Some
of the native APIs are listed below.

e (Call Transaction

Call Transaction is the SAP-provided functionality for entering data into an SAP
system. Call Transaction guarantees that the data adheres to the SAP data model
by using the same screens an online user sees in a transaction. This process is
commonly referred to as screen scraping.

* Batch data communication (BDC)

Batch Data Communication (BDC) is an instruction set that SAP can follow to
process a transaction without user intervention. The instructions specify the



sequence in which the screens in a transaction are processed and which fields

are populated with data on which screens. All of the elements of an SAP

transaction that are exposed to an online user have identifications that can be

used in a BDC.
* ABAP SQL

ABAP SQL is the SAP proprietary version of SQL. It is database- and platform-
independent, so that whatever SQL code you write, you can run it on any
database and platform combination that SAP supports. ABAP SQL is similar in
syntax to other versions of SQL and supports all of the basic database table
commands such as update, insert, modify, select, and delete. For a complete
description of ABAP SQL, see your SAP documentation.

Using ABAP SQL, an ABAP handler can modify SAP database tables with
business object data for create, update, and delete operations. It can also use the
business object data in the where clause of an ABAP select statement as the

keys.

Note: Use of ABAP SQL to modify SAP tables is not recommended, because it

might corrupt the integrity of the database. Use ABAP SQL only to
retrieve data.

¢ ABAP Function Modules and Subroutines

From the ABAP Handler, you can call ABAP function modules or subroutines

that implement the required function.

Call Transaction Recorder wizard:

The adapter provides the Call Transaction Recorder wizard to assist you in
developing the ABAP handlers that use call transactions or BDC sessions.

The Call Transaction Recorder wizard enables you to generate sample code for call
transactions to facilitate development. It generates sample code stubs for each
screen that is modified during the recording phase.

To access this wizard, enter the /CWLD/HOME transaction in the SAP graphical

user interface.

The following is sample code generated by the wizard. You can adopt this code in
the ABAP Handler.

* Customer master:
perform dynpro_new

* Customer account
perform dynpro_set

* Function Command
perform dynpro_set

* Function Command
perform dynpro_set

* Customer master:
perform dynpro_new

* Title
perform dynpro_set

* Function Command
perform dynpro_set

request screen chnge/displ cent.
using 'SAPMFO2D' '0101' .

number
using 'RFO2D-KUNNR'

Ill .
using 'BDC_OKCODE' '/@0' .
using 'BDC_OKCODE' '/00' .
General data, CAM address, communication
using 'SAPMFO2D' '0111' .

using 'SZA1_DO10O-TITLE_MEDI' 'Mr.' .

using 'BDC_OKCODE' '=UPDA"' .
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* Call Transaction
Call Transaction 'XD02' using bdcdata

mode input_mode

update 'S’
messages into bdc_messages.

The wizard does not generate the required business object. You must manually
build the object.

Inbound processing for the advanced event processing interface:

The adapter uses the advanced event processing interface to poll for events on the
SAP server, to process the events, and to send them to an endpoint.

The following list describes the sequence of processing actions that result from an
inbound request using the advanced event processing interface.

1.
2.

A triggered event enters the event table with an initial status of pre-queued.

When the adapter polls for events, the status of the event changes from
pre-queued to queued if there are no database locks for the combination of the
user who created the event and the event key.

After the event is retrieved from the event table, the status of the event is
updated to InProgress.

If locks exist, the status of the event is set to locked and the event is re-queued
into the queue. Every event with a pre-queued or locked status is updated with
every poll. You can configure the polling frequency using the Poll Frequency
property.

After preprocessing all pre-queued events, the adapter selects the events.

The property Poll Quantity determines the maximum number of events
returned for a single poll call.

For each event, the adapter uses the remote function specified for the Retrieve
operation to retrieve the data and send it to the endpoint.

If the AssuredOnceDelivery property is set to true, an XID value is set for each
event in the event store. After each event is picked up for processing, the XID
value for that event is updated in the event table.

If before the event is delivered to the endpoint, the SAP connection is lost or
the application is stopped, and the event is consequently not processed
completely, the XID column ensures that the event is reprocessed and sent to
the endpoint. After the SAP connection is reestablished or the adapter starts up
again, it first checks for events in the event table that have a value in the XID
column. It then processes these events first and then polls the other events
during the poll cycles.

After each event is processed, it is updated or archived in the SAP application.

When the event is processed successfully, it is archived and then deleted from
the event table.

The adapter can also filter the events to be processed by business object type.
The filter is set in the Event Filter Type property. This property has a
comma-delimited list of business object types, and only the types specified in
the property are picked for processing. If no value is specified for the property,
no filter is applied and all the events are picked up for processing.

If the Filter Future Events property is set to true, the adapter filters events
based on the timestamp. The adapter gets the system time in each poll cycle
and compares it to the timestamp on each event. If the event is set to occur in
the future, it is not picked up for processing until that time.



For more information, see the following topics.

* |“Event notification”]

* |“Event triggers” on page 32|

Event notification:

Event notification refers to the collection of processes that notify the adapter of
SAP application object events. Notification includes, but is not limited to, the type
of the event (object and operation) and the data key required for the external
system to retrieve the associated data.

Events that are detected are stored in an SAP application table. This event table is
delivered as part of the ABAP component. The event table structure is as follows.

Table 3. Event table fields

Name Type Description

event_id NUMBER Unique event ID that is a primary key for the
table

object_name STRING Business graph name or business object name.

object_key STRING Delimited string that contains the keys for the
business object.

object_function STRING Operation corresponding to the event (Delete,
Create, or Update).

event_priority NUMBER Any positive integer to denote the priority of
the event.

event_time DATE Date and time when the event was generated

event_status NUMBER Event processing status. Possible values are:

* 0 - Ready for poll

* 1 - Event delivered

* 2 - Event prequeued
* 3 - Event in progress
* 4 - Event locked

e -1 - Event failed

Xid STRING Unique XID (transaction ID) value for
assured-once delivery.

event_user STRING User who created the event.

event_comment STRING Description of the event.

Many different mechanisms can be used to detect events in the SAP application.
An event-detection mechanism must have the ability to make a function module
call. The four event-detection mechanisms supported by the adapter are described
in the following list:

* Custom Triggers, which are implemented for a business process (normally a
single SAP transaction) by inserting event detection code at an appropriate point
within the SAP transaction

* Batch programs, which involve developing an ABAP program containing the
criteria for detecting an event

* Business workflows, which use the object-oriented event detection capabilities of
SAP
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* Change pointers, a variation of business workflows, which use the concept of
change documents to detect changes for a business process

Event triggers:

After an event is identified by one of the event-detection mechanisms, it is
triggered by one of the adapter-delivered event triggers. Event triggers can cause
events to be processed immediately or in the future.

The function modules that trigger events are described in the following list.

* /CWLD/ADD_TO_QUEUE
This function module triggers events to the current event table for immediate
processing.

+ /CWLD/ADD_TO_QUEUE_IN_FUTURE

This function module triggers events to the future event table to be processed at
a later time.

Note: Both functions are for real-time triggering.

If the event will be triggered in real-time, /CWLD/ADD_TO_QUEUE commits the
event to the current event table (/CWLD/EVT_CUR). Specifically, it adds a row of
data for the object name, verb, and key that represents the event.

If an event needs to be processed at a future date, /CWLD/
ADD_TO_QUEUE_IN_FUTURE commits the event to the future event table
(/CWLD/EVT_FUT). Specifically, it adds a row of data for the object name, verb,
and key that represents the event. In addition, it adds a Date row, which is read by
the adapter-delivered batch program /CWLD/SUBMIT_FUTURE_EVENTS. This
batch program can be scheduled to retrieve events from the future event table.
After it retrieves an event, it calls /CWLD/ADD_TO_QUEUE to trigger the event
to the current event table.

/CWLD/ADD_TO_QUEUE_IN_FUTURE uses the system date as the current date
when it populates the Date row of the future event table.

Business objects:

A business object is a structure that consists of data, the action to be performed on
the data, and additional instructions, if any, for processing the data. The Adapter
Connection wizard is used to generate business object definitions based on IDocs.
Either SAP-delivered or customer-built IDocs can be used.

How data is represented in business objects

The data in the business object represents an IDoc.

How business objects are created

You create business objects by using the Adapter Connection wizard. The wizard
connects to the application, discovers data structures in the application, and
generates business objects to represent them. It also generates other resources that
are needed by the adapter , such as the interface information that indicates the

input and output parameters.

Overview of WebSphere Adapter for Siebel Business Applications:



WebSphere Adapter for Siebel Business Applications provides a way to create
integrated processes that include the exchange of information with a Siebel
application. With it, an application can send requests to the Siebel Business
Applications server or receive notifications of changes from the server.

The adapter creates a standard interface to the applications and data on the Siebel
Business Applications server, so that the application does not have to understand
the lower-level details (the implementation of the application or the data
structures) on the Siebel Business Applications server. An application, for example,
can send a request to the Siebel Business Applications server, to query a customer
record in a Siebel Business Applications table or to update an order document. It
can also receive events from the server, for example, to be notified that a customer
record has been updated. This provides you with improved business workflow and
processes to help manage your customer relations.

WebSphere Adapter for Siebel Business Applications complies with the Java
Connector Architecture (JCA). JCA standardizes the way application components,
application servers, and Siebel applications, such as Siebel Business Applications
server, interact with each other.

The adapter configuration, which you generate with the Adapter Connection
wizard, uses a standard interface and standard data objects. The adapter takes the
standard data object sent by the application component and calls the Siebel
Business Applications function. The adapter then returns a standard data object to
the application component. The application component does not have to deal
directly with the Siebel Business Applications function; it is the Siebel Business
Applications adapter that calls the function and returns the results.

For example, the application component that needs the list of customers sends a
standard business object with the range of customer IDs to Adapter for Siebel
Business Applications. In return, the application component receives the results
(the list of customers) in the form of a standard business object. The application
component does not need to know how the function worked or how the data was
structured. The adapter performs all the interactions with the actual Siebel
Business Applications function.

Similarly, the client application might want to know about a change to the data on
the Siebel Business Applications server (for example, a change to a particular
customer). You can generate an adapter component that polls for such events on
the Siebel Business Applications server and notifies client applications of the
update. In this case, the interaction begins at the Siebel Business Applications
server.

Technical overview of the Adapter for Siebel Business Applications:

WebSphere Adapter for Siebel Business Applications supports the exchange of
information between your existing applications and Siebel Business Applications.
The adapter supports Siebel entities, including business objects, business
components, and business services. This enables you to create business processes
that exchange data.

The adapter supports outbound processing (requests for data or services from an

application to the Siebel application) and inbound processing (event notification
from a Siebel application server to an application).
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With Adapter for Siebel Business Applications, you can use existing or
newly-created applications that run in a supported runtime environment to send
requests for data and services to Siebel Business Applications.

You can also add event-generation triggers to Siebel business objects to have
notifications of events, such as the creation, update, and deletion of a record, sent

to one or more of your applications.

For more information, see the following topics.

+ “Outbound processing”|

+ |“Inbound processing” on page 35|

* |[“Business objects” on page 3§|

+ [“Adapter Connection wizard (Siebel)” on page 38|

Outbound processing:

WebSphere Adapter for Siebel Business Applications supports synchronous
outbound processing. This means that when the component sends a request in the
form of a WebSphere business object hierarchy to the adapter, the adapter
processes the request and returns a WebSphere business object hierarchy that
represents the result of the operation.

When the adapter receives a WebSphere business object hierarchy, the adapter
processes it as follows:

1. The adapter extracts metadata from the WebSphere business object hierarchy.

2. It identifies the appropriate Siebel objects to access (for example, Siebel
business objects and business components, or Siebel business services,
integrations objects, and integration components) depending on the objects
against which the artifacts were generated.

3. The adapter extracts the outbound operation to perform from the WebSphere
business object hierarchy.

4. After accessing the required Siebel objects, the adapter retrieves, updates,
deletes, or creates a Siebel business component hierarchy or performs the
corresponding business service method on the integration component hierarchy:.

5. If there are updates (Create, Update, Delete), the adapter populates that Siebel
object (business or integration component hierarchy) with data from the
hierarchy of WebSphere business objects.

Supported Outbound Operations

WebSphere Adapter for Siebel Business Applications supports the following
outbound operations as shown in the table below.

Table 4. Supported outbound operations

Operation Description

Create Creates the business component.

Delete Deletes the business component and its children.

Exists Checks for the existence of incoming business objects.
The output business object, "ExistsResult” will be
returned with the boolean value populated.

Retrieve Specifies the value of the business component.
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Table 4. Supported outbound operations (continued)

Operation Description

RetrieveAll Retrieves multiple instances of the same business
component and populates it as the container business
graph.

Update Updates the Siebel application with the incoming

business object.

Inbound processing:

WebSphere Adapter for Siebel Business Applications supports asynchronous
inbound processing. This means that the adapter polls the Siebel Business
Applications at specified intervals for events. When the adapter detects an event, it
converts the event data into a business object and sends it to the component.

When the adapter detects an event for Siebel event business components or
integration components, it processes it by retrieving the updated data for the Siebel
event business component or integration component and converting it into a
business object. Then, the adapter sends the business object to the event business
component. For example, if an event business component (an account) is updated,
an event trigger adds an event record to the event business component. The
adapter then polls the event business component, retrieves the event record, and
processes it.

When the adapter finds an event for a Siebel event business component, it is
processed as follows:

1. The adapter retrieves the event information from the Siebel event business
component.

2. It retrieves the corresponding event business component instance hierarchy.

3. It populates the associated WebSphere business object or business graph (if it
was generated) with the values it retrieves from the event business component.

4. It sends a notification to each registered application.

Note: Before inbound processing can occur, a Siebel event business component
must be created in the Siebel application (IBM2 for Siebel version 7.x and
IBM_EVENT for Siebel version 8) and its name specified against the
corresponding property in the adapter activation specification.

Event store:

The event store is a persistent cache where event records are saved until the
polling adapter can process them. To keep track of inbound events as they make
their way through the system, the adapter uses an event store.

The creation, update, or deletion of an event record in the Siebel business
application is an ‘event’. Each time a business object is created, updated, or
deleted, the adapter updates the status of the event in an event store.

For example, if you have a customer component and a new customer has just been
added to it, this signals an update. If the adapter is configured to receive the
events about the new update, there will be triggers attached to the Siebel end and
connected to the customer component. The triggers add a record to the event
business component. The record contains information about the new customer,
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such as the customer ID. This information is stored in the object key. The object
key is the unique identifier that provides the key name and value of the event
business component that was updated (for example, 1d=1-20RT). The object name is
the WebSphere business object name that represents the customer component (for
example, AccountBG or Account). The adapter retrieves this event and the new
customer information that relates to it.

During inbound processing, the adapter polls the event business components from
the event store at regular intervals. Each time it polls, a number of events are
processed by the adapter. Events are processed in ascending order of priority and
ascending order of the event time stamp. In each poll cycle, new events are picked
up. The adapter retrieves the value set in the object key field for the event and
loads the business object that corresponds to it. The business object, or optionally
the business graph, is created from the retrieved information and is delivered to
the exports.

If you set the activation specification property AssuredOnceDelivery to true, a
transaction ID (XID) value is set for each event in the event store. After the event is
retrieved for processing, the XID value for it is updated in the event store and
displayed in the XID column in the event business component. The event is then
delivered to its corresponding export, and the status is updated to show that the
event has been successfully delivered. If the application is stopped or the event is
not processed completely, the XID column is filled with a value. This ensures that
the event is reprocessed and sent to the export. After the connection is
reestablished or the adapter starts again, the adapter checks for events in the event
store that have a value in the XID column. The adapter processes these events first
and then polls the other events during the poll cycles.

The adapter can either process all events or process events filtered by business
object type. You set the filter through the activation specification property,
EventTypekFilter. This property contains a comma-delimited list of business object
types. Only the types specified in the property are processed. If the
EventTypeFilter property is not set, then all of the events are processed. If the
FilterFutureEvents property is set to true, the adapter filters events based on the
time stamp. The adapter compares the system time in each poll cycle to the time
stamp on each event. If an event is set to occur in the future, it is not processed
until that time.

After an event is successfully posted and delivered to the export, the entry is
deleted from the event store. Failed events (posting and delivery to the export is
unsuccessful), remain in the event store and are marked -1. This prevents duplicate
processing.

Event store structure for Siebel business objects and business components

The IBM2 event business component stores information about the event. The
information stored is used by the resource adapter during event subscription to
build the corresponding business object and send it to the registered exports. The
information that is stored, as well as the structure of the event store used by the
adapter, is shown in the following table.

Table 5. Event store structure for IBM2 Siebel event business objects and business components

Field Description Example
Description Any comment associated with the Account Create Event
event.
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Table 5. Event store structure for IBM2 Siebel event business objects and business components (continued)

Field

Description

Example

Event ID

The ID of the event row.

Automatically generated unique ID
in Siebel (for example: 1-XYZ )

Event timestamp

The time stamp for the event. The
format is in mm/dd/yyyy hh:mm:ss

02/24/2007 11:37:56

Event type

The type of event.

Create, Update, or Delete

Object key

A unique identifier of the business
object row for which the event was
created. It is a name value pair
consisting of the name of the
property (key name) and value.

1d=1-20RT

Object name

The name of the business object or
business graph for which the event
was detected.

I0AccountPRMANIICAccount

Priority

The event priority.

Status

The event status. This is initially set
to the value for a new event and
updated by the adapter as it
processes the event. The status can
have one of the following values:

* 0: Identifies a new event.

* 1: Identifies an event that has been
delivered to an export.

e -1: An error occurred while
processing the event.

This column cannot be null.

XID

The transaction ID. This is to ensure
“assured once delivery’.

None

Event store structure for Siebel business services

The event is retrieved from the IBM2 event business component and the
information is used to retrieve the event business component. This creates a
business graph which is published to the registered exports.

Table 6. Event store structure for IBM2 Siebel business services

Field Description Example
Description Any comment associated with the Account PRM ANI Event
event.
Event ID The ID of the event row. Automatically generated unique ID

in Siebel (for example: 1-XYZ )

Event timestamp

The time stamp for the event. The 02/24/2007 11:37:56
format is in mm/dd/yyyy hh:mm:ss

Event type

The type of event. Create, Update, or Delete

Object key

A unique identifier of the business Name=TestName;Location=BGM,
object row for which the event was | where 'Name’ and "Location’ are the
created. It is a name value pair keys in the integration component.
consisting of the name of the "TestName” and 'BGM’ are the values
property (key name) and value. specified, and ; is the event key
delimiter.
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Table 6. Event store structure for IBM2 Siebel business services (continued)

Field

Description Example

Object name

The name of the business object or I0AccountPRMANIICAccount
business graph for which the event
was detected.

Priority

The event priority. 1

Status

The event status. This is initially set |0
to the value for a new event and
updated by the adapter as it
processes the event. The status can
have one of the following values:

e (: Identifies a new event.

* 1: Identifies an event that has been
delivered to an export.

e -1: An error occurred while
processing the event.

This column cannot be null.

XID

The transaction ID. This is to ensure |None
“assured once delivery’.
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Business objects:

To send data or obtain data from Siebel Business Applications, the adapter uses
business objects. A business object is a structure that consists of data, the action to
be performed on the data, and additional instructions, if any, for processing the
data. The data can represent either a business entity, such as an invoice or an
employee record, or unstructured text.

How business objects are created

You create business objects by using the Adapter Connection wizard, which
connects to the application, discovers data structures in the application, and
generates business objects to represent them. It also generates other resources that
are needed by the adapter.

Business object structure

The adapter supports business objects that are hierarchically structured. The
top-level business object must have a one-to-one correspondence with the Siebel
business component, and collections that occur within the top-level object are
children of it. Information about the processed object is stored in the
application-specific information for the object and each of its attributes.

Adapter Connection wizard (Siebel):

The Adapter Connection wizard is a tool that you use to configure your adapter.
The wizard establishes a connection to the Siebel server, discovers business objects
and services (based on search criteria you provide), and generates business objects
based on the services discovered.




Using the Adapter Connection wizard, you establish a connection to the Siebel
server to browse the metadata repository on the Siebel server. You also specify
connection information, such as the Connection URL, user name, and password
needed to access the server.

The result of running the wizard is a message set project that contains the Siebel
business objects and services along with the adapter.

Overview of WebSphere Adapter for PeopleSoft Enterprise:

WebSphere Adapter for PeopleSoft Enterprise provides you with a way to create
integrated processes that include the exchange of information with a PeopleSoft
Enterprise server.

Using the adapter, a client application can send requests to the PeopleSoft
Enterprise server (for example, to query an employee record in an HR table) or
receive events from the server (for example, to be notified that an employee record
has been updated). The adapter creates a standard interface to the applications and
data on the PeopleSoft Enterprise server, so that the client application does not
have to understand the lower-level details (the implementation of the application
or the data structures) on the PeopleSoft Enterprise server.

WebSphere Adapter for PeopleSoft Enterprise complies with the Java Connector
Architecture (JCA), which standardizes the way application components,
application servers, and enterprise information systems, such as a PeopleSoft
Enterprise server, interact with each other.

The adapter component, which you generate with the Adapter Connection wizard
uses a standard interface and standard data objects. The adapter component takes
the standard data object sent by the client application and calls the PeopleSoft
function. It then returns a standard data object to the client application. The client
application does not have to deal directly with the PeopleSoft function; it is the
adapter component that calls the function and returns the results.

For example, the client application that needed the list of employees would send a
standard business object with the range of skill codes to the PeopleSoft adapter
component. The client application would receive, in return, the results (the list of
employees) in the form of a standard business object. The client application would
have no need to know how the function worked or how the data was structured.
The adapter component would perform all the interactions with the actual
PeopleSoft function.

Similarly, the client application might want to know about a change to the data on
the PeopleSoft Enterprise server (for example, a change to the skills set of a
particular employee). You can generate an adapter component that listens for such
events on the PeopleSoft Enterprise server and notifies client applications with the
update. In this case, the interaction begins at the PeopleSoft Enterprise server.

For more information, see [“Technical overview.”|

Technical overview:

The adapter supports the exchange of business data between the PeopleSoft
Enterprise server and WebSphere Message Broker. It does so by connecting to two
layers of PeopleTools application programming interface classes that reveal the
underlying business data for integration.
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Adapter for PeopleSoft Enterprise establishes bidirectional connectivity with the
PeopleSoft Enterprise server by connecting to two PeopleTools application
programming interfaces as follows:

1. The adapter accesses the primary API layer to create a session instance and to
connect to the application server through the Jolt port.

2. The adapter then accesses the PeopleSoft Component Interface API, which
reveals underlying business data, logic, and functionality.

In PeopleSoft, a component is a set of pages grouped together for a business
purpose (such as an employee profile), and a component interface is an API that
provides synchronous access to a component from an external application. Once
the adapter connects to the component interface, the following entities are exposed
to the adapter and available for integration:

 All business objects in the component interface definition
* PeopleCode methods associated with the underlying components
* Records, except searches and menu-specific processing options

For more information, see the following topics.

+ [“Outbound processing”|

* |“Inbound processing”]

+ [“Business objects” on page 42|

Outbound processing:

The Adapter for PeopleSoft Enterprise supports synchronous outbound request
processing. Synchronous outbound processing means that when the client
application sends a request in the form of a business object to the adapter, the
adapter processes the request and returns a business object representing the result
of the operation to the client application.

When the adapter receives an inbound business object, the processing flow is as
follows:

1. The adapter extracts meta data from the business object that identifies the
appropriate PeopleSoft component interface to access.

2. It extracts from the business object the outbound operation to perform.

3. Once it accesses the component interface, the adapter sets the keys from values
specified in the business objects.

4. The adapter instantiates an existing component interface to retrieve, update, or
create a component interface, and then it populates that component interface
with data from the hierarchy of business objects.

Note: The adapter processes attributes in the order defined in the business object.
For example, if there is a complex attribute between two simple attributes,
the adapter processes the simple attribute at the first position, then the
complex attribute followed by the simple attribute. After the changes are
made, the component interface is saved to commit the data to the PeopleSoft
database. This pattern of processing is used for Create and Update
operations only.

Inbound processing:

The WebSphere Adapter for PeopleSoft Enterprise supports asynchronous inbound
event processing. Inbound event processing means that the adapter polls the



PeopleSoft Enterprise server at specified intervals for events. When the adapter
detects an event, it converts the event data into a business object and sends it to
the client application.

In order to use inbound event processing, you must create a custom event project
in PeoileSoft, as described in [“Creating a custom event project in PeopleTools” on|
page 243,

For more information, see [“Event store.”

Event store:

The event store is a table that holds events that represent data changes until the
polling adapter can process them. The adapter uses the event store to keep track of
event entities. Each time a business object is created, updated, or deleted, the
adapter updates the status of the event in an event table. The status of each event
is continually updated by the adapter for recovery purposes until the events are
delivered to a configured endpoint on the runtime environment.

To use inbound processing, you must use PeopleTools Application Designer to
create a custom project for event notification. This creates the event table the
adapter uses for inbound processing. Each event table is associated with a specific
inbound module. The adapter does not support multiple adapter modules pointing
to the same event table.

With inbound processing, the adapter polls the event entities from the event store
at regular intervals. In each poll call, a number of events are processed by the
adapter. The order of event processing is based on the ascending order of priority
and the ascending order of the event time stamp. The events with the status,
Ready for poll, are picked up for polling in each poll cycle. The adapter uses the
object name and object key to retrieve the integration object or business object.

If you set the activation specification property AssuredOnceDelivery to true, an
XID (transaction ID) value is set for each event in the event store. After an event is
obtained for processing, the XID value for that event is updated in the event table.
The event is then delivered to its corresponding endpoint, and its status is updated
to show that event delivery has been completed. If the application is stopped
before the event can be delivered to the endpoint, the event might not be
processed completely. In this case, the XID column ensures that the event is
reprocessed and sent to the endpoint. Once the database connection is
re-established or the adapter starts again, the adapter checks for events in the
event table that have a value in the XID column. The adapter processes these
events first, and then polls the other events during the poll cycles.

The adapter can process all events or filter events by business object type. The
filter is set by use of the activation specification property EventFilterType. This
property has a comma-delimited list of business object types. Only the types
specified in the property are processed. If no value is specified for the property, no
filter is applied, and all the events are processed. If the Activation specification
property FilterFutureEvents is set to true, the adapter filters events based on
timestamp. The adapter compares the system time in each poll cycle to the time
stamp on each event. If an event is set to occur in the future, it will not be
processed until that time.

The event table follows a certain structure.
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Table 7. Event table structure

Field

Description

Example

Description Any comment associated Account Interface event.
with the event.
Event ID The ID of the event row. Automatically generated

unique ID in PeopleSoft
Enterprise.

Event time stamp

The time stamp for the
event. The format is

mm/dd/yyy hh:mm:ss.

06/24/2007 10:43:22

Event type

The type of event.

Create.

Object key

A unique identifier of the
business object row for
which the event was created.
It is a name value pair
consisting of the name of the
property and the value.

Object name

The business graph for
which the event was
detected.

Priority

The event priority.

Status

The event status. This is
initially set to
READY_FOR_POLL.

XID

The transaction ID.

None.

As events are retrieved and processed from the event table, the status of the event
changes to reflect the cycle, as shown in the table below.

Table 8. Event status values

completed.

Status short name Description Event table value
Error processing event An error occurred during -1
event processing.
Ready for poll The event has not yet been |0
picked up by the adapter.
The event is ready to be
picked up.
Success The event has been delivered |1
to the event manager.
Complete Event processing has 4

Business objects:

A business object is a structure that consists of data, the action to be performed on
the data, and additional instructions, if any, for processing the data. The data can
represent either a business entity, such as an invoice or an employee record, or
unstructured text. The adapter uses business objects to send data to or obtain data
from the PeopleSoft Enterprise server.




How business objects are created

You create business objects by using the Adapter Connection wizard. The wizard
connects to the application, discovers data structures in the application, and
generates business objects to represent them. It also generates other resources that
are needed by the adapter.

Business object structure

The adapter supports business objects that are hierarchically structured. The
top-level business object must have a one-to-one correspondence with the
PeopleSoft component interface, and collections that occur within the top-level
object are children of it. Information about the processed object is stored in the
application-specific information for the object and each of its attributes.

The following table describes the attributes that comprise a business object.

Attribute property Description
Name Indicates the name of the Business Object attribute.
Type Indicates the type of the Business Object attribute. The

adapter uses character mapping between PeopleSoft
component property types and the generated business
object attribute types. PeopleSoft component property
types map to generated attribute types in the following
manner:

CHAR maps to attribute type String
NUMBER maps to attribute type BigDecimal
LONG maps to attribute type Long

SIGN maps to attribute type BigDecimal
DATE maps to attribute type Date

TIME maps to attribute type Time

DTTM maps to attribute type DateTime

Key and foreign key PeopleSoft architecture does not use the foreign key
attribute. Child business objects have their own keys
that have the primary key application-specific
information. They also inherit keys from their parent
business object.

Cardinality Single cardinality for simple attributes; multiple
cardinality for container attributes.

Special None

Message flow node palette

The palette contains all of the built-in nodes, which are organized into categories,
or drawers. A drawer is a container for a list of icons, such as the Favorites
drawer. You can drag the nodes that you use most often into the Favorites drawer
for easy access. If you create your own nodes, you can also add them to the
palette. You can drag a node from the palette onto the canvas, and create a
connection between two nodes.

If you right-click the palette, you can add a selected node to the canvas, or

customize the appearance and behavior of the palette. The following example
shows the palette in List view, using small icons.
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The Customize Palette dialog box allows you to reorder node categories, set the
drawer behavior for individual categories, and rename or hide nodes or categories.
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You cannot move any category above the Favorites category. You can hide the
Favorites category, but you cannot delete or rename it.

The Palette Settings dialog box allows you to set the palette layout, determine the
behavior of palette drawers, and choose a particular font.

& PaletteKSEttings = o]
Font: <Using Workbench Dialog Font = Change...
Restore Default

Layout: Details layout options
" Columns I Use large icons
 List
" Icons only
i Details

Drawer options:
" Always dose when opening anather drawer
% Close automatically when there is not enough room

" Never close

OK I Cancel |

The following topics explain how to change the palette layout and settings:

+ [“Changing the palette layout” on page 219

+ |“Changing the palette settings” on page 219

+ [“Customizing the palette” on page 219

Message flows, ESQL, and mappings

A message flow represents the set of actions performed on a message when it is
received and processed by a broker. The content and behavior of a message flow is
defined by a set of files that you create when you complete your definition and
configuration of the message flow content and structure:

* The message flow definition file <message_flow_name>.msgflow. This is a
required file and is created automatically for you. It contains details about the
message flow characteristics and contents (for example, what nodes it includes,
its promoted properties, and so on).

* The ESQL resources file <message_flow_name>.esql. This file is required only if
your message flow includes one or more of the nodes that must be customized
using ESQL modules. You can create this file yourself, or you can cause it to be
created for you by requesting specific actions against a node.
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You can customize the following built-in nodes by creating free-form ESQL
statements that use the built-in ESQL statements and functions, and your own
user-defined functions:

— Compute

— Database

— Filter

* The message mappings file <message_flow_name><_nodename>.msgmap. This
file is required only if your message flow contains one or more of the nodes that
must be customized using mappings. You can create this file yourself, or you
can cause it to be created for you by requesting specific actions against a node.
A different file is required for each node in the message flow that uses the
Message Mapping editor.

You can customize the following built-in nodes by specifying how input values
map to output values:

Usage

Use this node to delete one or more rows from a database table without creating an output
message.

Use this node to insert one or more rows in a database table without creating an output message.

Use this node to update one or more rows in a database table without creating an output message.

“Extract node”|

Use this node to create a new output message that contains a subset of the contents of the input
message. Use the Extract node only if no database is involved in the map.

The Extract node is deprecated in WebSphere Message Broker Version 6.0. Although message flows
that contain an Extract node remain valid in WebSphere Message Broker Version 6.0, where
possible, redesign your message flows so that any Extract node is replaced by a Mapping node.

|”Mapping|

ode” on page

H
—_
S

Use this node to construct output messages and populate them with information that is new,
modified from the input message, or taken from a database. You can also use the Mapping node to
update, insert or delete rows in a database table.

Use this node to store all or part of a message in a database table without creating an output
message.

You can use built-in ESQL functions and statements to define message
mappings, and you can use your own ESQL functions.

Message flow version and keywords

When you are developing a message flow, you can define the version of the
message flow as well as other key information that you want to be associated with
it. After the message flow has been deployed, you can view the properties of the
message flow in the workbench. These properties include the deployment and
modification dates and times (the default information that is displayed) as well as
any additional version or keyword information that you have set.

You can define information to give details of the message flow that has been
deployed; therefore, you can check that it is the message flow that you expect.
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Version
You can set the version of the message flow in the Version property.

You can also define a default message flow version in the Default version tag of
the message flow preferences. All new message flows that are created after this

value has been set have this default applied to the Version property at the message

flow level.

Keywords

Keywords are extracted from the compiled message flow (the .cmf file) rather than

the message flow source (the .msgflow file). Not all of the source properties are
added to the compiled file. Therefore, add message flow keywords in only these
places:

* The label property of a Passthrough node
¢ ESQL comments or string literals
* The Long Description property of the message flow

Any keywords that you define must follow certain rules to ensure that the
information can be parsed. The following example shows some values that you
might want to define in the Long Description property:

$MQSI Author=John Smith MQSI$
$MQSI Subflow 1 Version=v1.3.2 MQSI$

The following table contains the information that the workbench shows.

Message flow name

Deployment Time 28-Aug-2004 15:04
Modification Time 28-Aug-2004 14:27
Version v1.0

Author John Smith
Subflow 1 Version v1.3.2

In this display, the version information has also been defined using the Version
property of the object. If the version information has not been defined using the
property, it is omitted from this display.

If message flows contain subflows, you can embed keywords in each subflow.
Restrictions within keywords

Do not use the following characters within keywords because they cause
unpredictable behavior:

~§. | \<>?+x=4[]

You can use these characters in the values that are associated with keywords; for
example:

* $MQSI RCSVER=$id$ MQSI$ is acceptable
* $MQSI $name=Fred MQSI$ is not acceptable
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Message flow connections
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A connection is an entity that connects an output terminal of one message flow
node to the input terminal of another. It represents the flow of control and data
between two message flow nodes.

The connections of the message flow, represented by black lines within the
message flow editor view, determine the path that a message takes through the
message flow. You can add bend points to the connection to alter the way in which
it is displayed.

See [“Bend points”l for a description of bend points. See ["Message flow node]
[terminals”[ for a description of terminals.

Bend points
A bend point is a point that is introduced in a connection between two message
flow nodes at which the line that represents the connection changes direction.

Use bend points to change the visual path of a connection to display node
alignment and processing logic more clearly and effectively. Bend points have no
effect on the behavior of the message flow; they are visual modifications only.

A connection is initially made as a straight line between the two connected nodes
or brokers. Use bend points to move the representation of the connection, without
moving its start and end points.

Message flow node terminals
A terminal is the point at which one node in a message flow is connected to
another node.

Use terminals to control the route that a message takes, depending whether the
operation performed by a node on that message is successful. Terminals are wired
to other node terminals using message flow node connections to indicate the flow
of control.

Every built-in node has a number of terminals to which you can connect other
nodes. Input nodes (for example, MQInput) do not have in terminals; all other
nodes have at least one in terminal through which to receive messages to be
processed. Most built-in nodes have failure terminals that you can use to manage
the handling of errors in the message flow. Most nodes have output terminals
through which the message can flow to a subsequent node.

If you have any user-defined nodes, these might also have terminals that you can
connect to other built-in or user-defined node terminals.

Dynamic terminals are terminals that you can add to certain nodes after you have
added them to a message flow in the Message Flow editor. For example, you can
add dynamic output terminals to the Route and DatabaseRoute nodes, or you can
add dynamic input terminals to the Collector node. You can also delete and
rename dynamic terminals. If a node has five or more terminals, they are displayed
in a group. For example, the following example shows a node with more than four

o

output nodes.



Threading

A message flow is inherently thread-safe, and message flows can be run
concurrently on more than one thread.

An instance of a message flow processing node is shared and used by all the
threads that service the message flow in which the node is defined.

The number of threads servicing a flow is configured using the Additional
instances property on the node.

Execution model

The execution model is the system used to start message flows through a series of
nodes.

When an execution group is initialized, the appropriate loadable implementation
library (LIL) files and Plug-in Archive (PAR) files are made available to the
runtime environment. The execution group runtime process starts, and creates a
dedicated configuration thread. In the message flow execution environment, the
message flow is thread-safe. You can run message flows concurrently on many
operating system threads, without having to consider serialization issues. Consider
the following points:

* An input message sent to a message flow is processed only by the thread that
received it.

* The memory requirements of an execution group are not unduly affected by
running message flows on more operating system threads.

* The message flow execution environment is conceptually similar to procedural
programming. Nodes that you insert into a message flow are similar to
subroutines called using a function call interface. However, rather than a
call-return interface, in which parameters are passed in the form of input
message data, the execution model is referred to as a propagation-and-return
model.

* A message flow is inherently thread-safe, and message flows can be run
concurrently on more than one thread.

The message tree

A message tree is a structure that is created by one or more parsers when an input
message bit stream is received by a message flow or by the action of a message
flow node.

A message is used to describe:

* A set of business data exchanged by applications

* A set of elements arranged in a predefined structure
* A structured sequence of bytes

WebSphere Message Broker routes and manipulates messages after converting
them into a logical tree. The process of conversion, called parsing, makes the
content and structure of a message obvious, and simplifies later operations. After
the message has been processed, the parser converts it back into a bit stream.

WebSphere Message Broker supplies a range of parsers to handle the many
different messaging standards in use. See

After a message has been parsed, it can be processed in a message flow.
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The logical tree contains identical contents to that of the message but is easier to
manipulate within the message flow. The message flow nodes provide an interface
to query, update or create the content within the tree.

How the message tree is populated
The message tree is initially populated by the input node of the message flow.

When the input node receives the input message, it creates and completes the
Proi erties tree (the first subtree of the message tree). See |“Message tree structure”|

The node then examines the contents of the input message bit stream and creates
the remainder of the message tree to reflect those contents. This process depends to
some extent on the input node itself, which is governed by the transport across
which the message is received:

WebSphere MQ Enterprise Transport and WebSphere MQ Telemetry Transport

protocols
If your application communicates with the broker across these protocols,
and your message flow includes the corresponding MQInput or
SCADAInput node, all messages that are received must start with a
Message Queue Message Descriptor (MQMD) header. If a valid MQMD is
not present at the start of the message, the message is rejected, and no
further processing takes place.

The input node first invokes the MQMD parser and creates the subtree for
that header.

A message can have zero or more additional headers following the
MQMD. These headers are chained together, with the Format field of one
header defining the format of the following header, up to and including
the last header, which defines the format of the message body. If an
MQRFH and an MQRFH2 header exist in the chain, the name and value
data in either of these two headers can also contain information about the
format of the following data. If the value that is specified in Format is a
recognized parser, this value always takes precedence over the name and
value data.

The broker invokes the appropriate parser to interpret each header,
following the chain in the message. Each header is parsed independently.
The fields within a single header are parsed in an order that is governed
by the parser. You cannot predict the order that is chosen, but the order in
which fields are parsed does not affect the order in which the fields are
displayed within the header.

The broker ensures that the integrity of the headers that precede a message
body is maintained. The format of each part of the message is defined,
either by the Format field in the immediately preceding header (if the
following part is a recognized WebSphere MQ format), or by the values
that are set in the MQRFH or MQRFH?2 header:

* The format of the first header is known because it must be MQMD.

* The format of any subsequent header in the message is set in the Format
field in the preceding header.

* The format of the body corresponds to the message domain and the
parser that must be invoked for the message body (for example,
XMLNSC). This information is set either in the MQRFH or MQRFH2
header, or in the Message Domain property of the input node that
receives the message.



This process is repeated as many times as required by the number of
headers that precede the message body. You do not need to populate these
fields yourself; the broker handles this sequence for you.

The broker completes this process to ensure that Format fields in headers
correctly identify each part of the message. If the broker does not complete
this process, WebSphere MQ might be unable to deliver the message. The
message body parser is not a recognized WebSphere MQ header format,
therefore the broker replaces this value in the last header’s Format field
with the value MQFMT_NONE. The original value in that field is stored in
the Domain field within the MQRFH or MQRFH2 header to retain the
information about the contents of the message body.

For example, if the MQRFH2 header immediately precedes the message
body, and its Format field is set to XMLNSC, which indicates that the
message body must be parsed by the XMLNSC parser, the MQRFH2
Domain field is set to XMLNSC, and its Format field is reset to
MQFMT_NONE.

These actions might result in information that is stored explicitly by an
ESQL or Java expression being replaced by the broker.

When all the headers have been parsed, and the corresponding sub-trees
have been created within the message tree, the input node associates the
specified parser with the message body. Specify the parser that is to be
associated with the message body content, either in a header in the
message (for example, the <mecd> folder within the MQRFH2 header), or
in the input node properties (if the message does not include headers). The
input node makes the association as described in the following list:

* If the message has an MQRFH or MQRFH2 header, the domain that is
identified in the header (either in Format or the name and value data)
determines the parser that is associated with this message.

The SCADAInput node creates WebSphere MQ format messages with
MQRFH2 headers from the input messages that the listener receives on
the TCP/IP port.

¢ If the message does not have an MQRFH or MQRFH2 header, or if the
header does not identify the domain, the Message Domain property of the
input node indicates the domain of the message, and the parser that is
to be used. You can specify a user-defined domain and parser.

¢ If the message domain cannot be identified by header values or by the
Message Domain property of the input node, the message is handled as a
binary object (BLOB). The BLOB parser is associated with the message.
A BLOB can be interpreted as a string of hexadecimal characters, and
can be modified or examined in the message flow by specifying the
location of the subset of the string.

By default, the message body is not parsed straight away, for performance
reasons. The message body might not need to be parsed during the
message flow. It is parsed only when a reference is made to its contents.

For example, the message body is parsed when you refer to a field in the
message body, for example: Root.XMLNSC.MyDoc.MyField. Depending on the
paths that are taken in the message flow, this parse can take place at
different points. This "parse when first needed” approach is also referred to
as ’partial parsing’ or ‘'on demand parsing’, and in typical processing does
not affect the logic of a message flow. However, there are some
implications for error handling scenarios; see ['Handling errors in message]
[flows” on page 194
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If you want a message flow to accept messages from more than one
message domain, include an MQRFH?2 header in your message from which
the input nodes extract the message domain and related message definition
information (message set, message type, and message format).

If you set up the message headers or the input node properties to identify
a user-defined domain and parser, the way in which it interprets the
message and constructs the logical tree might differ from that described
here.

WebSphere MQ Multicast Transport, WebSphere MQ Real-time Transport,
WebSphere Broker File Transport, WebSphere Broker Adapters Transport,
WebSphere MQ Web Services Transport, and WebSphere Broker JMS Transport
protocols
If your application communicates with the broker across these supported
protocols, and your message flow includes the corresponding input nodes,
messages that are received do not have to include a particular header. If
recognized headers are included, the input node invokes the appropriate
parsers to interpret the headers and to build the relevant parts of the
message tree, as described for the other supported protocols.

If there are no headers, or these headers do not specify the parser for the
message body, set the input node properties to define the message body
parser. If you do not set the node properties in this way, the message is
treated as a BLOB. You can specify a user-defined parser.

The specified parser is associated with the message body by the input
node (in the same way as it is for the WebSphere MQ Enterprise Transport
and WebSphere MQ Telemetry Transport protocols), and by default the
message body is not parsed immediately.

If you set up the message headers or the input node properties to identify
a user-defined domain and parser, the way in which it interprets the
message and constructs the logical tree might differ from that described
here.

All other protocols
If you want your message flow to accept messages from a transport
protocol for which WebSphere Message Broker does not provide built-in
support, or you want it to provide some specific processing on receipt of a
message, use either the Java or the C language programming interface to
create a new user-defined input node.

This interface does not automatically generate a Properties subtree for a
message (this subtree is discussed in [“Message tree structure” on page 57).
A message does not need to have a Properties subtree, but you might find
it useful to create one to provide a consistent message tree structure,
regardless of input node. If you are using a user-defined input node, you
must create a Properties subtree within the message tree yourself.

To process messages that do not conform to any of the defined message
domains, use the C language programming interface to create a new
user-defined parser.

Refer to the node interface to understand how it uses parsers, and whether
you can configure it to modify its behavior. If the node uses a user-defined
parser, the tree structure that is created for the message might differ
slightly from that created for built-in parsers. A user-defined input node
can parse an input message completely, or it can participate in partial
parsing in which the message body is parsed only when it is required.



You can also create your own output and message processing nodes in C
or Java.

Properties versus MQMD folder behavior for various transports

Differences exist in the way the Properties folder and the MQMD folder are treated
with respect to which folder takes precedence for the same fields. This treatment is
characterized by the transport type (for example, HTTP or WebSphere MQ) that
you use.

When the message flow is sourced by an MQInput node then you have an MQMD
to parse. In this case the Properties folder is sourced by the MQMD values and so
the MQMD folder takes precedence over the Properties folder in terms of value
propagation between the folders. This scenario means that you can perform ESQL,
for example, SET OutputRoot.MQMD.Correlld and this command updates the
Properties folder value.

When the message flow is sourced from a input node that is not the MQInput
node (such as the HTTPInput node or a user-defined input node), then no MQMD
is parsed. This scenario means the Properties folder is not sourced from an input
MQMD, it is created and populated with transport values that come from other
transport specific headers. When you create an MQMD folder in a message flow
that was not sourced from the WebSphere MQ transport, the MQMD header does
not take precedence over the Properties folder because the WebSphere MQ
transport did not populate the Properties folder. Therefore, in this case, the
Properties folder overwrites any values in MQMD.

The Properties folder is constructed and represents a message received on the
transport. In this scenario two entirely different transports are being used which
have different meanings and, therefore, different requirements of the Properties
folder. When sourced from an HTTPInput node, the HTTP headers have control
over the Properties folder for like fields. When sourced from an MQInput node the
MQMD has control over the Properties folder for like fields.

Therefore, it follows that when you add an MQMD folder to a tree that was
created by the HTTP Transport then this MQMD folder does not have control over
the Properties folder, and the value propagation direction is not MQMD to
Properties, it is Properties to MQMD. The correct approach here is for you to set
the Properties folders replyldentifier field and to use this to populate the MQMD:

SET OutputRoot.Properties.Replyldentifier = X' ..... 5

The behavior is not unique to just the Correlld to Replyldentifier fields. It applies
for all like fields between the MQMD and Properties folder:

* Correlld

* Encoding

* CodedCharSetld
* Persistence

* Expiry

* Priority

In summary:

1. When your message flow is sourced by an MQInput node then the MQMD
takes precedence over the Properties folder in terms of value propagation
between the folders.
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2. When your message flow is sourced from an input node that is not the
MQInput node (such as the HTTPInput node or a user-defined input node), the
MQMD header does not take precedence over Properties folder .

3. When a MQMD folder is added in a tree that was created by the HTTP
Transport then this MQMD does not have control over the Properties folder
and the value propagation direction is not MQMD to Properties; it is Properties
to MQMD.

Example

SET OutputRoot.Properties = InputRoot.Properties;

SET OQutputRoot.MQMD.Version = 2;

SET OQutputRoot.MQMD.Correlld = X'4d454e53414a453320202020202020202020202020202020" ;
SET OQutputRoot.MQMD.Encoding = 785;

SET OQutputRoot.MQMD.CodedCharSetId = 500;

SET OQutputRoot.MQMD.Persistence = 1;

SET OutputRoot.MQMD.Expiry = 10000;

SET OutputRoot.MQMD.Priority = 9;

SET OutputRoot.BLOB.BLOB = X'01';

When sourced from an HTTPInput node none of these changes will take effect and
the MQMD output from the Compute node is:

(0x01000000) :MQMD = (

(0x03000000) :Version =2

(0x03000000) :Correlld = X'000000000000000000000000000000000000000000000000 '
(6x03000000) :Encoding = 546

(0x03000000) : CodedCharSetId = 1208

(0x03000000) :Persistence = FALSE

(0x03000000) :Expiry = -1

(0x03000000) :Priority =0

Message tree contents after an exception: The contents of the message tree are
updated if an exception is raised.

If no exception occurs while processing the message, the tree structure and content
received by an individual node is determined by the action of previous nodes in
the flow.

If an exception occurs in the message flow, the content of the four trees depends
on the following factors:

* If the exception is returned to the input node, and the input node catch terminal
is not connected, the trees are discarded. If the message is within a transaction, it
is returned to the input queue for further processing. When the message is
processed again, a new tree structure is created. If the message is not within a
transaction, it is discarded.

* If the exception is returned to the input node and the catch terminal is
connected, the Message and LocalEnvironment trees that were created originally
by the input node, and propagated through the out terminal, are restored, and
any updates that you made to their content in the nodes that followed the input
node are lost. The Environment tree is not restored, and its contents are
preserved. If the nodes following the input node include a Compute node that
creates a new LocalEnvironment or Message tree, those trees are lost. The
ExceptionList tree reflects the one or more exceptions that have been recorded.

e If the exception is caught within the message flow by a TryCatch node, the
Message and LocalEnvironment trees that were previously propagated through
the try terminal of the TryCatch node are restored and propagated through the
catch terminal. Any updates that you made to their content in the nodes that
followed the TryCatch node are lost. The Environment tree is not restored, and



its contents are preserved. If the nodes following the TryCatch node include a
Compute node that creates a new LocalEnvironment or Message tree, those trees
are lost. The ExceptionList tree reflects the one or more exceptions that have
been recorded.

Exception handling paths in a message flow: Exception handling paths start at a
failure terminal (most message processing nodes have these), the catch terminal of
an input node, a TryCatch node, or an AggregateReply node, but are no different
in principle from a normal message flow path. Such a flow consists of a sequence
of nodes connected together by the designer of the message flow. The exception
handling paths differ in the kind of processing that they do to record or react to
the exception. For example, they might examine the exception list to determine the
nature of the error, and take appropriate action or log data from the message or
exception.

The LocalEnvironment and message tree that are propagated to the exception
handling message flow path are those at the start of the exception path, not those
at the point when the exception is thrown. The figure below illustrates this point:

A B
M1 (@ M2
Kt L1 B—TD

TryCatch Compute1 Compute2

* A message (M1) and LocalEnvironment (L1) are being processed by a message
flow. They are passed through the TryCatch node to Computel.

* Computel updates the message and LocalEnvironment and propagates a new
message (M2) and LocalEnvironment (L2) to the next node, Compute2.

* An exception is thrown in Compute2. If the failure terminal of Compute2 is not
connected (point B), the exception is propagated back to the TryCatch node, but
the message and LocalEnvironment are not. The exception handling path
starting at point A has access to the first message and LocalEnvironment, M1
and L1. The Environment tree is also available and retains the content it had
when the exception occurred.

e If the failure terminal of Compute2 is connected (point B), the message and
LocalEnvironment M2 and L2 are propagated to the node connected to that
failure terminal. The Environment tree is also available and retains the content it
had when the exception occurred.

Logical tree structure
The logical tree structure is the internal (broker) representation of a message. It is
also known as the message assembly.

When a message arrives at a broker, it is received by an input node that you have
configured in a message flow. Before the message can be processed by the message
flow, the message must be interpreted by one or more parsers that create a logical
tree representation from the bit stream of the message data.

The tree format contains identical content to the bit stream from which it is
created, but it is easier to manipulate within the message flow. Many of the built-in
message flow nodes provide an interface for you to query and update message
content within the tree, and perform other actions against messages and databases
to help you to provide the required function in each node.
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Several interfaces are provided:

* ESQL, a programming language that you can code in the Compute, Database,
and Filter nodes.

* Java, a programming language that you can code in the JavaCompute node.

* Mappings, a graphical method of achieving transformation from input to output
structures, available in the DataDelete, Datalnsert, DataUpdate, Extract,
Mapping, and Warehouse nodes.

* XSL, a language for transforming XML that you can use in the XSLT node.

The tree structure that is created by the parsers is largely independent of any
message format (for example, XML). The exception to this is the subtree that is
created as part of the message tree to represent the message body. This subtree is
message dependent, and its content is not further described here.

The input node creates this message assembly, which consists of four trees:
* ["Message tree structure” on page 57|

* [“Environment tree structure” on page 59|

+ |“LocalEnvironment tree structure” on page 60|

* |[“ExceptionList tree structure” on page 63|

The first of these trees is populated with the contents of the input message bit
stream, as described in [“How the message tree is populated” on page 50} the
remaining three trees are initially empty.

Each of the four trees created has a root element (with a name that is specific to
each tree). Each tree is made up of a number of discrete pieces of information
called elements. The root element has no parent and no siblings (siblings are
elements that share a single parent). The root is parent to a number of child
elements. Each child must have a parent, can have zero or more siblings, and can
have zero or more children.

The four trees are created for both built-in and user-defined input nodes and
parsers.

The input node passes the message assembly that it has created to subsequent
message processing nodes in the message flow:

* All message processing nodes can read the four trees.

* You can code ESQL in the Database and Filter nodes, or use mappings in the
nodes that support that interface to modify the Environment and
LocalEnvironment trees only.

¢ The Compute node differs from other nodes in that it has both an input message
assembly and at least one output message assembly. Configure the Compute
node to determine which trees are included in the output message assembly; the
Environment tree is an exception in that it is always retained from input
message assembly to output message assembly.

To determine which of the other trees are included, you must specify a value for
the Compute mode property of the node (displayed on the Advanced tab). The
default action is for only the message to be created. You can specify any
combination of message, LocalEnvironment, and ExceptionList trees to be
created in the output message assembly.

If you want the output message assembly to contain a complete copy of the
input message tree, you can code a single ESQL SET statement to make the copy.



If you want the output message to contain a subset of the input message tree,
code ESQL to copy those parts that you want. In both cases, your choice of
Compute mode must include Message.

If you want the output message assembly to contain all or part of the input
LocalEnvironment or ExceptionList tree contents, code the appropriate ESQL to
copy information you want to retain in that tree. Your choice of Compute mode
must include LocalEnvironment, or Exception, or both.

You can also code ESQL to populate the output message, Environment,
LocalEnvironment, or ExceptionList tree with information that is not copied
from the input tree. For example, you can retrieve data from a database, or
calculate content from the input message data.

* A similar capability exists in the JavaCompute node. See [“Writing Java” on page]
for more information.

Message tree structure:

The message tree is a part of the logical message tree in which the broker stores its
internal representation of the message body.

The root of a message tree is called Root. The message tree is always present, and
is passed from node to node within a single instance of a message flow.

The message tree includes all the headers that are present in the message, in
addition to the message body. The tree also includes the Properties subtree
(described in [“Parsers” on page 69), if that is created by the parser. If a supplied
parser has created the message tree, the element that represents the Properties
subtree is followed by zero or more headers.

If the message has been received across the WebSphere MQ Enterprise Transport,
WebSphere MQ Mobile Transport, or WebSphere MQ Telemetry Transport, the first
header (the second element) must be the MQMD. Any additional headers that are
included in the message appear in the tree in the same order as in the message.
The last element beneath the root of the message tree is always the message body.

If a user-defined parser has created the message tree, the Properties tree, if present,
is followed by the message body.

The message tree structure is shown below. If the input message is not a
WebSphere MQ message, the headers that are shown might not be present. If the
parser that created this tree is a user-defined parser, the Properties tree might not
be present.
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| |

Properties MQMD Other headers Body
Element1/Format1
Element2/Field2 Element3/Field3

The Body tree is a structure of child elements (described below) that represents the
message content (data), and reflects the logical structure of that content. The Body
tree is created by a body parser (either a supplied parser or a user-defined parser),
as described in [“Parsers” on page 69|

Each element within the parsed tree is one of three types:

Name element
A name element has a string associated with it, which is the name of the
element. An example of a name element is XMLETement, as described in
["XML element” on page 1297 A name element also has a second string
associated with it, which is the namespace of the element; this string might
be empty.

Value element
A value element has a value associated with it. An example of a value
element is XMLContent, as described in [“XML content” on page 1297 |

Name-value element
A name-value element is an optimization of the case where a name
element contains only a value element and nothing else. The element
contains both a name and a value. An example of a name-value element is
XMLAttribute, as described in [“XML attribute” on page 1295 |

For information about how the message tree is populated, see [‘How the message|
[tree is populated” on page 50.|

Properties folder: The Properties folder is the first element of the message tree and
holds information about the characteristics of the message.

The root of the Properties folder is called Properties. It is the first element under
Root. All message trees that are generated by the built-in parsers include a
Properties folder for the message. If you create your own user-defined parser, you
can choose whether the parser creates a Properties folder. However, for consistency,
you should include this action in the user-defined parser.

The Properties folder contains a set of standard properties that you can manipulate
in the message flow nodes in the same way as any other property. Some of these
fields map to fields in the supported WebSphere MQ headers, if present, and are
passed to the appropriate parser when a message is delivered from one node to
another.



For example, the MQRFH2 header contains information about the message set,
message type, and message format. These values are stored in the Properties folder
as MessageSet, MessageType, and MessageFormat. To access these values using
ESQL or Java within the message processing nodes, refer to these values in the
Properties folder; do not refer directly to the fields in the headers from which they
are derived.

The Properties parser ensures that the values in the header fields match the values
in the Properties folder on input to, and output from, every node. For any field, if
only one header is changed (the Properties header or a specific message header),
that value is used. If both the Properties header and the specific message header
are changed, the value from the Properties folder is used.

When the message flow processing is complete, the Properties folder is discarded.

Environment tree structure: The Environment tree is a part of the logical message
tree in which you can store information while the message passes through the
message flow.

The root of the Environment tree is called Environment. This tree is always present
in the input message; an empty Environment tree is created when a message is
received and parsed by the input node. You can use this tree as you choose, and
create both its content and structure.

There is one situation in which WebSphere Message Broker refers to (but never
creates) a field in this tree. If you have requested data collection for message flow
accounting and statistics, and have indicated that accounting origin basic support
is required, the broker checks for the existence of the field
Environment.Broker.AccountingOrigin. If the field exists, the broker uses its value
to set the accounting origin for the current data record. For further information
about the use of this field, see [‘Setting message flow accounting and statistics|
accounting origin” on page 517.| (Contrast this with the [“LocalEnvironment tree
structure” on page 60,/ which the broker uses in several situations.)

The Environment tree differs from the LocalEnvironment tree in that a single
instance of it is maintained throughout the message flow. If you include a
Compute node, a Mapping node, or a JavaCompute node in your message flow,
you do not have to specify whether you want the Environment tree to be included
in the output message. This happens automatically, and the entire contents of the
input Environment tree are retained in the output Environment tree, subject to any
modifications that you make in the node. Any changes that you make are available
to subsequent nodes in the message flow, and to previous nodes if the message
flows back (for example, to a FlowOrder or TryCatch node).

If you want to create your own information, create it in the Environment tree
within a subtree called Variables.

An example of an Environment tree is shown below:
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Environment

Variables

T T
bread wine cheese colors J country J

name currency

You could use the following ESQL statements to create the content shown above.

SET Environment.Variables =
ROW('granary' AS bread, 'riesling' AS wine, 'stilton' AS cheese);
SET Environment.Variables.Colors[] =
LIST{'yellow', 'green', 'blue', 'red', 'black'};
SET Environment.Variables.Country[] = LIST{ROW('UK' AS name, 'pound' AS currency),
ROW('USA' AS name, 'dollar' AS currency)};

When the message flow processing is complete, the Environment tree is discarded.

LocalEnvironment tree structure: The LocalEnvironment tree is a part of the
logical message tree in which you can store information while the message flow
processes the message.

The root of the LocalEnvironment tree is called LocalEnvironment. This tree is
always present in the input message: an empty LocalEnvironment tree is created
when a message is received by the input node.

Use the LocalEnvironment tree to store variables that can be referred to and
updated by message processing nodes that occur later in the message flow. You
can also use the LocalEnvironment tree to define destinations (that are internal and
external to the message flow) to which a message is sent. WebSphere Message
Broker also stores information in LocalEnvironment in some circumstances, and
references it to access values that you might have set for destinations. (Contrast
this to the Environment tree structure, which the broker refers to in one situation
only, see [“Environment tree structure” on page 59.)

The figure below shows an example of the LocalEnvironment tree structure. The
children of Destination are protocol-dependent. The example below shows the
structure for a WebSphere MQ message. If the message is parsed by another
built-in parser, or by a user-defined parser, the tree structure below the Destination
element has different content than that shown in the figure.
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In the tree structure shown above, LocalEnvironment has several children:

Variables

This subtree is optional. If you create local environment variables, you are
recommended to store them in a subtree called Variables. It provides a
work area that you can use to pass information between nodes. This
subtree is never inspected or modified by any supplied node.

Variables in the local environment can be changed by any subsequent
message processing node, and persist until the message flow goes out of
scope and the node that created it has completed its work and returns
control to the previous node

The variables in this subtree are only persistent within a single instance of
a message flow. If you have multiple instances of a message passing
through the message flow, and need to pass information between them,
you must use an external database.

Destination

This subtree consists of a number of children that indicate the transport
types to which the message is directed (the Transport identifiers), or the
target Label nodes that are used by a RouteToLabel node.

* Transport information

Transport information is used by some input and output nodes,
including HTTP, MQ, JMS, SOAP, File, and e-mail.

HTTP

If the message flow starts with an HTTPInput node, a single name
element HTTP is added to Destination. The element
HTTP.Requestldentifier is created and initialized so that it can be used
by an HTTPReply node. You can also create other fields in the HTTP
structure for use by the HTTPRequest node, for example the URL of the
service to which the request is sent. The topic for each node contains
more information about the contents of Destination for the WebSphere
MQ Web Services Transport protocol.

MQ

If the message flow includes an MQOutput node, each element is a
name element, MQ (A deprecated alternative exists, called
MQDestinationList. Use MQ for all new message flows). If more than one
element exists, each is processed sequentially by the node. See the
example in [“Populating Destination in the LocalEnvironment tree” on|

|Eage 298.|
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If you have included a user-defined output node in the message flow,
the contents of Destination (if supported) are defined by that node.

You can configure output nodes to examine the list of destinations and
send the message to those destinations, by setting the property
Destination Mode to Destination List. If you do so, you must create this
subtree and its contents to define those destinations, giving it the name
Destination. If you do not do so, the output node cannot deliver the
messages.

If you prefer, you can configure the output node to send messages to a
single fixed destination, by setting the property Destination Mode to
Queue Name or Reply To Queue. If you select either of these fixed
options, the destination list has no effect on broker operations and you
do not have to create this subtree.

You can construct the MQ element to contain a single optional Defaults
element. The Defaults element, if created, must be the first child and
must contain a set of name-value elements that give default values for
the message destination and its PUT options for that parent.

You can also create a number of elements called DestinationData within
MQ . Each of these can be set up with a set of name-value elements that
defines a message destination and its PUT options.

The set of elements that define a destination is described in |”Data typesl
[for elements in the DestinationData subtree” on page 1261

The content of each instance of DestinationData is the same as the
content of Defaults for each protocol, and can be used to override the
default values in Defaults. You can set up Defaults to contain values that
are common to all destinations, and set only the unique values in each
DestinationData subtree. If you do not set a value either in
DestinationData or Defaults then the value that you have set for the
corresponding node property is used. Similarly, if you specify a field
name or value with the wrong spelling or case, it is ignored, and the
value that you have set for the corresponding node property is used.
The information that you insert into DestinationData depends on the
characteristic of the corresponding node property: this is described in
[“Accessing the LocalEnvironment tree” on page 295

* Routing information

The child of Destination is RouterList. It has a single child element called
DestinationData, which has a single entry called labelName. If you are
using a dynamic routing scenario involving the RouteToLabel and Label
nodes, you must set up the Destination subtree with a RouterList that
contains the reference labels.

WrittenDestination
This subtree contains the addresses to which the message has been written.
Its name is fixed. It is created by the message flow when a message is
propagated through the out terminal of an output node. It includes
transport specific information (for example, if the output message has been
put to a WebSphere MQ queue, it includes the queue manager and queue
names). If the out terminal of the output node is not connected to another
node, this subtree is not created.

The topic for each output node contains more information about the
contents of WrittenDestination for WebSphere MQ and WebSphere MQ
Everyplace.



When the message flow processing is complete, the LocalEnvironment tree is
discarded.

The following samples demonstrate how to use the LocalEnvironment to
dynamically route messages based on the destination list:

+ |Airline Reservations sample|

+ [Message Routing sample]

The following sample uses the LocalEnvironment to store information that is later
added to the output message that is created by the message flow:

» |User-defined Extension sample|

You can view samples only when you use the information center that is integrated
with the Message Broker Toolkit.

ExceptionList tree structure: The ExceptionList tree is a part of the logical
message tree in which the message flow writes information about exceptions that
occur when a message is processed.

The root of the ExceptionList tree is called ExceptionList, and the tree consists of a
set of zero or more exception descriptions. The ExceptionList tree is populated by
the message flow if an exception occurs. If no exception conditions occur during
message flow processing, the exception list that is associated with that message
consists of a root element only. This list is, in effect, an empty list of exceptions.

The ExceptionList tree can be accessed by other nodes within the message flow
that receive the message after the exception has occurred. You can modify the
contents of the ExceptionList tree only in the Compute node.

If an exception condition occurs, message processing is suspended and an
exception is thrown. Control is passed back to a higher level, that is, an enclosing
catch block. An ExceptionList is built to describe the failure condition, and the
whole message, together with the LocalEnvironment and the newly-populated
ExceptionList, is propagated through an exception-handling message flow path.

The child of the ExceptionList is always RecoverableException. There is normally
only one child of the root, although more than one might be generated in some
circumstances. The child of the ExceptionList contains a number of children, the
last of which provides further information specific to the type of exception. The
following list includes some of the exception types that you might see.

* FatalException

* RecoverableException

* ConfigurationException

* SecurityException

* ParserException

* ConversionException

* DatabaseException

¢ UserException

 CastException

* MessageException

* SqlException

* SocketException

* SocketTimeoutException

* UnknownException
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The structure of the exception list tree for a RecoverableException is shown below:

ExceptionList

RecoverableException

. . . . Recoverable
File | [Line| | Function | | Type| | Name | | Label | | Catalog | | Severity | | Number | | Text Exception (1)

[ [ [ [ [ [ ==

File | |Line| | Function | | Type | | Name | | Label | | Catalog | | Severity | [ Number | | Text In(ssrt Exec?;;/t(iac:ﬁb(ga)

,_L\- T

I
]
|
Type | | Text !

The exception description structure can be both repeated and nested to produce an
ExceptionList tree. In this tree:

e The depth (that is, the number of parent-child steps from the root) represents
increasingly detailed information for the same exception.

e The width of the tree represents the number of separate exception conditions
that occurred before processing was abandoned. This number is usually one, and
results in an ExceptionList tree that consists of a number of exception
descriptions that are connected as children of each other.

¢ At the numbered points in the tree:

1. This child can be one of RecoverableException, ParserException,
DatabaseException, UserException, ConversionException, or
MessageException. All of these elements have the children shown; if present,
the last child is the same element as its parent.

2. This element might be repeated.
3. If present, this child contains the same children as its parent.

The children in the tree take the form of a number of name-value elements that
give details of the exception, and zero or more name elements whose name is
Insert. The NLS (National Language Support) message number identified in a
name-value element identifies a WebSphere Message Broker error message. The
Insert values are used to replace the variables within this message and provide
further detail about the cause of the exception.

The name-value elements within the exception list shown in the figure above are
described in the table below.

Name Type Description

File' String C++ source file name

Line' Integer C++ source file line number
Function' String C++ source function name
Type’ String Source object type
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Name Type Description
Name? String Source object name
Label? String Source object label
Text' String Additional text
Catalog® String NLS message catalog name*
Severity® Integer

1 = information

2 = warning

3 = error
Number’ Integer NLS message number*
Insert’ Type Integer The data type of the value:

yp 8 yp

0 = Unknown

1 = Boolean

2 = Integer

3 = Float

4 = Decimal

5 = Character

6 = Time

7 = GMT Time

8 = Date

9 = Timestamp

10 = GMT Timestamp

11 = Interval

12 = BLOB

13 = Bit Array

14 = Pointer

Text String The data value

Notes:

1. Do not use the File, Line, Function, and Text elements for exception
handling decision making. These elements ensure that information can
be written to a log for use by IBM Service personnel, and are subject to
change in both content and order.

2. The Type, Name, and Label elements define the object (usually a
message flow node) that was processing the message when the
exception condition occurred.

3. The Catalog, Severity, and Number elements define an NLS message:
the Insert elements that contain the two name-value elements shown
define the inserts into that NLS message.

4. NLS message catalog name and NLS message number refer to a

translatable message catalog and message number.

When the message flow processing is complete, the ExceptionList tree is discarded.

The following sample uses the ExceptionList in the XML_Reservation message flow
to pass error information to the Throw node, which generates an error message
that includes the information from the ExceptionList:

+ |Airline Reservations sample]

You can view samples only when you use the information center that is integrated
with the Message Broker Toolkit.
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Correlation names

A correlation name is a field reference that identifies a well-defined starting point
in the logical message tree and is used in field references to describe a standard
part of the tree format.

When you access data in any of the four trees (message, environment, local
environment, or exception list), the correlation names that you can use depend on
the node for which you create ESQL or mappings, and whether the node creates an
output message. For example, a Trace node does not alter the content of the
message as it passes through the node, but a Compute node can construct a new
output message.

You can introduce new correlation names with SELECT expressions, quantified
predicates, and FOR statements. You can create non-correlation names in a node by
using reference variables.

Correlation names in nodes that do not create an output message: Most message
flow nodes do not create an output message; all ESQL expressions that you write
in ESQL modules or in mappings within these nodes refer to just the input
message. Use the following correlation names in the ESQL modules that you write
for Database and Filter nodes:

Root  The root of the message passing through the node.

Body The last child of the root of the message; that is, the body of the message.
This name is an alias for Root.*[<].

For a description of how to use the asterisk (*) in field references, see
[“Using anonymous field references” on page 278

Properties
The standard properties of the input message.

Environment
The structure that contains the current global environment variables that
are available to the node. Environment can be read and updated from any
node for which you can create ESQL code or mappings.

LocalEnvironment
The structure that contains the current local environment variables that are
available to the node. LocalEnvironment can be read and updated from
any node for which you can create ESQL code or mappings.

DestinationList
The structure that contains the current local environment variables
available to the node. Its preferred name is LocalEnvironment, although
the DestinationList correlation name can be used for compatibility with
earlier versions.

ExceptionList
The structure that contains the current exception list to which the node has
access.

You cannot use these correlation names in the expression of any mapping for a
Mapping, Extract, Warehouse, Datalnsert, DataUpdate, or DataDelete node.

Correlation names in nodes that create an output message: If you are coding
ESQL for a Compute node, the correlation names must distinguish between the
two message trees involved: the input message and the output message. The
correlation names in ESQL within these nodes are:



InputBody
The last child of the root of the input message. This name is an alias for
InputRoot.*[<].

For a description of how to use *, see [“Using anonymous field references”
on page 278.

InputRoot
The root of the input message.

InputProperties
The standard properties of the input message.

Environment
The structure that contains the current global environment variables that
are available to the node. Environment can be read and updated.

InputLocalEnvironment
The structure that contains the local environment variables for the message
passing through the node.

InputDestinationList
The structure that contains the local environment variables for the message
passing through the node. Use the correlation name InputDestinationList
for compatibility with earlier versions; if compatibility is not required, use
the preferred name InputLocalEnvironment

InputExceptionList
The structure that contains the exception list for the message passing
through the node.

OutputRoot
The root of the output message.

In a Compute node, the correlation name OutputBody is not valid.

OutputLocalEnvironment
The structure that contains the local environment variables that are sent
out from the node.

While this correlation name is always valid, it has meaning only when the
Compute Mode property of the Compute node indicates that the Compute
node is propagating the LocalEnvironment.

OutputDestinationList
The structure that contains the local environment variables that are sent
out from the node. Use the correlation name OutputDestinationList for
compatibility with earlier versions; if compatibility is not required, use the
preferred name OutputLocalEnvironment

OutputExceptionList
The structure that contains the exception list that the node is generating.

While this correlation name is always valid, it has meaning only when the
Compute Mode property of the Compute node indicates that the Compute
node is propagating the ExceptionList.

Predefined and self-defining messages
This topic describes predefined and self-defining messages.

Each message that flows through your system has a specific structure that is
meaningful to the applications that send or receive that message.
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WebSphere Message Broker refers to the structure as the message template. Message
template information comprises the message domain, message set, message type, and
physical format of the message. Together these values identify the structure of the
data that the message contains.

The message domain identifies the parser that is used to parse and write instances of
the message. Message set, message type, and physical format are optional, and are
used by model-driven parsers such as the MRM parser.

You can use:

* Messages that you have modeled using the workbench; these are referred to as
predefined messages. A model-driven parser requires predefined messages.

* Messages that can be parsed without a model; these are called self-defining
messages.

Predefined messages: When you create a message using the workbench, you
define the fields (Elements) in the message, along with any special field types that
you might need, and any specific values (Value Constraints) to which the fields
might be restricted.

Every message that you model in the workbench must be a member of a message
set. You can group related messages together in a message set: for example, request
and response messages for a bank account query can be defined in a single
message set.

When you deploy a message set to a broker, the definition of that message set is
sent by the Configuration Manager to the broker in a form appropriate to the
parser that is used to parse and write the message. The broker can manage
multiple message dictionaries simultaneously.

For information about the benefits of predefining messages, see

The [Video Rental sample|and the [Comma Separated Value (CSV) sample]
demonstrate how to model messages in XML, CWE, and TDS formats. The
[EDIFACT sample} [FIX sample} [SWIFT sample} and [X12 sample| provide message
sets for industry-standard message formats, which might be useful if you use any
of those formats. You can view samples only when you use the information center
that is integrated with the Message Broker Toolkit.

Self-defining messages: You can create and route messages that are self-defining.
The best example of a self-defining message is an XML document.

Self-defining messages can also be modeled using the workbench. However, you
do not have to deploy these message sets to the brokers that support those
message flows. See[Why model messages?}

The [Large Messaging sample} the |Airline Reservations sample} and several other
samples in the [Samples Gallery| use self-defining XML messages for the sake of
simplicity; they don’t require a message set. The |Coordinated Request Reply|
demonstrates how you can transform a message from self-defining XML to
a predefined binary format, and the [Data Warehouse sample| demonstrates how
you can extract information from an XML message and transform it into BLOB
format to store it in a database. You can view samples only when you use the
information center that is integrated with the Message Broker Toolkit.
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Parsers

A parser is a program that interprets the bit stream of an incoming message, and
creates an internal representation of the message in a tree structure. The parser also
regenerates a bit stream for an outgoing message from the internal message tree
representation.

A parser is invoked when the bit stream that represents an input message is
converted to the internal form that can be handled by the broker; this invocation of
the parser is known as parsing. The internal form, a logical tree structure, is
described in|“Logical tree structure” on page 55| The way in which the parser
interprets the bit stream is unique to that parser; therefore, the logical message tree
that is created from the bit stream varies from parser to parser.

Similarly, a parser is invoked when a logical tree that represents an output message
is converted into a bit stream; this invocation of the parser is known as writing.

The broker requires access to a parser for every message domain to which your
input messages and output messages belong. In addition, the broker requires a
parser for every identifiable message header that is included in the input or output
message. Parsers are invoked when required by the message flow.

Body parsers

WebSphere Message Broker provides built-in support for messages in the following
message domains by providing the message body parsers that are listed below:

+ MRM (“MRM parser and domain” on page 93)

+ XMLNSC, XMLNS, and XML (“XML parsers and domains” on page 76)
+ SOAP (“SOAP parser and domain” on page 73)

* DataObject (“DataObject parser and domain” on page 95)

* JMSMap and JMSStream (“JMS parsers and domains” on page 96)

+ MIME (“MIME parser and domain” on page 96)

+ BLOB (“BLOB parser and domain” on page 101)

+ IDOC (“IDOC parser and domain” on page 102)

See [“Which body parser should you use?” on page 71| for a discussion about which
message body parser to use under what circumstances.

You specify which message domain to use for your message at the place in the
message flow where parsing or writing is initiated.

¢ To parse a message bit stream, typically you set the Message Domain property of
the input node that receives the message. But, if you are initiating the parse
operation in ESQL, use the DOMAIN clause of the CREATE statement.

The message tree that is created is described in [“Message tree structure” on page|

The last child element of the Root element of the message tree takes the name of
the body parser that created the tree. For example, if the Message Domain
property was set to MRM, the last child element of Root is called MRM, which
indicates that the message tree is owned by the MRM parser.

* To write a message, the broker calls the owning body parser to create the
message bit stream from the message tree.
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Some body parsers are model-driven, which means that they use predefined
messages from a message set when parsing and writing. The MRM, SOAP,
DataObject, IDOC, and (optionally) XMLNSC parsers are model-driven parsers. To
use these parsers, messages must be modeled in a message set and deployed to the
broker from the Message Broker Toolkit.

Other body parsers are programmatic, which means that the messages that they
parse and write are self-defining messages, and no message set is required. See
[‘Predefined and self-defining messages” on page 67|

When you use a model-driven parser, you must also specify the Message Set and,
optionally, the Message Type and Message Format so that the parser can locate the
deployed message definition with which to guide the parsing or writing of the
message.

To parse a message bit stream, typically you set the Message Set, Message Type, and
Message Format properties of the input node that receives the message. Or, if you
are initiating the parse operation in ESQL, you use the SETTYPE, and FORMAT
clauses of the CREATE statement. This information is copied into the Properties
folder of the message tree.

To write a message, the broker calls the owning body parser to create the message
bit stream from the message tree. If the parser is a model-driven parser, it uses the
MessageSet, MessageType, and MessageFormat fields in the Properties folder.

Whether Message Type or Message Format are needed depends on the message
domain.

Even if the body parser is not model-driven, it is good practice to create and use a
message set in the Message Broker Toolkit because it simplifies the development of
your message flow applications, even though the message set is not deployed in
the broker runtime environment. See [Why model messages?| for information about
the advantages of creating a message set.

Header parsers

WebSphere Message Broker also provides parsers for the following message
headers, which your applications can include in input or output messages:

+ WMQ MQMD (“The MQMD parser” on page 1265)

+ WMQ MQMDE (“The MQMDE parser” on page 1266)

+ WMQ MQCFH (“The MQCFH parser” on page 1262)

+ WMQ MQCIH ({“The MQCIH parser” on page 1263)

+ WMQ MQDLH (“The MQDLH parser” on page 1264)

+ WMQ MOQITH ({“The MQIIH parser” on page 1264)

+ WMQ MQRFH (“The MQRFH parser” on page 1267)

+ WMQ MQRFH2 and MQRFH2C (“The MQRFH2 and MQRFH2C parsers” on|

+ WMQ MQRMH (“The MQRMH parser” on page 1267)

+ WMQ MQSAPH (“The MQSAPH parser” on page 1268)

+ WMQ MQWIH (“The MQWIH parser” on page 1268)

+ WMQ SMQ _BMH (“The SMQ BMH parser” on page 1269)

+ JMS header (Representation of messages across the JMS Transport)




e HTTP headers

All header parsers are programmatic and do not use a message set when parsing
or writing.

User-defined parsers

To parse or write message body data or headers that the supplied parsers do not
handle, you can create user-defined parsers that use the WebSphere Message
Broker user-defined parser programming interface.

Tip: No parser is provided for messages, or parts of messages, in the WMQ format
MQFMT_IMS_VAR_STRING. Data in this format is often preceded by an MQIIH
header (format MQFMT_IMS). WebSphere Message Broker treats such data as a
BLOB message. If you change the CodedCharSetld or the encoding of such a
message in a message flow, the MQFMT_IMS_VAR_STRING data is not converted,
and the message descriptor or preceding header does not correctly describe
that part of the message. If you need the data in these messages to be
converted, use the MRM domain and create a message set to model the
message content, or provide a user-defined parser.

Which body parser should you use?
The characteristics of the messages that your applications exchange indicate which
body parser you must use.

WebSphere Message Broker provides a range of message parsers. Each parser
processes either message body data for messages in a particular message domain
(for example, XML), or particular message headers (for example, the MQMD).

Review the messages that your applications send to the broker, and determine to
which message domain the message body data belongs, using the following criteria
as a guide.

If your application data uses SOAP-based Web services, including SOAP with
Attachments (MIME) or MTOM
Use the SOAP domain. The SOAP domain has built-in support for
WS-Addressing and WS-Security standards.

If your application data is in XML format other than SOAP
The domain that you use depends on the nature of the XML documents
and the processing that you want to perform. See [“Which XML parser]
lshould you use?” on page 72|

If your application data comes from a C or COBOL application, or consists of
fixed-format binary data
Use the MRM domain with a Custom Wire Format (CWF) physical format.

If your application data consists of formatted text, perhaps with field content
that is identified by tags, or separated by specific delimiters, or both
Use the MRM domain with a Tagged/Delimited String (TDS) physical
format.

If your application data is created using the JMS API
The domain that you use depends on the type of the JMS message. For a
full description of JMS message processing, see [MS message as input}

If your application data is from a WebSphere Adapter such as the adapters for
SAP, PeopleSoft, or Siebel
Use the DataObject domain.
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If your application data is in SAP text IDoc format, such as those exported using
the WebSphere MQ Link for R3
Use the MRM domain with a Tagged/Delimited String (TDS) physical
format.

If your application data is in MIME format other than SOAP with Attachments
(for example, RosettaNet)
Use the MIME domain. If the message is multipart MIME, you might need
to parse specific parts of the message with other parsers. For example, you
might use the XMLNSC parser to parse the XML content of a RosettaNet
message.

If you do not know, or do not need to know, the content of your application
data  Use the BLOB domain.

Which XML parser should you use?:

If your messages are general purpose XML documents, you can use one of the
dedicated XML domains (XMLNSC or XMLNS) to parse the message, or you can
use the MRM domain to parse the message.

Note: Although SOAP XML can be parsed using any namespace-aware XML
parser, use the dedicated SOAP domain to parse SOAP XML because the
SOAP domain provides full support for SOAP with Attachments, and
standards such as WS-Addressing and WS-Security.

Note: The XML domain is deprecated. Do not use it for developing new message
flows. The XML domain still works with existing message flows.

Which XML parser you choose depends on the nature of your XML messages, and
the transformation logic that you want to use. The differentiating features of each
domain are:

¢ The XMLNSC parser has a new architecture that gives significant performance
improvements over the XMLNS and XML parsers.

* The XMLNSC parser can be used with or without an XML Schema that is
generated from a message set. Using a message set with the XMLNSC parser
allows the parser to operate in validating mode which provides the following
capabilities:

— XML Schema 1.0 compliant validation when parsing and writing.

— The XML Schema indicates the real data type of a field in the message instead
of always treating the field as a character string.

— Base64 binary data can be automatically decoded.

* The MRM parser must be used with a message dictionary that is generated from
a message set. This message dictionary enables the MRM parser to provide the
following capabilities: For example:

— Validation against the dictionary when parsing and writing. Note that
validation is not XML Schema 1.0 compliant.

— The dictionary indicates the real data type of a field in the message instead of
always treating the field as a character string.

— Base64 binary data can be automatically decoded.
* The XMLNS parser is programmatic and does not use a model when parsing.
This means that:
— All data in an XML message is treated as character strings.
— Validation is not possible when parsing and writing.



¢ The MRM parser uses information from the XML physical format of a message
set to simplify the task of creating transformation logic:

— Date and time information can be extracted from a data value using a
specified format string.

— When creating output messages, the MRM parser can automatically generate
the XML declaration, and other XML constraints.

* The XMLNSC and XMLNS parsers do not use XML physical format information
from a message set. Transformation logic must explicitly create all constructs in
an output message.

¢ The MRM parser discards some parts of an XML message when parsing; for
example, white space formatting, XML comments, XML processing instructions,
and inline DTDs. If you use this parser, you cannot create these constructs when
building an output message.

¢ The XMLNSC parser, by default, discards white space formatting, XML
comments, XML processing instructions, and inline DTDs. However, options are
provided to preserve all of these constructs, except inline DTDs. You can create
them all, except inline DTDs, when constructing an output message.

¢ The XMLNS parser preserves all parts of an XML document, including white
space formatting. You can create all XML constructs when constructing an
output message.

¢ The XMLNSC and MRM parsers build compact message trees that use fewer
syntax elements than the XMLNS parser for attributes and simple elements. This
makes these parsers more suitable than the XMLNS parser for parsing very large
XML messages.

* The XMLNS parser builds a message tree that conforms more closely than the
XMLNSC or MRM parsers to the XML Data Model. You might want to use this
parser if you are using certain XPath expressions to access the message tree, and
the relative position of parent and child nodes is important, or if you are
accessing text nodes directly.

Tip: If performance is critical, use the XMLNSC domain.

Tip: If you need to validate the content and values in XML messages, use the
XMLNSC domain.

Tip: If you need to preserve formatting in XML messages on output, use the
XMLNSC domain with the option to retain mixed content.

Tip: If you require message tree to conform as closely as possible to the XML data
model, perhaps because you are using certain XPath expressions to access the
message tree, use the XMLNS domain.

Tip: If you are taking non-XML data that has been parsed by the CWF or TDS
formats of the MRM domain, and merely transforming the data to the
equivalent XML, use the MRM domain. This can be achieved by adding an
XML physical format to the message set with default values, and changing
the Message Format in the Properties folder of the message tree.

SOAP parser and domain
You can use the SOAP parser to create a common WSDL-based logical tree format
for working with Web services, independent of the physical bitstream format.

Use the SOAP parser in conjunction with the SOAP nodes in your message flow.
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Messages in the SOAP domain are processed by the SOAP parser. The SOAP
parser creates a common logical tree representation for all SOAP-based Web
services and validates the message against a WSDL definition. If a runtime
message is not allowed by the WSDL, an exception is thrown, otherwise the
portType and operation names from the WSDL are saved in the logical tree.

The SOAP domain offers WS-* processing, together with a canonical tree shape that
is independent of the wire format (XML or MIME).

The standards supported are:

« WSDL 1.1

* SOAP 1.1 and 1.2

« MIME 1.0

* Message Transmission Optimization Mechanism (MTOM) 1.0

A WSDL 1.1 definition must be deployed to describe the Web service messages that
the SOAP domain needs to parse and write at runtime. The SOAP parser is,
therefore, always model-driven. The bitstream format for these runtime messages
can be SOAP 1.1 or SOAP 1.2, optionally wrapped by MIME as an SwA (SOAP
with Attachments) or MTOM message.

When a message set that supports the SOAP domain is added to a broker archive
(bar) file, XML Schemas are created automatically from the message definition files
in the message set, and any WSDL files in the message set are added to the bar
file. The WSDL and XML Schema are deployed to the broker and used by the
SOAP parser.

If you want the SOAP domain to parse your SOAP Web service, you must:
1. Create a new message set, or locate an existing message set.

2. Ensure that either the message set has its Default message domain project set to
SOAP, or the SOAP check box (under Supported message domains) is selected, to
indicate that the message set supports the SOAP domain.

3. Import your WSDL file to create a message definition file. The WSDL is also
added to the message set. Message definition files for the SOAP envelope and
the SOAP logical tree are also added to the message set automatically.

4. Add the message set to a broker archive (bar) file, which generates the required
XML Schema and WSDL in a file with extension .xsdzip, and deploy the bar
file to the broker.

5. If you associate your WSDL with a SOAP node in your message flow, the
Message Set property is automatically set in the node. The Message domain
property is always pre-selected as SOAP.

Tip: The SOAP parser invokes the XMLNSC parser to parse and validate the XML
content of the SOAP Web service. See ["XMLNSC parser” on page 80|

SOAP message details:

A SOAP message consists of an <Envelope>, which is the root element in every
SOAP message, and this contains two child elements, an optional <Header> and a
mandatory <Body>.

If the SOAP message has attachments, the ‘envelope’ is wrapped by MIME, or is
encoded as MTOM.



For further information on the structure of a SOAP message, see |“The structure of]
[a SOAP message” on page 565

SOATP tree overview:

This tree format allows you to access the key parts of the SOAP message in a
convenient way.

This is a diagrammatic representation of the SOAP tree parser:

Root
[ [ I
Properties Transport headers SOAP
| | |
Set=myMS Type Format ContentType=top-level C-T
Context Header Body Attachment
1
—_———— 1 —_————
—— port | | |
—— portType fred bill harry IDg ID, Dy
operation (subtree) (subtree) (subtree) : a IID e IID
—— operationType —l— 0 0
—— SOAP_Verson=1.1/1.2 | |
—— Namespace
mesp MIME_Headers BLOB
—— XMLDeclaration Content-Type= i
Content-Transfer-Encoding=
—— Envelope
Content-ld=
[Header] BLOB(=X"...)
Body
—— MIME_Headers
Content-ld=
Content-Type=
boundary=
—— type==

The SOAP tree contains the following elements:

SOAP.Header
Contains the SOAP header blocks (children of Envelope.Header)

SOAP.Body
Contains the SOAP payload (children of Envelope.Body )

The shape of the Body subtree depends on the WSDL style and a child of
the Body subtree is generated in such a way that an rpc-enabled message
model generated on WSDL import, correctly matches the shape of the tree
at runtime.

SOAP.Attachment
Contains attachments for an SwA message in their non encoded format.
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Note that attachments for an MTOM message are represented inline as part of
the SOAP content in a base 64 representation.

SOAP.Context
Contains the following WSDL-derived information, which is set by the
SOAP parser on input:
e Port
* PortType
* Operation
* OperationType; one of RequestResponse or Onelay
The SOAP parser does not throw an exception if it does not recognize

the operation. However, you can configure the SOAPInput node to reject
or accept unknown operations as required.

The SOAP parser also saves the following information under Context:

* SOAP Version , one of 1.1 or 1.2

e XmlDeclaration

* Envelope, that is the envelope, body, and — if present — header from the
input message.

* MIME_Headers, that is the MIME headers associated with the SOAP part
of the input message if it arrived as MIME. Most MIME headers have
simple string values but the children of the Content-Type header are
further broken out into separate fields for each Content-Type attribute or
parameter.

The SOAP part is identified by the Content-Type start parameter or, by
default, is the first part of a SOAP with Attachments (SwA) document.

XML parsers and domains
You can use the XML domains that are described in this topic to parse and write
messages that conform to the W3C XML standard.

The term XML domains refers to a group of three WebSphere Message Broker
domains that are used to parse XML documents.

When reading an XML message, the parser that is associated with the domain
builds a message tree from the input bit stream. The input bit stream must be a
well-formed XML document that conforms to the W3C XML Specification (version
1.0 or 1.1).

When writing a message, the parser creates an XML bit stream from a message
tree.

The domains have different characteristics, and guidance about which domain to
choose is provided by [“Which XML parser should you use?” on page 72|

XMLNSC domain
The XMLNSC domain is the recommended domain for parsing all general
purpose XML messages, including those messages that use XML
namespaces. See |"XMLNSC parser” on page 80,

* The XMLNSC parser has an architecture that results in ultra-high
performance when parsing all kinds of XML.

¢ The XMLNSC parser reduces the amount of memory used by the logical
message tree that is created from the parsed message. The default
behavior of the parser is to discard non-significant white space and



mixed content, comments, processing instructions, and embedded DTDs;
however controls are provided to retain mixed content, comments, and
processing instructions, if required.

¢ The XMLNSC parser can operate as a model-driven parser, and can
validate XML messages against XML Schemas generated from a message
set, to ensure that your XML messages are correct.

XMLNS domain
If the XMLNSC domain does not meet your requirements, use the
alternative namespace-aware domain and parser. See ["XMLNS parser” onl|
|o age 89,

XML domain
The XML domain is not namespace-aware. It is deprecated and should not
be used to develop new message flows. See ["XML parser” on page 93/

The MRM domain also provides XML parsing and writing facilities. For guidance
on when you might use MRM XML instead of one of the XML parsers, see
[XML parser should you use?” on page 72)

By default, the three XML parsers are programmatic parsers and do not use a
message set at run time when parsing and writing. However, the XMLNSC parser
can operate as a model-driven parser and can validate XML messages for
correctness against XML Schemas generated from a message set. See
[validation” on page 84

When you use the XMLNS or XML parsers, or the XMLNSC parser without a
message set, it is still good practice to create and use a message set in the Message
Broker Toolkit; this simplifies the development of your message flow applications,
even though the message set is not deployed to the broker run time.

For the advantages of creating a message set, see[Why model messages?|

The XML parsers are on-demand parsers. For more information, see
[demand” on page 1229|

The information that is provided with WebSphere Message Broker provides a
summary of XML terminology, concepts, and message constructs. These aspects are
important when you use XML messages in your message flows.

Tip: For more detailed information about XML see the [World Wide Web|
[Consortium (W3C)| Web site.

Example XML message parsing: A simple XML message might take the following
form:

<?xml version="1.0" encoding="UTF-8" standalone="no"?>
<IDOCTYPE Envelope
PUBLIC "http://www.ibm.com/dtds" "example.dtd"
[<!ENTITY Example_ID "ST_TimeoutNodes Timeout Request Input Test Message">]
>
<Envelope version="1.0">

<Header>

<Example>&Example_ID;</Example>

<l-- This is a comment -->

</Header>

<Body version="1.0">

<Element01>Value@l</Element01>

<Element02/>

<ETement03>
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<Repeated>ValueA</Repeated>
<Repeated>ValueB</Repeated>
</Element03>
<Element04><P>This is <B>bold</B> text</P></Element04>
</Body>
</Envelope>

The following sections show the output created by the Trace node when the above
message has been parsed in the XMLNS and XMLNSC parsers. They demonstrate
the differences in the internal structures that are used to represent the data as it is
processed by the broker.

Example XML Message parsed in the XMLNS domain: In the following example, the
white space elements within the tree are present because of the space, tab, and line
breaks that format the original XML document; for clarity, the actual characters in
the trace have been replaced with "WhiteSpace”. White space within an XML
element does have business meaning, and is represented using the Content syntax
element. The XmlIDecl, DTD, and comments, are represented in the XML domain
using explicit syntax elements with specific field types.

(0x01000010) : XMLNS = (
(0x05000018) : XML = (
(0x06000011): = '1.0'
(0x06000012) : = 'UTF-8'
(0x06000014): = 'no'
)
(0x06000002) : = 'WhiteSpace'

(0x05000020) :Envelope
(0x06000004): = 'http://www.ibm.com/dtds"

(0x06000008) : = 'example.dtd'
(0x05000021): = (
(0x05000011) :Example_ID = (
(0x06000041): = 'ST_TimeoutNodes Timeout Request Input Test Message'
)
)
)
(0x06000002) : = 'WhiteSpace'
(0x01000000) :Envelope = (
(6x03000000) :version = '1.0'
(6x02000000) : = 'WhiteSpace'
(0x01000000) :Header = (
(0x02000000) : = 'WhiteSpace'
(0x01000000) :Example =
(0x06000020) : = 'Example_ID'
(0x02000000) : = 'ST_TimeoutNodes Timeout Request Input Test Message'
(0x06000021) : = 'Example_ID'
)
(0x02000000) : = 'WhiteSpace'
(0x06000018) : = ' This is a comment '
(0x02000000) : = 'WhiteSpace'
)
(0x02000000) : = 'WhiteSpace'
(6x01000000) :Body = (
(0x03000000) :version = '1.0'
(0x02000000) : = 'WhiteSpace'

(0x01000000) :Element01
(0x02000000): = 'Value0O1'

)
(0x02000000) : = 'WhiteSpace'
(0x01000000) :Element02 =
(0x62000000) : = 'WhiteSpace'
(0x01000000) :E1ement03 =

(0x02000000) : = 'WhiteSpace'

(0x01000000) : Repeated
(0x02000000): = 'ValueA'



)

(0x02000000) : "WhiteSpace'

(0x01000000) : Repeated = (
(0x02000000): = 'ValueB'

)
(0x02000000) : = 'WhiteSpace'
)
(0x02000000) : = 'WhiteSpace'
(0x01000000) :Element04 = (
(0x01000000) :P = (
(0x02000000) : 'This is '

(0x01000000) :B
(0x02000000) : = 'bold'

)
(0x02000000) : = ' text'
)
)
(0x02000000) : = 'WhiteSpace'
)
(0x02000000) : = 'WhiteSpace'

)

Example XML Message parsed in the XMLNSC domain: The following trace shows
the elements that are created to represent the same XML structure within the
compact XMLNSC parser in its default mode. In this mode, the compact parser
does not retain comments, processing instructions, or mixed text.

The example illustrates the significant saving in the number of syntax elements
that are used to represent the same business content of the example XML message
when using the compact parser.

By not retaining mixed text, all of the white space elements that have no business
data content are no longer taking any runtime footprint in the broker message tree.
However, the mixed text in ETement04.P is also discarded, and only the value of
the child folder, Element04.P.B, is held in the tree; the text This is and text in P is
discarded. This type of XML structure is not typically associated with business
data formats; therefore, use of the compact XMLNSC parser is typically desirable.
However, if you need this type of processing, either do not use the XMLNSC
parser, or use it with Retain mixed text mode enabled.

The handling of the XML declaration is also different in the XMLNSC parser. The
version, encoding, and standalone attributes are held as children of the
XmlDeclaration, rather than as elements with a particular field type.

(0x01000000) : XMLNSC = (
(0x01000400) : Xm1Declaration = (

(0x03000100) :Version 1.0
(6x03000100) :Encoding

(0x03000100) :StandAlone

mnom 1
=
=
v
©

)

(0x01000000) :Envelope
(0x03000100) :version
(0x01000000) :Header

(0x03000000) : Example

{

'ST_TimeoutNodes Timeout Request Input Test Message'

)

(0x01000000) :Body = (
(0x03000100) :version
(0x03000000) :Element01
(0x01000000) :ETement02
(0x01000000) :ETement03

(0x03000000) : Repeated
(6x03000000) :Repeated

'1.0'
'"Value01'

(
'"ValueA'

'ValueB'

)
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(0x01000000) : ETement04 = (
(0x01000000) :P = (
(0x03000000) :B = 'bold’
)
)
)

The following samples use the XML parser to process messages:

* |Coordinated Request Reply sample|

+ [Large Messaging sample]

+ [Message Routing sample]

You can view samples only when you use the information center that is integrated
with the Message Broker Toolkit.

Some predefined message models are supplied with the Message Broker Toolkit
and can be imported using the New Message Definition File wizard and selecting
the IBM-supplied message option. See [[BM supplied messages that you can import}

XMLNSC parser:

The XMLNSC parser is a flexible, general-purpose XML parser that offers high
performance XML parsing and optional XML Schema validation.

The XMLNSC parser has a range of options that make it suitable for most XML
processing requirements. Some of these features are only available in the XMLNSC
parser.

Although the XMLNSC parser is capable of parsing XML documents without an
XML Schema, extra features of the parser become available when it operates in
model-driven mode. In this mode, the XMLNSC parser is guided by an XML
Schema, which describes the shape of the message tree (the logical model). XML
Schemas are created automatically from the content of a message set when it is
added to a broker archive (bar) file. The XML Schema are deployed to the broker
and used by the XMLNSC parser to validate your XML messages. Validation is
fully compliant with the XML Schema 1.0 specification.

For guidance on when to use the XMLNSC domain and parser, see ["Which XML
[parser should you use?” on page 72

If you want the XMLNSC domain to parse a particular message, you must select
Message Domain as XMLNSC on the appropriate node in the message flow.
Additionally, if you want the XMLNSC parser to validate your messages, you must
form the additional steps that are described in ["XMLNSC validation” on page]
84

Features of the XMLNSC parser

Feature Present Description

Namespace support Yes Namespace information is
used if it is present. No user
configuration is required. See
“Namespace support” on]

page 399.|

On-demand parsing Yes See [“Parsing on demand” on|

|Eage 1229.|
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Feature Present Description

Compact message tree Yes Less memory is used when
building a message tree from
an XML document. See
“Manipulating messages in|
the XMLNSC domain” on|

page 350.|

Opaque parsing Yes One or more elements can be
parsed opaquely. See
“XMLNSC opaque parsing”|

on page 83.|

Ultra high performance Yes The architecture of the
XMLNSC parser means that
it uses significantly less CPU
than the other XML parsers.

Validation Yes See table below.

Inline DTD support Partial Inline DTDs are processed
but discarded. See ['XMLNS(
[DTD support” on page 88|

XML Data Model compliance | Partial The compact nature of the
message tree means that
certain XPath queries are not
supported.

The following features are only available when message validation is enabled. See
[“XMLNSC validation” on page 84

Feature Description

Message validation Standards-compliant XML Schema 1.0
validation.

xsimil support Sets the value of an element to NULL if it

has xsimnil="true” and the XML Schema
indicates that it is nillable.

Default value support Sets the value of an empty element, or
missing attribute, to its default value,
according to XML Schema rules.

Use correct simple types Can use the simple types that are defined in
the XML Schema when building the message
tree.

Base64 support Converts base64 data to BLOB when
parsing. Converts BLOB to base64 when
writing.

If you specify the SOAP domain as the owner of a SOAP Web Services message,
the SOAP parser invokes the XMLNSC parser in model-driven mode to parse the
XML content of the SOAP message.

If you specify the DataObject domain as the owner of a WebSphere Adapter
message, and the message is written to a destination other than a WebSphere
Adapter, the DataObject parser invokes the XMLNSC parser to write the message
as XML.

XMLNSC empty elements and null values:
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Empty elements and null values occur frequently in XML documents.

A robust message flow must be able to recognise and handle empty elements and
null values. Similarly, elements in a message tree might have a NULL value, an
empty value, or no value at all. This topic explains the parsing and writing of
these values by the XMLNSC domain. For advice on good ESQL or Java coding
practices see [“Null handling” on page 103 |

Parsing
XML input parsed by Value of ‘element’ in
Description XMLNSC message tree
Empty element value <element/> Empty string
Empty element value <element></element> Empty string
Folder with child elements <element><childElement/ No value
></element>
Nil element value <element xsi:nil="true" /> Empty string or NULL
Note: Which value depends
on whether the element
definition is ‘nillable” in the
XML Schema

Note that both forms of an empty element result in the same value in the message
tree.

Writing
Value of ‘element’ in XML output from XMLNSC
Description message tree parser
Empty element value Empty string <element/>
Null element value NULL <element/>
Folder with child elements No value <element><childElement/
></element>

Empty elements
An empty element can take two forms in an XML document:
- <element/>

- <element></element>

The XMLNSC parser treats both forms in the same way. The element is added to
the message tree with a value of “” (the empty string).

When a message tree is output by the XMLNSC parser, it always uses the first
form for elements that have a value of “” (the empty string).

Elements with an xsi:nil attribute

The following behavior is available only when validation is enabled in the message
flow.



If an element in the input document has an xsi:nil attribute with the value ‘true’,
and the ‘nillable” property of the element definition in the XML schema is set to
‘true’, the XMLNSC parser sets the value of the message tree element to NULL.

When a message tree is output by the XMLNSC parser, if the value of the element
is NULL and the element has no child elements, the element is written as
<element/>; but, if the element has an xsi:nil attribute, it is written exactly like any
other attribute.

Note that the XMLNSC parser only outputs xsi:nil attributes that are already in the
messsage tree. It does not automatically output xsi:nil attributes for all message
tree elements that have a NULL value and are 'nillable’.

XMLNSC opaque parsing:
Opaque parsing is a performance feature that is offered by the XMLNSC domain.

If you are designing a message flow and you know that certain elements in a
message are never referenced by the message flow, specify that these elements
should be parsed opaquely. This reduces the costs of parsing and writing the
message, and might improve performance in other parts of the message flow.

Use the property Opaque Elements on the Parser options page of the relevant
message flow node to specify the elements that you want to be parsed opaquely.
This property specifies a list of element names. If an element in the input XML
message is named in this list, the element is parsed as a single string.

An opaque element cannot be queried like an ordinary element; its value is the
segment of the XML bit stream that belongs to the element, and it has no child
elements in the message tree, even though it can represent a large subtree in the
XML document.

When an opaque element is serialized, the value of the element is copied directly

into the output bit stream. The string is converted to the correct code page, but no
other changes are made. Because this might produce a bit stream that is not valid

XML, some care is required.

An element should not be parsed opaquely in any of the following cases:
* The message flow needs to access one of its child elements.

* The message flow changes the namespace prefix in a way that affects the opaque
element or one of its child elements and the element is to be copied to the
output bit stream.

* The element, or any child element, contains a reference to an internal entity that
is defined in an inline DTD and the element is to be copied to the output bit
stream.

e The element contains child attributes that have default values that are defined in
an inline DTD and the element is to be copied to the output bit stream.

Make sure that you check the above points before you specify an element for
opaque parsing.

There are some drawbacks to using opaque parsing. When it is enabled, some
parts of the message are never parsed. This might allow XML that is either badly
formed or not valid to pass through the message flow without being detected. For
this reason, if you enable validation, you cannot use opaque parsing.
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The XMLNS domain offers a more limited opaque parsing facility, but this is
provided only to support existing applications. New message flows should use the
XMLNSC domain for opaque parsing.

Specifying opaque elements for the XMLNSC parser:

Specify an element as an opaque element so that its content is ignored by the
XMLNSC parser.

To specify the elements that are to be skipped by the XMLNSC parser:

1. Right-click the selected message flow node and click Properties and select
Parser Options.

2. At the bottom of the XMLNSC Parser Options panel, is an area that lists the
elements that have already been selected as opaque elements. Click Add... to
add an element to this list. A new pane Add Opaque elements Entry opens.

3. In the Add Opaque elements Entry pane, specify the new XML element that
you want to be opaquely passed. Each opaque element must be specified as an
ESQL element name or an XPath expression of the form //prefix:name (or
//name, if your input document does not contain namespaces).

Note: A prefix is used rather than a full URI to identify the namespace; see
[“XPath namespace support” on page 418|for further information.

Click Edit... or Delete... to edit the list of opaque elements.
XMLNSC validation:

The XMLNSC parser offers high-performance, standards-compliant XML Schema
validation at any point in a message flow.

Validation of the input XML message or the message tree is performed against the
XML Schemas that are deployed.

Validation is not the same as parsing. When parsing, the XMLNSC parser always
checks that the input document is well-formed XML, according to the XML
specification. If validation is enabled, the XMLNSC parser also checks that the
XML document obeys the rules in the XML Schema.

Enabling XML Schema validation in a message flow

You must complete the following tasks to construct a message flow that validates
an XML document in accordance with an XML Schema:

* Enable validation at the appropriate point in the message flow. This is typically
achieved by setting the Validate property of the appropriate node to Content or
Content and Value. See [“Validating messages” on page 156

* Ensure that all required XML Schema files are deployed. See ["Deploying XMI]
below.

* Specify the message set in which the XML Schemas are deployed. Typically, you
specify the message set by selecting the Message Set property on the node.

Deploying XML Schemas

All XML Schemas that are used by WebSphere Message Broker must be created as
message definition files within a message set.



To create and deploy a message set for XML Schema validation:
1. Create a new message set or locate an existing message set.

2. Ensure that the message set has its Default message domain set to XMLNSC, or that
the XMLNSC check box under Supported message domains is selected, to indicate
that the message set supports the XMLNSC domain.

3. Create a message definition file in the message set to represent your message. If
you have an existing XML Schema or DTD that describes your message, you
can import it. You can repeat this step for each message that you want to
validate.

4. Add the message set to a broker archive (bar) file, which generates the required
XML Schema in a file with extension .xsdzip, and deploy the bar file to the
broker.

Standards compliant validation
XMLNSC validation complies fully with XML Schema v1.0 as defined in the

specifications that are available at|http:// www.w3.org/TR/xmlschema-1/ | and
lhttp: / /www.w3.org/TR/xmlschema-2/| with the following minor exceptions:

* Any floating point value that is smaller than 10E-43 is treated as zero.

* Any member of a group or complex type, that has both minOccurs > 1024 and
maxQOccurs > 1024, is validated as if minOccurs = 0 and maxOccurs is
unbounded.

Validating XML v1.1 documents

You can validate documents that conform to the XML v1.1 specification, but
support is limited by the fact that the XML Schema v1.0 documents must conform
to XML v1.0.

As an example, you cannot always declare an XML v1.1 tag name in XML Schema
v1.0. This limitation is not imposed by the XMLNSC parser implementation; it is a
limitation of XML Schema v1.0.

Interpreting validation errors

A validation error is an error that results when the XML document breaks the rules
that are defined in the XML schema. The XML Schema standard specifies exactly
what these rules are, and how they should be applied. Validation errors that the
XMLNSC parser issues contain information that links the error to the XML Schema
rule that has been violated.

All validation errors are reported in BIP5025 or BIP5026 messages. Both messages
begin with text in the following form:

XML schema validation error '[cvc-error key: error description]'

Examples:

'cvc-minInclusive-valid: The value "2" is not valid with respect to the minInclusive facet
with value "3" for type "po:itemCountType".'

'cvc-complex-type.2.4.a: Expecting element with Tocal name "numItems" but saw "totalValue".

To find the XML Schema rule that has been violated, open the XML Schema
specification and search for the error key.
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Example 1: Open fhttp:/ /www.w3.org/TR/xmlschema-1/| and search for
‘cve-minInclusive-valid’. Follow the link to the XML Schema rules for the
minlnclusive facet.

Example 2: Open |http:/ /www.w3.org/TR/xmlschema-1/| and search for
‘cvc-complex-type’. Follow the link to the XML Schema rules for validating the
content of a complex type. In this case, the error key contains extra information.
The ‘2.4.a" refers to the exact sub-rule that was violated. It should not be included
when searching for the rule.

If the XML Schema specification does not provide enough information, you can
find more information using a search engine. The XML Schema standard is very
widely used, and many online tutorials and other resources are available.

XMLNSC message tree options:

The XMLNSC options that are described below affect the parsing of an XML
document by the XMLNSC parser. They have no effect on XML output.

Retain Mixed Content

Mixed content is XML text which occurs between elements.

<parent>
<childElement1>Not mixed content</childElementl>
This text is mixed content
<childElement2>Not mixed content</childElement2>
</parent>

By default, the XMLNSC parser discards all mixed content. Mixed content is
retained in the message tree if you select Retain mixed content in the Parser options
page of the input node. For further information, see "Handling mixed text” in
[“Manipulating messages in the XMLNSC domain” on page 350}

Retain Comments

By default, the XMLNSC parser discards all comments in the input XML.
Comments are retained in the message tree if you select Retain comments in the
Parser options page of the input node. For further information, see "Handling
comments’ in [“Manipulating messages in the XMLNSC domain” on page 350}

Retain Processing Instructions

By default, the XMLNSC parser discards all processing instructions in the input
XML. Processing instructions are retained in the message tree if you select Retain
processing instructions in the Parser options page of the input node. For further
information, see "Handling processing instructions’ in [“Manipulating messages in|
[the XMLNSC domain” on page 350}

Build tree using XML Schema data types

By default, the XMLNSC parser uses the CHARACTER data type for all element
and attribute values that the parser creates in the message tree. However, if you
are using the XMLNSC parser to validate the XML document, you can select Build
tree using XML Schema data types in the Parser options page of the input node. This
causes element and attribute values to be cast to the message broker data type that
most closely matches their XML Schema simple type. The exact mapping between


http://www.w3.org/TR/xmlschema-1/
http://www.w3.org/TR/xmlschema-1/

XML schema types and message broker types can be found in [“XMLNSC data

XMLNSC data types:

The table shows the mapping between XML Schema simple types and the data

types that the XMLNSC parser uses in the message tree.

XML Schema type

Data type in message tree

anyURI CHARACTER
base64Binary BLOB
Boolean BOOLEAN
Byte INTEGER
Date DATE
dateTime TIMESTAMP
Decimal DECIMAL
Double FLOAT
duration INTERVAL
ENTITIES List of CHARACTER
ENTITY STRING

Float FLOAT

gDay DATE
gMonth DATE
gMonthDay DATE

gYear DATE
gYearMonth DATE
hexBinary BLOB

1D CHARACTER
IDREF CHARACTER
IDREFS List of CHARACTER
int INTEGER
Integer DECIMAL
language CHARACTER
Long INTEGER
Name CHARACTER
NCName CHARACTER
negativelnteger DECIMAL
NMTOKEN CHARACTER
NMTOKENS List of CHARACTER
nonNegativelnteger DECIMAL
nonPositivelnteger DECIMAL
normalizedString CHARACTER
NOTATION CHARACTER
positivelnteger DECIMAL
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XML Schema type Data type in message tree
Qname CHARACTER

short INTEGER

string CHARACTER

Time DATETIME

Token CHARACTER
unsignedByte INTEGER

unsignedInt INTEGER

unsignedLong DECIMAL

unsignedShort INTEGER

Note: Base64 decoding is automatically performed by the XMLNSC parser.
List types

In the message tree, a list type is represented as a parent node with an anonymous
child node for each list item. This allows repeating lists to be handled without any
loss of information.

If a list element repeats, the occurrences appear as siblings of one another, and
each occurrence has its own set of child nodes representing its own list items.

XMLNSC DTD support:
The input XML message might contain an inline DTD.
Parsing

If the input XML document has an inline DTD, the XMLNSC parser reads and uses
information in the DTD while parsing, but does not add the DTD information to
the message tree.

Internal entity definitions in the DTD are used to automatically expand entity
references that are encountered in the body of the document.

Attributes that are missing from the input document are automatically supplied
with the default value specified in the DTD.

The XMLNSC parser never adds the DTD to the message tree because the
information that it contains has already been used during the parse. This behavior
keeps the message tree compact and reduces CPU usage, and means that the
XMLNSC parser does not always produce exactly the same document as it parsed.
However, the business meaning of the output document is not altered.

If these restrictions are a problem, the XMLNS domain and parser provide full
%Jport for parsing and writing of the DTD. See [“XMLNS DTD support” on page

Writing

The XMLNSC parser can output a DTD that contains entity definitions only. This
behavior allows the XMLNSC parser to be used for writing out XML documents



that use internal entities (the most common reason for using a DTD). See
[“Manipulating messages in the XMLNSC domain” on page 350| for further details.

External DTDs

No support is offered for external DTDs

XMLNS parser:

The XMLNS parser is a flexible, general-purpose XML parser.

The XMLNS parser is not model-driven and does not use an XML Schema when
parsing XML documents.

For guidance on when to use the XMLNS domain and parser, see ["Which XM
[parser should you use?” on page 72

If you want the XMLNS domain to parse a particular message, you must select
Message Domain as XMLNS on the appropriate node in the message flow.

Features of the XMLNS parser

Feature Present Description

Namespace support Yes Namespace information is
used if it is present. No user
configuration is required. See
“Namespace support” on|

page 399.|

On-demand parsing Yes See [“Parsing on demand” on|

lpage 1229

Compact message tree No

Opaque parsing Partial Limited support from ESQL
only for parsing a single
element opaquely. See
“XMLNS opaque parsing” on|
page 90,

Ultra high performance No

Validation No

Inline DTD support Yes Inline DTDs are processed
and retained in the message
tree. See [ XMLNS DTD]
lsupport” on page 91

XML Data Model compliance | Yes The resultant message tree
conforms to the XML Data
Model.

XMLNS empty elements and null values:
Empty elements and null values occur frequently in XML documents.
A robust message flow must be able to recognise and handle empty elements and

null values. Similarly, elements in a message tree might have a NULL value, an
empty value, or no value at all. This topic explains the parsing and writing of
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these values by the XMLNS domain. For advice on good ESQL or Java coding

practices see [“Null handling” on page 103

Parsing
XML input parsed by Value of ‘element’ in
Description XMLNS message tree
Empty element value <element/> Empty string
Empty element value <element></element> Empty string

Folder with child elements

<element><childElement/
></element>

No value

Nil element value

<element xsi:nil="true" />

Empty string

Note that both forms of an empty element result in the same value in the message

tree.

Note also that a NULL value is never put into the message tree by the XMLNS

parser.
Writing

Value of ‘element’ in XML output from XMLNS
Description message tree parser
Empty element value Empty string <element/>
Null element value NULL <element/>
Folder with child elements No value <element><childElement/

></element>

Empty elements

An empty element can take two forms in an XML document:

- <element/>
- <element></element>

The XMLNS parser treats both forms in the same way. The element is added to the
message tree with a value of “” (the empty string).

When a message tree is output by the XMLNS parser, it always uses the first form
for elements that have a value of “” (the empty string).

Elements with an xsi:nil attribute

The XMLNS parser treats the xsi:nil attribute exactly like any other attribute. When
xsimil is encountered while parsing, it does not set the value of the parent element
to NULL. If you require this behavior you should use the XMLNSC parser. When
writing a message tree, if an xsi:nil attribute exists it will be output in the same
way as any other attribute.

XMLNS opaque parsing:

Opaque parsing is a performance feature that is offered by the XMLNS domain.
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XMLNS opaque parsing has been superseded by the opaque parsing feature of the
XMLNSC domain. Do not use the XMLNS parser for opaque parsing unless your
message flow requires features that are only offered by the XMLNS parser.

If you are designing a message flow, and you know that a particular element in a
message is never referenced by the message flow, you can specify that that element
is to be parsed opaquely. This reduces the costs of parsing and writing the
message, and might improve performance in other parts of the message flow.

To specify that an XML element is to be parsed opaquely, use an ESQL CREATE
statement with a PARSE clause to parse the XML document. Set the FORMAT
qualifier of the PARSE clause to the constant, case-sensitive string
"XMLNS_OPAQUE’ and set the TYPE qualifier of the PARSE clause to the name of
the XML element that is to be parsed in an opaque manner.

The TYPE clause can specify the element name with no namespace (to match any
namespace), or with a namespace prefix or full namespace URI (to match a specific
namespace).

XMLNS opaque elements cannot be specified via the node properties.

Consider the following example:
DECLARE soap NAMESPACE 'http://schemas.xmlsoap.org/soap/envelope/';

DECLARE BitStream BLOB ASBITSTREAM(InputRoot.XMLNS
ENCODING InputRoot.Properties.Encoding

CCSID InputRoot.Properties.CodedCharSetId);

--No Namespace

CREATE LASTCHILD OF OutputRoot
DOMAIN('XMLNS")
PARSE (BitStream

ENCODING InputRoot.Properties.Encoding
CCSID InputRoot.Properties.CodedCharSetlId
FORMAT 'XMLNS_OPAQUE'
TYPE 'Body');

--Namespace Prefix
CREATE LASTCHILD OF QutputRoot
DOMAIN('XMLNS"')
PARSE (BitStream

ENCODING InputRoot.Properties.Encoding
CCSID InputRoot.Properties.CodedCharSetId
FORMAT 'XMLNS_OPAQUE'
TYPE 'soap:Body');

--Namespace URI
CREATE LASTCHILD OF OutputRoot
DOMAIN('XMLNS')
PARSE (BitStream
ENCODING InputRoot.Properties.Encoding
CCSID InputRoot.Properties.CodedCharSetId
FORMAT 'XMLNS_OPAQUE'
TYPE '{http://schemas.xmlsoap.org/soap/envelope/}:Body"');

XMLNS DTD support:

The input XML might contain an inline DTD.
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Parsing

If the input XML document has an inline DTD, the XMLNS parser reads and uses
information in the DTD while parsing, and adds the DTD information to the
message tree.

Internal entity definitions in the DTD are used to automatically expand entity
references that are encountered in the body of the document.

Attributes that are missing from the input document are automatically supplied
with the default value specified in the DTD.

Writing

The XMLNS parser can output any inline DTD that has been constructed in the
message tree.

External DTDs

No support is offered for external DTDs
XML parsers namespace support:

Namespaces in XML messages are supported by the XMLNSC and XMLNS
parsers. Namespaces are not supported by the XML parser.

Parsing

The XMLNS and XMLNSC parsers can parse any well-formed XML document,
whether or not the document contains namespaces. If elements or attributes have
namespaces, those namespaces are applied to the elements and attributes in the
message tree. Namespace prefix mappings are also carried in the message tree, and
are used when serializing the message tree back to XML.

 If an element or attribute in the input XML has a namespace, the corresponding
node in the message tree also has that namespace.

 If an element contains a namespace declaration (an xmlns attribute), a child
element that contains its prefix and namespace URI is created in the message
tree.

While the message is passing through a message flow, namespaces and namespace
mappings can be modified using ESQL or any of the other transformation
technologies that are offered by message broker.

Writing

Namespaces and their prefixes are preserved in the message tree when parsing,
and are used when the XMLNS and XMLNSC parsers convert a message tree to an
XML bitstream.

* When serializing a message tree, the parser scans for namespace declarations on
each XML element. If any are found, it uses them to select the namespace
prefixes in the output document.

* If an element in the message tree has a namespace, but there is no in-scope
namespace declaration for its namespace URI, a valid namespace prefix is
automatically generated and used in the output XML. Auto-generated prefixes
have the form NS1, NS2, and so on.



Tip: If an element in the message tree has a child element that is a ‘default
namespace’ declaration, every child of that element (wWhether an XML element
or an XML attribute, at any nesting depth) must have a namespace. If this
rule is not enforced message broker cannot generate correct XML output for
the message tree.

XML parser:

The XML domain is very similar to the XMLNS domain, but the XML domain has
no support for XML namespaces or opaque parsing.

The XML domain is deprecated, but existing message flows that use the XML
domain continue to work. Use the XMLNSC domain when developing new
message flows.

The XML parser is not model-driven and does not use an XML Schema when
parsing XML documents.

If you want the XML domain to parse a particular message, you must select
Message Domain as XML on the appropriate node in the message flow.

Tip: The XMLNSC and XMLNS parsers both support XML messages that do not
use namespaces, with no extra configuration.

Features of the XML parser

Feature Present Description

Namespace support No

On-demand parsing Yes See [“Parsing on demand” on|
|Eage 1229.|

Compact message tree No

Opaque parsing No

Ultra high performance No

Validation No

Inline DTD support Yes Inline DTDs are processed
and retained in the message
tree.

XML Data Model compliance | Yes The resultant message tree
conforms to the XML Data
Model.

MRM parser and domain
You can use the MRM domain to parse and write a wide range of message
formats.

The MRM domain can be used to parse and write a wide variety of message
formats. It is primarily intended for non-XML message formats, but it can also
parse and write XML. For guidance on when to consider using the MRM parser,
instead of one of the XML parsers, to parse XML, see [“Which XML parser should|
[you use?” on page 72|

The key features of the MRM domain are:
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Support for messages from applications that are written in C, COBOL, PL/I and
other languages, by using the Custom Wire Format (CWF) physical format. This
support includes the ability to create a message model directly from a C header
file or COBOL copybook.

Support for text messages, perhaps with field content that is identified by tags,
separated by specific delimiters, or both, by using the Tagged Delimited String
(TDS) physical format. This includes industry standards such as CSV, HL?,
SWIFT, EDIFACT, and X12.

Support for XML messages, including those that use XML namespaces, by using
the XML physical format.

WebSphere Message Broker uses the MRM parser to read and write messages that
belong to the MRM domain. When reading a message, the MRM parser constructs
a message tree from a bit stream. When writing a message, the MRM parser creates
a bit stream from a message tree. The MRM parser is always model-driven, and it
is guided by a message dictionary that describes the shape of the message tree (the
logical model) and the physical layout of the bytes or characters in the bit stream
(the physical format). A message dictionary is created automatically from the
content of a message set when it is added to the broker archive (bar) file.
Therefore, when you create a message set for use with the MRM domain, you must
define both the logical model and the appropriate physical format information.

The operation of the parser depends on the physical format that you have
associated with the input or output message:

For a binary message, the parser reads a set sequence of bytes according to
information in the CWF physical format, and translates them into the fields and
values in the message tree.

For a text message, the parser uses a key piece of TDS physical format
information called Data Element Separation to decide how to parse each portion
of the message bit stream. This informs the parser whether the message uses
delimiters, tags, fixed length elements, patterns, and so on. The parser then
reads the data according to information in the TDS physical format, and
translates it into the fields and values in the message tree.

For an XML message, the parser reads the XML markup language (element tags
and attributes), guided by information in the XML physical format, and
translates them into the fields and values in the message tree.

Because the MRM parser is model-driven, it can perform validation of messages
against the model that is defined in the deployed dictionary. The level of
validation that is performed by the MRM parser is similar to that defined by XML
Schema 1.0, but is not fully compliant. If you use XML messages, and you want
fully compliant XML Schema 1.0 validation, use the XMLNSC domain.

The MRM parser is an on-demand parser. See [“Parsing on demand” on page 1229

If you want to use the MRM domain to parse a particular message:

1.

Create a new message set with an appropriate CWF, TDS, or XML physical
format; or locate an existing message set.

Ensure that the message set has its Default message domain set to MRM, or that the
MRM check box under Supported message domains is selected to indicate that the
message set supports the MRM domain.

Create a message definition file in the message set to represent your message,
ensuring that both logical and physical format information is provided. If you



have an existing C, COBOL, XML Schema, or DTD description of your
message, you can import the description using a wizard.

4. Add the message set to a broker archive (bar) file which will generate a
message dictionary for use by the MRM parser, and deploy the bar file to the
broker.

5. Select MRM as Message Domain on the appropriate node in your message flow.

6. Additionally set values for Message Set, Message Type, and Message Format on the
node. Message Type is the name of the message in the message definition file.

The following samples all use the MRM parser to process messages:

+ [Video Rental sample|

+ |Comma Separated Value (CSV) sample|
[EDIFACT sample|

.

.

You can view samples only when you use the information center that is integrated
with the Message Broker Toolkit.

Some predefined message models are supplied with the Message Broker Toolkit
and can be imported using the New Message Definition File From IBM supplied
Message wizard. The CSV, ALE IDoc, and File IDoc models are specifically for use
with the MRM domain. See [[BM supplied messages that you can import|

IBM supplies predefined message sets for industry standard formats SWIFT, X12,
EDIFACT, and FIX. Contact dubadapt@ie.ibm.com for more information.

DataObject parser and domain
Use the DataObject domain to parse and write messages for WebSphere Adapters.

The DataObject domain must be used when you use the WebSphere Adapter nodes
in your message flow.

WebSphere Message Broker uses the DataObject parser to read and write message
from Enterprise Information Systems (EIS) such as SAP, PeopleSoft, and Siebel.
Such messages belong to the DataObject domain.

When it receives a message from an adapter, the DataObject parser constructs a
message tree from the business object that it receives from the EIS. When it writes
a message, the DataObject parser creates from the message tree the business object
that it sends to the EIS. The DataObject parser is always model-driven, and it is
guided by the XML Schemas that model the EIS business objects. The XML
Schemas are created automatically from the content of a message set when the
message set is added to the broker archive (bar) file.

If you want to parse a message using the DataObject domain, you must:
1. Create a new message set, or locate an existing message set.

2. Ensure that either the message set has its Default message domain project set to
DataObject, or the DataObject check box (under Supported message domains) is
selected, to indicate that the message set supports the DataObject domain.

3. Create a message definition file in the message set to represent your EIS
business object. Use the New adapter connection wizard to connect to the EIS and
retrieve the Business object metadata.
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4. Add the message set to a broker archive (bar) file, which generates XML
Schema for the DataObject parser to use, and deploy the bar file to the broker.

5. If you associate your adapter inbound or outbound message with an adapter
node in your message flow, the Message Set property is automatically set in the
node. The Message domain property is always pre-selected as DataObject.

Tip: If a message that belongs to the DataObject domain is written to a destination
other than a WebSphere Adapter, the DataObject parser invokes the XMLNSC

parser to write the message as XML.

The following adapter samples use the DataObject parser to process messages:

* [ISAP Connectivity samplel

* [Twineball Example EIS Adapter sample|

You can view samples only when you use the information center that is integrated
with the Message Broker Toolkit.

JMS parsers and domains
The J]MSMap and JMSStream domains can be used for modeling messages that are
produced by the implementations of the Java Messaging Service standard.

Use the ]MSMap domain when handling JMS messages of type MapMessage. Use
the JMSStream domain when handling JMS messages of type StreamMessage.

These message types appear in the broker in XML format, and are therefore
supported in an identical way to XML domain messages.

For a full description of JMS MapMessage and StreamMessage processing, see
[WebSphere Broker JMS Transport

MIME parser and domain
Use the MIME domain if your messages use the MIME standard for multipart
messages.

The MIME (Multipurpose Internet Mail Extension) parser does not support the full
MIME standard, but does support common uses of MIME. You can send the
messages to the broker over HTTP or over other transport types, such as
WebSphere MQ. Use the MIME domain if your messages use the MIME standard
for multipart messages.

The MIME domain does not support Content-Type values with a media type of
message.

To specify that a message uses the MIME domain, select MIME as the Message
Domain on the relevant message flow node.

Use the MIME domain and parser to parse and write MIME messages. The MIME
parser creates a logical tree, and sets up the broker ContentType property. You can
use Compute nodes and JavaCompute nodes to manipulate the logical tree. Set the
Content-Type value using the ContentType property in the MIME domain.

Example MIME message

The following example shows a simple multipart MIME message. The message
shown is a SOAP with Attachments message with two parts: the root part and one
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attachment part. The boundary string MIME_boundary delimits the parts.

MIME-Version: 1.0
Content-Type: Multipart/Related; boundary=MIME_boundary; type=text/xm]
Content-Description: Optional description of message.

Optional preamble text
--MIME_boundary

Content-Type: text/xml; charset=UTF-8
Content-Transfer-Encoding: 8bit
Content-ID: <rootpart@example.com>

<?xml version='1.0"' ?>
<SOAP-ENV:Envelope
xmIns:SOAP-ENV="http://schemas.xmlsoap.org/soap/envelope/">

<SOAP-ENV:Header xmins:ins="http://myInsurers.com">
<ins:ClaimReference>abc-123</ins:ClaimReference>
</SOAP-ENV:Header>

<SOAP-ENV:Body xmlns:ins="http://myInsurers.com">
<ins:SendClaim>
<ins:ClaimDetail>myClaimDetails</ins:ClaimDetail>
<ins:CTaimPhoto>
<href>cid:claimphoto@example.com</href>
</ins:ClaimPhoto>
</ins:SendClaim>
</SOAP-ENV:Body>

</SOAP-ENV:Envelope>

--MIME_boundary

Content-Type: application/octet-stream
Content-Transfer-Encoding: binary
Content-ID: <claimphoto@example.com>

myBinaryData

--MIME_boundary--
Optional epilogue text

Example MIME logical tree

The following diagram shows a [MIME logical tree} A MIME logical tree does not

need to contain all of the children that are shown in the diagram. The value of the

Content-Type header of a MIME message is the same as the ContentType field in

the Properties subtree. The Transport-headers are headers from the transport that is

used, such as an MQMD or HTTP.
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MIME-Version Content-Type Content-Description

[

Optional preamble| | Part | EPart

Content-Type | | Content-Transfer-Encoding | |Content-ID| | Data |

BLOB

You can further parse the BLOB data in the tree (for example, by using an ESQL
CREATE statement) if you know about the format of that MIME part. You might
be able to find information about the format from its Content-Type field in the
logical tree. Alternatively, you might know the format that your MIME messages
take, and be able to parse them appropriately. For example, you might know that
the first MIME Part is always an XML message, and that the second MIME Part is
a binary security signature.

You must specify how to parse other message formats, such as tagged delimited or
binary data, within your message flow, because the MIME parser does not do this.
You must also specify how to handle encoded and signed message parts, because
the MIME parser does not process these.

Some pre-defined MIME message models are supplied with the workbench and
can be imported using the New Message Definition From IBM Supplied Message
wizard. See [[BM supplied message: Select an IBM supplied message}

MIME messages:
MIME headers

A MIME message consists of both data and metadata. MIME metadata consists of
HTTP-style headers and MIME boundary delimiters. Each header is a
colon-separated name-value pair on a line. The ASCII sequence <CR><LF>
terminates the line. A sequence of these headers, called a header block, is
terminated by a blank line: <CR><LF><CR><LF>. Any headers that are in this HTTP
style can appear in a MIME document. Some common MIME headers are
described in [MIME standard header fields|

Content-Type

The only header that must be present is the Content-Type header. This header
specifies the type of the data in the message. If the Content-Type value starts with



“multipart”, the message is a multipart MIME message. For multipart messages the
Content-Type header must also include a boundary attribute that gives the text
that is used to delimit the message parts. Each MIME part has its own
Content-Type field that specifies the type of the data in the part. This can also be
multipart, which allows multipart messages to be nested. MIME parts with any
other Content-Type values are handled as BLOB data.

If a MIME document is sent over HTTP, the Content-Type header appears in the
HTTP header block rather than in the MIME message body. For this reason, the
broker manages the value of the Content-Type header as the ContentType property
in the Properties folder of the logical tree. This allows the MIME parser to obtain
the Content-Type value for a MIME document that is received over HTTP. If you
need to either create a new MIME tree or modify the value of the Content-Type,
set the Content-Type value using the ContentType property in the MIME domain.
If you set the Content-Type value directly in the MIME tree or HTTP tree, this
value might be ignored or used inconsistently. The following ESQL is an example
of how to set the broker ContentType property:

SET OutputRoot.Properties.ContentType = 'text/plain';
Parsing

The MIME domain does not enforce the full MIME specification. Therefore, you
can work with messages that might not be valid in other applications. For
example, the MIME parser does not insist on a MIME-Version header. The MIME
parser imposes the following constraints:

¢ The MIME headers must be properly formatted:

— Each header is a colon-separated name-value pair, on a line of its own,
terminated by the ASCII sequence <CR><LF>.

— The header line must use 7-bit ASCIL
— Semicolons are used to separate parameters:
Content-Type: Multipart/Related; boundary=MIME_boundary; type=text/xm]
— A header might contain a comment in parentheses, for example:
MIME-Version: 1.0 (Generated by XYZ)

* A line that starts with white space is treated as a continuation of the previous
line. Therefore, a long header can be split across more than one line.

e If two or more headers in a header block have the same name, their values are
concatenated into a comma-separated list.

* A top-level MIME Content-Type header must be available. The header is not
case-sensitive. If the transport is HTTP, any Content-Type value in the HTTP
header is used as the top-level Content-Type. If the transport is not HTTD, the
Content-Type must appear in the initial header block of the MIME message.

¢ The Content-Type value is a media type followed by the / character and a
subtype. Examples of this are text/xml and multipart/related. The parser does
not validate subtypes. The Content-Type value can be followed by one or more
parameters that are separated by semicolons.

e If the media type of a message is multipart, a boundary attribute must provide
the text that is used to delimit the separate MIME parts.

* Each individual MIME part can have its own Content-Type header. The part
header can have a media type of multipart, so that multipart messages can be
nested. In this case, a valid boundary attribute must be provided, and its value
must be different from any that has been previously defined in the message.
MIME parts that have any other Content-Type value are handled as BLOB data.
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¢ MIME multipart boundary delimiters are represented in 7-bit ASCIL. The
boundary delimiter consists of a line starting with a hyphen pair, followed by a
boundary string. This sequence must not occur within the MIME message at any
point other than as a boundary. A MIME end-delimiter is a hyphen pair,
followed by the MIME boundary string, followed by a further hyphen pair. All
delimiter lines must end in the ASCII sequence <CR><LF>. An example of a
delimited message is:
--MIME_boundary
message data
--MIME_boundary

message data
--MIME_boundary--

where MIME_boundary is the boundary delimiter string, and message data
represents message data.

e The MIME media type message is not supported and results in an error at run
time.

* Any preamble data (text between the initial MIME header block and the first
boundary delimiter) or epilogue data (text after the final boundary delimiter) is
stored in the logical tree as a value-only element. Preamble data and epilogue
data can appear only as the first and last children, respectively, of a Parts node.

* The MIME parser does not support on demand parsing and ignores the Parse
Timing property. The parser does not validate MIME messages against a message
model, and ignores the Message Brokers Toolkit Validate property.

Special cases of multipart MIME

The MIME parser is intended primarily for use with multipart MIME messages.
However, the parser also handles some special cases:

* Multipart MIME with just one part. The logical tree for the MIME part saves the
Content-Type and other information as usual, but the Data element for the
attachment is empty.

* Single-part MIME. For single-part MIME, the logical tree has no Parts child. The
last child of the MIME tree is the Data element. The Data element is the parent
of the BLOB that contains the message data.

* MIME parts with no content.
Secure MIME (S/MIME)

S/MIME is a standard for sending secure e-mail. S/MIME has an outer level
Content-Type of multipart/signed with parameters protocol and micalg that define
the algorithms that are used to encrypt the message. One or more MIME parts can
have encoded content. These parts have Content-Type values such as
application/pkcs7-signature and a Content-Transfer-Encoding of base64. The MIME
domain does not attempt to interpret or verify whether the message is actually
signed.

MIME tree details:
Logical tree elements

A MIME message is represented in the broker as a logical tree with the following
elements:

e The root of the tree is a node called MIME.



 All correctly formatted headers are stored in the logical tree, regardless of
whether they conform to the MIME standard. The headers appear in the logical
tree as name=value, as shown here:

Content-Type=text/xml

* A multipart MIME message is represented by a subtree with a root node called
Parts.

* Any preamble or epilogue data associated with a multipart MIME message is
represented by value-only elements appearing as the first and last children of
Parts.

* In the special case of single-part MIME, the content is represented by a subtree
with the root called Data.

¢ Each part of a multipart MIME message is represented by an element called Part
with a child element for each MIME header, and a last child called Data.

¢ The Data element represents the content of a MIME part. This makes it easier to
test for the presence of body content using ESQL because the Data element is
always the last child of its parent.

Writing MIME messages

When writing a message, the MIME parser creates a message bit stream using the
logical message tree. The MIME domain does not enforce all of the constraints that
the MIME specification requires, therefore it might generate MIME messages that
do not conform to the MIME specification. The constraints that the MIME parser
imposes are:

e The tree must have a root called MIME, and constituent Parts, Part, and Data
elements, as described in [“Logical tree elements” on page 100

* Exactly one Content-Type header must be present at the top level of the tree, or
be available via the ContentType property. Media subtypes are not validated.

e If the media type is multipart then there must also be a valid boundary
parameter.

* Any constituent MIME parts may have exactly one Content-Type header. If the
value of this header starts with multipart then it must also include a valid
boundary parameter. The value of this boundary parameter must not be the
same as other boundary parameter values in the definition.

* The MIME Content-Type value “message” is not supported and results in an
error at run time.

* All name-value elements in the tree are written as name: value followed by the
ASCII sequence <CR><LF>.

If you have other elements in the tree, the parser behaves in the same way as the
HTTP header parser:

* A name-only element or a NameValue element with a NULL value results in
Name: NULL .

* Any children of a name-value element are ignored.

The message flow must serialize subtrees if they exist. This can be done using the
ESQL command ASBITSTREAM.

BLOB parser and domain
The BLOB message domain includes all the messages with content that cannot be
interpreted and subdivided into smaller sections of information.
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Messages in this domain are processed by the BLOB parser. The BLOB parser is a
program that interprets a bit stream or message tree that represents a message that
belongs to the BLOB domain, and generates the corresponding tree from the bit
stream on input, or a bit stream from the tree on output.

A BLOB message is handled as a single string of bytes, and although you can
manipulate it, you cannot identify specific pieces of the byte string using a field
reference, in the way that you can with messages in other domains.

You can process messages in the BLOB domain in the following ways:

* You can refer to the message content if you know the location (offset) of
particular information within the message. You can specify offset values in ESQL
statements within nodes in a message flow to manipulate the information.

* You can store the message in an external database, in whole or in part (where
the part is identified by the offset of the data that is to be stored).

The BLOB message body parser does not create a tree structure in the same way
that other message body parsers do. It has a root element BLOB, that has a child
element, also called BLOB, that contains the data.

For example, InputBody.BLOB.BLOB[10] identifies the tenth byte of the message
body; substring(InputBody.BLOB.BLOB from 10 for 10) references 10 bytes of the
message data starting at offset 10.

If you want to use the BLOB parser to parse a particular message, select BLOB as
the Message Domain on the relevant node in your message flow.

The following sample demonstrates how you can extract information from an XML
message and transform it into BLOB format to store it in a database.

+ |Data Warehouse sample|

You can view samples only when you use the information center that is integrated
with the Message Broker Toolkit.

IDOC parser and domain

The IDOC domain can be used to process messages that are sent to the broker by
SAP R3 clients across the WebSphere MQ link for R3. Such messages are known as
SAP ALE IDocs.

Note: The IDOC domain is deprecated and is not recommended for developing
new message flows. Instead use the MRM domain with a TDS physical
format. See ["'MRM parser and domain” on page 93

A typical ALE IDoc message that has been sent from SAP to the WebSphere MQ
link for R3 consists of an MQMD header, an MQSAPH header, and the ALE IDoc
itself. The IDoc is made up of fixed size structures:

* The first structure is the Control Structure (DC). This is a complex element 524
bytes long that contains a fixed set of SAP-defined simple elements.

* One or more Data Structures (DDs). Each DD is a complex element 1063 bytes
long that contains a fixed set of SAP-defined simple elements that occupies 63
bytes, followed by 1000 bytes of user-defined segment data.

WebSphere Message Broker uses the IDOC parser to read and write ALE IDocs
that belong to the IDOC domain. When reading a message, the IDOC parser
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constructs a message tree from a bit stream. When writing a message, the IDOC
parser creates a bit stream from a message tree.

The IDOC parser processes the SAP-defined elements in the DC, and then, for each
DD, the IDOC parser processes the SAP-defined elements and then invokes the
MRM parser to process the user-defined segment data, using its CWF physical
format. The IDOC parser is therefore a model-driven parser, and requires that you
create a message set in which to model the IDoc message, and deploy it to the
broker.

If you want the IDOC domain to parse a particular message, you must:

1. Create a new message set with a CWF physical format, or locate an existing
message set.

2. Ensure that either the message set has its Default message domain project set to
IDOC, or the IDOC check box (under Supported message domains) is selected, to
indicate that the message set supports the IDOC domain.

3. Create message definition files in the message set to represent your message.
See [Building the message model for the IDOC parser for the steps involved.

4. Add the message set to a broker archive (bar) file which generates a message
dictionary for use by the MRM parser, and deploy the bar file to the broker.

5. Select Message Domain as IDOC on the appropriate node in your message flow.

6. Additionally, select Message Set and Message Format on the node. (You do not
need to select Message Type).

Null handling

A business message might contain fields that are either empty or have a specific
out-of-range value. In these cases, the application that receives the message is
expected to treat the field as if it did not have a value. The logical message tree
supports this concept by allowing the value of any element to be set to NULL.

Ways to represent a null value: In an XML document, the usual way to represent
a null value is to leave the element or attribute empty.

For example:<price></price> or <element price=""/>

The xsimnil attribute provides a way to make this more
explicit:price=<xsi:nil="true"/>

Some business messages use a special value to represent null:<price>-999</price>
This style of null representation is supported only by the MRM parser.

ESQL support for null values: Using ESQL, you can set the value of a message
tree element to NULL:SET OutputRoot.XMLNSC.myField VALUE = NULL;

Note that this is quite different from SET OutputRoot.XMLNSC.myField = NULL;
which would cause myField to be deleted from the message tree.

The same effect can be achieved using Java or a Mapping node.

XMLNSC parser support for null values: Typically, the XML parsers (XMLNSC,
XMLNS, and XML) do not create null values in the message tree; an empty
element or an empty attribute value merely produces an empty string value in the
message tree.
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If validation is enabled, the XMLNSC parser detects and processes any xsi:nil
attributes in the input document. If the xsi:nil attribute is set to "true’, and the
element is nillable, the attribute’s parent element in the message tree is given a
NULL value.

For more information about XML parser support for empty and null elements, see
“XMLNSC empty elements and null values” on page 81{and ["XMLNS empty|
elements and null values” on page 89

MRM parser support for null values: XML physical format

When parsing, the MRM XML parser can detect and process xsimnil attributes in the
input XML document. If the xsi:nil attribute is set to ‘true’, and the element is
nillable, the attribute’s parent element in the message tree is given a NULL value.

For information about enabling xsi:nil support in the MRM parser, see XML Nul
[handling options|

The following topics provide more information about NULL handling in the MRM
parser:

All physical formats

The MRM parser can detect a null that is represented by an out-of-range value.
The 'null value” must be specified in the physical format of the message set.

While parsing, the MRM parser checks the null value for each element in the
message. If the value in the bit stream matches the null value in the message set,
the MRM parser sets the value in the message tree to NULL.

The same check is performed when converting a message tree to a bit stream. If
the value in the message tree is NULL, the MRM parser outputs the null value
from the message set.

* |Custom wire format: NULL handling]

+ [IMRM XML physical format: NULL handling]|

* [TDS format: NULL handling]

Properties

104 Message Flows

This topic discusses the following types of broker properties:

e “Built-in” or broker-supplied properties, which are sometimes known simply as
“broker properties”: see [“Broker properties.”|

+ Promoted properties: see ['Promoted properties” on page 105,

* User-defined properties: see [“User-defined properties” on page 106/

Broker properties

For each broker, WebSphere Message Broker maintains a set of properties. You can
access some of these properties from your ESQL programs. A subset of the
properties is also accessible from Java code. It can be useful, during the runtime of
your code, to have real-time access to details of a specific node, flow, or broker.

Four categories of broker properties exist.
 Properties relating to a specific node

* Properties relating to nodes in general
* Properties relating to a message flow



* Properties relating to the execution group

For a description of the broker, flow, and node properties that are accessible from
ESQL and Java, see [“Broker properties that are accessible from ESQL and Java” on|

page 1517.

Broker properties have the following characteristics.

* They are grouped by broker, execution group, flow, and node.
* They are case sensitive. Their names always start with an uppercase letter.
* They return NULL if they do not contain a value.

All nodes that allow user programs to edit ESQL support access to broker
properties. These nodes are:

¢ Compute nodes

* Database nodes

* Filter nodes

* All derivatives of these nodes

A complex property is a property to which you can assign multiple values. Complex
properties are displayed in a table in the Properties view, where you can add, edit,
and delete values, and change the order of the values in the table. You cannot
promote complex properties, so they do not appear in the Promote properties
dialog box; nor can you configure complex properties, so they are not supported in
the Broker Archive editor. For an example of a complex property, see the Query
elements property of the DatabaseRoute node.

For more information about editing a node’s properties, see

[message flow node” on page 225 |

Promoted properties
A promoted property is a message flow node property that has been promoted to
the level of the message flow in which it is included.

A message flow contains one or more message flow nodes, each of which is an
instance of a message flow type (a built-in node, or a user-defined node). You can
promote the properties of a message flow node to apply to the message flow to
which it belongs. If you do this, any user of the message flow can set values for
the properties of the nodes in this higher message flow by setting them at the
message flow level, without being aware of the message flow’s internal structure.

You can promote compatible properties (that is, properties that represent
comparable values) from more than one node to the same promoted property; you
can then set a single property that affects multiple nodes.

For example, you might want to set the name of a data source as a property of the
message flow, rather than a property of each individual node in the message flow
that references that data source. You create a message flow that accesses a database
called SALESDATA. However, while you are testing the message flow, you want to
use a test database called TESTDATA. If you set the data source properties of each
individual node within the message flow to refer to SALESDATA, you can promote
the data source property for each node in the flow that refers to it, and update the
property to have the value TESTDATA which overrides the node data source
properties values while you test the message flow (the promoted property always
takes precedence over the settings for the properties within any relevant nodes).
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A subset of message flow node properties is also configurable (that is, the
properties can be updated at deploy time). You can promote configurable
properties: if you do so, the promoted property (which can have a different name
from the property or properties that it represents) is the one that is available to
update at deploy time. Configurable properties are those associated with system
resources, for example queues and data sources: they can be set at deploy time by
an administrator rather than a message flow developer.

You cannot promote a complex property, so it does not appear in the Promote
properties dialog box. For more information about complex properties, see
[properties” on page 104

User-defined properties

A user-defined property (UDP) is a property that is defined when you construct a
message flow using the Message Flow editor. This property can be used by the
ESQL program inside message flow nodes such as a Compute node. It can also be
used as a Java property inside the Java generated by a JavaCompute node.

The advantage of UDPs is that their values can be changed by operational staff at
deployment time. You do not need to change your application programs. For
example, if you use the UDPs to hold data about your computer center, you can
configure a message flow for a particular machine, task, or environment at
deployment time, without having to change the code at the message node level.

When you launch the Message flow editor to either create a message flow or
modify an existing message flow, as well as deciding which nodes are required in
the message flow, you also have the option (provided by the tab ) of defining and
giving initial values to some user-defined properties. Use the User Defined
Properties tab at the bottom of the edit window. See [Message Flow editor] for more
information about how you do this.

As well as being defined using the Message flow editor, a UDP must also be
defined using either a DECLARE statement with the EXTERNAL keyword in any
ESQL program that uses it, or the getUserDefined Attribute method in any
JavaCompute node that uses it.

See the ["'DECLARE statement” on page 1382| for details of the DECLARE
statement, and see [“Accessing user-defined properties from a JavaCompute node”]
for more information about how to use a UDP in a JavaCompute
node.

Any value that you give to a UDP when you define it in a message flow, overrides
the value of that variable in your ESQL or Java program.

The value of a UDP can also be modified at deployment time by using the Broker
Archive editor to edit the bar file. This value overrides any value that was given
when you defined the message flow.

Every UDP in a message flow must have a value, given either when the UDP is
declared or by the Message Flow or Broker Archive editor; otherwise a
deployment-time error occurs. At run time, after the UDP has been declared its
value can be queried by subsequent program statements but it cannot be modified.

The value of the UDP is set at the flow level and is the same for all eligible nodes
that are contained in the flow. An “eligible node” is a node that supports UDPs
and is within the scope of the declaration that declares the UDP to your



application. For example, if you use the Message Flow editor to change the value
of a user property called “timezone”, that is declared in a schema called
“mySchema”, in a message flow called “myFlow”, the UDP is available at run time to
all the nodes in myFlow that support UDPs and that fall within mySchema.

Similarly, if you use the Message Flow editor to change the value of a user-defined
property in a subflow, the newly edited property is available to all the nodes in the
subflow that support UDPs and that are within the scope of the declaration. It is
not available, for example, to nodes in the parent flow.

Message flow transactions

A message flow can be one of two styles:

[“Coordinated message flows”|
These ensure that all updates to resources are committed or rolled back
together within a single transaction.

[“Uncoordinated message flows” on page 108
These allow updates to resources to occur independently; the updates are
not affected by the overall success or failure of the message flow.

Coordinated message flows

You can configure a message flow that includes interaction with an external
database or other recoverable resource so that all of its processing is coordinated
within a single, global, transaction. This coordination ensures that either all
processing is successfully completed, or no processing is completed. The
transaction is committed (if all processing is successful), or rolled back (if at least
one part of the processing is unsuccessful). Therefore, all affected resources
(queues, databases, and so on) are maintained in a consistent state, and data
integrity is preserved.

Updates that are made by a coordinated message flow are committed when the
flow processes the input message successfully. The updates are backed out if both
of the following conditions are met:

* Any node within the flow throws an exception that is not caught by a node
other than the input node

¢ The input node’s Catch terminal is not connected

To configure a message flow as coordinated, set the Coordinated property on the
message flow.

For some input nodes, such as MQInput or SCADAInput nodes, set the
Transaction Mode property on the nodes in the flow to Automatic. The Automatic
option makes messages part of the global transaction, and marks the message flow
as transactional if the input message is persistent, or uncoordinated if the input
message is not persistent. Subsequent nodes in the flow that set the Transaction
Mode property to Automatic are included in the global transaction if the flow is
marked transactional by the input node.

Transaction coordination of message flows is provided on distributed systems by
WebSphere MQ, and on z/OS systems by RRS. Message flows are always globally
coordinated on z/0S, regardless of the setting of the message flow’s Coordinated

property.
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Uncoordinated message flows

Uncoordinated flows are flows for which the Coordinated property is not set.
Updates to resources that are used by a uncoordinated flow are managed by the
separate resource managers. Some resource managers, such as WebSphere MQ,
allow updates to be made non-transactionally, or as part of a resource-specific
transaction. Other resource managers, such as database managers, always use a
resource-specific transaction. A resource-specific transaction is a transaction with a
scope that is limited to the resources that are owned by a single resource manager,
such as a database or queue manager.

Resource-specific transactions are typically used when only one type of recoverable
resource is used in a flow. An example of such a flow is one that contains an
MQInput and an MQOutput node, but which does not access any databases. Do
not use resource-specific transactions when more than one resource exists and data
integrity must be maintained.

Updates that are made to a resource that is accessed non-transactionally are
committed immediately. An MQInput node that is configured to be
non-transactional removes messages from the queue immediately; if the flow fails,
the messages are lost.

Set the Transaction Mode property to Automatic to make some input nodes (such
as MQInput or SCADAInput) part of a transaction, depending on the persistence
of the input message. If the input message is persistent, messages are made part of
the transaction, and the flow is marked as transactional. If the message is not
persistent, the flow is marked as non-transactional.

The following sample demonstrates the use of globally-coordinated transactions
and the differences in the message flow when database updates are coordinated
(the main flow), and when they are not (the error flow).

* [Error Handler sample|

You can view samples only when you use the information center that is integrated
with the Message Broker Toolkit.

Broker schemas

108 Message Flows

A broker schema is a symbol space that defines the scope of uniqueness of the
names of resources defined within it. The resources are message flows, ESQL files,
and mapping files.

The broker schema is defined as the relative path from the project source directory
to the flow name. When you first create a message flow project, a default broker
schema named (default) is created within the project.

You can create new broker schemas to provide separate symbol spaces within the
same message flow project. A broker schema is implemented as a folder, or
subdirectory, within the project, and provides organization within that project. You
can also use project references to spread the scope of a single broker schema across
multiple projects to create an application symbol space that provides a scope for all
resources associated with an application suite.

A broker schema name must be a character string that starts with a Unicode
character followed by zero or more Unicode characters or digits, and the
underscore. You can use the period to provide a structure to the name, for example
Stock.Common. A directory is created in the project directory to represent the
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schema, and if the schema is structured using periods, further subdirectories are
defined. For example, the broker schema Stock.Common results in a directory
Common within a directory Stock within the message flow project directory.

If you create a resource (for example, a message flow) in the default broker schema
within a project, the file or files associated with that resource are created in the
directory that represents the project. If you create a resource in another broker
schema, the files are created within the schema directory.

For example, if you create a message flow Update in the default schema in the
message flow project Projectl, its associated files are stored in the Projectl
directory. If you create another message flow in the Stock.Common broker schema
within the project Projectl, its associated files are created in the directory
Project1\Stock\Common.

Because each broker schema represents a unique name scope, you can create two
message flows that share the same name within two broker schemas. The broker
schemas ensure that these two message flows are recognized as separate resources.
The two message flows, despite having the same name, are considered unique.

If you move a message flow from one project to another, you can continue to use
the message flow within the original project if you preserve the broker schema. If
you do this, you must update the list of dependent projects for the original project
by adding the target project. If, however, you do not preserve the broker schema,
the flow becomes a different flow because the schema name is part of the fully
qualified message flow name, and it is no longer recognized by other projects. This
action results in broken links that you must manually correct. For further
information about correcting errors after moving a message flow, see
[message flow” on page 212

Do not move resources by moving their associated files in the file system; you
must use the workbench to move resources to ensure that all references are
corrected to reflect the new organization.

The following scope and reuse conditions apply when you create functions,
procedures, and constants in a broker schema:
Functions

* Functions are locally reusable and can be called by module-scope
subroutines or mappings within the same schema.

* Functions are globally reusable and can be called by other functions or
procedures in ESQL or mapping files within any schema defined in the
same or another project.

Procedures

* Procedures are locally reusable and can be called from module-scope
subroutines in ESQL files within the same schema.

* Procedures are globally reusable and can be called by other functions or
procedures in ESQL files within any schema defined in the same or
another project.

Procedures cannot be used in mapping files.

Constants

 Constants are locally reusable and can be used where they are defined in
any ESQL or mapping file within the same broker schema.
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* Constants are not globally reusable; you cannot use a constant that is
declared in another schema.

If you want to reuse functions or procedures globally:
* Specify the path of the function or procedure:

— If you want to reuse a function or procedure in an ESQL file, either provide a
fully-qualified reference, or include a PATH statement that defines the path.

If you choose to define the path, code the PATH statement in the same ESQL
file as that in which the function is coded, but not within any MODULE.

— If you want to reuse a function in a mapping file, do one of the following:
- Qualify the function in the Composition Expression editor.

- Select Organize Schema References in the outline view. This detects
dependent PATHs and automatically updates the reference.

- Select Modify Schema References in the outline view. You can then select
the schema in which the function is defined.
(You cannot reuse a procedure in a mapping file.)

* Set up references between the projects in which the functions and procedures are
defined and used.

Message flow accounting and statistics data

110 Message Flows

Message flow accounting and statistics data is the information that can be collected
by a broker to record performance and operating details of message flow
execution.

These reports are not the same as the publish/subscribe statistics reports that you
can generate. The publish/subscribe statistics provide information about the
performance of brokers, and the throughput between the broker and clients that
are connected to the broker. Message flow accounting and statistics reports provide
information about the performance and operating details of a message flow
execution.

Message flow accounting and statistics data records dynamic information about the
runtime behavior of a message flow. For example, it indicates how many messages
are processed and how large those messages are, as well as CPU usage and
elapsed processing times. The broker collects the data and records it in a specified
location when one of a number of events occurs (for example, when a snapshot
interval expires or when the execution group you are recording information about
stops).

The following restrictions apply to data collection:

e If the message flow starts with a SCADAInput node or a Real-timelnput node,
no data is collected (and no error is reported).

* Data relating to the size of messages is not collected for WebSphere Adapters
nodes (for example, the SAPInput node), the FileInput node, the JMSInput node,
or any user-defined input node that does not create a message tree from a bit
stream.

Under some circumstances, message size is recorded for the Web Services nodes
(for example, the SOAPInput node), but the value might not reflect the real
input message size and should be ignored.

Collecting message flow accounting and statistics data is optional; by default it is
switched off. To use this facility, request it on a message flow or execution group



basis. The settings for accounting and statistics data collection are reset to the
defaults when an execution group is redeployed. Previous settings for message
flows in an execution group are not passed on to the new message flows deployed
to that execution group. Data collection is started and stopped dynamically when
you issue the mgsichangeflowstats command; you do not need to make any
change to the broker or to the message flow, or redeploy the message flow, to
request statistics collection.

You can activate data collection on both your production and test systems. If you
collect the default level of statistics (message flow), the impact on broker
performance is minimal. However, collecting more data than the default message
flow statistics can generate high volumes of report data that might cause a small
but noticeable performance overhead.

When you plan data collection, consider the following points:
* |Collection options
* |Accounting origin

* [Output formats|

You can find more information on how to use accounting and statistics data to
improve the performance of a message flow in this [developerWorks article on|
[message flow performance}

The following SupportPac provides additional information about using
accounting and statistics:
+ |Using statistics and accounting SupportPac (IS11)|

Message flow accounting and statistics collection options

The options that you specify for message flow accounting and statistics collection
determine what information is collected. You can request the following types of
data collection:

* Snapshot data is collected for an interval of approximately 20 seconds. The exact
length of the interval depends on system loading and the level of current broker
activity. You cannot modify the length of time for which snapshot data is
collected. At the end of this interval, the recorded statistics are written to the
output destination and the interval is restarted.

* Archive data is collected for an interval that you have set for the broker on the
mgsicreatebroker or mqsichangebroker command. You can specify an interval of
between 10 and 14400 minutes, the default value is 60 minutes. At the end of
this interval, the recorded statistics are written to the output destination and the
interval is restarted.

An interval is prematurely expired and restarted when any of the following
events occur:

— The message flow is redeployed.

— The set of statistics data to be collected is modified.

— The broker is shut down.

This preserves the integrity of the data already collected when that event occurs.

On z/0S, you can set the command parameter to 0, which means that
the interval is controlled by an external timer mechanism. This support is
provided by the Event Notification Facility (ENF), which you can use instead of
the broker command parameter if you want to coordinate the expiration of this
timer with other system events.

You can request snapshot data collection, archive data collection, or both. You can
activate snapshot data collection while archive data collection is active. The data
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recorded in both reports is the same, but is collected for different intervals. If you
activate both snapshot and archive data collection, be careful not to combine
information from the two different reports, because you might count information
twice.

You can use the statistics generated for the following purposes:

* You can record the load that applications, trading partners, or other users put on
the broker. This allows you to record the relative use that different users make of
the broker, and perhaps to charge them accordingly. For example, you could
levy a nominal charge on every message that is processed by a broker, or by a
specific message flow.

Archive data provides the information that you need for a use assessment of this
kind.

* You can assess the execution of a message flow to determine why it, or a node
within it, is not performing as you expect.

Snapshot data is appropriate for performance assessment.

* You can determine the route that messages are taking through a message flow.
For example, you might find that an error path is taken more frequently than
you expect and you can use the statistics to understand when the messages are
routed to this error path.

Check the information provided by snapshot data for routing information; if this
is insufficient for your needs, use archive data.

Message flow accounting and statistics accounting origin
Accounting and statistics data can be accumulated and reported with reference to
an identifier associated with a message within a message flow. This identifier is the
accounting origin. This provides a method of producing individual accounting and
statistics data for multiple accounting origins that generate input to message flows.
The accounting origin can be a fixed value, or it can be dynamically set according
to your criteria.

For example, if your broker hosts a set of message flows associated with a
particular client in a single execution group, you can set a specific value for the
accounting origin for all these flows. You can then analyze the output provided to
assess the use that the client or department makes of the broker, and charge them
accordingly.

If you want to track the behavior of a particular message flow, you can set a
unique accounting origin for this message flow, and analyze its activity over a
given period.

To make use of the accounting origin, you must perform the following tasks:
* Activate data collection, specifying the correct parameter to request basic

support (the default is none, or no support). For details, see [mgsichangeflowstats|

* Configure each message flow for which you want a specific origin to include
ESQL statements that set the unique value that is to be associated with the data
collected. Data for message flows for which a specific value has not been set are
identified with the value Anonymous.

The ESQL statements can be coded in a Compute, Database, or Filter node.

You can configure the message flow either to set a fixed value, or to determine a
dynamic value, and can therefore create a very flexible method of recording sets



of data that are specific to particular messages or circumstances. For more
information, refer to [‘Setting message flow accounting and statistics accounting]
forigin” on page 517

You can complete these tasks in either order; if you configure the message flow
before starting data collection, the broker ignores the setting. If you start data
collection, specifying accounting origin support, before configuring the message
flow, all data is collected with the Accounting Origin set to Anonymous. The broker
acknowledges the origin when you redeploy the message flow. You can also
modify data collection that has already started to request accounting origin
support from the time that you issue the command. In both cases, data that has
already been collected is written out and collection is restarted.

When data has been collected, you can review information for one or more specific
origins. For example, if you select XML publication messages as your output
format, you can start an application that subscribes to the origin in which you are
interested.

Output formats for message flow accounting and statistics data
When you collect message flow statistics, you can choose the output destination
for the data.

Select one of the following destinations:

. ser trace

+ XML publication|

- v

Statistics data is written to the specified output location in the following
circumstances:

* When the archive data interval expires.
* When the snapshot interval expires.

* When the broker shuts down. Any data that has been collected by the broker,
but has not yet been written to the specified output destination, is written
during shutdown. It might therefore represent data for an incomplete interval.

* When any part of the broker configuration is redeployed. Redeployed
configuration data might contain an updated configuration that is not consistent
with the existing record structure (for example, a message flow might include an
additional node, or an execution group might include a new message flow).
Therefore the current data, which might represent an incomplete interval, is
written to the output destination. Data collection continues for the redeployed
configuration until you change data collection parameters or stop data collection.

* When data collection parameters are modified. If you update the parameters that
you have set for data collection, all data that is collected for the message flow
(or message flows) is written to the output destination to retain data integrity.
Statistics collection is restarted according to the new parameters.

* When an error occurs that terminates data collection. You must restart data
collection yourself in this case.

User trace

You can specify that the data that is collected is written to the user trace log. The
data is written even when trace is switched off. The default output destination for
accounting and statistics data is the user trace log. The data is written to one of the
following locations:
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« WM On Windows® systems, if the broker workpath has been set using the
-w option of the mgsicreatebroker command, data is written to workpath\log. If
the broker workpath has not been specified, data is written to C:\Documents
and Settings\ All Users\ Application Data\IBM\MQSI\common\log,

. BTT#@ On Linux® and UNIX® systems, data is written to
/var/mgqsi/common/log.

. On z/0S® systems, data is written to /component_filesystem /log.
XML publication

You can specify that the data that is collected is published. The publication
message is created in XML format and is available to subscribers registered in the

broker network that subscribe to the correct topic.

The topic on which the data is published has the following structure:

$SYS/Broker/brokerName/StatisticsAccounting/recordType/executionGrouplabel/messageFlowLabel
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The variables correspond to the following values:

brokerName
The name of the broker for which statistics are collected.

recordType
Set to Snapshot or Archive, depending on the type of data to which you
are subscribing. Alternatively, use # to register for both snapshot and
archive data if it is being produced.

executionGroupLabel
The name of the execution group for which statistics are collected.

messageFlowLabel
The label on the message flow for which statistics are collected.

Subscribers can include filter expressions to limit the publications that they receive.
For example, they can choose to see only snapshot data, or to see data that is
collected for a single broker. Subscribers can specify wild cards (+ and #) to receive
publications that refer to multiple resources.

The following examples show the topic with which a subscriber should register to
receive different sorts of data:

* Register the following topic for the subscriber to receive data for all message
flows running on BrokerA:
$SYS/Broker/BrokerA /StatisticsAccounting /#

* Register the following topic for the subscriber to receive only archive statistics
relating to a message flow Flowl running on execution group Execution on
broker BrokerA:
$SYS/Broker/BrokerA /StatisticsAccounting / Archive / Execution / Flow1

* Register the following topic for the subscriber to receive both snapshot and

archive data for message flow Flowl running on execution group Execution on
broker BrokerA

$SYS/Broker/BrokerA /StatisticsAccouting /#/ Execution / Flow1

[Message display, test and performance utilities SupportPac (IH03)| can help you
with registering your subscriber.
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SMF

On z/0S, you can specify that the data collected is written to SME. Accounting
and statistics data uses SMF type 117 records. SMF supports the collection of data
from multiple subsystems, and you might therefore be able to synchronize the
information that is recorded from different sources.

When you want to interpret the information recorded, you can use any utility
program that processes SMF records.

Message flow aggregation

Aggregation is the generation and fan-out of related requests that are derived from
a single input message, and the fan-in of the corresponding replies to produce a
single aggregated reply message.

The initial request that is received by the message flow, representing a collection of
related request items, is split into the appropriate number of individual requests to
satisfy the subtasks of the initial request. This process is known as fan-out, and it
is provided by a message flow that includes aggregation nodes.

Replies from the subtasks are combined and merged into a single reply, which is
returned to the original requester (or another target application) to indicate
completion of the processing. This process is known as fan-in, and it is also
provided by a message flow that includes aggregation nodes.

A message aggregation is initiated by a message flow that contains the
AggregateControl node followed by an AggregateRequest node. The responses are
aggregated back together using a flow that contains the AggregateReply node. The
aggregation nodes work correctly only for transports that use a request/reply
model; for example, WebSphere MQ Enterprise Transport.

If you use WebSphere MQ Enterprise Transport, the responses that are received by
the fan-in flow must be valid reply messages that contain the reply identifier. You
must set the reply identifier to the value of the message in the request message’s
message descriptor (MQMD), then store the reply identifier in the correlation
identifier field (Correlld) of the MQMD. If the Correlld is set to MQCI_NONE, the
AggregateReply node issues an error because the reply message is not valid, and
cannot be matched to a request message.

WebSphere Message Broker provides three message flow nodes that support
aggregation:

¢ The AggregateControl node

* The AggregateRequest node

* The AggregateReply node

When you include these nodes in your message flows, the multiple fan-out
requests are issued in parallel from within a message flow. The standard operation
of the message flow is for each node to perform its processing in sequence.

You can also use these aggregation nodes to issue requests to applications outside
the broker environment. Messages can be sent asynchronously to external
applications or services; the responses are retrieved from those applications, and
the responses are combined to provide a single response to the original request
message.
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These nodes can help to improve response time because slow requests can be
performed in parallel, and they do not need to follow each other sequentially. If
the subtasks can be processed independently, and they do not need to be handled
as part of a single unit of work, they can be processed by separate message flows.

You can design and configure a message flow that provides a similar function
without using the aggregation nodes, by issuing the subtask requests to another
application (for example, using the HTTPRequest node), and recording the results
of each request in the LocalEnvironment. After each subtask has completed, merge
the results from the LocalEnvironment in a Compute node, and create the
combined response message for propagating to the target application. However, all
the subtasks are performed sequentially, and they do not provide the performance
benefits of parallel operation that you can achieve if you use the aggregation
nodes.

Examples of aggregation flows that use the aggregation nodes are provided in the
following samples:

* |[Ageregation sample]

+ |Airline Reservations sample|

The Aggregation sample demonstrates a simple four-way aggregation, and the
Airline Reservations sample simulates requests that are related to an airline
reservation service, and illustrates the techniques that are associated with
aggregation flows. You can view samples only when you use the information
center that is integrated with the Message Broker Toolkit.

In previous releases of WebSphere Message Broker, the aggregation nodes used a
table in the broker database to persist aggregation requests. From WebSphere
Business Integration Message Broker Version 5.0 onwards, you can use WebSphere
MQ instead. The external functioning of aggregation nodes is unchanged, but you
can configure an execution group to use WebSphere MQ queues for storing
aggregations, instead of a database table. Using WebSphere MQ in this way
improves performance and means that you can run aggregation in a non-persistent
mode when persistence of aggregation requests is not required. For details of how
to migrate and configure an execution group to use WebSphere MQ, see
[WebSphere MQ to store state in aggregation nodes” on page 541If you change
from using a database table to using WebSphere MQ to store aggregation state, no
migration of existing aggregations is performed. Therefore, you must ensure that
no outstanding aggregations exist, because these aggregations are not migrated.

The aggregation nodes store state for aggregations on WebSphere MQ queues. If
you do not specify a timeout on the AggregateControl node, or if you leave it set
to zero, aggregation requests that WebSphere MQ stores internally are never
cleaned up unless all reply messages return. This situation could lead to a gradual
build up of messages on the internal queues. Set the timeout to a value greater
than zero to ensure that requests are cleaned up and queues do not fill with
redundant requests. It is good practice to set the timeout value to a large value, for
example, 864000 seconds (24 hours), so that the queues clear old aggregation
messages even if timeouts are not required or expected.

The aggregation nodes use WebSphere MQ message expiry to manage timeout of
messages. For message expiry to work, the aggregation nodes must browse the
message queues. The aggregation nodes browse the queues automatically to ensure
that expired messages are processed.


/help/livehelp/?pluginID=com.ibm.samplegallery&class=com.ibm.samplegallery.SampleGalleryAction&arg=com.ibm.etools.mft.samples.aggregation.doc/doc/overview.htm
/help/livehelp/?pluginID=com.ibm.samplegallery&class=com.ibm.samplegallery.SampleGalleryAction&arg=com.ibm.etools.mft.samples.airline.xml.doc/doc/overview.htm

On z/0S, you can configure WebSphere MQ to run a scavenger process
that browses the queues instead of the aggregation nodes. To enable the scavenger,
set the broker’s queue manager property EXPRYINT to 5 seconds. If you do not set
EXPRYINT, or set it to a value higher than 10 seconds, the aggregation nodes
revert to browsing the aggregation queues automatically.

Message collection

Message collection is the generation of a single message that can derive from
multiple messages from one or more sources. This single message containing
multiple source messages is known as a message collection.

You can use a Collector node to group together messages from one or more
sources into a message collection, so that they can be processed together by
downstream nodes. You can also manually build a message collection using a
JavaCompute node.

Structure of a message collection

A message collection tree contains sub-trees that hold the content of the individual
messages received by the Collector node. The message assembly that is propagated
from the Collector node to other nodes in your message flow contains the
following four components:

* Message (including transport headers)

* Local environment

* Global environment

* Exception list

The following figure an example of the message tree structure of a message

collection. The message collection in this example contains two messages, one
received from WebSphere MQ, and one from a file input source.
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Root

Properties Collection

<folder name>

<name> / <value> <folder name>

attribute

Collection attributes (name/value pairs)

A message collection has a Properties header and a single folder element named
Collection. A message collection can also have zero or more attributes that are
name/value pairs; the name of an attribute must be unique within a message
collection. These are shown as <name> / <value> in the figure. A standard attribute
for the message collection is an attribute called CollectionName. If you use a
Collector node to generate a message collection, the value for the collection name
is generated based on the values you configure in the node. The collection name
attribute is not compulsory.

Within the Collection folder in the message collection tree structure are folders,
shown as <folder name> in the diagram. These folders contain the message tree of
each message added to the message collection. Each of these folders has a name,
but this name does not have to be unique within the message collection. The value
for the <folder name> is derived from the source of the input message. The
LocalEnvironment, Environment and ExceptionList trees are not included in the
structure, but are instead carried separately as a part of the message assembly.
There is no concept of a LocalEnvironment associated with each message in a
message collection.

You can not use a message collection as a source message for another message
collection. Nested message collections are not permitted. For example, If you
attempt to pass a message collection to a input terminal on a Collector node, an
error is generated.

Generating a message collection using a Collector node
You can use the Collector node to make multiple synchronous or asynchronous

requests in parallel. The results of these requests can be joined together
downstream if required. This is different from the behavior of the aggregation



nodes where there is a fixed pattern of request/response and where reply
messages are grouped by request id. In contrast, the collector node does not need
an initial fan-out stage and can group together unrelated input messages by
correlating their content. You can configure dynamic input terminals on a Collector
node to receive messages from different sources. You can also configure properties
on the Collector node, known as event handlers, to determine how messages are
added to a message collection, and when a message collection is complete.

Processing a message collection

A message collection is supported by the following nodes only:
* Compute

¢ JavaCompute

Errors are generated by other nodes if they receive a message collection.

You can use ESQL or XPATH expressions to access the content of messages in a
message collection by referencing the folder names. To access the contents of a
message in a message collection using ESQL you can use code similar to the
following ESQL:

InputRoot.<collection name>.<folderl>.XMLNSC

Examples of XPath expressions that you can use to access the message collection
are:

e /*: returns a list of all the messages in the message collection.
* /@*: returns a list of all the attributes of the message collection.
* /@Name: returns the value of the attribute Name.

You might not be able to determine the order of the messages within a message
collection. If you generate a message collection using the Collector node, the
messages are arranged in the same order as the messages arrived at the node.

Converting data with message flows

Convert data that you are transferring between different environments.

Data conversion is the process by which data is transformed from the format
recognized by one operating system into that recognized by a second operating
system with different characteristics such as numeric order.

If you are using a network of systems that use different methods for storing
numeric values, or you need to communicate between users who view data in
different code pages, you must consider how to implement data conversion.

Numeric order
For numeric and encoding aspects, consider:
* Big Endian versus Little Endian
* Encoding values in WebSphere MQ (the Encoding field in the MQMD)

Encoding values are system specific. For example, Windows typically
has an encoding of 546, hexadecimal value X’00000222’. The three final
hexadecimal digits identify:

1. The float number format

This value can be 1 (IEEE format byte order normal), 2 (IEEE format
byte order reversed), or 3 (zSeries® format byte order normal).
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Operations on floating point numbers, whether IEEE or z/Series
(S/390%) format, are subject to rounding error.

2. The packed decimal number format

This value can be 1 (byte order normal) or 2 (byte order reversed).
3. The hexadecimal number format

This value can be 1 (byte order normal) or 2 (byte order reversed).

The bit order within a byte is never reversed. Byte order normal means
that the least significant digit occupies the highest address.

Systems that process numbers in normal byte order are Big Endian
(z/Series, iSeries”", Linux, and UNIX). Systems that process numbers in
reversed byte order are Little Endian (mainly PCs).

For further details about numeric order, see "Appendix D Machine
encodings” of the Application Programming Reference section in the
[WebSphere MQ Version 6 information center online}

Code page conversions

Code page conversion might be required for any of the following reasons:
* ASCII versus EBCDIC

* National languages

* Operating system specific code pages

For more information about code page support in WebSphere MQ, see the
Application Programming Reference section in the [WebSphere MQ Version|
{6 information center online}

When you use WebSphere Message Broker, you can use the data conversion
facilities of WebSphere MQ, WebSphere Message Broker, or both.

WebSphere MQ facilities

Headers and message body are converted according to the MQMD values,
and other header format names. You might have to set up data conversion
exits to convert the body of your messages.

When you use WebSphere MQ facilities, the whole message is converted to
the specified encoding and CCSID, according to the setting of the format in
the WebSphere MQ header.

For more detail about data conversion using WebSphere MQ facilities, see
"Appendix F Data conversion” in the Application Programming Reference
section in the [WebSphere MQ Version 6 information center online]

WebSphere Message Broker facilities

You can model your messages in the MRM through the workbench.
Predefined elements of the messages are converted according to their type
and physical layer characteristics. For further details, see
[physical properties| You can also use self-defining messages. You can then

use the Compute or JavaCompute node to configure encoding and CCSIDs.
You do not need WebSphere MQ data conversion exits.

* String data is converted according to the CCSID setting.

* Decimal integer and float extended decimal types are converted
according to the CCSID setting.

* Decimal integer and float (other physical data types) are converted
according to the Encoding setting.

* Binary and Boolean data is not converted.


http://publib.boulder.ibm.com/infocenter/wmqv6/v6r0/index.jsp
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http://publib.boulder.ibm.com/infocenter/wmqv6/v6r0/index.jsp
http://publib.boulder.ibm.com/infocenter/wmqv6/v6r0/index.jsp

WebSphere Message Broker can also convert those WebSphere MQ headers
for which parsers are provided (listed in [‘Parsers” on page 69).

When you use WebSphere Message Broker facilities, the whole message is
not converted to the specified encoding and CCSID: you can specify a
different encoding, or CCSID, or both, in each header to perform a
different conversion for the following part of the message. The encoding
and CCSID in the last header defines the values for the message body.

User exits

A user exit is user-provided custom software, written in C, to track data passing
through message flows.

User-provided functions can be invoked at specific points during the life cycle of a
message while it passes through the message flow, and can invoke utility functions
to query information about the point in the flow, and the contents of the message
assembly.

The user exits can be invoked when one or more of the following events occurs:
* End of unit-of-work (UOW) or transaction (COMMIT or ROLLBACK)

* A message passing between two nodes

* A message dequeued from the input source

MQInput Compute MQOutput

In the basic message flow shown here, you can track messages at two levels:
* Transaction level
* Node level

At the transaction level, you can track the following events:
* Messages being read into the flow
* Completion of the transaction

At the node level, you can track the following events:
* A message passing from one node to another
¢ Completion of processing for one node

Therefore, you can track four different types of events, which occur in the
following sequence:

1. Message dequeued from the input source (read into the flow)
2. Message propagated to the node for processing

3. Node processing completed

4. End of the transaction
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Getting started with Quick Start wizards

A Quick Start wizard sets up the basic resources that are required to develop a
Message Broker application. The wizard sets up and gives names to containers for
the resources in which you subsequently develop your application.

The topics in this section describe how to use the Quick Start wizards.

Concept topics:

* |“Quick Start wizards overview”]

Task topics:

+ [“Creating an application from scratch” on page 123|

+ [“Creating an application based on WSDL or XSD files” on page 124

* [“Creating an application based on an existing message set” on page 125|

+ |“Creating an application using WebSphere Adapters” on page 126|

Quick Start wizards overview
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This concept topic describes the Quick Start wizards.

You can use a Quick Start wizard to set up the basic resources that are required to
develop a Message Broker application. The wizard sets up and gives names to
containers for the resources in which you subsequently develop an application. The
resources that can be set up are as follows:

Message flow project
A specialized container in which you create and maintain all the resources
associated with one or more message flows.

Message set project
A specialized container in which you create and maintain all the resources
that are associated with a message set.

Message set
A container for grouping messages and associated message resources
(elements, types, groups).

Message flow
A container for a sequence of processing steps that execute in the broker
when an input message is received.

Working set
A specialized container in which you can group related application
projects, so that you limit the number of resources that are displayed in the
Broker Development view.

The Quick Start wizards are:

+ Start from scratch, described in [“Creating an application from scratch” on page]
123

+ Start from WSDL and/or XSD files, described in [“Creating an application based|
[on WSDL or XSD files” on page 124|

* Start from existing message set, described in [“Creating an application based on|
[an existing message set” on page 125|

+ Start from adapter connection, described in [“Creating an application using]|
[WebSphere Adapters” on page 126|




Creating an application from scratch

This task topic describes how to use the Start from scratch wizard to create the
basic resources that are required to develop a Message Broker application. The
Start from scratch wizard creates a message flow project, a message set project, sets
up the project dependency, creates a message set and, optionally, creates a message
flow and working set. To create these resources, perform the actions in this topic.

1. Switch to the Broker Application Development perspective.
2. Open the Start from scratch wizard by doing one of the following:

At the top of the Broker Development view, click on the down arrow El .
A list containing the three Quick Start wizards is displayed.

— Click Start from scratch.

¢ Click File> New> Project or right-click anywhere in the Broker Development
view and then click New> Project on the pop-up menu. The New Project
window opens.

a. Expand Message Brokers. A list of wizards is displayed.
b. Click the Start from scratch and click Next.

The New Message Broker Application panel of the wizard is displayed. In this
panel, you can type the names of the basic resources that are required to
develop a Message Broker application.

3. Type into the appropriate fields, the names of the message flow project, the
message set project, the message set, the message flow, and the name of the
working set that contains the two new projects. Default names of the message
flow project, the message flow, and the working set are already displayed in
the appropriate fields, but you can edit these fields by typing your own names
for these resources.

Note: You can change any of the names that are displayed by typing into the
appropriate field the name that you want. You can also clear either of the
check boxes that relate to the creation of a new message flow or a new
working set; if you do this, you cannot enter text into the associated
name field, and the associated resource file will not be created.

4. Click Next. The Message set Physical Formats panel is displayed. The panel
lists three physical formats: XML documents, Binary data (Custom Wire
Format), and Text data (TDS Format).

5. Select one or more of the check boxes to describe the type of message data that
you want to process. If you do not select a check box, XML documents is
selected by default.

6. Click Finish to complete the task. The Start from scratch wizard closes.

The wizard creates a message flow project, message set project, message set, and,
optionally, a message flow, with the names that you have specified. It also creates,
optionally, a new working set, with the name that you have specified. The working
set contains all of the resources you have created, and the Broker Development
view shows the new working set as the active working set. If you have chosen not
to create a new working set, the projects are created in the active working set
currently shown in the Broker Development view.

The XML, CWF or TDS formats are created with default names for the message
set.

The message flow, if created, is opened in the message flow editor.
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If you have created a message flow, you can now go on to [“Defining message flow|

fcontent” on page 218

Creating an application based on WSDL or XSD files
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This task topic describes how to create a new application that is based on existing
WSDL or XSD files.

1. Switch to the Broker Application Development perspective.

2. Open the New Message Broker Application wizard. You can do this in one of
the following ways:

At the top of the Broker Development view, click the down arrow El LA
pop-up window displays the Quick Start wizards.

— Click Start from WSDL and/or XSD files.

Click File> New> Project, or right-click anywhere in the Broker
Development view and then click New> Project. The New Project window
opens.

— Double-click Message Brokers. A list of wizards is displayed.

— Select Start from WSDL and/or XSD files. and click Next.

The first panel of the New Message Broker Application wizard is shown.

3. Set up the basic resources that are required to develop a Message Broker
application that uses existing WSDL and XSD files as a starting point.

Type the name of your new application in the Message flow project name
field.

The name that you type is also displayed in the Message set project name
and Message set name fields, but with "MessageSet” appended.

Similarly, the name that you type is also displayed in the Message flow
name field (with 'Flow” appended), and in the Working set name field.

Click Next.

Note: You can change any of the names that are displayed by typing into
the appropriate field the name that you want. You can also clear
either of the check boxes that relate to the creation of a new message
flow or a new working set; if you do this, you cannot enter text into
the associated name field.

4. Select the WSDL or XSD files that you want to use as the initial contents of
the message set.

If you want to choose WSDL or XSD files that exist in your workspace, click
Use resources from the workspace.

You are presented with a list of resources from which you can choose.

If you want to choose WSDL or XSD files that exist outside your
workspace, click Use external resources and type a directory name in the
From directory field. Click Browse ....

You are presented with a list of the items in that directory. Make your
choice from this list.

In both cases, a two-pane view is displayed. On the left side, containers (for
example, projects, folders, and message sets) are displayed. On the right side,
the contents of these containers are shown. Depending on which button was
clicked, either a workspace view or a file system view of the resources is
displayed.



If the only use of the XSD file is from the WSDL bindings, you do not need to
select an XSD file that a selected WSDL files depends on.

The view incorporates an option that allows you to copy the source file into
the importFiles directory of the message set.

You can use this option as follows:
If you choose only WSDL files, you can select the check box.

If you choose only XSD files, the option is automatically selected and the
check box is greyed out. If you subsequently select a WSDL file, the check box
is enabled but the selection state is not changed; that is, the check box remains
selected.

Regardless of what you select, if the importFiles folder exists in the message
set project after the import, it is collapsed.

If you import only WSDL files, the wizard sets the default message domain to
SOAP.

. Click Next. If you selected one or more WSDL files, the WSDL files that you

selected are shown in a check box tree, with the acceptable bindings for each
file shown as children.

. (Optional) Select one or more bindings for each of the WSDL files that you

selected. If you do not select at least one binding for each WSDL file, an error
message is displayed and the Next and Finish buttons are disabled.

. Click Next. If you selected one or more XSD files, the XSD files that you

selected are displayed in the next pane, with the global elements for each file
shown as children.

. (Optional) Select the global elements from which you want to create message

definitions. Click Next.

. (Optional) If any errors or warnings are listed, either click Finish, if you want

the import to be attempted regardless of the errors or warnings listed, or click
Cancel to terminate the import. You can then correct any errors and attempt
the import again.

10. Click Finish.

After a WSDL file has been imported into a message set, you can drag and drop
the WSDL file onto the message flow editor.

Creating an application based on an existing message set

Before you start:

You must have completed the following task:

* |Creating a message set|

This task topic describes how to create a new application that is based on an
existing message set.

1.
2.

Switch to the Broker Application Development perspective.

Open the New Message Broker Application wizard. You can do this in one of
the following ways:

* At the top of the Broker Development view, click the down arrow El A
pop-up window displays the three Quick Start wizards.

— Click Start from existing message set.
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¢ Click File> New> Project, or right-click anywhere in the Broker
Development view and then click New> Project. The New Project window
opens.

a. Click Message Brokers. A list of wizards is displayed.
b. Click Start from existing message set and then click Next.

The first panel of the New Message Broker Application wizard is shown.

3. Set up the basic resources that are required to develop a Message Broker
application from an existing message set.

a. (Optional) If the message set that you want to use is in a .zip file, click
Import a message set from a ZIP file and either type the location of the
message set in the Zip file and Zipped message set fields, or click
Browse... and select and open the .zip file from the list that is displayed,
and then select the required message set. If the .zip file that you specify
does not contain a message set, you receive a message that tells you this. If
you want, you can then type a different location for the message set in the
Zip file field. Otherwise click Cancel.

b. (Optional) If the message set that you want to use is not in a .zip file, click
Create a new message set by copying an existing message set and type
into the Message set to copy field the name of the message set file that you
want to copy. A list is displayed of the message set names that you can
choose from.

c. Click Next.

A panel of the New Message Broker Application wizard is shown. In this panel,
you can type the names of the projects, the message flow, the message set, and
the working set that contains the two new projects.

4. Type into the appropriate fields, the names of the projects, the message flow,
the message set, and the working set that contains the two new projects.
Default names of the message flow project, the message flow, and the working
set are already displayed in the appropriate fields, but you can edit these fields
by typing your own names for these resources. Note, however, that if the
message set is copied from a .zip file that is a project interchange file, you
cannot edit the names of the message set project and the message set; the
names are imported from the .zip file.

5. Click Finish. The new message set project, message set, message flow project,
and message flow are created. A new working set is also created, if required.
The new projects appear in the specified working set. The contents of the
message set project and the message flow project are displayed in the Broker
Development view. The message flow is opened in the message flow editor.

Creating an application using WebSphere Adapters

Use the Start from adapter connection quick start wizard to create an application
that uses WebSphere Adapters.

Before you start:

* Read ["WebSphere Adapters nodes” on page 7|

* [Prepare the environment for WebSphere Adapters nodes|

+ Perform the preparatory tasks listed in [“Developing message flow applications|
[using WebSphere Adapters” on page 235

1. Switch to the Broker Application Development perspective.
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3.
4.

At the top of the Broker Development view, from the list of Quick Start
wizards, click Start from adapter connection. If the list of wizards is not

displayed, click the down arrow El .
The Adapter Connection wizard opens.
Follow the instructions in the wizard.
Click Finish.

When you have completed the steps in the wizard, the specified message set
project contains a message set with a message type for each business object, and
the specified message flow project references the message set project.

Creating an application using the Configure New Web Service
Usage wizard

Use this topic to generate a message flow using the Configure New Web Service
usage wizard.

This task topic describes how to create a new application using the Configure New
Web Service Usage wizard.

1.
2.

Open a message set project containing a WSDL file.

Select a WSDL file from either the message set or the ImportFiles folder and
drag and drop the WSDL file onto the Message Flow Editor canvas. Validation
occurs and if any of the following errors occurs, a message appears in a
message box:

* WSDL file does not come either from a message set or ImportFiles folder of
the message set project.

For a multiple-file WSDL the process also checks that either, imports inside
the main WSDL have been properly imported into the message set, or
imports are available in the ImportFiles folder.

* The message set that contains the WSDL file does not support any one of the
SOAP, XMLNSC, XMLNS, or MRM domains.

However, if the message set that contains the WSDL file does not support
only the SOAP domain, you are given an option to generate a flow based on
the HTTP nodes, and the process continues.

* There are no HTTP bindings in the WSDL file.
* There are no port types in the WSDL file.
If there are no errors, the first page of a Configure New Web Service Usage

wizard appears. See |Configure Web Service Usage details| for further
information on the following fields.

In Web service usage, select Expose message flow as a web service or Invoke
web service from message flow. Selecting Expose message flow as a web
service means that you can use WebSphere Message Broker with other
applications on the web, whereas selecting Invoke web service from message
flow means that you use WebSphere Message Broker to start the web service.

Select the Port type you are going to use. By default, the initially selected port
type is the first one that has at least one http binding associated with it.

You receive an error message in the following circumstances:
* Selected port type does not contain at least one operation.

* No SOAP bindings (with HTTP transport) in the WSDL document are
associated with the port type.
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5. Select the Binding you are going to use. You receive an error message in the
following circumstances:

* Selected binding has no operations associated with it.
* Selected binding has no ports associated with it.
The Service Port box lists all the WSDL ports that point to a selected binding.

6. Select the Binding operations that you require. By default, only those
operations implemented by the binding you choose are selected.

If you select one of the operations that is not implemented by the selected
binding, you receive a warning message, but you can continue.

7. Click Next to go to the second page . See [File generation details| for further
information on the following fields.

8. Select HTTP nodes if you have imported the WSDL file from a message set
and do not want the default value of SOAP nodes. If you select HTTP nodes
you see a message explaining the advantages of using the SOAP nodes. Using
SOAP nodes allows you to use features such as WS_Security and
WS_Addressing. However, if the message set does not support the SOAP
domain you receive an error message.

Note, that if you import the WSDL file from the ImportFiles folder, you cannot
select SOAP nodes.

All the file names that are about to be generated, together with their location
are listed on this page.

A Details pane appears if there are any warnings about the subflow that is
generated.

9. Click Finish to complete the wizard, create the subflow, and add appropriate
nodes to the main flow. See [“Web service provider message flow generated”| for
details about the subflow and nodes generated by the wizard if you selected
Expose message flow as a web service as the initial step.

See [“Web service consumer message flow generated” on page 129|for details
about the subflow and nodes generated by the wizard if you selected Invoke
web service from message flow as the initial step.

Web service provider message flow generated

This provides additional information in relation to the Configure New Web Service
Usage wizard about the message flow generated when the flow is a web service
provider.

Note that the default name for the generated subflow is prefixed by the name of
the WSDL file you selected.

Generated message flow

The message flow generated consists of a:

SoapInput node
This SOAPInput node fills in the LocalEnvironment destination tree with the
SOAP operation so that it can be followed either by a:

¢ SOAPExtract node, or by a
* RouteTolabel node. In this case, appropriate Label nodes need to be in
place.

The out terminal of the SOAPInput node is connected to the in terminal of
the SOAPExtract node.



Subflow node
The subflow node name reflects the name of the WSDL file.

SOAPReply node
This node sends the response message back to the originating client.

Typically, you connect the output of your node, or nodes, that handle your
operation, or operations, to the in terminal of the SOAPReply node.

Generated message subflow

The generated subflow is constructed as follows:

* The input node is connected to the SOAPExtract node, which removes the SOAP
envelope.
The SOAPExtract node also allows for routing of the SOAP messages, based on
the operation being performed. In particular, the SOAP message is routed to a
Label node within the message flow as identified by the SOAP operation within
the message.

* The Failure output terminal of the SOAPExtract node is connected to the Output
node used when a process fails named, for example, failure.

* A Label node is generated for each SOAP operation and each Label node is
connected to the corresponding Output node.

* Each Output node in the subflow corresponds to an output terminal for the
SOAPExtract node in the main message flow.
Therefore, there is one failure output terminal, plus one output terminal for
each operation.
Typically, you connect the output terminal corresponding to the operation you
require to the node, or nodes, that handle this operation, for example, Compute
node.

Web service consumer message flow generated

This provides additional information in relation to the Configure New Web Service
Usage wizard about the message flow generated when the flow is a web service
consumer.

Note that the default name for the generated subflow is prefixed by the name of
the WSDL file you selected.

Generated message flow

The low generated consists of a single node that has a number of output terminals:
e Failure

* Error

e Fault

* One more, corresponding to the name of the selected operation.

Typically, your message flow feeds an input message to the in terminal of the
generated subflow node, and handles various outcomes of the web service
invocation.

The default name of the subflow node is a combination of selected operation and
WSDL file name. You can change the name of the corresponding .msgflow file on
the second page of the wizard; see |Configure New Web Service Usage wizard: File|
[zeneration details|
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The generated .msgflow file is placed into the gen folder of the message set project;
see [“Generated message subflow”| for details of this subflow.

Generated message subflow

The generated subflow is constructed as follows:
* A SOAPRequest node immediately follows an Input node. This is a synchronous

request and response node that blocks after sending the request, until the
response is received. The SOAPRequest node parses the response message.

The Failure and Error terminals are connected to the Output nodes for failure
and error respectively.

The Out terminal is connected to the SOAPExtract node.

The SOAPExtract node removes the SOAP envelope so that the body of a SOAP
message is extracted.

The SOAPExtract node also allows for routing of the SOAP messages, based on
the operation being performed. Note that only the selected operation and fault
are handled.

In particular, the SOAP message is routed to a Label node within the message
flow as identified by the SOAP operation or a ws__Fault label, if fault is
returned from the web service.

Each Label node is connected to the corresponding Output node.

The Failure terminal of the SOAPExtract node is connected to the Output node
for failure.

Each Output node in the subflow corresponds to an output terminal for the
subflow node.

Therefore, there are three output terminals:
— Failure
- Fault

— One for the selected operation.

Designing a message flow

130 Message Flows

A message flow can perform a wide range of operations, depending on your
business and operational requirements. For best performance and capability, you
must design it to include the most appropriate nodes.

Before you start:

Read the concept topic about jmessage flow nodes}

When you design a message flow, consider the following questions and options:
* Which nodes provide the function that you require. In many cases, you can

choose between several nodes that provide a suitable function. You might have
to consider other factors listed here to determine which node is best for your

overall needs. You can include built-in nodes, user-defined nodes, and subflow
nodes. For more information, see [‘Deciding which nodes to use” on page 132

Whether it is appropriate to include more than one input node. For more
information, see [“Using more than one input node” on page 143

How to specify the characteristics of the input message. See [“Defining input|
[message characteristics” on page 144| for more details.

Whether to determine the path that a message follows through the message
flow, based on the content or the characteristics of the message. Several nodes



provide checks or examination of the message, and have output terminals that
can be connected to direct certain messages to different nodes. For more
information, see [“Using nodes for decision making” on page 145

Whether you can use subflows that provide a well-defined subset of processing.
You might be able to reuse subflows that were created for another project (for
example, an error processing routine). Or you might create a subflow in your
current project, and reuse it in several places within the same message flow. For
more information, see [“Using subflows” on page 147 |

What response times your applications expect from the message flow. This factor
is influenced by several aspects of how you configure your nodes and the
message flow. For more information, see [“Optimizing message flow response
[times” on page 149

Whether your message flow processing makes demands on system resources
such as stack size. For more information, see [‘System considerations for message]
[flow development” on page 151

Whether you can use the destination list within the LocalEnvironment that is
associated with the message to determine the processing within the message
flow (for example, using RouteToLabel and Label nodes), or the target for the
output messages (for example, by setting the Destination Mode property of the
MQOutput node to Destination List). For more information, see I”Creatina
[destination lists” on page 154.|

Whether to use WebSphere MQ cluster queues. For more information, see
[“Using WebSphere MQ cluster queues for input and output” on page 154

Whether to use WebSphere MQ shared queues on z/OS . For more information,
see [“Using WebSphere MQ shared queues for input and output (z/OS)” on|

|Eage 156.|

Whether to validate input messages that are received by the input node, or
output messages that are generated by the Compute node, or both. For more
information, see [“Validating messages” on page 156,

Whether to view or record message structure in Trace node output. For more
information, see |“Viewing the logical message tree in trace output” on page 159,

Whether your message flows access data in databases. You must configure
brokers, databases, and database connections to enable this function, as
described in |Configuring databases| You must also configure your message
flows; see [’Accessing databases from message flows” on page 162

If you include nodes that use ESQL, see [“Accessing databases from ESQL” on|

age 164 for information about how to code the appropriate statements. If you
want to access databases from Java nodes using JDBC, see [“Interacting with|
databases using the JavaCompute node” on page 424| or [Extending the capability|
of a Java message processing or output node}

You can also access databases through the Broker Application Development
perspective in the workbench; see [“Adding database definitions to the Message|
[Broker Toolkit” on page 448 |

Whether your message flows access data in files. Using the FileInput and
FileOutput nodes, your message flows can read messages from files and write
messages to files in the local file system, or on a network file system that
appears local to the broker. For more information, see [“Working with files” onl|
hae 659,

Whether your messages must be handled within a transaction. You can set the
properties of some built-in nodes to control how transactions are managed, and
how messages are processed within a transaction. For more information, see
[‘Configuring globally coordinated message flows” on page 166
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If you want to include JMSInput and JMSOutput nodes in your message flow
transactions, you must consider the additional information in |”Configurina
[[MSInput and JMSOutput nodes to support global transactions” on page 169

* Whether you want your messages to go through data conversion. The available

options are described in [‘Configuring message flows for data conversion” on|
page 174,

* Whether you want to use the MQGet node. [“Using MQGet nodes” on page 176|
explains how messages are processed by the MQGet node, and describes a
request-reply scenario using this node.

* How your message flows can benefit from user exits. For more information, see
[“Exploiting user exits” on page 189.|

* What steps to take to ensure that messages are not lost. For more information,
see [“Ensuring that messages are not lost” on page 191

* How errors are handled within the message flow. You can use the facilities
provided by the broker to handle any errors that arise during message flow
execution (for example, if the input node fails to retrieve an input message, or if
writing to a database results in an error). However, you might prefer to design
your message flow to handle errors in a specific way. For more information, see
[‘Handling errors in message flows” on page 194

For a basic introduction to developing message flows, see the IBM Redbooks
publication [WebSphere Message Broker Basics} (This link works only if you are
connected to the Internet.)

Deciding which nodes to use

132 Message Flows

WebSphere Message Broker includes a large number of message processing nodes
that you can use within your message flows.

Before you start:

Read the concept topic about jmessage flow nodes|

WebSphere Message Broker also provides an interface that you can use to define
your own nodes, known as user-defined nodes.

Your decision about which nodes to use depends on the processing that you want
to perform on your messages.

Input and output nodes
Input and output nodes define points in the message flow to which client
applications send messages (input nodes, such as MQInput), and from
which client applications receive messages (output nodes, such as
MQOutput). Client applications interact with these nodes by putting
messages to, or getting messages from, the I/O resource that is specified
by the node as the source or target of the messages. Although a message
flow must include at least one input node, it does not need to include an
output node.

* If you are creating a message flow that you want to deploy to a broker,
you must include at least one input node to receive messages. The input
node that you choose depends on the source of the input messages, and
where in the flow you want to receive the messages:


http://www.redbooks.ibm.com/abstracts/sg247137.html

MQInput
Use an MQInput node if the messages arrive at the broker on a
WebSphere MQ queue, and the node is to be at the start of a
message flow.

The use of message flows that contain MQelnput nodes in
WebSphere Message Broker Version 6.1 is deprecated. Redesign
your message flows to remove the MQe nodes and replace them
with MQ nodes that are configured to your own specifications
and coordinated with your MQe Gateway configuration. For
more details, see [Migrating a message flow that contains|
[WebSphere MQ Everyplace nodes]

MQGet
Use an MQGet node if the messages arrive at the broker on a
WebSphere MQ queue and the node is not to be at the start of a
message flow.

SCADAInput
Use a SCADAInput node if the messages are sent by a telemetry
device.

HTTPInput
Use an HTTPInput node if the messages are sent by a Web
services client.

FileInput
Use a FileInput node if the messages are contents of files.

Real-timeInput or Real-timeOptimizedFlow
Use one of these nodes if the messages are sent by a JMS or
multicast application.

The Real-timelnput node is an input node and the
Real-timeOptimizedFlow node is a complete message flow that
provides a high performance publish/subscribe message flow.

JMSInput
Use a JMSInput node if the messages are sent by a JMS
application.

User-defined input node
Use a user-defined input node if the message source is a client
or application that uses a different protocol or transport.

Input node
If you are creating a message flow that you want to embed in
another message flow (a subflow) that you will not deploy as a
standalone message flow, you must include at least one Input
node to receive messages into the subflow.

An instance of the Input node represents an In terminal. For
example, if you have included one instance of the Input node,
the subflow icon shows one In terminal, which you can connect
to other nodes in the main flow in the same way that you
connect any other node.

To deploy a message flow, it must have at least one input node.
If your message flow does not contain an input node, you are
prevented from adding it to the broker archive file. The input
node can be in the main flow, or in a message flow that is
embedded in the main flow.
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You can use more than one input node in a message flow. For
more information, see [“Using more than one input node” on|

* If you want to send the messages that are produced by the message flow

to a target application, you can include one or more output nodes. The
output node that you choose depends on the transport across which the
target application expects to receive those messages:

Publication
Use a Publication node to distribute the messages using the
publish/subscribe network for applications that subscribe to the
broker across all supported protocols. A Publication node is an
output node that uses output destinations that are identified by
subscribers whose subscriptions match the characteristics of the
current message.

MQOutput
Use an MQOutput node if the target application expects to
receive messages on a WebSphere MQ queue, or on the
WebSphere MQ reply-to queue that is specified in the input
message MQMD.

The use of message flows that contain MQeOutput nodes in
WebSphere Message Broker Version 6.0 is deprecated. Redesign
your message flows to remove the MQe nodes and replace them
with MQ nodes that are configured to your own specifications
and coordinated with your MQe Gateway configuration. For
more details, see [Migrating a message flow that contains|
[WebSphere MQ Everyplace nodes}

MQReply
Use an MQReply node if the target application expects to receive
messages on the WebSphere MQ reply-to queue that is specified
in the input message MQMD.

SCADAOutput
Use a SCADAOutput node if a telemetry device is the target of
the output messages, and the Publication node is not suitable.

HTTPReply
Use an HTTPReply node if the messages are in response to a
Web services client request.

HTTPRequest
Use an HTTPRequest node if your message flow interacts with a
Web service.

FileOutput
Use a FileOutput node if a file is the target of the output
messages.

Real-timeOptimizedFlow
Use a Real-timeOptimizedFlow node if the target application is a
JMS or multicast application.

JMSOutput
Use a JMSOutput node if the messages are for a JMS destination.

JMSReply
The JMSReply node has a similar function to the J]MSOutput
node, but the JMSReply node sends JMS messages only to the



reply destination that is supplied in the JMSReplyTo header field
of the J]MS message tree. Use the JMSReply node to treat a J]MS
message that is produced from a message flow as a reply to a
JMS input message, and where you have no other routing
requirements.

User-defined output node
Use a user-defined output node if the target is a client or
application that uses a different protocol or transport.

EmailOutput node
Use the EmailOutput node to send e-mail messages to one or
more recipients.

Output node
If you are creating a message flow that you want to embed in
another message flow (a subflow) that you will not deploy as a
standalone message flow, you must include at least one Output
node to propagate messages to subsequent nodes that you
connect to the subflow.

An instance of the Output node represents an Out terminal. For
example, if you have included two instances of the Output node,
the subflow icon shows two Out terminals, which you can
connect to other nodes in the main flow in the same way that
you connect any other node.

WebSphere Adapters nodes
Use the WebSphere Adapters nodes to interact with Enterprise
Information Systems (EIS) like SAP, Siebel, and PeopleSoft. The
following input and request nodes are available:
— SAPInput node
— SAPRequest node
— Siebellnput node
— SiebelRequest node
— PeopleSoftInput node
— PeopleSoftRequest node
— Twineballlnput node
— TwineballRequest node

The WebSphere Adapters input nodes monitor an EIS for a
particular event. When that event occurs, business objects are
sent to the input node. The node constructs a tree representation
of the business objects and propagates it to the Out terminal so
that the data can be used by the rest of the message flow.

The WebSphere Adapters request nodes can send and receive
business data. They request information from an EIS and
propagate the data to the rest of the message flow.

Nodes for manipulating, enhancing, and transforming messages

Most enterprises have applications that have been developed over many
years, on different systems, using different programming languages, and
different methods of communication. WebSphere Message Broker removes
the need for applications to understand these differences by providing the
ability to configure message flows that transform messages from one
format to another.

For example, personal names are held in many forms in different
applications. Family name first or last, with or without middle initials,
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upper or lower case: these are just some of the permutations. Because you
can configure your message flow to know the requirements of each
application, each message can be transformed to the correct format without
modifying the sending or receiving application.

You can work with the content of the message to update it in several ways.
Your choices here might depend on whether the message flow must handle
predefined (modeled) messages, self-defining messages (for example,
XML), or both.

A message flow can completely rebuild a message, convert it from one
format to another (whether format means order of fields, byte order,
language, and so on), remove content from the message, or introduce
specific data into it. For example, a node can interact with a database to
retrieve additional information, or to store a copy of the message (whole or
part) in the database for offline processing.

The following examples show how important message transformation can
be:

* An order entry application has a Part ID in the body of the message, but
its partner stock application expects it in the message header. The
message is directed to a message flow that knows the two different
formats, and can therefore reformat the information as it is needed.

* A data-entry application creates messages containing stock trade
information. Some applications that receive this message need the
information as provided, but others need additional information added
to the message about the price to earnings (PE) ratio. The stock trade
messages are directed to a message flow that passes the message
unchanged to some output nodes, but calculates and adds the extra
information for the others. The message flow does this by looking up the
current stock price in a database, and uses this value and the trade
information in the original message to calculate the PE value before
passing on the updated message.

You can also create message flows that use these nodes to interact with
each other. Although the default operation of one message flow does not
influence the operation of another message flow, you can force this action
by configuring your message flows to store and retrieve information in an
external source, such as a database.

Compute
Use the Compute node to:

* Manipulate message content
* Transform the message in some way

* Interact with a database to modify the content of the message or
the database and pass on one or more new messages

You can use this node to manipulate predefined and self-defining
messages.

Use the ESQL editor to create an ESQL module, specific to this
node, that contains the statements that define the actions to
perform against the message or database. Do not use the ESQL
code that you develop for use in a Compute node in any other
type of node.

You can control the way in which the database is accessed by this
node by specifying user and password information for the data



source that you specify in the node property. Use the
mgsisetdbparms command to initialize and maintain these values.

If your message manipulation requirements are complex, perform
these within a single Compute node. Fewer, more complex
Compute nodes perform better than a larger number of simpler
nodes because the broker parses the message on entry to each
Compute node.

JavaCompute

Use the JavaCompute node to:

* Examine an incoming message and, depending on its content,
propagate it unchanged to one of the node’s two output
terminals. The node behaves in a similar way to a Filter node,
but uses Java instead of ESQL to decide which output terminal
to use.

* Change part of an incoming message and propagate the changed
message to one of the output terminals.

* Interact with a database through a JDBC type 4 connection to
modify the content of the message or the database and pass on
one or more new messages

* Create and build a new output message that is totally
independent of the input message.

Mapping

Extract

Use the Mapping node to create a new message from the input
message by mapping the content of elements of the output
message from elements of the input message, or from database
content. You can also extract parts of the message, and optionally
change their content, to create a new output message that is a
partial copy of the message that is received by the node. The
Mapping node handles only predefined messages.

You can control the way in which the database is accessed by this
node by specifying user and password information for the data
source that you specify in the node property. Use the
mgqsisetdbparms command to initialize and maintain these values.

Use the Mapping editor to develop mappings to perform simple
manipulations on predefined messages. Do not use the mappings
that you develop for use in a Mapping node in any other type of
node.

The Extract node is deprecated in WebSphere Message Broker
Version 6.1. Although message flows that contain an Extract node
remain valid in WebSphere Message Broker Version 6.1, where
possible, redesign your message flows so that any Extract node is
replaced by a Mapping node.

With an Extract node you can create a new output message from
specified elements of the input message. You can extract parts of
the message, and optionally change their content, to create a new
output message that is a partial copy of the message received by
the node. The Extract node handles only predefined messages.
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Use the Mapping editor to develop mappings to perform simple
manipulations on predefined messages in the Extract node. Do not
use the mappings that you develop for use in an Extract node in
any other type of node.

Database

Use the Database node to interact with a database that is identified
by the node properties. The Database node handles both
predefined and self-defining messages. Use the ESQL editor to
code ESQL functions to update database content from the message,
insert new information into the database, and delete information
from the database, perhaps based on information in the message.
Do not use the ESQL code that you develop for use in a Database
node in any other type of node.

This node provides a very flexible interface with a wide range of
functions. It also has properties that you can use to control the way
in which the interaction participates in transactions.

You can control the way in which the database is accessed by this
node by specifying user and password information for the data
source that you specify in the node properties. Use the
mgsisetdbparms command to initialize and maintain these values.

You can update only databases from this node; you cannot update
message content. If you want to update message content, use the
Compute or Mapping node.

DataDelete, Datalnsert, DataUpdate

The DataDelete, Datalnsert, and DataUpdate nodes are specialized
forms of the Database node that provide a single mode of
interaction (deletion of one or more rows, insertion of one or more
rows, or update of one or more existing rows respectively).

The DataDelete, Datalnsert, and DataUpdate nodes handle only
predefined messages. Use a mapping editor to develop mappings
to perform these functions. Do not use the mappings that you
develop for these nodes in any other type of node. These nodes
also let you control the transactional characteristics of the updates
that they perform.

You can control the way in which the database is accessed by this
node by specifying user and password information for the data
source that you specify in the node property. Use the
mgsisetdbparms command to initialize and maintain these values.

You can update only databases from these nodes; you cannot
update message content. If you want to update message content,
use the Compute or Mapping node.

Warehouse

The Warehouse node provides a store interface that you can use to
store all or part of the message in a database, for example, for
audit reasons. The Warehouse node handles only predefined
messages. Use the Mapping editor to develop mappings to perform
this action. Do not use the mappings that you develop for a
Warehouse node in any other type of node.

You can control the way in which the database is accessed by this
node by specifying user and password information for the data



source that you specify in the node property. Use the
mgsisetdbparms command to initialize and maintain these values.

You can update only a database from this node; you cannot update
message content. If you want to update message content, use the
Compute or Mapping node.

DatabaseRoute node
Use the DatabaseRoute node to route a message using information
from a database in conjunction with applied XPath routing
expressions. The node looks up a collection of named column
values from a located database row and synchronously applies one
or more XPath expressions to these acquired values. Use the
DatabaseRoute to implement message routing with minimal
programming logic. For more advanced routing scenarios, use a
Compute node or a JavaCompute node.

DatabaseRetrieve node
Use the DatabaseRetrieve node to ensure that information in a
message is up to date. Use the node to modify a message using
information from a database. For example, you can add
information to a message using a key, such as an account number,
that is contained in a message. Use the DatabaseRetrieve to
implement message routing with minimal programming logic. For
more advanced routing scenarios, use a Compute node or a
JavaCompute node.

XSLTransform

Use the XSLTransform node (formerly known as the
XMLTransformation node) to transform an input XML message
into another format using XSLT style sheets and to set the message
domain, message set, message type, and message format for the
generated message. It is imperative that the data can be parsed
into a XML message. The style sheet, using the rules that are
defined within it, can perform the following actions:

e Sort the data
¢ Select data elements to include or exclude based on some criteria
¢ Transform the data into another format

The Xalan-Java transformation engine (Apache Xalan-java XSLT]|
is used as the underlying transformation engine. For
more information about XML Transformations, the W3C
specification of the syntax, and semantics of the XSL
Transformations language for transforming XML documents into
other XML documents, see [W3C XSL Transformations]

You can deploy style sheets and XML files to broker execution
groups, to help with style sheet and XML file maintenance.

JMSMQTransform
Use the JMSMQTransform node to transform a message with a JMS
message tree into a message that has a tree structure that is

compatible with the format of messages that are produced by the
WebSphere MQ JMS provider.

The J]MSMQTransform node can be used to send messages to
legacy message flows and to interoperate with WebSphere MQ JMS
and WebSphere MQ Publish/Subscribe.
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MQJMSTransform
Use the MQJMSTransform node to receive messages that have a
WebSphere MQ JMS provider message tree format, and transform
them into a format that is compatible with messages that are to be
sent to JMS destinations.

You can use the MQJMSTransform node to send messages to
legacy message flows and to interoperate with WebSphere MQ JMS
and WebSphere MQ Publish/Subscribe.

MQOptimizedFlow

Use the MQOptimizedFlow node to replace a publish/subscribe
message flow that consists of an MQInput node connected to a
Publication node, and that uses the JMS over WebSphere MQ
transport. The MQOptimizedFlow node cannot be used on z/0S
systems.

Use the MQOptimizedFlow node to improve performance,
particularly where a single publisher produces a persistent
publication for a single subscriber.

User-defined
Use a user-defined node to handle specific requirements that are
not met by the built-in nodes.

For example, if your node accesses a database, include a
user-defined node to interact with the database. You can control
the way in which the database is accessed by this node by
specifying user and password information for the data source that
you specify in the node property. Use the mgsisetdbparms
command to initialize and maintain these values.

Nodes for making decisions

You can use nodes that determine the order and flow of control within the
message flow in various ways to make decisions about how messages are
processed by the flow. You can also use nodes (TimeoutControl and
TimeoutNotification) that determine the time, and frequency of occurrence,
of events within the message flow. Routing is independent of message
transformation, although the route that a message takes might determine
exactly what transformation is performed on it.

For example, a money transfer application always sends messages to one
other application. You might decide that every message with a transfer
value of more than $10,000 must also be sent to a second application, to
enable all high-value transactions to be recorded.

In another example, a national auto club offers a premier service to specific
members for orders above a threshold value. Most orders are routed
through the usual channels, but, if the membership number and order
value meet certain criteria, the order gets special treatment.

You can also establish a more dynamic routing option by building
additional routing information into the message when it is processed.
Optional sets of rules are set up to receive messages according to values
(destinations) set into the message. You can establish these rules such that
a message is processed by one or more of the optional sets of rules, in an
order determined by the added message content.

Use the following nodes to make decisions about the route that a message
follows through the message flow:



Validate

Filter

Use the Validate node to check that the message that arrives on its
input terminal is as expected. You can check that the message has
the expected message template properties (that is, the message
domain, message set and message type) and that the content of the
message is correct. You can check the message against one or more
of message domain, message set, or message type.

The Validate node replaces the Check node, which is deprecated in
WebSphere Message Broker Version 6.1. The Validate node works
in the same way as the Check node, but it has additional
Validation properties to allow the validation of message content by
parsers that support that capability.

Use the Filter node with an ESQL statement to determine the next
node to which the message is sent by this node. Do not use the
ESQL code that you develop for use in a Filter node in any other
type of node.

The node’s terminals are True, False, Unknown, and Failure; the
message is propagated to the True terminal if the test succeeds,
and to the False terminal if it fails. If the statement cannot be
resolved (for example, it tests the value of a field that does not
appear in the input message), the message is propagated to the
Unknown terminal. If any other error is detected, the message is
propagated to the Failure terminal.

The test in the ESQL statement can depend on message content,
database content, or a combination of the two.

If you reference a database, you can control the way in which it is
accessed by this node by specifying user and password information
for each data source defined in the registry on the broker system.
Use the mgsisetdbparms command to initialize and maintain these
values.

Use this node in preference to the Compute node to provide
message selection and routing; the Filter node is more efficient for
this task.

FlowOrder

Connect the terminals of this node to force the message to be
processed by one sequence of nodes, followed by a second
sequence of nodes.

Passthrough

Use the Passthrough node to enable versioning of a subflow at run
time. Use this node to add a label to your subflow. By combining
this label with keyword replacement from your version control
system, you can identify which version of a subflow is included in
a deployed message flow. You can use this label for your own
purposes. If you have included the correct version keywords in the
label, you can see the value of the label:

* Stored in the broker archive (bar) file, using the mqsireadbar
command

* As last deployed to a particular broker, on the properties of a
deployed message flow in the Message Broker Toolkit

* In the run time, if you enable user trace for that message flow
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Route node

Use the Route node to direct messages that meet certain criteria
down different paths of a message flow. For example, you might
need to forward a message to different service providers, based on
the request details. You can also use the Route node to bypass
unnecessary steps. For example, you can check to see if certain
data is in a message, and perform a database lookup operation
only if the data is missing. If you set the Distribution Mode
property to All, you can trigger multiple events that each require
different conditions. For example, you could log requests that
relate to a particular account identifier, and send requests that
relate to a particular product to be audited.

Use the Route node to implement message routing with minimal
programming logic. For more advanced routing scenarios, use a
Compute node or a JavaCompute node.

RouteToLabel and Label

Use the RouteToLabel node following a Compute node for complex
routing. Define a list of destinations in a Compute node that are
acted on by the RouteToLabel node, which interrogates the
destinations and passes the message on to the corresponding Label
node.

ResetContentDescriptor

Use the ResetContentDescriptor node to set new message
properties that are used when the message bit stream is next
parsed by a subsequent node in the message flow.

Nodes for controlling time-sensitive operations

You might want a batch job to run every day at a specific time, or
you might want information to be processed and published at
fixed intervals (for example, currency exchange rates are calculated
and sent to banks), or you might want to take a specified recovery
action if certain transactions are not completed within a defined
time. For all these cases two timeout nodes (TimeoutControl and
TimeoutNotification) are provided.

TimeoutControl
Use a TimeoutControl node and a TimeoutNotification
node together in a message flow to control events that
occur at a specific time or at defined time intervals. The
TimeoutControl node receives an input message that
contains a timeout request. All or part of this input
message is validated and stored to be propagated by an
associated TimeoutNotification node in the message flow.
The input message is also propagated unchanged to the
next node in the message flow.

More than one TimeoutControl node can be associated
with each TimeoutNotification node.

TimeoutNotification
Use a standalone TimeoutNotification node to generate
messages that are propagated at configured times or time
intervals to the next node in the message flow for further
processing.

Nodes for collating requests



Use the AggregateControl, AggregateReply, and AggregateRequest nodes
to collate related requests and responses. Use these nodes to generate
several requests in response to one input message, to control and
coordinate the responses that are received in response to those requests,
and to combine the information that is provided by the responses to
continue processing.

Nodes for handling and reporting errors
Use the following nodes to affect error handling and reporting:

Trace Include a Trace node to generate one or more trace entries to
record what is happening in the message flow at this point.

TryCatch
Include a TryCatch node to control the error processing when
exceptions are thrown.

Throw
Include a Throw node to force an exception to be thrown, and
specify the identity of the exception, to make it easier to diagnose
the problem.

Using more than one input node

You can include more than one input node in a single message flow.
Before you start:

Read the following concept topic:

+ ["Message flow nodes” on page 5|

You might find this useful in the following situations:

* The message flow provides common processing for messages that are received
across multiple transports. For example, a single message flow might handle:

— Data in messages received across WebSphere MQ, and therefore through a
WebSphere MQ queue and an MQInput node

— Messages that are received across native IP connections (a Real-timelnput
node)

* You need to set standard properties on the MQInput node if input messages:
- are predefined, and
— are all received across WebSphere MQ, and
— do not include an MQRFH2 header.

If the required standard properties are not always the same for every message,
you can include more than one input node and configure each to handle a
particular set of properties.

This requirement is not necessary for self-defining messages.

* Each input node in a message flow causes the broker to start a separate thread
of execution. Including more than one input node might improve the message
flow performance. However, if you include multiple input nodes that access the
same input source (for example, a WebSphere MQ queue), the order in which
the messages are processed cannot be guaranteed. If you want the message flow
to process messages in the order in which they are received, this option is not
appropriate.

If you are not concerned about message order, consider using additional
instances of the same message flow rather than multiple input nodes. If you set
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the Additional Instances property of the message flow when you deploy it to the
broker, multiple copies of the message flow are started in the execution group.
This is the most efficient way of handling multiple instances.

Look at the following sample :

* [Scribble sample]

This sample uses two input nodes: an MQInput node and a Real-timeInput node.
You can use these two input nodes to enable the sample’s message flow to accept
input across both WebSphere MQ transport and native IP connections. You can
view samples only when you use the information center that is integrated with the
Message Broker Toolkit.

Defining input message characteristics
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When a message is received by an input node in a message flow, the node detects
how to interpret that message by determining the domain in which the message is
defined and starting the appropriate parser.

Before you start:

Read the following concept topic:

+ [“Parsers” on page 69|

You can provide message domain information to the input node in one of two

ways:

1. You can configure the built-in input nodes to indicate the message domain, and
therefore the parser to be started, for each message that is received.

2. You can set values in the input message itself that specify this information.
Include an MQRFH?2 header, which contains a folder that defines the message
characteristics. This approach is more flexible because it means that the input
node can start the appropriate parser based on the content of each message.

If the input message is defined in the MRM domain, and is therefore interpreted
by the MRM parser, you must specify the following additional properties:

* The Message set within which the message is defined

* The Message type, which is defined by the message model

* The Message format, which defines the physical characteristics of the message

The way that these properties are set depends upon the type of message, or node,
that you want to use:

* If the message is a WebSphere MQ message, these properties can be set either in
the input node or in the MQRFH2 header of the incoming message. If the
properties are set in both, the properties of the MQRFH2 header take
precedence. If the properties are not found in either the node or the MQRFH2
header, the default value is empty and the BLOB parser is used.

e If the message is a J]MS message, the property that is set on the node takes
precedence. If the Message domain is empty, the Message domain is, by default,
derived according to certain criteria following a predetermined order of
precedence; see [Order of precedence for deriving the message domain}

¢ If the input message belongs to a Message domain other than those for which a
parser is supplied, you must provide a user-defined parser to handle it, and a
user-defined input node to accept it for processing in the message flow. Check
the documentation provided with the user-defined parser and node for further
information.
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¢ If the Message domain is in a TimeoutControl node, an empty Message domain
has either of the following results:

— If the Stored message location property is also empty, the full message is
stored. When the message comes back at TimeoutNotification, it is parsed in
the same way as the original message.

— If the Stored message location property is not empty, a partial message is
stored and no parser is associated, so, by default, it is treated as BLOB.

* If the Message domain is in a ResetContentDescriptor node, an empty Message
domain has either of the following results:

— If Reset message domain is cleared, the domain is not reset.

— If Reset message domain is selected, the default is BLOB.

e If the input node cannot determine the message characteristics, the default value

is empty and the message is considered to be in the BLOB domain, and the
BLOB parser is started.

Import either of the following samples, or another sample that uses a Message set,
from the Samples Gallery, and look at the values on the Input Message Parsing
properties tab of the input node in the sample’s message flow.

* [Video Rental sample|
+ [Comma Separated Value (CSV) sample|

You can view samples only when you use the information center that is integrated
with the Message Broker Toolkit.

Using nodes for decision making

Before you start:

Read the concept topic about [message flow nodes]

You can use several built-in nodes in different ways to control the path that a
message takes through the message flow.

These nodes let you decide how messages are processed by specifying the route
that each message takes through the message flow based on dynamic values such
as message structure and content.

For more information, see the following topics:

+ [“Testing the message structure (Check node)”]

+ [“Controlling the order of processing within a message flow” on page 146|

+ [“Testing the message content (Filter node)” on page 146|

+ |“Using the destination list to route messages (RouteToLabel and Label nodes)’]
on page 147]

Testing the message structure (Check node)
Use the Check node to test the characteristics of the message structure.

If you set the node properties appropriately, you can request that one or all of the
message domain, message set, and message type are compared to a specific value.
If the message matches those values for which you have requested the check, it is
routed through the match terminal and is processed by the sequence of nodes that
you have connected to that terminal.
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If the message does not match any one of those values for which you have
requested the check, it is routed through the failure terminal and is processed by
the sequence of nodes that you have connected to that terminal.

For example, you might design a message flow that provides additional processing
for all messages that are in the MRM domain. You can include a Check node that
tests just that characteristic of the message, and passes it to a sequence of nodes
that provide the specialized processing. If the message is not in the MRM domain,
the extra nodes are bypassed, and the failure terminal is wired up directly to the
node that follows the sequence required for MRM messages only.

Controlling the order of processing within a message flow
Use the FlowOrder node to control the order of processing within a message flow.

When you connect message flow nodes together, the broker determines the way in
which the different connections are processed. This includes the order in which
they are processed. If you have connected more than one node or sequence of
nodes to a single output terminal, you cannot predict whether one sequence is
processed before another for any given message.

If the order of processing is important in your message flow, use the FlowOrder
node to force a prescribed order of processing of the messages that are propagated
by this node.

The FlowOrder node has two output terminals that you can connect to control the
order in which subsequent nodes process the message. The output terminals,
named first and second, are always processed in that order.

When you connect a node or sequence of nodes to the terminal named first, the
input message is passed to the next node, and all processing defined by all
subsequent nodes in this sequence is completed before control returns to the
FlowOrder node.

The input message is then propagated to the next node in the sequence of nodes
connected to the terminal named second.

The message passed to both sequences of nodes, from the terminal named first and
the terminal named second, is identical. It is always the message that the
FlowOrder node receives as input. The message that the FlowOrder node
propagates to the terminal named second is in no way affected by the processing of
the message that has been performed by the sequence of nodes connected to the
terminal named first.

The FlowOrder node provides no other processing on the input message; it is used
only for imposing order on subsequent processing.

Testing the message content (Filter node)
This topic describes how you can use the Filter node to determine the path taken
by a message through the message flow based on its content.

You can customize the Filter node using ESQL statements to determine if the
message content meets some condition. The condition tested must yield a Boolean
result, that is it must be true or false (or unknown). You can create the test to
reference information from a database, if applicable.



You can connect nodes following the Filter node to the corresponding terminals of
the Filter node, and process the message according to its content.

Look at the following samples to see how to use the Filter node:
+ |Airline Reservations sample]
« |[Error Handler sample|

You can view samples only when you use the information center that is integrated
with the Message Broker Toolkit.

Using the destination list to route messages (RouteToLabel and
Label nodes)

You can determine the path that a message takes through the message flow using
the RouteToLabel and Label nodes.

These nodes provide a more flexible way to process messages than the Filter node,
which depends on the Boolean result of an ESQL expression for its logic.

When you use RouteToLabel and Label nodes, you must include a Compute node
that determines, using some combination of message content, database content,
and ESQL logic, how messages are to be processed next. Configure the Compute
node to create a destination list (within the DestinationList folder in the
LocalEnvironment subtree) that contains the destination for each message, specified
as the LabelName of a Label node. The Compute node passes the message to the
RouteToLabel node, which reads the destination list and propagates the message to
either the first or last item on the destination list, according to the value that is
specified for the RouteToLabel node’s Mode property. Although there is no limit to
the number of destinations that the Compute node writes in the destination list,
the RouteToLabel node propagates the message only to a single label node. This
use of the destination list is in contrast to its use to define the final recipients of
the output messages. For more information about the procedure for creating a
destination list, see [“Creating destination lists” on page 154

If you intend to derive destination values from the message itself, or from a
database, you might also need to cast values from one type to another. For more
information about the LocalEnvironment, see [“LocalEnvironment tree structure” on|
For more information about casting, see ["Supported casts” on page 1499,

Look at the following sample to see how to use these nodes:
+ |Airline Reservations sample]

The XML_PassengerQuery message flow in the previous sample demonstrates how
you can use the destination list in the LocalEnvironment to route messages based
on the information in the message itself. You can view samples only when you use
the information center that is integrated with the Message Broker Toolkit.

Using subflows

Subflows can be included in your message flows in exactly the same way as you
include built-in or user-defined nodes.

You can also connect subflows to other nodes in the same way. You can define a
subflow once, and use it in more than one message flow (and even in more than
one message flow project), so a subflow can provide the following benefits:

* Reusability and reduced development time.
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* Consistency and increased maintainability of your message flows (consider a
subflow as analogous to a programming macro, or to inline code that is written
once but used in many places).

* Flexibility to tailor a subflow to a specific context (for example, by updating the
output queue or data source information).

However, remember that a subflow is not a single node, and its inclusion increases
the number of nodes in the message flow, which might affect its performance.

Consider these examples of subflow use:

* You can define a subflow that provides a common sequence of actions that
applies to several message flows if an error is encountered; for example, you
might have a common error routine that writes the message to a database
through the Warehouse node, and puts it to a queue for processing by an error
recovery routine. The use of this routine in multiple message flows, or in several
places within one message flow, provides an efficient and consistent use of
resources and avoids reinventing such routines every time an error is
encountered.

* You might want to perform a common calculation on messages that pass
through several different message flows; for example, you might access currency
exchange rates from a database and apply these to calculate prices in several
different currencies. You can include the currency calculator subflow in each of
the message flows in which it is appropriate.

Use the Passthrough node to enable versioning of a subflow at run time. The
Passthrough node allows you to add a label to your message flow or subflow. By
combining this label with keyword replacement from your version control system,
you can identify which version of a subflow is included in a deployed message
flow. You can use this label for your own purposes. If you have included the
correct version keywords in the label, you can see the value of the label:

* Stored in the broker archive (bar) file, using the mgsireadbar command

* As last deployed to a particular broker, on the properties of a deployed message
flow in the Message Broker Toolkit

¢ In the run time, if you enable user trace for that message flow

The message that it propagates on its Out terminal is the same message that it
received on its In terminal; for example, if you develop an error processing
subflow to include in several message flows, you might want to modify that
subflow. However, you might want to introduce the modified version initially to
just a subset of the message flows in which it is included. Set a value for the
instance of the Passthrough node that identifies which version of the subflow you
have included.

The use of subflows is demonstrated in the following samples:

+ [Error Handler sample|

* |Coordinated Request Reply sample|

The Error Handler sample uses a subflow to trap information about errors and
store the information in a database. The Coordinated Request Reply sample uses a
subflow to encapsulate the storage of the ReplyToQ and ReplyToQMgr values in a
WebSphere MQ message so that the processing logic can be easily reused in other
message flows and to allow alternative implementations to be substituted.

You can view samples only when you use the information center that is integrated
with the Message Broker Toolkit.
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Adding keywords to subflows

You can embed keywords in each subflow that you use in a message flow. A
different keyword must be used in each instance of a subflow. This is because only
the first recorded instance of each keyword within the message flow .cmf file is
available to Configuration Manager Proxy applications and to the toolkit. The
order that subflows appear in the .cmf file is not guaranteed.

Optimizing message flow response times
This topic describes how you can improve message flow response times.

Before you start:

Read the following concept topic:

* ["Message flow nodes” on page 5|

When you design a message flow, the flexibility and richness of the built-in nodes
often means that there are several ways to achieve the processing and therefore the
end results that you require. However, you can also find that these different
solutions deliver different performance and, if this is an important consideration,
you must design for performance as well as function.

Your applications can perceive performance in either of these ways:

1. The response time indicates how quickly each message is processed by the
message flow. The response time is particularly influenced by how you design
your message flows. Response time is discussed in this topic.

2. The throughput indicates how many messages of particular sizes can be
processed by a message flow in a given time. The throughput is mainly
affected by configuration and system resource factors, and is discussed in the
topic on optimizing message flow throughput along with other domain
configuration information. See [Optimizing message flow throughputl

Several aspects influence message flow response times. However, as you create and
modify your message flow design to arrive at the best results that meet your
specific business requirements, you must also consider the eventual complexity of
the message flow. The most efficient message flows are not necessarily the easiest
to understand and maintain; experiment with the solutions available to arrive at
the best balance for your needs.

Several factors influence message flow response times:

The number of nodes that you include in the message flow
Every node increases the amount of processing required in the broker, so
consider the content of the message flow carefully, including the use of
subflows.

Use as few nodes as possible in a message flow; every node that you
include in the message flow increases the amount of processing required in
the broker. The number of nodes within a single flow has an upper limit.
This limit is governed by system resources, particularly the stack size.

For more information about stack sizes, see [’System considerations for
Imessage flow development” on page 151

How the message flow routes and processes messages
In some situations, you might find that the built-in nodes, and perhaps
other nodes that are available in your system, provide more than one way
of providing the same function. Choose the simplest configuration. For
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If your

example, if you want to define some specific processing based on the value
of a field in each message, you might design a message flow that has a
sequence of Filter nodes to handle each case. If appropriate, you can group
messages through the Filter node to reduce the number that each message
type has to pass through before being processed.

For example, you might have a message flow that handles eight different
messages (Invoice, Despatch Note, and so on). You can include a Filter
node to identify each type of message and route it according to its type.
You can optimize the performance of this technique by testing for the most
frequent message types in the earliest Filter nodes. However, the eighth
message type must always pass through eight Filter nodes.

If you can group the message types (for example, if the message type is
numeric, and you can test for all types greater than four and not greater
than four), you can reduce the number of Filter nodes required. The first
Filter node tests for greater than four, and passes the message on to two
further Filter nodes (attached to the true and false terminals) that test for
less than two and less than six respectively. An additional four Filter nodes
can then test for one or two, three or four, and so on. Although the actual
number of Filter nodes required is the same, the number of nodes that
each message passes through is reduced.

You might find that using a RouteToLabel node with a set of Label nodes
provides a better alternative to a sequence of Filter nodes. Each message
passes through a smaller number of nodes, improving throughput.
However, you must also consider using a RouteToLabel node means using
a Compute node: the increase in the amount of processing required in the
broker that is caused by the node might outweigh the advantages. If you
are dealing with a limited number of message types, a small number of
Filter nodes is more efficient.

The following sample demonstrates how you can use the RouteToLabel
and Label nodes instead of using multiple Filter nodes in the
XML_PassengerQuery message flow.

+ |Airline Reservations sample|

The following sample demonstrates how you can store routing information
in a database table in an in-memory cache in the message flow.

+ [Message Routing sample]

You can view samples only when you use the information center that is
integrated with the Message Broker Toolkit.

message flow includes loops

Avoid loops of repeating nodes; these can be very inefficient and can cause
performance and stack problems. You might find that a Compute node
with multiple PROPAGATE statements avoids the need to loop round a
series of nodes.

The efficiency of the ESQL

Check all the ESQL code that you have created for your message flow
nodes. As you develop and test a node, you might maintain statements
that are not required when you have finalized your message processing.
You might also find that something you have coded as two statements can
be coded as one. Taking the time to review and check your ESQL code
might provide simplification and performance improvements.


/help/livehelp/?pluginID=com.ibm.samplegallery&class=com.ibm.samplegallery.SampleGalleryAction&arg=com.ibm.etools.mft.samples.airline.xml.doc/doc/overview.htm
/help/livehelp/?pluginID=com.ibm.samplegallery&class=com.ibm.samplegallery.SampleGalleryAction&arg=com.ibm.etools.mft.samples.routing.doc/doc/overview.htm

If you have imported message flows from a previous release, check your
ESQL statements against the ESQL available in Version 5.0 to see if you can
use new functions or statements to improve its efficiency.

The use of persistent and transactional messages
Persistent messages are saved to disk during message flow processing. This
situation is avoided if you can specify that messages either on input,
output, or both, are non-persistent. If your message flow is handling only
non-persistent messages, check the configuration of the nodes and the
message flow itself; if your messages are non-persistent, transactional
support might be unnecessary. The default configuration of some nodes
enforces transactionality; if you update these properties and redeploy the
message flow, response times might improve.

Message size
A larger message takes longer to process. If you can split large messages
into smaller chunks of information, you might be able to improve the
speed at which they are handled by the message flow. The following
sample demonstrates how to minimize the virtual memory requirements
for the message flow to improve a message flow’s performance when
processing potentially large messages.

* [Large Messaging sample|

You can view samples only when you use the information center that is
integrated with the Message Broker Toolkit.

Message format
Although WebSphere Message Broker supports multiple message formats,
and provides facilities that you can use to transform from one format to
another, this transformation increases the amount of processing required in
the broker. Make sure that you do not perform any unnecessary
conversions or transformations.

You can find more information on improving the performance of a message flow in
this |[developerWorks article on message flow performance]

System considerations for message flow development

Ensuring you configure your message flows to make the best use of your
computer’s resources is of paramount importance, especially if you are going to be
processing large messages. As well as designing your message flow to optimize
throughput, you need to ensure that particular areas of storage are efficiently used
so that your system does not suffer from capacity issues or processes abend due to
lack of resources.

Consider the following storage issues when developing your message flows:

* [“Stack storage”

* “IVM heap sizing” on page 153

Stack storage
When a message flow thread starts, it requires storage to perform the instructions
that are defined by the message flow nodes. This storage comes from the execution

group’s heap and stack size. The default stack size that is allocated to a message
flow thread depends on the operating system that is used.

BTN On Windows, each message flow thread is allocated 1 MB of stack space.
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On Linux, each message flow thread is allocated 8 MB of stack space.
On UNIX, each message flow thread is allocated 1 MB of stack space.

On z/08S, each message flow thread is allocated 512 KB of downward
stack space and 50 KB of upward stack space.

In a message flow, a node typically uses 2 KB of the stack space. A typical message
flow can therefore include 250 nodes on z/0OS, 500 nodes on UNIX systems and
500 nodes on Windows. This amount can be higher or lower depending on the
type of nodes used and the processing that they perform.

In WebSphere Message Broker, any processing that involves nested or recursive
processing can cause extensive usage of the stack. For example, in the following
situations you might need to increase the stack size:

* When a message flow is processing a message that contains a large number of
repetitions or complex nesting

* When a message flow is executing ESQL that calls the same procedure or
function recursively, or when an operator (for example, the concatenation
operator) is used repeatedly in an ESQL statement

You can increase the stack size to improve performance. For details, see:

* |“Increasing the stack size on Windows, Linux, and UNIX systems.”|

* [“Increasing the stack size on z/0S.”]

Increasing the stack size on Windows, Linux, and UNIX systems:

Increase the stack size on Windows, Linux, and UNIX systems by setting the
MQSI_THREAD_STACK_SIZE environment variable to an appropriate value.
When you restart brokers that are running on the system, they use the new value.

The value of MQSI_THREAD_STACK_SIZE that you set is used for every thread
that is created within a DataFlowEngine process. If the execution group has a large
number of message flows assigned to it, and you set a large value for
MQSI_THREAD_STACK_SIZE, the DataFlowEngine process therefore needs a
large amount of storage for the stack.

Increasing the stack size on z/OS:

Integrator components on z/OS are compiled using the XPLINKage (extra
performance linkage), which adds optimization to the runtime code. However, if
the initial stack size is not large enough, stack extents are used. 128 KB is used in
each extent. Ensure that you choose a large enough downward stack size because
the performance of XPLINK can be affected when stack extents are used.

To determine suitable stack sizes, a component administrator for z/OS can use the
LE (Language Environment®) Report Storage tool.

To use this tool, use the RPTSTG option with the _CEE_RUNOPTS environment
variable to test a message flow. Set this option in the component profile
(BIPBPROF for a broker) during the development and test of message flows that
are intended for production; for example:

export _CEE_RUNOPTS=XPLINK\(ON\),RPTSTG(ON)



You can then override the default values for the stack sizes on z/OS by altering or
adding the LE_CEE_RUNOPTS environment variable in the component profile.

When you update the component profile, perform the following steps:
1. Stop the component.

2. Make the necessary changes to the profile.

3. Submit BIPGEN to re-create the ENVFILE.
4.

Restart the component.

For example, you can change the default values of 50 K and 512 K in the following
line to suit your needs:

export _CEE_RUNOPTS=XPLINK(ON),THREADSTACK(ON,50K, 15K, ANYWHERE ,KEEP,512K, 128K)

When you use RPTSTG, it increases the time that an application takes to run, so
use it as an aid to the development of message flows only, and not in your final
production environment. When you have determined the correct stack sizes
needed, remove this option from the _.CEE_RUNOPTS environment variable.

XPLINK stacks grow downward in virtual storage while the standard linkage
grows upward. To avoid a performance impact caused by switching between
downward stack space and upward stack space during run time, compile
user-defined extensions using the XPLINK option where possible. If your message
flow uses user-defined extensions that have been compiled with the standard
linkage convention, set a suitable value for the upward stack size.

JVM heap sizing

The Java Virtual Machine (JVM) heap is an independent memory allocation that
can reduce the capacity of the main memory heap.

Every execution group creates its own Java Virtual Machine (JVM). The execution
group uses the JVM to execute the internal administration threads that require
Java. This usage is typically minimal. The primary use of the JVM is for IBM
primitive nodes that make use of Java functionality. These primitives include:

* Java user-defined plugin nodes

Publish/subscribe nodes together with some publish/subscribe functionality
XSLT nodes

* HTTPRequest nodes

* Real-time nodes

From WebSphere Business Integration Message Broker Version 5.0 onwards, the
JVM is created with a minimum of 128 MB of space allocated and reserved for its
use. As with any JVM, you can pass parameters in to set the minimum and
maximum heap sizes.

To give more capacity to a message flow that is going to process large messages,
reduce the minimum JVM heap size to allow the main memory heap to occupy
more address space. For details of how to reduce the minimum JVM heap size, see
[‘Setting the JVM heap size.”

Setting the JVM heap size:

When you start an execution group, it creates a Java Virtual Machine (JVM) for
executing a Java user-defined node. You can pass parameters to the JVM to set the
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minimum and maximum heap sizes. To give more capacity to a message flow that
is going to process large messages, reduce the minimum JVM heap size to allow
the main memory heap to occupy more address space.

You do not need to increase the maximum heap size unless you use Java
intensively with, for example, user-defined nodes.

Use caution when you set the maximum heap size because the Java Runtime
Environment takes the values for its initial, maximum, and current heap sizes to
calculate how frequently it drives garbage collection. A large maximum heap size
drives garbage collection less frequently. If garbage collection is driven less
frequently, the DataFlowEngine heap size continues to grow.

Creating destination lists

Using
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Create a list of destinations to indicate where a message is sent.
Before you start:

Read the following concept topic:

* ["Message flow nodes” on page 5|

You can include a Compute node in your message flow, and configure it to create a
destination list within the LocalEnvironment subtree. You can then use the
destination list in the following nodes:

¢ The MQOutput node, to put output messages to a specified list of queues.
* The RouteToLabel node, to pass messages to Label nodes.

For details about how this technique is used, look at the following sample:

— |Airline Reservations sample]

You can view samples only when you use the information center that is
integrated with the Message Broker Toolkit.

For more information about accessing the LocalEnvironment subtree, destination
list contents, and example procedures for setting values for each of these scenarios,
see [“Accessing the LocalEnvironment tree” on page 295

For more information about how to populate destination in the LocalEnvironment
subtree, and how to build JMS destination lists, see ["Populating Destination in the|
[LocalEnvironment tree” on page 298

You might find it useful to create the contents of the destination list from an
external database that is accessed by the Compute node. You can then update the
destinations without needing to update and redeploy the message flow.

The use of the destination list to define which applications receive the output
messages is in contrast to the publish/subscribe application model, in which the
recipients of the publications are those subscribers that are currently registered
with the broker. The processing that is completed by the message flow does not
have any effect on the current list of subscribers.

WebSphere MQ cluster queues for input and output

When you design the WebSphere MQ network that underlies your WebSphere
Message Broker broker domain, consider whether to use clusters.
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The use of queue manager clusters brings the following significant benefits:

1.

Reduced system administration

Clusters need fewer definitions to establish a network; you can set up and
change your network more quickly and easily.

Increased availability and workload balancing

You can benefit by defining instances of the same queue to more than one
queue manager, thus distributing the workload through the cluster.

If you use clusters with WebSphere Message Broker, consider the following:

For SYSTEM.BROKER queues:

The SYSTEM.BROKER queues are defined for you when you create
WebSphere Message Broker components, and are not defined as cluster
queues. Do not change this attribute.

For broker, Configuration Manager, and User Name Server connectivity:

If you define the queue managers that support your brokers, the
Configuration Manager, and the User Name Server to a cluster, you can
benefit from the simplified administration provided by WebSphere MQ
clusters. You might find this particularly relevant for the brokers in a
collective, which must all have WebSphere MQ interconnections.

For message flow input queues:

If you define an input queue as a cluster queue, consider the implications
for the order of messages or the segments of a segmented message. The
implications are the same as they are for any WebSphere MQ cluster
queue. In particular, the application must ensure that, if it is sending
segmented messages, all segments are processed by the same target queue,
and therefore by the same instance of the message flow at the same broker.

For message flow output queues:

* WebSphere Message Broker always specifies MQOO_BIND_AS_Q_DEF

when it opens a queue for output. If you expect segmented messages to
be put to an output queue, or want a series of messages to be handled
by the same process, you must specify DEFBIND(OPEN) when you
define that queue. This ensures that all segments of a single message, or
all messages within a sequence, are put to the same target queue and are
processed by the same instance of the receiving application.

If you create your own output nodes, specify MQOO_BIND_AS_Q_DEF
when you open the output queue, and DEFBIND(OPEN) when you
define the queue, if you need to guarantee message order, or to ensure a
single target for segmented messages.

For publish/subscribe:

¢ If the target queue for a publication is a cluster queue, you must deploy

the publish/subscribe message flow to all the brokers on queue
managers in the cluster. However, the cluster does not provide any of
the failover function to the broker domain topology and function. If a
broker to which a message is published, or a subscriber registers, is
unavailable, the distribution of the publication or registration is not
taken over by another broker.

When a client registers a subscription with a broker that is running on a
queue manager that is a member of a cluster, the broker forwards a
proxy registration to its neighbors within the broker domain; the
registration details are not advertised to other members of the cluster.
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* A client might choose to become a clustered subscriber, so that its
subscriber queue is one of a set of clustered queues that receive any
given publication. In this case, when registering a subscription, use the
name of an "imaginary” queue manager that is associated with the
cluster; this is not the queue manager to which the publication will be
sent, but an alias for the broker to use. As an administrative activity, a
blank queue manager alias definition is made for this queue manager on
the broker that satisfies this subscription for all clustered subscribers.
When the broker publishes to a subscriber queue that names this queue
manager, resolution of the queue manager name results in the
publication being sent to any queue manager that hosts the subscriber
cluster queue, and only one clustered subscriber receives the publication.

For example, if the clustered subscriber queue was SUBS_QUEUE and
the "imaginary” subscriber queue manager was CLUSTER_QM, the
broker definition would be:

DEFINE QREMOTE(CLUSTER_QM) RQMNAME(' ') RNAME(' ')

This sends broker publications for SUBS_QUEUE on CLUSTER_QM to
one instance of the cluster queue named SUBS_QUEUE anywhere in the
cluster.

To understand more about clusters, and the implications of using cluster queues,
see the WebSphere MQ Queue Manager Clusters book.

Using WebSphere MQ shared queues for input and output
(z/0S)

On z/0S systems you can define WebSphere MQ shared queues as input and
output queues for message flows.

Use the WebSphere MQ for z/OS product facilities to define these queues and
specify that they are shared.

For more information about configuring on z/0OS, refer to the WebSphere MQ for
z/OS Concepts and Planning Guide.

Using shared queues helps to provide failover support between different images
running WebSphere Message Broker on a sysplex.

You cannot use shared queues for broker or User Name Server component queues
such as SYSTEM.BROKER.CONTROL.QUEUE.

Shared queues are available only on z/OS.

Validating messages

Before you start:

Read the concept topics about [message flow nodes| and [“Parsers” on page 69,
especially the ["MRM parser and domain” on page 93|and the ["XMLNSC parser”|

|on page 80.|
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The broker provides validation based on the message set for predefined messages.
Validation, therefore, applies only to messages that you have modeled and
deployed to the broker. Specifically, the message domains that support validation
are MRM, XMLNSC, SOAP, and IDOC.

The broker does not provide any validation for self-defining messages. The MRM
and IDOC parsers validate predefined messages against the message dictionary
generated from a message set. The XMLNSC and SOAP domains validate
predefined messages directly against XML Schema generated from a message set.

Message flows are designed to transform and route messages that conform to
certain rules. By default, parsers performs some validity checking on a message,
but only to ensure the integrity of the parsing operation. However, you can
validate a message more stringently against the message model contained in the
message set, by specifying validation options on certain nodes in your message
flow.

You can use validation options to validate the following messages:

* Input messages that are received by an input node

¢ Output messages that are created, for example, by a Compute, Mapping, or
JavaCompute node

These validation options can guarantee the validity of data entering and leaving
the message flow. The options provide you with some degree of control over the
validation performed to:

* Maintain a balance between performance and security requirements.

* Validate at different stages of message flow execution, such as on input of a
message and before a message is output, or at any point in-between

* Cope with messages that your message model does not fully describe.

You can also specify what action to take when validation fails.

Message validation involves navigating a message tree and checking its validity. It
is an extension of tree creation when the input message is parsed, and an extension

of bit stream creation when the output message is written.

Validation options are available on the following nodes:

Node type Nodes with validation options

Input node MQInput, SCADAInput, HTTPInput, JMSInput, TimeoutNotification,
SOAPInput, FileInput

Output node MQOutput, MQReply, SCADAOutput, HTTPReply, JMSOutput,
JMSReply, FileOutput, SOAPReply

Other nodes Compute, Mapping, JavaCompute, Validate, ResetContentDescriptor,
MQGet, HTTPRequest, XSLTransform, DatabaseRetrieve, SOAPRequest,
SOAPAsyncResponse

Validation options can also be specified on the ESQL CREATE statement and
ASBITSTREAM function.

To validate input messages received on an input node, you can specify validation

properties on the input node. The input message is then validated as the message
bit stream is parsed to form the message tree.
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You can also use the Parse Timing property of the input node to control whether
the entire message is to be parsed and validated at this time, or whether individual
fields in the message are parsed and validated only when referenced.

To validate output messages created by a transformation node, you either specify
validation properties on the node itself, or you specify validation properties on the
output node that sends the message. The validation takes place when the message
bit stream is created from the message tree by the output node.

Alternatively, you can use a Validate node to validate a message tree at a particular
place in your message flow, or you can use the ESQL ASBITSTREAM function
within a Compute, Filter or Database node.

A limited amount of validation occurs by default if you leave the validation
settings unaltered. At this default level, an exception is thrown if one of the
following is true:

* There is a data mismatch, where, for example, the parser cannot interpret the
data provided for the field type specified

e The order of elements in the output message does not match the order in the
logical message tree (MRM, CWF and TDS fixed length models only)

Additionally, the MRM parser by default will perform limited remedial action
under the following circumstances:

1. Extraneous fields are discarded on output for fixed formats (CWF and TDS
fixed length models only).

2. If mandatory content is missing, defaults are supplied, if available, on output
for fixed formats (CWF and TDS fixed length models only).

3. If an element’s data type in the tree does not match that specified in the
dictionary the data type is converted on output to match the dictionary
definition, if possible, for all formats.

However, using validation options you can request more thorough validation of
messages. For example, you might want to validate one or more of the following
conditions and throw an exception, or log the errors:

* The whole message at the start of the message flow

* That complex elements have the correct Composition and Content Validation
¢ That all data fields contain the correct type of data

 That data fields conform to the value constraints in the message model

* That all mandatory fields are present in the message

* That only the expected fields are present in the message

* That message elements are in the correct order
The samples illustrate some of these validation options.

When using validation options, it is important to understand the following
behavior:

* The Parse Timing property, which controls whether ‘on demand’ parsing

(sometimes called partial parsing) takes place, has an effect on the timing of the
validation of input messages, including message headers.

For more information on Parse Timing, see [“Parsing on demand” on page 1229




* If a message tree is passed to an output node, then by default the output node
inherits the validation options in force for the message tree. You can override
these options by specifying a new set of validation options on the output node.

* If a message tree is passed as input to a Compute, Mapping, XSLTransform,
DatabaseRetrieve, or JavaCompute node, any new output message trees created
by the node have the validation options specified by the node itself (even if the
whole message is copied). You can override this behavior and specify that
messages that are created by the node inherit the validation options of the input
message tree.

* (MRM domain only) When the bit stream is written and validation options are
applied, the entire message is validated. The message tree might contain an
unresolved type (for example, if a Compute node copied an unresolved type
from an input message to an output message without resolving it). If such a
type is encountered, a validation error occurs because it is not possible to
validate the type. To prevent this, ensure that all unresolved types are resolved
before they are copied to output messages.

* (MRM domain only) You must not select the Truncate fixed length strings check
box. The reason for this is that validation is done before truncation, and a fixed
length field fails validation if its length exceeds the length defined in the
message set. [Custom Wire Format message set properties| and [TDS Format]
[message set properties| give more information about the Truncate fixed length
strings property.

For information about how you can control validation by using different
properties, see [“Validation properties” on page 1225

Viewing the logical message tree in trace output

To view the structure of the logical message tree at any point in the message flow,
include a Trace node and write some or all of the message (including headers and
all four message trees) to the trace output destination.

You might find trace output useful to check or record the content of a message
before and after a node has made changes to it, or on its receipt by the input node.
For example, if you include a Compute node that builds a destination list in
LocalEnvironment, you might want a record of the structure that it has created as
part of an audit trail, or you might just want to check that the Compute node is
working as you expect it to.

1. Switch to the Broker Application Development perspective.

2. Open the message flow for which you want to view messages. Open an
existing message flow, or create a new message flow.

3. Include a Trace node wherever you want to view part or all of the message tree
structure. You can include as many Trace nodes as you choose; however, each
node introduces some overhead to the message flow processing.

4. Set the Trace node properties to trace the message, or parts of the message, that
you want to view. Specify the parts of the message using ESQL field references.
Several examples are included below.

5. If you have added a Trace node to investigate a particular behavior of your
message flow, and have now resolved your concerns or checked that the
message flow is working correctly, remove the Trace node or nodes, and
redeploy the message flow.

Assume that you have configured a message flow that receives an XML message
on a WebSphere MQ queue in an MQInput node. The input message includes an
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MQRFH?2 header. The message content is shown below:

<Trade type='buy'
Company="1BM'
Price='200.20"
Date='2000-01-01"
Quantity='1000"'/>

You can include and configure a Trace node to produce output that shows one or
more of the trees created from this message: the message body, Environment,
LocalEnvironment, and Exception trees. If you choose to record the content of the
message body, the Properties tree and the contents of all headers (in this example,
at least an MQMD and an MQRFH?2) are included. You specify what you want to
be recorded when you set the Trace node property Pattern. You can use most of
the correlation names to define this pattern (you cannot use those names that are
specific to the Compute node).

Message body
If you want the Trace node to write the message body tree including
Properties and all headers, set Pattern to $Root. If you want only the
message data, set Pattern to ${Body}.

The trace output generated for the message tree of the message shown
above with Pattern set to $Root would look something like:

Root
Properties
CreationTime=GMTTIMESTAMP '1999-11-24 13:10:00' (a GMT timestamp field)

. and other fields ...

MQMD
PutDate=DATE '19991124' (a date field)
PutTime=GMTTIME '131000' (a GMTTIME field)

. and other fields ...
MQRFH
mcd
msd="'xml"' (a character string field)

. and other fields ...

XML
Trade
type="'buy' (a character string field)
Company="1BM' (a character string field)
Price='200" (a character string field)
Date='2000-01-01" (a character string field)
Quantity='1000" (a character string field)

Environment
To trace any data in the environment tree, set Pattern to ${Environment}.
This setting produces output similar to the following:
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(6x1000000) Environment = (
(0x1000000)Variables = (
(0x1000000)MyVariablel = (
(0x2000000) = '3'

)

(0x1000000)MyVariable2 = (
(0x2000000) = 'Hello'

)

)
)
To trace particular variables in the variables folder of the environment tree,
you can use a more specific pattern, for example
${Environment.Variables.MyVariablel}. This setting returns the value only
(for example, it returns just the value 3).
LocalEnvironment

To trace data in the LocalEnvironment tree, set Pattern to
${LocalEnvironment}. The output you get is similar to the following
example, which shows that a destination list has been created within the
LocalEnvironment tree:

(0x1000000)Destination = (
(0x1000000)MQ (
(0x1000000)DestinationData = (
(0x3000000) queuename = 'MQOUT'
)
)
(0x1000000)MQDestinationList = (
(0x1000000)DestinationData = (
(0x3000000) queuename = '0LDMQOUT'

)
(0x1000000)RouterList (
(0x1000000)DestinationData = (
(0x3000000) Tabelname = 'continue’

)
(0x1000000)DestinationData = (
(0x3000000) Tabelname = 'custdetails'

(0x1000000)DestinationData = (
(0x3000000) Tabelname = 'trade’
)
)
)

Another example, shown below, includes a WrittenDestination folder. This
example represents a trace that has been written by a Trace node that is
included after an MQOutput node, where the Out terminal of the
MQOutput node is connected to a sequence of nodes including the Trace
node. When an Out terminal is connected, the LocalEnvironment is
augmented with information about the action that the output node has
performed.

Developing message flows 161



(0x1000000)Destination = (
(0x1000000)MQ (
(0x1000000)DestinationData

(0x3000000) queuename = 'MQOUT'

(0x1000000)WrittenDestination = (
(6x1000000)MQ = (
(0x1000000)DestinationData = (
(0x3000000) queueName
(6x3000000) queueManagerName
(0x3000000) replyldentfier

"MQOUT"
'MQSI_SAMPLE_QM'
X'414d51204d5153495F53414d504c455f1F4423b12600100"

(0x3000000)msgId X'414d51204d5153495153414d504c455f1F44213b12600100"
(6x3000000) correlld X'000000000000000000000000000000000000000000000000
(0x03000000) : GroupId = X'414d5120425244b45523220202020203159934620001803
)
)
)
)
ExceptionList

To trace data in the exception list, set Pattern to ${ExceptionList}.

You can also view message structure within the message flow, and other
information, when you use the flow debugger.

Accessing databases from message flows

This topic describes how you can create and configure message flows to access
user databases.

Before you start:
Complete the following tasks:

* |“Creating a message flow” on page 208
* |Configuring databases|

Read the following concept topic:
+ ["“Message flow nodes” on page 5|

You can access information in a database to enhance or influence the operation of
the message flow. You can also modify the contents of a database by inserting new
information or by removing or replacing existing information.

You can access a database from a message flow using the following nodes:
e Compute

* Database

e DatabaseRetrieve
¢ DatabaseRoute

* Datalnsert
 DataDelete

» DataUpdate

* Filter

* JavaCompute

* Mapping

* Warehouse

For more details of these nodes, and how to configure them in message flows, see
[“Built-in nodes” on page 762
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If you want the actions that the message flow takes against the database to be
coordinated with other actions, configure the message flow to support global
coordination of transactions. For information about how to do this, see
[‘Configuring globally coordinated message flows” on page 166

To access a database from a message flow:

1. Identify the database that you want to access. You can access an existing
database or a new one that has been created for this purpose. See
fon z/OS” on page 1307| for more information on what to call a z/OS user

database.

If iou want to create a new database, follow the instructions given in

If you want to use a database other than DB2®, refer to the database product
documentation for detailed instructions on how to do this.

[Supported databases] lists the database managers that are supported by
WebSphere Message Broker.

2. Define a connection to the data source name (DSN) to enable a connection to
the database, if one does not already exist:

a. Define a JDBC connection if you want to interact with a database directly
from a Java application. You can code Java in both a JavaCompute node and
in a Java user-defined node.

For more information, see [Enabling JDBC connections to the databases}

b. Define an ODBC connection if you want to interact with a database in a
node that supports ESQL, including a JavaCompute node in which use the
MbSQLStatement interface.

For more information, see [Enabling ODBC connections to the databases}

3. Authorize the broker to access the database.

Access to a user database from within a message flow is controlled by user ID
and password.

On z/0S, you can specify these values:
* When you create the broker.

The broker started task ID is used to access user databases, irrespective of
the user ID and password specified on the mgsicreatebroker command in the
BIPCRBK JCL in the customization data set <hTg>.SBIPPROC.

* After you have created the broker.

Use the BIPSDBP JCL in the customization data set <h1g>.SBIPPROC to
customize the mgsisetdbparms command to specify a user ID and password
for a specific database. This changes the default values that were set when
you created the broker (described above).

You can create a user ID and password for any database (identified by DSN)
that is accessed by a message flow. You can, therefore, control access to a
database at an individual level if you choose. This includes databases that
you have created and configured on distributed systems that are accessed by
z/0OS DB2 remote database access.

On distributed systems, you can specify these values:
* When you create the broker.

The mgsicreatebroker command has two parameters -u DataSourceUserid
and -p DataSourcePassword that you can use to identify the user ID that the
broker uses to access its own database. If you specify these parameters, they
are used as the default access control parameters for user databases that are
accessed by message flows.
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If you do not specify DataSourceUserid and DataSourcePassword, the broker
uses the values specified for the parameters -i ServiceUserID and -a
ServicePassword (which identify the user under which the broker runs) as
the default values.

* After you have created the broker.

Use the mgsisetdbparms command to specify a user ID and password pair.
This changes the defaults that were set when you created the broker
(described above).

You can create a user ID and password pair for any database (identified by
DSN) that is accessed by a message flow. You can therefore control access to
a database at an individual level if you choose. This includes databases that
you have created and configured on z/OS that are accessed by brokers on
distributed systems.

If the user that created a table in a database is not the user that the broker is
using to access the database, you must specify the user ID that created the
database as the schema name in relevant ESQL statements, unless you have set
up an alias or synonym.

If you access a database from a message flow using a Compute, Database, or Filter
node, use the New Database Definition File wizard to enable a connection to the
appropriate database. See [“Adding database definitions to the Message Broker|
[Toolkit” on page 448| for further details.

The following samples access databases from message flows:

+ [Message Routing sample]

+ |Data Warehouse sample|

+ [Error Handler sample|

+ |Airline Reservations sample|

The Message Routing sample and the Data Warehouse sample use Compute nodes
to access the database, the Error Handler uses Database nodes to access the
database, and the Airline Reservations sample uses both Compute and Database
nodes. You can view samples only when you use the information center that is
integrated with the Message Broker Toolkit.

Accessing databases from ESQL
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You can create and configure ESQL in message flows to access user databases.

Before you start:
+ [Create a message flow]
+ [Ensure that the databases are configured|

You can use a number of ESQL statements and functions to access databases:

INSERT statement
The INSERT statement adds a row to a database table.

UPDATE statement
The UPDATE statement changes one or more values stored in zero or more
rows.

DELETE FROM statement
The DELETE FROM statement removes zero or more rows.


/help/livehelp/?pluginID=com.ibm.samplegallery&class=com.ibm.samplegallery.SampleGalleryAction&arg=com.ibm.etools.mft.samples.routing.doc/doc/overview.htm
/help/livehelp/?pluginID=com.ibm.samplegallery&class=com.ibm.samplegallery.SampleGalleryAction&arg=com.ibm.etools.mft.samples.datawarehouse.doc/doc/overview.htm
/help/livehelp/?pluginID=com.ibm.samplegallery&class=com.ibm.samplegallery.SampleGalleryAction&arg=com.ibm.etools.mft.samples.errorhandler.doc/doc/overview.htm
/help/livehelp/?pluginID=com.ibm.samplegallery&class=com.ibm.samplegallery.SampleGalleryAction&arg=com.ibm.etools.mft.samples.airline.xml.doc/doc/overview.htm

SELECT function
The SELECT function retrieves data from a table.

CALL statement
The CALL statement invokes a stored procedure.

PASSTHRU statement
The PASSTHRU statement can be used to invoke administrative operations,
such as creating a table.

PASSTHRU function
The PASSTHRU function can be used to invoke complex selects.

You can access user databases from Compute, Database, and Filter nodes; you can

use the same ESQL statements and functions to access databases in all three types

of node. A single node can access multiple databases but the following restrictions
apply:

* Any node that accesses one or more databases must have its Data source
property set with the ODBC data source name (DSN) of a database; the database
must be accessible and operational, and the broker must be authorized to
connect to it.

 All databases that are accessed from a single node must be compatible with each
other. If you use the same database manager on the same platform at the same
service level for all the databases, the data sources will be compatible. For
example, two DB2 database instances at the same DB2 fix pack level are
compatible but a DB2 database and an Oracle database are not compatible. If
you use data sources that are not compatible, when you put a message through
the message flow to test it, the message flow throws an error. If your data
sources are not compatible, you cannot access them from a single node; if this is
the case, use additional nodes in your message flow.

* All tables that are referred to in a single SELECT function’s FROM clause must
be in the same database.

To access databases, you must ensure that suitable ODBC data source names (DSN)
have been defined on the system on which the broker is running. On Linux
(zSeries platform) and Linux (POWER platform), the only supported database
manager is DB2 and ODBC is not used; the broker and message flows connect to
the databases directly. When you configure message flows, use the DB2 alias of the
database as the DSN.

If you have used the mgsisetdbparms command to set a user ID and password for
a particular database, the broker uses these values to connect to the database. If
you have not set values for a particular database, the broker uses the default
database user ID and password that you supplied on the mgsicreatebroker
command, or the user ID and password details that you specified if you have
modified the broker using the mqsichangebroker command.

On z/0S systems, the broker uses the broker started-task ID to connect
to the database. You must also ensure that the database user IDs have sufficient
privileges to perform the operations your flow requires. If they do not have the
required privileges, errors will occur at run time.

For a description of database transactional issues, see [The Transactional modell
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If you select the Treat Warnings As Errors and Throw Exception on Database
Error check boxes, and, from the Transaction list, select Automatic, you have the
flexibility to use the COMMIT and ROLLBACK statements for transaction control
and handlers for dealing with errors.

Configuring globally coordinated message flows
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A coordinated message flow executes within a single transaction, which is started
when a message is received by an input node, and can be committed or rolled
back when all processing has completed. You can also control how database errors
are handled by the node that interacts with the database.

Before you start:

You must have completed the following tasks:

1. [Configuring databases for global coordination of transactions}

2. [Configuring global coordination of transactions (two-phase commit)}

3. [‘Creating a message flow” on page 208

If you want the actions of a message flow to be globally coordinated (that is, it
must complete all processing successfully, or complete none), ensure that your
configuration supports this action. For more information about global coordination
of message flow transactions, see [The Transactional modell

The following sample demonstrates the use of globally-coordinated transactions,
and the differences in the message flow when database updates are coordinated
(the main flow) and when they are not (the error flow).

* [Error Handler sample|

You can view samples only when you use the information center that is integrated
with the Message Broker Toolkit.

To configure a message flow for global coordination:

1. In the Message Broker Toolkit, switch to the Broker Application Development
perspective.

2. Open the message flow that you want to configure.

3. Set the Transaction property for the following nodes if they appear in this

message flow:

* Compute node

* Database node

 DataDelete node

* Datalnsert node

¢ DataUpdate node

* Filter node

* Mapping node

* Warehouse node

You can set the Transaction property to the following values:

Automatic
Any updates, deletions, and additions performed by the node are
committed or rolled back when the message flow processing completes.
If the message flow completes successfully, all changes are committed.
If the message flow does not complete successfully, all changes are
rolled back.


/help/livehelp/?pluginID=com.ibm.samplegallery&class=com.ibm.samplegallery.SampleGalleryAction&arg=com.ibm.etools.mft.samples.errorhandler.doc/doc/overview.htm

If you want all of the processing by the message flow to be
coordinated, you must select this value.

Commit
The action taken depends on the system to which the message flow has
been deployed:

¢ On distributed systems, any work that has been done to this data
source in this message flow to date, including any actions taken in
this node, is committed regardless of the subsequent success or
failure of the message flow.

Note: On systems other than z/0S, individual relational databases
might or might not support this mode of operation.

. On z/0S, actions that are taken in this node only are
committed, regardless of the subsequent success or failure of the
message flow. Any actions that are taken before this node, under
automatic transactionality, are not committed, but remain within a
unit of work, and might either be committed or rolled back,
depending on the success of the message flow.

To mix nodes with Automatic and Commit transactionality in the same
message flow, where the nodes operate on the same external database, use
separate ODBC connections: one for the nodes that are not to commit until the
completion of the message flow, and one for the nodes that are to commit
immediately. If you do not, the nodes that commit immediately will also
commit all operations that are carried out by preceding Automatic nodes.

Note: On systems other than z/OS, individual relational databases might or
might not support this mode of operation.

If you define more than one ODBC connection you might get database locking
problems. In particular, if a node with Automatic transactionality carries out an
operation, such as an INSERT or an UPDATE, that causes a database object
(such as a table) to be locked, and a subsequent node tries to access that
database object using a different ODBC connection, an infinite lock (deadlock)
occurs.

The second node waits for the lock acquired by the first to be released, but the
first node will not commit its operations and release its lock until the message
flow completes; this will never happen because the second node is waiting for
the first node’s database lock to be released.

Such a situation cannot be detected by any DBMS automatic
deadlock-avoidance routines because the two operations are interfering with
each other indirectly using the broker.

There are two ways to avoid this type of locking problem:

* Design your message flow so that uncommitted (automatic) operations do
not lock database objects that subsequent operations using a different ODBC
connection need to access.

* Configure your database’s lock timeout parameter so that an attempt to
acquire a lock fails after a specified length of time. If a database operation
fails because of a lock timeout, an exception is thrown that the broker
handles in the usual way.

For information concerning which database objects are locked by particular
operations, and how to configure your database’s lock timeout parameter,
consult your database product documentation.
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Set the Transaction Mode property for the following nodes, if they are in this
message flow:

* MQInput node

* MQOutput node

* MQReply node

* SCADAInput node

* JMSInput node

* JMSOutput node

The following table provides a summary of the actions taken in response to
specific property settings for the input and output nodes.

Message Input node MQOutput or Message flow is globally
persistence * | Transaction Mode MQReply node coordinated?
Transaction Mode

Yes Yes Automatic Yes

No Yes Automatic Yes

Yes No Automatic No

No No Automatic No

Yes Automatic Automatic Yes

No Automatic Automatic No

Any ® Any ® Yes Yes

Any ® Any ° No No

Notes:

6.
7.

a. Persistence is relevant only for messages received across the
WebSphere MQ Enterprise Transport, WebSphere MQ Mobile
Transport, and WebSphere MQ Telemetry Transport protocols.

b. The MQOutput or MQReply node property setting overrides the
value set here.

c. The Transaction Mode settings of the J]MSInput and JMSOutput
nodes are set differently to the preceding table. See [“JMSInput node”|
[on page 884 and ['/JMSOutput node” on page 897

The default on each input node is Yes, which means that the incoming
messages are processed under syncpoint. In addition, messages sent to the
output node are delivered under syncpoint. You can change this behavior if the
output node is an MQOutput or MQReply node, both of which have a
Transaction Mode property.

If you set the Transaction Mode on an input node to Automatic, the incoming
messages are processed under syncpoint only if they are defined as persistent.
Messages sent to the MQOutput node are delivered under syncpoint unless
you explicitly change the Transaction Mode in the MQOutput node.

Set the Treat warnings as errors and Throw exception on database error for
each node that accesses a database to indicate how you want that node to
handle database warnings and errors. Whether you select these properties, and
how you connect the failure terminals of the nodes, also affect the way in
which database updates are committed or rolled back.

Switch to the Broker Administration perspective.
Add the message flow to a broker archive.



8. Select the Configure tab below the broker archive editor view and select the

message flow. This displays the configurable properties for the message flow
within the broker archive. Select coordinatedTransaction to configure the
message flow as globally coordinated.

On z/0S, transactions are always globally coordinated. The setting of
the coordinatedTransaction property for a message flow is ignored.
Coordination is always provided by RRS.

The message flow is now configured for global coordination.

Now, you can deploy the message flow to the broker. Ensure that the broker
environment (including the broker’s queue manager) and databases are correctly
configured for global coordination before you deploy the message flow.

If the broker environment and the databases are not correctly configured for global
coordination, the message flow transactions will not be globally coordinated.

Configuring JMSInput and JMSOutput nodes to support global
transactions

If you want to include JMSInput and JMSOutput nodes in globally-coordinated
transactions, additional configuration is required.

Complete the following steps:
1. Switch to the Broker Application Development perspective.

2. Set the message flow property Coordinated Transaction to yes in the bar file
properties.

3. For each JMSInput or JMSOutput node required in the global transaction, set
the Advanced property Transaction mode to Global in the message flow editor.

4. Create a Queue Connection Factory and either use the default name,
recoverXAQCF , or supply your own name. See the [[MSInput| or [MSOutput]
node for further details about creating JNDI administered objects.

5. On distributed systems, you must set up a stanza for each JMS provider that
you want to use, prior to deployment.

The following table shows the switch files that are provided on each platform.

Platform 32-bit file 64-bit file

Linux (x86 platform) lib]MSSwitch.so

Windows JMSSwitch.dll

HP-UX (PA-RISC platform) libJMSSwitch.sl lib]MSSwitch64.sl
AIX lib]MSSwitch.so lib]MSSwitch64.so

Linux (x86-64 platform)
Solaris (SPARC platform)

HP-UX (Integrity platform) libJ]MSSwitch.so
Linux (POWER™ platform)
Linux (zSeries platform)
Solaris (x86-64 platform)

Select the appropriate link for details of this task on the platform, or platforms,
that your enterprise uses:

. PTTI [Linux and UNIX systems|
o« M [Windows systems|
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For further information, see:

+ [“Configuring for coordinated transactions” on page 889 within the JMSInput
node topic

* |“Configuring for coordinated transactions” on page 903| within the
JMSOutput node topic

On z/0S, the only JMS provider supported is the IBM WebSphere
MQ Java Client and the only transport mode supported for that client is BIND
mode; no further configuration steps are required.

The JMS provider might supply additional jar files that are required for
transactional support; see the documentation supplied with the JMS provider for
more information. For example, on distributed systems, the WebSphere MQ JMS
provider supplies an extra jar file com.ibm.mgetclient.jar.

You must add any additional jar files to the broker shared_classes directory. On
Windows, this directory is C:\Documents and Settings\ All Users\ Application
Data\IBM\MQSI\shared-classes. For more information, see the section on making
the JMS provider client available to the JMS Nodes in [‘TMSInput node” on page|

Choice of JMS Provider

Any JMS provider that conforms to the [[ava Message Service Specification, version|
and that supports the J]MS XAResource API through the JMS session can be
used if transaction coordination is required.

If the message designer has specified a non XA-compliant provider, the non
transactional mode only is supported. In this case, you must set the Transaction
mode property to None for all JMSInput and JMSOutput nodes.

Linux and UNIX systems: configuring the queue manager to
coordinate JMS resources
Edit the queue manager qm.ini file to configure the queue manager.

You must specify a stanza in the broker’s queue manager .ini file for each JMS
provider that you want to use. There must be one stanza for each new JMS
provider, where the JMS provider can be specified by any JMSInput or J]MSOutput
node included in a message flow that is running on a broker.

The parameters that are supplied on XAOpenString are comma delimited and
positional. Any missing optional parameter must be represented by a comma if
other parameters are provided later in the string.

The following stanza entry is an example you can add when using WebSphere MQ
Java as the JMS provider:

XAResourceManager:
Name=WBIWMQJMS

SwitchFile=/<Installation Path>/1ib/JMSSwitch.so

XAOpenString=<Initial Context Factory>,
<location of JNDI bindings>'
<LDAP Principal>,
<LDAP Credentials>,
<Recovery Connection Factory Name>,
<JMS Principal>,
<JMS Credentials>
ThreadOfControl=THREAD


http://java.sun.com/products/jms/docs.html
http://java.sun.com/products/jms/docs.html

where:

<Installation Path>
Is the location of the WebSphere Message Broker installation. This value is
mandatory where the LDAP parameters are omitted, but a user defined
Queue Connection Factory is specified for recovery.

<Initial Context Factory>
Is the Initial Context Factory identifier for the JMS provider; this value is
required.

<Location of JNDI bindings>
Is either the file path to the bindings file, or the LDAP directory location of
the JNDI administered objects that can be used to create an initial context
factory for the JMS connection. When supplying the file path to the
bindings file, do not include the file name. See the JMSInput or JMSOutput
node for further details on creating the JNDI administered objects; this
value is required.

<LDAP Principal>
Is an optional parameter used to specify the principal (user ID) that might
be required when an LDAP database is used to hold the JNDI
administered objects.

<LDAP Credentials>
Is an optional parameter used to specify the Credentials (password) that
might be required if a password protected LDAP database is used to hold
the JNDI administered objects.

<Recovery Connection Factory Name>
Is an optional parameter used to specify the name of a Queue Connection
Factory object in the JNDI administered objects for recovery purposes,
when the non default name is required.

<JMS Principal>
Is an optional parameter for the user ID required to connect to a JMS
provider, using a secure JMS Connection Factory.

<JMS Credentials>
Is an optional parameter for the password required to connect to the same
JMS provider in conjunction with the JMS principal.

The values for the Initial Context factory and Location of JNDI bindings in the
stanza must match those specified in the JMSInput or J]MSOutput nodes in the
message flows.

Any LDAP parameters must match those that have been specified by using the
mgsicreatebroker or mqgsichangebroker command.

The Recovery Factory Name must match a Queue Connection Factory name that is
created in the JNDI administered objects. If this is omitted, a default factory called
recoverXAQCF is used. In either case this value must refer to a JNDI administered
object that has already been created.

The JMS Principal and JMS Credentials must be configured together

Following is an example format of a stanza in the gm.ini file that describes a JMS
provider for global transactions:
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XAResourceManager:
Name=XAJMS_PROVIDER1
SwitchFile=/opt/var/mqsi/1ib/JIMSSwitch.so
XAOpenString= com.sun.jndi.fscontext.RefFSContextFactory,
/Bindings/JMSProviderl Bindings_Directory,

H

myJMSuserl,
passwd
ThreadOfControl=THREAD

where:

XAJMS_PROVIDER1
Is the user-defined name for the resource manager

lopt/var/mqsi
Is the <Installation Path>

com.sun.jndi.fscontext.RefFSContextFactory
Is the <Initial Context Factory>

/Bindings/JMSProviderl_Bindings_Directory
Is the location of the bindings

myJMSuserl
Is the <JMS Principal>

passwd
Is the password used in <JMS Credentials>

In this example the optional fields <LDAP Principal>, <LDAP Credentials>, and
<Recovery Connection Factory Name> are not required, so only the positional
comma delimiters are configured in the XAOpenString stanza.

Windows systems: configure the queue manager to coordinate
JMS resources
Use WebSphere MQ Explorer to configure the queue manager.

You must specify a stanza in the broker’s queue manager .1ini file for each JMS
provider that you want to use. There must be one stanza for each new JMS
provider, where the JMS provider can be specified by any JMSInput or JMSOutput
node included in a message flow that is running on a broker.

The parameters that are supplied on XAOpenString are comma delimited and
positional. Any missing optional parameter must be represented by a comma if
other parameters are provided later in the string.

The extra entry, called the XACToseString, should match the values provided for
the XAOpenString.

The following stanza entry is an example you can add when using WebSphere MQ
Java as the JMS provider:

XAResourceManager:
Name=WBIWMQJIMS
SwitchFile=/<Installation Path>/1ib/JMSSwitch.so
XAOpenString=<Initial Context Factory>,
<location of JNDI bindings>'
<LDAP Principal>,
<LDAP Credentials>,



<Recovery Connection Factory Name>,
<JMS Principal>,

<JMS Credentials>
ThreadOfControl=THREAD

where:

<Installation Path>
Is the location of the WebSphere Message Broker installation. This value is
mandatory where the LDAP parameters are omitted, but a user defined
Queue Connection Factory is specified for recovery.

<Initial Context Factory>
Is the Initial Context Factory identifier for the JMS provider; this value is
required.

<Location of JNDI bindings>
Is either the file path to the bindings file, or the LDAP directory location of
the JNDI administered objects that can be used to create an initial context
factory for the JMS connection. When supplying the file path to the
bindings file, do not include the file name. See the JMSInput or J]MSOutput
node for further details on creating the JNDI administered objects; this
value is required.

<LDAP Principal>
Is an optional parameter used to specify the principal (user ID) that might
be required when an LDAP database is used to hold the JNDI
administered objects.

<LDAP Credentials>
Is an optional parameter used to specify the Credentials (password) that
might be required if a password protected LDAP database is used to hold
the JNDI administered objects.

<Recovery Connection Factory Name>
Is an optional parameter used to specify the name of a Queue Connection
Factory object in the JNDI administered objects for recovery purposes,
when the non default name is required.

<JMS Principal>
Is an optional parameter for the user ID required to connect to a JMS
provider, using a secure JMS Connection Factory.

<JMS Credentials>
Is an optional parameter for the password required to connect to the same
JMS provider in conjunction with the JMS principal.

The values for the Initial Context factory and Location of JNDI bindings in the
stanza must match those specified in the JMSInput or J]MSOutput nodes in the
message flows.

Any LDAP parameters must match those that have been specified by using the
mgsicreatebroker or mgsichangebroker command.

The Recovery Factory Name must match a Queue Connection Factory name that is
created in the JNDI administered objects. If this is omitted, a default factory called
recoverXAQCF is used. In either case this value must refer to a JNDI administered
object that has already been created.

The JMS Principal and JMS Credentials must be configured together
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Following is an example format of a stanza in the gm.ini file that describes a JMS
provider for global transactions:
XAResourceManager:
Name=XAJMS_PROVIDER1
SwitchFile=/opt/var/mqsi/1ib/JIMSSwitch.so
XAOpenString= com.sun.jndi.fscontext.RefFSContextFactory,
/Bindings/JMSProviderl Bindings_Directory,

myJMSuserl,
passwd
ThreadOfControl=THREAD

where:

XAJMS_PROVIDER1
Is the user-defined name for the resource manager

/opt/var/mqsi
Is the <Installation Path>

com.sun.jndi.fscontext.RefFSContextFactory
Is the <Initial Context Factory>

/Bindings/JMSProviderl_Bindings_Directory
Is the location of the bindings

myJMSuserl
Is the <JMS Principal>

passwd
Is the password used in <JMS Credentials>

In this example the optional fields <LDAP Principal>, <LDAP Credentials>, and
<Recovery Connection Factory Name> are not required, so only the positional
comma delimiters are configured in the XAOpenString stanza.

Configuring message flows for data conversion
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If you exchange messages between applications that run on systems that are
incompatible in some way, you can configure your system to provide data
conversion as the message passes through the broker. Data conversion might be
necessary if either of the following two values are different on the sending and
receiving systems:

1. CCSID. The Coded Character Set Identifier refers to a set of coded characters
and their code point assignments. WebSphere Message Broker can process and
construct application messages in any code page for which WebSphere MQ
provides conversion to and from Unicode, on all operating systems. For more
information about code page support, see the WebSphere MQ Application
Programming Reference.

This behavior might be affected by the use of other products in conjunction
with WebSphere Message Broker. Check the documentation for other products,
including any databases that you use, for further code page support
information.

2. Encoding. This defines the way in which a machine encodes numbers, that is
binary integers, packed-decimal integers, and floating point numbers. Numbers
that are represented as characters are handled in the same way as all other
string data.



If the native CCSID and encoding on the sending and receiving systems are the
same, you do not need to invoke data conversion processes.

WebSphere Message Broker and WebSphere MQ provide data conversion facilities
to support message exchange between unlike systems. Your choice of which
facilities to use depends on the characteristics of the messages that are processed
by the message flow:

Messages that contain text only]

Message that include numerics

Messages that are self-definin

Messages that contain text only

Read this section if your messages are WebSphere MQ messages that
contain all text (character data or string). If WebSphere MQ supports the
systems on which both sending and receiving applications are running for
data conversion, use WebSphere MQ facilities. This provides the most
efficient data conversion option.

The default behavior of WebSphere MQ is to put messages to queues
specifying the local system CCSID and encoding. Applications issuing
MQGET can request that the queue manager provides conversion to their
local CCSID and encoding as part of get processing.

To use this option:

1. Design messages to be text-only. If you are using COBOL, move
numeric fields to USAGE DISPLAY to put them into string form.

2. Set the Format field in the MQMD to MQFMT_STRING (value
MQSTR).

3. Issue MQGET with MOQGMO_CONVERT in the receiving application. If
you prefer, you can convert when the message is received by the
broker, by setting the Convert property of the MQInput node to yes (by
selecting the check box).

If you require more sophisticated data conversion than WebSphere MQ
provides in this way (for example, to an unsupported code page), use
WebSphere MQ data conversion exits. For more information about these,
see the WebSphere MQ Application Programming Reference.

Messages that include numerics

Read this section if your messages include numeric data, or are text only
but are not WebSphere MQ messages. If these messages can be predefined
(that is, their content and structure is known and predictable), use the
facilities provided by WebSphere Message Broker and the MRM.

All application messages are handled by the broker in Unicode, to which
they are converted on input, and from which they are converted on output.
You can configure message flows to influence the way in which output
messages are constructed.

To use this option:

1. Define the output message in the MRM domain. You can create this
definition in one of the following ways:

¢ Import an external message definition (for example a C header or
COBOL copybook).

* Create the message model in the message definition editor.
2. Configure a message flow to receive and process this message:
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a. If you include an MQInput node, do not request conversion by this
node.

b. Include a Compute node in the message flow to create the output
message with the required content:

* If the output message is a WebSphere MQ message, code ESQL
in the Compute node to set the CCSID and encoding for the
target system in the MQMD.

For example, to set values for a target z/OS system running with
CCSID of 37 and encoding of 785:

SET OutputRoot.MQMD.CodedCharSetId = 37;
SET QutputRoot.MQMD.Encoding = 785;

* If the output message is not a WebSphere MQ message, code
ESQL in the Compute node to set the CCSID and encoding for
the target system in the Properties folder.

Messages that are self-defining
Read this section if your messages are self-defining.

Self-defining messages are supported in the XML and JMS domains. These
messages are all text and can be handled by WebSphere MQ, if they
originate from, or are destined for, WebSphere MQ applications. If not, use
WebSphere Message Broker facilities by setting the CCSID and Encoding
fields in the Properties folder in the message when it passes through a
Compute node.

Using MQGet nodes

176 Message Flows

The following topics explain how the MQGet node processes messages, and how
you might use an MQGet node in a request-response flow:

+ ["How the MQGet node processes messages”]

* [“A request-response scenario using an MQGet node” on page 180|

How the MQGet node processes messages
The MQGet node processes each message that it receives.

This topic contains the following sections:

* |“Propagating the message”|

+ [“Constructing OutputLocalEnvironment” on page 178

+ |“Constructing the Output message” on page 179

Propagating the message

1. If an MQ Message Descriptor header (MQMD) is present in the input tree, the
MQGet node uses it. If not, the node creates a default MQMD.

2. The node also creates a default MQ Get Message Options (MQGMO) structure
based on the values that you have set for the node properties. If an MQGMO is
present in the input tree, the node uses its content to modify the default one.

3. The node makes the MQGet call to WebSphere MQ.

4. The node analyzes the completion code (CC), and propagates the message to
the appropriate terminal:

OK  The node creates the output LocalEnvironment and the output message
trees using standard message-parsing techniques, then propagates the
message to the Out terminal.



Warning
The node creates the output LocalEnvironment and the output message
trees using BLOB as the message body type, then propagates the
message to the Warning terminal, if it is connected. If the Warning
terminal is not connected, no propagation occurs, and the flow ends.

Fail (no message)

The node creates the output LocalEnvironment and the output message
trees by copying the input trees, then propagates the message to the No
Message terminal, if it is connected. If the No Message terminal is not
connected, no propagation occurs. The output message that is
propagated to the No Message terminal is constructed from the input
message only, according to the values of the Generate Mode property,
and the Copy Message or Copy Local Environment properties.

Fail (other)
The node propagates the message to the Failure terminal. If the Failure
terminal is not connected, the broker throws an exception and returns
control to the closest previous node that can process it. For more
information, see [“Handling errors in message flows” on page 194

The following diagram shows this processing:
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Constructing OutputLocalEnvironment

1. If the Generate Mode property on the MQGet node is set to an option that does
not include LocalEnvironment, the node copies the input LocalEnvironment
tree to the output LocalEnvironment tree.

If this copy is made, any updates that are made in this node to the output
LocalEnvironment tree are not propagated downstream.

If the Copy Local Environment property is set to an option other than None,

the node copies the input LocalEnvironment tree to the output

LocalEnvironment tree.
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3. If the output data location points to the output LocalEnvironment tree, the
node applies changes in that tree by copying from the result tree.

4. The LocalEnvironment tree is propagated.

The following diagram shows this processing:

Input Local
Environment

Does generateMode
include LocalEnv?

Set the output
local environment
to be the input one.

Copy the input
local environment
into the output.

Is copyLocalEnv
set to none?

(If the output data location points
to the output local environment,
then changes are inserted here
by copying from the Result tree).

A 4

.| Propagate the

P> 4
local environment.

Constructing the Output message

1. If the Generate Mode property on the MQGet node is set to an option that does

not include Message, the node copies the input message tree to the output
message tree. |Go to step 5

2. If the Output Data Location property is set to OutputRoot, the node creates the
output message tree entirely from the result tree. |Go to step 5

3. If the Copy Message property is set to a value other than None, the node
copies the input message tree to the output message tree.

4. If the Output Data Location property points to a part of the output message

tree, the node applies changes in that tree by copying from the result tree at the

point that is defined by the Result Data Location property.
5. The message tree is propagated.

The following diagram shows this processing:
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For an example of how this processing is implemented in a message flow, see

[request-response scenario using an MQGet node.”

A request-response scenario using an MQGet node

This topic describes a scenario in which an MQGet node is used in a
request-response flow, and explains how the node processes the input messages to
construct the output messages, based on both the content of the LocalEnvironment
tree and the input parameters that you set.

A request-response flow is a specialized form of a point-to-point application. For a
general description of these applications, see [Application communication models}
For an example of a request-response message flow, see the following sample:




+ |Coordinated Request Reply sample|

You can view samples only when you use the information center that is integrated
with the Message Broker Toolkit.

You can include an MQGet node anywhere in a message flow, including a flow
that implements a request-response scenario. The node receives an input message
on its input terminal from the preceding node in the message flow. It issues an
MOQGET call to retrieve a message from the WebSphere MQ queue that you have
configured in its properties, and builds a result message tree. Finally, it uses the
input tree and the result tree to create an output tree that is then propagated to its
Output, Warning, or Failure terminal, depending on the configuration of the node
and the result of the MQGET operation.

How the MQGet node handles the LocalEnvironment:

The MQGet node examines the LocalEnvironment tree that is propagated from the
preceding node. It uses the content related to the MQGMO (MQ Get Message
Options) and the MQMD (MQ Message Descriptor header), and updates the
LocalEnvironment:

* The node reads the MQGMO structure from ${inputMQParmsLocation}.MQGMO. *.

* The node copies the WebSphere MQ completion and reason codes to
${outputMQParmsLocation}.CC and ${outputMQParmsLocation}.RC.

e The node writes the complete MQGMO that is used for the MQGET call into
${outputMQParmsLocation}.MQGMO if ${inputMQParmsLocation}.MQGMO exists in the
input tree.

¢ The node writes the MQMD that is passed to the MQGET call (that contains the
values that are specified in the input message or are generated by the node) into
${inputMQParmsLocation} .MQMD, deleting any existing content.

Set the value to ${inputMQParmsLocation} in the MQGet node property Input MQ
Parameters Location on the Request Properties tab.

Set the value to ${outputMQParmsLocation} in the MQGet node property Output
MQ Parameters Location on the Result Properties tab.

For more information about these properties, see |“MQGet node” on page 930

In summary:

${inputMQParmsLocation}
* QueueName: Optional override for MQGet node Queue Name property
* InitialBufferSize: Optional override for MQGet node Initial Buffer Size
property
* MQGMO.*: Optional MQGET message options that are used by the
MQGet node
${outputMQParmsLocation}
¢ CC: MQGET call completion code
* RC: MQGET call result code

¢ MQGMO.*: MQGET message options that are used if present in
${inputMQParmsLocation}

* MQMD: unparsed MQ Message Descriptor for received messages'
* Browsed: Set to true if the message is browsed. Not present if the
message is removed from the queue
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Notes:
1. You can parse the MQMD (for example, using ESQL), where
${outputMQParmsLocation} is LocalEnvironment. MQ.GET:

DECLARE ptr REFERENCE TO OutputLocalEnvironment.MyMQParms;
CREATE FIRSTCHILD OF ptr DOMAIN('MQMD') PARSE(InputLocalEnvironment.MQ.GET.MQMD)

How the MQMD for the MQGET call is constructed:

* A default MQMD is prepared. For further information about MOMD see the
Application Programming Reference in the [WebSphere MQ Version 6|
[information center online}

* If you do not supply an input MQMD, the default MQMD is used.

* If you do supply an input MQMD, the default MOMD is used after the
following modifications:

— If the property Use all input MQMD fields is set, all MQMD fields supplied
are copied into the default MQMD from the input MQMD.

— If the property Use all input MQMD fields is not set and the properties Get
by Message ID or Get by Correlation ID are selected, the respective IDs are
copied into the default MQMD from the input MQMD.

The following diagram shows how the MQGet node constructs the MQMD that is
used on the call to WebSphere MQ:
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How the output message tree is constructed:

»
»

The following diagram outlines how the MQGet node constructs the output
message tree, combining the input tree from the previous node with the result tree

from the MQGET call:
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Input Tree from
previous node

Result Tree from
MQGET call

Ouput Tree sent to
downstream nodes

In this example, the MQGet node properties are configured as shown in the

following table.

Table 9.
Property Action
Copy Message Copy Entire Message

Generate Mode

Message

Output Data Location

QutputRoot.XMLNS.A

Result Data Location

ResuTtRoot.XMLNS.C

The MQGet node constructs the output tree according to the following sequence:

1. The whole of the input tree is copied to the output tree, including the XML
branch with child A, and A’s child B.

2. From the result tree, the XML branch’s child C, and C’s child D, are put into
the output tree at position OutputRoot.XMLNS.A. Any previous content of A
(values and children) is lost, and replaced with C’s content, including all values
and children it has, in this case child D.

3. The position in the output tree retains the name A.

The following diagram illustrates this:
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For some examples of message trees that are constructed by the MQGet node
according to the rules described above, see["MQGet node message tree examples.”|

MQGet node message tree examples:

The tables below show examples of message trees that are constructed by the
MQGet node according to the rules described in[A request-response scenario|

[using an MQGet node” on page 180 .|

With a message assembly like this:

The message that the MQGet node returns is:

InputRoot

MQMD
{input message MQMD)}

MQRFH2
{input message MQRFH2}

XMLNS
{input message body}

InputLocalEnvironment

MQ
GET
MQGMO
MatchOptions =
MQMO_MATCH_CORREL_ID
MQMD (with no children)
MyData
MQMD

{input MQMD} (with CorrellD =
{correct Correlation ID as binary})

ResultRoot

MQMD
{result message MQMD)}

MQRFH2
{result message MQRFH2}

XML  {result message body}
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With the following node property settings:

The resulting output message assembly is:

Input MQMD Location
InputLocalEnvironment.MyData.MQMD

Copy Message
Copy Entire Message

Copy Local Environment
Copy Entire LocalEnvironment

Generate Mode
Message and LocalEnvironment

Output Data Location
InputLocalEnvironment.MyData.ReturnedMessage

OutputRoot
MQMD
{input message MQMD}
MOQRFH2
{input message MQRFH2}

XMLNS
{input message body}

OutputLocalEnvironment
MQ
GET
MQGMO

{MQGMO used
for MQGET}

MQMD
{MQMD used
for MQGET}

CC=0

RC=0

MyData
MQMD
{input MQMD)} (with
CorrellD = {correct

Correlation ID as
binary})

ReturnedMessage

MQMD
{result message
MQMD}

MOQRFH2
{result message
MQRFH?2}

XML  {result message
body}
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With the following node property settings:

The resulting output message assembly is:

Result Data Location
ResultRoot. XML

OutputRoot

MQMD
{input message MQMD)}

MQRFH2
{input message MQRFH2}

XMLNS
{input message body}

OutputLocalEnvironment

MQ
GET
MQGMO
{MQGMO used
for MQGET]}
MQMD
{MQMD used
for MQGET}
CC=0
RC=0
MyData
MQMD

{input MQMD} (with
CorrellD = {correct
Correlation ID as
binary})

ReturnedMessage (with any
attributes and value from
ResultRoot.XML)

{result message body}

This tree is effectively the result of doing an
assignment from ${resultDatalocation} to
${outputDataLocation}. The value of the source
element is copied, as are all children including
attributes.
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With the following node property settings:

The resulting output message assembly is:

Copy Local Environment
None

OutputRoot

MQMD
{input message MQMD}

MQRFH2
{input message MQRFH2}

XMLNS
{input message body}

OutputLocalEnvironment

MQ
GET
MQGMO
{MQGMO used
for MQGET}
MQMD
{MQMD used
for MQGET}
CC=0
RC=0
MyData

ReturnedMessage (with any
attributes and value from
ResultRoot.XML)

{result message body}

This tree has the MQMD that is used for the
MQGET call in the OutputLocalEnvironment,
because the input MQ parameters location had an
MQMD element under it. Even though the input
tree is not copied, the presence of the MQMD
element causes the MQMD that is used for the
MOQGET call to be placed in the output tree.
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With the following node property settings:

The resulting output message assembly is:

Output Data Location
<blank>

Copy Local Environment
Copy Entire Local Environment

OutputRoot

MQMD
{result message MQMD)}

MQRFH2
{result message MQRFH2}

XMLNS
{result message body}

OutputLocalEnvironment

MQ
GET
MQGMO
{MQGMO used
for MQGET]}
MQMD
{MQMD used
for MQGET}
CC=0
RC=0
MyData
MQMD

{input MQMD} (with
CorrellD = {correct
Correlation ID as
binary})

The value that you set for the Copy Message
property makes no difference to the eventual
output tree in this case.

Exploiting user exits

This topic shows how your message flows can benefit from user exits.

Before you start you must read [“User exits” on page 121)

In the diagram below, the MQInput node is used as an example, but the function
applies to all input nodes, including user-defined nodes.
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Transaction Manager

Event 1. The message is dequeued from the input source (read into the flow).
However, built-in nodes and user-defined nodes differ slightly in the way in which
user exits are invoked. For built-in input nodes, the user exit is invoked as soon as
possible after the data has been read from the external source. For user-defined
input nodes, the user exit is called just before the node propagates the message.

Event 2. The message is propagated to the node for processing.
Event 3. The node processing is completed.

Event 4. The user exit is invoked after the transaction has completed, so the user
exit processing is not part of that transaction. The user exit is invoked even if no
transactional processing was completed by the flow. Where the message flow
property Commit Count is greater than 1, many-to-one ratios exist between event 1
and event 4. This ratio also exists for some scenarios specific to the particular input
node; for example, when an MQInputNode is configured with the Commit by
Message Group property selected.

You can write a user exit to track any number of these events. For each of these
events, the following data is available to the user exit. All access is read-only,
unless stated otherwise:

* Dequeue message:

— Bit stream

— Input node

— Environment tree (read and write)
* Message propagated to node:

— Message tree

— LocalEnvironment tree (read/write)

— Exception list

— Environment tree (read/write)

— Source node

— Target node

* Node processing completed:



— Message tree
— LocalEnvironment tree (read and write)
— Exception list
— Environment tree (read and write)
— Node
— Upstream node
— Exception (if any)
* End of transaction:
- Input node
— Exception if any
— Environment tree (read and write)

You can register multiple user exits, and, if they are registered, they are invoked in
a defined order (see [mgsichangeflowuserexits command). Any changes made to the
message assembly by a user exit are visible to subsequent user exits.

When the user exit is invoked, it can query the following information:
* Message flow information:

— Message flow name

— Broker name

— Broker’s queue manager name

- Execution group name

— Message flow’s commit count property

— Message flow’s commit interval property

— Message flow’s coordinated transaction property
* Node information:

— Node name

Node type
Terminal name

— Node properties

The node can also perform the following tasks:

* Navigate and read the message assembly (Message, LocalEnvironment,
ExceptionList)

* Navigate and read or write the Environment tree

The user exits can be registered on a dynamic basis, without needing to redeploy
the configuration.

Ensuring that messages are not lost

It is important to safeguard that messages that flow through your broker domain.
This is true of both application-generated messages and those used internally for
inter-component communication. Messages used internally between components
always use the WebSphere MQ protocol. Application messages can use all
supported transport protocols.

For application and internal messages travelling across WebSphere MQ, two
techniques protect against message loss:
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* Message persistence

If a message is persistent, WebSphere MQ ensures that it is not lost when a
failure occurs, by copying it to disk.

* Syncpoint control

An application can request that a message is processed in a synchronized
unit-of-work (UOW)

For more information about how to use these options, refer to the WebSphere MQ
System Administration Guide.

Internal messages

WebSphere Message Broker components use WebSphere MQ messages to
communicate events and data between broker processes and subsystems, and the
Configuration Manager and User Name Server. The components ensure that the
WebSphere MQ features are exploited to protect against message loss. You do not
need to take any additional steps to configure WebSphere MQ or WebSphere
Message Broker to protect against loss of internal messages.

Application messages

If delivery of application messages is critical, you must design application
programs and the message flows that they use to ensure that messages are not lost.
The techniques used depend on the protocol used by the applications.

WebSphere MQ Enterprise Transport and WebSphere MQ Mobile Transport
If you are using the built-in input nodes that accept messages across the
WebSphere MQ or WebSphere MQ Everyplace protocols, you can use the
following guidelines and recommendations:

* Using persistent messages

WebSphere MQ messaging products provide message persistence, which
defines the longevity of the message in the system and guarantees
message integrity. Nonpersistent messages are lost in the event of system
or queue manager failure. Persistent messages are always recovered if a
failure occurs.

You can control message persistence in the following ways:

— Program your applications that put messages to a queue using the
MQI or AMI to indicate that the messages are persistent.

— Define the input queue with message persistence as the default
setting.

— Configure the output node to handle persistent messages.
— Program your subscriber applications to request message persistence.

When an input node reads a message is read from an input queue, the
default action is to use the persistence defined in the WebSphere MQ
message header (MQMD), that has been set either by the application
creating the message, or by the default persistence of the input queue.
The message retains this persistence throughout the message flow, unless
it is changed in a subsequent message processing node.

You can override the persistence value of each message when the
message flow terminates at an output node. This node has a property
that allows you to specify the message persistence of each message
when it is put to the output queue, either as the required value, or as a



default value. If you specify the default, the message takes the
persistence value defined for the queues to which the messages are
written.

If a message passes through a Publication node, the persistence of
messages sent to subscribers is determined by the subscribers’
registration options. If a subscriber has requested persistent message
delivery, and is authorized to do so by explicit or implicit (inherited)
ACL, the message is delivered persistently regardless of its existing
persistence property. Also, if the user has requested nonpersistent
message delivery, the message is delivered nonpersistent regardless of its
existing persistence property.

If a message flow creates a new message (for example, in a Compute
node), the persistence in the MQMD of the new message is copied from
the persistence in the MQMD of the incoming message.

* Processing messages under syncpoint control

The default action of a message flow is to process incoming messages
under syncpoint in a broker-controlled transaction. This means that a
message that fails to be processed for any reason is backed out by the
broker. Because it was received under syncpoint, the failing message is
reinstated on the input queue and can be processed again. If the
processing fails, the error handling procedures that are in place for this
message flow (defined either by how you have configured the message
flow, or by the broker) are executed.

For full details of input node processing, see [‘Managing errors in the]
linput node” on page 197/

WebSphere MQ Telemetry Transport
If you are using the built-in input node SCADAInput that accepts
messages from telemetry devices across the MQIsdp protocol, this protocol
does not have a concept of queues. Clients connect to a SCADAInput node
by specifying the port number on which the node is listening. Messages
are sent to clients using a clientId. However, you can specify a maximum
QoS (Quality of Service) within a SCADA subscription message, which is
similar to persistence:
* QoS0 Nonpersistent.
* QoS1 Persistent, but might be delivered more than once
* QoS2 Once and once only delivery

If a persistent SCADA message is published, it might be downgraded to
the highest level that the client can accept. In some circumstances this
might mean that the message becomes nonpersistent.

WebSphere MQ Real-time Transport, WebSphere MQ Multicast Transport, and

WebSphere MQ Web Services Transport
If you are using the built-in input nodes Real-timelnput and
Real-timeOptimizedFlow that accept messages from JMS and multicast
applications, or you are using the HTTPInput, HTTPRequest, SOAPInput,
SOAPRequest nodes or a SOAPAsyncRequest and SOAPAsyncResponse
node pair that accept messages from Web services applications, no facilities
are available to protect against message loss. You can, however, provide
recovery procedures by configuring the message flow to handle its own
erTorS.

Other transports and protocols
If you have created your own user-defined input nodes that receive
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messages from another transport protocol, you must rely on the support
provided by that transport protocol, or provide your own recovery
procedures.

Handling errors in message flows

194 Message Flows

The broker provides basic error handling for all your message flows. If basic
processing is not sufficient, and you want to take specific action in response to
certain error conditions and situations, you can enhance your message flows to
provide your own error handling.

For example, you might design a message flow that expects certain errors that you
want to process in a particular way, or a flow that updates a database and must
roll back those updates if other processing does not complete successfully.

The options that you can use to do this are quite complex in some cases. The
options that are provided for MQInput and TimeoutNotification nodes are
extensive because these nodes deal with persistent messages and transactions. The
MQInput node is also affected by configuration options for WebSphere MQ.

Because you can decide to handle different errors in different ways, there are no
fixed procedures to describe. This section provides information about the principles
of error handling, and the options that are available, and you must decide what
combination of choices that you need in each situation based on the details that are
provided in this section.

You can choose one or more of these options in your message flows:

* Connect the failure terminal of any node to a sequence of nodes that processes
the node’s internal exception (the fail flow).

* Connect the catch terminal of the input node or a TryCatch node to a sequence
of nodes that processes exceptions that are generated beyond it (the catch flow).

* Insert one or more TryCatch nodes at specific points in the message flow to
catch and process exceptions that are generated by the flow connected to the try
terminal.

* Include a Throw node, or code an ESQL THROW statement, to generate an
exception.

* Connect the catch terminal of the AggregateReply node to process aggregation
exceptions if you are using aggregation.

* Ensure that all of the messages received by an MQInput node are processed
within a transaction, or are not processed within a transaction.

* Ensure that all of the messages received by an MQInput node are persistent, or
are not persistent.

If you include user-defined nodes in your message flow, you must refer to the
information provided with the node to understand how you might handle errors
with these nodes. The descriptions in this section cover only the built-in nodes.

When you design your error handling approach, consider the following factors:

* Most of the built-in nodes have failure terminals. The exceptions are the
AggregateControl, AggregateRequest, Input, Label, Output, Passthrough,
Publication, Real-timelnput, Real-timeOptimizedFlow, Throw, Trace, and
TryCatch nodes.

When an exception is detected within a node, the message and the exception
information are propagated to the node’s failure terminal. If the node does not



have a failure terminal, or it is not connected, the broker throws an exception
and returns control to the closest previous node that can process it. This might
be a TryCatch node, an AggregateReply node, or the input node.

If an MQInput node detects an internal error, its behavior is slightly different; if
the failure terminal is not connected, it attempts to put the message to the input
queue’s backout requeue queue, or (if that is not defined) to the dead letter
queue of the broker’s queue manager.

For more information, see [“Handling MQInput errors” on page 198

A small number of built-in nodes have catch terminals. These are the
AggregateReply, HTTPInput, MQInput, SCADAInput, J]MSInput, J]MSOutput,
TimeoutNotification, and TryCatch nodes.

A message is propagated to a catch terminal only if it has first been propagated
beyond the node (for example, to the nodes connected to the out terminal).

When a message is propagated to the failure or catch terminal, the node creates
and populates a new ExceptionList with an exception that represents the error
that has occurred. The ExceptionList is propagated as part of the message tree.

The MQInput and TimeoutNotification nodes have additional processing for
transactional messages (other input nodes do not handle transactional messages).

For more information, see [“Handling MQInput errors” on page 198/ and
[“Handling TimeoutNotification errors” on page 202

If you include a Trace node that specifies $Root or $Body, the complete message
is parsed. This might generate parser errors that are not otherwise detected.

The general principles of error handling are:

If you connect the catch terminal of the input node, you are indicating that the
flow handles all of the exceptions that are generated anywhere in the out flow.
The broker performs no rollback and takes no action unless there is an exception
on the catch flow. If you want any rollback action after an exception has been
raised and caught, you must provide this in the catch flow.

If you do not connect the catch terminal of the MQInput or the HTTPInput
node, you can connect the failure terminal and provide a fail flow to handle
exceptions generated by the node. The fail flow is started immediately when an
exception occurs in the node.

The fail flow is also started if an exception is generated beyond the MQInput
node (in either out or catch flows), the message is transactional, and the
reinstatement of the message on the input queue causes the backout count to
reach the backout threshold.

The HTTPInput and SCADAInput nodes do not propagate the message to the
failure terminal if an exception is generated beyond the node and you have not
connected the catch terminal.

If a node propagates a message to a catch flow, and another exception occurs
that returns control to the same node again, the node handles the message as
though the catch terminal is not connected.

If you do not connect either the failure or catch terminals of the input node, the
broker provides default processing (which varies with the type of input node).
If you need a more comprehensive error and recovery approach, include one or
more TryCatch nodes to provide more localized areas of error handling.

If you have a common procedure for handling particular errors, you might find
it appropriate to create a subflow that includes the sequence of nodes required.
Include this subflow wherever you need that action to be taken.
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For more information, see [‘Connecting failure terminals,”|[“Managing errors in the|
input node” on page 197 | and [“Catching exceptions in a TryCatch node” on page]
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If your message flows include database updates, the way in which you configure
the nodes that interact with those databases can also affect the way that errors are
handled:

* You can specify whether updates are committed or rolled back. You can set the
node property Transaction to specify whether database updates are committed
or rolled back with the message flow (option Automatic), or are committed or
rolled back when the node itself terminates (option Commit). You must ensure
that the combination of these property settings and the message flow error
processing give the correct result.

* You can specify how database errors are handled. You can set the properties
Treat warnings as errors and Throw exception on database error to change the
default behavior of database error handling.

For more information about coordinated database updates, see
[zlobally coordinated message flows” on page 166

Message flows for aggregation involve additional considerations that are not
discussed in this topic. For information about message flows for aggregation, see
[‘Handling exceptions in aggregation flows” on page 539

The following sample demonstrates how to use an error handling routine to trap
information about errors and to store that information in a database. The error
handling routine is a subflow that you can add, unchanged, to any message flow.
The sample also demonstrates how to configure message flows to control
transactionality; in particular, the use of globally coordinated transactions to ensure
overall data integrity.

* [Error Handler sample|

You can view samples only when you use the information center that is integrated
with the Message Broker Toolkit.

Connecting failure terminals

When a node that has a failure terminal detects an internal error, it propagates the
message to that terminal. If it does not have a failure terminal, or if you have not
connected the failure terminal, the broker generates an exception.

The nodes sometimes generate errors that you can predict, and it is in these cases
that you might want to consider connecting the failure terminal to a sequence of
nodes that can take sensible actions in response to the expected errors.

Examples of expected errors are:
* Temporary errors when the input node retrieves the message.
* Validation errors detected by an MQInput, Compute, or Mapping node.

* Messages with an internal or format error that cannot be recognized or
processed by the input node.

* Acceptable errors when a node accesses a database, and you choose not to
configure the node to handle those errors.

* ESQL errors during message flow development (some ESQL errors cannot be
detected by the editor, but are recognized only by the broker; these cause an
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exception if you have not connected the failure terminal. You can remove the fail
flow when you have completely tested the runtime ESQL code).

You can also connect the failure terminal if you do not want WebSphere MQ to
retry a message or put it to a backout or dead letter queue.

Managing errors in the input node

When you design your message flow, consider which terminals on the input node
to connect:

¢ If the node detects an error, it always propagates the message to the failure
terminal if the node has one and if you have connected a fail flow.

 If you connect the catch terminal (if the node has one), this indicates that you
want to handle all exceptions that are generated in the out flow. This handles
errors that can be expected in the out flow. The broker does not take any action
unless there is an exception on the catch flow and the message is transactional.
Connect the failure terminal to handle this case if you choose.

* If you do not connect the catch terminal, or the node does not have a catch
terminal, the broker provides default processing. This depends on the node and
whether the message is transactional. Processing for non-transactional messages
is described in this topic. Refer to [“Handling MQInput errors” on page 198 |and
[‘Handling TimeoutNotification errors” on page 202| for details of how these
nodes handle transactional messages (other input nodes do not support
transactional messages).

All input nodes process non-transactional, non-persistent messages. The built-in
input nodes handle failures and exceptions associated with these messages in this
way:

¢ If the node detects an internal error:

— If you have not connected the failure terminal, the node logs the error in the
local error log and discards the message.

The Real-timelnput and Real-timeOptimizedFlow nodes retry once before
they discard the message; that is, they retrieve the message again and attempt
to process it.

— If you have connected the failure terminal, you are responsible for handling
the error in the fail flow. The broker creates a new ExceptionList to represent
the error and this is propagated to the failure terminal as part of the message
tree, but neither the node nor the broker provide any further failure
processing.

* If the node has successfully propagated the message to the out terminal and a
later exception results in the message being returned to the input node:

— If you have not connected the catch terminal or the node does not have a
catch terminal, the node logs the error in the local error log and discards the
message.

— If you have connected the catch terminal, you are responsible for handling the
error in the catch flow. The broker creates a new ExceptionList to represent
the error and this is propagated to the catch terminal as part of the message
tree, but neither the node nor the broker provide any further exception
processing.

¢ If the node has already propagated the message to the catch terminal and an
exception is thrown in the catch flow:
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— If you have not connected the failure terminal, or the input node does not
have a failure terminal, the node logs the error in the local error log and
discards the message.

— If you have connected the failure terminal, you are responsible for handling
the error in the fail flow. The broker creates a new ExceptionList to represent
the error and this is propagated to the failure terminal as part of the message
tree, but neither the node nor the broker provide any further failure

processing.

The HTTPInput and SCADAInput nodes do not propagate the message to the
failure terminal if an exception is generated in the catch flow. The node logs
the error in the local error log and discards the message.
¢ If the node has propagated the message to the failure terminal and an exception
is thrown in the fail flow, the node logs the error in the local error log and
discards the message.

In every situation in which it discards the message, the HTTPInput node waits
until the time specified by the node property Maximum client wait time expires, and
returns an error to the Web services client.

This action is summarized in the table below:

Error event

Failure terminal
connected

Failure terminal
not connected

Catch terminal
connected

Catch terminal
not connected

Node detects
internal error

Fail flow
handles the error

Node logs the
error and
discards the
message

Not applicable

Not applicable

Node propagates
message to out
terminal,
exception occurs
in out flow

Not applicable

Not applicable

Catch flow
handles the error

Node logs the
error and
discards the
message

Node propagates
message to catch
terminal,
exception occurs
in catch flow

Fail flow
handles the error
(not HTTPInput
or SCADAInput)

Node logs the
error and
discards the
message

Not applicable

Not applicable

Node propagates
message to
failure terminal,
exception occurs
in fail flow

Not applicable

Not applicable

Node logs the
error and
discards the
message

Node logs the
error and
discards the
message

Handling MQInput errors:

The MQInput node takes the following actions when it handles errors with
persistent and transactional messages. Errors encountered with non-transactional
messaies are handled as described in [‘Managing errors in the input node” on|
page 197.

* The MQInput node detects an internal error in the following situations:

— A message validation error occurs when the associated message parser is

initialized.

— A warning is received on an MQGET.




— The backout threshold is reached when the message is rolled back to the
input queue.
* If the MQInput node detects an internal error, one of the following actions occur:

— If you have not connected the Failure terminal, the MQInput node attempts to
put the message to the input queue’s backout requeue queue, or (if that is not
defined) to the dead letter queue of the broker’s queue manager. If the put
attempt fails, the message is rolled back to the input queue. The MQInput
node writes the original error and the MQPUT error to the local error log.
The MQInput node now invokes the retry logic, described in
[processing” on page 200

— If you have connected the Failure terminal, you are responsible for handling
the error in the flow connected to the Failure terminal. The broker creates a
new ExceptionList to represent the error and this is propagated to the Failure
terminal as part of the message tree, but neither the MQInput node nor the
broker provide any further failure processing.

¢ If the MQInput node has successfully propagated the message to the out
terminal and an exception is thrown in the out flow, the message is returned to
the MQInput node:

— If you have not connected the Catch terminal, the message is rolled back to
the input queue. The MQInput node writes the error to the local error log and
invokes the retry logic, described in [‘Retry processing” on page 200

— If you have connected the Catch terminal, you are responsible for handling
the error in the flow connected to the Catch terminal. The broker creates a
new ExceptionList to represent the error and this is propagated to the Catch
terminal as part of the message tree, but neither the MQInput node nor the
broker provide any further failure processing.

* If the MQInput node has already propagated the message to the Catch terminal
and an exception is thrown in the flow connected to the Catch terminal, the
message is returned to the MQInput node:

— The MQInput node writes the error to the local error log.
— The message is rolled back to the input queue.

* If the MQInput node has already propagated the message to the Failure terminal
and an exception is thrown in the flow connected to the Failure terminal, the
message is returned to the MQInput node and rolled back to the input queue.
The MQInput node writes the error to the local error log and invokes the retry
logic, described in [“Retry processing” on page 200 The message is not
propagated to the Catch terminal, even if that is connected.

This action is summarized in the table below:

Error event

Failure terminal
connected

Failure terminal
not connected

Catch terminal
connected

Catch terminal
not connected

Node detects
internal error

Flow connected
to the Failure
terminal handles
the error

Message put to
alternative
queue; node
retries if the put
fails

Not applicable

Not applicable

Node propagates
message to out
terminal,
exception occurs
in out flow

Not applicable

Not applicable

Flow connected
to the Catch
terminal handles
the error

Node retries
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Error event

Failure terminal
connected

Failure terminal
not connected

Catch terminal
connected

Catch terminal
not connected

Node propagates
message to
Catch terminal,
exception occurs
in flow
connected to the
Catch terminal

Error logged,
message rolled
back

Error logged,
message rolled
back

Not applicable

Not applicable

Node propagates
message to
Failure terminal,
exception occurs
in flow
connected to the
Failure terminal

Not applicable

Not applicable

Node retries

Node retries

Retry processing:

The node attempts retry processing when a message is rolled back to the input
queue. It checks whether the message has been backed out before, and if it has,
whether the backout count has reached (equalled) the backout threshold. The
backout count for each message is maintained by WebSphere MQ in the MQMD.

You specify (or allow to default to 0) the backout threshold attribute BOTHRESH
when you create the queue. If you accept the default value of 0, the node increases
this to 1. The node also sets the value to 1 if it cannot detect the current value.
This means that if a message has not been backed out before, it is backed out and
retried at least once.

1. If the node has propagated a message to the out terminal many times following
repeated failed attempts in the out flow, and the number of retries has reached
the backout threshold limit, it attempts to propagate the message through the
Failure terminal if that is connected. If you have not connected the Failure
terminal, the node attempts to put the message to another queue.

If a failure occurs beyond the Failure terminal, further retries are made until
the backout count field in the MQMD reaches twice the backout threshold set
for the input queue. When this limit is reached, the node attempts to put the
message to another queue.

2. If the backout threshold has not been reached, the node gets the message from
the queue again. If this fails, this is handled as an internal error (described
above). If it succeeds, the node propagates the message to the out flow.

3. If the backout threshold has been reached:

* If you have connected the Failure terminal, node propagates the message to
that terminal. You must handle the error on the flow connected to the Failure

terminal.

* If you have not connected the Failure terminal, the node attempts to put the
message on an available queue, in order of preference:

a. The message is put on the input queue’s backout requeue name (queue
attribute BOQNAME), if one is defined.

b. If the backout queue is not defined, or it cannot be identified by the
node, the message is put on the dead letter queue (DLQ), if one is
defined. (If the broker’s queue manager has been defined by the



mgsicreatebroker command, a DLQ with a default name of
SYSTEM.DEAD.LETTER.QUEUE has been defined and is enabled for this
queue manager.)

c. If the message cannot be put on either of these queues because there is an
MQPUT error (including queue does not exist), or because they cannot be
identified by the node, it cannot be handled safely without risk of loss.

The message cannot be discarded, therefore the message flow continues
to attempt to backout the message. It records the error situation by
writing errors to the local error log. A second indication of this error is
the continual incrementing of the BackoutCount of the message in the
input queue.

If this situation has occurred because neither queue exists, you can define
one of the backout queues mentioned above. If the condition preventing
the message from being processed has cleared, you can temporarily
increase the value of the BOTHRESH attribute. This forces the message
through normal processing.

4. If twice the backout threshold has been reached or exceeded, the node attempts
to put the message on an available queue, in order of preference, as defined in
the previous step.

Handling message group errors:

WebSphere MQ supports message groups. You can specify that a message belongs
to a group and its processing is then completed with reference to the other
messages in the group (that is, either all messages are committed or all messages
are rolled back). When you send grouped messages to a broker, this condition is
upheld if you have configured the message flow correctly, and errors do not occur
during group message processing.

To configure the message flow to handle grouped messages correctly, follow the
actions described in the [“MQInput node” on page 940 However, correct processing
of the message group cannot be guaranteed if an error occurs while one of the
messages is being processed.

If you have configured the MQInput node as described, under normal
circumstances all messages in the group are processed in a single unit of work
which is committed when the last message in the group has been successfully
processed. However, if an error occurs before the last message in the group is
processed, the unit of work that includes the messages up to and including the
message that generates the error is subject to the error handling defined by the
rules documented here, which might result in the unit of work being backed out.

However, any of the remaining messages within the group might be successfully
read and processed by the message flow, and therefore are handled and committed
in a new unit of work. A commit is issued when the last message is encountered
and processed. Therefore if an error occurs within a group, but not on the first or
last message, it is possible that part of the group is backed out and another part
committed.

If your message processing requirements demand that this situation is handled in a
particular way, you must provide additional error handling to handle errors within
message groups. For example, you could record the failure of the message group
within a database, and include a check on the database when you retrieve each
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message, forcing a rollback if the current group has already encountered an error.
This would ensure that the whole group of messages is backed out and not
processed unless all are successful.

Handling TimeoutNotification errors: The TimeoutNotification node takes the
following actions when it handles errors with transactional messages. Errors
encountered with non-transactional messages are handled as described in

["Managing errors in the input node” on page 197/

* If the TimeoutNotification node detects an internal error, one of the following

actions occur:
— If you have not connected the Failure terminal the following happens:
1. The TimeoutNotification node writes the error to the local error log.

2. The TimeoutNotification node repeatedly tries to process the request until
the problem has been resolved.

— If you have connected the Failure terminal, you are responsible for handling
the error in the flow connected to the Failure terminal. The broker creates a
new ExceptionList to represent the error and this is propagated to the Failure
terminal as part of the message tree, but neither the TimeoutNotification node
nor the broker provide any further failure processing. The message is written
to the Failure terminal as part of the same transaction, and if the failure flow
handles the error successfully the transaction is committed.

If the TimeoutNotification node has successfully propagated the message to the
Out terminal and an exception is thrown in the flow connected to the Out
terminal, the message is returned to the TimeoutNotification node. The
TimeoutNotification node writes the error to the local error log and does one of
the following:

— If you have not connected the Catch terminal, the TimeoutNotification node
tries to process the message again until the problem is resolved.

— If you have connected the Catch terminal, you are responsible for handling
the error in the flow connected to the Catch terminal. The broker creates a
new ExceptionList to represent the error and this is propagated to the Catch
terminal as part of the message tree, but neither the TimeoutNotification node
nor the broker provide any further failure processing. The message is written
to the Catch terminal as part of the same transaction, and if the flow
connected to the Catch terminal handles the error successfully the transaction
is committed.

If the TimeoutNotification node has already propagated the message to the
Catch terminal and an exception is thrown in the flow connected to the Catch
terminal, the message is returned to the TimeoutNotification node. The
TimeoutNotification node writes the error to the local error log and tries to
process the message again.

If the TimeoutNotification node has already propagated the message to the
Failure terminal and an exception is thrown in the flow connected to the Failure
terminal, the message is returned to the TimeoutNotification node. The
TimeoutNotification node writes the error to the local error log and tries to
process the message again. The message is not propagated to the Catch terminal,
even if that is connected.



This action is summarized in the table below:

Error event

Failure terminal
connected

Failure terminal
not connected

Catch terminal
connected

Catch terminal
not connected

Node detects
internal error

Flow connected
to the Failure
terminal handles
the error

Error logged,
node retries

Not applicable

Not applicable

Node propagates
message to out
terminal,
exception occurs
in out flow

Not applicable

Not applicable

Flow connected
to the Catch
terminal handles
the error

Error logged,
node retries

Node propagates
message to
Catch terminal,
exception occurs
in flow
connected to the
Catch terminal

Error logged,
node retries

Error logged,
node retries

Not applicable

Not applicable

Node propagates
message to
Failure terminal,
exception occurs
in flow
connected to the
Failure terminal

Not applicable

Not applicable

Error logged,
node retries

Error logged,
node retries

Catching exceptions in a TryCatch node

You can design a message flow to catch exceptions before they are returned to the
input node. Within a single flow, you can include one or more TryCatch nodes to
provide a single point of failure for a sequence of nodes. With this technique, you
can provide very specific error processing and recovery.

A TryCatch node does not process a message in any way;, it represents only a
decision point in a message flow. When the TryCatch node receives a message, it
propagates it to the try terminal. The broker passes control to the sequence of
nodes connected to that terminal (the try flow).

If an exception is thrown in the try flow, the broker returns control to the TryCatch
node. The node writes the current contents of the ExceptionList to the local error
log, then writes the information for the current exception to ExceptionList,
overwriting the information stored there.

The node now propagates the message to the sequence of nodes connected to the
catch terminal (the catch flow). The content of the message tree that is propagated
is identical to the content that was propagated to the try terminal, which is the
content of the tree when the TryCatch node first received it. It enhances this tree
with the new exception information which it has written to ExceptionList. Any
modifications or additions the nodes in try flow made to the message tree are not
present in the message tree that is propagated to the catch flow.

However, if the try flow has completed processing that involves updates to
external databases, these are not lost. The updates persist while the message is
processed by the catch flow, and the decision about whether the updates are
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committed or rolled back is made on the configuration of your message flow and
the individual nodes that interact with the databases. If the updates are committed
because of the configuration you have set, you must include logic in your catch
flow that rolls back the changes that were made.

To review the options for configuration, see [“Configuring globally coordinated]
[message flows” on page 166

The broker returns control to the next catch point in the message flow (which
might be another TryCatch node, but is always, in the last case, the input node) if
one of the following conditions is true:

* An exception is thrown in the catch flow of the TryCatch node (for example, if
you include a Throw node, or code an ESQL THROW statement, or if the broker
generates the exception).

* You do not connect the catch terminal of the TryCatch node.

The following example shows how you can configure the flow to catch exceptions
in the input node. The MQInput node’s catch terminal is connected to a Trace node
to record the error.

ID=—leb—D

MQInpuk Compute MQOutpLE

o I =

Trace

In the following example, the message flow has two separate processing flows
connected to the Filter node’s true and false terminals. Here a TryCatch node is
included on each of the two routes that the message can take. The catch terminal
of both TryCatch terminals is connected to a common error processing subflow.
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If the input node in your message flow does not have a catch terminal (for
example, Real-timelnput), and you want to process errors in the flow, you must
include a TryCatch node. The following example shows how you could connect a
flow to provide this error processing. In this example, you could configure the
ESQL in the Compute node on the catch flow to examine the exception that has
been caught and set the output queue name dynamically.
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Managing message flows

How you can use tasks to manage message flows.

* [“Creating a message flow project”]

* [“Deleting a message flow project” on page 207

+ [“Creating a broker schema” on page 208|

+ |“Creating a message flow” on page 208|

* |“Opening an existing message flow” on page 210

+ [“Copying a message flow using copy” on page 210

+ [“Renaming a message flow” on page 211|

* [“Moving a message flow” on page 212]

* [“Deleting a message flow” on page 213|

+ [“Viewing version and keyword information for deployable objects” on page 214|

* [“Saving a message flow” on page 215|

To learn more about message flows look at the following sample:

+ |Airline Reservations sample]

In the previous sample you can explore message flow resources, and learn how to
create, delete, or rename the resources. You can view samples only when you use
the information center that is integrated with the Message Broker Toolkit.

For a basic introduction to developing message flows, see the IBM Redbooks
publication [WebSphere Message Broker Basics|

Creating a message flow project

Before you start:

Read the concept topic about [message flow projects|

A message flow project is a container for message flows; you must create a project
before you can create a message flow.

The project and its resources are stored in a file system or in a shared repository. If
you are using a file system, this can be the local file system or a shared drive. If
you store files in a repository, you can use any of the available repositories that are
supported by Eclipse, for example CVS.

To create a message flow project and other resource files that you need to start
developing applications, you can use a Quick Start wizard.

To create only a message flow project, perform the following actions:
1. Switch to the Broker Application Development perspective.
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206 Message Flows

2. Click File » New » Message Flow Project or right-click any resource in the
Broker Development view and click New » Message Flow Project.

You can also press Ctrl+N. This displays a dialog that allows you to select the
wizard to create a new object. Click Message Brokers in the left view; the right
view displays a list of objects that you can create for WebSphere Message
Broker. Click Message Flow Project in the right view, then click Next. The New
Message Flow Project wizard displays.

3. Enter a name for the project. Choose a project name that reflects the message
flows that it contains. For example, if you want to use this project for financial
processing message flows, you might give it the name Finance_Flows.

4. Leave the Use default check box checked (it is checked when the dialog opens)
This applies if you want to use the default location for the new message project
directory, that is, in the \workspace subdirectory of your current installation.
You cannot edit the Directory entry field.

a. Alternatively, clear the Use default check box and specify a location for the
new message flow project files in the Directory entry field. This applies if
you do not want to use the default location.

b. Use the Browse button to find the desired location or type the location in.

5. Click Next if you want to specify that this message flow project depends on
other message flow projects, or on message set projects, You are presented with
a list of current projects. Select one or more message flow projects, or one or
more message set projects, or both, from the list to indicate this new message
flow project’s dependencies.

This message flow project depends on another message flow project if you
intend to use common resources within it. Common resources that you can
share between message flow projects are:

a. ESQL subroutines (defined in broker schemas)

b. Mappings
C. Message sets
d. Subflows

For example, you might want to reuse a subflow that provides standard error
processing such as writing the message to a database, or recording a trace
entry.

This message flow project depends on a message set project if you intend to
refer to the message it defines within ESQL within the message flow nodes.

You can add dependencies after you have created the message flow project by
right-clicking the project in the Broker Development view and clicking
Properties. Click References and select the dependent message flow or
message set project from the list of projects displayed.

6. Click Finish to complete the task.

The project file is created within a directory that has the same name as your
message flow project in the specified location. All other files that you create (or
cause to be created) related to this message flow project are created in this same
directory.

A default broker schema (default) is also created within the project. You can
create and use different schemas within a single project to organize message flow
resources, and to provide the scope of resource names to ensure uniqueness.

Next: [create a message flow]|




Deleting a message flow project

A message flow project is the container in which you create and maintain all the
resources associated with one or more message flows. These resources are created
as files, and are displayed within the project in the Broker Development view. If
you do not want to retain a message flow project, you can delete it.

Before you start:

* [Create a message flow project]

* Read the concept topic about [message flow projects|

Deleting a message flow project in the workbench deletes the project and its
resources; the Configuration Manager does not hold a copy. If you are using a
shared repository, the repository might retain a copy of a deleted resource.

In previous releases you could remove resources from the Control Center, which
removed the reference in your workspace, but retained the resource in the
Configuration Manager repository.

To delete a message flow project:
1. Switch to the Broker Application Development perspective.

2. Highlight the message flow project that you want to delete and click Edit ~»
Delete You can also press Del, or right-click the project in the Broker
Development view and click Delete

3. You must choose if you want the contents of the message flow project folder
deleted with this action on the displayed confirmation dialog. The dialog
contains two buttons:

a. The first confirms that all contents are to be deleted.

b. The second requests that the directory contents are not deleted. The default
action is not to delete the contents, and the second button is selected by
default when the dialog is initially displayed.

a. Select the appropriate button. If you choose not to delete the contents of the
message flow project directory, all the files and the directory itself are
retained.

If you later create another project with the same name, and specify the same
location for the project (or accept this as the default value), you can access
the files previously created.

If you choose to delete all the contents, all files and the directory itself are
deleted.

4. Click Yes to complete the delete request, or No to terminate the delete request.
When you click Yes, the requested objects are deleted.

If you maintain resources in a shared repository, a copy is retained in that
repository. You can follow the instructions provided by the repository supplier to
retrieve the resource if required.

If you are using the local drive or a shared drive to store your resources, no copy

of the resource is retained. Be very careful to select the correct resource when you
complete this task.
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Creating a broker schema

If you want to organize your message flow project resources, and to define the
scope of resource names to ensure uniqueness, you can create broker schemas. A
default schema is created when you create the message flow project, but you can
create additional schemas if you choose.

Before you start:

* [Create a message flow project]

* Read the concept topic about

To create a broker schema:

1. Switch to the Broker Application Development perspective.

2. Click File » New » BrokerSchema or right-click any resource in the Broker
Development view and click New » BrokerSchema.

You can also press Ctrl+N. This displays a dialog that allows you to select the
wizard to create a new object. Click Message Brokers in the left view. The right
view displays a list of objects that you can create for WebSphere Message
Broker. Click Broker Schema in the right view, then click Next. The New Broker
Schema wizard displays.

3. Enter the message flow project in which you want the new schema to be
created. If you have a message flow project or one of its resources highlighted
when you invoke the wizard, that project name appears in the dialog. If a name
does not appear in this field, or if you want to create the schema in another
project, click Browse and select the correct project from the displayed list.

You can type the project name in, but you must enter a valid name. The dialog
displays a red cross and the error message The specified project does not
exist if your entry is not a valid project. You must specify a message flow
project; if you select a message set project, the Finish button remains disabled.

4. Enter a name for the schema. Choose a name that reflects the resources that it
contains. For example, if you want to use this schema for message flows for
retail applications, you might give it the name Retail.

A broker schema name must be a character string that starts with a Unicode
character followed by zero or more Unicode characters or digits, and the
underscore. You can use the period to provide a structure to the name, for
example Stock.Common.

5. Click Finish to complete the task.

The schema directory is created in the project directory. If the schema is structured
using periods, further subdirectories are defined. For example, the broker schema
Stock.Common results in a directory Common within a directory Stock within the
message flow project directory.

Creating a message flow

208 Message Flows

Create a message flow to specify how to process messages in the broker. You can
create any number of message flows and deploy them to one or more brokers.

Before you start:
* [Create a message flow project

* Read the concept topic about proker schemas|




The message flow and its resources are stored in a file system or in a shared
repository. If you are using a file system, this can be the local drive or a shared
drive. If you store files in a repository, you can use any of the available repositories
that are supported by Eclipse, for example CVS.

Use this process to create a complete message flow that you can deploy, or a
subflow that provides a subset of function (for example, a reusable error
processing routine) that you cannot deploy on its own.

To create a message flow and other resource files that you need to start developing
applications, you can use a Quick Start wizard.

To create only a message flow, perform the following actions:

1.
2.

Switch to the Broker Application Development perspective.

Check to see whether you have already created the message flow project in
which you want to create the message flow. If the message flow project does
not already exist, you can either create it now (before following the steps in this
topic to create the message flow) or you can create the message flow project as
an optional step in creating the message flow (see step 4). The project can be
empty, or can have message flows defined in it.

Click File » New > Message Flow or right-click any resource in the Broker
Development view and click New » Message Flow.

You can also press Ctrl+N. This displays a dialog that allows you to select the
wizard to create a new object. Click Message Brokers in the left view. The right
view displays a list of objects that you can create for WebSphere Message
Broker. Click Message Flow in the right view, then click Next. The New
Message Flow wizard displays.

Identify the project in which you want to define the message flow. If you have
a resource selected in the Broker Development view, the name of the
corresponding project is displayed in the Message Flow Project field.

If you do not have a resource selected, the first field is blank. If the message
flow project for this message flow has already been created, you can either type
the name of the project into the field or click the down-arrow and select the
appropriate project from the list displayed.

If the message flow project has not yet been created, select New. The New
Message Flow Project wizard starts, and you can use it to create the message
flow project for your new message flow. When you have finished creating the
new message flow project, the New Message Flow Project wizard closes, and
the name of your new message flow project is displayed in the Message Flow
Project field of the New Message Flow window.

If your entry is not a valid project name, the window displays a red cross and
the error message The specified project does not exist .

In the Message flow Name field, enter the name of the new message flow. You
can use any valid character for the name, but it is helpful to choose a name
that reflects its function, for example OrderProcessing.

If you want the message flow to be created in the default broker schema,
ensure that Use default in the Flow organization section has been selected.
When you create a message flow project, a default schema is created within it,
and this default value is assumed unless you deselect it.

If you want to use a different broker schema, deselect Use default. You can
now either enter the name of the broker schema into the Schema field, or use
the Browse button to view and select from any of the broker schemas in the
message flow project.
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You can create and use different schemas within a single project to organize
message flow resources, and to provide the scope of resource names to ensure
uniqueness.

7. Click Finish.

The new message flow (<message_flow_name>.msgflow) is displayed within its
project in the Broker Development view. The editor view is empty and ready to
receive your input.

Next: [save the message flow] or [define message flow content]

Opening an existing message flow

Open an existing message flow to change or update its contents, or to add or
remove nodes.

Before you start

To complete this task, you must have completed the following tasks:
+ |“Creating a message flow” on page 208

To open an existing message flow:

1. Switch to the Broker Application Development perspective. The Broker
Development view is populated with all the message flow and message set
projects that you have access to. A message flow is contained in a file called
<message_flow_name>.msgflow.

2. Right-click the message flow that you want to work with, and click Open.
Alternatively you can double-click the message flow in the Broker
Development view.

The graphical view of the message flow is displayed in the editor view. You
can now work with this message flow, for example, adding or removing nodes,
changing connections, or modifying properties.

3. Click Open ESQL for any node in the flow that requires ESQL, or you can
double-click the ESQL file (the .esql file) in the Broker Development view to
open it, if you want to work with the ESQL file for this message flow.

4. Click Open Mappings for any node in the flow that requires mappings, or you
can double-click the mappings file (the .mfmap file) in the Broker Development
view to open it, if you want to work with the mappings file for this message
flow.

Copying a message flow using copy

210 Message Flows

You might find it useful to copy a message flow as a starting point for a new
message flow that has similar function. For example, you might want to replace or
remove one or two nodes to process messages in a different way.

Before you start

To complete this task, you must have completed the following task:

* [“Creating a message flow” on page 208

To copy a message flow:

1. Switch to the Broker Application Development perspective.



2. Select the message flow (<message_flow_name>.msgflow) that you want to
copy in the Broker Development view.

a. Right-click the file and click Copy from the menu.

3. Right-click the broker schema within the message flow project to which you
want to copy the message flow and click Paste. You can copy the message flow
within the same broker schema within the same message flow, or to a different
broker schema within the same message flow project, or to a broker schema in
a different message flow project.

When you copy a message flow, the associated files (ESQL and mapping, if
present) are not automatically copied to the same target message flow project. If
you want these files copied as well, you must do this explicitly following this
procedure.

You might also need to update nodes that have associated ESQL or mappings,
to ensure that modules are unique.

For example, if you have created a message flow (Testl for example) that
contains a single Compute node, and you copy message flow Testl and its
associated .esql file to the same broker schema within the same message flow
project (and give the new copy a different name, for example Test2), there are
now two modules named Testl_Compute within the single schema. One is
within Testl.esql, the second within Test2.esql.

This is not supported, and an error message is written to the Tasks view when
you have completed the copy action. You must rename the associated ESQL
modules within the .esql file and update the matching node properties to
ensure that every module within a broker schema is unique.

The message flow is copied with all property settings intact. If you intend to use
this copy of the message flow for another purpose, for example to retrieve
messages from a different input queue, you might have to modify its properties.

You can also use File » Save As to copy a message flow. This is described in
[‘Saving a message flow” on page 215

Renaming a message flow

You can rename a message flow. You might want to do this if you have modified
the message flow to provide a different function and you want the name of the
message flow to reflect this new function.

Before you start

To complete this task, you must have completed the following task:

* [“Creating a message flow” on page 208|

To rename a message flow:
1. Switch to the Broker Application Development perspective.

2. Right-click the message flow that you want to rename
(<message_flow_name>.msgflow) in the Broker Development view, and click
Rename, or click File » Rename. If you have the message flow selected, you
can also press F2. The Rename Resource dialog is displayed.

3. Type in the new name for the message flow.

4. Click OK to complete this action, or Cancel to cancel the request. If you click
OK, the message flow is renamed.
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After you have renamed the message flow, any references that you have to this
message flow (for example, if it is embedded in another message flow) are no
longer valid.

You must open the affected message flows and correct the references if you are
not sure where you have embedded this message flow.

a. Click File » Save All The save action saves and validates all resources.
Unresolved references are displayed in the Tasks view, and you can click
each error listed.

This opens the message flow that makes a non-valid reference in the editor
view

b. Right click the subflow icon and click Locate Subflow. The Locate Subflow
dialog is displayed, listing the available message flow projects.

c. Expand the list and explore the resources available to locate the required
subflow.

d. Select the correct subflow and click OK. All references in the current
message flow are updated for you and the errors removed from the Tasks
view.

Moving a message flow

212 Message Flows

You can move a message flow from one broker schema to another within the same
project or to a broker schema in another project. You might want to do this, for
example, if you are reorganizing the resources in your projects.

Before you start

To complete this task, you must have completed the following task:

+ [“Creating a message flow” on page 208

To move a message flow:

1.
2.

Switch to the Broker Application Development perspective.

Drag and drop the message flow that you want to move from its current
location to a broker schema within the same or another message flow project. If
the target location that you have chosen is not valid, a black no-entry icon
appears over the target, an error dialog is displayed, and the message flow is
not moved.

You can move a message flow to another schema in the same project or to a
schema in another message flow project.

If you prefer, you can:

a. Right-click the message flow that you want to move
(<message_flow_name>.msgflow) in the Broker Development view and click
Move, or File > Move The Move dialog is displayed. This contains a list of
all valid projects to which you can move this message flow.

b. Select the project and the broker schema within the project to which you
want to move the message flow. You can move a message flow to another
schema in the same project or to a schema in another message flow project.

c. Click OK to complete the move, or Cancel to cancel the move. If you click
OK, the message flow is moved to its new location.

Check the Tasks view for any errors (indicated by the error icon L ) or

warnings (indicated by the warning icon £ ) generated by the move. The
errors in the Tasks view include those caused by broker references. When the



move is done, all references to this message flow (for example, if this is a
reusable error message flow that you have embedded in another message flow)
are checked.

If you have moved the message flow within the same broker schema (in the
same or another project), all references are still valid.

However, if you move the message flow from one broker schema to another (in
the same or a different project), the references are broken.

This is because the resources are linked by a fully-qualified name of which the
broker schema is a part. Information about any broken references is written to
the Tasks view, for example, Linked or nested flow mflowl cannot be
Tocated.

5. Double-click each error or warning to correct it. This opens the message flow
that has the error in the editor view and highlights the node in error.

When you move a message flow, the associated files (for example, any ESQL or
mapping files) are not automatically moved to the target broker schema. If you
want these files moved as well, you must do this explicitly following this
procedure.

Deleting a message flow

You can delete a message flow that you have created in a message flow project if
you no longer need it.

Deleting a message flow in the workbench deletes the project and its resources,
and the Configuration Manager does not hold a copy. If you are using a shared
repository, the repository might retain a copy of a deleted resource.

In previous releases you could remove resources from the Control Center, which
removed the reference in your workspace, but retained the resource in the
Configuration Manager repository.

Before you start

To complete this task, you must have completed the following task:

+ [“Creating a message flow” on page 208|

To delete a message flow:

1. Switch to the Broker Application Development perspective.

2. Select the message flow in the Broker Development view
(<message_flow_name>.msgflow) and press the Delete key. A confirmation
dialog is displayed.

You can also right-click the message flow in the Broker Development view and
click Delete, or click Edit » Delete. The same dialog is displayed.

3. Click Yes to delete the message flow definition file or No to cancel the delete
request. When you click Yes, the requested objects are deleted.

If you maintain resources in a shared repository, a copy is retained in that
repository. You can follow the instructions provided by the repository supplier
to retrieve the resource if required.

If you are using the local file system or a shared file system to store your
resources, no copy of the resource is retained. Be very careful to select the
correct resource when you complete this task.
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4.

Check the Tasks view for any errors that are caused by the deletion. Errors are
generated if you delete a message flow that is embedded within another flow
because the reference is no longer valid.

a. Click the error in the Tasks view This opens the message flow that now has
a non-valid reference.

b. Either remove the node that represents the deleted message flow from the
parent message flow, or create a new message flow with the same name to
provide whatever processing is required.

When you delete the message flow, the files that are associated with the message
flow (the ESQL and mapping files, if present) are not deleted by this action. If you
want to delete these files also, you must do so explicitly.

Deleting a broker schema

You can delete a broker schema that you have created in a message flow project if
you no longer need it.

Before you start:

* |Create a broker schema|

Read the concept topic about

To delete a broker schema:

1.
2.

Switch to the Broker Application Development perspective.

Select the broker schema in the Broker Development view and press the Delete
key. A confirmation dialog box is displayed.

You can also right-click the broker schema in the Broker Development view and
click Delete, or click Edit » Delete. The same dialog box is displayed.

If the broker schema contains resources, the Delete menu option is disabled,
and the Delete key has no effect. You must delete all resources within the
schema before you can delete the schema.

Click Yes to delete the broker schema directory or No to cancel the delete
request. When you click Yes, the requested objects are deleted.

If you maintain resources in a shared repository, a copy is retained in that
repository. You can follow the instructions provided by the repository supplier
to retrieve the resource, if required.

If you are using the local file system or a shared file system to store your
resources, no copy of the resource is retained. Be very careful to select the
correct resource when you complete this task.

Viewing version and keyword information for deployable
objects

This topic contains information about how to view the version and keyword
information of deployable objects.

214 Message Flows

» |“Displaying object version in the bar file editor” on page 215|

“Displaying version, deploy time, and keywords of deployed objects” on page|

215

This topic also contains information on populating the Comment and Path
columns; see [“Populating the Comment and Path columns” on page 215/




Displaying object version in the bar file editor

A column in the bar editor called Version displays the version tag for all objects
that have a defined version. These are:

e .dictionary files
» .cmf files
* Embedded JAR files with a version defined in a META-INF/keywords.txt file

You cannot edit the Version column.

You can use the command to list the keywords that are defined for
each deployable file within a deployable archive file.

Displaying version, deploy time, and keywords of deployed
objects

The Eclipse Properties View displays, for any deployed object:
¢ Version

* Deploy Time

 All defined keywords

For example, if you deploy a message flow with these literal strings:
¢ $MQSI_VERSION=v1.0 MQSI$

e $MQSI Author=fred MQSI$

e $MQSI Subflow 1 Version=v1.3.2 MQSI$

the Properties View displays:

Deployment Time Date and time of deployment
Modification Time Date and time of modification
Version vl.0
Author fred
Subflow 1 Version vl.3.2

You are given a reason if the keyword information is not available. For example, if
keyword resolution has not been enabled at deploy time, the Properties View
displays the message Deployed with keyword search disabled. Also, if you deploy
to a Configuration Manager that is an earlier version than Version 6.0, the
properties view displays Keywords not available on this Configuration Manager.
Populating the Comment and Path columns

If you add source files, the Path column is populated automatically.

To add a comment, double click on the Comment column and type the text that
you require.

Saving a message flow

You might want to save your message flow when you want to:
* Close the workbench.
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216 Message Flows

¢ Work with another resource.

* Validate the contents of the message flow.

Before you start:

To complete this task, you must have completed the following task:
* [“Creating a message flow” on page 208|

To save a message flow:

1.
2.

Switch to the Broker Application Development perspective.

Select the editor view that contains the open message flow that you want to
save.

If you want to save the message flow without closing it in the editor view,
press Ctrl+S or click File » Save name on the taskbar menu (where name is the
name of this message flow). You can also choose to save everything by clicking
File » Save AlL

The message flow is saved and the message flow validator is invoked to
validate its contents. The validator provides a report of any errors that it finds
in the Tasks view. The message flow remains open in the editor view.

For example, if you save a message flow and have not set a mandatory
property, an error message appears in the Tasks view and the editor marks the

node with the error icon e . The message flow in the Broker Development
view is also marked with the error icon. This can occur if you have not edited
the properties of an MQInput node to define the queue from which the input
node retrieves its input messages.

(If you edit the properties of a node, you cannot click OK unless you have set
all mandatory properties. Therefore this situation can arise only if you have
never set any properties.)

You might also get warnings when you save a message flow. These are

indicated by the warning icon <& . This informs you that, although there is not
an explicit error in the configuration of the message flow, there is a situation
that might result in unexpected results when the message flow completes. For
example, if you have included an input node in your message flow that you
have not connected to any other node, you get a warning. In this situation, the
editor marks the node with the warning icon. The message flow in the Broker
Development view is also marked with a warning icon.

If you save a message flow that includes a subflow, and the subflow is no
longer available, three error messages are added to the Tasks view that indicate
that the input and output terminals and the subflow itself cannot be located.
This can occur if the subflow has been moved or renamed.

To resolve this situation, right-click the subflow node in error and click Locate
Subflow. The Locate Subflow dialog is displayed, listing the available message
flow projects. Expand the list and explore the resources available to locate the
required subflow. Select the correct subflow and click OK. All references in the
current message flow are updated for you and the errors removed from the
Tasks view.

If you want to save the message flow when you close it, click the close view
icon & on the editor view tab for this message flow or click File > Close on

the taskbar menu. The editor view is closed and the file saved. The same
validation occurs and any errors and warnings are written to the Tasks view.



For information about using the File > Save As option to take a copy of the
current message flow, see [“Copying a message flow using save.”|

See |“Correcting errors from saving a message flow”| for information about
handling errors from the save action.

Copying a message flow using save

You can copy a message flow by using the File » Save As option.
1. Click File » Save name As.

2. Specify the message flow project in which you want to save a copy of the
message flow. The project name defaults to the current project. You can accept
this name, or choose another name from the valid options that are displayed in
the File Save dialog.

3. Specify the name for the new copy of the message flow. If you want to save
this message flow in the same project, you must either give it another name, or
confirm that you want to overwrite the current copy (that is, copy the flow to
itself).

If you want to save this message flow in another project, the project must
already exist (you can only select from the list of existing projects). You can
save the flow with the same or another name in another project.

4. Click OK. The message flow is saved and the message flow editor validates its
contents. The editor provides a report of any errors that it finds in the Tasks
view. See [“Correcting errors from saving a message flow”| for information about
handling errors from the save action.

Correcting errors from saving a message flow
Correct the errors that are reported when you save a message flow.

To correct errors from the save or save as action:

1. Examine the list of errors and warnings that the validator has generated in the
Tasks view.

2. Double-click each entry in turn. The message flow is displayed in the editor
view (if it is not already there), and the editor selects the node in which the
error was detected. If the error has been generated because you have not set a
mandatory property, the editor also opens the Properties view or dialog box for
that node.

If you have included a user-defined node in your message flow, and have
defined one or more of its properties as configurable, you might get a warning
about a custom property editor. If you define a property as configurable, and
you have specified that it uses a custom property editor, the bar editor cannot
handle the custom property editor and handles the property as if it is type
String. This restricts your ability to make changes to this property at deploy
time.

3. Correct the error that is indicated by the message. For example, provide a value
for the mandatory property.

4. When you have corrected all the errors, you can save again. The editor
validates all the resources that you have changed, removes any corrected errors
from the Tasks view, and removes the corresponding graphical indication from
the nodes that you have modified successfully.

You do not have to correct every error to save your work. The editor saves your
resources even if it detects errors or warnings, so that you can continue to work
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with them at a later date. However, you cannot deploy any resource that has a
validation error. You must correct every error before you deploy a resource.
Warnings do not prevent successful deployment.

Defining message flow content

This topic describes how to create the contents of the message flow.

When you create a new message flow, the editor view is initially empty. You must
create the contents of the message flow by:

+ [“Adding a message flow node” on page 221|
+ “Adding a subflow” on page 224|
* |“Renaming a message flow node” on page 224|

+ [“Configuring a message flow node” on page 225|

+ |“Connecting message flow nodes” on page 229

* |“Adding a bend point” on page 232|

+ |“Aligning and arranging nodes” on page 234

When you finalize the content of the message flow, you might also need to
perform the following tasks:

+ ['Removing a message flow node” on page 228|

* [“Removing a node connection” on page 232

* [“Removing a bend point” on page 233

To learn more about message flow content, you can import either of the following
samples:

+ |Airline Reservations sample]

¢ [Error Handler sample
[E p

Follow the supplied instructions to build the sample yourself. You can also try
adding and deleting nodes, adding subflows, and connecting nodes together. You
can view samples only when you use the information center that is integrated with
the Message Broker Toolkit.

For a basic introduction to developing message flows, see the IBM Redbooks
publication [WebSphere Message Broker Basics}|

Using the node palette

218 Message Flows

Before you start:

Read the concept topic about [the node palette}

The node palette contains all of the built-in nodes, which are organized into
categories. You can add the nodes that you use most often to the Favorites
category by following the instructions in [“Adding nodes to the Favorites category|
fon the palette” on page 220

You can change the palette preferences in the Message Broker Toolkit. The changes
that you can make are described in the following topics.

* |“Changing the palette layout” on page 219|

+ [“Changing the palette settings” on page 219
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+ [“Customizing the palette”]

Changing the palette layout

You can change the layout of the palette in the Message Flow editor and the
Broker Topology editor.

1. Switch to the Broker Application Development perspective
2. Right-click the palette to display the pop-up menu.
3. Click Layout.
4. Click one of the available views:
Columns

Displays named icons in one or more columns. Change the number of
columns by clicking on the right edge of the palette and dragging.

List  Displays named icons in a single-column list. The list view is the
default layout.

Icons Only
Displays a list of icons only.

Details
Displays descriptions of the icons.

Changing the palette settings

Change the palette settings in the Message Flow editor and the Broker Topology
editor using the Palette Settings dialog box.

1. Switch to the Broker Application Development perspective.
2. Right-click the palette to display the pop-up menu.
3. Click Settings. The Palette Settings dialog box opens.
4. Use the dialog to change the appropriate setting:
¢ Click Change to change the font on the palette.
¢ Click Restore Default to restore the default palette settings.

* In the Layout list, click the appropriate radio button to change the palette
layout. (See [“Changing the palette layout”| for more information.)

 Select User large icons to toggle between large and small icons in the palette.

* In the Drawer options list, click the appropriate radio button to change the
way that drawers are handled in the palette. A drawer is a container for a
list of icons, such as the Favorites drawer on the Message Flow editor’s
palette, or the Entity drawer on the Broker Topology editor’s palette.

Customizing the palette

If you customize the message flow node palette, you can make it easier to find the
nodes that you use most often, saving time and on-screen space. For example:

* Change the order of the drawers in the palette so that the ones that you use
most often are at the top.

* Hide any drawers that you do not use, to save on-screen space.

* Pin open the drawers that contain the nodes that you use most often.

* Create your own drawers to hold user-defined nodes that you create.
Customize the palette for the Message Flow editor using the Customize Palette
dialog box:

1. Switch to the Broker Application Development perspective.
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2. Right-click the palette, then click Customize. The Customize Palette dialog box

opens.

¢ To change the order of entries and drawers in the palette, click the
appropriate item in the list to highlight it, then click Move Down or Move
Up. You cannot move any category above the Favorites category.

* To hide an entry or drawer, click the appropriate item in the list to highlight
it, then select the Hide check box.

* To create a new separator, click New » Separator.
* To create a new drawer:
a. Click New » Drawer.
b. Type a name and description for the drawer.
c. If required, select the Open drawer at start-up check box.

d. If required, select the Pin drawer open at start-up check box.

3. Click OK or Apply to save your changes.

You have customized the message flow node palette.

Adding nodes to the Favorites category on the palette

Before you start:

Read the concept topic about [the message flow node palette]

The nodes on the palette are organized in categories. The first category is
Favorites, which is usually empty. You can drag the nodes that you use most often
to the Favorites category.

1.
2.
3.

Switch to the Broker Application Development perspective.
On the palette, open the Favorites category.

On the palette, open the category that contains the node that you want to add
to the Favorites category.

Use the mouse to drag the node into the Favorites category, as shown in the
following example:
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Alternatively, right-click the palette and choose the appropriate option to add or
remove nodes from the Favorites category.

Adding a message flow node

When you have created a new message flow, add nodes to define its function.

Before you start:
* |Create a message flow]|or [open an existing message flow]
* Read the concept topic about [message flow nodes|

To add a node to a message flow:

1. Switch to the Broker Application Development perspective.
2. Open the message flow with which you want to work.

3. Open the Palette.

* Hover the mouse over the palette bar while it is in collapsed mode. The
palette bar expands. When you move the mouse away from the palette bar, it
collapses again.

* Click the Show Palette icon at the top of the palette bar. The palette bar
expands and it remains expanded when the mouse is moved away from the
palette bar. To collapse the palette bar again, click the Hide Palette icon at
the top of the palette bar while it is in expanded mode.

4. Click Selection above the palette of nodes.

5. Decide which node you want to add: a built-in node or a user-defined node.
You can select any of the nodes that appear in the node palette, but you can
add only one node at a time.
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Nodes are grouped in categories according to the function that they provide. To
see descriptions of the nodes in the palette, either hover the mouse over a node
in the palette, or switch to the Details view by following the instructions in
[‘Changing the palette layout” on page 219

6. Drag the node from the node palette onto the canvas.

When you add a node to the canvas, the editor automatically assigns a name to
the node, but the name is highlighted and you can change it by entering a
name of your choice. If you do not change the default name at this time, you
can later. The default name is set to the type of node for the first
instance. For example, if you add an MQInput node to the canvas, it is given
the name MQInput; if you add a second MQInput node, the default name is
MQInputl; the third is MQInput2, and so on.

7. Repeat steps and |§| to add further nodes.
8. You can also add nodes from other flows into this flow:
a. Open the other message flow.

b. Select the node or nodes that you want to copy from the editor or outline
views, and press Ctrl+C or click Edit > Copy.

C. Return to the flow with which you are currently working.

d. Press Ctrl+V or click Edit » Paste. This action copies the node or nodes into
your current flow. The node names and properties are preserved in the new

copy.

When you have added the nodes that you want in this message flow, you can
connect them to specify the flow of control through the message flow, and you can
configure their properties.

Next: [configure the nodes|

Adding a node using the keyboard

Before you start:
+ |Create a message flow|or [open an existing message flow|
* Read the concept topic about [message flow nodes|

You can use the keyboard to perform tasks in the Message Flow editor, such as
adding a node to the canvas.

1. Switch to the Broker Application Development perspective.
2. Open the message flow to which you want to add a node.

3. Open the Palette view or the Palette bar.
4

. Select a node in the Palette view or Palette bar using the up and down arrows
to highlight the node that you want to add to the canvas.

o

Add the Node to the canvas using one of the following methods:
* DPress Alt + L, then press N.

* Press Shift + F10 to open the context-sensitive menu for the Palette, and
press N.

The node that you selected in the Palette bar or Palette view is placed on the
canvas in the Editor view.

When you add a node to the canvas, the editor automatically assigns a name to
the node, but the name is highlighted and you can change it by entering a
name of your choice. If you do not change the default name at this time, you
can later. The default name is set to the type of node for the first
instance. For example, if you add an MQInput node to the canvas, it is given



the name MQInput; if you add a second MQInput node, the default name is
MQInputl; the third is MQInput2, and so on.

You can move the node that you have placed on the canvas using the keyboard
controls described in [Message Broker Toolkit keyboard shortcuts|

Dragging a resource from the Broker Development view
Drag a node or a related resource into the Message Flow editor.

Before you start:
* |Create a message flow] or [open an existing message flow|
+ Read about [message flow nodes|

Drag a resource from the Broker Development view to an empty canvas to create a
new node, or drag a resource onto an existing node to modify that node. The
following resources are supported:

* An Adapter file

* An ESQL file

* AJava file

© A

* A WSDL file

* An XSL file

1. Switch to the Broker Application Development perspective.
2. Open the message flow with which you want to work.

3. Drag one of the supported resources from the Broker Development view onto
the canvas.

* If you drop the resource on an empty canvas, a node is created and
configured automatically.

The following table shows the results when you drag a resource from the
Broker Development view onto an empty canvas:

Resource Node created Property set

Adapter file | A]“PeopleSoftinput node” on page| | Adapter component
[970 J|’SAPInput node” on page 996 |
or [SiebellInput node” on page 1012|

is created

ESQL file Al“Compute node” on page 779 is ESQL Module
created

Java file Al“JavaCompute node” on page 881| |Java Class
is created

WSDL file A[“SOAPInput node” on page 1040] | WSDL file name
or ["'SOAPRequest node” on page]
|1051| is created

XSL file An [“XSLTransform node” on page| Stylesheet
|1088| is created

* If you drop the resource onto an existing node, the relevant node property is
updated with the name of the resource file. For example, if you drop a Java
file onto a JavaCompute node, the Java Class property is set to the class
name of the Java file that you are dropping. If you drop an ESQL file over
any node that uses ESQL, such as a Database node, the ESQL Module
property is set.
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Adding a subflow

Within a message flow, you might want to include an embedded message flow,
also known as a subflow. For example, you might define a subflow that provides
error handling, and include it in a message flow connected to a failure terminal on
a node that can generate an error in some situations.

Before you start
To complete this task, you must have completed one of the following tasks:

+ [“Creating a message flow” on page 208
* |“Opening an existing message flow” on page 210

When you add a subflow, it appears in the editor view as a single node.

You can embed subflows into your message flow if either of the following
statements is true:

¢ The flow that you want to embed is defined in the same message flow project.

* The flow is defined in a different message flow project, and you have specified
the dependency of the current message flow project on that other project.

To add a subflow to a message flow:

1. Switch to the Broker Application Development perspective.

2. Open the message flow that you want to work with.

3. Drag and drop the message flow from the Navigator view into the editor view.
Alternatively, highlight the embedding message flow and click Edit » Add
subflow, which displays a list of valid flows that you can add to the current
flow.

4. Select the flow that you want to add from the list. The subflow icon is
displayed with the terminals that represent the Input and Output nodes that
you have included in the subflow.

5. Click OK.

6. Repeat steps @ EL and [5[to add further subflow nodes.

7. Select and open (double-click) the flow by name in the Navigator view, or

right-click the embedded flow icon and select Open Subflow to work with the
contents of the embedded flow

When you have added the nodes that you want in this message flow, you can
connect them to specify the flow of control through the message flow, and you can
modify their properties.

Renaming a message flow node

224 Message Flows

Before you start:

* |Create a message flow|

* Read the concept topic about [message flow nodes|

You can change the name of any type of node (a built-in node, user-defined node,
or subflow node) to reflect its purpose. When you first add a node to the canvas,
the editor automatically assigns a name to the node, but the name is highlighted
and you can change it by entering a name of your choice. If you do not change the
default name at this time, you can change it later, as described in this topic. For



example, you might include a Compute node to calculate the price of a specific
part within an order, and you could change the name of the node to be
Calculate_Price.

When you rename a node, use only the supported characters for this entity. The
editor prevents you from entering unsupported characters.

To rename a node:

1. Switch to the Broker Application Development perspective.
2. Open the message flow with which you want to work.

3. You can rename a node in three ways:

* Right-click the node and click Rename. The name is highlighted; enter a
name of your choice and press Enter.

e (lick the node to select it, then click the node’s name so that it is
highlighted; enter a name of your choice and press Enter.

¢ Click the node to select it, then on the Description tab of the Properties view,
enter a name of your choice in the Node name field.

The name that you enter must be unique within the message flow.

If you generate ESQL code for a Compute, Database, or Filter node, the code is
contained within a module that is associated with the node. The name of the
module within the ESQL file must match the name specified for the module in the
ESQL Module property of the corresponding node. Although you can modify the
module name, and change it from its default value (which is the name of the
message flow, concatenated with the name of the node with which the module is
associated), ensure that the module in the ESQL file matches the node property.

Configuring a message flow node

When you have included an instance of a node in your message flow, you can
configure its properties to customize how it works.

Before you start:

* Read the concept topic about [message flow nodes|

* [Add a nodd

Viewing a node’s properties

To view a node’s properties:
1. Switch to the Broker Application Development perspective.
2. Open the message flow with which you want to work.

3. Open the palette.
4. Click Selection above the node palette.
5. Right-click a node and click Properties to open the Properties view.

For nodes that do not have an associated resource, you can also double-click
the node to display the properties. However, if you double-click any of the
nodes in the following table, you open the associated resource.

Node Result of double-clicking the node

“Compute node” on pagel Opens an ESQL file
779,
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Node

Result of double-clicking the node

"“Database node” on page|

787]

Opens an ESQL file

“DataDelete node” on|

age 80

:

Opens the New Message Map dialog box

“Datalnsert node” on|

age 81

:

Opens the New Message Map dialog box

“DataUpdate node” on|

age 81

:

Opens the New Message Map dialog box

"“Extract node” on page|

[¢9)

26)

Opens the New Message Map dialog box

“JTavaCompute node” on|

age 881

d

Opens the New JavaCompute Node Class wizard

“Mapping node” on page]

914

Opens the New Message Map dialog box

[“SOAPAsyncRequest|

[node” on page 1019|

Opens the WSDL Selection dialog box

[“SOAPInput node” on|

|Eage 1040|

Opens the WSDL Selection dialog box

“SOAPRequest node” on|

[page 1051]

Opens the WSDL Selection dialog box

““Warehouse node” on|

hgage 1085|

Opens the New Message Map dialog box

WebSphere Adapters
nodes

Opens the Adapter Component Selection dialog box

[“XSLTransform node” onl|

|Eage 1088|

Opens the XSL Selection dialog box

The selected node’s properties are displayed.

Editing a node’s properties

Properties are organized into related groups and displayed on tabs. Each tab is

listed on the left of the Properties view. Click each tab to view the properties that

you can edit.

* Every node has at least one tab, Description, where you can change the name of
the node and enter short and long descriptions. The description fields are
optional because they are used only for documentation purposes.

If a property is mandatory, that is, one for which you must enter a value, the
property name is marked with an asterisk, as shown in the following example:

Queue Namex

For details of how to configure each individual built-in node, see the node
description. You can find a list of the nodes, with links to the individual topics, in
[Built-in nodes” on page 762

If you have included a user-defined node, refer to the documentation that came
with the node to understand if, and how, you can configure its properties.



Editing complex properties

A complex property is a property to which you can assign multiple values.
Complex properties are displayed in a table in the Properties view, where you can
add, edit, and delete values, and change the order of the values in the table. This
example shows the Query elements complex property of the DatabaseRoute node.

Query elements®
| Tahle name | Calumn narne | Operakar | Value Tvpe add

Edit... |
Delete |

.| | » 215

* To add a value to a complex property, click Add, enter the required fields in the
dialog box that opens, then click OK. The values appear in the table. Repeat this
step to enter as many values as are required.

* To edit a value, click any element in a row, click Edit, edit any of the values in
the dialog box, then click OK.

* To delete a value, click any element in a row and click Delete. The entire row is
deleted.

* To change the order of values in the table, click any element in a row and click

the up icon _I or down icon _I to move the row.

Promoting properties

You can promote node properties to their containing message flow; for more
information, see [“Promoting a property” on page 507 Use this technique to set
some values at the message flow level, without having to change individual nodes.
This can be useful, for example, when you embed a message flow in another flow,
and want to override some property such as output queue or data source with a
value that is correct in this context. You cannot promote complex properties. For a
full list of properties that are unavailable for promotion, as well as instructions for
how to promote properties, see [“Promoting a property” on page 507 |

Overriding properties at deployment time

You can override a small number of node property values when you deploy a
message flow. These property values are known as configurable properties, and
you can use them to modify some characteristics of a deployed message flow
without changing the message flow definitions. For example, you can update
queue manager and data source information.

Even though you can set values for configurable properties at deployment time,
you must set values for these properties within the message flow if they are
mandatory. Each |Euﬂt—in node| reference topic contains a table of properties, which
identifies the configurable and mandatory properties.

Next: [connect the nodes]

Using dynamic terminals

You can add, rename, and remove dynamic terminals on a node in the Message
Flow editor.

Before you start:
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* Add a node that supports dynamic terminals; for more details, see |“Adding 5|
message flow node” on page 221|and [“Message flow node terminals” on page|

m

Some message flow nodes support dynamic input or output terminals, including
the Collector, Route, and DatabaseRoute nodes. When you have added a node to
the flow editor, you can add, remove, or change dynamic terminals.

* Adding a dynamic terminal
1. Right-click the node and click Add Input Terminal or Add Output Terminal.

2. Enter a name for the new terminal and click OK. The name must be unique
for the terminal type. For example, if an input terminal called In already
exists, you cannot create a dynamic input terminal with the name In.

The new terminal is displayed on the node. If a node has five or more
terminals, they are displayed as a terminal group. The following example

]
=R
shows a Route node with more than four output terminals. To
connect a particular output terminal, click the terminal group to open the
Terminal Selection dialog box, or right-click the node and select Create
Connection.

* Renaming a dynamic terminal

1. Right-click the node and click Rename Input Terminal or Rename Output
Terminal. These options are available only if you have added one or more
appropriate terminals to this node.

2. Select from the list the name of the terminal that you want to change. Only
dynamic terminals are listed because you cannot change the name of a static
terminal.

3. Enter a new name for the terminal and click OK. Do not rename a dynamic
terminal if one of the node properties is configured to use that name.

* Removing a dynamic terminal

1. Right-click the node and click Remove Input Terminal or Remove Output
Terminal, These options are available only if you have added one or more
appropriate terminals to this node.

2. Select from the list the name of the terminal that you want to remove and
click OK. Only dynamic terminals are listed because you cannot remove a
static terminal. Do not remove a dynamic terminal if one of the node
properties is configured to use that terminal.

When you have added dynamic terminals to a node, connect them to other nodes
in the message flow; for more information, see [“Connecting message flow nodes”]

Removing a message flow node

228 Message Flows

When you have created and populated a message flow, you might need to remove
a node to change the function of the flow, or to replace it with another more
appropriate node. The node can be a built-in node, a user-defined node, or a
subflow node.

Before you start:

.
¢ [Add a subflow|



* Read the concept topic about [message flow nodes|

To remove a node:

1. Switch to the Broker Application Development perspective.
2. Open the message flow that you want to work with.

3. Select the node in the editor view and press the Delete key.
4. Highlight the node and click Edit » Delete

You can also right-click the node in the editor view and click Delete, or
right-click the node in the Outline view and click Delete. The editor removes
the node. If you have created any connections between that node and any other
node, those connections are also deleted when you delete the node.

5. If you delete a node in error, you can restore it by right-clicking in the editor
view and clicking Undo Delete. The node and its connections, if any, are
restored.

You can also click Edit » Undo Delete or press Ctrl+Z.

7. If you undo the delete, but decide it is the correct delete action, you can
right-click in the editor view and click Redo Delete.

You can also click Edit » Redo Delete.

Connecting message flow nodes

When you include more than one node in your message flow, you must connect
the nodes to indicate how the flow of control passes from input to output. The
nodes can be built-in nodes, user-defined nodes, or subflow nodes.

Before you start:

.
* |Add a subflow|
* Read the concept topic about

Your message flow might contain just one MQInput node, one Compute node, and
one MQOutput node. Or it might involve a large number of nodes, and perhaps
embedded message flows, that provide a number of paths through which a
message can travel depending on its content. You might also have some error
processing routines included in the flow. You might also need to control the order
of processing.

You can connect a single output terminal of one node to the input terminal of more
than one node (this is known as fan-out). If you do this, the same message is
propagated to all target nodes, but you have no control over the order in which
the subsequent paths through the message flow are executed (except with the
FlowOrder node).

You can also connect the output terminal of several nodes to a single node input
terminal (this is known as fan-in). Again, the messages that are received by the
target node are not received in any guaranteed order.

When you have completed a connection, it is displayed as a black line, and is
drawn as close as possible to a straight line between the connected terminals. This
might result in the connection passing across other nodes. To avoid this, you can
add bend points to the connection.
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In the Message Flow editor, you can display node and connection metadata by
hovering the mouse over a node or subflow in a message flow. To view metadata
information for a node, subflow, or connection:

1. Switch to the Broker Application Development perspective.

2. Open a message flow.

3. In the Message Flow editor, hover the mouse over a node, a subflow, or a node
connection in the open message flow by placing the mouse over the element.

A custom tooltip is displayed below the element.

¢ To turn the pop-up window into a scrollable window, press F2.

* To hide the pop-up window, either press Esc or move the mouse away from the
node.

If you define a complex message flow, you might have to create a large number of
connections. The principle is the same for every connection. You create connections
either by using the mouse, or by using the Terminal Selection dialog. See |”Creatina

node connections with the mouse”| and [“Creating node connections with the

Terminal Selection dialog box” on page 231| for more information.

Creating node connections with the mouse
Use the mouse to connect one node to another.

Before you start:

Read the concept topic about

1. Switch to the Broker Application Development perspective.
2. Open the message flow with which you want to work.

3. Click the terminal from which the connection is to be made; that is, the
terminal from which the message is propagated from the current node.

For example, you can click the Failure, Out, or Catch terminal of the MQInput
node. Hover the mouse over each terminal to see the name of the terminal. You
do not need to keep the mouse button pressed.

Alternatively, click Connection on the palette, then click the node from which
the connection is to be made. The [Terminal Selection dialog box| opens for you
to choose the terminal from which to make a connection. Click OK. If a node
has five or more input or output terminals (for example, if you have added
dynamic terminals), they are displayed in a group. The following example

—$!

o

shows a node with more than four output nodes. To select a
particular output terminal, click the grouped output terminal to open the
Terminal Selection dialog box.

4. Click the input terminal of the next node in the message flow (to which the
message passes for further processing). The connection is made when you click
a valid input terminal. The connection appears as a black line between the two
terminals.

In the Message Flow editor, you can display node and connection metadata by
hovering the mouse over a node or subflow in a message flow. To view metadata
information for a node, subflow, or connection:

1. Switch to the Broker Application Development perspective.
2. Open a message flow.



3. In the Message Flow editor, hover the mouse over a node, a subflow, or a node
connection in the open message flow by placing the mouse over the element.

A custom tooltip is displayed below the element.

* To turn the pop-up window into a scrollable window, press F2.

* To hide the pop-up window, either press Esc or move the mouse away from the
node.

Next: add a bend point, as described in [“Adding a bend point” on page 232

Creating node connections with the Terminal Selection dialog
box
Use the Terminal Selection dialog box to connect one node to another.

Before you start:

Read the concept topic about

1. Switch to the Broker Application Development perspective.
2. Open the message flow with which you want to work.

3. Click Connection above the node palette.
4

. Click the node from which you want the connection to be made. The Terminal
Selection dialog box is displayed.
5. Select the terminal from the list of valid terminals on this node. Click OK. The
dialog box closes.

6. Click the node to which to make the connection. If this node has only one
input terminal, the connection is made immediately. If this node has more than
one input terminal, the Terminal Selection dialog box is displayed again, listing
the input terminals of the selected node. Click the correct terminal and click
OK.

Alternatively, you can make a connection in the following way:
1. Click Selection above the node palette.

2. Right-click the node from which you want to make the connection and click
Create Connection. The Terminal Selection dialog box is displayed.

3. Select the terminal from the list of valid terminals on this node. Click OK. The
dialog box closes.

4. Click the node to which to make the connection. If this node has only one
input terminal, the connection is made immediately. If this node has more than
one input terminal, the Terminal Selection dialog box is displayed again, listing
the input terminals of the selected node. Click the correct terminal and click
OK.

In the Message Flow editor, you can display node and connection metadata by
hovering the mouse over a node or subflow in a message flow. To view metadata
information for a node, subflow, or connection:

1. Switch to the Broker Application Development perspective.

2. Open a message flow.

3. In the Message Flow editor, hover the mouse over a node, a subflow, or a node
connection in the open message flow by placing the mouse over the element.

A custom tooltip is displayed below the element.

* To turn the pop-up window into a scrollable window, press F2.
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* To hide the pop-up window, either press Esc or move the mouse away from the
node.

Next: add a bend point, as described in [“Adding a bend point.”]

Removing a node connection

The message flow editor displays the nodes and connections in the editor view.
You can remove connections to change the way in which the message flow
processes messages.

Before you start:
+ |Connect the nodes|

* Read the concept topic about

If you want to remove a connection that you have created between two nodes:

1. Switch to the Broker Application Development perspective.
2. Open the message flow that you want to work with.

3. Click Selection above the node palette.
4

Select the connection that you want to delete. When you hover your mouse
pointer over the connection, the editor highlights the connection that you have
selected by thickening its line, adding an arrowhead at the target terminal end,
and annotating the connection with the name of the two terminals connected,
for example Out->In.

When you select the connection, the editor appends a small black square at
each end and at every bend point of the connection, and a small arrowhead at
the target terminal end. The annotation disappears when you select the
connection.

5. Check that the selected connection is the one that you want to delete.

6. Right-click the connection and click Delete, press the Delete key, or click Edit »
Delete. If you want to delete further connections, repeat these actions from step

7. If you delete a connection in error, you can restore it by right-clicking in the
editor view and clicking Undo Delete. The connection is restored.

8. If you undo the delete, but decide that it is the correct delete action, you can
right-click in the editor view and click Redo Delete. You can also delete a
connection by selecting it in the Outline view and pressing the Delete key.

If you delete a node, its connections are automatically removed; you do not have
to do this as a separate task.

Adding a bend point
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When you are working with a message flow, and connecting your chosen nodes
together to determine the flow of control, you might find that a connection that
you have made crosses over an intervening node and makes the flow of control
difficult to follow.

To help you to display the message flow nodes and their connections in a clear
way, you can add bend points to the connections that you have made to improve
the organization of the display. The addition of bend points has no effect on the
execution of the nodes or the operation of the message flow.



Before you start:
+ |Connect the nodes|

* Read the concept topic about

To add a bend point:

1.

Switch to the Broker Application Development perspective.

2. Open the message flow that you want to work with.
3.
4

. Select the connection to which you want to add a bend point. The editor

Click Selection above the node palette.

appends a small black square to each end of the connection to highlight it.

a. Check that this is the correct connection. The editor also adds a small point
(a handle) in the connection halfway between the in and out terminals that
are joined by this connection.

Hover your mouse pointer over this point until the editor displays a black
cross to indicate that you now have control of this bend point.

a. Hold down the left mouse button and move your mouse to move the black
cross and bend point across the editor view.

As you drag your mouse, the connection is updated, retaining its start and end
points with a bend point at the drag point. You can move this anywhere within
the editor view to improve the layout of your message flow.

Release the mouse button when the connection is in the correct place. The
editor now displays the bend point that you have created with a small square
(like those at the ends of the connection), and displays another two small
points within the connection, one between your newly-created bend point and
the out terminal, the other between the new bend point and the in terminal.

If you want to add more than one bend point to the same connection, repeat these
actions from step El using the additional small points inserted into the connection.

Next: [align and arrange the nodes}

Removing a bend point

When you are working with a message flow in the editor view, you might want to
simplify the display of the message flow by removing a bend point that you
previously added to a connection between two nodes.

Before you start:
* |Add a bend point|
* Read the concept topic about

To remove a bend point:

1.

Switch to the Broker Application Development perspective.

2. Open the message flow that you want to work with.
3.
4

. Select the connection from which you want to remove the bend point. The

Click Selection above the node palette.

editor highlights the connection and its current bend points by thickening its
line and appending a small black square to each end of the connection, and by
indicating each bend point with a small black square. Check that this is the
correct connection.

Right-click over the selected connection, if you added this bend point in the
current edit session.
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a. Click Undo Create Bend Point.

The editor removes the selected bend point.

If you right-click in the editor view without a connection being selected, you
can also click Undo Create Bend Point from the menu. However, this removes
the last bend point that you created in any connection, which might not be the
one that you want to remove.

Move the bend point to straighten the line if you added this bend point in a
previous edit session, because you cannot use the undo action. When the line is
straight, the bend point is removed automatically.

When the bend point has been removed, the connection remains highlighted.
Both ends of the connection, and any remaining bend points, remain displayed
as small black squares. The editor also inserts small points (handles) into the
connection between each bend point and between each terminal and its
adjacent bend point, which you can use to add more bend points if you choose.

If you want to remove another bend point from the same connection, repeat
these actions from stepE on Eaée 23SI

Aligning and arranging nodes
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When you are working in the Message Flow editor, you can decide how your
nodes are aligned within the editor view.

This option is closely linked to the way in which your nodes are arranged. Again,
the default for this is left to right, which means that the in terminal of a node
appears on its left edge, and its out terminals appear on its right edge. You can
also change this characteristic of a node by rotating the icon display to right to left,
top to bottom, and bottom to top.

Before you start

To complete this task, you must have completed the following task:

+ [“Adding a message flow node” on page 221

To modify the way in which nodes and connections are displayed in the editor:

1.

2.
3.
4.

Switch to the Broker Application Development perspective.
Open the message flow that you want to work with.
Click Selection above the node palette.

Right-click in the editor window and select Manhattan Layout if you want the
connections between the nodes to be displayed in Manhattan style; that is with
horizontal and vertical lines joined at right angles.

If you want to change the layout of the complete message flow:

a. Right-click in the editor view and click Layout. The default for the
alignment is left to right, such that your message flow starts (with an input
node) on the left and control passes to the right.

b. From the four further options displayed, Left to Right, Right to Left, Top
to Bottom, and Bottom to Top, click the option that you want for this
message flow. The message flow display is updated to reflect your choice.
As a result of the change in alignment, all the nodes within the message
flow are also realigned.



For example, if you have changed from a left to right display (the default)
to a right to left display, each node in the flow has now also changed to
right to left (that is, the in terminal now appears on the right edge, the out
terminals appear on the left edge).

6. You might want to arrange an individual node in a different direction from that
in which the remaining nodes are arranged within the message flow, To do this:

a. Right-click the node that you want to change and click Rotate. This gives
you four further options: Left to Right, Right to Left, Top to Bottom, and
Bottom to Top.

b. Click the option that you want for this node. The option that represents the
current arrangement of the node is not available for selection.

If you change the alignment of the message flow, or the arrangement of an
individual node, or both, these settings are saved when you save the message flow.
They are applied when another user accesses this same message flow, either
through a shared repository or through shared files or import and export. When
you reopen the message flow, you see these changed characteristics. The alignment
and arrangement that you have selected for this message flow have no impact on
the alignment and arrangement of any other message flow.

In the Message Broker Toolkit Version 5.1 you can adjust the zoom by
right-clicking in the editor view and clicking Zoom in or Zoom out. Alternatively,
you can use the drop-down list on the editor toolbar to specify a zoom percentage.

You can also access the editor toolbar to select other options related to the display
and arrangement of nodes, for example, snap to grid. These are defined in
[Message Flow editor]|

Developing message flow applications using WebSphere Adapters

Before you can connect to an Enterprise Information System (EIS), perform the
following tasks, in the order shown, to prepare your system.

Before you start:

* Read ["WebSphere Adapters nodes” on page 7|

* Check for the latest information about WebSphere Adapters at
[Adapters technotes]

+ [Enable the WebSphere Adapters nodes in the broker runtime environment

* If you want to use the IBM Tivoli License Manager (ITLM), perform the steps in
[“Activating ITLM for WebSphere Adapters” on page 236

* Look at the [Twineball Example EIS Adapter sample|and the [SAP Connectivity]

|samEIel

* SAP
1. Follow the instructions in [“Adding external software dependencies for SAP”|

2. Follow the instructions in [’Configuring the SAP system to work with the|
ladapter” on page 237
* Siebel
1. Follow the instructions in [“Adding external software dependencies for
[Siebel” on page 239)
2. Follow the instructions in [’Configuring the Siebel application to work with|
[the adapter” on page 240
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* PeopleSoft

1. Follow the instructions in [“Adding external software dependencies for
[PeopleSoft” on page 242

2. Follow the instructions in [“Creating a custom event project in PeopleTools”]

After you have prepared your system, connect to an EIS by following the
instructions in [“Connecting to an EIS using the Adapter Connection wizard” on|

|Eage 244.|

Activating ITLM for WebSphere Adapters

If you want to use IBM Tivoli® License Manager (ITLM), you must activate it for
each of the WebSphere Adapters.

ITLM enables you to monitor the usage of IBM (and other) software products. For
more information, see [Installing Tivoli License Manager]

The following steps describe how to activate the ITLM file for each of the adapters.
1. Locate the ITLM directory for the adapter.

* For SAP: install_dir/itlm/SAP

e For Siebel: install_dir/itlm/Siebel

* For PeopleSoft: install_dir/itlm/PeopleSoft

2. Remove the inactive file extension from the file in the ITLM directory so that it
ends with .sys2.

When you run ITLM, the adapter is visible.

Adding external software dependencies for SAP
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Ensure that you have the relevant prerequisite files for your SAP system.

SAP delivered files:

* sapjco.jar

* sapjcorfc.dll or libsapjcorfc.so
¢ librfc32.d1l or librfccm.so

Download these files for your operating system from the [SAP Service Marketplace}
and save them to a directory, such as C:\SAP_LIB. You must have an SAPNet
account to be able to access this Web site.

* On Windows, download any .dll files that come with the SAP JCo download.

¢ On z/0S, Linux, and UNIX, download any .so and .o files that come with the
SAP JCo download.

Locating the SAP support files in the run time on Windows

To add the SAP prerequisite files to the run time, take the following steps.
1. Ensure that the broker has started.

2. Either open the Command Console, or open a Windows command prompt and
enter mgsiprofile.

3. Enter the following command:
mgsireportproperties WBRK61 DEFAULT BROKER -c Al1Types -o AllReportableEntityNames


http://service.sap.com/connectors

mgsichangeproperties
mqgsichangeproperties

The following example shows what typically is displayed when you run this
command:

ReportableEntityName=""
EISProviders

PeopleSoft=""
jarsURL="default_Path'
nativelLibs='default_Path'

SAP=""
jarsURL="'default_Path'
nativelLibs='default_Path'

Siebel=""
jarsURL="'default_Path'
nativelLibs="'default_Path'

Twineball=""
jarsURL="default_Path'
nativelLibs="'default_Path'

4. Set the location of the SAP prerequisite files using the following command:

WBRK61_DEFAULT_BROKER -c EISProviders -o SAP -n jarsURL -v C:\SAP_LIB

WBRK61_DEFAULT_BROKER -c EISProviders -o SAP -n nativelLibs -v C:\SAP_LIB

5. To check that the values have been set correctly, run the following command:
mgsireportproperties WBRK61 DEFAULT_BROKER -c EISProviders -o SAP -r

The following example shows what is displayed by the mgsireportproperties
command.

ReportableEntityName=
EISProviders
SAp=""
jarsURL="'C:\SAP_LIB'
nativeLibs="'C:\SAP_LIB'

BIP8071I: Successful command completion.
6. Restart the broker.

Configuring the SAP system to work with the adapter

Before you configure the WebSphere Adapter for SAP Software for ALE processing,
you must register an RFC destination on the SAP server, and configure a receiver
port, logical system, distribution model, and partner profile on the SAP server. Ask
your system administrator if these items have been configured.

Perform the following steps on the SAP server using the SAP graphical user
interface.

1. Register an RFC program ID:
a. Open transaction SM59 (Display and Maintain RFC Destinations).
Click Create.
Type a name for the RFC destination.
In the Connection Type field, select T.
In the Activation Type field, select Registered Server Program.

-0 oo00T

Type a Program ID.

You use this program ID when you configure the adapter. This value
indicates to the SAP gateway which RFC-enabled functions the program ID
listens for.

g. Enter a description in Description 1, such as RFC for Test Sample.
h. Enter a description in Description 2, such as your name.

i. Click MDMP & Unicode, and in the Communication Type with Target
System section, click Unicode.
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j-

Save your entry.

2. Set up a receiver port:

a.
b
C.
d. Type the name of the destination that you created in the previous task (or

e.

Open transaction WE21 (Ports in IDoc processing).

. SelectTransactional RFC, click Ports, and click the Create icon.

Type a name for the port and click OK.

select it from the list).

Save your entry.

3. Specify a logical system:

a.
b. Click New Entries.

C.

d. If you see the Prompts for Workbench request, click the New Request icon.

e.

Open transaction BD54 (Change View Logical Systems).

Type a name for the logical system and click the Save icon.

Then enter a short description and click the Save icon.

Click the Continue icon.

4. Configure a distribution model:

-0 a0 TP

Open transaction BD64 (Maintenance of Distribution Model).

Click Distribution Model » Switch processing model.

Click Create model view.

Type a name for the model view and click the Continue icon.

Select the distribution model that you created and click Add message type.

For outbound processing, type the logical system name that you created in
the previous task as Sender, and the logical name of the SAP server as
Receiver, then select a message type (for example, MATMAS) and click the
Continue icon.

Select the distribution model again and click Add message type.

For inbound processing, type the logical name of the SAP server as Sender,
and the logical system name that you created in the previous task as
Receiver, then select a message type (for example, MATMAS) and click the
Continue icon.

Save your entry.

5. Set up a partner profile:

a.
b.
c.

Open transaction WE20 (Partner Profiles).
Click the Create icon.

Type the name of the logical system that you created in the earlier task and,
for Partner Type, select LS.

For Post Processing: permitted agent, type US and your user ID.

e. Click the Save icon.

In the Outbound parameters section, click the Create outbound parameter
icon.

In the Outbound parameters window, type a message type (for example,
MATMASO5), select the receiver port that you created in the earlier task, and
select Transfer IDoc immed.

Click the Save icon.
Press F3 to return to the Partner Profiles view.

In the Inbound parameters section, click the Create inbound parameter icon.



k. In the Inbound parameters window, type a message type (for example,
MATMAS), and a process code (for example, MATM).

|. Click the Save icon.

m. Press F3 to return to the Partner Profiles view.

n. In the Inbound parameters section, click the Create inbound parameter

icon.

0. In the Inbound parameters window, type the following values: ALEAUD for
Message Type, and AUD1 for Process Code.

p. Click the Save icon.

g. Press F3 to return to the Partner Profiles view.

=

Click the Save icon.

Adding external software dependencies for Siebel

Ensure that you have the relevant prerequisite files for your Siebel system.

Siebel support files

Table 10. External software dependency files required by Siebel Business Applications

Adapter Connection wizard property
name

Required dependency files for
Siebel Business Applications
(Versions 7.5 and earlier)

Required dependency files for
Siebel Business Applications
(Versions 7.7x, 7.8x, and 8.0)

Siebel jar

None

Siebel jar

Siebel]I_<language code>.jar

Siebel]I_<language code> jar (for
example, Siebel]I_enu jar)

Siebel]I_<language code> jar (for
example, Siebel]I_enu.jar)

Siebel]I_Common.jar

Siebel]I_Common.jar

None

Download these files from the Siebel application, and save them to a directory,
such as C:\Siebel LIB.

The sample resources that you need to set up the Siebel system so that it can
communicate with the broker are in install_dir\ResrouceAdapters\Siebel _6.1.0.0\

samples.

Locating the Siebel support files in the run time on Windows

To add the Siebel prerequisite files to the run time, take the following steps.
1. Ensure that the broker has started.

2. Either open the Command Console, or open a Windows command prompt and
enter mqsiprofile.

3. Enter the following command:
mgsireportproperties WBRK61 DEFAULT_BROKER -c Al1Types -o AllReportableEntityNames

The following example shows what typically is displayed when you run this
command:

ReportableEntityName=""
EISProviders
PeopleSoft=""
jarsURL="default_Path'
nativelLibs='default_Path'

SAP=""

jarsURL="default_Path'

nativelLibs='default_Path'
Siebel=""

jarsURL="'default_Path'
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mqsichangeproperties
mqsichangeproperties

nativelLibs="'default_Path'
Twineball=""

jarsURL="'default_Path'

nativelLibs="'default_Path'

4. Set the location of the Siebel prerequisite files using the following command:

WBRK61_DEFAULT_BROKER -c EISProviders -o Siebel -n jarsURL -v C:\Siebel LIB
WBRK61 DEFAULT BROKER -c EISProviders -o Siebel -n nativelibs -v C:\Siebel LIB

5. To check that the values have been set correctly, run the following command:
mgsireportproperties WBRK61 DEFAULT_BROKER -c EISProviders -o Siebel -r

The following example shows what is displayed by the mgsireportproperties
command.
ReportableEntityName=" "
EISProviders
Siebel="' "'
jarsURL="C:\Siebel LIB'
nativelLibs='C:\Siebel_LIB'

BIP8071I: Successful command completion.
6. Restart the broker.

Configuring the Siebel application to work with the adapter

Configure the Siebel application to work with the adapter by creating an event
table and a Siebel business object.

Before you start:

Before you configure the Siebel application to work with WebSphere Adapter for
Siebel Business Applications, you must create a user name and password so that
the Adapter Connection wizard can connect to Siebel Business Applications to
perform outbound operations, and retrieve Siebel business objects and services.

You perform this task on the Siebel server, therefore ensure that you are familiar
with the Siebel tools that are required to complete it. For information about using
Siebel tools, refer to the Siebel tools documentation.

To open Siebel Sales Enterprise on your local database, you must have
administrative privileges.

To configure the Siebel application, create an event table and Siebel business object.

The following steps describe how to create the event store to be used for inbound
operations in the Siebel application. You can substitute all references to Siebel Sales
Enterprise with the name of the Siebel application that you are using.

1. Create a project called IBM, and lock the project with Siebel tools.

2. Using the object wizard, create an event table called CX_IBM_EVENT in
which to store the events.

a. In the event table, create the columns that are shown in the following

table.
Column Name | Type Length Data Type Required Nullable Status
DESCRIPTION | Data (public)  |255 Varchar No Yes Active
EVENT_ID Data (public) |30 Varchar Yes No Active
EVENT_TYPE |Data (public) |20 Varchar Yes No Active
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Column Name | Type Length Data Type Required Nullable Status
OBJECT_KEY |Data (public) |255 Varchar Yes No Active
OBJECT_NAME Data (public) |255 Varchar Yes No Active
PRIORITY Data (public) |10 Varchar No Yes Active
STATUS Data (public) |20 Varchar Yes No Active
XID Data (public) |255 Varchar Yes No Active

b. Create a new business component called IBM Event.

c. Create a new time stamp called Field Event, and map it to the CREATED
column from CX_IBM_EVENT. Make the Type of this field
DTYPE_UTCDATETIME.

. Create a new business object called IBM Event.

e. Associate the IBM event business component to the IBM Event business
object.

Create an applet called IBM Event List Applet, and base it on the IBM
Event business component that you have created.

. Create a view called IBM Event List View, and base it on the IBM Event

business object that you have created.

Create a screen called IBM Event Screen, and associate it with the IBM

Event List View in the Siebel tools.

Create a page tab.

a. Click Start Application » Siebel Sales Enterprise » Page tab.

b. Right-click, then click New Record.

C. Specify IBM Event as the screen name, and IBM Event for the Text - String
Override field.

d. Leave the Inactive field clear.

Create a new business object called Schema Version for your IBM project and

associate it with the Schema Version business component.

a. Apply the physical schema for the new tables to your local database by
querying for the new table, 'CX_IBM_EVENT_Q’ and selecting the current
query to create a physical schema. Leave the table space and index space
blank.

b. Click Activate to activate the new schema.

Add or modify the Siebel VB or e-scripts for the business component that

corresponds to the business objects that are used at your site. Siebel scripts

trigger event notification for business objects. Samples are located in the

Samples Folder in your adapter installation.

Create a new Siebel repository file by compiling the updated and locked

projects on your local database. The new repository file has an extension of

srf.

Open Siebel Sales Enterprise on your local database.

a. Create a new responsibility called IBM Responsibility for IBM Event List

View.

b. Add the employees or teams who are responsible for reviewing events to
the newly created IBM Responsibility.

c. Create a user name called IBMCONN (or another user name to be used by

the adapter later). Add the user name to the newly created IBM
Responsibility and also to the Administrative Responsibility.
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8. Test the application in your local environment to ensure that you have
visibility of the IBM Event List View. An event is generated in the view after
you create a record in the supported object. As part of the test, create a new
Account business component instance in Siebel. Confirm that a new Account
event appears in the IBM Event List View (assuming that you have added the
e-script trigger to the Account business component). If a new Account event
does not appear in the view, check for an error and fix it. For more
information on the errors that might be generated, check either the Siebel
support site or Siebel documentation.

9. When the test that you perform in Step 8 is successful, add your new and
updated projects to your development server.

10. Activate the new table in the development server.
11. Compile a new Siebel repository (.srf) file on the server.
12. Back up the original repository file on the server.

13. Stop the Siebel server and replace the original repository file with the newly
created one.

14. Restart the Siebel server.

Adding external software dependencies for PeopleSoft
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Ensure that you have the relevant prerequisite files for your PeopleSoft system.

PeopleSoft support files
* psjoa.jar
* AJAR file that contains the component interface API classes

Save both support files to a directory such as C:\PeopleSoft_LIB. You can find the
psjoa.jar file in the following location on the PeopleSoft Application Server:
peopleTools_installation_directory\web\PSJOA\psjoa.jar. Use PeopleTools to generate
the component interface JAR file for your business objects.

The sample resources that you need to set up the PeopleSoft system so that it can
communicate with the broker are in install_dir\ResrouceAdapters\
PeopleSoft_6.1.0.0\samples.

Locating the PeopleSoft support files in the run time on Windows

To add the PeopleSoft prerequisite files to the run time, follow the steps below.
1. Ensure that the broker has started.

2. Either open the Command Console, or open a Windows command prompt and
enter mqsiprofile.

3. Enter the following command:
mgsireportproperties WBRK61 DEFAULT BROKER -c Al1Types -o AllReportableEntityNames

The following example shows what typically is displayed when you run this
command:

ReportableEntityName=""
EISProviders

PeopleSoft=""
jarsURL="'default_Path'
nativelLibs='default_Path'

SAP=""
jarsURL="'default_Path'
nativelLibs="'default_Path'

Siebel=""



jarsURL="default_Path'
nativelLibs='default_Path'
Twineball=""
jarsURL="default_Path'
nativelLibs='default_Path'
4. Set the location of the PeopleSoft prerequisite files using the following
command:

mgsichangeproperties WBRK61 DEFAULT BROKER -c EISProviders -o PeopleSoft -n jarsURL -v C:\PeopleSoft_ LIB
5. To check that the values have been set correctly, run the following command:
mgsireportproperties WBRK61 DEFAULT_BROKER -c EISProviders -o PeopleSoft -r

The following example shows what is displayed by the mgsireportproperties
command.
ReportableEntityName=" "
EISProviders
PeopleSoft=" "'
jarsURL="'C:\PeopleSoft LIB'

BIP8071I: Successful command completion.
6. Restart the broker.

Creating a custom event project in PeopleTools

The adapter requires an event project in PeopleSoft in order to perform
asynchronous inbound event processing. Use PeopleTools to create the custom
event project.

If your environment requires inbound event support, you must use a custom event
project in PeopleSoft. A sample event project, IBM_EVENT_V600, is provided with
the adapter. You can modify and use and the sample project, or you can create
your own project using PeopleTools. If you create your own project, make sure that
you complete the steps below.

1. Use PeopleTools Application Designer to create and name a new project.
2. Create the fields for the new project as described in the following table:

Field name Field description

IBM_EVENT_ID A numeric value that is retrieved from
IBM_FETCH_ID record. This value is a
unique ID for the event.

IBM_OBJECT_NAME The name of the corresponding business
graph.
IBM_OBJECT_KEYS The get key property names in the

Component Interface, followed by the key
values in name-value pairs. This information
is used for the component’s retrieval from
the EIS.

IBM_EVENT_STATUS This field is set to 0. If the event is ready to
be polled, the status is set to 0 and the
IBMPublishEvent function is called.

IBM_OBJECT_VERB The verb that is set on the business object
graph that contains the retrieved business
object.

IBM_EVENT_DTTM The date on which the event is created. For
a future dated event, this is the effective
date.
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Field name Field description

IBM_NEXT_EVENT_ID The field that has the latest event ID under
the record IBM_FETCH_ ID. This field is
incremented for each event that is added to
the IBM_EVENT_TBL, and it populates the
IBM_EVENT_ID field within that table.

IBM_XID The transaction ID that is needed to provide

assured event delivery.

3. Create a record named IBM_EVENT_TBL and add to it all the fields that you
have just created.

4. Create a record named IBM_FETCH_ID and add to it only the
IBM_NEXT_EVENT_ID field.

5. Open the IBM_FETCH_ID record, select the IBM_NEXT_EVENT_ID field,
view the PeopleCode, and select fieldformula.

6. Copy the PeopleCode for a custom event project from [“PeopleCode for a|
[custom event project” on page 1175|to the project that you are creating.

7. Create a page under your project that contains the fields of the
IBM_EVENT_TBL record at level 0. The page can have any name.

8. Create a component under your project that contains the page that you have
just created. The component can have any name.

9. Create a Component Interface against this component and give it any name.
Confirm that you want to default the properties that are based on the
underlying component definition.

10. Build the entire project, selecting all create options.

11. Test and confirm that the Component Interface works, using the Component
Interface tester.

12. Generate the Java APIs for the Component Interface, then add the generated
classes to the adapter classpath. For complete information about building a
PeopleTools project and testing the PeopleSoft Component Interface, refer to
PeopleSoft documentation.

Connecting to an EIS using the Adapter Connection wizard
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Use the Adapter Connection wizard to create the resources that are needed by the
WebSphere Adapters, and connect to an Enterprise Information System (EIS).

Before you start:

+ Read [“WebSphere Adapters nodes” on page 7|

* |Prepare the environment for WebSphere Adapters nodes|

* Perform the preparatory tasks listed in [“Developing message flow applications|
[using WebSphere Adapters” on page 235

A message flow application that uses one of the WebSphere Adapters requires the

following resources:

* One or more message flows that contain one or more WebSphere Adapters
nodes

* A message set that contains the XML Schema Definitions (XSD) for the business
objects in the Enterprise Information System (EIS)

* An adapter component file for the WebSphere Adapter that is being used

The Adapter Connection wizard creates these resources automatically. Before you
run the wizard, you need to gather the following information from the EIS.




* SAP
— SAP system user name
— SAP system password
— SAP host name or IP address
— SAP Client ID (for example, 001)
— SAP system number (for example, 00)
- Language code (for example, EN)

For more information, see [“SAP connection properties for the Adapter|
[Connection wizard” on page 1106/

e Siebel

— Siebel user name

— Siebel password
— Siebel host name or IP address

- Language code

For more information, see [“Siebel connection properties for the Adapter|
[Connection wizard” on page 1156,

* PeopleSoft

— PeopleSoft user name

— PeopleSoft password

— PeopleSoft host name or IP address
— Port number (for example, 9000)

— Language code (for example, ENG)

For more information, see [“PeopleSoft connection properties for the Adapter]
[Connection wizard” on page 1179,

The following steps describe how to connect to an EIS.

1. Switch to the Broker Application Development perspective.

2. Click File » New » Adapter Connection. The Adapter Connection wizard
opens.

3. Follow the instructions in the wizard. To see a description of each field within
the wizard, hover the mouse over the field.

Ensure that inbound and outbound SAP IDocs have different names if they are
stored in the same message set. For more information, see|An error is issued|
when you use the message set that is generated by the Adapter Connection|
wizard

When you have completed the steps in the wizard, the specified message set
project contains a message set with a message type for each business object, and
the specified message flow project references the message set project.

To continue, configure the WebSphere Adapters nodes. For more information, see
[‘Configuring a message flow node” on page 225

Developing ESQL

When you use the built-in nodes Compute, Database, and Filter, you must
customize them to determine the exact processing that they provide. To do this,
you must create, for each node, an ESQL module in which you code the ESQL
statements and functions to tailor the behavior of the node, referring to message
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content, or database content, or both, to achieve the results that you require. ESQL
modules are maintained in ESQL files, managed through the Broker Application
Development perspective.

This section provides information on:
+ ["ESQL overview”|

+ ["Managing ESQL files” on page 256|
* [“Writing ESQL” on page 268

You can use the ESQL debugger, which is part of the flow debugger, to debug the
code that you write. The debugger steps through ESQL code statement by
statement, so that you can view and check the results of every line of code that is
executed.

Note: In previous releases there were several types of debugger, each of which
handled a specific type of code, such as ESQL, message flows, or Java. In
Version 6, these are integrated into a single debugger, which is known
simply as “the debugger”, and which handles all types of code.

ESQL overview
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Extended Structured Query Language (ESQL) is a programming language defined
by WebSphere Message Broker to define and manipulate data within a message
flow.

This section contains introductory information about ESQL.
* For descriptions of ESQL user tasks, see [“Writing ESQL” on page 268

* For reference information about ESQL, see [“ESQL reference” on page 1309

Read the following information before you proceed:

* An overview of message flows, see [“Message flows overview” on page 4

* An overview of message trees, see [‘The message tree” on page 49)and the
toi ics within this container, paying special attention to [‘Logical tree structure”|

ESQL is based on Structured Query Language (SQL) which is in common usage
with relational databases such as DB2. ESQL extends the constructs of the SQL
language to provide support for you to work with message and database content
to define the behavior of nodes in a message flow.

The ESQL code that you create to customize nodes within a message flow is
defined in an ESQL file, typically named <message_flow_name>.esql,, which is
associated with the message flow project. You can use ESQL in the following
built-in nodes:

+ [“Compute node” on page 779

+ |[“Database node” on page 787

* |“Filter node” on page 851|

You can also use ESQL to create functions and procedures that you can use in the
following built-in nodes:

+ ["“DataDelete node” on page 807

+ [“Datalnsert node” on page 810

* ["DataUpdate node” on page 813|

+ [“Extract node” on page 826|

+ ["Mapping node” on page 914|




+ [“Warehouse node” on page 1085|

To use ESQL correctly and efficiently in your message flows, you must also
understand the following concepts:

¢ |Data types

* |Variables

+ [Field references|

Use the ESQL debugger, which is part of the flow debugger, to debug the code that
you write. The debugger steps through ESQL code statement by statement, so that
you can view and check the results of every line of code that is executed.

Note: In previous releases there were several types of debugger, each of which
handled a specific type of code, such as ESQL, message flows, or Java. In
Version 6, these separate debuggers are integrated into a single debugger,
which is known simply as “the debugger”, and which handles all types of
code.

ESQL data types

A data type defines the characteristics of an item of data, and determines how that
data is processed. ESQL supports six data types, listed below. Data that is retrieved
from databases, received in a self-defining message, or defined in a message model
(using MRM data types), is mapped to one of these basic ESQL types when it is
processed in ESQL expressions.

Within a broker, the fields of a message contain data that has a definite data type.
It is also possible to use intermediate variables to help process a message. You
must declare all such variables with a data type before use. A variable’s data type
is fixed; If you try to assign values of a different type you get either an implicit
cast or an exception. Message fields do not have a fixed data type, and you can
assign values of a different type. The field adopts the new value and type.

It is not always possible to predict the data type that results from evaluating an
expression. This is because expressions are compiled without reference to any kind

of message schema, and so some type errors are not caught until runtime.

ESQL defines the following categories of data. Each category contains one or more

ESQL variables
An ESQL variable is a data field used to help process a message.

You must declare a variable and state its type before you can use it. A variable’s
data type is fixed; if you code ESQL that assigns a value of a different type, either
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an implicit cast to the data type of the target is implemented or an exception is
raised (if the implicit cast is not supported).

To define a variable and give it a name, use the DECLARE statement.

Note: The names of ESQL variables are case sensitive, so it is important to make
sure that you use the correct case in all places. The simplest way to
guarantee this is always to define variables using upper case names.

The Message Broker Toolkit flags, with warning markers, variables that have not

been defined. It is best practice to remove all these warnings before deploying a

message flow.

You can assign an initial value to the variable on the DECLARE statement. If an
initial value isn’t specified, scalar variables are initialized with the special value
NULL, while ROW variables are initialized to an empty state. Subsequently, you
can change the variable’s value using the SET statement.

There are three types of built-in node that can contain ESQL code and hence
support the use of ESQL variables:

+ |“Compute node” on page 779

+ ["Database node” on page 787

« |“Filter node” on page 851

Variable scope, lifetime, and sharing

How widespread and for how long a particular ESQL variable is available, is
described by its scope, lifetime, and sharing:

A variable’s scope is a measure of the range over which it is visible. In the broker
environment, the scope of variables is normally limited to the individual node.

A variable’s lifetime is a measure of the time for which it retains its value. In the
broker environment, the lifetime of a variable varies but is typically restricted to
the life of a thread within a node.

A variable’s sharing characteristics indicate whether each thread has its own copy
of the variable or whether one variable is shared between many threads. In the

broker environment, variables are typically not shared.

Types of variable

You can use the ['DECLARE statement” on page 1382| to define three types of
variable:

External
External variables (defined with the EXTERNAL keyword) are also known as
user-defined properties (see [“User-defined properties in ESQL” on page 249).
They exist for the entire lifetime of a message flow and are visible to all
messages passing through the flow. You can define external variables only at
the module and schema level. You can modify their initial values (optionally
set by the DECLARE statement) at design time, using the Message Flow editor,
or at deployment time, using the BAR editor. You cannot later modify their
values using ESQL.

Normal
“Normal” variables have a lifetime of just one message passing through a
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node. They are visible to that message only. To define a “normal” variable,
omit both the EXTERNAL and SHARED keywords.

Shared
Shared variables can be used to implement an in-memory cache in the message
flow (see [“Optimizing message flow response times” on page 149). Shared
variables have a long lifetime and are visible to multiple messages passing
through a flow (see [‘Long-lived variables” on page 250). They exist for the
lifetime of the execution group process, the lifetime of the flow or node, or the
lifetime of the node’s SQL that declares the variable (whichever is the shortest).
They are initialized when the first message passes through the flow or node
after each broker startup.

See also the ATOMIC option of the [“BEGIN ... END statement” on page 1339
The BEGIN ATOMIC construct is useful when a number of changes need to be
made to a shared variable and it is important to prevent other instances seeing
the intermediate states of the data.

For information about specific types of variable, see:
+ [“User-defined properties in ESQL”| (external variables)
+ [“Long-lived variables” on page 250| (shared variables)

User-defined properties in ESQL: A user-defined property (UDP) is a variable
that is defined in your ESQL program by specifying the EXTERNAL keyword on a
['DECLARE statement” on page 1382 For example, the ESQL statement DECLARE
today EXTERNAL CHARACTER 'monday' defines a user-defined property called today
with an initial value ‘'monday’.

Before you can use a user-defined property, you must also define the property
when you construct a message flow that uses it. Use the [Message Flow editor] to
do this.

When you define a UDP using the Message Flow editor, a value and property type
is also defined. The value might be a default value, which varies according to the
UDP’s type. The value assigned to the UDP in the Message Flow editor takes
precedence over any value that you have assigned to the UDP in your ESQL
program.

Before you deploy the message flow that uses the UDP, you can change the value
of the UDP by using the [Broker Archive editor] A deployment failure occurs if you
try to deploy a message flow that contains a UDP that has had no value assigned
to it.

See [“Configuring a message flow at deployment time using UDPs” on page 395| for
more information.

Using UDPs, configuration data can be set easily and used just like normal
constants. Because no external calls to user-written plug-ins or parsing of
environment trees are involved, the ESQL code is easier to write and maintain, and
performs better. Also, the parsing costs of reading data out of trees are removed.
The value of the UDP is stamped into the variable at deployment time, which
makes it quick to access.

You can declare UDPs only in modules or schemas.

UDPs can be accessed by any built-in node that uses ESQL:
e Compute
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* Database

* Filter

* Nodes derived from these node-types, for example Datalnsert, DataDelete, and
DataUpdate.

See |“Accessing user-defined properties from a JavaCompute node” on page 423| for
a description of how to access a UDP from a JavaCompute node.

Long-lived variables:

You can use appropriate long-lived ESQL data types to provide an in-memory
cache of the data for a certain period of time.

It is sometimes desirable to store data for longer than the lifetime of a single
message passing through a flow. One way to do this, is to store the data in a
database. Using a database is good for long-term persistence and transactionality,
but access (particularly write access) is slow.

Alternatively, you can use appropriate long-lived ESQL data types to provide an
in-memory cache of the data for a certain period of time. Using long-lived ESQL
data types makes access faster than from a database, though this is at the expense
of shorter persistence and no transactionality.

Long-lifetime variables are created by using the SHARED keyword on the
DECLARE statement. For further information see ["DECLARE statement” on page

1382.

The following sample demonstrates how to define shared variables using the
DECLARE statement. The sample demonstrates how to store routing information
in a database table and use shared variables to store the database table in memory
in the message flow to improve performance.

* [Message Routing sample]

You can view samples only when you use the information center that is integrated
with the Message Broker Toolkit.

Long-lived data types have an extended lifetime beyond that of a single message
passing through a node. Long-lived data types are shared between threads and
exist for the life of a message flow (strictly speaking the time between
configuration changes to a message flow), as described in this table:

| Scope | Life Shared
Short lifetime variables
Schema & Module Node Thread within Not at all
node
Routine Local Node Thread within Not at all
routine
Block Local Node Thread within Not at all
block
Long lifetime variables
Node Shared Node Life of node All threads of flow
Flow Shared Flow Life of flow All threads of flow



/help/livehelp/?pluginID=com.ibm.samplegallery&class=com.ibm.samplegallery.SampleGalleryAction&arg=com.ibm.etools.mft.samples.routing.doc/doc/overview.htm

Features of long-lived ESQL data types include:
* The ability to handle large amounts of long-lifetime data.
* The joining of data to messages is fast.

¢ On multiple processor machines, multiple threads are able to access the same
data simultaneously.

* Subsequent messages can access the data left by a previous message.

* Long lifetime read-write data can be shared between threads, because there is no
long term association between threads and messages.

* In contrast to data stored in database tables in the environment, this type of data
is stored privately; that is, within the broker.

¢ The use of ROW variables can be used to create a modifiable copy of the input
message. See |'ESQL ROW data type” on page 1311

* It is possible to create shared constants.

A typical use of these data types might be in a flow in which data tables are
‘read-only’ as far as the flow is concerned. Although the table data is not actually
static, the flow does not change it, and thousands of messages pass through the
flow before there is any change to the table data.

An example is a table which contains a day’s credit card transactions. The table is
created each day and that day’s messages are run against it. Then the flow is
stopped, the table updated and the next day’s messages run. These flows might
perform better if they cache the table data rather than read it from a database for
each message.

Another use of these data types might be the accumulation and integration of data
from multiple messages.

Broker properties

For each broker, WebSphere Message Broker maintains a set of properties. You can
access some of these properties from your ESQL programs. A subset of the
properties is also accessible from Java code. It can be useful, during the runtime of
your code, to have real-time access to details of a specific node, flow, or broker.

Four categories of broker properties exist.

* Properties relating to a specific node

* Properties relating to nodes in general

* Properties relating to a message flow

* Properties relating to the execution group

For a description of the broker, flow, and node properties that are accessible from
ESQL and Java, see [“Broker properties that are accessible from ESQL and Java” on|

Broker properties have the following characteristics.

* They are grouped by broker, execution group, flow, and node.
* They are case sensitive. Their names always start with an uppercase letter.

* They return NULL if they do not contain a value.
All nodes that allow user programs to edit ESQL support access to broker

properties. These nodes are:
* Compute nodes
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¢ Database nodes
 Filter nodes
e All derivatives of these nodes

A complex property is a property to which you can assign multiple values. Complex
properties are displayed in a table in the Properties view, where you can add, edit,
and delete values, and change the order of the values in the table. You cannot
promote complex properties, so they do not appear in the Promote properties
dialog box; nor can you configure complex properties, so they are not supported in
the Broker Archive editor. For an example of a complex property, see the Query
elements property of the DatabaseRoute node.

For more information about editing a node’s properties, see [“Configuring a

[message flow node” on page 225

ESQL field references

An ESQL field reference is a sequence of period-separated values that identify a
specific field (which might be a structure) within a message tree or a database
table. The path from the root of the information to the specific field is traced using
the parent/child relationships.

A field reference is used in an ESQL statement to identify the field that is to be
referenced, updated, or created within the message or database table. For example,
you might use the following identifier as a message field reference:

Body.Invoice.Payment

You can use an ESQL variable of type REFERENCE to set up a dynamic pointer to
contain a field reference. This might be useful in creating a fixed reference to a
commonly-referenced point within a message; for example the start of a particular
structure that contains repeating fields.

A field reference can also specify element types, XML namespace identifications,
indexes and a type constraint. These are discussed in detail later.

The first name in a field reference is sometimes known as a Correlation name.

ESQL operators
An ESQL operator is a character or symbol that you can use in expressions to
specify relationships between fields or values.

ESQL supports the following groups of operators:

¢ Comparison operators, to compare one value to another value (for example, less
than). Refer to [“ESQL simple comparison operators” on page 1330| for details of
the supported operators and their use.

* Logical operators, to perform logical operations on one or two terms (for
example, AND). Refer to ["ESQL logical operators” on page 1334 for details of
the supported operators and their use.

* Numeric operators, to indicate operations on numeric data (for example, +).
Refer to [“ESQL numeric operators” on page 1335| for details of the supported
operators and their use.

There are some restrictions on the application of some operators to data types; not
all lead to a meaningful operation. These are documented where they apply to
each operator.



Operators that return a Boolean value (TRUE or FALSE), for example the greater
than operator, are also known as predicates.

ESQL statements

An ESQL statement is an instruction that represents a step in a sequence of actions
or a set of declarations.

ESQL provides a large number of different statements that perform different types
of operation. All ESQL statements start with a keyword that identifies the type of
statement and end with a semicolon. An ESQL program consists of a number of
statements that are processed in the order they are written.

As an example, consider the following ESQL program:

DECLARE x INTEGER;
SET x = 42;

This program consists of two statements. The first starts with the keyword
DECLARE and ends at the first semicolon. The second statement starts with the
keyword SET and ends at the second semicolon. These two statements are written
on separate lines and it is conventional (but not required) that they be so. You will
notice that the language keywords are written in capital letters. This is also the
convention but is not required; mixed and lower case are acceptable.

The first statement declares a variable called x of type INTEGER, that is, it reserves
a space in the computer’s memory large enough to hold an integer value and
allows this space to be subsequently referred to in the program by the name x. The
second statement sets the value of the variable x to 42. A number appearing in an
ESQL program without decimal point and not within quotes is known as an
integer literal.

ESQL has a number of data types and each has its own way of writing literal
values. These are described in ["ESQL data types” on page 247

For a full description of all the ESQL statements, see [“ESQL statements” on page]

ESQL nested statements: An ESQL nested statement is a statement that is
contained within another statement.

Consider the following ESQL program fragment:

IF Size> 100.00 THEN

SET X = 03

SET Y = 03

SET REVERSE = FALSE;
ELSE

SET X = 639;

SET Y = 479;

SET REVERSE = TRUE;
END IF;

In this example, you can see a single IF statement containing the optional ELSE
clause. Both the IF and ELSE portions contain three nested statements. Those
within the IF clause are executed if the operator> (greater than) returns the value
TRUE (that is, if Size has a value greater than 100.00); otherwise, those within the
ELSE clause are processed.
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Many statements can have expressions nested within them, but only a few can
have statements nested within them. The key difference between an expression and
a statement is that an expression calculates a value to be used, whereas a statement
performs an action (usually changing the state of the program) but does not
produce a value.

ESQL functions

A function is an ESQL construct that calculates a value from a number of given
input values.

A function usually has input parameters and can, but does not usually have,
output parameters. It returns a value calculated by the algorithm described by its
statement. This statement is usually a compound statement, such as BEGIN... END,
because this allows an unlimited number of nested statements to be used to
implement the algorithm.

ESQL provides a number of predefined, or “built-in”, functions which you can use
freely within expressions. You can also use the CREATE FUNCTION statement to
define your own functions.

When you define a function, you must give it a unique name. The name is
handled in a case insensitive way (that is, use of the name with any combination
of upper and lower case letters matches the declaration). This is in contrast to the
names that you declare for schemas, constants, variables, and labels, which are
handled in a case sensitive way, and which you must specify exactly as you
declared them.

Consider the following ESQL program fragment:
SET Diameter = SQRT(Area / 3.142) =* 2;

In this example, the function SQRT (square root) is given the value inside the
brackets (itself the result of an expression, a divide operation) and its result is used
in a further expression, a multiply operation. Its return value is assigned to the
variable Diameter. See [‘Calling ESQL functions” on page 1423 for information
about all the built-in ESQL functions.

In addition, an ESQL expression can refer to a function in another broker schema
(that is, a function defined by a CREATE FUNCTION statement in an ESQL file in
the same or in a different dependent project). To resolve the name of the called
function, you must do one of the following:

* Specify the fully-qualified name (<SchemaName>.<FunctionName>) of the called
function.

* Include a PATH statement to make all functions from the named schema visible.
Note that this technique only works if the schemas do not contain
identically-named functions. The PATH statement must be coded in the same
ESQL file, but not within any MODULE.

Note that you cannot define a function within an EVAL statement or an EVAL
function.

ESQL procedures
An procedure is a subroutine that has no return value. It can accept input
parameters from, and return output parameters to, the caller.



Procedures are very similar to functions. The main difference between them is that,
unlike functions, procedures have no return value. Thus they cannot form part of
an expression and are invoked by using the CALL statement. Procedures
commonly have output parameters

You can implement a procedure in ESQL (an internal procedure) or as a database
stored procedure (an external procedure). The ESQL procedure must be a single
ESQL statement, although that statement can be a compound statement such as
BEGIN END. You cannot define a procedure within an EVAL statement or an
EVAL function.

When you define a procedure, give it a name. The name is handled in a case
insensitive way (that is, use of the name with any combination of upper and lower
case letters matches the declaration). That is in contrast to the names that you
declare for schemas, constants, variables, and labels, which are handled in a case
sensitive way, and which you must specify exactly as you declared them.

An ESQL expression can include a reference to a procedure in another broker
schema (defined in an ESQL file in the same or a different dependent project). If
you want to use this technique, either fully qualify the procedure, or include a
PATH statement that sets the qualifier. The PATH statement must be coded in the
same ESQL file, but not within a MODULE.

An external database procedure is indicated by the keyword EXTERNAL and the
external procedure name. This procedure must be defined in the database and in
the broker, and the name specified with the EXTERNAL keyword and the name of
the stored database procedure must be the same, although parameter names do not
have to match. The ESQL procedure name can be different to the external name it
defines.

Overloaded procedures are not supported to any database. (An overloaded
procedure is one that has the same name as another procedure in the same
database schema which has a different number of parameters, or parameters with
different types.) If the broker detects that a procedure has been overloaded, it
raises an exception.

Dynamic schema name resolution for stored procedures is supported; when you
define the procedure you must specify a wildcard for the schema that is resolved
before invocation of the procedure by ESQL. This is explained further in
[stored procedures” on page 319

ESQL modules

A module is a sequence of declarations that define variables and their initialization,
and a sequence of subroutine (function and procedure) declarations that define a
specific behavior for a message flow node.

A module must begin with the CREATE node_type MODULE statement and end with
an END MODULE statement. The node_type must be one of COMPUTE, DATABASE,
or FILTER. The entry point of the ESQL code is the function named MAIN, which
has MODULE scope.

Each module is identified by a name which follows CREATE node_type MODULE. The
name might be created for you with a default value, which you can modify, or you
can create it yourself. The name is handled in a case insensitive way (that is, use of
the name with any combination of upper and lower case letters matches the
declaration). That is in contrast to the names that you declare for schemas,
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constants, variables, and labels, which are handled in a case sensitive way, and
which you must specify exactly as you declared them.

You must create the code for a module in an ESQL file which has a suffix of .esql.
You must create this file in the same broker schema as the node that references it.
There must be one module of the correct type for each corresponding node, and it
is specific to that node and cannot be used by any other node.

When you create an ESQL file (or complete a task that creates one), you indicate
the message flow project and broker schema with which the file is associated as
well as specifying the name for the file.

Within the ESQL file, the name of each module is determined by the value of the
corresponding property of the message flow node. For example, the property ESQL
Module for the Compute node specifies the name of the node’s module in the ESQL
file. The default value for this property is the name of the node. You can specify a
different name, but you must ensure that the value of the property and the name
of the module that provides the required function are the same.

The module must contain the function MAIN, which is the entry point for the
module. This is included automatically if the module is created for you. Within
MAIN, you can code ESQL to configure the behavior of the node. If you include
ESQL within the module that declares variables, constants, functions, and
procedures, these are of local scope only and can be used within this single
module.

If you want to reuse ESQL constants, functions, or procedures, you must declare
them at broker schema level. You can then refer to these from any resource within
that broker schema, in the same or another project. If you want to use this
technique, either fully qualify the procedure, or include a PATH statement that sets
the qualifier. The PATH statement must be coded in the same ESQL file, but not
within any MODULE.

Managing ESQL files
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Within a message flow project, you can create ESQL files to contain the ESQL code
that you provide to modify or customize the behavior of Compute, Database, or
Filter nodes.

The ESQL code is contained within a module that is associated with the node.
Each module must be created within an ESQL file. The name of the module within
the ESQL file must match the name specified for the module in the ESQL Module
property of the corresponding node. Although you can modify the module name,
and change it from its default value (which is the name of the message flow,
concatenated with the name of the node with which the module is associated),
ensure that the module in the ESQL file matches the node property.

The following topics describe how you can manage these files:
+ [“Creating an ESQL file” on page 257

* [“Opening an existing ESQL file” on page 258

+ [“Creating ESQL for a node” on page 259

+ ["“Modifying ESQL for a node” on page 261]

* [“Saving an ESQL file” on page 262|

+ [“Copying an ESQL file” on page 263

+ ["Renaming an ESQL file” on page 264

* ["Moving an ESQL file” on page 265|




+ |“Changing ESQL preferences” on page 265|
* |“Deleting ESQL for a node” on page 267
* [“Deleting an ESQL file” on page 267]

Creating an ESQL file

When you include a node in your message flow that requires ESQL to customize
its function (the Compute, Database, and Filter nodes), you must code the ESQL
statements that provide the customization in an ESQL module within an ESQL file.
You can use the same ESQL file for more than one module, if you choose.

Before you start

To complete this task, you must have completed the following task:
+ [“Creating a message flow project” on page 205|

ESQL files are stored in a file system or in a shared repository. If you are using a
file system, this can be the local file system or a shared drive. If you store files in a
repository, you can use any of the available repositories that are supported by
Eclipse, for example CVS.

To create an ESQL file:
1. Switch to the Broker Application Development perspective.
2. Click File » New » Message Flow ESQL File.

You can also press Ctrl+N. This displays a dialog box that allows you to select
the wizard to create a new object. Click Message Brokers in the left view; the
right view displays a list of objects that you can create for WebSphere Message
Broker. Click Message Flow ESQL File in the right view, then click Next. The
New Message Flow ESQL File wizard is displayed.

3. Enter the name of the message flow project in which to create the ESQL file.
You must enter the name of an existing message flow project. The dialog box is
displayed with the current project name entered in the project name field. You
can accept this value or change it to specify a different project. You can also
click Browse to view a list of valid projects (projects that are defined and
displayed in the Navigator view), and select the appropriate value from that
list.

If you type in the name of a project that does not exist, the error message The
specified project does not exist is displayed in the dialog box and you
cannot continue until you specify a valid project name.

4. If you want the ESQL file to be defined within a specific broker schema, enter
the name of the broker schema in the appropriate entry field, or click Browse
to select the broker schema from the list of valid broker schema for this project.
(If only the default broker schema is defined in this project, Browse is
disabled.)

5. Enter a name for the new ESQL file. If you enter a name that is already in use
for an ESQL file in this project, the error message The resource <name>.esq]
already exists is displayed in the dialog box and you cannot continue until
you specify a valid name.

When creating ESQL files, the overall file path length must not exceed 256
characters, due to a Windows file system limitation. If you try to add a
message flow to a broker archive file with ESQL or mapping files with a path
length that exceeds 256 characters, the compiled message flow will not be
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generated and cannot be deployed. Therefore, make sure that the names of
your ESQL files, mapping files, projects, and broker schema are as short as
possible.

An ESQL file can also be created automatically for you. If you select Open ESQL
from the menu displayed when you right-click a Compute, Database, or Filter
node, and the module identified by the appropriate property does not already exist
within the broker schema, a module is automatically created for you. This is
created in the file <message_flow_name>.esql in the same broker schema within
the same project as the <message_flow_name>.msgflow file. If that ESQL file does
not already exist, that is also created for you.

The contents of a single ESQL file do not have any specific relationship with
message flows and nodes. It is your decision which modules are created in which
files (unless the specified module, identified by the appropriate property, is created
by default in the file <message_flow_name>.esql as described above). Monitor the
size and complexity of the ESQL within each file, and split the file if it becomes
difficult to view or manage.

If you create reusable subroutines (at broker schema level) within an ESQL file,
you might want to refer to these routines from ESQL modules in another project.
To do this, specify that the project that wants to invoke the subroutines depends
on the project in which the ESQL file containing them is defined. You can specify
this when you create the second project, or you can update project dependencies
by selecting the project, clicking Properties, and updating the dependencies in the
Project Reference page of the Properties dialog box.

Opening an existing ESQL file

You can add to and modify ESQL code that you have created in an ESQL file in a
message flow project.

Before you start

To complete this task, you must have completed the following task:
+ [“Creating an ESQL file” on page 257|

To open an existing ESQL file:
1. Switch to the Broker Application Development perspective.

2. In the Broker Development view, double-click the ESQL file that you want to
open. The file is opened in the editor view.

3. Work with the contents of file to make your changes. The file can contain
modules relating to specific nodes in a message flow, PATH statements, and
declarations at broker schema level such as reusable constants and procedures.
Scroll through the file to find the specific content that you want to work with.

4. You can select the content that you want to work with by selecting its name in
the Outline view. The code for the selected resource is highlighted.

You can also open an ESQL file when you have a message flow open in the editor
view by selecting an appropriate node (of type Compute, Database, or Filter),
right-clicking, and selecting Open ESQL. In this case, the ESQL file that contains
this module is opened, and the module for the selected node is highlighted in the
editor view.



Creating ESQL for a node
Create ESQL to customize the behavior of a Compute, Database, or Filter node
within an ESQL file.

Before you start

Complete the following task:
* [“Creating an ESQL file” on page 257

Within the ESQL file, create a module that is associated with a node in your
message flow. A module can be associated with only one node of a particular type
(Compute, Database, or Filter). Within the module you can create and use
functions and procedures as well as the supplied statements and functions. You
can also create local constants and variables.

If you have created constants, functions, or procedures at the broker schema level,
you can also refer to these within the module. You can define routines at a level at
which many different modules can use them, which can save you development
time and maintenance effort.

To create ESQL for a node:
1. Switch to the Broker Application Development perspective.

2. In the Broker Development view, double-click the message flow that includes
the node for which you want to create ESQL. The message flow opens in the
editor view.

3. Right-click the node (which must be Compute, Database, or Filter) and then
click Open ESQL. The default ESQL file for this message flow,
message_flow_name.esql, is opened in the editor view. The file is created if it
does not already exist.

If you have already created the file, it is opened in the editor view and a new
module is created and highlighted. If the file is created for you, it contains a
skeleton module for this node at the end. Its exact content depends on the type
of node.

The following module is created for a Compute node:

CREATE COMPUTE MODULE module_name
CREATE FUNCTION Main() RETURNS BOOLEAN
BEGIN
-- CALL CopyMessageHeaders();
-- CALL CopyEntireMessage();
RETURN TRUE;

END;

CREATE PROCEDURE CopyMessageHeaders() BEGIN
DECLARE I INTEGER 1;
DECLARE J INTEGER CARDINALITY(InputRoot.*[]);
WHILE I < J DO
SET OutputRoot.*[I] = InputRoot.*[I];
SET I =1+ 1;
END WHILE;
END;

CREATE PROCEDURE CopyEntireMessage() BEGIN
SET QutputRoot = InputRoot;
END;
END MODULE;
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The module name is determined by the value that you have set for the
corresponding node property. The default is message_flow_name_node_type. The
Main function contains calls to two procedures, described below, that are
declared within the Compute node module following the function Main. These
calls are commented out. If you want to include the function that they provide,
uncomment the lines and place them at the appropriate point in the ESQL that
you create for Main.

CopyMessageHeaders
This procedure loops through the headers contained in the input
message and copies each one to the output message.

CopyEntireMessage
This procedure copies the entire contents of the input message,
including the headers, to the output message.

If you create an ESQL module for a Database node, the following module is
created:

CREATE DATABASE MODULE module name

CREATE FUNCTION Main() RETURNS BOOLEAN
BEGIN

RETURN TRUE;
END;

END MODULE;

For a Filter node, the module is identical to that created for the Database node
except for the first line, which reads:

CREATE FILTER MODULE module_name

4.

Add ESQL to this file to customize the behavior of the node.

Start by adding ESQL statements within the Main function, that is after the
BEGIN statement, and before RETURN TRUE. You can add DECLARE
statements within the module that are not within the Main function. To add a
new line into the file, press Enter.

To help you to code valid ESQL, the editor displays a list of valid statements
and functions at the point of the cursor. To invoke this assistance, click Edit »
Content Assist. On some systems, you can use the key combination Ctrl+Space.
Scroll through the list displayed to find and highlight the one that you want,
and press Enter. The appropriate code is inserted into your module, and the list
disappears.

Content assistance is provided in the following areas:
* Applicable keywords, based on language syntax.
* Blocks of code that go together, such as BEGIN END;.

¢ Constants that you have defined, identifiers, labels, functions, and
procedures that can be used, where the routines can be in any projects, even
if the current project does not reference them.

e Database schema and table names after the database correlation name, as
well as table column names in INSERT, UPDATE, DELETE, and SELECT
statements, and, in most cases, the WHERE clauses of those statements.

* Elements of message field reference: runtime domain (parser) names, format
of type expression, namespace identifiers, namespace-qualified element and
attribute names, and format of index expression.

* Content in the Properties folder under the output message root.



¢ For the DECLARE NAMESPACE statement, target namespaces of message
sets and schema names.

Content assistance works only if the ESQL can be parsed correctly. Errors such
as END missing after BEGIN, and other unterminated block statements, cause
parser failures and no content assistance is provided. Try content assistance in
other areas around the statement where it does not work to narrow down the
point of error. Alternatively, save the ESQL file; saving the file causes validation
and all syntax errors are written to the Tasks view. Refer to the errors reported
to understand and correct the ESQL syntax. If you use content assistance to
generate most statements (such as block statements), these are correctly entered
and there is less opportunity for error.

5. When you have finished working with this module, you can close the ESQL
file. Save the file before you close it to retain all your changes and validate
your ESQL.

If you prefer, you can open the ESQL file directly and create the module within
that file using the editor. To do this:

1. Switch to the Broker Application Development perspective.

2. Select the ESQL file in which you want to create the module. Either
double-click to open this file in the editor view, or right-click and click Open.

3. In the editor view, position your cursor on a new line and use content
assistance to select the appropriate module skeleton for this type of node, for
example CREATE COMPUTE MODULE END MODULE;. You can type this in yourself if
you prefer, but you must ensure that what you type is consistent with the
required skeleton, shown above. Use content assistance to give you additional
help by inserting only valid ESQL, and by inserting matching end statements
(for example, END MODULE;) where these are required.

4. Complete the coding of the module as appropriate.

Whichever method you use to open the ESQL file, be aware that the editor
provides functions to help you to code ESQL. This section refers to content
assistance; other functions are available. For information about these functions, see

SQL editor
Modifying ESQL for a node
If you want to change the customization of a node that requires ESQL (Compute,
Database, or Filter), you can modify the ESQL statements within the module that
you created for that node.

Before you start

To complete this task, you must have completed the following task:
* [“Creating ESQL for a node” on page 259

To modify ESQL code:
1. Switch to the Broker Application Development perspective.

2. In the Broker Development view, select the message flow that you want to
work with and double-click it. The message flow is opened in the editor view.

3. Right-click the node corresponding to the ESQL module that you want to
modify and click Open ESQL. The ESQL file is opened in the editor view. The
module for this node is highlighted.

4. Make the changes that you want in the module, by entering new statements
(remember that you can use Content Assist, available from the Edit menu or, on
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some systems, by pressing Ctrl+Space), changing existing statements by
overtyping, or deleting statements using the Delete or backspace keys. Note
that, to get Content Assist to work with message references, you must set up a
project reference from the project containing the ESQL to the project containing
the message set. For information about setting up a project reference, see
[Project references]

5. You can change the name of the module that you are working with, by
over-typing the current name with the new one. Remember that, if you do that,
you must also change the node property ESQL Module to reflect the new name
to ensure that the correct ESQL code is deployed with the node.

6. When you have finished working with this module, you can close the ESQL
file. Save the file before you close it to retain all your changes and validate
your ESQL.

If you prefer, you can open the ESQL file directly by double-clicking it in the
Broker Development view. You can select the module that you want to work with
from the Outline view.

The editor provides functions that you can use to help you modify your ESQL

code. These functions are described in [ESQL edito

You can also modify the ESQL source by selecting Source » Format. This option
formats all selected lines of code (unless only partially selected, when they are
ignored), or, if no lines are selected, formats the entire file (correcting alignments
and indentation).

Adding comments to ESQL:

You can add comments to and remove comments from your ESQL code:

1. To change an existing line of code into a comment line, click Source -
Comment.

2. To change a comment line to a code line, click Source » Uncomment.

3. To create a new comment line, press Enter to create a new line and either type
the comment identifier -- or click Source » Comment. You can enter any text
after the identifier: everything you type is ignored by the ESQL editor.

Saving an ESQL file

When you edit your ESQL file, you can save it both to preserve the additions and
modifications that you have made and to force the editor to validate the file’s
content.

Before you start

To complete this task, you must have completed the following task:
+ [“Creating an ESQL file” on page 257|

To save an ESQL file:

1. Switch to the Broker Application Development perspective.
2. Create a new ESQL file or open an existing ESQL file.

3. Make the changes to the contents of the ESQL file.
4

. When you have finished working, save the file to retain all your changes by
clicking File » Save <filename>.esql or File » Save All (the menu always
shows the current filename correctly).



When you save the file, the validator is invoked by the editor to check that the
ESQL obeys all grammar and syntax rules (specified by the syntax diagrams
and explanations in [“ESQL reference” on page 1309).

You can request additional validation when you set ESQL preferences. Click
Window - Preferences. The Preferences dialog is displayed:

Expand the item for ESQL and Mapping on the left and click Validation. You
can choose a value of warning (the default), error, or ignore for the following
four categories of error:

a. Unresolved identifiers

b. Message references do not match message definitions
c. Database references do not match database schema
d. Use of deprecated keywords

Validating message definitions can impact response times in the editor,
particularly if you have complicated ESQL that makes many references to a
complex message definition. You might choose to delay this validation. Invoke
validation when you have finished developing the message flow and are about
to deploy it, to avoid runtime errors. For each error found, the editor writes an
entry in the Tasks view, providing both the code line number and the reason
for the error.

If you double-click the error, the editor positions your cursor on the line in

which it found that error. The line is also highlighted by the error icon ﬁ in
the margin to the left.

The editor might also find potential error situations, that it highlights as

warnings (with the warning icon 24 ), which it also writes to the tasks view.
For example, you might have included a BROKER SCHEMA statement that
references an invalid schema (namespace).

Check your code, and make the corrections required by that statement or
function.

Save As:

You can save a copy of this ESQL file by using File » Save As....

1.
2.

Click File » Save <name> As....

Specify the message flow project in which you want to save a copy of the ESQL
file. The project name defaults to the current project. You can accept this name,
or choose another name from the valid options that are displayed in the File
Save dialog.

Specify the name for the new copy of the ESQL file. If you want to save this
ESQL file in the same project, you must either give it another name, or confirm
that you want to overwrite the current copy (that is, copy the file to itself).

If you want to save this ESQL file in another project, the project must already
exist (you can only select from the list of existing projects). You can save the file
with the same or another name in another project.

Click OK. The message flow is saved and the message flow editor validates its
contents. The editor provides a report of any errors that it finds in the Tasks
view.

Copying an ESQL file

You might find it useful to copy an ESQL file as a starting point for a new ESQL
file that has similar function.
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Before you start

To complete this task, you must have completed the following task:
» [“Creating an ESQL file” on page 257|

To copy an ESQL file:
1. Switch to the Broker Application Development perspective.

2. In the Broker Development view, select the ESQL file
(<message_flow_name>.esql) that you want to copy. Right-click the file and
click Copy from the menu.

3. Right-click the broker schema within the message flow project to which you
want to copy the ESQL file and click Paste. You can copy the ESQL file to the
same broker schema within the same message flow project, or to a different
broker schema within the same message flow project, or to a broker schema in
a different message flow project.

When you copy an ESQL file, the associated files (message flow, and mapping
if present) are not automatically copied to the same target message flow project.
If you want these files copied as well, you must do this explicitly following this
procedure.

If you want to use this ESQL file with another message flow, ensure that the
modules within the ESQL file match the nodes that you have in the message
flow, and that the node properties are set correctly.

You can also use File » Save As to copy an ESQL file. This is described in
fan ESQL file” on page 262

Renaming an ESQL file

You can rename an ESQL file within the message flow project. You might want to
do this, for example, if you have renamed the message flow with which it is
associated.

Before you start

To complete this task, you must have completed the following task:
+ [“Creating an ESQL file” on page 257|

To rename an ESQL file:
1. Switch to the Broker Application Development perspective.

2. In the Broker Development view, right-click the ESQL file that you want to
rename. Its default name is <message_flow_name>.esql. Click Rename or click
File » Rename. If you have selected the ESQL file, you can press F2. The
Rename Resource dialog is displayed.

3. Enter the new name for the ESQL file. Click OK to complete the action, or
Cancel to cancel the request. If you click OK, the ESQL file is renamed.

When the rename is done, any references that you have to this ESQL file are no
longer valid and you must correct them. If you are unsure where the references
are, click File » Save All. This saves and validates all resources. Unresolved
references are listed in the Tasks view, and you can click each error listed to
locate and update the references.



Moving an ESQL file

If you move a message flow from one broker schema to another, or from one
project to another, you might want to move any ESQL file that is associated with
that message flow.

Before you start

To complete this task, you must have completed the following task:
+ [“Creating an ESQL file” on page 257

To move an ESQL file:

1.

Switch to the Broker Application Development perspective.

2. Move the ESQL file in one of the following ways:

a. Drag and drop the ESQL file that you want to move from its current
location to a broker schema within the same or another message flow
project.

If the target location that you have chosen is not valid (for example, if an
ESQL file of this name already exists in the broker schema), the invalid icon
is displayed and the move is not completed.

b. Right-click the ESQL file and click Move, or click File > Move. The Move
dialog is displayed.
Select the project and the broker schema from the list of valid targets that is
shown in the dialog.
Click OK to complete the move, or Cancel to cancel the request.
If you click OK, the ESQL file is moved to its new location.

3. Check the Tasks view for any errors (indicated by the error icon @ ) or

warnings (indicated by the warning icon <& ) generated by the move.

The errors in the Tasks view include those caused by broken references. When
the move is completed, all references to this ESQL file are checked. If you have
moved the file within the same named broker schema within the same message
flow project, all references are still valid. If you have moved the file to another
broker schema in the same or another message flow project, the references are
broken. If you have moved the file to the same named broker schema in
another message flow project, the references might be broken if the project
references are not set correctly to recognize external references in this file. These
errors occur because resources are linked by a fully-qualified name.

Double-click each error or warning to correct it. This opens the message flow
that has the error in the editor view and highlights the node in error.

When you move an ESQL file, its associated files (for example, the message flow
file) are not automatically moved to the same target broker schema. You must
move these files yourself.

Changing ESQL preferences

You can modify the way in which ESQL is displayed in the editor and validated by
the editor:

“Changing ESQL editor settings”]

“Changing ESQL validation settings” on page 266|

Changing ESQL editor settings:
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When you open an ESQL file in the editor view, you can tailor the editor
appearance by changing editor settings.

To change ESQL editor settings:

1. Switch to the Broker Application Development perspective.

2. Click Window - Preferences. The Preferences dialog is displayed.
3. Expand the item for ESQL on the left and click ESQL Editor.

4. Update the settings available for tab width and colors:

* Click the General tab to change the displayed tab width within the ESQL
editor.

* Click the Colors tab to change the color of the editor view background, and
of the entities displayed in the editor view. These include comments and
keywords within your ESQL code.

5. When you have completed your changes, click Apply to close the Preferences
dialog, apply your changes and leave the Preferences dialog open. Click OK to
apply your changes and close the dialog. Click Cancel to close the dialog and
discard your changes.

6. If you want to return your ESQL editor settings to the initial values, click
Restore Defaults. All values are reset to the original settings.

If you change the editor settings when you have an editor session active, the
changes are implemented immediately. If you do not have an editor session open,
you see the changes when you next edit an ESQL file.

To change font settings for the ESQL editor:
1. Click Window - Preferences. The Preferences dialog is displayed.

2. Expand the item for Workbench on the left of the Preferences dialog, and click
Colors and Fonts.

3. Expand Basic in the Colors and Fonts tab

4. Select a font or text color option and click on Change . The Font dialog will be
displayed.

5. When you have completed your changes, click Apply to close the Preferences
dialog, apply your changes and leave the Preferences dialog open. Click OK to

apply your changes and close the dialog. Click Cancel to close the dialog and
discard your changes.

6. If you want to return your ESQL editor settings to the initial values, click
Restore Defaults.

Changing ESQL validation settings:

You can specify the level of validation that the ESQL editor performs when you
save a .esql file. If the validation you have requested results in warnings, you can
deploy a bar file containing this message flow. However, if errors are reported, you
cannot deploy the bar file.

To change ESQL validation settings:

1. Switch to the Broker Application Development perspective.

2. Click Window > Preferences. The Preferences dialog is displayed.
3. Expand the item for ESQL on the left and click Validation.
4

. Update the settings for what is validated, and for what warnings or errors are
reported. See |[ESQL editor| for details of the settings and their values.



5. When you have completed your changes, click Apply to close the Preferences
dialog, apply your changes and leave the Preferences dialog open. Click OK to
apply your changes and close the dialog. Click Cancel to close the dialog and
discard your changes.

6. If you want to return your ESQL editor preferences to the initial values, click
Restore Defaults. All values are reset to the original settings.

If you make changes to the validation settings, the changes are implemented
immediately for currently open edit sessions and for subsequent edit sessions.

Deleting ESQL for a node

If you delete a node from a message flow, you can delete the ESQL module that
you created to customize its function.

Before you start

To complete this task, you must have completed the following task:
+ [“Creating ESQL for a node” on page 259

To delete ESQL code:
1. Switch to the Broker Application Development perspective.

2. Open the message flow that you want to work with by double-clicking it in the
Broker Development view. The message flow is opened in the editor view.

3. Select the node for which you want to delete the ESQL module, right-click and
click Open ESQL. The ESQL file is opened in the editor view, with the module
for this node highlighted.

4. Press the Delete or backspace key to delete the whole module.

5. When you have finished working with this module, you can close the ESQL

file. Save the file before you close it to retain all your changes. Save also
validates your ESQL: see [‘Saving an ESQL file” on page 262,

If you prefer, you can open the ESQL file directly by double-clicking it in the
Broker Development view. The ESQL file is opened in the editor view. Select the
module that you want to delete from the Outline view and delete it as described
above. You can also right-click on the module name in the Broker Development
view (the modules in the ESQL file are visible if you expand the view of the file by
clicking the + beside the file name) and click Delete.

Deleting an ESQL file

If you delete a message flow, or if you have deleted all the ESQL code in an ESQL
file, you can delete the ESQL file.

Before you start

To complete this task, you must have completed the following task:
+ [“Creating an ESQL file” on page 257

To delete an ESQL file:
1. Switch to the Broker Application Development perspective.

2. Within the Broker Development view, right-click the ESQL file that you want to
delete, and click Delete. A dialog is displayed that asks you to confirm the
deletion.
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You can also select the file in the Broker Development view, and click Edit »
Delete. A dialog is displayed that asks you to confirm the deletion.

3. Click Yes to delete the file, or No to cancel the delete request.

If you maintain resources in a shared repository, a copy is retained in that
repository. You can follow the instructions provided by the repository supplier
to retrieve the file if required.

If you are using the local file system or a shared file system to store your
resources, no copy of the file is retained. Be careful to select the correct file
when you complete this task.

Writing ESQL

How you can use ESQL to customize nodes.

When you create a message flow, you include input nodes that receive the
messages and, optionally, output nodes that send out new or updated messages. If
required by the processing that must be performed on the message, you can
include other nodes after the input node that complete the actions that your
applications need.

Some of the built-in nodes enable you to customize the processing that they
provide. The Compute, Database, and Filter nodes require you to provide a
minimum level of ESQL, and you can provide much more than the minimum to
control precisely the behavior of each node. This set of topics discusses ESQL and
the ways in which you can use it to customize these nodes.

The DataDelete, Datalnsert, DataUpdate, Extract, Mapping, and Warehouse nodes
provide a mapping interface with which you can customize their function. The
ways in which you can use the mapping functions associated with these nodes are
described in developing message mappings, see ['Developing message mappings”|

ESQL provides a rich and flexible syntax for statements and functions that enable
you to check and manipulate message and database content. You can:

* Read the contents of the input message
* Modify message content with data from databases
* Modify database content with data from messages

* Construct new output messages created from all, part, or none of the input
message (in the Compute node only)

The following topics provide more information about these and other tasks that
you can perform with ESQL. Unless otherwise stated, these guidelines apply to
messages in all message domains except the BLOB domain, for which you can
implement a limited set of actions.

* [“Tailoring ESQL code for different node types” on page 270

* [“Manipulating message body content” on page 271
+ [“Manipulating other parts of the message tree” on page 291
* |“Transforming from one data type to another” on page 301
* [“Adding keywords to ESQL files” on page 309
* |“”Accessing databases from ESQL” on page 309
+ [“Coding ESQL to handle errors” on page 320
+ [“Accessing broker properties from ESQL” on page 394|

+ [“Configuring a message flow at deployment time using UDPs” on page 395|
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The following topics provide additional information specific to the parser that you
have specified for the input message:

+ “Manipulating messages in the MRM domain” on page 373

+ [“Manipulating messages in the XML domain” on page 372|

+ [“Manipulating messages in the XMLNS domain” on page 363|

+ [“Manipulating messages in the XMLNSC domain” on page 350)

* ["Manipulating messages in the JMS domains” on page 389

+ [“Manipulating messages in the IDOC domain” on page 389

+ [“Manipulating messages in the MIME domain” on page 390|

* [“Manipulating messages in the BLOB domain” on page 392|

ESQL examples

Most of the examples included in the topics listed previously show
parser-independent ESQL. If examples include a reference to MRM, they assume
that you have modeled the message in the MRM and that you have set the names
of the MRM objects to be identical to the names of the corresponding tags or
attributes in the XML source message. Some examples are also shown for the XML
domain. Unless stated otherwise, the principals illustrated are the same for all
message domains. For domain-specific information, use the appropriate link in the
previous list.

Most of the topics that include example ESQL use the ESQL sample message,
Invoice, as the input message to the logic. This message is provided in XML source
format (with tags and attributes), see [‘Example message” on page 1525] The
example message is shown in the following diagram.

The topics specific to the MRM domain use the message that is created in the
following sample:

+ |Video Rental sample|

You can view samples only when you use the information center that is integrated
with the Message Broker Toolkit.

A few other input messages are used to show ESQL that provides function on
messages with a structure or content that is not included in the Invoice or Video
samples. Where this occurs, the input message is included in the topic that refers
to it.
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Invoice

‘InvoiceNo‘ ‘ InvoiceTime ‘ ‘ Cashier ‘ Payment ‘ StoreRecord‘ ‘ Error ‘
‘ InvoiceDate ‘ ‘ TillNumber ‘ ‘ ‘ DirectMail
‘ CardType‘ ‘ CardName ‘ ‘ Expires ‘

CardNo @

Customer Purchases

‘FirstName‘ ‘ Title ‘PhoneHome ‘ Billing ‘ ‘ ltem ‘ ‘ ltem ‘ ‘ ltem ‘

‘ LastName‘ ‘ DOB ‘ ‘ PhoneWork‘ ‘ ‘ ‘ ‘

\ Title

‘ Author

\ PublishDate

‘ Quantity ‘

‘ ‘ ‘ ISBN ‘ ‘Publisher‘ ‘UnitPrice‘

‘ Address

‘ Address ‘

‘ Address ‘ ‘ PostCode ‘

Tailoring ESQL code for different node types

When you code ESQL to configure Compute, Database, and Filter node behavior,
be aware of the limitations of each type of node:

Compute node
You can configure the Compute node to do any of the following
operations:

¢ Update data in a database.

* Insert data into a database.

* Delete data from a database.

¢ Update the Environment tree.

* Update the LocalEnvironment tree.

* Create one or more output messages, with none, some, or all the content
of the input message, and propagate these new messages to the next
node in the message flow.

If you want to propagate the input LocalEnvironment to the output
LocalEnvironment, remember to set the Compute node property Compute
mode to an appropriate value. The Environment is always propagated in
the output message.
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Database node
You can configure the Database node to do any of the following
operations:

* Update data in a database.

* Insert data into a database.

* Delete data from a database.

* Update the Environment tree.

* Update the LocalEnvironment tree.

* Propagate the input message to the next node in the message flow.
Filter node

You can configure the Filter node to do any of the following operations:

¢ Update data in a database.

* Insert data into a database.

* Delete data from a database.

* Update the Environment tree.

* Update the LocalEnvironment tree.

* Propagate the input message to the next node in the message flow (the
terminal through which the message is propagated depends on the
result of the filter expression).

View the remaining tasks in this section to find the details of how you can perform
these operations.

Manipulating message body content

The message body is always the last child of root, and is identified by its parser
name, for example XML or MRM.

The following topics describe how you can refer to, modify, and create message
body data. The information provided here is domain independent.

* [“Referencing field types”|

* |“Accessing elements in the message body” on page 272|

* |“Accessing known multiple occurrences of an element” on page 276|

* |“Accessing unknown multiple occurrences of an element” on page 277

+ [“Using anonymous field references” on page 278§|

[‘Creating dynamic field references” on page 279

* [“Creating new fields” on page 280|

* [“Generating multiple output messages” on page 282|

* [“Using numeric operators with datetime values” on page 283|

+ [“Calculating a time interval” on page 284|

+ [“Selecting a subfield from a larger field” on page 285|

* |“Copying repeating fields” on page 286|

+ [“Manipulating repeating fields in a message tree” on page 290|

Referencing field types:
Some message parsers have complex models in which it is not enough to identify a

field simply by its name and an array subscript. In these cases, you associate an
optional field type with an element of data in the tree format.
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Each element within the parsed tree can be one of three types:

Name element
A name element has a string, which is the name of the element, associated
with it. An example of a name element is XMLETement, described in
felement” on page 1297

Value element
A value element has a value associated with it. An example of a value
element is XMLContent, described in [“XML content” on page 1297

Name-value element
A name-value element is an optimization of the case where a name
element contains only a value element and nothing else. The element
contains both a name and a value. An example of a name-value element is
XMLAttribute, described in [“XML attribute” on page 1295 |

Accessing elements in the message body:

When you want to access the contents of a message, for reading or writing, use the
structure and arrangement of the elements in the tree that is created by the parser
from the input bit stream. Follow the relevant parent and child relationships from
the top of the tree downwards, until you reach the required element.

 If you are referring to the input message tree to interrogate its content in a
Compute node, use correlation name InputBody followed by the path to the
element to which you are referring. InputBody is equivalent to InputRoot
followed by the parser name (for example, InputRoot.MRM), which you can use if
you prefer.

 If you are referring to the output message tree to set or modify its content in the
Compute node, use correlation name OutputRoot followed by the parser name
(for example, OutputRoot.MRM).

 If you are referring to the input message to interrogate its contents in a Database
or Filter node, use correlation name Body to refer to the start of the message.
Body is equivalent to Root followed by the parser name (for example,
Root.XMLNS), which you can use if you prefer.

You must use these different correlation names because there is only one
message to which to refer in a Database or Filter node; you cannot create a new
output message in these nodes. Use a Compute node to create a new output
message.

When you construct field references, the names that you use must be valid ESQL
identifiers that conform to ESQL rules. If you enclose anything in double quotation
marks, ESQL interprets it as an identifier. If you enclose anything in single
quotation marks, ESQL interprets it as a character literal. You must enclose all
strings (character strings, byte strings, or binary (bit) strings) in quotation marks,
as shown in the examples below. To include a single or double quotation mark
within a string, include two consecutive single or double quotation marks.

Important: For a full description of field reference syntax, see ["ESQL field
[references” on page 1323 |

For more information about ESQL data types, see [“ESQL data types in message]
[flows” on page 1310

Assume that you have created a message flow that handles the message Invoice,
shown in the figure in [“Writing ESQL” on page 268]If, for example, you want to
interrogate the element CardType from within a Compute node, use the following
statement:




IF InputBody.Invoice.Payment.CardType='Visa' THEN
DO;
-- more ESQL --
END IF;

If you want to make the same test in a Database or Filter node (where the
reference is to the single input message), code:

IF Body.Invoice.Payment.CardType="'Visa' THEN
DO;
-- more ESQL --
END IF;

If you want to copy an element from an input XML message to an output message
in the Compute node without changing it, use the following ESQL:

SET OutputRoot.XMLNS.Invoice.Customer.FirstName =
InputBody.Invoice.Customer.FirstName;

If you want to copy an element from an input XML message to an output message
and update it, for example by folding to uppercase or by calculating a new value,
code:

SET OutputRoot.XMLNS.Invoice.Customer.FirstName =
UPPER(InputBody.Invoice.Customer.FirstName);
SET OutputRoot.XMLNS.Invoice.InvoiceNo = InputBody.Invoice.InvoiceNo + 1000;

If you want to set a STRING element to a constant value, code:
SET OutputRoot.XMLNS.Invoice.Customer.Title = 'Mr';

You can also use the equivalent statement:
SET OutputRoot.XMLNS.Invoice.Customer.Title VALUE = 'Mr';

If you want to update an INTEGER or DECIMAL, for example the element
Ti11Number, with the value 26, use the following assignment (valid in the Compute
node only):

SET OQutputRoot.MRM.Invoice.Til1Number=26;

The integer data type stores numbers using the 64-bit twos complement form,
allowing numbers in the range -9223372036854775808 to 9223372036854775807. You
can specify hexadecimal notation for integers as well as normal integer literal
format. The hexadecimal letters A to F can be written in upper or lower case, as
can the X after the initial zero, which is required. The example below produces the
same result as the example shown above:

SET OutputRoot.MRM.Invoice.Til11Number= 0x1A;

The following examples show SET statements for element types that do not appear
in the example Invoice message.

To set a FLOAT element to a non-integer value, code:
SET OutputRoot.MRM.FloatETementl = 1.2345e2;
To set a BINARY element to a constant value, code:

SET OutputRoot.MRM.BinaryElementl = X'F1F1';
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For BINARY values, you must use an initial character X (upper or lower case) and
enclose the hexadecimal characters (also upper or lower case) in single quotation
marks, as shown.

To set a BOOLEAN element to a constant value (the value 1 equates to true, 0
equates to false), code:

SET OutputRoot.MRM.BooleanETlementl = true;
or
SET OutputRoot.MRM.BooleanElementl = 1;

You can use the SELECT statement to filter records from an input message without
reformatting the records, and without any knowledge of the complete format of
each record. Consider the following example:

-- Declare local variable
DECLARE CurrentCustomer CHAR 'Smith';

-- Loop through the input message
SET OutputRoot.XMLNS.Invoice[] =
(SELECT I FROM InputRoot.XMLNS.Invoice[] AS I
WHERE I.Customer.LastName = CurrentCustomer
)s

This writes all records from the input Invoice message to the output message if the
WHERE condition (LastName = Smith) is met. All records that do not meet the
condition are not copied from input to output. I is used as an alias for the
correlation name InputRoot. XMLNS.Invoice[].

The declared variable CurrentCustomer is initialized on the DECLARE statement:
this is the most efficient way of declaring a variable for which the initial value is
known.

You can use this alias technique with other SELECT constructs. For example, if you
want to select all the records of the input Invoice message, and create an additional
record:

-- Loop through the input message
SET OutputRoot.XMLNS.Invoice[] =
(SELECT I, 'Customer' || I.Customer.LastName AS ExtraField
FROM InputRoot.XMLNS.Invoice[] AS I
)3

You could also include an AS clause to place records in a subfolder in the message
tree:

-- Loop through the input message
SET OutputRoot.XMLNS.Invoice[] =
(SELECT I AS Order
FROM InputRoot.XMLNS.Invoice[] AS I
)s

If you are querying or setting elements that contain, or might contain, null values,
be aware of the following considerations:

Querying null values
When you compare an element to the ESQL keyword NULL, this tests



whether the element is present in the logical tree that has been created
from the input message by the parser.

For example, you can check if an invoice number is included in the current
Invoice message with the following statement:

IF InputRoot.XMLNS.Invoice.InvoiceNo IS NULL THEN
DO;
-- more ESQL --
END IF;

You can also use an ESQL reference. The following example illustrates this.

DECLARE cursor REFERENCE TO InputRoot.MRM.InvoiceNo;

IF LASTMOVE(cursor) = FALSE THEN

SET OQutputRoot.MRM.Analysis = 'InvoiceNo does not exist in Togical tree';
ELSEIF FIELDVALUE(cursor) IS NULL THEN
SET OQutputRoot.MRM.Analysis =

'"InvoiceNo does exist in logical tree but is defined as an MRM NULL value';
ELSE

SET OQutputRoot.MRM.Analysis = 'InvoiceNo does exist and has a value';
END IF;

For more information about declaring and using references, see
[dynamic field references” on page 279 For a description of the

LASTMOVE and FIELDVALUE functions, see ["'LASTMOVE function” on|
[page 1468 and [“FIELDTYPE function” on page 1464

If the message is in the MRM domain, there are additional considerations
for querying null elements that depend on the physical format. For further
details, see [“Querying null values in a message in the MRM domain” on|

[page 381/
Setting null values
There are two statements that you can use to set null values.

1. If you set the element to NULL using the following statement, the
element is deleted from the message tree:

SET OutputRoot.XMLNS.Invoice.Customer.Title = NULL;

If the message is in the MRM domain, there are additional
considerations for null values that depend on the physical format. For

further details, see [‘Setting null values in a message in the MRM|
[domain” on page 382

This is called implicit null processing.
2. If you set the value of this element to NULL as follows:

SET OutputRoot.XMLNS.Invoice.Customer.Title VALUE = NULL;

the element is not deleted from the message tree. Instead, a special
value of NULL is assigned to the element.

SET OutputRoot.XMLNS.Invoice.Customer.Title = NULL;

If the message is in the MRM domain, the content of the output bit
stream depends on the settings of the physical format null handling
properties. For further details, see [“Setting null values in a message in|
[the MRM domain” on page 382
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This is called explicit null processing.

If you set an MRM complex element or an XML, XMLNS, or JMS parent
element to NULL without using the VALUE keyword, that element and all
its children are deleted from the logical tree.

Accessing known multiple occurrences of an element:

When you refer to or create the content of messages, it is very likely that the data
contains repeating fields. If you know how many instances there are of a repeating
field, and you want to access a specific instance of such a field, you can use an
array index as part of a field reference.

For example, you might want to filter on the first line of an address, to expedite
the delivery of an order. Three instances of the element Billling. Address are always
present in the sample message. To test the first line, write an expression such as:

IF Body.Invoice.Customer.Billing.Address[1] = 'Patent Office' THEN
DO;
-- more ESQL --
END IF;

The array index [1] indicates that it is the first instance of the repeating field that
you are interested in (array indices start at 1). An array index such as this can be
used at any point in a field reference, so you could, for example, filter on the
following test:

IF Body.Invoice."Item"[1].Quantity> 2 THEN
DO;
-- more ESQL --
END IF;

You can refer to the last instance of a repeating field using the special [<] array
index, and to instances relative to the last (for example, the second to last) as
follows:

* Field[<] indicates the last element.
e Field[<1] indicates the last element.
* Field[<2] indicates the last but one element (the penultimate element).

You can also use the array index [>] to represent the first element, and elements
relative to the first element in a similar way.

* Field[>] indicates the first element. This is equivalent to Field[1].
The following examples refer to the Invoice message using these indexes:

IF Body.Invoice.Customer.Billing.Address[<] = 'Hampshire' THEN
DO;
-- more ESQL --

END IF;

IF Body.Invoice.Customer.Billing.Address[<2 ] = 'Southampton' THEN

DO;

-- more ESQL --

END IF;

You can also use these special indexes for elements that repeat an unknown
number of times.

Deleting repeating fields:



If you pass a message with several repeats of an element through a message flow
and you want to delete some of the repeats, be aware that the numbering of the
repeats is reordered after each delete. For example, if you have a message with five
repeats of a particular element, and in the message flow you have the following
ESQL:

SET OutputRoot.MRM.e_PersonName[1]
SET OutputRoot.MRM.e_PersonName[4]

NULL;
NULL;

You might expect elements one and four to be deleted. However, because repeating
elements are stored on a stack, when you delete one, the one above it takes its
place. This means that, in the above example, elements one and five are deleted. To
avoid this problem, delete in reverse order, that is, delete element four first, then
delete element one.

Accessing unknown multiple occurrences of an element:
You are very likely to deal with messages that contain repeating fields with an

unknown number of repeats. This is the situation with the Item field in the
example message in [“Example message” on page 1525

To write a filter that takes into account all instances of the Item field, you need to
use a construct that can iterate over all instances of a repeating field. The
quantified predicate allows you to execute a predicate against all instances of a
repeating field, and collate the results.

For example, you might want to verify that none of the items that are being
ordered has a quantity greater than 50. To do this you could write:

FOR ALL Body.Invoice.Purchases."Item"[]
AS 1 (I.Quantity <= 50)

With the quantified predicate, the first thing to note is the brackets [] on the end of
the field reference after FOR ALL. These tell you that you are iterating over all
instances of the Item field.

In some cases, this syntax appears unnecessary because you can get that
information from the context, but it is done for consistency with other pieces of

syntax.

The AS clause associates the name I with the current instance of the repeating
field. This is similar to the concept of iterator classes used in some object oriented
languages such as C++. The expression in parentheses is a predicate that is
evaluated for each instance of the Item field.

A description of this example is:

Iterate over all instances of the field Item inside Body.Invoice. For each iteration:
1. Bind the name I to the current instance of Item.
2. Evaluate the predicate I.Quantity <= 50. If the predicate:

e Evaluates to TRUE for all instances of Item, return TRUE.

* Is FALSE for any instance of Item, return FALSE.

e For a mixture of TRUE and UNKNOWN, return UNKNOWN.
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The above is a description of how the predicate is evaluated if you use the ALL
keyword. An alternative is to specify SOME, or ANY, which are equivalent. In this
case the quantified predicate returns TRUE if the sub-predicate returns TRUE for
any instance of the repeating field. Only if the sub-predicate returns FALSE for all
instances of the repeating field does the quantified predicate return FALSE. If a
mixture of FALSE and UNKNOWN values are returned from the sub-predicate, an
overall value of UNKNOWN is returned.

In the following filter expression:

FOR ANY Body.Invoice.Purchases."Item"[]
AS 1 (I.Title = 'The XML Companion')

the sub-predicate evaluates to TRUE. However this next expression returns FALSE:

FOR ANY Body.Invoice.Purchases."Item"[]
AS I (I.Title = 'C Primer')

because the C Primer is not included on this invoice. If some of the items in the
invoice do not include a book title field, the sub-predicate returns UNKNOWN,
and the quantified predicate returns the value UNKNOWN.

To deal with the possibility of null values appearing, write this filter with an
explicit check on the existence of the field, as follows:

FOR ANY Body.Invoice.Purchases."Item"[]
AS I (I.Book IS NOT NULL AND I.Book.Title = 'C Primer')

The predicate IS NOT NULL ensures that, if an Item field does not contain a Book,
a FALSE value is returned from the sub-predicate.

You can also manipulate arbitrary repeats of fields within a message by using a
SELECT expression, as described in [‘Referencing columns in a database” on page]

You can refer to the first and last instances of a repeating field using the [>] and
[<] array indexes, and to instances relative to the first and last, even if you do not
know how many instances there are. These indexes are described in

[known multiple occurrences of an element” on page 276,

Alternatively, you can use the CARDINALITY function to determine how many
instances of a repeating field there are. For example:

DECLARE I INTEGER CARDINALITY(Body.Invoice.Purchases."Item"[])
Using anonymous field references:

You can refer to the array of all children of a particular element by using a path
element of *. So, for example:

InputRoot.*[]

is a path that identifies the array of all children of InputRoot. This is often used in
conjunction with an array subscript to refer to a particular child of an entity by
position, rather than by name. For example:



InputRoot.*[<]
Refers to the last child of the root of the input message, that is, the body of
the message.

InputRoot.*[1]
Refers to the first child of the root of the input message, the message
properties.

You might want to find out the name of an element that has been identified with a
path of this kind. To do this, use the FIELDNAME function, which is described in
[“FIELDNAME function” on page 1463

Creating dynamic field references:

You can use a variable of type REFERENCE as a dynamic reference to navigate a
message tree. This acts in a similar way to a message cursor or a variable pointer.
It is generally simpler and more efficient to use reference variables in preference to
array indexes when you access repeating structures. Reference variables are
accepted everywhere. Field references are accepted and come with a set of
statements and functions to allow detailed manipulation of message trees.

You must declare a dynamic reference before you can use it. A dynamic reference
is declared and initialized in a single statement. The following example shows how
to create and use a reference.

-- Declare the dynamic reference
DECLARE myref REFERENCE TO OutputRoot.XMLNS.Invoice.Purchases.Item[1];

-- Continue processing for each item in the array

WHILE LASTMOVE (myref)=TRUE

DO

-- Add 1 to each item in the array
SET myref = myref + 1;

-- Move the dynamic reference to the next item in the array
MOVE myref NEXTSIBLING;

END WHILE;

This example declares a dynamic reference, myref, which points to the first item in
the array within Purchases. The value in the first item is incremented by one, and
the pointer (dynamic reference) is moved to the next item. Once again the item
value is incremented by one. This process continues until the pointer moves
outside the scope of the message array (all the items in this array have been
processed) and the LASTMOVE function returns FALSE.

The examples below show further examples.

DECLARE refl REFERENCE TO InputBody.Invoice.Purchases.Item[1];

DECLARE ref2 REFERENCE TO
InputBody.Invoice.Purchases.NonExistentField;

DECLARE scalarl CHARACTER;
DECLARE ref3 REFERENCE TO scalarl;

In the second example, ref? is set to point to InputBody because the specified field
does not exist.

With the exception of the MOVE statement, which changes the position of the
dynamic reference, you can use a dynamic reference anywhere that you can use a
static reference. The value of the dynamic reference in any expression or statement
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is the value of the field or variable to which it currently points. For example, using
the message in [“Example message” on page 1525 the value of
Invoice.Customer.FirstName is Andrew. If the dynamic reference myref is set to
point at the FirstName field as follows:

DECLARE myref REFERENCE TO Invoice.Customer;
the value of myref is Andrew. You can extend this dynamic reference as follows:
SET myref.Billing.Address[1] = 'Oaklands';

This changes the address in the example to Oaklands Hursley Village Hampshire
SO213JR.

The position of a dynamic reference remains fixed even if a tree is modified. To
illustrate this point the steps that follow use the message in [“Example message” on|

page 1525 as their input message and create a modified version of this message as

an output message:
1. Copy the input message to the output message.

2. To modify the output message, first declare a dynamic reference refl that
points at the first item, The XML Companion.

DECLARE refl REFERENCE TO
OutputRoot.XMLNS.Invoice.Purchases.Item[1];

The dynamic reference is now equivalent to the static reference
OutputRoot.XMLNS.Invoice.Purchases.Item[1].

3. Use a create statement to insert a new first item for this purchase.
CREATE PREVIQUSSIBLING OF refl VALUES 'Item’';

The dynamic reference is now equivalent to the static reference
OutputRoot.XMLNS.Invoice.Purchases.Item[2].

Creating new fields:

This topic provides example ESQL code for a Compute node that creates a new
output message based on the input message, to which are added a number of
additional fields.

The input message received by the Compute node within the message flow is an
XML message, and has the following content:

<TestCase description="This is my TestCase">
<Identifier>ESO3B305_T1l</Identifier>
<Sport>Football</Sport>
<Date>01/02/2000</Date>
<Type>LEAGUE</Type>

</TestCase>

The Compute node is configured and an ESQL module is created that includes the
following ESQL. The code shown below copies the headers from the input message
to the new output message, then creates the entire content of the output message

body.



-- copy
DECLARE

headers
i INTEGER 1;

DECLARE numHeaders INTEGER CARDINALITY(InputRoot.*[]);

WHILE i < numHeaders DO
SET OutputRoot.*[i] = InputRoot.=*[i];

SET

i=d+1;

END WHILE;

CREATE FIELD OutputRoot.XMLNS.TestCase.description TYPE NameValue VALUE 'This is my TestCase';
CREATE FIRSTCHILD OF OutputRoot.XMLNS.TestCase Domain('XMLNS') NAME 'Identifier'

VALUE InputRoot.XMLNS.TestCase.Identifier;

CREATE LASTCHILD OF OutputRoot.XMLNS.TestCase Domain('XMLNS') NAME 'Sport'

CREATE
CREATE
CREATE
CREATE
CREATE
CREATE
CREATE

CREATE
CREATE

CREATE
CREATE
CREATE
CREATE
CREATE

CREATE
CREATE

CREATE

CREATE

CREATE

CREATE
CREATE

CREATE

CREATE
CREATE

CREATE

VALUE InputRoot.XMLNS.TestCase.Sport;
LASTCHILD OF OutputRoot.XMLNS.TestCase Domain('XMLNS') NAME 'Date’
VALUE InputRoot.XMLNS.TestCase.Date;
LASTCHILD OF OutputRoot.XMLNS.TestCase Domain('XMLNS') NAME 'Type'
VALUE InputRoot.XMLNS.TestCase.Type;
FIELD OutputRoot.XMLNS.TestCase.Division[1].Number TYPE NameValue
VALUE 'Premiership';
FIELD OutputRoot.XMLNS.TestCase.Division[1].Result[1].Number TYPE NameValue VALUE
FIELD OutputRoot.XMLNS.TestCase.Division[1].Result[1].Home TYPE Name;
LASTCHILD OF OutputRoot.XMLNS.TestCase.Division[1].Result[1].Home NAME 'Team'
VALUE 'Liverpool' ;
LASTCHILD OF OutputRoot.XMLNS.TestCase.Division[1].Result[1].Home NAME 'Score'
VALUE '4';
FIELD OutputRoot.XMLNS.TestCase.Division[1].Result[1].Away TYPE Name;
LASTCHILD OF OutputRoot.XMLNS.TestCase.Division[1].Result[1].Away NAME 'Team'
VALUE 'Everton';
LASTCHILD OF OQutputRoot.XMLNS.TestCase.Division[1].Result[1].Away NAME 'Score'
VALUE '0';

I].I;

FIELD OutputRoot.XMLNS.TestCase.Division[1].Result[2].Number TYPE NameValue VALUE '2';

FIELD OutputRoot.XMLNS.TestCase.Division[1].Result[2].Home TYPE Name;

LASTCHILD OF OutputRoot.XMLNS.TestCase.Division[1].Result[2].Home NAME 'Team'
VALUE 'Manchester United';

LASTCHILD OF OutputRoot.XMLNS.TestCase.Division[1].Result[2].Home NAME 'Score'
VALUE '2';

FIELD OutputRoot.XMLNS.TestCase.Division[1].Result[2].Away TYPE Name;

LASTCHILD OF OutputRoot.XMLNS.TestCase.Division[1].Result[2].Away NAME 'Team'
VALUE 'Arsenal';

LASTCHILD OF OutputRoot.XMLNS.TestCase.Division[1].Result[2].Away NAME 'Score’
VALUE '3';

FIELD OutputRoot.XMLNS.TestCase.Division[2].Number TYPE NameValue
VALUE '2';

FIELD OutputRoot.XMLNS.TestCase.Division[2].Result[1].Number TYPE NameValue
VALUE '1';

FIELD OutputRoot.XMLNS.TestCase.Division[2].Result[1].Home TYPE Name;

LASTCHILD OF OutputRoot.XMLNS.TestCase.Division[2].Result[1].Home NAME 'Team'
VALUE 'Port Vale';

LASTCHILD OF OutputRoot.XMLNS.TestCase.Division[2].Result[1].Home NAME 'Score'
VALUE '9'

FIELD OutputRoot.XMLNS.TestCase.Division[2].Result[1].Away TYPE Name;

LASTCHILD OF OutputRoot.XMLNS.TestCase.Division[2].Result[1].Away NAME 'Team'
VALUE 'Brentford';

LASTCHILD OF OutputRoot.XMLNS.TestCase.Division[2].Result[1].Away NAME 'Score'
VALUE '5';

The output message that results from the ESQL shown above has the following

structure and content:
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<TestCase description="This is my TestCase">
<Identifier>ESO3B305_T1</Identifier>
<Sport>Foothall</Sport>
<Date>01/02/2000</Date>
<Type>LEAGUE</Type>
<Division Number="Premiership">
<Result Number="1">

<Home>
<Team>Liverpool</Team>
<Score>4</Score>
</Home>
<Away>
<Team>Everton</Team>
<Score>0</Score>
</Away>
</Result>
<Result Number="2">
<Home>
<Team>Manchester United</Team>
<Score>2</Score>
</Home>
<Away>
<Team>Arsenal</Team>
<Score>3</Score>
</Away>
</Result>

</Division>
<Division Number="2">
<Result Number="1">
<Home>
<Team>Port Vale</Team>
<Score>9</Score>
</Home>
<Away>
<Team>Brentford</Team>
<Score>5</Score>
</Away>
</Result>
</Division>
</TestCase>

Generating multiple output messages:

You can use the PROPAGATE statement to generate multiple output messages in
the Compute node. The output messages that you generate can have the same or
different content. You can also direct output messages to any of the four alternate
output terminals of the Compute node, or to a Label node.

For example, if you want to create three copies of the input message received by
the Compute node, and send one to the standard "Out” terminal of the Compute
node, one to the first alternate "outl” terminal of the Compute node, and one to
the Label node "ThirdCopy”, code the following ESQL:

SET OutputRoot = InputRoot;
PROPAGATE;

SET OutputRoot = InputRoot;
PROPAGATE TO TERMINAL 'outl';
SET OQutputRoot = InputRoot;
PROPAGATE TO LABEL 'ThirdCopy';

In the above example, the content of OutputRoot is reset before each PROPAGATE,
because by default the node clears the output message buffer and reclaims the
memory when the PROPAGATE statement completes. An alternative method is to
instruct the node not to clear the output message on the first two PROPAGATE



statements, so that the message is available for routing to the next destination. The
code to do this is:

SET OutputRoot = InputRoot;

PROPAGATE DELETE NONE;

SET OutputRoot = InputRoot;

PROPAGATE TO TERMINAL 'outl' DELETE NONE;
SET OQutputRoot = InputRoot;

PROPAGATE TO LABEL 'ThirdCopy';

If you do not initialize the output buffer, an empty message is generated, and the
message flow detects an error and throws an exception.

Also ensure that you copy all required message headers to the output message
buffer for each output message that you propagate.

If you want to modify the output message content before propagating each
message, code the appropriate ESQL to make the changes that you want before
you code the PROPAGATE statement.

If you set up the contents of the last output message that you want to generate,
and propagate it as the final action of the Compute node, you do not have to
include the final PROPAGATE statement. The default action of the Compute node
is to propagate the contents of the output buffer when it terminates. This is
implemented by the RETURN TRUE statement, included as the final statement in
the module skeleton.

For example, if you want to generate three copies of the input message, and not
perform any further action, include this code immediately before the RETURN
TRUE statement:

SET OutputRoot = InputRoot;
PROPAGATE DELETE NONE;
PROPAGATE DELETE NONE;

Alternatively, you can modify the default behavior of the node by changing
RETURN TRUE to RETURN FALSE:

SET OutputRoot = InputRoot;
PROPAGATE DELETE NONE;
PROPAGATE DELETE NONE;
PROPAGATE;

RETURN FALSE;

Three output messages are generated by the three PROPAGATE statements. The
final RETURN FALSE statement causes the node to terminate but not propagate a
final output message. Note that the final PROPAGATE statement does not include
the DELETE NONE clause, because the node must release the memory at this
stage.

Using numeric operators with datetime values:

The following examples show the ESQL that you can code to manipulate datetime
values with numeric operators.

Adding an interval to a datetime value
The simplest operation that you can perform is to add an interval to, or
subtract an interval from, a datetime value. For example, you could write
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the following expressions:

DATE '2000-03-29' + INTERVAL '1' MONTH
TIMESTAMP '1999-12-31 23:59:59' + INTERVAL '1' SECOND

The following example shows how to calculate a retirement date by adding the retirement
age to the birth date.

DECLARE retAge CHARACTER '65';
DECLARE birthDate DATE DATE '1953-06-01';

SET OQutputRoot.XML.Test.retirementDate = birthDate + CAST(retAge AS INTERVAL YEAR);

The repetition of the word DATE in the above example is intentional. The first occurrence of
DATE specifies the data type of the declared variable, birthDate. The second occurrence
initializes the same variable with the constant character string that is enclosed in quotes as a
DATE.

Adding or subtracting two intervals
You can combine two interval values using addition or subtraction. The
two interval values must be of compatible types. It is not valid to add a
year-month interval to a day-second interval as shown in the following
example:

INTERVAL '1-06' YEAR TO MONTH + INTERVAL '20' DAY

The interval qualifier of the resultant interval is sufficient to encompass all
the fields that are present in the two operand intervals. For example:

INTERVAL '2 01' DAY TO HOUR + INTERVAL '123:59' MINUTE TO SECOND

results in an interval with qualifier DAY TO SECOND, because both day
and second fields are present in at least one of the operand values.

Subtracting two datetime values
You can subtract two datetime values to return an interval. You must
include an interval qualifier in the expression to indicate what precision
the result should be returned in. For example:

(CURRENT_DATE - DATE '1776-07-04') DAY
returns the number of days since the 4th July 1776, whereas:
(CURRENT_TIME - TIME '00:00:00') MINUTE TO SECOND

returns the age of the day in minutes and seconds.

Scaling intervals
You can multiply or divide an interval value by an integer factor:

INTERVAL '2:30' MINUTE TO SECOND / 4
Calculating a time interval:
This ESQL example calculates the time interval between an input WebSphere MQ

message being put on the input queue, and the time that it is processed in the
current Compute node.



(When you make a call to a CURRENT_ datetime function, the value that is
returned is identical to the value returned to another call in the same node. This
ensures that you can use the function consistently within a single node.)

CALL CopyMessageHeaders();
Declare PutTime INTERVAL;

SET PutTime = (CURRENT_GMTTIME - InputRoot.MQMD.PutTime) MINUTE TO SECOND;

SET OQutputRoot.XMLNS.Test.PutTime = PutTime;

The output message has the format (although actual values vary):

<Test>
<PutTime>INTERVAL &apos;1:21.862&apos; MINUTE TO SECOND</PutTime>
</Test>

The following code snippet sets a timer, to be triggered after a specified interval
from the start of processing, in order to check that processing has completed. If
processing has not completed within the elapsed time, the firing of the timer
might, for example, trigger some recovery processing.

The StartTime field of the timeout request message is set to the current time plus
the allowed delay period, which is defined by a user-defined property on the flow.
(The user-defined property has been set to a string of the form "HH:MM:SS" by the
administrator.)

DECLARE StartDelyIntervalStr EXTERNAL CHARACTER '01:15:05';
CREATE PROCEDURE ValidateTimeoutRequest() BEGIN

-- Set the timeout period
DECLARE timeoutStartTimeRef REFERENCE TO
QutputRoot.XMLNSC.Envelope.Header.TimeoutRequest.StartTime;
IF LASTMOVE(timeoutStartTimeRef)
THEN
-- Already set
ELSE
-- Set it from the UDP StartDelyIntervalStr
DECLARE startAtTime TIME CURRENT_TIME
+ CAST(StartDelyIntervalStr AS INTERVAL HOUR TO SECOND);

-- Convert "TIME 'hh.mm.ss.fff'" to hh.mm.ss format
-- needed in StartTime field
DECLARE startAtTimeStr CHAR;
SET startAtTimeStr = startAtTime;
SET startAtTimeStr = SUBSTRING(startAtTimeStr FROM 7 FOR 8);
SET OutputRoot.XMLNSC.Envelope.Header.TimeoutRequest.StartTime
= startAtTimeStr;
END IF;
END;

Selecting a subfield from a larger field:

You might have a message flow that processes a message containing delimited
subfields. You can code ESQL to extract a subfield from the surrounding content if
you know the delimiters of the subfield.

If you create a function that performs this task, or a similar one, you can invoke it
both from ESQL modules (for Compute, Database, and Filter nodes) and from
mapping files (used by DataDelete, Datalnsert, DataUpdate, Extract, Mapping, and
Warehouse nodes).
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The following function example extracts a particular subfield of a message that is
delimited by a specific character.

CREATE FUNCTION SelectSubField
(SourceString CHAR, Delimiter CHAR, TargetStringPosition INT)
RETURNS CHAR
-- This function returns a substring at parameter position TargetStringPosition within the
-- passed parameter SourceString. An example of use might be:
-- SelectSubField(MySourceField,' ',2) which will select the second subfield from the
-- field MySourceField delimited by a blank. If MySourceField has the value
-- "First Second Third" the function will return the value "Second"
BEGIN
DECLARE DelimiterPosition INT;
DECLARE CurrentFieldPosition INT 1;
DECLARE StartNewString INT 1;
DECLARE WorkingSource CHAR SourceString;
SET DelimiterPosition = POSITION(Delimiter IN SourceString);
WHILE CurrentFieldPosition < TargetStringPosition
DO
IF DelimiterPosition = 0 THEN
-- DelimiterPosition will be 0 if the delimiter is not found
-- exit the Toop
SET CurrentFieldPosition = TargetStringPosition;
ELSE
SET StartNewString = DelimiterPosition + 1;
SET WorkingSource = SUBSTRING(WorkingSource FROM StartNewString);
SET DelimiterPosition = POSITION(Delimiter IN WorkingSource);
SET CurrentFieldPosition = CurrentFieldPosition + 1;
END IF;
END WHILE;
IF DelimiterPosition> @ THEN
-- Remove anything following the delimiter from the string
SET WorkingSource = SUBSTRING(WorkingSource FROM 1 FOR DelimiterPosition);
SET WorkingSource = TRIM(TRAILING Delimiter FROM WorkingSource);
END IF;
RETURN WorkingSource;
END;

Copying repeating fields:
You can configure a node with ESQL to copy repeating fields in several ways.
Consider an input XML message that contains a repeating structure:

<Field_top>
<fieldl></fieldl>
<fieldl></fieldl>
<fieldl></fieldl>
<fieldl></fieldl>
<fieldl></fieldl>

</Field_top>

You cannot copy this whole structure field with the following statement:
SET OutputRoot.XMLNS.Output top.Outfieldl = InputRoot.XMLNS.Field top.fieldl;

That statement copies only the first repeat, and therefore produces the same result
as this statement:

SET OutputRoot.XMLNS.Output_top.Outfield1[1] = InputRoot.XMLNS.Field top.fieldl[1];

You can copy the fields within a loop, controlling the iterations with the
CARDINALITY of the input field:
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SET I 1;

SET J = CARDINALITY(InputRoot.XMLNS.Field top.fieldl[]);

WHILE I <= J DO

SET OutputRoot.XMLNS.Output_top.Outfield1[I] = InputRoot.XMLNS.Field_top.fieldl[I];
SET I =1+ 1;

END WHILE;

This might be appropriate if you want to modify each field in the output message
as you copy it from the input field (for example, add a number to it, or fold its
contents to uppercase), or after it has been copied. If the output message already
contained more Field1 fields than existed in the input message, the surplus fields
would not be modified by the loop and would remain in the output message.

The following single statement copies the iterations of the input fields to the
output fields, and deletes any surplus fields in the output message.

SET OutputRoot.XMLNS.Output top.Outfieldl.[] = InputRoot.XMLNS.Field top.fieldl[];

The example below shows how you can rename the elements when you copy them
into the output tree. This statement does not copy across the source element name,
therefore each fieldl element becomes a Target element.

SET OutputRoot.XMLNS.Output_top.Outfieldl.Target[] =
(SELECT I FROM InputRoot.XMLNS.Field top.fieldl[] AS I );

The next example shows a different way to do the same operation; it produces the
same end result.

SET OutputRoot.XMLNS.Output_top.Outfield2.Target[]
= InputRoot.XMLNS.Field top.fieldl[];

The following example copies across the source element name. Each fieldl
element is retained as a fieldl element under the Target element.

SET OutputRoot.XMLNS.Output_top.Outfield3.Target.[]
= InputRoot.XMLNS.Field_top.fieldl[];

This example is an alternative way to achieve the same result, with fieldl
elements created under the Target element.

SET OutputRoot.XMLNS.Output top.Outfield4.Target.=*[]
= InputRoot.XMLNS.Field top.fieldl[];

These examples show that there are several ways in which you can code ESQL to
copy repeating fields from source to target. Select the most appropriate method to
achieve the results that you require.

The principals shown here apply equally to all areas of the message tree to which
you can write data, not just the output message tree.

A note about copying fields:

Be aware that, when copying an input message element to an output element, not
only the value of the output element but also its type is set to that of the input
element. This means that if, for example, you have an input XML document with
an attribute, and you want to set a Field element (rather than an attribute) in your
output message to the value of the input attribute, you have to include a TYPE
clause cast to change the element-type from attribute to Field.

For example, given an input like:
<Fiel1d0l Attrib0l='Attrib@l Value'>Field0l_Value</Field01>
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To create an output like:
<MyField_A MyAttrib_A='Attrib0l_Value' MyAttrib_B='Field0l Value' >
<MyField B>Field01 Value</MyField BC>
<MyField_C>Attrib@1_ Value</MyField_C>
</MyField A'>

You would use the following ESQL:

-- Create output attribute from input attribute

SET OutputRoot.XMLNSC.MyField_A.MyAttrib_A = InputRoot.XMLNSC.Field01l.Attrib01;
-- Create output field from input field

SET QutputRoot.XMLNSC.MyField_A.MyField B = InputRoot.XMLNSC.Field01;

-- Create output attribute from input field value, noting we have to

- "cast" back to an attribute element

SET OutputRoot.XMLNSC.MyField A.(XMLNSC.Attribute)MyAttrib B =
InputRoot.XMLNSC.FieldOl;

-- Create output field from input attribute value, noting we have to

-- "cast" back to a field element

SET OutputRoot.XMLNSC.MyField A.(XMLNSC.Field)MyField C =
InputRoot.XMLNSC.Field01.Attrib01;

Working with elements of type list:

The XML Schema specification allows an element, or attribute, to contain a list of
values that are based on a simple type, with the individual values separated by
white space. In the message tree, an xsd:1ist element is represented as a name
node, with an anonymous child node for each list item. Repeating lists can be
handled without any loss of information.

Consider the following XML input message:

<messagel>
<listEl>one two three</TistEl>
</messagel>

This XML element produces the following message tree:

MRM

1istET (Name)
"one"  (Value)
"two"  (Value)
"three" (Value)

Individual list items can be accessed as ElementName.*[n].

For example, use the following ESQL to access the third item of listE1:
SET X = FIELDVALUE (InputBody.messagel.listEl.*[3]);

An attribute can also be of type xsd:1ist.
Consider the following XML input message:
<messagel>

<Element TistAttr="one two three"/>
</messagel>

This XML element produces the following message tree:



MRM

Element (Name)
listAttr (Name)
"one" (Value)
"two" (Value)
"three" (Value)

As before, individual list items can be accessed as AttrName.=*[n].

For example, use the following ESQL to access the third item of listAttr:
SET X = FIELDVALUE (InputBody.messagel.Element.listAttr.*[3]);

A list element can occur more than once.

Consider the following XML message:

<messagel>
<listEl>one two three/listEl>
<listEl>four five six/1istEl>
</messagel>

The message tree for this XML message is:
MRM
1TistEl (Name)
"one" (Value)
"two" (Value)
"three" (Value)
1istEl (Name)
"four" (Value)
"five" (Value)
"six" (Value)

Code the following ESQL to access the first item in the second occurrence of the
list:
SET X = FIELDVALUE (InputBody.messagel.listE1[2].x[1]);

Mapping between a list and a repeating element:

Consider the form of the following XML input message:

<MRM>
<inner>abcde fghij 12345</inner>
</MRM>

where the element inner is of type xsd:1ist, and therefore has three associated
string values, rather than a single value.

To copy the three values into an output message, where each value is associated
with an instance of repeating elements as shown here:
<MRM>
<strl>abcde</strl>
<strl>fghij</strl>
<strl>12345</strl>
</MRM>

you might expect that the following ESQL syntax works:

DECLARE D INTEGER;
SET D = CARDINALITY(InputBody.strl.*[]);
DECLARE M INTEGER 1;
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WHILE M <= D DO
SET OutputRoot.MRM.str1[M] = InputBody.inner.x[M];
SETM =M+ 1;

END WHILE;

However, the statement:
SET OutputRoot.MRM.str1l[M] = InputBody.inner.*[M];

requests a tree copy from source to target. Because the target element does not yet
exist, the statement creates it, and its value and type are set from the source.

Therefore, to create the output message with the required format, given an input
element which is of type xsd:1ist, use the [“FIELDVALUE function” on page 1466|
to explicitly retrieve only the value of the source element:

SET OutputRoot.MRM.str1[M] = FIELDVALUE (InputBody.inner.*[M]);

Manipulating repeating fields in a message tree:

This topic describes the use of the SELECT function, and other column functions,
to manipulate repeating fields in a message tree.

Suppose that you want to perform a special action on invoices that have a total
order value greater than a certain amount. To calculate the total order value of an
Invoice field, you must multiply the Price fields by the Quantity fields in all the
Items in the message, and total the result. You can do this using a SELECT
expression as follows:

(
SELECT SUM( CAST(I.Price AS DECIMAL) = CAST(I.Quantity AS INTEGER) )
FROM Body.Invoice.Purchases."Item"[] AS I
)

The example assumes that you need to use CAST expressions to cast the string
values of the fields Price and Quantity into the correct data types. The cast of the
Price field into a decimal produces a decimal value with the natural scale and
precision, that is, whatever scale and precision is necessary to represent the
number. These CASTs would not be necessary if the data were already in an
appropriate data type.

The SELECT expression works in a similar way to the quantified predicate, and in
much the same way that a SELECT works in standard database SQL. The FROM
clause specifies what is being iterated, in this case, all Item fields in Invoice, and
establishes that the current instance of Item can be referred to using I. This form of
SELECT involves a column function, in this case the SUM function, so the SELECT
is evaluated by adding together the results of evaluating the expression inside the
SUM function for each Item field in the Invoice. As with standard SQL, NULL
values are ignored by column functions, with the exception of the COUNT column
function explained below, and a NULL value is returned by the column function
only if there are no non-NULL values to combine.

The other column functions that are provided are MAX, MIN, and COUNT. The
COUNT function has two forms that work in different ways with regard to
NULLSs. In the first form you use it much like the SUM function above, for
example:



SELECT COUNT(I.Quantity)
FROM Body.Invoice.Purchases."Item"[] AS I

This expression returns the number of Item fields for which the Quantity field is
non-NULL. That is, the COUNT function counts non-NULL values, in the same
way that the SUM function adds non-NULL values. The alternative way of using
the COUNT function is as follows:

SELECT COUNT(*)
FROM Body.Invoice.Purchases."Item"[] AS I

Using COUNT(*) counts the total number of Item fields, regardless of whether any
of the fields is NULL. The above example is in fact equivalent to using the
CARDINALITY function, as in the following:

CARDINALITY (Body.Invoice.Purchases."Item"[]

In all the examples of SELECT given here, just as in standard SQL, you could use a
WHERE clause to provide filtering on the fields.

Manipulating other parts of the message tree

The following topics describe how you can access parts of the message tree other

than the message body data. These parts of the logical tree are independent of the
domain in which the message exists, and all these topics apply to messages in the
BLOB domain in addition to all other supported domains.

* |“Accessing headers’]

* |“Accessing the Properties tree” on page 294|

* |“Accessing the LocalEnvironment tree” on page 295|

* [“Accessing the Environment tree” on page 299

* |“Accessing the ExceptionList tree” on page 300]

Accessing headers:

If the input message received by an input node includes message headers that are
recognized by the input node, the node invokes the correct parser for each header.
You can access these headers using ESQL.

Parsers are supplied for most WebSphere MQ headers. The topics listed below
provide some guidance for accessing the information in the MQMD, MQRFH2, and
MQPCF headers, which you can follow as general guidance for accessing other
headers also present in your messages.

Every header has its own correlation name, for example, MQMD, and you must
use this name in all ESQL statements that refer to or set the content of this tree:

* [“Accessing the MQMD header”]
* |“Accessing the MQRFH2 header” on page 292|
* |“Accessing the MQCFH header” on page 293|

For further details of the contents of these and other WebSphere MQ headers for
which WebSphere Message Broker provides a parser, see [“Element definitions for|
[message parsers” on page 1259

Accessing the MQMD header:
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Code ESQL statements to access the fields of the MQMD header.

WebSphere MQ, WebSphere MQ Everyplace, and SCADA messages include an
MQMD header. You can refer to the fields within the MQMD, and you can update
them in a Compute node.

For example, you might want to copy the message identifier MSGID in the MQMD
to another field in your output message. To do that, code:

SET OutputRoot.MRM.Identifier = InputRoot.MQMD.Msgld;

If you send a message to an EBCDIC system from a distributed system, you might
need to convert the message to a compatible CodedCharSetld and Encoding. To do
this conversion, code the following ESQL in the Compute node:

SET OQutputRoot.MQMD.CodedCharSetId = 500;
SET OutputRoot.MQMD.Encoding = 785;

The MQMD properties of CodedCharSetld and Encoding define the code page and
encoding of the section of the message that follows (typically this is either the
MQRFH2 header or the message body itself).

Differences exist in the way the Properties folder and the MQMD folder are treated
with respect to which folder takes precedence for the same fields. For more
information, see |“Properties versus MQMD folder behavior for various transports”]

|on page 53.|

Accessing the MQRFH?2 header:

Code ESQL statements to access the fields of the MQRFH2 header.

When you construct an MQRFH2 header in a Compute node, it includes two types
of fields:

* Fields in the MQRFH2 header structure; for example, Format and
NameValueCCSID.

¢ Fields in the MQRFH2 NameValue buffer; for example, mcd and psc.

To differentiate between these two field types, insert a value in front of the
referenced field in the MQRFH? field to identify its type; a value for the
NameValue buffer is not required because this is the default. The value that you
specify for the header structure is (MQRFH2.Field).

For example:
* To create or change an MQRFH2 Format field, specify the following ESQL:

SET OutputRoot.MQRFH2.(MQRFH2.Field)Format = 'MQSTR ';
* To create or change the psc folder with a topic:
SET OutputRoot.MQRFH2.psc.Topic = 'department';

* To add an MQRFH?2 header to an outgoing message that is to be used to make a
subscription request:



DECLARE I INTEGER 1;
DECLARE J INTEGER CARDINALITY(InputRoot.*[]);

WHILE I < J DO

SET OutputRoot.*[I] = InputRoot.*[I];
SET I=I+1;

END WHILE;

SET OutputRoot.MQRFH2.(MQRFH2.Field)Version = 2;

SET OutputRoot.MQRFH2.(MQRFH2.Field)Format = 'MQSTR';

SET OutputRoot.MQRFH2. (MQRFH2.Field)NameValueCCSID = 1208;
SET OutputRoot.MQRFH2.psc.Command = 'RegSub';

SET OutputRoot.MQRFH2.psc.Topic = "InputRoot"."MRM"."topel";
SET OutputRoot.MQRFH2.psc.QMgrName = 'DebugQM';

SET OutputRoot.MQRFH2.psc.QName = 'PUBOUT';

SET OutputRoot.MQRFH2.psc.RegOpt = 'PersAsPub';

Variable ] is initialized to the value of the cardinality of the existing headers in
the message. Using a variable is more efficient than calculating the cardinality on
each iteration of the loop, which happens if you code the following WHILE
statement:

WHILE I < CARDINALITY(InputRoot.*[]) DO

The MQRFH?2 header can be parsed using either the MQRFH?2 parser or the
MQRFH2C compact parser. To consume less memory, use the MQRFH2C compact
parser by selecting the Use MQRFH2C compact parser for MQRFH2 Header check box
on the input node of the message flow. This results in paths that contain
MQRFH2C instead of MQRFH2; for example: SET OutputRoot.MQRFH2C.psc.Topic
= 'department';

Target MQRFH2 fields are created only if the headers are copied, and the
MQRFH2C parser option is not selected on the MQInput node. In all other
circumstances, an MQRFH2C field is created on output.

Accessing the MQCFH header:

Code ESQL statements to access the fields of the MQCFH header (root name
MQPCE).

Messages that are of PCF format (MQPCE, MQADMIN, and MQEVENT) include
the MQCFH header. You can process the contents of the MQCFH header, accessing
parameters, parameter lists, strings and groups.

* To access or to construct parameters in the header, use the following syntax:
OutputRoot.MQPCF.Parameter[nn] = Integer parameter ID

If you access a 64-bit parameter, use the following syntax to differentiate from
32-bit parameters:

OutputRoot.MQPCF.Parameter64[nn] = Integer parameter ID

For example:
OutputRoot.MQPCF.Parameter[1] = MQCACF_AUTH_PROFILE_NAME;
* For parameter lists, use the following syntax:

OutputRoot.MQPCF.ParameterList64[nn] = Integer parameter ID
OutputRoot.MQPCF.ParameterList64[nn].x[xx] = Integer parameter values

For example:
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OutputRoot.MQPCF.ParameterList[1] = MQIACF_AUTH_ADD_AUTHS;
OutputRoot.MQPCF.ParameterList[1].*[1] = MQAUTH_SET;
OutputRoot.MQPCF.ParameterList[1].*[2] = MQAUTH_SET_ALL_CONTEXT;

* A byte string is a byte array data type, and is supported with this syntax:
OutputRoot.MQPCF.Parameter[nn] = Integer parameter ID
OutputRoot.MQPCF.Parameter[nn].* = Integer, String or ByteArray Parameter value

* A group is implemented as a folder containing more PCF, and requires the
following syntax:

OutputRoot.MQPCF.Group[xx] = Group Parameter ID

For example:

OutputRoot .MQPCF.Group[1] = MQGACF_Q ACCOUNTING_DATA;
OutputRoot.MQPCF.Group[1].Parameter[1] = MQCA_CREATION_DATE;
OutputRoot.MQPCF.Group[1] .Parameter[1].* = '2007-02-05";

You can also use nested groups; for example;

OutputRoot.MQPCF.Group[1].Group[1] = MQGACF_Q ACCOUNTING_DATA;
OutputRoot.MQPCF.Group[1].Group[1].Parameter[1] = MQCA_CREATION_DATE;
OutputRoot.MQPCF.Group[1].Group[1].Parameter[1].* = '2007-02-05";

* A filter is almost identical to a parameter, but it also includes an operator.
Therefore the syntax is a tree with named values:
OutputRoot.MQPCF.Filter[xx] = Integer parameter ID

OutputRoot.MQPCF.Filter[xx].Operator = Integer Filter name
OutputRoot.MQPCF.Filter[xx].Value = Byte, Integer or String Filter Value

Accessing the Properties tree:

The Properties tree has its own correlation name, Properties, and you must use this
in all ESQL statements that refer to or set the content of this tree.

The fields in the Properties tree contain values that define the characteristics of the
message. For example, the Properties tree contains a field for the message domain,
and fields for the encoding and CCSID in which message data is encoded. For a
full list of fields in this tree, see |[“Data types for elements in the Properties subtree”]

on page 1260,

You can interrogate and update these fields using the appropriate ESQL
statements. If you create a new output message in the Compute node, you must
set values for the message properties.

Setting output message properties:

If you use the Compute node to generate a new output message, you must set its
properties in the Properties tree. The output message properties do not have to be
the same as the input message properties.

For example, to set the output message properties for an output MRM message, set
the following properties:

Property Value

Message domain MRM

Message set Message set identifier
Message type Message name?
Message format Physical format name?
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Notes:

1. For details of the syntax of Message type, see [Specifying namespaces in|
[the Message Type property]

2. The name that you specify for the physical layer must match the name
that you have defined for it. The default physical layer names are
Binaryl, XML1, and Textl.

This ESQL procedure sets message properties to values passed in by the calling
statement. You might find that you have to perform this task frequently, and you
can use a procedure such as this in many different nodes and message flows. If
you prefer, you can code ESQL that sets specific values.

CREATE PROCEDURE setMessageProperties(IN OutputRoot REFERENCE, IN setName char,
IN typeName char, IN formatName char) BEGIN

[ ek ko ko ok ke kok ok ok ok ok R B R T B R

* A procedure that sets the message properties

****************************************************************************/

set QutputRoot.Properties.MessageSet = setName;

set OutputRoot.Properties.MessageType = typeName;

set QutputRoot.Properties.MessageFormat = formatName;

END;

To set the output message domain, you can set the message property, or you can
code ESQL statements that refer to the required domain in the second qualifier of
the SET statement, the parser field. For example, the ESQL statement sets the
domain to MRM:

SET OQutputRoot.MRM.Fieldl = 'fieldl data';

This ESQL statement sets the domain to XMLNS:

SET OutputRoot.XMLNS.Fieldl = 'fieldl data';

Do not specify more than one domain in the ESQL for any single message.
However, if you use PROPAGATE statements to generate several output messages,

you can set a different domain for each message.

For information about the full list of elements in the Properties tree, see
[types for elements in the Properties subtree” on page 1260.

Differences exist in the way the Properties folder and the MQMD folder are treated
with respect to which folder takes precedence for the same fields. For more
information, see |“Properties versus MQMD folder behavior for various transports”]

|0n page 53.|

Accessing the LocalEnvironment tree:

The LocalEnvironment tree has its own correlation name, LocalEnvironment, and
you must use this name in all ESQL statements that refer to or set the content of
this tree.

The LocalEnvironment tree is used by the broker, and you can refer to and modify
this information. You can also extend the tree to contain information that you
create yourself. You can create subtrees within this tree that you can use as a
scratchpad or working area.
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The message flow sets up information in two subtrees, Destination and
WrittenDestination, below the LocalEnvironment root. You can refer to the content
of both of these, and you can write to them to influence the way in which the
message flow processes your message. However, if you write to these areas, ensure
that you follow the defined structure to ensure that the tree remains valid.

If you want the LocalEnvironment tree to be included in the output message that
is propagated by the Compute node, you must set the Compute node property
Compute mode to a value that includes LocalEnvironment (for example, A11). If you
do not, the LocalEnvironment tree is not copied to the output message.

The information that you insert into DestinationData or Defaults depends on the
characteristic of the corresponding node property:

* If a node property is represented by a check box (for example, New Message ID),
set the Defaults or DestinationData element to Yes (equivalent to selecting the
check box) or No (equivalent to clearing the check box).

* If a node property is represented by a drop-down list (for example, Transaction
Mode), set the Defaults or DestinationData element to the appropriate character
string (for example Automatic).

 If a node property is represented by a text entry field (for example, Queue
Manager Name), set the Defaults or DestinationData element to the character
string that you would enter in this field.

If necessary, configure the sending node to indicate where the destination
information is. For example, for the output node MQOutput, set Destination Mode:

* If you set Destination Mode to Queue Name, the output message is sent to the
queue identified in the output node properties Quene Name and Queue Manager
Name. Destination is not referenced by the node.

* If you set Destination Mode to Destination List, the node extracts the
destination information from the Destination subtree. If you use this value you
can send a single message to multiple destinations, if you configure Destination
and a single output node correctly. The node only checks the node properties if
a value is not available in Destination (as described above).

* If you set Destination Mode to Reply To Queue, the message is sent to the reply-to
queue identified in the MQMD in this message (field ReplyToQ). Destination is
not referenced by the node.

To find more information about ESQL procedures that perform typical updates to
the LocalEnvironment see [“Populating Destination in the LocalEnvironment tree”]

Review the ESQL statements in these procedures to see how to

modify LocalEnvironment. You can use these procedures unchanged, or modify
them for your own requirements.

To find more information about how to extend the contents of this tree for your
own purposes see [“Using scratchpad areas in LocalEnvironment” on page 297

For another example of how you can use LocalEnvironment to modify the
behavior of a message flow, refer to the XML_PassengerQuery message flow in the
following sample program:

+ |Airline Reservations sample

The Compute node in this message flow writes a list of destinations in the
RouterList subtree of Destination that are used as labels by a later RouteToLabel


/help/livehelp/?pluginID=com.ibm.samplegallery&class=com.ibm.samplegallery.SampleGalleryAction&arg=com.ibm.etools.mft.samples.airline.xml.doc/doc/overview.htm

node that propagates the message to the corresponding Label node. You can view
samples only when you use the information center that is integrated with the
Message Broker Toolkit.

Using scratchpad areas in LocalEnvironment:

The LocalEnvironment tree includes a subtree called Variables. This is always
created, but is never populated by the message flow. Use this area for your own
purposes, for example to pass information from one node to another. You can
create other subtrees in the LocalEnvironment tree if you choose.

The advantage of creating your own data in a scratchpad in the LocalEnvironment
is that this data can be propagated as part of the logical tree to subsequent nodes
in the message flow. If you create a new output message in a Compute node, you
can also include all or part of the LocalEnvironment tree from the input message in
the new output message.

To ensure that the information in the LocalEnvironment is propagated further
down the flow, the Compute mode property of the Compute node must be set to
include LocalEnvironment as part of the output tree (for example, specify
LocalEnvironment and Message). See [‘Setting the mode” on page 783 for further
details about Compute mode.

However, any data updates or additions that you make in one node are not
retained if the message flows backwards through the message flow (for example, if
an exception is thrown). If you create your own data, and want that data to be
preserved throughout the message flow, you must use the Environment tree.

You can set values in the Variables subtree in a Compute node that are used later
by another node (Compute, Database, or Filter) for some purpose that you
determine when you configure the message flow.

Because LocalEnvironment is not in scope in a Compute node,
InputLocalEnvironment and OutputLocalEnvironment must be used instead.

For example, you might use the scratchpad in the LocalEnvironment to propagate
the destination of an output message to subsequent nodes in a message flow. Your
first Compute node determines that the output messages from this message flow
must go to WebSphere MQ queues. Include the following ESQL to insert this
information into the LocalEnvironment by setting the value of OutputLocation in
the OutputLocalEnvironment:

SET OutputLocalEnvironment.Variables.OutputLocation = 'MQ"';

Your second Compute node can access this information from its input message. In
the ESQL in this node, use the correlation name InputLocalEnvironment to identify
the LocalEnvironment tree within the input message that contains this data. The
following ESQL sets queueManagerName and queueName based on the content of
OutputLocation in the LocalEnvironment, using InputLocalEnvironment:
IF InputLocalEnvironment.Variables.OutputLocation = 'MQ' THEN
SET OutputLocalEnvironment.Destination.MQ.DestinationData.queueManagerName = 'myQManagerName';

SET OutputLocalEnvironment.Destination.MQ.DestinationData.queueName = 'myQueueName';
END IF;

In the example queueManagerName and queueName are set for the Destination
subtree in the output message. The Compute mode of the second compute node
must be set to include the LocalEnvironment tree in the output message. Configure

Developing message flows 297



the MQOutput node to use the destination list that you have created in the
LocalEnvironment tree by setting property Destination Mode to Destination List.

For information about the full list of elements in the DestinationData subtree, see
[‘Data types for elements in the DestinationData subtree” on page 1261

Populating Destination in the LocalEnvironment tree:

You can use the Destination subtree to set up target destinations that are used by
output nodes, the HTTPRequest node, SOAPRequest node, the
SOAPAsyncRequest, and the RouteToLabel node. The following examples show
how you can create and use an ESQL procedure to perform the task of setting up
values for each of these uses.

You can copy and use these procedures as shown, or you can modify or extend
them to perform similar tasks.

Adding a queue name for the MQOutput node

CREATE PROCEDURE addToMQDestinationList(IN LocalEnvironment REFERENCE, IN newQueue char) BEGIN
/*******************************************************************************
* A procedure that will add a queue name to the MQ destination Tist

in the local environment.

This 1ist is used by a MQOutput node that has its mode set to Destination list.

IN LocalEnvironment: LocalEnvironment to be modified.
Set this to OutputLocalEnvironment when calling this procedure
IN queue: queue to be added to the list

* %k ok 3k X X X

*******************************************************************************/
DECLARE I INTEGER CARDINALITY(LocalEnvironment.Destination.MQ.DestinationDatal[]);
IF I = 0 THEN

SET LocalEnvironment.Destination.MQ.DestinationData[1].queueName = newQueue;
ELSE

SET LocalEnvironment.Destination.MQ.DestinationData[I+1].queueName = newQueue;
END IF;
END;

Changing the default URL for a SOAPRequest node or a SOAPAsyncRequest
node request

CREATE PROCEDURE overrideDefaultSOAPRequestURL(IN LocalEnvironment REFERENCE, IN newUrl char) BEGIN
/*******************************************************************************
* A procedure that will change the URL to which the SOAPRequest node or

SOAPAsyncRequest node will send the request.

IN LocalEnvironment: LocalEnvironment to be modified.
Set this to OQutputLocalEnvironment when calling this procedure
IN queue: URL to send the request to.

* ok Sk X X X

*******************************************************************************/

set LocalEnvironment.Destination.SOAP.Request.Transport.WebServiceURL = newUrl;
END;

Changing the default URL for an HTTPRequest node request
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CREATE PROCEDURE overrideDefaultHTTPRequestURL(IN LocalEnvironment REFERENCE, IN newUrl char) BEGIN

/*******************************************************************************

* A procedure that will change the URL to which the HTTPRequest node will send the request.

* ok

IN LocalEnvironment: LocalEnvironment to be modified.

* Set this to OutputLocalEnvironment when calling this procedure
* IN queue: URL to send the request to.

*

*******************************************************************************/

set LocalEnvironment.Destination.HTTP.RequestURL = newUrl;
END;

Adding a label for the RouteToLabel node

CREATE PROCEDURE addToRouteToLabelList(IN LocalEnvironment REFERENCE, IN newLabel char) BEGIN

/*******************************************************************************

* A procedure that will add a Tabel name to the RouteTolLabel Tist

* in the local environment.
* This Tist is used by a RoteTolLabel node.
*
* IN LocalEnvironment: LocalEnvironment to be modified.
* Set this to OutputLocalEnvironment when calling this procedure
* IN Tabel: label to be added to the Tist
*
* % % Kk k% % *Axkhkhkhkhhkhhhkhhhhhhkhhkhkhkhk%k *Axkhkkhhhkhhhhhhhhhhhkhkhkhk*k *Axkhkkhhhkhhhhhhhhhkhkkhkhk*k /
if LocalEnvironment.Destination.RouterList.DestinationData is null then
set LocalEnvironment.Destination.RouterList.DestinationData."Tabel" = newlLabel;
else

create LASTCHILD OF LocalEnvironment.Destination.RouterList.DestinationData
NAME 'label' VALUE newlLabel;
end if;
END;

Setting up JMS destination lists
The following example shows how to set up JMS destination lists in the
LocalEnvironment tree.

CREATE PROCEDURE CreateJMSDestinationList() BEGIN
SET OutputLocalEnvironment.Destination.JMSDestinationList.DestinationData[1]
SET OutputLocalEnvironment.Destination.JMSDestinationList.DestinationData[2]
SET OQutputLocalEnvironment.Destination.JMSDestinationList.DestinationData[3]
END;

'jndi://TestDestQueuel';
'jndi://TestDestQueue2';
'jndi://TestDestQueue3';

Accessing the Environment tree:

The Environment tree has its own correlation name, Environment, and you must
use this name in all ESQL statements that refer to, or set, the content of this tree.

The Environment tree is always created when the logical tree is created for an
input message. However, the message flow neither populates it, nor uses its
contents. You can use this tree for your own purposes, for example, to pass
information from one node to another. You can use the whole tree as a scratchpad
or working area.

The advantage of creating your own data in Environment is that this data is
propagated as part of the logical tree to subsequent nodes in the message flow. If
you create a new output message in a Compute node, the Environment tree is also
copied from the input message to the new output message. (In contrast to the
LocalEnvironment tree, which is only included in the output message if you
explicitly request that it is).
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Only one Environment tree is present for the duration of the message flow. Any
data updates, or additions, that you make in one node are retained, and all of the
nodes in the message flow have access to the latest copy of this tree. Even if the
message flows back through the message flow (for example, if an exception is
thrown, or if the message is processed through the second terminal of the
FlowOrder node), the latest state is retained. (In contrast to the LocalEnvironment
tree, which reverts to its previous state if the message flows back through the
message flow.)

You can use this tree for any purpose you choose. For example, you can use the
following ESQL statements to create fields in the tree:

SET Environment.Variables =
ROW('granary' AS bread, 'reisling' AS wine, 'stilton' AS cheese);
SET Environment.Variables.Colors[] =
LIST{'yellow', 'green', 'blue', 'red', 'black'};
SET Environment.Variables.Country[] = LIST{ROW('UK' AS name, 'pound' AS currency),
ROW('USA' AS name, 'dollar' AS currency)};

This information is now available to all nodes to which a message is propagated,
regardless of their relative position in the message flow.

For another example of how you can use Environment to store information used
by other nodes in the message flow, look at the Reservation message flow in the
following sample:

+ |Airline Reservations sample|

The Compute node in this message flow writes information to the subtree
Environment.Variables that it has extracted from a database according to the value
of a field in the input message.

You can view samples only when you use the information center that is integrated
with the Message Broker Toolkit.

Accessing the ExceptionList tree:

The ExceptionList tree has its own correlation name, ExceptionList, and you must
use this in all ESQL statements that refer to or set the content of this tree.

This tree is created with the logical tree when an input message is parsed. It is
initially empty, and is only populated if an exception occurs during message flow
processing. It is possible that more than one exception can occur; if more than one
exception occurs, the ExceptionList tree contains a subtree for each exception.

You can access the ExceptionList tree in Compute, Database, and Filter nodes, and
you can update it in a Compute node. You must use the appropriate correlation
name; ExceptionList for a Database or Filter node, and InputExceptionList for a
Compute node.

You might want to access this tree in a node in an error handling procedure. For
example, you might want to route the message to a different path based on the
type of exception, for example one that you have explicitly generated using an
ESQL THROW statement, or one that the broker has generated.

The following ESQL shows how you can access the ExceptionList and process each
child that it contains:
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-- Declare a reference for the ExceptionList
-- (in a Compute node use InputExceptionList)
DECLARE start REFERENCE TO ExceptionlList.*[1];

-- Loop through the exception 1ist children
WHILE start.Number IS NOT NULL DO
-- more ESQL

-- Move start to the last child of the field to which it currently points
MOVE start LASTCHILD;
END WHILE;

The following example shows an extract of ESQL that has been coded for a
Compute node to loop through the exception list to the last (nested) exception
description and extract the error number. This error relates to the original cause of
the problem and normally provides the most precise information. Subsequent
action taken by the message flow can be decided by the error number retrieved in
this way.

CREATE PROCEDURE getlLastExceptionDetail(IN InputTree reference,0UT messageNumber integer,
OUT messageText char)
/****************************************************************************
A procedure that will get the details of the last exception from a message
IN InputTree: The incoming exception Tist
IN messageNumber: The Tast message numberr.
IN messageText: The Tast message text.
*****************************************************************************/
BEGIN
-- Create a reference to the first child of the exception list
declare ptrException reference to InputTree.*[1];
-- keep looping while the moves to the child of exception list work
WHILE lastmove(ptrException) DO
-- store the current values for the error number and text
IF ptrException.Number is not null THEN
SET messageNumber = ptrException.Number;
SET messageText = ptrException.Text;
END IF;
-- now move to the last child which should be the next exceptionlist
move ptrException lastchild;
END WHILE;
END;

EE I .

For more information about the use of ExceptionList, look at the subflow in the
following sample which includes ESQL that interrogates the ExceptionList
structure and takes specific action according to its content:

* [Error Handler sample|

You can view samples only when you use the information center that is integrated
with the Message Broker Toolkit.

Transforming from one data type to another

You can use ESQL to transform messages and data types in many ways. The
following topics provide guidance about the following:

+ [“Casting data from message fields”]

+ [“Converting code page and message encoding” on page 302
+ [“Converting EBCDIC NL to ASCII CR LE” on page 305
+ |“Changing message format” on page 307]

Casting data from message fields:
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When you compare an element with another element, variable or constant, ensure
that the value with which you are comparing the element is consistent (for
example, character with character). If the values are not consistent, the broker
generates a runtime error if it cannot provide an implicit casting to resolve the

inconsistency. For details of what implicit casts are supported, see [“Implicit casts”
on page 1507,

You can use the CAST function to transform the data type of one value to match
the data type of the other. For example, you can use the CAST function when you
process generic XML messages. All fields in an XML message have character
values, so if you want to perform arithmetic calculations or datetime comparisons,
for example, you must convert the string value of the field into a value of the
appropriate type using CAST.

In the Invoice message, the field InvoiceDate contains the date of the invoice. If
you want to refer to or manipulate this field, you must CAST it to the correct
format first. For example, to refer to this field in a test:

IF CAST(Body.Invoice.InvoiceDate AS DATE) = CURRENT DATE THEN

This converts the string value of the InvoiceDate field into a date value, and
compares it to the current date.

Another example is casting from integer to character:

DECLARE I INTEGER 1;
DECLARE C CHARACTER;

-- The following statement generates an error
SET C = I;

-- The following statement is valid
SET C = CAST(I AS CHARACTER);

Converting code page and message encoding:

You can use ESQL within a Compute node to convert data for code page and
message encoding. If your message flow is processing WebSphere MQ messages,
you can use WebSphere MQ facilities (including get and put options and
WebSphere MQ data conversion exits) to provide these conversions. If you are not
processing WebSphere MQ messages, or you choose not to use WebSphere MQ
facilities, you can use WebSphere Message Broker facilities by coding the
appropriate ESQL in a Compute node in your message flow.

The contents of the MOQMD, the MQRFH?2, and the message body of a message in
the MRM domain that has been modeled with a CWF physical format can be
subject to code page and encoding conversion. The contents of a message body of
a message in the XML, XMLNS, and JMS domains, and those messages in the
MRM domain that have been modeled with an XML or TDS physical format, are
treated as strings. Only code page conversion applies; no encoding conversion is
required.

For messages in the MRM domain modeled with a CWF physical format, you can
set the MQMD CCSID and Encoding fields of the output message, plus the CCSID
and Encoding of any additional headers, to the required target value.



For messages in the MRM domain modeled with an XML or TDS physical format,
you can set the MQMD CCSID field of the output message, plus the CCSID of any
additional headers. XML and TDS data is handled as strings and is therefore
subject to CCSID conversion only.

An example WebSphere MQ message has an MQMD header, an MQRFH2 header,
and a message body. To convert this message to a mainframe CodedCharSetld and
Encoding, code the following ESQL in the Compute node:

SET OQutputRoot.MQMD.CodedCharSetId = 500;
SET OQutputRoot.MQMD.Encoding = 785;

SET OQutputRoot.MQRFH2.CodedCharSetId = 500;
SET OQutputRoot.MQRFH2.Encoding = 785;

The following example illustrates what you must do to modify a CWF message so
that it can be passed from WebSphere Message Broker to IMS" on z/OS.

1. You have defined the input message in XML and are using an MQRFH2
header. Remove the header before passing the message to IMS.

2. The message passed to IMS must have MQIIH header, and must be in the
z/0S code page. This message is modeled in the MRM and has the name
IMSI1. Define the PIC X fields in this message as logical type string for
conversions between EBCDIC and ASCII to take place. If they are logical type
binary, no data conversion occurs; binary data is ignored when a CWF message
is parsed by the MRM parser.

3. The message received from IMS is also defined in the MRM and has the name
IMS2. Define the PIC X fields in this message as logical type string for
conversions between EBCDIC and ASCII to take place. If they are logical type
binary, no data conversion occurs; binary data is ignored when a CWF message
is parsed by the MRM parser.

4. Convert the reply message to the Windows code page. The MQIIH header is
retained on this message.

5. You have created a message flow that contains the following nodes: :
a. The outbound flow, MQInputl --> Computel --> MQOutputl.
b. The inbound flow, MQInput2 --> Compute2 --> MQOutput2.

6. Code ESQL in Computel (outbound) node as follows, specifying the relevant
MessageSet id. This code shows the use of the default CWF physical layer
name. You must use the name that matches your model definitions. If you
specify an incorrect value, the broker fails with message BIP5431.
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-- Loop to copy message headers
DECLARE I INTEGER 1;
DECLARE J INTEGER CARDINALITY(InputRoot.x[]);

WHILE I <J -1 DO
SET OutputRoot.*[I] = InputRoot.*[I];
SET I=I+1;

END WHILE;

SET OQutputRoot.MQMD.CodedCharSetId = 500;

SET OQutputRoot.MQMD.Encoding = 785;

SET OutputRoot.MQMD.Format = 'MQIMS ';

SET OQutputRoot.MQIIH.Version = 1;

SET OutputRoot.MQIIH.StrucLength = 84;

SET OQutputRoot.MQIIH.Encoding = 785;

SET OQutputRoot.MQIIH.CodedCharSetId = 500;

SET OQutputRoot.MQIIH.Format = 'MQIMSVS ';

SET OQutputRoot.MQIIH.Flags = 0;

SET OQutputRoot.MQIIH.LTermOverride = ' 'y

SET OQutputRoot.MQIIH.MFSMapName = ' s

SET OutputRoot.MQIIH.ReplyToFormat = 'MQIMSVS ';

SET OQutputRoot.MQIIH.Authenticator = ' 'y

SET OQutputRoot.MQIIH.TranInstanceld = X'00000000000000000000000000000000" ;
SET OQutputRoot.MQIIH.TranState = ' ';

SET OQutputRoot.MQIIH.CommitMode = '0';

SET OQutputRoot.MQIIH.SecurityScope = 'C';

SET OQutputRoot.MQIIH.Reserved = ' ';

SET OutputRoot.MRM.e_elen08 = 30;

SET OutputRoot.MRM.e_elen09 = 0;

SET OutputRoot.MRM.e_string08 = InputBody.e_string01;
SET OutputRoot.MRM.e binary02 = X'31323334353637383940';
SET OQutputRoot.Properties.MessageDomain = 'MRM';

SET OutputRoot.Properties.MessageSet = 'DHCJOEGO72001';
SET OQutputRoot.Properties.MessageType = 'IMS1';

SET OQutputRoot.Properties.MessageFormat = 'Binaryl';

I © W |

Note the use of a variable, ], that is initialized to the value of the cardinality of
the existing headers in the message. This is more efficient than calculating the
cardinality on each iteration of the loop, which happens if you code the
following WHILE statement:

WHILE I < CARDINALITY(InputRoot.*[]) DO
7. Create ESQL in Compute2 (inbound) node as follows, specifying the relevant
MessageSet id. This code shows the use of the default CWF physical layer

name. You must use the name that matches your model definition. If you
specify an incorrect value, the broker fails with message BIP5431.
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-- Loop to copy message headers
DECLARE I INTEGER 1;
DECLARE J INTEGER CARDINALITY(InputRoot.x[]);

WHILE I < J DO
SET OutputRoot.*[I] = InputRoot.x[I];
SET I=I+1;

END WHILE;

SET OutputRoot.MQMD.CodedCharSetId = 437;

SET OutputRoot.MQMD.Encoding = 546;

SET OutputRoot.MQMD.Format = 'MQIMS ';

SET OutputRoot.MQIIH.CodedCharSetId = 437;

SET OutputRoot.MQIIH.Encoding = 546;

SET OutputRoot.MQIIH.Format = ' s

SET OQutputRoot.MRM = InputBody;

SET OutputRoot.Properties.MessageDomain = 'MRM';

SET OQutputRoot.Properties.MessageSet = 'DHCJOEGO72001';
SET OutputRoot.Properties.MessageType = 'IMS2';

SET QutputRoot.Properties.MessageFormat = 'Binaryl';

You do not have to set any specific values for the MQInputl node properties,
because the message and message set are identified in the MQRFH2 header, and
no conversion is required.

You must set values for message domain, set, type, and format in the MQInput
node for the inbound message flow (MQInput2). You do not need to set conversion
parameters.

One specific situation in which you might need to convert data in one code page
to another is when messages contain new line indicators and are passing between
EBCDIC and ASCII systems. The required conversion for this situation is described
in [“Converting EBCDIC NL to ASCII CR LE.”|

Converting EBCDIC NL to ASCII CR LF:

This topic describes an example task that changes new line (NL) characters in a
text message to carriage return (CR) and line feed (LF) character pairs.

This conversion might be useful if messages from an EBCDIC platform (for
example, using CCSID 1047) are sent to an ASCII platform (for example, using
CCSID 437). Problems can arise because the EBCDIC NL character hex 15’ is
converted to the undefined ASCII character hex "7F’. There is no corresponding
code point for the NL character in the ASCII code page.

In this example, a message flow is created that interprets the input message as a
message in the BLOB domain. This is passed into a ResetContentDescriptor node
to reset the data to a message in the MRM domain. The message is called msg_nl
(a set of repeating string elements delimited by EBCDIC NL characters). A
Compute node is then used to create an output based on another message in the
MRM domain called msg_crlf (a set of repeating string elements delimited by CR
LF pairs). The message domain is then changed back to BLOB in another
ResetContentDescriptor node. This message flow is illustrated below.
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The following instructions show how to create the messages and configure the
message flow.

1. Create the message models for the messages in the MRM domain:

a.
b.

f.

g.

Create a message set project called myProj.

Create a message set called myMessageSet with a TDS physical format (the
default name is Textl).

Create an element stringl of type xsd:string.

Create a complex type called t_msg_nl and specify the following complex

type properties:

* Composition = Ordered Set

* Content Validation = Closed

* Data Element Separation = A11 Elements Delimited

* Delimiter = <U+0085> (hex "0085" is the UTF-16 representation of a NL
character)

* Repeat = Yes

* Min Occurs =1

* Max Occurs = 50 (the text of the message is assumed to consist of no
more than 50 lines)

Add Element stringl and set the following property:

* Repeating Element Delimiter = <U+0085>

Create a Message msg_nl and set its associated complex type to t_msg_n]1

Create a complex type called t_msg_crlf and specify the following complex

type properties:

* Composition = Ordered Set

* Content Validation = Closed

* Data Element Separation = A11 Elements Delimited

* Delimiter <CR><LF> (<CR> and <LF> are the mnemonics for the CR and
LF characters)

* Repeat = Yes

* Min Occurs = 1

* Max Occurs = 50

Add Element string1l and set the following property:

* Repeating Element Delimiter = <CR><LF>

Create a Message msg_crlf and set complex type to t_msg_crlf.

2. Configure the message flow shown in the figure above:
a. Start with the MQInput node:

* Set Message Domain = BLOB
* Set Queue Name = <Your input message queue name>

b. Add the ResetContentDescriptor node, connected to the out terminal of
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MQInput:
* Set Message Domain = MRM
* Select Reset Message Domain



* Set Message Set = <Your Message Set ID> (this has a maximum of 13
characters)

* Select Reset Message Set

* Set Message Type = msg_n]

* Select Reset Message Type

* Set Message Format = Textl

* Select Reset Message Format

c. Add the Compute node, connected to the out terminal of
ResetContentDescriptor:
* Enter a name for the ESQL Module for this node, or accept the default
(<message flow name>_Compute).
* Right-click the Compute node and select Open ESQL. Code the following
ESQL in the module:

-- Declare local working variables
DECLARE I INTEGER 1;
DECLARE J INTEGER CARDINALITY(InputRoot.x[]);

-- Loop to copy all message headers from input to output message
WHILE I < J DO

SET OQutputRoot.*[I] = InputRoot.=*[I];

SET I=I+1;
END WHILE;

-- Set new output message type which uses CRLF delimiter
SET OutputRoot.Properties.MessageType = 't msg crlf';

-- Loop to copy each instance of stringl child within message body
SET I 1;
SET J = CARDINALITY("InputBody"."stringl"[]);
WHILE I <= J DO
SET "OutputRoot"."MRM"."stringl"[I] = "InputBody"."stringl"[I];
SET I=I+1;
END WHILE;

Note the use of a variable, ], initialized to the value of the cardinality of
the existing headers in the message. This is more efficient than calculating
the cardinality on each iteration of the loop, which happens if you code
the following WHILE statement:

WHILE I < CARDINALITY(InputRoot.*[]) DO

d. Add the ResetContentDescriptorl node, connected to the out terminal of the
Compute node:
* Set Message Domain = BLOB
* Select Reset Message Domain.

e. Finally, add the MQOutput node, connected to the out terminal of the
ResetContentDescriptorl node. Configure its properties to direct the output
message to the required queue or queues.

Changing message format:
Use the Compute node to copy part of an input message to an output message.
The results of such a copy depend on the type of input and output parsers

involved.

Like parsers:
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Where both the source and target messages have the same folder structure at root
level, a like-parser-copy is performed. For example:

SET OQutputRoot.MQMD = InputRoot.MQMD;

This statement copies all the children in the MQMD folder of the input message to
the MQMD folder of the output message.

Another example of a tree structure that supports a like-parser-copy is:
SET OutputRoot.XMLNS.Data.Account = InputRoot.XMLNS.Customer.Bank.Data;

To transform an input message in the MRM domain to an output message also in
the MRM domain, you can use either the Compute or the Mapping node. The
Mapping node can interpret the action that is required because it knows the format
of both messages. Content Assist in the ESQL module for the Compute node can
also use the message definitions for those messages. If the messages are not in the
same namespace, you must use the Compute node.

To use Content Assist with message references, you must set up a project reference
from the project containing the ESQL to the project containing the message set. For
information about setting up a project reference, see [Project references}

If both input and output messages are not in the MRM domain, you must use the
Compute node and specify the structure of the messages yourself.

Unlike parsers:

Where the source and target messages have different folder structures at root level,
you cannot make an exact copy of the message source. Instead, the
unlike-parser-copy views the source message as a set of nested folders terminated
by a leaf name-value pair. For example, copying the following message from XML
to MRM:

<Name3><Name31>Value31</Name31>Value32</Name3>

produces a name element Name3, and a name-value element called Name31 with
the value Value31. The second XML pcdata (Value32) cannot be represented and is
discarded.

The unlike-parser-copy scans the source tree, and copies folders, also known as
name elements, and leaf name-value pairs. Everything else, including elements
flagged as special by the source parser, is not copied.

An example of a tree structure that results in an unlike-parser-copy is:
SET OutputRoot.MRM.Data.Account = InputRoot.XMLNS.Data.Account;

If the algorithm used to make an unlike-parser-copy does not suit your tree
structure, you should further qualify the source field to restrict the amount of tree
copied.

Be careful when you copy information from input messages to output messages in
different domains. You could code ESQL that creates a message structure or
content that is not completely consistent with the rules of the parser that processes
the output message. This action can result in an output message not being created,
or being created with unexpected content. If you believe that the output message



generated by a particular message flow does not contain the correct content, or
have the expected form, check the ESQL that creates the output message, and look
for potential mismatches of structure, field types, field names, and field values.

When copying trees between unlike parsers, you should set the message format of
the target parser. For example, if a message set has been defined with XMLNS and
CWEF formats, the following commands are required to copy an input XMLNS
stream to the MRM parser and set the latter to be generated in CWF format:

-- Copy message to the output, moving from XMLNS to MRM domains

SET OQutputRoot.MRM = InputRoot.XMLNS.rootETement;

-- Set the CWF format for output by the MRM domain

SET OutputRoot.Properties.MessageType = '<MessageTypeName>';
SET OutputRoot.Properties.MessageSet = '<MessageSetName>';
SET OQutputRoot.Properties.MessageFormat = 'CWF';

Adding keywords to ESQL files

can be included in ESQL files in three ways:

comment fields
Add the keyword as a comment in the ESQL file:
-- $MQSI compiled by = John MQSI$

static strings
Include the keyword as part of a static string in the ESQL file:
Set target = '$MQSI_target = production only MQSI$'

variable string
Include the keyword value as a variable string in the ESQL file:
$MQSI_VERSION=$id$MQSI$

For this example, when the message flow source is extracted from the file
repository, the repository’s plug-in has been configured to substitute the
identifier $id$ with the actual version number. The identifier value that is
required depends on the capability and configuration of the repository, and
is not part of WebSphere Message Brokers.

Restrictions within keywords

Do not use the following characters within keywords because they cause
unpredictable behavior:

~$L | \<>24++=4]]

You can use these characters in the values that are associated with keywords; for
example:

* $MQSI RCSVER=$id$ MQSI$ is acceptable
* $MQSI $name=Fred MQSI$ is not acceptable

Accessing databases from ESQL
How to use ESQL statements and functions to access databases.

ESQL has a number of statements and functions for accessing databases:

* The['CALL statement” on page 1345|invokes a stored procedure.

+ The|'DELETE FROM statement” on page 1388| removes rows from a database
table.

* The[“INSERT statement” on page 1395/ adds a row to a database table.
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* The|“PASSTHRU function” on page 1514| can be used to make complex
selections.

* The|'PASSTHRU statement” on page 1404| can be used to invoke administrative
operations (for example, creating a table).

* The|’SELECT function” on page 1488| retrieves data from a table.

+ The|'UPDATE statement” on page 1417| changes one or more values stored in
Zero or more rows.

You can access user databases from Compute, Database, and Filter nodes.

Note: There is no difference between the database access capabilities of these

nodes; their names are partly historical and partly based on typical usage.
You can use the data in the databases to update or create messages; or use the data
in the message to update or create data in the databases.

* Any node that uses any of the ESQL database statements or functions must have
its Data Source property set with the name (that is, the ODBC DSN) of a
database. The database must be accessible, operational, and allow the broker to
connect to it.

* All databases accessed from the same node must have the same ODBC
functionality as the database specified on the node’s Data Source property. This
requirement is always satisfied if the databases are of the same type (for
example, DB2 or Oracle), at the same level (for example, release 8.1 CSD3), and
on the same platform. Other database combinations may or may not have the
same ODBC functionality. If a node tries to access a database that does not have
the same ODBC functionality as the database specified on the node’s Data
Source property, the broker issues an error message.

 All tables referred to in a single SELECT FROM clause must be in the same
database.

You must ensure that suitable ODBC data sources have been created on the system
on which the broker is running. If you have used the mgsisetdbparms command to
set a user ID and password for a particular database, the broker uses these values
to connect to the database. If you have not set a user ID and password, the broker
uses the default database user ID and password that you supplied on the
mgsicreatebroker command (as modified by any subsequent mgsichangebroker
commands).

On z/0S systems, use the JCL member BIPSDBP in the customization
data set <h1g>.SBIPPROC to perform the mqsisetdbparms command.

You must also ensure that the database user IDs have sufficient privileges to
perform the operations your flow requires. Otherwise errors will occur at runtime.

Select the Throw exception on database error property check box and the Treat
warnings as errors property check box, and set the Transaction property to
Automatic, to provide maximum flexibility. You can then use the COMMIT and
ROLLBACK statements for transaction control, and create handlers for dealing
with errors.

+ [“Referencing columns in a database” on page 311|

+ |“Selecting data from database columns” on page 312|

* |“Accessing multiple database tables” on page 315|

+ [“Changing database content” on page 317

+ [“Checking returns to SELECT” on page 317

+ “Committing database updates” on page 318




+ |“Invoking stored procedures” on page 319

Referencing columns in a database:

While the standard SQL SELECT syntax is supported for queries to an external
database, there are a number of points to be borne in mind. You must prefix the
name of the table with the keyword Database to indicate that the SELECT is to be
targeted at the external database, rather than at a repeating structure in the
message.

The basic form of database SELECT is:

SELECT ...
FROM Database.TABLE1
WHERE ...

If necessary, you can specify a schema name:

SELECT ...
FROM Database.SCHEMA.TABLE1
WHERE ...

where SCHEMA is the name of the schema in which the table TABLE1 is defined.
Include the schema if the user ID under which you are running does not match the
schema. For example, if your userID is USER1, the expression Database. TABLE1 is
equivalent to Database.USER1.TABLE1. However, if the schema associated with the
table in the database is db2admin, you must specify Database.db2admin. TABLE1.
If you do not include the schema, and this does not match your current user ID,
the broker generates a runtime error when a message is processed by the message
flow.

If, as in the two previous examples, a data source is not specified, TABLE1 must be
a table in the default database specified by the node’s data source property. To
access data in a database other than the default specified on the node’s data
source property, you must specify the data source explicitly. For example:

SELECT ...
FROM Database.DataSource.SCHEMA.TABLE1
WHERE ...

Qualify references to column names with either the table name or the correlation
name defined for the table by the FROM clause. So, where you could normally
execute a query such as:

SELECT columnl, column2 FROM tablel
you must write one of the following two forms:

SELECT T.columnl, T.column2 FROM Database.tablel AS T

SELECT tablel.columnl, tablel.column2 FROM Database.tablel

This is necessary in order to distinguish references to database columns from any
references to fields in a message that might also appear in the SELECT:

SELECT T.columnl, T.column2 FROM Database.tablel
AS T WHERE T.column3 = Body.Field2
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You can use the AS clause to rename the columns returned. For example:

SELECT T.columnl AS price, T.column2 AS item
FROM Database.tablel AS T WHERE...

The standard select all SQL option is supported in the SELECT clause. If you use
this option, you must qualify the column names with either the table name or the
correlation name defined for the table. For example:

SELECT T.* FROM Database.Tablel AS T

When you use ESQL procedure and function names within a database query, the
positioning of these within the call affects how these names are processed. If it is
determined that the procedure or function affects the results returned by the query,
it is not processed as ESQL and is passed as part of the database call.

This applies when attempting to use a function or procedure name with the
column identifiers within the SELECT statement.

For example, if you use a CAST statement on a column identifier specified in the
Select clause, this is used during the database query to determine the data type of
the data being returned for that column. An ESQL CAST is not performed to that
ESQL data type, and the data returned is affected by the database interaction’s
interpretation of that data type.

If you use a function or procedure on a column identifier specified in the WHERE
clause, this is passed directly to the database manager for processing.

The examples in the subsequent topics illustrate how the results sets of external
database queries are represented in WebSphere Message Broker. The results of
database queries are assigned to fields in a message using a Compute node.

A column function is a function that takes the values of a single column in all the
selected rows of a table or message and returns a single scalar result.

Selecting data from database columns:

You can configure a Compute, Filter, or Database node to select data from database
columns and include it in an output message. The following example assumes that
you have a database table called USERTABLE with two char(6) data type columns
(or equivalent), called Columnl and Column2. The table contains two rows:

Column1 Column2
Row 1 valuel value2
Row 2 value3 value4

Configure the Compute, Filter, or Database node to identify the database in which
you have defined the table. For example, if you are using the default database
(specified on the data source property of the node), right-click the node, select
Open ESQL, and code the following ESQL statements in the module for this node:

SET OutputRoot = InputRoot;
DELETE FIELD OutputRoot.*[<];
SET OutputRoot.XML.Test.Result[] =
(SELECT T.Columnl, T.Column2 FROM Database.USERTABLE AS T);



This produces the following output message:

<Test>
<Result>
<Columnl>valuel</Columnl>
<Column2>value2</Column2>
</Result>
<Result>
<Columnl>value3</Columnl>
<Column2>value4</Column2>
</Result>
</Test>

To trigger the SELECT, send a trigger message with an XML body that is of the
following form:

<Test>
<Result>
<Columnl></Columnl>
<CoTumn2></Column2>
</Result>
<Result>
<Columnl></Columnl>
<Column2></Column2>
</Result>
</Test>

The exact structure of the XML is not important, but the enclosing tag must be
<Test> to match the reference in the ESQL. If it is not, the ESQL statements result
in top-level enclosing tags being formed, which is not valid XML.

If you want to create an output message that includes all the columns of all the
rows that meet a particular condition, use the SELECT statement with a WHERE
clause:

-- Declare and initialize a variable to hold the
- test vaue (in this case the surname Smith)
DECLARE CurrentCustomer STRING 'Smith';

-- Loop through table records to extract matching information
SET OutputRoot.XML.Invoice[] =
(SELECT R FROM Database.USERTABLE AS R
WHERE R.Customer.LastName = CurrentCustomer
)s

The message fields are created in the same order as the columns appear in the
table.

If you are familiar with SQL in a database environment, you might expect to code
SELECT *. This is not accepted by the broker because you must start all references
to columns with a correlation name. This avoids ambiguities with declared
variables. Also, if you code SELECT L%, this is accepted by the broker but the *
interpreted as the first child element, not all elements, as you might expect from
other database SQL.

Assignment of database result sets into a parser-owned message tree requires the
result set to exactly match the message definition. Since the Generic XML parser is
self-defining, the above example will create a new subtree off the Invoice folder,
and the parser will be able to parse these new elements. If the result set structure
exactly matches the message definition, then the result set can be assigned directly
into the OutputRoot message body tree.
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If the result set structure does not exactly match the MRM message definition, then
you must first assign the result set into a ROW data type, or an Environment tree
that doesn’t have any parsers associated with it.

The required data can then be assigned to OutputRoot to build a message tree that
conforms to the message definition.

Selecting data from a table in a case sensitive database system:

If the database system is case sensitive, you must use an alternative approach. This
approach is also necessary if you want to change the name of the generated field
to something different:

SET OutputRoot = InputRoot;

SET OutputRoot.XML.Test.Result[] =
(SELECT T.Columnl AS Columnl, T.Column2 AS Column2
FROM Database.USERTABLE AS T);

This example produces the same message as the example above. Ensure that
references to the database columns (in this example, T.Columnl and T.Column?2)
are specified in the correct case to match the database definitions exactly. If you do
not match the database definitions exactly, for example if you specify
T.COLUMN], the broker generates a runtime error. Note the use of Columnl and
Column2 in the SELECT statement. You can use any values here, they do not have
to match the names of the columns that you have defined in the database as they
do in this example.

Selecting bitstream data from a database:

These samples show how to retrieve XML bitstream data from a database and
include it in an output message. See ['INSERT statement” on page 1395| for
examples on how you can insert bitstream data into a database.

In the following example bitstream data is held in a database column with a BLOB
data type. If the bitstream from the database does not need to be interrogated or
manipulated by the message flow, then the output message can be constructed in
the BLOB domain as shown in the following ESQL code:

CALL CopyMessageHeaders();
SET Environment.Variables.DBResult = THE( SELECT T.* FROM Database.TABLE1l AS T);
DECLARE resultRef REFERENCE TO Environment.Variables.DBResult;
IF LASTMOVE (resultRef) THEN
SET OutputRoot.Properties.CodedCharSetId = resultRef.MSGCCSID;
SET OutputRoot.Properties.Encoding = resultRef.MSGENCODING;
SET OQutputRoot.BLOB.BLOB = resultRef.MSGDATA;
END IF;

If you want to interrogate or manipulate a bitstream extracted from a database,
you must recreate the original message tree. To recreate the XML message tree
from the bitstream you can use a CREATE statement with a PARSE clause. The output
message can then be modified by the message flow. The following example shows
how to recreate the message tree in the XMLNS domain:

CALL CopyMessageHeaders();
SET Environment.Variables.DBResult = THE( SELECT T.* FROM Database.TABLE1l AS T);
DECLARE resultRef REFERENCE TO Environment.Variables.DBResult;
IF LASTMOVE(resultRef) THEN
DECLARE outCCSID INT resultRef.MSGCCSID;
DECLARE outEncoding INT resultRef.MSGENCODING;
DECLARE outMsg BLOB resultRef.MSGDATA;
SET OQutputRoot.Properties.CodedCharSetId = outCCSID;
SET OutputRoot.Properties.Encoding = outEncoding;



CREATE LASTCHILD OF OutputRoot DOMAIN('XMLNS') PARSE(outMsg, outEncoding, outCCSID);
-- Now modify the message tree fields
SET OutputRoot.XMLNS.A.B = 4;
SET OQutputRoot.XMLNS.A.E = 5;
END IF;

In the following example the data is held in a database column with a character
data type, such as CHAR or VARCHAR. A cast is used to convert the data
extracted from the database into BLOB format. If the bitstream data from the
database does not need to be interrogated or manipulated by the message flow,
then the output message can be constructed in the BLOB domain, without any
alteration.

CALL CopyMessageHeaders();
SET Environment.Variables.DBResult = THE( SELECT T.* FROM Database.TABLE1l AS T);
DECLARE resultRef REFERENCE TO Environment.Variables.DBResult;
IF LASTMOVE(resultRef) THEN
DECLARE outCCSID INT resultRef.MSGCCSID;
DECLARE outMsg BLOB CAST(resultRef.MSGDATA AS BLOB CCSID outCCSID);
SET OutputRoot.Properties.CodedCharSetId = outCCSID;
SET OQutputRoot.Properties.Encoding = resultRef.MSGENCODING;
SET QutputRoot.BLOB.BLOB = outMsg;
END IF;

In the following example the data is held in a database column with a character
data type, such as CHAR or VARCHAR. A cast is used to convert the data
extracted from the database into BLOB format. In order to manipulate or
interrogate this data within the message flow, you must recreate the original
message tree. In this example, a CREATE statement with a PARSE clause is used to
recreate the XML message tree in the XMLNS domain.

CALL CopyMessageHeaders();
SET Environment.Variables.DBResult = THE( SELECT T.* FROM Database.TABLE1l AS T);
DECLARE resultRef REFERENCE TO Environment.Variables.DBResult;
IF LASTMOVE (resultRef) THEN
DECLARE outCCSID INT resultRef.MSGCCSID;
DECLARE outEncoding INT resultRef.MSGENCODING;
DECLARE outMsg BLOB CAST(resultRef.MSGDATA AS BLOB CCSID outCCSID);
SET OutputRoot.Properties.CodedCharSetId = outCCSID;
SET OutputRoot.Properties.Encoding = outEncoding;
CREATE LASTCHILD OF OQutputRoot DOMAIN('XMLNS') PARSE(outMsg, outEncoding, outCCSID);
-- Now modify the message tree fields
SET OutputRoot.XMLNS.A.B
SET QutputRoot.XMLNS.A.E
END IF;

4
5;

Accessing multiple database tables:

You can refer to multiple tables that you have created in the same database. Use
the FROM clause on the SELECT statement to join the data from the two tables.

The following example assumes that you have two database tables called
USERTABLE1 and USERTABLE2. Both tables have two char(6) data type columns

(or equivalent).

USERTABLE]1 contains two rows:

Column1 Column2
Row 1 valuel value2
Row 2 value3 value4
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USERTABLE2 contains two rows:

Column3 Column4
Row 1 valueb value6
Row 2 value?7 value8

All tables referenced by a single SELECT function must be in the same database.
The database can be either the default (specified on the “data source” property of
the node) or another database (specified on the FROM clause of the SELECT
function).

Configure the Compute, Filter, or Database node that you're using to identify the
database in which you have defined the tables. For example, if you're using the
default database, right-click the node, select Open ESQL, and code the following
ESQL statements in the module for this node:

SET OutputRoot.XML.Test.Result[] =
(SELECT A.Columnl AS FirstColumn,
A.Column2 AS SecondColumn,
B.Column3 AS ThirdColumn,
B.Column4 AS FourthColumn
FROM Database.USERTABLE1 AS A,
Database.USERTABLE2 AS B
WHERE A.Columnl = 'valuel' AND
B.Column4 'value8'
)s

This results in the following output message content:

<Test>
<Result>
<FirstColumn>valuel</FirstColumn>
<SecondColumn>value2</SecondColumn>
<ThirdColumn>value7</ThirdColumn>
<FourthColumn>value8</FourthColumn>
</Result>
</Test>

The example above shows how to access data from two database tables. You can
code more complex FROM clauses to access multiple database tables (although all
the tables must be in the same database). You can also refer to one or more
message trees, and can use SELECT to join tables with tables, messages with
messages, or tables with messages. [“Joining data from messages and database]
[tables” on page 338| provides an example of how to merge message data with data
in a database table.

(defined by the data source property of the node).

If you specify an ESQL function or procedure on the column identifier in the
WHERE clause, this is processed as part of the database query and not as ESQL.

Consider the following example:

SET OQutputRoot.XML.Test.Result =
THE(SELECT ITEM T.Columnl FROM Database.USERTABLE1l AS T
WHERE UPPER(T.Column2) = 'VALUE2');

316 Message Flows



This attempts to return the rows where the value of Column2 converted to upper
case is VALUEZ2. However, only the database manager can determine the value of
T.Column2 for any given row, and therefore it cannot be processed by ESQL before
the database query is issued, because the WHERE clause determines the rows that
are returned to the message flow.

Therefore, the UPPER is passed to the database manager to be included as part of
its processing. However, if the database manager cannot process the token within
the select statement, an error is returned.

Changing database content:

You can code ESQL in the Compute, Database, and Filter nodes to change the
contents of a database in the following ways:

* Update data in a database

* Insert data into a database

* Delete data from a database

The following ESQL code includes statements that show all three operations. This
code is appropriate for a Database and Filter node; if you create this code for a
Compute node, use the correlation name InputRoot in place of Root.

IF Root.XMLNS.TestCase.Action = 'INSERT' THEN
INSERT INTO Database.STOCK (STOCK_ID, STOCK DESC, STOCK QTY HELD,
BROKER_BUY_PRICE, BROKER_SELL_PRICE, STOCK HIGH_PRICE, STOCK HIGH_DATE,
STOCK_HIGH TIME) VALUES
(CAST(Root.XMLNS.TestCase.stock_id AS INTEGER),
Root.XMLNS.TestCase.stock desc,
CAST (Root.XMLNS.TestCase.stock_qty_held AS DECIMAL),
CAST(Root.XMLNS.TestCase.broker_buy price AS DECIMAL),
CAST (Root.XMLNS.TestCase.broker_sell price AS DECIMAL),
Root.XMLNS.TestCase.stock_high_price,
CURRENT_DATE,
CURRENT_TIME);

ELSEIF Root.XMLNS.TestCase.Action = 'DELETE' THEN

DELETE FROM Database.STOCK WHERE STOCK.STOCK_ID =
CAST(Root.XMLNS.TestCase.stock_id AS INTEGER);

ELSEIF Root.XMLNS.TestCase.Action = 'UPDATE' THEN

UPDATE Database.STOCK as A SET STOCK_DESC = Root.XMLNS.TestCase.stock_desc
WHERE A.STOCK_ID = CAST(Root.XMLNS.TestCase.stock_id AS INTEGER);
END IF;

Checking returns to SELECT:

If a SELECT statement returns no data, or no further data, this is handled as a
normal situation and no error code is set in SQLCODE. This occurs regardless of
the setting of the Throw Exception On Database Error and Treat Warnings As Errors
properties on the current node.

To recognize that a SELECT statement has returned no data, include ESQL that
checks what has been returned. You can do this in a number of ways:

1. EXISTS

This returns a Boolean value that indicates if a SELECT function returned one
or more values (TRUE), or none (FALSE).
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IF EXISTS(SELECT T.MYCOL FROM Database.MYTABLE) THEN

2. CARDINALITY

If you expect an array in response to a SELECT, you can use CARDINALITY to
calculate how many entries have been received.

SET OutputRoot.XMLNS.Testcase.Results[] = (
SELECT T.MYCOL FROM Database.MYTABLE)

3. ISNULL

If you have used either THE or ITEM keywords in your SELECT statement, a
scalar value is returned. If no rows have been returned, the value set is NULL.
However, it is possible that the value NULL is contained within the column,
and you might want to distinguish between these two cases.

To do this include COALESCE in the SELECT statement, for example:

SET OutputRoot.XMLNS.Testcase.Results VALUE = THE (

SELECT ITEM COALESCE(T.MYCOL, 'WAS NULL")

FROM Database.MYTABLE);
If this returns the character string WAS NULL, this indicates that the column
contained NULL, and not that no rows were returned.

In previous releases, an SQLCODE of 100 was set in most cases if no data, or no
further data, was returned. An exception was raised by the broker if you chose to
handle database errors in the message flow.

Committing database updates:

When you create a message flow that interacts with databases, you can choose
whether the updates that you make are committed when the current node has
completed processing, or when the current invocation of the message flow has
terminated.

For each node, select the appropriate option for the Transaction property to specify
when its database updates are to be committed:

* Choose Automatic (the default) if you want updates made in this node to be
committed or rolled back as part of the whole message flow. The actions that
you define in the ESQL module are performed on the message and it continues
through the message flow. If the message flow completes successfully, the
updates are committed. If the message flow fails, the message and the database
updates are rolled back.

* Choose Commit if you want to commit the action of the node on the database,
irrespective of the success or failure of the message flow as a whole. The
database update is committed when the node processing is successfully
completed, that is, after all ESQL has been processed, even if the message flow
itself detects an error in a subsequent node that causes the message to be rolled
back.

The value that you choose is implemented for the database tables that you have
updated. You cannot select a different value for each table.

If you have set Transaction to Commit, the behavior of the message flow and the
commitment of database updates can be affected by the use of the PROPAGATE
statement.



If you choose to include a PROPAGATE statement in the node’s ESQL that
generates one or more output message from the node, the processing of the
PROPAGATE statement is not considered complete until the entire path that the
output message takes has completed. This path might include several other nodes,
including one or more output nodes. Only then does the node that issues the
PROPAGATE statement receive control back and its ESQL terminate. At that point,
a database commit is performed, if appropriate.

If one of the nodes on the propagated path detects an error and throws an
exception, the processing of the node in which you have coded the PROPAGATE
statement never completes. If the error processing results in a rollback, the message
flow and the database update in this node are rolled back. This behavior is consistent
with the stated operation of the Commit option, but might not be the behavior that
you expect.

Invoking stored procedures:

To invoke a procedure that is stored in a database, use the ESQL CALL statement.

The stored procedure must be defined by a|[‘CREATE PROCEDURE statement” on|

that has:

* A Language clause of DATABASE

* An EXTERNAL NAME clause that identifies the name of the procedure in the
database and, optionally, the database schema to which it belongs.

When you invoke a stored procedure with the CALL statement, the broker ensures
that the ESQL definition and the database definition match:

* The external name of the procedure must match a procedure in the database.
* The number of parameters must be the same.

* The type of each parameter must be the same.

* The direction of each parameter (IN, OUT, INOUT) must be the same.

The following restrictions apply to the use of stored procedures:

* Opverloaded procedures are not supported. (An overloaded procedure is one that
has the same name as another procedure in the same database schema with a
different number of parameters, or parameters with different types.) If the
broker detects that a procedure has been overloaded, it raises an exception.

* In an Oracle stored procedure declaration, you are not permitted to constrain
CHAR and VARCHAR? parameters with a length, and NUMBER parameters
with a precision or scale, or both. Use %TYPE when you declare CHAR,
VARCHAR and NUMBER parameters to provide constraints on a formal
parameter.

Creating a stored procedure in ESQL:

When you define an ESQL procedure that corresponds to a database stored
procedure, you can specify either a qualified name (where the qualifier is a
database schema) or an unqualified name.

To create a stored procedure:
1. Code a statement similar to this example to create an unqualified procedure:
CREATE PROCEDURE myProcl(IN pl CHAR) LANGUAGE DATABASE EXTERNAL NAME "myProc";

The EXTERNAL NAME that you specify must match the definition you have
created in the database, but you can specify any name you choose for the
corresponding ESQL procedure.
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2. Code a statement similar to this example to create a qualified procedure:

CREATE PROCEDURE myProc2(IN pl CHAR) LANGUAGE DATABASE EXTERNAL NAME "Schemal.myProc";
3. Code a statement similar to this example to create a qualified procedure in an

Oracle package:

CREATE PROCEDURE myProc3(IN pl CHAR) LANGUAGE DATABASE EXTERNAL
NAME "mySchema.myPackage.myProc";

For examples of stored procedure definitions in the database, see the |"CREATE|
[PROCEDURE statement” on page 1368

Calling a stored procedure:

1. Code a statement similar to this example to invoke an unqualified procedure:
CALL myProcl('HelloWorld');
Because it is not defined explicitly as belonging to any schema, the myProcl
procedure must exist in the default schema (the name of which is the user
name used to connect to the data source) or the command fails.

2. The following example calls the myProc procedure in schema Schemal.
CALL myProc2('HelloWorld');

3. Code a statement similar to this example to invoke an unqualified procedure
with a dynamic schema:

DECLARE Schema2 char 'mySchema2';

CALL myProcl('HelloWorld') IN Database.{'Schema2'};

This statement calls the myProcl procedure in database Schema2, overriding the
default “username” schema.

Calling a stored procedure that returns two result sets:

To call a stored procedure that takes one input parameter and returns one output

parameter and two result sets:

1. Define the procedure with a CREATE PROCEDURE statement that specifies
one input parameter, one output parameter, and two result sets:

CREATE PROCEDURE myProcl (IN P1 INT, OUT P2 INT)
LANGUAGE DATABASE
DYNAMIC RESULT SETS 2
EXTERNAL NAME "myschema.myprocl";

2. To invoke the myProcl procedure using a field reference, code:

/* using a field reference =/
CALL myProcl(InvVarl, OutVar2, Environment.ResultSetl[],
OutputRoot.XMLNS.Test.ResultSet2[]);

3. To invoke the myProcl procedure using a reference variable, code:
/* using a reference variablex/
DECLARE cursor REFERENCE TO OutputRoot.XMLNS.Test;

CALL myProcl(InVarl, cursor.QutVar2, cursor.ResultSetl[],
cursor.ResultSet2[]);

Coding ESQL to handle errors

When you process messages in a message flow, errors can have a number of
different causes and the message flow designer must decide how to handle those
eITors.

Introduction

When you process messages in message flows, errors can have the following
causes:
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* External causes; for example, the incoming message is syntactically invalid, a
database used by the flow has been shut down, or the power supply to the
machine on which the broker is running fails.

* Internal causes; for example, an attempt to insert a row into a database table
fails because of a constraint check, or a character string that is read from a
database cannot be converted to a number because it contains alphabetic
characters.

Internal errors can be caused by programs storing invalid data in the database,
or by a flaw in the logic of a flow.

The message flow designer must decide how to handle errors.
Using default error-handling

The simplest strategy for handling ESQL errors is to do nothing and use the
broker’s default behavior. The default behavior is to cut short the processing of the
failing message and to proceed to the next message. Input and output nodes
provide options to control exactly what happens when processing is cut short.

If the input and output nodes are set to transactional mode, the broker restores the
state prior to the message being processed:

1. The input message that has apparently been taken from the input queue is put
back.

2. Any output messages that the flow has apparently written to output queues are
discarded.

If the input and output nodes are not set to transactional mode:
1. The input message that was taken from the input queue is not put back.

2. Any output messages that the flow has written to output queues remain on the
output queues.

Each of these strategies has its advantages. The transactional model preserves the
consistency of data, while the non-transactional model maximizes the continuity of
message processing. In the transactional model, the failing input message is put
back onto the input queue, and the broker attempts to process it again. The most
likely outcome of this scenario is that the message continues to fail until the retry
limit is reached, at which point the message is placed on a dead letter queue. The
reason for the failure to process the message is logged to the system event log
(Windows) or syslog (UNIX). Therefore, the failing message holds up the
processing of subsequent valid messages, and is left unprocessed by the broker.

Most databases operate transactionally so that all changes that are made to
database tables are committed if the processing of the message succeeds, or rolled
back if it fails, therefore maintaining the integrity of data. An exception to this
situation is if the broker itself, or a database, fails (for example, the power to the
computers on which they are running is interrupted). In these cases, changes might
be committed in some databases, but not in others, or the database changes might
be committed but the input and output messages are not committed. If these
possibilities concern you, make the flow coordinated and configure the databases
that are involved.

Using customized error handling: The following list contains some general tips
for creating customized error handlers.
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* If you require something better than default error handling, the first step is to
use a handler; see ['DECLARE HANDLER statement” on page 1387|Create one
handler per node to intercept all possible exceptions (or as many exceptions as
can be foreseen).

* Having intercepted an error, the error handler can use whatever logic is
appropriate to handle it. Alternatively, it can use a THROW statement or node to
create an exception, which could be handled higher in the flow logic, or even
reach the input node, causing the transaction to be rolled back; see
lan exception” on page 324

 If a node generates an exception that is not caught by the handler, the flow is
diverted to the Failure terminal, if one is connected, or handled by default
error-handling if no Failure terminal is connected.

Use Failure terminals to catch unhandled errors. Attach a simple logic flow to
the Failure terminal. This logic flow could consist of a database or Compute
node that writes a log record to a database (possibly including the message’s bit
stream), or writes a record to the event log. The flow could also contain an
output node that writes the message to a special queue.

The full exception tree is passed to any node that is connected to a Failure
terminal; see [“ExceptionList tree structure” on page 63

* Your error handlers are responsible for logging each error in an appropriate
place, such as the system event log.

For a detailed description of the options that you can use to process errors in a
message flow, see [“Handling errors in message flows” on page 194 For examples
of what you can do, see|’Throwing an exception” on page 324 and |[“Capturing|
[database state” on page 325

Writing code to detect errors

The following sections assume that the broker detects the error. It is possible,
however, for the logic of the flow to detect an error. For example, when coding the
flow logic, you could use the following elements:

* [IF statements that are inserted specifically to detect situations that should not
occur

* The ELSE clause of a case expression or statement to trap routes through the
code that should not be possible

As an example of a flow logic-detected error, consider a field that has a range of
possible integer values that indicate the type of message. It would not be good
practice to leave to chance what would happen if a message were to arrive in
which the field’s value did not correspond to any known type of message. One
way this situation could occur is if the system is upgraded to support extra types
of message, but one part of the system is not upgraded.

Using your own logic to handle input messages that are not valid

Input messages that are syntactically invalid (and input messages that appear to be
not valid because of erroneous message format information) are difficult to deal
with because the broker has no idea what the message contains. Typically, the best
way of dealing with these messages is to configure the input node to fully parse
and validate the message. However, this configuration applies only to predefined
messages, that is MRM or IDoc.

If the input node is configured in this way, the following results are guaranteed if
the input message cannot be parsed successfully:



¢ The input message never emerges from the node’s normal output terminal (it
goes to the Failure terminal).

* The input message never enters the main part of the message flow.

* The input message never causes any database updates.

* No messages are written to any output queues.

To deal with a failing message, connect a simple logic flow to the Failure terminal.
The only disadvantage to this strategy is that if the normal flow does not require
access to all of the message’s fields, the forcing of complete parsing of the message
affects performance.

Using your own logic to handle database errors

Database errors fall into three categories:

¢ The database is not working at all (for example, it’s off line).

* The database is working but refuses your request (for example, a lock contention
occurs).

* The database is working but what you ask it to do is impossible (for example, to
read from a non-existent table).

If you require something better than default error handling, the first step is to use
a handler (see ["DECLARE HANDLER statement” on page 1387) to intercept the
exception. The handler can determine the nature of the failure from the SQL state
that is returned by the database.

A database is not working
If a database is not working at all, and is essential to the processing of
messages, there is typically not much that you can do. The handler, having
determined the cause, might perform any of the following actions:

* Use the RESIGNAL statement to re-throw the original error, therefore
allowing the default error handler to take over

* Use a different database
* Write the message to a special output queue

However, take care with this sort of strategy. The handler absorbs the
exception, therefore any changes to other databases, or writes to queues, are
committed.

A database refuses your request
The situation when a lock contention occurs is similar to the “Database not
working” case because the database will have backed out all the database
changes that you have made for the current message, not just the failing
request. Therefore, unless you are sure that this was the only update, default
error-handling is typically the best strategy, except possibly logging the error
or passing the message to a special queue.

Impossible requests
The case where the database is working but what you ask it to do is
impossible covers a wide variety of problems.

If, as in the example, the database simply does not have a table of the name
that the flow expects, default error-handling is typically the best strategy,
except possibly logging the error or passing the message to a special queue.
Many other errors might be handled successfully, however. For example, an
attempt to insert a row might fail because there is already such a row and the
new row would be a duplicate. Or an attempt to update a row might fail
because there is no such row (that is, the update updated zero rows). In these
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cases, the handler can incorporate whatever logic you think fit. It might insert
the missing row or utilize the existing one (possibly making sure the values in
it are suitable).

Note: For an update of zero rows to be reported as an error, the Treat
warnings as errors node property must be set to true, which is not the
default setting.

Using your own logic to handle errors in output nodes

Errors that occur in MQOutput nodes report the nature of the error in the SQL
state and give additional information in the SQL native error variable. Therefore, if
something better than default error handling is required, the first step is to use a
handler (see ['DECLARE HANDLER statement” on page 1387) to intercept the
exception. Such a handler typically surrounds only a single PROPAGATE
statement.

Using your own logic to handle other errors

Besides those errors covered above, a variety of other errors can occur. For
example, an arithmetic calculation might overflow, a cast might fail because of the
unsuitability of the data, or an access to a message field might fail because of a
type constraint. The broker offers two programming strategies for dealing with
these types of error.

* The error causes an exception that is either handled or left to roll back the
transaction.

* The failure is recorded as a special value that is tested for later.

In the absence of a type constraint, an attempt to access a non-existent message
field results in the value null. Null values propagate through expressions, making
the result null. Therefore, if an expression, however complex, does not return a
null value, you know that all the values that it needed to calculate its result were
not null.

Cast expressions can have a default clause. If there is a default clause, casts fail
quietly; instead of throwing an exception, they simply return the default value. The
default value could be an innocuous number (for example, zero for an integer), or
a value that is clearly invalid in the context (for example, -1 for a customer
number). Null might be particularly suitable because it is a value that is different
from all others, and it will propagate through expressions without any possibility
of the error condition being masked.

Handling errors in other nodes

Exceptions that occur in other nodes (that is, downstream of a PROPAGATE
statement) might be caught by handlers in the normal way. Handling such errors
intelligently, however, poses a problem: another node was involved in the original
error, therefore another node, and not necessarily the originator of the exception, is
likely to be involved in handling the error.

To help in these situations, the Database and Compute nodes have four terminals
called Outl, Out2, Out3, and Out4. In addition, the syntax of the PROPAGATE
statement includes target expression, message source, and control clauses to give
more control over these terminals.

Throwing an exception:



If you detect an error or other situation in your message flow in which you want
message processing to be ended, you can throw an exception in a message flow in
two ways:

1. Use the ESQL THROW EXCEPTION statement.
Include the THROW statement anywhere in the ESQL module for a Compute,
Database, or Filter node. Use the options on the statement to code your own
data to be inserted into the exception.

2. Include a THROW node in your message flow.

Set the node properties to identify the source and content of the exception.

Using either statement options or node properties, you can specify a message
identifier and values that are inserted into the message text to give additional
information and identification to users who interpret the exception. You can specify
any message in any catalog that is available to the broker. See [Using event logging]|
[from a user-defined extension| for more information.

The situations in which you might want to throw an exception are determined by
the behavior of the message flow; decide when you design the message flow
where this action might be appropriate. For example, you might want to examine
the content of the input message to ensure that it meets criteria that cannot be
detected by the input node (which might check that a particular message format is
received).

The example below uses the example Invoice message to show how you can use
the ESQL THROW statement. If you want to check that the invoice number is
within a particular range, throw an exception for any invoice message received
that does not fall in the valid range.

--Check for invoice number Tower than permitted range

IF Body.Invoice.InvoiceNo < 100000 THEN
THROW USER EXCEPTION CATALOG 'MyCatalog' MESSAGE 1234 VALUES
(*Invoice number too Tow', Body.Invoice.InvoiceNo);

-- Check for invoice number higher than permitted range
ELSEIF Body.InvoiceNo> 500000 THEN
THROW USER EXCEPTION CATALOG 'MyCatalog' MESSAGE 1235 VALUES
(*Invoice number too high', Body.Invoice.InvoiceNo);

ELSE DO
-- invoice number is within permitted range
-- complete normal processing

ENDIF;

Capturing database state:

This topic describes your options if an error occurs when accessing an external
database.

If an error occurs when accessing an external database, you have two options:
* Let the broker throw an exception during node processing
* Process the exception within the node itself using ESQL statements

The first option is the default; ESQL processing in the current node is abandoned.
The exception is then propagated backwards through the message flow until an
enclosing catch node, or the input node for this message flow, is reached. If the
exception reaches the input node, any transaction is rolled back.
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The second option requires an understanding of database return codes and a
logical course of action to take when an error occurs. To enable this inline database
error processing, you must clear the Filter, Database, or Compute node’s Throw
Exception On Database Error property. If you do this, the node sets the database
state indicators SQLCODE, SQLSTATE, SQLNATIVEERROR, and SQLERRORTEXT,
with appropriate information from the database manager instead of throwing an
exception.

The indicators contain information only when an error (not a warning) occurs,
unless you have selected the Treat Warnings As Errors property. In the case of
successful and success with information database operations, the indicators contain
their default success values.

You can use the values contained in these indicators in ESQL statements to make
decisions about the action to take. You can access these indicators with the
SQLCODE, SQLSTATE, SQLNATIVEERROR, and SQLERRORTEXT functions.

If you are attempting inline error processing, you must check the state indicators
after each database statement is executed to ensure that you catch and assess all
errors. When processing the indicators, if you meet an error that you cannot
handle inline, you can raise a new exception either to deal with it upstream in a
catch node, or to let it through to the input node so that the transaction is rolled
back. You can use the ESQL THROW statement to do this.

You might want to check for the special case in which a SELECT returns no data.
This situation is not considered an error and SQLCODE is not set, so you must test
explicitly for it. This is described in [“Checking returns to SELECT” on page 317

Using ESQL to access database state indicators

The following ESQL example shows how to use the four database state functions,
and how to include the error information that is returned in an exception:

DECLARE SQLStatel CHARACTER;
DECLARE SQLErrorTextl CHARACTER;
DECLARE SQLCodel INTEGER;
DECLARE SQLNativeErrorl INTEGER;

-- Make a database insert to a table that does not exist --
INSERT INTO Database.DB2ADMIN.NONEXISTENTTABLE (KEY,QMGR,QNAME)
VALUES (45, 'REG356','my TESTING 2');

--Retrieve the database return codes --
SET SQLStatel = SQLSTATE;

SET SQLCodel = SQLCODE;

SET SQLErrorTextl = SQLERRORTEXT;

SET SQLNativeErrorl = SQLNATIVEERROR;

--Use the THROW statement to back out the database and issue a user exception--
THROW USER EXCEPTION MESSAGE 2950 VALUES

( 'The SQL State' , SQLStatel , SQLCodel , SQLNativeErrorl ,

SQLErrorTextl );

You do not have to throw an exception when you detect a database error; you
might prefer to save the error information returned in the LocalEnvironment tree,
and include a Filter node in your message flow that routes the message to error or
success subflows according to the values saved.



The following sample program provides another example of ESQL that uses these
database functions:

+ |Airline Reservations sample]

You can view samples only when you use the information center that is integrated
with the Message Broker Toolkit.

Using the SELECT function

The SELECT function is a convenient and powerful tool for accessing fields and
transforming data in a message tree.

The following topics show by example how to use the SELECT function to
transform a variety of messages. The examples are based on an XML input
message that has been parsed in the XMLNS domain. However, the techniques
shown in these topics can be applied to any message tree.

* [“Transforming a simple message”|

+ [“Transforming a complex message” on page 331

+ [“Returning a scalar value in a message” on page 333|

* [“Joining data in a message” on page 335|

+ [“Translating data in a message” on page 336|

+ [“Joining data from messages and database tables” on page 338§|

Transforming a simple message:

When you code the ESQL for a Compute node, use the SELECT function to
transform simple messages.

This topic provides examples of simple message transformation. Review the
examples and modify them for your own use. They are all based on the Invoice
message as input.

Consider the following ESQL:

SET OutputRoot.XMLNS.Data.Output[] =
(SELECT R.Quantity, R.Author FROM InputRoot.XMLNS.Invoice.Purchases.Item[] AS R

)s

When this ESQL code processes the Invoice message, it produces the following
output message:

<Data>
<Qutput>
<Quantity>2</Quantity>
<Author>Neil Bradley</Author>
</Output>
<Output>
<Quantity>1</Quantity>
<Author>Don Chamberlin</Author>
</Output>
<Output>
<Quantity>1</Quantity>
<Author>Philip Heller, Simon Roberts</Author>
</Output>
</Data>

Three Output fields are present, one for each Item field, because SELECT creates
an item in its result list for each item described by its FROM list. Within each
Output field, a Field is created for each field named in the SELECT clause. These

Developing message flows 327


/help/livehelp/?pluginID=com.ibm.samplegallery&class=com.ibm.samplegallery.SampleGalleryAction&arg=com.ibm.etools.mft.samples.airline.xml.doc/doc/overview.htm

DECLARE i INTEGER 1;

fields are in the order in which they are specified within the SELECT clause, not in
the order in which they appear in the incoming message.

The R that is introduced by the final AS keyword is known as a correlation name.
It is a local variable that represents in turn each of the fields addressed by the
FROM clause. The name chosen has no significance. In summary, this simple
transform does two things:

1. It discards unwanted fields.

2. It guarantees the order of the fields.

You can perform the same transform with a procedural algorithm:

DECLARE count INTEGER CARDINALITY(InputRoot.XMLNS.Invoice.Purchases.Item[]);

WHILE (i <= count)

SET OutputRoot.XMLNS.Data.Output[i].Quantity
SET OutputRoot.XMLNS.Data.Output[i].Author

SET i = i+1;
END WHILE;
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InputRoot.XMLNS.Invoice.Purchases.Item[i].Quantity;
InputRoot.XMLNS.Invoice.Purchases.Item[i].Author;

These examples show that the SELECT version of the transform is much more
concise. It also executes faster.

The following example shows a more advanced transformation:

SET OutputRoot.XMLNS.Data.Output[] =
(SELECT R.Quantity AS Book.Quantity,
R.Author AS Book.Author
FROM InputRoot.XMLNS.Invoice.Purchases.Item[] AS R
)s

In this transform, an AS clause is associated with each item in the SELECT clause.
This clause gives each field in the result an explicit name rather than a field name
that is inherited from the input. These names can be paths (that is, a dot-separated
list of names), as shown in the example. The structure of the output message
structure can be different from the input message. Using the same Invoice message,
the result is:



<Data>
<Output>
<Book>
<Quantity>2</Quantity>
<Author>Neil Bradley</Author>
</Book>
</Output>
</Data>

<Data>
<Output>
<Book>
<Quantity>2</Quantity>
<Author>Neil Bradley</Author>
</Book>
</Output>
<Qutput>
<Book>
<Quantity>1</Quantity>
<Author>Don Chamberlin</Author>
</Book>
</Output>
<Output>
<Book>
<Quantity>1</Quantity>
<Author>Philip Heller, Simon Roberts</Author>
</Book>
</Output>
</Data>

The expressions in the SELECT clause can be of any complexity and there are no
special restrictions. They can include operators, functions, and literals, and they
can refer to variables or fields that are not related to the correlation name. The
following example shows more complex expressions:

SET OutputRoot.XMLNS.Data.Output[] =

(SELECT 'Start' AS Header,
'Number of books:' || R.Quantity AS Book.Quantity,
R.Author || ':Name and Surname' AS Book.Author,
"End’ AS Trailer

FROM InputRoot.XMLNS.Invoice.Purchases.Item[] AS R
)s

Using the same Invoice message, the result in this case is:
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<Data>
<Output>
<Header>Start</Header>
<Book>
<Quantity>Number of books:2</Quantity>
<Author>Neil Bradley:Name and Surname</Author>
</Book>
<Trailer>End</Trailer>
</Output>
<Output>
<Header>Start</Header>
<Book>
<Quantity>Number of books:1</Quantity>
<Author>Don Chamberlin:Name and Surname</Author>
</Book>
<Trailer>End</Trailer>
</Output>
<Output>
<Header>Start</Header>
<Book>
<Quantity>Number of books:1</Quantity>
<Author>Philip Heller, Simon Roberts:Name and Surname</Author>
</Book>
<Trailer>End</Trailer>
</Output>
</Data>

As shown above, the AS clauses of the SELECT clause contain a path that
describes the full name of the field that is to be created in the result. These paths
can also specify (as is normal for paths) the type of field that is to be created. The
following example transform specifies the field types. In this case, XML tagged
data is transformed to XML attributes:

SET OutputRoot.XMLNS.Data.Output[] =
(SELECT R.Quantity.* AS Book.(XML.Attribute)Quantity,
R.Author.x  AS Book.(XML.Attribute)Author
FROM InputRoot.XMLNS.Invoice.Purchases.Item[] AS R

)s
Using the same Invoice message, the result is:

<Data>

<Output>

<Book Quantity="2" Author="Neil Bradley"/>
</Output>

<Output>

<Book Quantity="1" Author="Don Chamberlin"/>
</Output>

<Output>

<Book Quantity="1" Author="Philip Heller, Simon Roberts"/>
</Output>
</Data>

Finally, you can use a WHERE clause to eliminate some of the results. In the
following example a WHERE clause is used to remove results in which a specific
criterion is met. An entire result is either included or excluded:

SET OutputRoot.XMLNS.Data.Output[] =
(SELECT R.Quantity AS Book.Quantity,
R.Author  AS Book.Author
FROM InputRoot.XMLNS.Invoice.Purchases.Item[] AS R
WHERE R.Quantity = 2



Using the same input message, the result is:

<Data>

<Output>
<Book>
<Quantity>2</Quantity>
<Author>Neil Bradley</Author>
</Book>

</Output>

</Data>

Transforming a complex message:

When you code the ESQL for a Compute node, use the SELECT function for

complex message transformation.

This topic provides examples of complex message transformation. Review the
examples and modify them for your own use. They are all based on the Invoice

message as input.

In this example, Invoice contains a variable number of Items. The transform is

shown below:

SET OutputRoot.XMLNS.Data.Statement[] =

(SELECT I.Customer.Title AS Customer.Title,
I.Customer.FirstName || ' ' || I.Customer.LastName AS Customer.Name,
COALESCE(I.Customer.PhoneHome,"'") AS Customer.Phone,
(SELECT II.Title AS Desc,

CAST(II.UnitPrice AS FLOAT) = 1.6 AS Cost,
II.Quantity AS Qty
FROM I.Purchases.Item[] AS II
WHERE II.UnitPrice> 0.0 ) AS Purchases.Article[],

)s

(SELECT SUM( CAST(II.UnitPrice AS FLOAT) =
CAST(II.Quantity AS FLOAT) *
1.6 )

FROM I.Purchases.Item[] AS II ) AS Amount,

'Dollars’ AS Amount. (XML.Attribute)Currency

FROM InputRoot.XMLNS.Invoice[] AS I
WHERE I.Customer.LastName <> 'Brown'

The output message that is generated is:
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<Data>
<Statement>
<Customer>
<Title>Mr</Title>
<Name>Andrew Smith</Name>
<Phone>01962818000</Phone>
</Customer>
<Purchases>
<Article>
<Desc Category="Computer" Form="Paperback" Edition="2">The XML Companion</Desc>
<Cost>4.472E+1</Cost>
<Qty>2</Qty>
</Article>
<Article>
<Desc Category="Computer" Form="Paperback" Edition="2">
A Complete Guide to DB2 Universal Database</Desc>
<Cost>6.872E+1</Cost>
<Qty>1</Qty>
</Article>
<Article>
<Desc Category="Computer" Form="Hardcover" Edition="0">JAVA 2 Developers Handbook</Desc>
<Cost>9.5984E+1</Cost>
<Qty>1</Qty>
</Article>
</Purchases>
<Amount Currency="Dollars">2.54144E+2</Amount>
</Statement>
</Data>

This transform has nested SELECT clauses. The outer statement operates on the list
of Invoices. The inner statement operates on the list of Items. The AS clause that is
associated with the inner SELECT clause expects an array:

(SELECT II.Title AS Desc,
CAST(II.UnitPrice AS FLOAT) * 1.6 AS Cost,
II.Quantity AS Qty

FROM I.Purchases.Item[] AS II

WHERE II.UnitPrice> 0.0 )

-- Note the use of [] in the next expression
AS Purchases.Article[],

This statement tells the outer SELECT clause to expect a variable number of Items
in each result. Each SELECT clause has its own correlation name: I for the outer
SELECT clause and II for the inner one. Each SELECT clause typically uses its own
correlation name, but the FROM clause in the inner SELECT clause refers to the
correlation name of the outer SELECT clause:

(SELECT II.Title AS Desc,
CAST(II.UnitPrice AS FLOAT) * 1.6 AS Cost,
II.Quantity AS Qty

-- Note the use of I.Purchases.Item in the next expression
FROM I.Purchases.Item[] AS II
WHERE II.UnitPrice> 0.0 ) AS Purchases.Article[],

This statement tells the inner SELECT clause to work with the current Invoice’s
Items. Both SELECT clauses contain WHERE clauses. The outer one uses one
criterion to discard certain Customers, and the inner one uses a different criterion
to discard certain Items. The example also shows the use of COALESCE to prevent
missing input fields from causing the corresponding output field to be missing.
Finally, it also uses the column function SUM to add together the value of all Items
in each Invoice. Column functions are discussed in [“Referencing columns in a
[database” on page 311
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When the fields Desc are created, the whole of the input Title field is copied: the
XML attributes and the field value. If you do not want these attributes in the
output message, use the FIELDVALUE function to discard them; for example, code
the following ESQL.:

SET OutputRoot.XMLNS.Data.Statement[] =

(SELECT I.Customer.Title AS Customer.Title,
I.Customer.FirstName || ' ' || I.Customer.LastName AS Customer.Name,
COALESCE(I.Customer.PhoneHome,'") AS Customer.Phone,
(SELECT FIELDVALUE(II.Title) AS Desc,

CAST(II.UnitPrice AS FLOAT) * 1.6 AS Cost,
II.Quantity AS Qty
FROM I.Purchases.Item[] AS II
WHERE II.UnitPrice> 0.0 ) AS Purchases.Article[],

(SELECT SUM( CAST(II.UnitPrice AS FLOAT) =
CAST(II.Quantity AS FLOAT) =
1.6 )
FROM I.Purchases.Item[] AS II ) AS Amount,
'Dollars' AS Amount. (XML.Attribute)Currency

FROM InputRoot.XMLNS.Invoice[] AS I
WHERE I.Customer.LastName <> 'Brown'

)3
That code generates the following output message:

<Data>
<Statement>
<Customer>
<Title>Mr</Title>
<Name>Andrew Smith</Name>
<Phone>01962818000</Phone>
</Customer>
<Purchases>
<Article>
<Desc>The XML Companion</Desc>
<Cost>4.472E+1</Cost>
<Qty>2</Qty>
</Article>
<Article>
<Desc>A Complete Guide to DB2 Universal Database</Desc>
<Cost>6.872E+1</Cost>
<Qty>1</Qty>
</Article>
<Article>
<Desc>JAVA 2 Developers Handbook</Desc>
<Cost>9.5984E+1</Cost>
<Qty>1</Qty>
</Article>
</Purchases>
<Amount Currency="Dollars">2.54144E+2</Amount>
</Statement>
</Data>

Returning a scalar value in a message:

Use a SELECT statement to return a scalar value by including both the THE and
ITEM keywords.

For example:
1 + THE(SELECT ITEM T.a FROM Body.Test.A[] AS T WHERE T.b = '123")

Use of the ITEM keyword:
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The following example shows the use of the ITEM keyword to select one item and
create a single value.

SET OQutputRoot.MQMD = InputRoot.MQMD;

SET OutputRoot.XMLNS.Test.Result[] =
(SELECT ITEM T.UnitPrice FROM InputBody.Invoice.Purchases.Item[] AS T);

When the Invoice message is received as input, the ESQL shown generates the
following output message:

<Test>
<Result>27.95</Result>
<Result>42.95</Result>
<Result>59.99</Result>
</Test>

When the ITEM keyword is specified, the output message includes a list of scalar
values. Compare this message to the one that is produced if the ITEM keyword is
omitted, in which a list of fields (name-value pairs) is generated:

<Test>
<Result>
<UnitPrice>27.95</UnitPrice>
</Result>
<Result>
<UnitPrice>42.95</UnitPrice>
</Result>
<Result>
<UnitPrice>59.99</UnitPrice>
</Result>
</Test>

Effects of the THE keyword:
The THE keyword converts a list containing one item to the item itself.

The two previous examples both specified a list as the source of the SELECT in the
FROM clause (the field reference has [] at the end to indicate an array), so typically
the SELECT function generates a list of results. Because of this behavior, you must

specify a list as the target of the assignment (thus the "Result[]"” as the target of the
assignment). However, you often know that the WHERE clause that you specify as
part of the SELECT returns TRUE for only one item in the list. In this case use the

THE keyword.

The following example shows the effect of using the THE keyword:

SET OutputRoot.MQMD = InputRoot.MQMD;

SET OutputRoot.XMLNS.Test.Result =
THE (SELECT T.Publisher, T.Author FROM InputBody.Invoice.Purchases.Item[]
AS T WHERE T.UnitPrice = 42.95);

The THE keyword means that the target of the assignment becomes
OutputRoot.XMLNS.Test.Result (the "[]” is not permitted). Its use generates the
following output message:



<Test>
<Result>
<Publisher>Morgan Kaufmann Publishers</Publisher>
<Author>Don Chamberlin</Author>
</Result>
</Test>

Selecting from a list of scalars:
Consider the following sample input message:

<Test>
<A>1</A>
<A>2</A>
<A>3</A>
<A>4</p>
<A>5</A>

</Test>

If you code the following ESQL statements to process this message:

SET OutputRoot.XMLNS.Test.A[] =
(SELECT ITEM A from InputBody.Test.A[]
WHERE CAST(A AS INTEGER) BETWEEN 2 AND 4);

the following output message is generated:

<A>2</A>
<A>3</A>
<A>4</A>

Joining data in a message:

The FROM clause is not restricted to having one item. Specifying multiple items in
the FROM clause produces the usual Cartesian product joining effect, in which the
result includes an item for all combinations of items in the two lists.

Using the FROM clause in this way produces the same joining effect as standard
SQL.

The Invoice message includes a set of customer details, payment details, and
details of the purchases that the customer makes. Code the following ESQL to
process the input Invoice message:

SET OutputRoot.XMLNS.Items.Item[] =
(SELECT D.LastName, D.Billing,
P.UnitPrice, P.Quantity
FROM InputBody.Invoice.Customer[] AS D,
InputBody.Invoice.Purchases.Item[] AS P);

The following output message is generated:
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<Items>

<Item>
<LastName>Smith</LastName>
<Billing>
<Address>14 High Street</Address>
<Address>Hursley Village</Address>
<Address>Hampshire</Address>
<PostCode>S0213JR</PostCode>
</Billing>
<UnitPrice>27.95</UnitPrice>
<Quantity>2</Quantity>

</Item>

<Item>
<LastName>Smith</LastName>
<Bil1ling>
<Address>14 High Street</Address>
<Address>Hursley Village</Address>
<Address>Hampshire</Address>
<PostCode>S0213JR</PostCode>
</Billing>
<UnitPrice>42.95</UnitPrice>
<Quantity>1</Quantity>

</Item>

<Item>
<LastName>Smith</LastName>
<Billing>
<Address>14 High Street</Address>
<Address>Hursley Village</Address>
<Address>Hampshire</Address>
<PostCode>S0213JR</PostCode>
</Billing>
<UnitPrice>59.99</UnitPrice>
<Quantity>1</Quantity>

</Item>

</Items>

Three results are produced, giving the number of descriptions in the first list (one)
multiplied by the number of prices in the second (three). The results systematically
work through all the combinations of the two lists. You can see this by looking at
the LastName and UnitPrice fields selected from each result:

LastName Smith  UnitPrice 27.95
LastName Smith  UnitPrice 42.95
LastName Smith  UnitPrice 59.99

You can join data that occurs in a list and a non-list, or in two non-lists, and so on.
For example:

OutputRoot.XMLNS.Test.Resultl[] =

(SELECT ... FROM InputBody.Test.A[], InputBody.Test.b);
QutputRoot.XMLNS.Test.Resultl =

(SELECT ... FROM InputBody.Test.A, InputBody.Test.b);

The location of the [] in each case is significant. Any number of items can be
specified in the FROM list, not just one or two. If any of the items specify [] to
indicate a list of items, the SELECT function a list of results (the list might contain
only one item, but the SELECT function can potentially return a list of items). The
target of the assignment must specify a list (so must end in []), or you must use
the THE keyword if you know that the WHERE clause guarantees that only one
combination is matched.

Translating data in a message:



You can translate data from one form to another.

A typical example of the requirement to translate data is if the items are known in
one message by names, and in another message by numbers. For example:

Type Name Type Code
Confectionary 2000
Newspapers 3000
Hardware 4000

Consider the following input message:

<Data>
<Items>
<Item>
<Cat>1000</Cat>
<Description>Milk Chocolate Bar</Description>
<Type>Confectionary</Type>
</Item>
<Item>
<Cat>1001</Cat>
<Description>Daily Newspaper</Description>
<Type>NewsPapers</Type>
</Item>
<Item>
<Cat>1002</Cat>
<Description>Kitchen Sink</Description>
<Type>Hardware</Type>
</Item>
</Items>
<TranslateTable>
<Translate>
<Name>Confectionary</Name>
<Number>2000</Number>
</Translate>
<Translate>
<Name>NewsPapers</Name>
<Number>3000</Number>
</Translate>
<Translate>
<Name>Hardware</Name>
<Number>4000</Number>
</Translate>
</TranslateTable>
</Data>

This message has two sections; the first section is a list of items in which each item
has a catalogue number and a type; the second section is a table for translating
between descriptive type names and numeric type codes. Include a Compute node
with the following transform:

SET OutputRoot.XMLNS.Result.Items.Item[] =
(SELECT M.Cat, M.Description, T.Number As Type
FROM
InputRoot.XMLNS.Data.Items.Item[] As M,
InputRoot.XMLNS.Data.TranslateTable.Translate[] As T
WHERE M.Type = T.Name
)s

The following output message is generated:
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<Result>
<Items>
<Item>
<Cat>1000</Cat>
<Description>Milk Chocolate Bar</Description>
<Type>2000</Type>
</Item>
<Item>
<Cat>1001</Cat>
<Description>Daily Newspaper</Description>
<Type>3000</Type>
</Item>
<Item>
<Cat>1002</Cat>
<Description>Kitchen Sink</Description>
<Type>4000</Type>
</Item>
</Items>
</Result>

In the result, each type name has been converted to its corresponding code. In this
example, both the data and the translate table were in the same message tree,
although this is not a requirement. For example, the translate table could be coded
in a database, or might have been set up in LocalEnvironment by a previous
Compute node.

Joining data from messages and database tables:
You can use SELECT functions that interact with both message data and databases.

You can also nest a SELECT function that interacts with one type of data within a
SELECT clause that interacts with the other type.

Consider the following input message, which contains invoice information for two
customers:

<Data>
<Invoice>
<CustomerNumber>1234</CustomerNumber>
<Item>
<PartNumber>1</PartNumber>
<Quantity>9876</Quantity>
</Item>
<Item>
<PartNumber>2</PartNumber>
<Quantity>8765</Quantity>
</Item>
</Invoice>
<Invoice>
<CustomerNumber>2345</CustomerNumber>
<Item>
<PartNumber>2</PartNumber>
<Quantity>7654</Quantity>
</Item>
<Item>
<PartNumber>1</PartNumber>
<Quantity>6543</Quantity>
</Item>
</Invoice>
</Data>

Consider the following database tables, Prices and Addresses, and their contents:



PARTNO PRICE

1 +2.50000E+001

2 +6.50000E+00
PARTNO STREET CITY
1234 22 Railway Cuttings East Cheam
2345 The Warren Watership Down

If you code the following ESQL transform:

-- Create a valid output message
SET OutputRoot.MQMD = InputRoot.MQMD;

-- Select suitable invoices
SET OutputRoot.XMLNS.Data.Statement[] =
(SELECT I.CustomerNumber
A.Street
A.City
A.Country

-- Select suitable items
(SELECT II.PartNumber AS PartNumber,
IT.Quantity AS Quantity,

PI.Price AS Price
FROM Database.db2admin.Prices AS PI,
I.1tem[] AS 1I

WHERE II.PartNumber = PI.PartNo )

FROM Database.db2admin.Addresses AS A,
InputRoot.XMLNS.Data.Invoice[] AS I

WHERE I.CustomerNumber = A.PartNo
)s

COUNTRY
England
England

AS Customer.Number,
AS Customer.Street,
AS Customer.Town,

AS Customer.Country,

AS Purchases.Item[]

the following output message is generated. The input message is augmented with
the price and address information from the database table:
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<Data>
<Statement>
<Customer>
<Number>1234</Number>
<Street>22 Railway Cuttings</Street>
<Town>East Cheam</Town>
<Country>England</Country>
</Customer>
<Purchases>
<Item>
<PartNumber>1</PartNumber>
<Quantity>9876</Quantity>
<Price>2.5E+1</Price>
</Item>
<Item>
<PartNumber>2</PartNumber>
<Quantity>8765</Quantity>
<Price>6.5E+1</Price>
</Item>
</Purchases>
</Statement>
<Statement>
<Customer>
<Number>2345</Number>
<Street>The Warren</Street>
<Town>Watership Down</Town>
<Country>England</Country>
</Customer>
<Purchases>
<Item>
<PartNumber>1</PartNumber>
<Quantity>6543</Quantity>
<Price>2.5E+1</Price></Item>
<Item>
<PartNumber>2</PartNumber>
<Quantity>7654</Quantity>
<Price>6.5E+1</Price>
</Item>
</Purchases>
</Statement>
</Data>

You can nest the database SELECT clause within the message SELECT clause. In
most cases, the code is not as efficient as the previous example, but you might find
that it is better if the messages are small and the database tables are large.
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-- Create a valid output message
SET OQutputRoot.MQMD = InputRoot.MQMD;

-- Select suitable invoices
SET OutputRoot.XMLNS.Data.Statement[] =
(SELECT I.CustomerNumber AS Customer.Number,

-- Look up the address
THE ( SELECT
A.Street,
A.City AS Town,
A.Country
FROM Database.db2admin.Addresses AS A
WHERE A.PartNo = I.CustomerNumber
) AS Customer,

-- Select suitable items
(SELECT
IT.PartNumber AS PartNumber,
IT.Quantity AS Quantity,

-- Look up the price

THE (SELECT ITEM P.Price
FROM Database.db2admin.Prices AS P
WHERE P.PartNo = II.PartNumber

) AS Price

FROM I.Item[] AS II ) AS Purchases.Item[]

FROM InputRoot.XMLNS.Data.Invoice[] AS I
)s

Manipulating messages in the XML domains

The following topics contain instructions on manipulating messages in the
XMLNSC, XMLNS, and XML domains.

* [“Working with XML messages”]|
* ["“Manipulating messages in the XMLNSC domain” on page 350)

+ [“Manipulating messages in the XMLNS domain” on page 363)|

* [“Manipulating messages in the XML domain” on page 372|

For information about dealing with MRM XML messages, see [“Manipulating]

[messages in the MRM domain” on page 373

Working with XML messages:

The following topics provide information about typical tasks for processing XML
messages.

Some of this information is available publicly in Web pages and online tutorials. If
you are new to XML, you will find it useful to also read about the XML standard.

+ [“Constructing an XML message tree” on page 342|

+ |“Working with namespaces” on page 342|

+ [“Working with binary data” on page 343|

["XMLNSC: Working with CData” on page 345|

["XMLNSC: Working with XML messages and bit streams” on page 345|
+ [“Working with large XML messages” on page 346|
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For details about XML Schema, see XML Schema Part 0: Primer on the [World Wide
[Web Consortium (W3C)| Web site.

Constructing an XML message tree:
Order of fields in the message tree

When you create an XML output message in a Compute node, the order of your
lines of ESQL code is important, because the message elements are created in the
order that you code them.

Consider the following XML message:

<Order>
<ItemNo>1</ItemNo>
<Quantity>2</Quantity>
</Order>

If you want to add a DocType Declaration to this, insert the DocType Declaration
before you copy the input message to the output message.

For example:

SET OutputRoot.XMLNS. (XML.Xm1Decl) = '';
SET OutputRoot.XMLNS. (XML.Xm1Dec1).(XML.Version) = '1.0';
SET OutputRoot.XMLNS. (XML.DocTypeDecl)Order ='";

SET OutputRoot.XMLNS. (XML.DocTypeDecl). (XML.SystemId) = 'NewDtdName.dtd';
SET OutputRoot = InputRoot;
-- more ESQL --

If you put the last statement to copy the input message before the XML-specific
statements, the following XML is generated for the output message.
<Order>
<ItemNo>1</ItemNo>
<Quantity>2</Quantity>
</Order>
<?xml version="1.0"?>

This is not well-formed XML and causes an error when it is written from the
message tree to a bit stream in the output node.

Setting the field type

If you copy a message tree from input to output without changing the domain,
most of the syntax elements will be created by the parser ( XMLNSC or XMLNS )
and their field types will be correct. However, if you construct your message tree
from a database query, or from another parser’s message tree, you must ensure
that you identify each syntax element correctly using its field type. You can find
full details of the field type constants used by XMLNSC and XMLNS in the
following topics:

+ ["XMLNSC: Using field types” on page 352

 ["XML constructs” on page 1292|

Working with namespaces:
The following example shows how to use ESQL to work with namespaces.

Namespace constants are declared at the start of the main module so that you can
use prefixes in the ESQL statements instead of the full URIs of the namespaces.


http://www.w3.org/TR/xmlschema-0/
http://www.w3.org/
http://www.w3.org/

The namespace constants affect only the ESQL; they do not control the prefixes
that are generated in the output message. The prefixes in the generated output
message are controlled by namespace declarations in the message tree. You can
include namespace declarations in the tree using the XML.NamespaceDecl field
type. These elements are then used to generate namespace declarations in the
output message.

When the output message is generated, if the parser encounters a namespace for
which it has no corresponding namespace declaration, a prefix is automatically
generated using prefixes of the form NSn where n is a positive integer.

CREATE COMPUTE MODULE xmlns_doc_fTow_Compute
CREATE FUNCTION Main() RETURNS BOOLEAN
BEGIN

CALL CopyMessageHeaders();

-- Declaration of namespace constants --
These are only used by ESQL

DECLARE spl NAMESPACE 'http://www.ibm.com/spacel';
DECLARE sp2 NAMESPACE 'http://www.ibm.com/space2';
DECLARE sp3 NAMESPACE 'http://www.ibm.com/space3';

-- Namespace declaration for prefix 'spacel'
SET OutputRoot.XMLNS.message. (XML.NamespaceDecl)xmlins:spacel = 'http://www.ibm.com/spacel’;
SET OutputRoot.XMLNS.message.spl:datal = 'Hello!';

-- Default namespace declaration ( empty prefix )

SET OutputRoot.XMLNS.message.sp2:data2. (XML.NamespaceDecl)xmins = 'http://www.ibm.com/space2';
SET OQutputRoot.XMLNS.message.sp2:data2.sp2:subDatal = 'Hola!';

SET OQutputRoot.XMLNS.message.sp2:data2.sp2:subData2 = 'Guten Tag!';

SET OQutputRoot.XMLNS.message.sp3:data3 = 'Bonjour!';

SET OutputRoot.Properties.MessageDomain = 'XMLNS';

RETURN TRUE;

END;

CREATE PROCEDURE CopyMessageHeaders ()

BEGIN

DECLARE I INTEGER 1;

DECLARE J INTEGER CARDINALITY(InputRoot.*[]);

WHILE I < J DO SET OutputRoot.*[I] = InputRoot.x[I];
SETI =1+ 1;

END WHILE;

END;

END MODULE;

When this ESQL is processed, the following output message is generated:

<message xmins:spacel-"http://www.ibm.com/spacel">
<spacel:datal>Hello!</spacel:datal>
<data2 xmlns="http://www.ibm.com/space2">
<subDatal>Hola!</subDatal>
<subData2>Guten Tag!</subData2>
</data2>
<NS1:data3 xmlns="http://www.ibm.com/space3>Bonjour!</NSl:data3>
</message>

Working with binary data:
Binary encodings for XML

If you need to include binary data or illegal characters in your XML documents,
the safest method is to encode the data as a binary string.

There are two methods of encoding binary data in an XML document.
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hexBinary: <nonXMLChars>0001020304050607080BOCOEOF</nonXMLChars>

base64Binary: <nonXMLChars>AAECAwQFBgcICwwODw==</nonXMLChars>

The base64Binary encoding makes better use of the available XML characters, and
on average a base64-encoded binary field is 2/3 the size of its hexBinary
equivalent. Base64Binary is widely used by the MIME format and by various
XML-based standards.

You might prefer to use the simpler hexBinary encoding if you are sending data to
applications that cannot decode base64 data, and if the increase in message size is
not important.

Parsing binary data

The most straightforward way to parse any binary data is to use the XMLNSC
parser with a message set.

1. Locate or construct an XML Schema that describes your input XML.
2. Import the XML Schema to create a message definition file.
3. In your message flow, set the node properties as follows:

¢ On the Default page, set Message Domain to XMLNSC and Message Set to the
name of your message set.

* On the Validation page, set Validation to Content and Value.

* In the XMLNSC properties, select the check box option Build tree using XML
Schema types.

The XMLNSC parser automatically decodes your hexBinary or base64Binary data,
being guided by the simple type of the element or attribute that contains the
binary data. The message tree will contain the decoded BLOB value.

If you are using the XMLNS domain, you must parse the binary data as a string. It
will appear in the message tree as a CHARACTER value. If the data is encoded as

hexBinary, you can use the ESQL CAST function to convert to a BLOB value. If the
data is encoded as base64Binary, the easiest approach is to call a static Java method
from ESQL to decode the base64 data into a BLOB value.

Generating binary data

You can generate binary data in your output XML in either hexBinary or
base64Binary encoding.

For hexBinary, use the ESQL CAST statement to convert your BLOB data to a
hexBinary string.

For base64Binary, you have two options:
* Call a static Java method to encode your BLOB data as base64.

* Use the XMLNSC parser, and modify the type field on the syntax element, as
shown in this example:

-- ESQL code to generate base64-encoded binary data
DECLARE myBLOB BLOB;
-- Populate myBLOB with your binary data
CREATE LASTCHILD OF OutputRoot.XMLNSC.message
NAME myBase64Element
TYPE XMLNSC.Attribute + XMLNSC.base64Binary
VALUE myBLOB;



XMLNSC: Working with CData:
What is a CData section?

An XML element can contain text content:
<element>text content</element>

However, some characters cannot appear in that content. In particular, ‘<’ and &’
both have special meaning to an XML parser. If they are included in the text
content of an element, they change the meaning of the XML document.

For example, this is a badly formed XML document:
<element><text><content></element>

There are two ways to make the XML well-formed:
* Use character entities:
<element>&1t;text&gt;&1t;contentégt;</element>
* Use a CData section:
<element><! [CDATA[<text><content>]]></element>

What can you use a CData section for?

In a CData section, you can include XML markup in the value of an element. But
non-valid XML characters cannot be included. Binary data also cannot be included
in a CData section.

The most common use for CData is to embed one XML document within another.
For example:
<outer>
<embedXML>
<! [CDATA[<innerMsg></innerMsg>]]>
</embedXML>
</outer>

You can even embed a badly-formed XML document in this way, because the XML
parser does not attempt to parse the content of a CData section.
<outer>
<embedXML>
<! [CDATA[<badXML></wrongClosingTag>]]>
</embedXML>
</outer>

The following are not valid within a CData section:

* Non-valid XML characters (see Ihttp: / /www.w3.org/TR /2006 / REC—xm1-|
[20060816 /#charsets)

* The text string "]]>" (because this terminates the CData section)

Because of these restrictions, you should not use a CData section to include
arbitrary text in your XML document, and you should not attempt to use a CData
section to hold binary data ( unless it is encoded as hexBinary or base64Binary ).

XMLNSC: Working with XML messages and bit streams:

This topic helps you to use the following ESQL code:
* [“ASBITSTREAM function” on page 1459
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+ [“CREATE statement” on page 1349 with a PARSE clause

The ASBITSTREAM function

If you code the ASBITSTREAM function with the parser mode option set to
RootBitStream to parse a message tree to a bit stream, the result is an XML
document that is built from the children of the target element in the normal way.
This algorithm is identical to that used to generate the normal output bit stream.
Because the target element is not included in the output bit stream, you must
ensure that the children of the element follow the constraints for an XML
document.

One constraint is that there must be only one body element in the message. You
can use a well-formed bit stream obtained in this way to recreate the original tree
using a CREATE statement with a PARSE clause.

If you code the ASBITSTREAM function with the parser mode option set to
FolderBitStream to parse a message tree to a bit stream, the generated bit stream is
an XML document built from the target element and its children. Any
DocTypeDecl or XmlDecl elements are ignored, and the target element itself is
included in the generated bit stream.

The advantage of this mode is that the target element becomes the body element of
the document, and that body element can have multiple elements nested within it.
Use this mode to obtain a bit stream description of arbitrary sub-trees owned by
an XML parser. You can use bit streams obtained in this way to recreate the
original tree using a CREATE statement with a PARSE clause, and a mode of
FolderBitStream.

For further information about the ASBITSTREAM function, and some examples of
its use, see ["ASBITSTREAM function” on page 1459 |

The CREATE statement with a PARSE clause

If you code a CREATE statement with a PARSE clause with the parser mode
option set to RootBitStream to parse a bit stream to a message tree, the expected
bit stream is a normal XML document. A field in the tree is created for each field
in the document. This algorithm is identical to that used when parsing a bit stream
from an input node. In particular, an element named XML’, XMLNS’, or
“XMLNSC’ is created as the root element of the tree, and all the content in the
message is created as children of that root.

If you code a CREATE statement with a PARSE clause with the parser mode
option set to FolderBitStream to parse a bit stream to a message tree, the expected
bit stream is a normal XML document. Any content outside the body element
(such as an XML declaration or doctype) is discarded. The first element created
during the parse corresponds to the body of the XML document, and from there
the parse proceeds as normal.

For further information about the CREATE statement, and examples of its use, see
[‘CREATE statement” on page 1349

Working with large XML messages:



When an input bit stream is parsed and a logical tree is created, the tree
representation of an XML message is typically bigger, and in some cases much
bigger, than the corresponding bit stream.

The reasons for this expansion include:

¢ The addition of the pointers that link the objects together

* Translation of character data into Unicode, which can double the size

* The inclusion of field names that might have been implicit in the bit stream

* The presence of control data that is associated with the broker’s operation

Manipulating a large message tree can require a lot of storage. If you design a
message flow that handles large messages that are made up of repeating structures,
you can code ESQL statements that help to reduce the storage load on the broker.
These statements support both random and sequential access to the message, but
assume that you do not need access to the whole message at one time.

These ESQL statements cause the broker to perform limited parsing of the
message, and to keep in storage at one time, only that part of the message tree that
reflects a single record. If your processing requires you to retain information from
record to record (for example, to calculate a total price from a repeating structure
of items in an order), you can either declare, initialize, and maintain ESQL
variables, or you can save values in another part of the message tree; for example,
in LocalEnvironment.

This technique reduces the memory that is used by the broker to that needed to
hold the full input and output bit streams, plus that needed for the message trees
of just one record. This technique also provides memory savings when even a
small number of repeats is encountered in the message. The broker uses partial
parsing and the ability to parse specified parts of the message tree, to and from the
corresponding part of the bit stream.

To use these techniques in your Compute node, apply these general techniques:

e Copy the body of the input message as a bit stream to a special folder in the
output message. The copy creates a modifiable copy of the input message that is
not parsed and that therefore uses a minimum amount of memory.

* Avoid any inspection of the input message, which avoids the need to parse the
message.

¢ Use a loop and a reference variable to step through the message one record at a
time. For each record:

— Use normal transforms to build a corresponding output subtree in a second
special folder.

— Use the ASBITSTREAM function to generate a bit stream for the output
subtree. The generated bit stream is stored in a BitStream element that is
placed in the position in the output subtree that corresponds to its required
position in the final bit stream.

— Use the DELETE statement to delete both the current input and output record
message trees when you have completed their manipulation.

— When you have completed the processing of all records, detach the special
folders so that they do not appear in the output bit stream.

You can vary these techniques to suit the processing that is required for your
messages.
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The following ESQL code provides an example of one implementation, and is a
modification of the ESQL example in [“Transforming a complex message” on page|
It uses a single SET statement with nested SELECT functions to transform a
message that contains nested, repeating structures.

-- Copy the MQMD header
SET OutputRoot.MQMD = InputRoot.MQMD;

-- Create a special folder in the output message to hold the input tree
-- Note : SourceMessageTree is the root element of an XML parser
CREATE LASTCHILD OF OutputRoot.XMLNS.Data DOMAIN 'XMLNS' NAME 'SourceMessageTree';

-- Copy the input message to a special folder in the output message
-- Note : This is a root to root copy which will therefore not build trees
SET OQutputRoot.XMLNS.Data.SourceMessageTree = InputRoot.XMLNS;

-- Create a special folder in the output message to hold the output tree
CREATE FIELD OutputRoot.XMLNS.Data.TargetMessageTree;

-- Prepare to loop through the purchased items
DECLARE sourceCursor REFERENCE TO OutputRoot.XMLNS.Data.SourceMessageTree.Invoice;
DECLARE targetCursor REFERENCE TO OutputRoot.XMLNS.Data.TargetMessageTree;
DECLARE resultCursor REFERENCE TO OutputRoot.XMLNS.Data;
DECLARE grandTotal FLOAT 0.0e0;

-- Create a block so that it's easy to abandon processing
ProcessInvoice: BEGIN
-- If there are no Invoices in the input message, there is nothing to do
IF NOT LASTMOVE(sourceCursor) THEN
LEAVE ProcessInvoice;
END IF;

-- Loop through the invoices in the source tree
Invoiceloop : LOOP
-- Inspect the current invoice and create a matching Statement
SET targetCursor.Statement = THE (SELECT 'Monthly' AS (XML.Attribute)Type,
"Full' AS (0x03000000)Style[1],
I.Customer.FirstName AS Customer.Name,
I.Customer.LastName AS Customer.Surname,
(SELECT
FIELDVALUE(II.Title) AS Title,
CAST(II.UnitPrice AS FLOAT) = 1.6 AS Cost,
II.Quantity AS Qty
FROM I.Purchases.Item[] AS II
WHERE II.UnitPrice> 0.0) AS Purchases.Article[],
(SELECT
SUM( CAST(II.UnitPrice AS FLOAT) =
CAST(II.Quantity AS FLOAT) =
1.6 )
FROM I.Purchases.Item[] AS II) AS Amount,
'Dollars' AS Amount.(XML.Attribute)Currency
FROM sourceCursor AS I
WHERE I.Customer.LastName <> 'White');

-- Turn the current Statement into a bit stream
DECLARE StatementBitStream BLOB
CAST(ASBITSTREAM(targetCursor.Statement OPTIONS
FolderBitStream) AS BLOB);

-- If the SELECT produced a result
-- (that is, it was not filtered out by the WHERE clause),
-- process the Statement
IF StatementBitStream IS NOT NULL THEN
-- create a field to hold the bit stream in the result tree
CREATE LASTCHILD OF resultCursor
Type XML.BitStream
NAME 'StatementBitStream'
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VALUE StatementBitStream;

-- Add the current Statement's Amount to the grand total
-- Note that the cast is necessary because of the behavior
-- of the XML syntax element
SET grandTotal = grandTotal
+ CAST(targetCursor.Statement.Amount AS FLOAT);

END IF;

-- Delete the real Statement tree leaving only the bit stream version
DELETE FIELD targetCursor.Statement;

-- Step onto the next Invoice,

-- removing the previous invoice and any
-- text elements that might have been

-- interspersed with the Invoices

REPEAT
MOVE sourceCursor NEXTSIBLING;
DELETE PREVIOQUSSIBLING OF sourceCursor;
UNTIL (FIELDNAME (sourceCursor) = 'Invoice')
OR (LASTMOVE (sourceCursor) = FALSE)
END REPEAT;

-- If there are no more invoices to process, abandon the loop
LEAVE Invoiceloop;
END IF;

END LOOP Invoiceloop;
END ProcessInvoice;

-- Remove the temporary source and target folders
DELETE FIELD QutputRoot.XMLNS.Data.SourceMessageTree;
DELETE FIELD QutputRoot.XMLNS.Data.TargetMessageTree;

-- Finally add the grand total
SET resultCursor.GrandTotal = grandTotal;

This ESQL code produces the following output message:

<Data>
<Statement Type="Monthly" Style="Full">
<Customer>
<Name>Andrew</Name>
<Surname>Smi th</Surname>
<Title>Mr</Title>
</Customer>
<Purchases>
<Article>
<Title>The XML Companion</Title>
<Cost>4.472E+1</Cost>
<Qty>2</Qty>
</Article>
<Article>
<Title>A Complete Guide to DB2 Universal Database</Title>
<Cost>6.872E+1</Cost>
<Qty>1</Qty>
</Article>
<Article>
<Title>JAVA 2 Developers Handbook</Title>
<Cost>9.5984E+1</Cost>
<Qty>1</Qty>
</Article>
</Purchases>
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<Amount Currency="Dollars">2.54144E+2</Amount>
</Statement>
<GrandTotal>2.54144E+2</GrandTotal>

</Data>

Manipulating messages in the XMLNSC domain:

This topic provides information about on how to write ESQL for processing
messages that belong to the XMLNSC domain, and that are parsed by the
XMLNSC parser. Refer to [“XMLNSC parser” on page 80| for background
information.

The following topics provide detailed information about the structure of the
message tree that the XMLNSC parser builds, and the field types that it uses.

+ ["XMLNSC: The XML declaration”]
 ["XMLNSC: The inline DTD” on page 351|

+ ["XMLNSC: The message body” on page 352|

+ ["XMLNSC: XML Schema support” on page 360|

Information for users who are migrating from XML, XMLNS, or MRM XML is
available in [“Migrating to XMLNSC” on page 362

Further information about processing XML messages can be found in
[with XML messages” on page 341

XMLNSC: The XML declaration:

The XML declaration is represented in the message tree by a syntax element with
field type XMLNSC.XMLDeclaration.

If an XML declaration is created by the XMLNSC parser, its name is
“XmlDeclaration’. However, when a message tree is being output the name is not
important — the XMLNSC parser recognizes this syntax element by its field type
only. An example is shown below:

<?xml version="1.0" encoding="UTF-8" standalone="yes"?>

<IDOCTYPE s1 PUBLIC "http://www.ibm.com/example.dtd" "example.dtd">
<sl>........ </sl>

The XML Declaration has three optional attributes; Version, Standalone, and
Encoding. The XMLNSC parser does not define special field types for these
attributes. Instead, they are identifed by their name, and by their position as a
child of the XML Declaration element.

ESQL example code to create an XML declaration

To construct the XML declaration that is shown above, the following ESQL is
required:

CREATE FIRSTCHILD of OutputRoot.XMLNSC Name 'XmlDeclaration' TYPE
XMLNSC.XMLDecTaration;

SET OutputRoot.XMLNSC. (XMLNSC.Xm1Declaration)*.(XMLNSC.Attribute)Version = '1.0';

SET OutputRoot.XMLNSC. (XMLNSC.Xm1Declaration)=*. (XMLNSC.Attribute)Encoding = 'UTF-8';
SET OutputRoot.XMLNSC. (XMLNSC.Xm1Declaration)*.(XMLNSC.Attribute)StandAlone = 'Yes';

The first line is optional; if it is omitted, the XMLNSC.XMLDeclaration element is
automatically created when it is referenced by the second line.



Java example code to create an XML declaration

To construct the XML declaration that is shown above, the following Java is
required:

//Create the XML domain root node

MBETement xmlRoot =
root.createElementAsLastChild(MbXMLNSC.PARSER NAME) ;
//Create the XML declaration parent node

MbElement xmlDecl =
xmlRoot.createElementAsFirstChild(MbXMLNSC.XML_DECLARATION) ;

xmlDecl.setName("XmlDeclaration");

MbElement version =

xmlDecl.CreateETementAsFirstChild(MbXMLNSC.ATTRIBUTE, "Version", "1.0");
MbElement encoding =

xmlDecl.CreateETlementAsFirstChild(MbXMLNSC.ATTRIBUTE, "Encoding", "utf-8");
MbETement standalone =

xmlDecl.CreateETlementAsFirstChild(MbXMLNSC.ATTRIBUTE, "Standalone", "Yes");

XMLNSC: The inline DTD:

When parsing an XML document that has an inline DTD, the XMLNSC parser

does not put the DTD information into the message tree. However, using ESQL

you can add XML entity definitions to the message tree, and these are used when

the message tree is output by the XMLNSC parser.
ESQL example code for entity definition and entity reference

This example assumes that InputRoot. XMLNSC has been created from the
following XML message:

<BookInfo dtn="BookInfo" edn="author" edv="A.N.Other"/>

The following output message is generated:

<IDOCTYPE BookInfo [<!ENTITY author "A.N.Other">]>
<BookInfo><entref>&author;</entref></BookInfo>

The ESQL to create the output message is:

DECLARE cursor REFERENCE TO InputRoot.XMLNSC.BookInfo;

-- Create <!DOCTYPE BOOKInfo ...

SET OutputRoot.XMLNSC. (XMLNSC.DocumentType)* NAME = cursor.dtn;

-- Create <!ENTITY author "A.N.Other" > ...

SET

OutputRoot.XMLNSC. (XMLNSC.DocumentType)* NAME = 'author' VALUE = cursor.edv;
-- Create the entity reference

SET OutputRoot.XMLNSC.BookInfo. (XMLNSC.EntityReference)entref = ‘'author';

Java example code to create an XML declaration

To construct the XML declaration that is shown above, the following Java is

required:

//Create the XML domain root node

MBETement xmlRoot =
root.createElementAsLastChild(MbXMLNSC.PARSER NAME) ;

//Create the XML declaration parent node

MbElement xmlDecl =
xmlRoot.createElementAsFirstChild(MbXMLNSC.XML_DECLARATION) ;

xmlDecl.setName("XmlDeclaration");
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MbElement version =

xmlDecl.CreateETlementAsFirstChild(MbXMLNSC.ATTRIBUTE, "Version", "1.0");
MbElement encoding =

xmlDecl.CreateETementAsFirstChild(MbXMLNSC.ATTRIBUTE, "Encoding", "utf-8");
MbElement standalone =

xmlDecl.CreateETementAsFirstChild(MbXMLNSC.ATTRIBUTE, "Standalone", "Yes");

XMLNSC: The message body:
Put your short description here; used for first paragraph and abstract.

The following topics describe how the XMLNSC parser builds a message tree from
the body of an XML document:

+ ["XMLNSC: Using field types”]

+ ["XMLNSC: Attributes and elements” on page 355|

+ ["XMLNSC: Namespace declarations” on page 356|

+ ["XMLNSC: Element values and mixed content” on page 357]

+ ["XMLNSC: Comments and Processing Instructions” on page 359

XMLNSC: Using field types:
The XMLNSC parser sets the field type on every syntax element that it creates.

The field type indicates the type of XML construct that the element represents. The
XMLNSC parser uses the field type when writing a message tree. The field type
can be set using ESQL or Java to control the output XML. The field types that are
used by the XMLNSC parser must be referenced using constants with names
prefixed by “XMLNSC.’

Tip: Field type constants that have the prefix "XML.” are for use with the XMLNS
and XML parsers only. They are not valid with the XMLNSC or MRM
parsers.

Field types for creating syntax elements
Use the following field type constants to create syntax elements in the message

tree. The XMLNSC parser uses these values when creating a message tree from an
input message.

XMLNSC Field Type
XML construct constant Value
Simple Element XMLNSC.PCDataField 0x02000000
XMLNSC.CDataField 0x02000001
Attribute XMLNSC.SingleAttribute 0x03000100
XMLNSC.DoubleAttribute 0x03000101
Mixed content XMLNSC.PCDataValue 0x03000000
XMLNSC.CDataValue 0x03000001
Namespace Declaration XMLNSC.SingleNamespaceDecl |0x03000102
XMLNSC.DoubTeNamespaceDecl |0x03000103
Complex element XMLNSC.Folder 0x01000000
Inline DTD XMLNSC.DocumentType 0x01000300
XML declaration XMLNSC.Xm1Declaration 0x01000400
Entity reference XMLNSC.EntityReference 0x02000100




XMLNSC Field Type
XML construct constant Value
Entity definition XMLNSC.SingleEntityDefinitipAx03000301
XMLNSC.DoubTeEntityDefinitipAx03000300
Comment XMLNSC.Comment 0x03000400
Processing Instruction XMLNSC.ProcessingInstruction0x03000401

Field types for path expressions ( generic field types )

Use the field type constants that are listed below when querying the message tree
using a path expression. For example:

SET str = FIELDVALUE(InputRoot.el.(XMLNSC.Attribute)attrl)

It is good practice to specify field types when querying a message tree built by the
XMLNSC parser. This makes your ESQL code more specific and more readable,
and it avoids incorrect results in some cases. However, care is required when
choosing which field type constant to use. When you use the XMLNSC parser, use
a generic field type constant when querying the message tree. This allows your
path expression to tolerate variations in the input XML.

The generic field type constants are listed below:

XMLNSC Field Type

XML construct constant Purpose

Element XMLNSC . Field Matches normal text, CData,
or a mixture of both

Attribute XMLNSC. Attribute Matches single-quoted and
double-quoted attributes

Mixed content XMLNSC.Value Matches normal text, CData,
or a mixture of both

XML Declaration XMLNSC.NamespaceDecl Matches single- and
double-quoted declarations

If you write
InputRoot.el. (XMLNSC.DoubleAttribute)attrName

your path expression does not match a single-quoted attribute. If you use the
generic field type constant XMLNSC.Attribute, your message flow works with
either single-quoted or double-quoted attributes.

Note that you should always use the field type constants and not their numeric
values.

Field types for controlling output format

The following field types are provided for XML Schema and base64 support. Do
not use these field type constants in path expressions; use them in conjunction
with XMLNSC.Attribute and XMLNSC.Field to indicate the required output format
for DATE and BLOB values. See ["XMLNSC: XML Schema support” on page 360|
for further information.
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XMLNSC Field Type
constant Purpose Value

XMLNSC.gYear Value must be a DATE. If the | 0x00000010
field type includes this value,
the DATE value is output
using the XML Schema gYear
format.

XMLNSC.gYearMonth Value must be a DATE. If the | 0x00000040
field type includes this value,
the DATE value is output
using the XML Schema
gYearMonth format.

XMLNSC.gMonth Value must be a DATE. If the | 0x00000020
field type includes this value,
the DATE value is output
using the XML Schema
gMonth format.

XMLNSC.gMonthDay Value must be a DATE. If the | 0x00000050
field type includes this value,
the DATE value is output
using the XML Schema
gMonthDay format.

XMLNSC.gDay Value must be a DATE. If the | 0x00000030
field type includes this value,
the DATE value is output

using the XML Schema gDay

format.

XMLNSC .base64Binary Value must be a BLOB. Value | 0x00000060
is output with base64
encoding.

XMLNSC.List Element must be 0x00000070

XMLNSC. Attribute or
XMLNSC.Field. If the field
type includes this value, the
values of all child elements
in the message tree are
output as a space-separated
list.

Field types for direct output

The following field types allow you to output pre-constructed segments of an XML
document. No character escaping is done and, if you are not careful, you can
construct a badly-formed output document. Only use these constants after carefully
exploring alternative solutions.

XMLNSC Field Type
constant Purpose Value

XMLNSC .Bitstream Value of syntax element must | 0x03000200
be a BLOB. The value is
written directly to the output
bit stream. See |”Workina
with large XML messages”]|

on page 346| for more

information about its usage.
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XMLNSC Field Type
constant Purpose Value

XMLNSC. AsisElementContent| Value of syntax element must | 0x03000600
be CHARACTER. The value
is written directly to the
output bit stream. No
character substitutions are
performed. Use this with
care.

XMLNSC: Attributes and elements:

The XMLNSC parser uses the following field types to represent attributes and
elements.

Use the field type constants that are listed below when creating your own syntax
elements in the message tree.

Table 11. Specific field type constants

XMLNSC Field Type
XML Construct constant Value
Complex element XMLNSC.Folder 0x01000000
Simple element XMLNSC.PCDataField 0x02000000
XMLNSC.CDataField 0x02000001
Attribute XMLNSC.SingleAttribute 0x03000100
XMLNSC.DoubTeAttribute 0x03000101

When accessing elements and attributes in the message tree, use generic field type
constants which match all of the alternative values. Because there is only one type
of Folder element, it is safe to use XMLNSC.Folder when querying the message
tree.

Table 12. Generic field type constants

XMLNSC Field Type
XML Construct constant Purpose

Element XMLNSC.Field Matches elements that
contain normal text, CData,
or a mixture of both

Attribute XMLNSC. Attribute Matches both single-quoted
and double-quoted attributes

ESQL code examples
The following examples use this XML message:
<root id="12345">

<id>ABCDE</id>
</root>

Note that the message contains an attribute and an element with the same name.

Example 1 : Query the value of an XML element
SET value = FIELDVALUE(InputRoot.XMLNSC.root.(XMLNSC.Field)id)
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The result is that value is set to “ABCDE’.

Example 2 : Query the value of an XML attribute
SET value = FIELDVALUE(InputRoot.XMLNSC.root.(XMLNSC.Attribute)id)

The result is that value is set to “12345’.

Example 3 : Create the example message using ESQL

CREATE LASTCHILD OF OutputRoot.XMLNSC Name 'root' Type 'XMLNSC.Folder';
-- Note : XMLNSC.Attribute could be used here as well.

SET OuputRoot.XMLNSC.root.(XMLNSC.DoubleAttribute)id = '12345"';

SET OuputRoot.XMLNSC.root.(XMLNSC.Field)id = 'ABCDE';

The first line is optional because the element ‘root’ is created automatically by the
following line if it does not already exist.

XMLNSC: Namespace declarations:
The XMLNSC parser provides full support for namespaces.

The parser sets the correct namespace on every syntax element that it creates while
parsing a message, and it stores namespace declarations in the message tree, and
uses them to select the appropriate prefixes when outputting the message tree.

The XMLNSC parser uses the following field types to represent namespace
declarations. You should use the field type constants that are listed below when
creating your own namespace declarations in the message tree.

Table 13. Specific field type constants

XMLNSC Field Type
XML Construct constant Value

Namespace declaration XMLNSC.SingleNamespaceDecl |0x030001602
XMLNSC.DoubleNamespaceDecl | 0x03000103

When accessing elements and attributes in the message tree, do not use the
constants in the previous table. Instead, use the generic field type constant that
matches both of the values in the table above.

Table 14. Generic field type constants

XMLNSC Field Type
XML Construct constant Purpose

Namespace declaration XMLNSC.NamespaceDecl Matches both single-quoted
and double-quoted
namespace declarations

ESQL code examples

Example 1 : Declaring a non-empty prefix

DECLARE spacel NAMESPACE 'namespacel';
SET OuputRoot.XMLNSC.root.(XMLNSC.NamespaceDecl)xmins:nsl = 'namespacel’;
SET OuputRoot.XMLNSC.root.spacel:example = 'ABCDE';

This creates the following XML message:



<root xmlns:nsl="namespacel">
<ns1:example>ABCDE</ns1:example>
</root>

Note that the ESQL namespace constant ‘spacel’ is only ever used by ESQL. It
does not affect the namespace prefix in the output message.

Example 2 : Declaring an empty prefix

DECLARE spacel NAMESPACE 'namespacel';
SET OuputRoot.XMLNSC.root. (XMLNSC.NamespaceDecl)xmins = 'namespacel’;
SET OQuputRoot.XMLNSC.root.spacel:example = 'ABCDE';

This creates the following XML message:

<root xmlns:nsl="namespacel">
<example>ABCDE</example>
</root>

Note that the syntax element ‘'example” must have a non-empty namespace. The
default namespace declaration means that any child element without a prefix is in
the namespace "namespacel’.

Example 3 : Example of incorrect usage

DECLARE spacel NAMESPACE 'namespacel';
SET OuputRoot.XMLNSC.root. (XMLNSC.NamespaceDecl)xmins = 'namespacel’;
SET OuputRoot.XMLNSC.root.example = 'ABCDE';

This causes the XMLNSC parser to issue the message BIP5014 when the it attempts
to output the message tree. The element ‘'example” must not have an empty
namespace because it exists within the scope of a default namespace declaration.

XMLNSC: Element values and mixed content:
Element with simple content

The XMLNSC parser is a compact parser. This means that the following XML
fragment is parsed as a single syntax element:

<simpleElement>simpleValue</simpleElement>

2‘ Name
"simpleElement"

XMLNSC.PCDataField % Field type

"simpleValue"

Value

ﬁ

The value of this element can be queried with this ESQL:
SET val = FIELDVALUE(InputRoot.XMLNSC. (XMLNSC.Field)simpleElement);

To generate an element with simple content in the output:
SET OutputRoot.XMLNSC. (PCDataField)simpleElement VALUE = 'simpleValue';

Note that we used XMLNSC.Field when querying the message tree, but we
specified XMLNSC.PCDataField when constructing the output message. We could
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have used XMLNSC.PCDataField to query the message tree; however, that would
not work if the input message used a CData section, as shown below:

<simpleElement><![CDATA[simpleValue]]></simpleElement>
Element with mixed content

If an element has child elements, it is typically a ‘folder’, and does not have a
value. When an element has both child elements and some text, the text is called
‘mixed content’.

<element>mixedl<child/>mixed2</element>

By default, mixed content is discarded because it is typically just formatting white
space and has no business meaning. Mixed content can be preserved if you select
the Retain mixed content’ check box on the Parser Options page of the node
properties.

If mixed content is being preserved, the XMLNSC parser creates a Value child
element for each distinct item of mixed content.

"element"
XMLNSC.CDataField
"child1"
XMLNSC.PCDataValue XMLNSC.PCDataField XMLNSC.PCDataValue
"mixed1" " "mixed2"

The mixed content can be queried with this ESQL:
SET mixedl = FIELDVALUE(InputRoot.XMLNSC. (element).*[1];

The ESQL to construct the above XML fragment is:

CREATE ref REFERENCE TO OQutputRoot.XMLNSC.element;

CREATE FIRSTCHILD OF ref TYPE XMLNSC.PCDataValue VALUE 'mixedl';

CREATE LASTCHILD OF ref NAME 'childl' TYPE XMLNSC.PCDataField VALUE '';
CREATE LASTSTCHILD OF ref TYPE XMLNSC.PCDataValue VALUE 'mixed2';

The following ESQL enables the Retain mixed content option:

DECLARE X BLOB;
-- assume that X contains an XML document
CREATE LASTCHILD OF OutputRoot
PARSE(X OPTIONS XMLNSC.MixedContentRetainAll);

Element containing a CData section

A CData section is an XML notation that allows XML markup characters to be
included in the content of an element.

The following two XML fragments are identical in their meaning:

<simpleElement>simpleValue</simpleElement>



<simpleElement><![CDATA[simpleValue]]></simpleElement>

If the CData section is the only text content, the XMLNSC parser remembers that
the input document contained a CData section by setting the field type to
XMLNSC.CDataField instead of XMLNSC.PCDataField.

If the CData section is not the only text content, it is created as a child value
element, with other child value elements representing the remaining text content.
An example is shown below:

<simpleElement><![CDATA[CDataValue]]>normalText</simpleElement>

"simpleElement"

XMLNSC.CDataField
XMLNSC.CDataValue XMLNSC.PCDataField
"CDataValue" normalText

See [“XMLNSC: Working with CData” on page 345| for more information about the
correct use of CData in XML documents.

XMLNSC: Comments and Processing Instructions:
Comments

By default, the XMLNSC parser discards comments because comments are
auxiliary information with no business meaning. Comments can be preserved if
you select the Retain comments check box on the Parser Options page of the node
properties.

If Retain comments is selected, each comment in the input document is represented
by a single syntax element with field type XMLNSC.Comment. The Retain
comments option can also be accessed using the following ESQL:

DECLARE X BLOB;
-- assume that X contains an XML document
CREATE LASTCHILD OF OutputRoot.XMLNSC
PARSE (X DOMAIN XMLNSC
NAME preserveComments
OPTIONS XMLNSC.CommentsRetainAll);

-- do it again, this time discarding comments
CREATE LASTCHILD OF OQutputRoot.XMLNSC
PARSE (X DOMAIN XMLNSC
NAME discardComments
OPTIONS XMLNSC.CommentsRetainNone);
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By default, the XMLNSC parser discards processing instructions because
processing instructions are auxiliary information with no business meaning.
Processing instructions can be preserved if you select the Retain processing
instructions check box on the Parser Options page of the node properties.

If Retain processing instructions is selected, each processing instruction the input
document is represented by a single syntax element with field type
XMLNSC.ProcessingInstruction. The Retain processing instructions option can also be
accessed using the following ESQL:
DECLARE X BLOB;
-- assume that X contains an XML document
CREATE LASTCHILD OF OutputRoot.XMLNSC

PARSE (X DOMAIN XMLNSC

NAME preserveProcessingInstructions
OPTIONS XMLNSC.ProcessingInstructionsRetainAll);

-- do it again, this time discarding processing instructions
CREATE LASTCHILD OF OutputRoot.XMLNSC
PARSE (X DOMAIN XMLNSC
NAME discardProcessingInstructions
OPTIONS XMLNSC.ProcessingInstructionsRetainNone);

XMLNSC: XML Schema support:

The XMLNSC parser can parse and validate using an XML Schema.

See ["XMLNSC parser” on page 80| for information about how to configure the
XMLNSC parser to use an XML Schema.

The following topics describe how the XMLNSC parser uses the field type to hold
information about XML Schema simple types. This enables the parser to output
dates and binary elements in the same form in which they were parsed, and
according to the XML Schema specification. It also allows the message flow
developer to output dates, lists and binary data in the correct XML Schema format.

* ["XMLNSC: base64 support”|
+ ["XMLNSC: XML Schema date formatting” on page 361
+ ["XMLNSC: XML List type support” on page 362|

XMLNSC: base64 support:
The XMLNSC parser can output binary data in base64-encoded format.

If Validation is set to Content and Value, and Build tree using schema types is
enabled, the XMLSNC parser automatically decodes base64 data and creates a
BLOB value in the message tree. When outputting a message tree, the XMLNSC
parser will ‘base64-encode” a BLOB if the field type includes the constant
XMLNSC .base64Binary.

ESQL code example to output base64 data

DECLARE Base64Data BLOB '0102030405060708090A0BOCODOEOF ' ;

-- Add in the base64Binary field type

DECLARE base64FieldType INTEGER XMLNSC.Field + XMLNSC.base64Binary;

CREATE LASTCHILD OF OutputRoot DOMAIN 'XMLNSC' NAME 'XMLNSC';

CREATE LASTCHILD OF OutputRoot.XMLNSC TYPE base64FieldType NAME 'myBinaryData' VALUE Base64Data;

Result : <myBinaryData>AQIDBAUGBwg]CgsMDQ4P</myBinaryData>
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Note that this example does not depend on validation. The XMLNSC parser can
output base64 binary data even if Validation is set to None.

XMLNSC: XML Schema date formatting:
The XMLNSC parser can parse and write all of the XML Schema simple types.

The rarely used types gYear, gYearMonthgMonthgMonthDay, and gDay do not
map directly to a message broker data type. For these simple types, the XMLNSC
parser adds one of the following constant values to the field type. This allows the
parser to output the data in the same format as it was received.

Field types for controlling date format

The following field types are provided for XML Schema date format support. Do
not use these field type constants in path expressions. Use them in conjunction
with constants XMLNSC.Attribute and XMLNSC.Field to indicate the required
output format for DATE values.

XMLNSC Field Type
constant Purpose Value

XMLNSC.gYear Value must be a DATE. If the | 0x00000010
field type includes this value,
the DATE value is output
using the XML Schema gYear
format.

XMLNSC.gYearMonth Value must be a DATE. If the | 0x00000040
field type includes this value,
the DATE value is output
using the XML Schema
gYearMonth format.

XMLNSC.gMonth Value must be a DATE. If the | 0x00000020
field type includes this value,
the DATE value is output
using the XML Schema
gMonth format.

XMLNSC.gMonthDay Value must be a DATE. If the | 0x00000050
field type includes this value,
the DATE value is output
using the XML Schema
gMonthDay format.

XMLNSC.gDay Value must be a DATE. If the | 0x00000030
field type includes this value,
the DATE value is output
using the XML Schema gDay
format.

ESQL code example

DECLARE gYear DATE '2007-01-01';

-- Add in the gYear field type

DECLARE gYearFieldType INTEGER XMLNSC.Field + XMLNSC.gYear;

CREATE LASTCHILD OF OutputRoot DOMAIN 'XMLNSC' NAME 'XMLNSC';

CREATE LASTCHILD OF OutputRoot.XMLNSC TYPE gYearFieldType NAME 'gYear' VALUE gYear;

Result : <gYear>2007</gYear>
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XMLNSC: XML List type support:

An element or an attribute can have multiple values separated by spaces, as shown
in the examples below:

<listElement>one two three</TistElement>
<element TistAttribute="1 2 3"><childEL1/></element>

If your XML schema specifes a list type for an element or an attribute, and
Validation is set to Content and Value, and Build tree using schema types is
enabled, the XMLNSC parser automatically parses the space-separated list of
values into individual syntax elements in the message tree. The resulting message
tree looks like this:

and for an attribute with a list value it looks like this:

listElement
one two three
element
listAttr childEL1 --_---
1 2 3

ESQL code examples

Access the individual values in a list
SET val = InputRoot.XMLNSC.TlistElement.*[1];

Result : val = “one’
SET val = InputRoot.XMLNSC.element.(XMLNSC.Attribute)TistAttr.*[3];

Result : val="3’

Create a list element in the message tree

CREATE LASTCHILD OF OutputRoot.XMLNSC

Name 'listElement'

Type XMLNSC.List;
DECLARE 1istET REFERENCE TO OutputRoot.XMLNSC.listETement;
DECLARE TlistValType INTEGER XMLNSC.PCDataValue;
CREATE LASTCHILD OF TistEl TYPE TistValType VALUE 'one';
CREATE LASTCHILD OF 1istEl TYPE 1listValType VALUE 'two';
CREATE LASTCHILD OF TistEl TYPE TistValType VALUE 'three';

Migrating to XMLNSC:
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Reasons to migrate

The XMLNSC parser now offers the best combination of features and performance
for most applications. If your message flow uses the XMLNS or XML domain, you
might want to migrate a message flow to XMLNSC to take advantage of the XML
schema validation. If your message flow uses the MRM domain, you might want
to migrate to XMLNSC to obtain standards-compliant validation, and a large
reduction in CPU usage.

Migrating from the XMLNS or XML domain

The XMLNSC parser differs from the XMLNS parser in the following ways:
¢ The XMLNSC parser builds a compact message tree.

* It uses different field type constants.

* It discards inline DTDs

In most cases, the compact message tree has no affect on ESQL paths or XPath
expressions. Typically, a simple message tree query produces the same results in
XMLNSC as in the XMLNS or XML domain. Merely changing the correlation name
from XMLNS to XMLNSC is usually sufficient, but care must be taken with
complex XPath expressions that navigate to the value of an element and then to its
parent in a single query. These might produce different results in the XMLNSC
domain.

The field type constants that are used by the XMLNSC parser are completely
different from those used by XMLNS or XML. Every occurrence of XML.Attribute,
XML.XmlDecl, for example, must be changed to use the equivalent XMLNSC field
type constant.

The discarding of inline DTDs only affects message flows that process the DTD.
Migrating from MRM XML

The XMLNSC parser differs from the MRM XML parser in the following ways:

¢ The XMLNSC parser uses field types to identify the XML constructs in the
message tree. The MRM parser distinguishes attributes from elements by
matching the message tree against the message definition.

*  When writing a message tree, the XMLNSC parser selects namespace prefixes
by detecting and using xmlns attributes in the message tree. The MRM XML
parser uses a table in the message set properties.

* The MRM parser does not include the root tag of the XML document in the
message tree.

Migrating a message flow from MRM to XMLNSC typically requires extensive
changes to your message flow. However, the migration usually delivers a large
reduction in CPU usage, and allows much more accurate control of the output
XML.

Manipulating messages in the XMLNS domain:

This topic provides information about how to write ESQL for processing messages
that belong to the XMLNS domain, and that are parsed by the XMLNS parser.
Most of the information in this topic, and the topics mentioned below, also applies
to the XML domain, unless it refers to features that are not supported in the XML
domain.
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Refer to["XMLNS parser” on page 89 for background information.

The following topics provided detailed information about the structure of the
message tree that the XMLNS parser builds, and the field types that it uses.

+ ["XMLNS: The XML declaration”]
+ ["XMLNS: The DTD” on page 365|
+ ["XMLNS: The XML message body” on page 366|

More information about processing XML messages can be found in
[XML messages” on page 341)

XMLNS: The XML declaration:
The beginning of an XML message can contain an XML declaration.

An example of a declaration is shown below:

<?xml version="1.0" encoding="UTF-8" standalone="no"?>
<IDOCTYPE sl PUBLIC "http://www.ibm.com/example.dtd" "example.dtd">
<sl>........ </sl>

The XML Declaration is represented by the following types of syntax element:
* ["XML.XMLDecl”|

-

+ ["XML.encoding” on page 365

* ["XML.standalone” on page 365|

["XMLNS: XML declaration example” on page 365|includes another example of an
XML declaration and the tree structure that it forms.

XML.XMLDecl:

The XML Declaration is represented in the message tree by a syntax element with
field type "XML.XMLDecl'.

If the XML declaration is created by the XMLNS parser its name is “XMLDecl'.
However, when a message tree is being output the name is not important; only the
field type is used by the parser.

An example of a declaration is shown below:

<?xml version="1.0" encoding="UTF-8" standalone="no"?>
<IDOCTYPE sl PUBLIC "http://www.ibm.com/example.dtd" "example.dtd">
<sl>........ </sl>

XML.version:

The XML version attribute in the XML declaration is represented in the message
tree by a syntax element with field type ‘XML.version’.

The value of the XML version attribute is the value of the version attribute. It is
always a child of an XML.XmlDecl syntaxelement. In the example below, the
version element contains the string value 1.0:

<?xml version="1.0" encoding="UTF-8" standalone="no"?>

<IDOCTYPE sl PUBLIC "http://www.ibm.com/example.dtd" "example.dtd">
<sl>........ </sl>



XML.encoding:

The encoding attribute is represented by a syntax element with field type
“XML.encoding’, and is always a child of an XML.XmlDecl syntax element.

In the example shown below, the encoding attribute has a value of UTF-8.

<?xml version="1.0" encoding="UTF-8" standalone="no"?>
<IDOCTYPE s1 PUBLIC "http://www.ibm.com/example.dtd" "example.dtd">
<sl>........ </sl>

You cannot specify WebSphere MQ encodings in this element.

In your ESQL, (XML,"Encoding”) must include quotes, because Encoding is a
reserved word.

XML.standalone:

The XML standalone element defines the existence of an externally-defined DTD.
In the message tree it is represented by a syntax element with field type
XML.standalone.

The value of the XML standalone element is the value of the standalone attribute
in the XML declaration. It is always a child of an XML.XmlDecl syntax element.
The only valid values for the standalone element are yes and no. An example is
shown below:

<?xml version="1.0" encoding="UTF-8" standalone="no"?>

<IDOCTYPE sl PUBLIC "http://www.ibm.com/example.dtd" "example.dtd">
<sl>........ </sl>

A value of no indicates that this XML document is not standalone, and depends on
an externally-defined DTD. A value of yes indicates that the XML document is
self-contained. However, because the current release of WebSphere Message Broker
does not resolve externally-defined DTDs, the setting of standalone is irrelevant,
and is ignored.

XMLNS: XML declaration example:

The following example shows an XML declaration in an XML document:
<?xml version="1.0" encoding="UTF-8" standalone="yes"?>

The following figure shows the tree structure that the XMLNS parser creates for
this declaration:

XmlDecl
Version Encoding Standalone
value="1.0" value="UTF-8" value="yes"

XMLNS: The DTD:

The document type declaration (DTD) of an XML message is represented by a
syntax element with field type XML.DocTypeDecl, and its children. These comprise
the DOCTYPE construct.
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Only internal (inline) DTD subsets are represented in the syntax element tree. An
inline DTD is a DTD that is declared within the XML document itself. It can be a
complete DTD definition, or it can extend the definition in an external DTD.

External DTD subsets (identified by the SystemlID or Publicld elements described
below) can be referenced in the message, but those referenced are not resolved by
the broker.

The following field type constants can be used to reference the various parts of a
DTD in the message tree:

* XML DocTypeDecl” on page 1299|

+ ["XML NotationDecl” on page 1300|

* [“XML entities” on page 1300

* ["XML ElementDef” on page 1301]

+ ["XML AttributeList” on page 1302

* XML AttributeDef” on page 1302|

* XML DocTypePl” on page 1303

+ XML WhiteSpace and DocTypeWhiteSpace” on page 1303|
* XML DocTypeComment” on page 1303|

["XML DTD example” on page 1304] shows an example of an XML DTD.

See [“XML document type declaration” on page 1298| for more information about
handling an inline DTD.

XMLNS: The XML message body:

Every XML message must have a body. The body consists of a hierarchy of XML
elements and other XML constructs that represent the message data.

The XMLNS parser assigns a field type to every syntax element that it creates. The
value of the field type indicates the XML construct that it represents. In the
following topics, each field type is discussed, with a series of example XML
fragments.

The following common element types are discussed:
+ ["XML.element” on page 368|

+ ["XML.Attribute” on page 369

* ["XML.content” on page 369

["XML message body example” on page 372| provides an example of an XML
message body and the tree structure that is created from it using the syntax
elements types that are listed above.

More complex XML messages might use some of the following syntax element
types:

+ ["XML.CDataSection” on page 369

* XML EntityReferenceStart and XML.EntityReferenceEnd” on page 370]

+ ["XML.comment” on page 371

* [“XML.ProcessingInstruction” on page 371]
+ ["XML.AsisElementContent” on page 371
+ XML BitStream” on page 372




Accessing attributes and elements: The XMLNS parser sets the field type on every
message tree element that it creates. The field type indicates the type of XML
construct that the element represents. The field types used by the XMLNS parser
can be referenced using constants with names prefixed with “XML.” Field type
constants with prefix XML." are for use with the XMLNS and XML parsers only;
they do not work at all with the XMLNSC or MRM parsers.

XMLNS Field Type constant

Tag XML.Element
Attribute XML.Attribute
XML.Attr

By using the field type in this way the XMLNS parser can distinguish between an
element and an attribute that have the same name.

Example XML
<parent id="12345">

<id>ABCDE</1id>
</parent>

Example ESQL

SET value = FIELDVALUE(InputRoot.XMLNS.parent.(XML.Element)id)
Result : value is 'ABCDE'

SET value = FIELDVALUE(InputRoot.XMLNS.parent. (XML.Attr)id)
Result : value is '12345'

Example using SELECT to access multiple attributes

In the example Invoice message, the element Title within each Item element has
three attributes: Category, Form, and Edition. For example, the first Title element
contains:

<Title Category="Computer" Form="Paperback" Edition="2">The XML Companion</Title>

The element InputRoot.XML.Invoice.Purchases.Item[1].Title has four children in
the logical tree: Category, Form, Edition, and the element value, which is “The
XML Companion”.

If you want to access the attributes for this element, you can code the following
ESQL. This extract of code retrieves the attributes from the input message and
creates them as elements in the output message. It does not process the value of
the element itself in this example.

-- Set the cursor to the first XML.Attribute of the Title.
-- Note the = after (XML.Attribute) meaning any name, because the name might not be known
DECLARE cursor REFERENCE TO InputRoot.XMLNS.Invoice.Purchases.Item[1].Title.(XML.Attribute)=;
WHILE LASTMOVE(cursor) DO
-- Create a field with the same name as the XML.Attribute
-- and set its value to the value of the XML.Attribute
SET OQutputRoot.XML.Data.Attributes.{FIELDNAME(cursor)} = FIELDVALUE(cursor);
-- Move to the next sibling of the same TYPE to avoid the Title value
-- which is not an XML.Attribute
MOVE cursor NEXTSIBLING REPEAT TYPE;
END WHILE;

When this ESQL is processed by the Compute node, the following output message
is generated:
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<Data>
<Attributes>
<Category>Computer</Category>
<Form>Paperback</Form>
<kEdition>2</Edition>
</Attributes>
</Data>

You can also use a SELECT statement:

SET OutputRoot.XMLNS.Data.Attributes[] =
(SELECT FIELDVALUE(I.Title) AS title,
FIELDVALUE(I.Title. (XML.Attribute)Category) AS category,
FIELDVALUE(I.Title.(XML.Attribute)Form) AS form,
FIELDVALUE(I.Title.(XML.Attribute)Edition) AS edition
FROM InputRoot.XML.Invoice.Purchases.Item[] AS I);

This generates the following output message:

<Data>

<Attributes>
<title>The XML Companion</title>
<category>Computer</category>
<form>Paperback</form>
<edition>2</edition>

</Attributes>

<Attributes>
<title>A Complete Guide to DB2 Universal Database</title>
<category>Computer</category>
<form>Paperback</form>
<edition>2</edition>

</Attributes>

<Attributes>
<title>JAVA 2 Developers Handbook</title>
<category>Computer</category>
<form>Hardcover</form>
<edition>0</edition>

</Attributes>

</Data>

You can qualify the SELECT with a WHERE statement to narrow down the results
to obtain the same output message as the one that is generated by the WHILE
statement. This second example shows that you can create the same results with
less, and less complex, ESQL.
SET OutputRoot.XMLNS.Data.Attributes[] =
(SELECT FIELDVALUE(I.Title.(XML.Attribute)Category) AS category,
FIELDVALUE(I.Title.(XML.Attribute)Form) AS form,
FIELDVALUE(I.Title. (XML.Attribute)Edition) AS edition

FROM InputRoot.XML.Invoice.Purchases.Item[] AS I)
WHERE I.Title = 'The XML Companion');

This generates the following output message:

<Data>
<Attributes>
<Category>Computer</Category>
<Form>Paperback</Form>
<Edition>2</Edition>
</Attributes>
</Data>

XML.element: This syntax element represents an XML element ( a tag ). The name
of the syntax element corresponds to the name of the XML element in the message.
This element can have many children in the message tree, including attributes,
elements, and content.



XML.tag is supported as an alternative to XML.element for compatibility with
earlier versions of WebSphere Message Broker. Use XML.element in any new
message flows that you create.

XML.Attribute: Parsing

The XMLNS parser uses this field type for syntax elements that represent an XML
attribute. The name and value of the syntax element correspond to the name and
value of the XML attribute that is represented. Attribute elements have no children,
and must always be children of an element.

Writing

When the XMLNS parser generates a bit stream from a message tree, occurrences

of ampersand (&), less than (<), greater than (>), double quote ("), and apostrophe
("), within the attribute value, are replaced by the predefined XML entities &amp;,
&lt;, &gt;, &quot;, and &apos;.

The XML.attr field type constant is also supported for compatibility with earlier
versions of WebSphere Message Broker.

XML.content: The XMLNS parser uses this syntax element to represent character
data (including an XML attribute. The name and value of the syntax element
correspond to the name and value of the XML attribute that is represented.
Attribute elements have no children, and must always be children of an element.

Writing

When the XMLNS parser generates a bit stream from a message tree, occurrences

of ampersand (&), less than (<), greater than (>), double quote ("), and apostrophe
("), within the attribute value, are replaced by the predefined XML entities &amp;,
&lt;, &gt;, &quot;, and &apos;.

XML.CDataSection: CData sections in the XML message are represented by a
syntax element with field type XML.CdataSection. The content of the CDataSection
element is the value of the CDataSection element without the <!/[CDATA[ that
marks its beginning, and the ]]> that marks its end.

For example, the following CData section
<! [CDATA[<greeting>Hello, world!</greeting>]]>

is represented by a CDataSection element with a string value of:
"<greeting>Hello, world!</greeting>"

Unlike Content, occurrences of <,>, &, ”, and ’ are not translated to their XML
character entities ( &lt;, &gt;, and &amp;) when the CDataSection is output.

When to use XML.CDataSection

A CData section is often used to embed one XML message within another. Using a
CData section ensures that the XML reserved characters ( <, >, and & ) are not
replaced with XML character entities.

XML.AslsElementContent also allows the output of unmodified character data, but
XML.CDataSection is usually a better choice because it protects the outer message

from errors in the embedded message.
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Parsing the contents of a CDataSection

A common requirement is to parse the contents of a CData section to create a
message tree. This can be achieved by using the ESQL statement CREATE with the
PARSE clause. See ["XMLNSC: Working with XML messages and bit streams” on|

XML.NamespaceDecl: A namespace declaration is represented by a syntax element
with field type XML.NamespaceDecl. Namespace declarations take one of two
forms in the message tree:

Standard namespace declaration
<nsl:el xmIns:nsl="namespacel"/>

In the message tree, the syntax element for this namespace declaration is as
follows:

Namespace “http:/ /www.w3.org/2000/xmlns/”
Name “nsl”
Value “namespacel”

Default namespace declaration

A default namespace declaration is an xmlns attribute that defines an empty prefix

<el xmlIns="namespacel"/>

In the message tree, the syntax element for this namespace declaration would be as
follows:

Namespace “
Name “xmlns”
Value “namespacel”

Note that, in both cases, element ‘el” is in namespace ‘namespacel’.

XML.EntityReferenceStart and XML.EntityReferenceEnd: When an entity reference is
encountered in the XML message, both the expanded form and the original entity
name are stored in the syntax element tree. The name of the entity is stored as the
value of the EntityReferenceStart and EntityReferenceEnd syntax elements, and any
syntax elements between contain the entity expansion. Examples of the XML entity
references in an XML document, and in tree structure form, are shown below:

<?xml version="1.0" encoding="UTF-8" standalone="yes"?>

<IDOCTYPE example [ <!ENTITY entityName "eValue"> ]>
<example>Test: &entityName;</example>

Element
-name="example"

Content EntityReferenceStart | | Content EntityReferenceEnd
-value="Test:" -value="entityName" -value="eValue"| | -value="entityName"




The XML declaration and the document type declaration are not shown here. Refer
to ["XMLNS: The XML declaration” on page 364 and [“XMLNS: The DTD” on page|
[365] for details of those sections of the syntax element tree.

XML.comment: An XML.comment that is encountered outside the document type
declaration is represented by a syntax element with field type XML.comment. The
value of the element is the comment text from the XML message.

If the value of the element contains the character sequence -->, the sequence is
replaced with the text -->. This ensures that the contents of the comment cannot
prematurely terminate the comment. Occurrences of <, >, &, ", and ” are not
translated to their escape sequences.

An example of the XML comment in an XML document is shown below:
<example><!-- This is a comment --></example>

XML.Processinglnstruction: A processing instruction that is encountered outside the
document type declaration is represented by a syntax element with field type
XML.ProcessingInstruction. This is a name-value element; the name of the syntax
element is the processing instruction target name, and the value of the syntax
element is the character data of the processing instruction. The value of the syntax
element must not be empty. The name cannot be XML’ in either uppercase or
lowercase.

If the value of the element contains the character sequence ?>, the sequence is
replaced with the text ?&gt. This ensures that the content of the processing
instruction cannot prematurely terminate the processing instruction. Occurrences of
<>, &, ", and ’ are not translated to their escape sequences.

An example of the XML processing instruction in an XML document is shown
below:

<example><?target This is a PI.?></example>

XML.AsisElementContent: XML.AsIsElementContent is a special field type. Use it
in a message flow to precisely control the XML that is generated in an output
message, without the safeguards of the Element, Attribute, and Content syntax
elements. The XMLNS parser never creates elements with this field type.

Try to avoid using AsisElementContent; there is usually a safer alternative
approach. If you do use AsisElementContent, it is your responsibility to ensure that
the output message is well-formed XML.

You might choose to use this syntax element if, for example, you want to suppress
the normal behavior in which occurrences of ampersand (&), less than (<), greater
than (>), double quote ("), and apostrophe (') are replaced by the predefined XML
entities &amp;, &lt;, &gt;, &quot;, and &apos;.

The following example illustrates the use of AsisElementContent. The statement:
Set OutputRoot.XMLNS. (XML.Element)Message. (XML.Content) = '<rawMarkup>';

generates the following XML in an output message:
<Message>&1t;rawMarkup&gt;</Message>

However, the statement
Set OutputRoot.XMLNS. (XML.Element)Message. (XML.AsisElementContent) = '<rawMarkup>';
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generates the following XML in an output message:
<Message><rawMarkup></Message>

This shows that the value of an AsisElementContent syntax element is not
modified before it is written to the output message.

XML.BitStream: XML.Bitstream is a special field type. When writing an XML
message, the value of the BitStream element is written directly into the message,
and the name is not important. The BitStream element might be the only element
in the message tree.

The value of the element must be of type BLOB; any other data type generates an
error when writing the element. Ensure that the content of the element is
appropriate for use in the output message; pay special attention to the CCSID and
the encoding of the XML text in the BLOB.

Use of the BitStream element is similar to the use of the AsisElementContent
element, except that the AsisElementContent type converts its value into a string,
whereas the BitStream element uses its BLOB value directly. This is a specialized
element designed to aid the processing of very large messages.

The following ESQL excerpts demonstrate some typical use of this element. First,
declare the element:

DECLARE StatementBitStream BLOB

Initialize the contents of StatementBitStream from an appropriate source, such as
an input message. If the source field is not of type BLOB, use the CAST statement
to convert the contents to BLOB. Then create the new field in the output message;
for example:
CREATE LASTCHILD OF resultCursor

Type XML.BitStream

NAME 'StatementBitStream'
VALUE StatementBitstream;

XML message body example: This topic shows the message tree that the XMLNS
parser creates for the following snippet from a simple XML document:
<Person age="32" height="172cm">

<Name>Cormac Keogh</Name>
</Person>

Element
-name="person"

Attribute Attribute Content Element Content
-name="age" -name="height" -value="\n" -name="Name" -value="\n"
-value="32" -value="172cm" I

Content

-value="Cormac Keogh"

Manipulating messages in the XML domain:
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The XML parser is very similar to the XMLNS parser, but it has no support for
namespaces or opaque parsing. For information about how to work with the XML
parser, refer to [“Manipulating messages in the XMLNS domain” on page 363

Manipulating messages in the MRM domain
Find out how to use messages that have been modeled in the MRM domain, and
that are parsed by the MRM parser.

The following topics show you how to deal with messages that have been modeled
in the MRM domain, and that are parsed by the MRM parser. The physical formats
associated with the message models do not affect this information unless
specifically stated. Use this information in conjunction with the information about
manipulating message body content; see [“Manipulating message body content” on|
I};age 271.|

* |“Accessing elements in a message in the MRM domain” on page 374

* |“Accessing multiple occurrences of an element in a message in the MRM|
domain” on page 374|

* [“Accessing attributes in a message in the MRM domain” on page 375|

* |“Accessing elements within groups in a message in the MRM domain” on page|
377]

* [“Accessing mixed content in a message in the MRM domain” on page 378
* [“Accessing embedded messages in the MRM domain” on page 380|

* |“Accessing the content of a message in the MRM domain with namespace]
support enabled” on page 381

* [“Querying null values in a message in the MRM domain” on page 381

* [“Setting null values in a message in the MRM domain” on page 382

* [“Working with MRM messages and bit streams” on page 383|

+ [“Handling large MRM messages” on page 386|

The following diagram shows the structure of the message, Customer, that is used
in the following sample:

+ |[Video Rental sample|

The message is used in the samples in the topics listed previously to show ESQL
that manipulates the objects that can be defined in a message model. You can view
samples only when you use the information center that is integrated with the
Message Broker Toolkit.

| | |

| |
‘ Name ‘ ‘ Address ‘ ‘ ID ‘ (IdGroup) ‘Borrowed‘
| |
| | | | | |

‘ HouseNo‘ ‘ Street ‘ ‘Town‘ ‘VideoTitle‘ ‘DueDate‘ ‘ Cost ‘

| [ — |

‘ Title ‘ ‘ FirstName ‘ LastName ! ‘ PassportNo ‘ ‘ DrivingLicenceNo‘ ‘CreditCardNo‘

The message includes a variety of structures that demonstrate how you can classify
metadata to the MRM. Within an MRM message set, you can define the following
objects: messages, types, groups, elements, and attributes. Folder icons that
represent each of these types of objects are displayed for each message definition
file in the Broker Application Development perspective.
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Each message definition file can contribute to a namespace; in this sample, each
namespace is completely defined by a single message definition file. You can
combine several message definition files to form a complete message dictionary,
which you can then deploy to a broker.

The video sample has three message definition files:

Customer.mxsd
Resides in the no target namespace

Address.mxsd
Resides in the namespace http://www.ibm.com/AddressDetails

Borrowed.mxsd

Resides in the namespace http:/ /www.ibm.com /BorrowedDetails

Look at the video rental message structure sample for detailed information about
the objects that are defined in this message model:

+ [Video Rental sample]

You can view samples only when you use the information center that is integrated
with the Message Broker Toolkit.

Accessing elements in a message in the MRM domain:

You can use ESQL to manipulate the logical tree that represents a message in the
message flow. This topic describes how to access data for elements in a message in
the MRM domain.

You can populate an element with data with the SET statement:
SET OutputRoot.MRM.Name = UPPER(InputRoot.MRM.Name);

The field reference on the left hand side of the expression refers to the element
called Name within the MRM message domain. This statement takes the input
value for the Name field, converts it to uppercase, and assigns the result to the
same element in the output message.

The Name element is defined in the noTarget namespace. No namespace prefix is
specified in front of the Name part of the field reference in the example above. If
you have defined an MRM element in a namespace other than the noTarget
namespace, you must also specify a namespace prefix in the statement. For
example:

DECLARE brw NAMESPACE 'http://www.ibm.com/Borrowed';

SET OutputRoot.MRM.brw:Borrowed.VideoTitle = 'MRM Greatest Hits';

For more information about using namespaces with messages in the MRM domain,
see [“Accessing the content of a message in the MRM domain with namespace]
lsupport enabled” on page 381

Accessing multiple occurrences of an element in a message in the MRM
domain:

You can access MRM domain elements following the general guidance given in
“ Accessing known multiple occurrences of an element” on page 276 and
" Accessing unknown multiple occurrences of an element” on page 277/ Further
information specific to MRM domain messages is provided in this topic.
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Consider the following statements:

DECLARE brw NAMESPACE 'http://www.ibm.com/Borrowed';

SET OutputRoot.MRM.brw:Borrowed[1].VideoTitle
SET OutputRoot.MRM.brw:Borrowed[2].VideoTitle

'MRM Greatest Hits Volume 1';
'MRM Greatest Hits Volume 2';

The above SET statements operate on two occurrences of the element Borrowed.
Each statement sets the value of the child VideoTitle. The array index indicates
which occurrence of the repeating element you are interested in.

When you define child elements of a complex type (which has its Composition
property set to Sequence) in a message set, you can add the same element to the
complex type more than once. These instances do not have to be contiguous, but
you must use the same method (array notation) to refer to them in ESQL.

For example, if you create a complex type with a Composition of Sequence that
contains the following elements:

StringETementl
IntegerElementl
StringETementl

use the following ESQL to set the value of StringElement1:

SET OutputRoot.MRM.StringElementl1[1] =

'This is the first occurrence of StringElementl';
SET OutputRoot.MRM.StringElementl1[2] =

'This is the second occurrence of StringElementl';

You can also use the arrow notation (the greater than (>) and less than (<)
symbols) to indicate the direction of search and the index to be specified:

SET OutputRoot.MRM.StringElementl[>] =

'This is the first occurrence of StringElementl';
SET OutputRoot.MRM.StringElementl[<2] =

'This is the last but one occurrence of
StringElementl';
SET OutputRoot.MRM.StringElementl[<1] =

'This is the last occurrence of StringElementl';

Refer to [“Accessing known multiple occurrences of an element” on page 276 and
[Accessing unknown multiple occurrences of an element” on page 277] for
additional detail.

Accessing attributes in a message in the MRM domain:

When an MRM message is parsed into a logical tree, attributes and the data that
they contain are created as name-value pairs in the same way that MRM elements
are. The ESQL that you code to interrogate and update the data held in attributes
refers to the attributes in a similar manner.

Consider the Video Rental sample MRM message. The attribute LastName is

defined as a child of the Name element in the Customer message. Here is an
example input XML message:
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<Customer xmlIns:addr="http://www.ibm.com/AddressDetails"

xmins:brw="http://www.ibm.com/BorrowedDetails">

<Name LastName="Bloggs">
<Title>Mr</Title>
<FirstName>Fred</FirstName>

</Name>

<addr:Address>
<HouseNo>13</HouseNo>
<Street>0ak Street</Street>
<Town>Southampton</Town>

</addr:Address>

<ID>P</ID>

<PassportNo>J123456TT</PassportNo>

<brw:Borrowed>
<VideoTitle>Fast Cars</VideoTitle>
<DueDate>2003-05-23T01:00:00</DueDate>
<Cost>3.50</Cost>

</brw:Borrowed>

<brw:Borrowed>
<VideoTitle>Cut To The Chase</VideoTitle>
<DueDate>2003-05-23T01:00:00</DueDate>
<Cost>3.00</Cost>

</brw:Borrowed>

<Magazine>0</Magazine>

</Customer>

When the input message is parsed, values are stored in the logical tree as shown in
the following section of user trace:

(0x0100001B) :MRM = (

(0x01000013) :Name = (

(0x0300000B) :LastName = 'Bloggs'
(0x0300000B) : Title = 'Mr'
(0x0300000B) :FirstName = 'Fred'

)

(0x01000013)http://www.ibm.com/AddressDetails:Address = (
(0x0300000B) :HouseNo = 13
(0x0300000B) : Street = 'Oak Street'

(0x0300000B) : Town = 'Southampton'

)

(0x0300000B) : ID = 'P'

(0x0300000B) : PassportNo = 'J123456TT'

(0x01000013)http://www.ibm.com/BorrowedDetails:Borrowed = (
(0x0300000B) :VideoTitle = 'Fast Cars'

(6x03000008B) :DueDate = TIMESTAMP '2003-05-23 00:00:00'
(0x0300000B) :Cost = 3.50

)

(0x01000013)http://www.ibm.com/BorrowedDetails:Borrowed = (
(0x0300000B) :VideoTitle = 'Cut To The Chase '
(6x0300000B) :DueDate = TIMESTAMP '2003-05-23 00:00:00'
(0x0300000B) :Cost = 3.00

)
(0x0300000B) :Magazine = FALSE

The following ESQL changes the value of the LastName attribute in the output
message:

SET OutputRoot.MRM.Name.LastName = 'Smith';

Be aware of the ordering of attributes when you code ESQL. When attributes are
parsed, the logical tree inserts the corresponding name-value before the MRM
element’s child elements. In the previous example, the child elements Title and
FirstName appear in the logical message tree after the attribute LastName. In the
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Broker Application Development perspective, the Outline view displays attributes
after the elements. When you code ESQL to construct output messages, you must
define name-value pairs for attributes before any child elements.

Accessing elements within groups in a message in the MRM domain:

When an input message is parsed, structures that you have defined as groups in
your message set are not represented in the logical tree, but its children are. If you
want to refer to or update values for elements that are children of a groups, do not
include the group in the ESQL statement. Groups do not have tags that appear in
instance messages, and do not appear in user trace of the logical message tree.

Consider the following Video message:

<Customer xmins:addr="http://www.ibm.com/AddressDetails"
xmIns:brw="http://www.ibm.com/BorrowedDetails">
<Name LastName="Bloggs">
<Title>Mr</Title>
<FirstName>Fred</FirstName>
</Name>
<addr:Address>
<HouseNo>13</HouseNo>
<Street>0ak Street</Street>
<Town>Southampton</Town>
</addr:Address>
<ID>P</ID>
<PassportNo>J123456TT</PassportNo>
<brw:Borrowed>
<VideoTitle>Fast Cars</VideoTitle>
<DueDate>2003-05-23T701:00:00</DueDate>
<Cost>3.50</Cost>
</brw:Borrowed>
<brw:Borrowed>
<VideoTitle>Cut To The Chase</VideoTitle>
<DueDate>2003-05-23T01:00:00</DueDate>
<Cost>3.00</Cost>
</brw:Borrowed>
<Magazine>0</Magazine>
</Customer>

When the input message is parsed, values are stored in the logical tree as shown in
the following section of user trace:
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(0x0100001B) :MRM = (

(0x01000013) :Name = (
(0x0300000B) : LastName = 'Bloggs'’
(0x0300000B) :Title = 'Mr'
(0x0300000B) :FirstName = 'Fred'

)

(6x01000013) http://www.ibm.com/AddressDetails:Address = (
(0x0300000B) :HouseNo = 13
(0x0300000B) :Street = 'Oak Street'
(0x0300000B) : Town = 'Southampton'

)

(0x0300000B) : ID = 'P'

(0x0300000B) : PassportNo = 'J123456TT'

(6x01000013) http://www.ibm.com/BorrowedDetails:Borrowed
(0x0300000B) :VideoTitle = 'Fast Cars'
(0x0300000B) :DueDate = TIMESTAMP '2003-05-23 00:00:00'
(0x0300000B) :Cost = 3.50

U}
—

)

(6x01000013) http://www.ibm.com/BorrowedDetails:Borrowed
(0x0300000B) :VideoTitle = 'Cut To The Chase '
(0x0300000B) :DueDate = TIMESTAMP '2003-05-23 00:00:00'
(0x0300000B) :Cost = 3.00

)
(0x0300000B) :Magazine = FALSE

I
—

Immediately following the element named ID, the MRM message definition uses a
group which has a Composition of Choice. The group is defined with three children:
PassportNo, DrivingLicenceNo, and CreditCardNo. The choice composition
dictates that instance documents must use only one of these three possible
alternatives. The example shown above uses the PassportNo element.

When you refer to this element in ESQL statements, you do not specify the group
to which the element belongs. For example:

SET OutputRoot.MRM.PassportNo = 'J999999TT';

If you define messages within message sets that include XML and TDS physical
formats, you can determine from the message data which option of a choice has
been taken, because the tags in the message represent one of the choice’s options.
However, if your messages have CWF physical format, or are non-tagged TDS
messages, it is not clear from the message data, and the application programs
processing the message must determine which option of the choice has been
selected. This is known as unresolved choice handling. For further information, see
the description of the value of Choice in [Complex type logical properties|

Accessing mixed content in a message in the MRM domain:
When you define a complex type in a message model, you can optionally specify
its content to be mixed. This setting, in support of mixed content in XML Schema,

allows you to manipulate data that is included between elements in the message.

Consider the following example:



<MRM>
<Mess1>
abc
<Eleml>def</Eleml>
ghi
<Elem2>jk1</El1em2>
mno
<Elem3>pgr</Elem3>
</Mess1>
</MRM>

The strings abc, ghi, and mno do not represent the value of a particular element

(unlike def, for example, which is the value of element Elem1). The presence of
these strings means that you must model Mess1 with mixed content. You can

model this XML message in the MRM using the following objects:
Message

The message Name property is set to Mess1 to match the XML tag.

The Type property is set to tMess1.

Type The complex type Name property is set to tMessl.
The Composition property is set to OrderedSet.
The complex type has mixed content.
The complex type contains the following objects:

Element

The Name property is set to Eleml to match the XML tag.

The Type property is set to simple type xsd:string.

Element

The Name property is set to Elem2 to match the XML tag.

The Type property is set to simple type xsd:string.

Element

The Name property is set to Elem3 to match the XML tag.

The Type property is set to simple type xsd:string.
If you code the following ESQL:

SET OutputRoot.MRM.*[1] = InputBody.Elem3;
SET OutputRoot.MRM.Eleml = InputBody.*[5];
SET OutputRoot.MRM.*[3] = InputBody.Elem2;
SET OutputRoot.MRM.Elem2 = InputBody.*[3];
SET OutputRoot.MRM.*[5] = InputBody.Eleml;
SET OutputRoot.MRM.Elem3 = InputBody*[1];

the mixed content is successfully mapped to the following output message:

<MRM>
<Mess1>
pqr
<Eleml>mno</Eleml>
Jjki
<Elem2>ghi</Elem2>
def
<Elem3>abc</Elem3>
</Mess1>
</MRM>
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Accessing embedded messages in the MRM domain:

If you have defined a multipart message, you have at least one message embedded
within another. Within the overall complex type that represents the outer messages,
you can model the inner message in one of the following ways:

* An element (named E_outer] in the following example) with its Type property
set to a complex type that has been defined with its Composition property set to
Message

* A complex type with its Composition property set to Message (named
t_Embedded in the following example)

The ESQL that you need to write to manipulate the inner message varies
depending on which of the above models you have used. For example, assume
that you have defined:

e An outer message M_outer that has its Type property set to t_Outer.
* An inner message M_inner1 that has its Type set to t_Innerl
* An inner message M_inner?2 that has its Type set to t_Inner2

e Type t_Outer that has its first child element named E_outerl and its second
child defined as a complex type named t Embedded

* Type t_Embedded that has its Composition property set to Message
* Type t_Innerl that has its first child element named E_inner11

e Type t_Inner2 that has its first child element named E_inner21

* Type t_outerl that has its Composition property set to Message

* Element E_outerl that has its Type property set to t_outerl

If you want to set the value of E_inner11, code the following ESQL:
SET OutputRoot.MRM.E outerl.M innerl.E innerll = 'FRED';

If you want to set the value of E_inner21, code the following ESQL:
SET OutputRoot.MRM.M_inner2.E_inner2l = 'FRED';

If you copy message headers from the input message to the output message, and
your input message type contains a path, only the outermost name in the path is
copied to the output message type.

When you configure a message flow to handle embedded messages, you can
specify the path of a message type in either an MQRFH2 header (if one is present
in the input message) or in the input node Message Type property in place of a
name (for example, for the message modeled above, the path could be specified as
M_Outer/M_Innerl/M_Inner?2 instead of just M_Outer).

If you have specified that the input message has a physical format of either CWF
or XML, any message type prefix is concatenated in front of the message type from
the MORFH2 or input node, giving a final path to use (for more information refer
to [Multipart messages)). The MRM uses the first item in the path as the outermost
message type, then progressively works inwards when it finds a complex type
with its Composition property set to Message.

If you have specified that the input message has a physical format of TDS, a
different process that uses message keys is implemented. This is described in
Iformat: Multipart messagesl




For more information about path concatenations, see [Message set properties]

Accessing the content of a message in the MRM domain with namespace
support enabled:

Use namespaces where appropriate for messages that are parsed by the MRM
parser.

When you want to access elements of a message and namespaces are enabled, you
must include the namespace when you code the ESQL reference to the element. If
you do not do so, the broker searches the no target namespace. If the element is
not found in the no target namespace, the broker searches all other known
namespaces in the message dictionary (that is, within the deployed message set).
For performance and integrity reasons, specify namespaces wherever they apply.
The most efficient way to refer to elements when namespaces are enabled is to
define a namespace constant, and use this in the appropriate ESQL statements.
This technique makes your ESQL code much easier to read and maintain.

Define a constant using the DECLARE NAMESPACE statement:

DECLARE ns01 NAMESPACE 'http://www.nsOl.com'

SET OutputRoot.MRM.Elementl = InputBody.nsOQl:Elementl;
ns01 is interpreted correctly as a namespace because of the way that it is declared.
You can also use a CHARACTER variable to declare a namespace:

DECLARE ns02 CHARACTER 'http://www.ns02.com'

SET OutputRoot.MRM.Element2 = InputBody.{ns02}:Element2;

If you use this method, you must surround the declared variable with braces to
ensure that it is interpreted as a namespace.

If you are concerned that a CHARACTER variable might get changed, you can use
a CONSTANT CHARACTER declaration:

DECLARE ns03 CONSTANT CHARACTER 'http://www.ns03.com'

SET OutputRoot.MRM.ETement3 = InputBody.{ns03}:Element3;
You can declare a namespace, constant, and variable within a module or function.
However, you can declare only a namespace or constant in schema scope (that is,

outside a module scope).

The following sample provides further examples of the use of namespaces:

+ |Video Rental sample|

You can view samples only when you use the information center that is integrated
with the Message Broker Toolkit.

Querying null values in a message in the MRM domain:
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If you want to compare an element to NULL, code the statement:

IF InputRoot.MRM.Elem2.Childl IS NULL THEN
DO:
-- more ESQL --

END IF;

If nulls are permitted for this element, this statement tests whether the element
exists in the input message, or whether it exists and contains the MRM-supplied
null value. The behavior of this test depends on the physical format:

* For an XML element, if the XML tag or attribute is not in the bit stream, this test
returns TRUE.

* For an XML element, if the XML tag or attribute is in the bit stream and contains
the MRM null value, this test returns TRUE.

* For an XML element, if the XML tag or attribute is in the bit stream and does
not contain the MRM null value, this test returns FALSE.

* For a delimited TDS element, if the element has no value between the previous
delimiter and its delimiter, this test returns TRUE.

* For a delimited TDS element, if the element has a value between the previous
delimiter and its delimiter that is the same as the MRM-defined null value for
this element, this test returns TRUE.

* For a delimited TDS element, if the element has a value between the previous
delimiter and its delimiter that is not the MRM-defined null value, this test
returns FALSE.

* For a CWF or fixed length TDS element, if the element’s value is the same as the
MRM-defined null value for this element, this test returns TRUE.

* For a CWF or fixed length TDS element, if the element’s value is not the same as
the MRM-defined null value, this test returns FALSE.

If you want to determine if the field is missing, rather than present but with null
value, you can use the ESQL CARDINALITY function.

Setting null values in a message in the MRM domain:

To set a value of an element in an output message, you normally code an ESQL
statement similar to the following;:

SET OutputRoot.MRM.Elem2.Childl = 'xyz';
or its equivalent statement:
SET OutputRoot.MRM.E1em2.Childl VALUE = 'xyz';

If you set the element to a non-null value, these two statements give identical
results. However, if you want to set the value to null, these two statements do not
give the same result:

1. If you set the element to NULL using the following statement, the element is
deleted from the message tree:

SET OutputRoot.MRM.ETem2.Childl = NULL;

The content of the output bit stream depends on the physical format:

* For an XML element, neither the XML tag or attribute nor its value are
included in the output bit stream.



* For a Delimited TDS element, neither the tag (if appropriate) nor its value
are included in the output bit stream. The absence of the element is typically
conveyed by two adjacent delimiters.

* For a CWF or Fixed Length TDS element, the content of the output bit
stream depends on whether you have set the Default Value property for the
element. If you have set this property, the default value is included in the bit
stream. If you have not set the property, an exception is raised.

This is called implicit null processing.
2. If you set the value of this element to NULL as follows:

SET OutputRoot.MRM.Elem2.Childl VALUE = NULL;

the element is not deleted from the message tree. Instead, a special value of
NULL is assigned to the element. The content of the output bit stream depends
on the settings of the physical format null-handling properties.

This is called explicit null processing.
Setting a complex element to NULL deletes that element and all its children.
Working with MRM messages and bit streams:

When you use the ASBITSTREAM function or the CREATE FIELD statement with
a PARSE clause note the following points.

The ASBITSTREAM function

If you code the ASBITSTREAM function with the parser mode option set to
RootBitStream, to parse a message tree to a bit stream, the result is an MRM
document in the format specified by the message format that is built from the
children of the target element in the normal way.

The target element must be a predefined message defined within the message set,
or can be a self-defined message if using an XML physical format. This algorithm
is identical to that used to generate the normal output bit stream. A well formed
bit stream obtained in this way can be used to recreate the original tree using a
CREATE statement with a PARSE clause.

If you code the ASBITSTREAM function with the parser mode option set to
FolderBitStream, to parse a message tree to a bit stream, the generated bit stream is
an MRM element built from the target element and its children. Unlike
RootBitStream mode the target element does not have to represent a message; it can
represent a predefined element within a message or self-defined element within a
message.

So that the MRM parser can correctly parse the message, the path from the
message to the target element within the message must be specified in the Message
Type. The format of the path is the same as that used by message paths except that
the message type prefix is not used.

For example, suppose the following message structure is used:

Message
eleml
elemll
eleml?

Developing message flows 383



384  Message Flows

To serialize the subtree representing element eleml2 and its children, specify the
message path 'message/eleml/eleml2' in the Message Type.

If an element in the path is qualified by a namespace, specify the namespace URI
between {} characters in the message path. For example if element eleml is
qualified by namespace 'http://www.ibm.com/temp', specify the message path as
'message/{http://www.ibm.com/temp}eleml/eleml2’

This mode can be used to obtain a bit stream description of arbitrary sub-trees
owned by an MRM parser. When in this mode, with a physical format of XML, the
XML bit stream generated is not enclosed by the ‘Root Tag Name’ specified for the
Message in the Message Set. No XML declaration is created, even if not suppressed
in the message set properties.

Bit streams obtained in this way can be used to recreate the original tree using a
CREATE statement with a PARSE clause (using a mode of FolderBitStream).

The CREATE statement with a PARSE clause

If you code a CREATE statement with a PARSE clause, with the parser mode
option set to RootBitStream, to parse a bit stream to a message tree, the expected bit
stream is a normal MRM document. A field in the tree is created for each field in
the document. This algorithm is identical to that used when parsing a bit stream
from an input node

If you code a CREATE statement with a PARSE clause, with the parser mode
option set to FolderBitStream, to parse a bit stream to a message tree, the expected
bit stream is a document in the format specified by the Message Format, which is
either specified directly or inherited. Unlike RootBitStreamn mode the root of the
document does not have to represent an MRM message; it can represent a
predefined element within a message or self-defined element within a message.

So that the MRM parser can correctly parse the message the path from the message
to the target element within the message must be specified in the Message Type. The
format of the message path is the same as that used for the ASBITSTREAM
function described above.

Example of using the ASBITSTREAM function and CREATE statement with a
PARSE clause in FolderBitStream mode

The following ESQL uses the message definition described above. The ESQL
serializes part of the input tree using the ASBITSTREAM function, and then uses
the CREATE statement with a PARSE clause to recreate the subtree in the output
tree. The Input message and corresponding Output message are shown below the
ESQL.
CREATE COMPUTE MODULE DocSampleFlow_Compute

CREATE FUNCTION Main() RETURNS BOOLEAN

BEGIN
CALL CopyMessageHeaders();

-- Set the options to be used by ASBITSTREAM and CREATE ... PARSE

-- to be FolderBitStream and enable validation

DECLARE parseOptions INTEGER BITOR(FolderBitStream, ValidateContent,
ValidateValue, ValidatelLocalError);

-- Serialise the eleml2 element and its children from the input bitstream
-- into a variable
DECLARE subBitStream BLOB



CAST(ASBITSTREAM(InputRoot.MRM.eleml.eleml2
OPTIONS parseOptions
SET 'DocSample’
TYPE 'message/eleml/eleml2’
FORMAT 'XML1') AS BLOB);

-- Set the value of the first element in the output tree
SET OutputRoot.MRM.eleml.elemll = 'valll';

-- Parse the serialized sub-tree into the output tree
IF subBitStream IS NOT NULL THEN
CREATE LASTCHILD OF QutputRoot.MRM.eleml
PARSE ( subBitStream

OPTIONS parseOptions
SET 'DocSample'’
TYPE 'message/eleml/eleml2’
FORMAT 'XML1');

END IF;

-- Convert the children of eleml2 in the output tree to uppercase
SET OutputRoot.MRM.eleml.eleml2.eleml2l =
UCASE (OutputRoot.MRM.eleml.eleml2.eleml21);

SET OutputRoot.MRM.eleml.eleml2.eleml22 =
UCASE (OutputRoot.MRM.eleml.eleml2.eleml22);

-- Set the value of the last element in the output tree
SET OutputRoot.MRM.eleml.eleml3 = 'vall3';

RETURN TRUE;
END;

CREATE PROCEDURE CopyMessageHeaders() BEGIN
DECLARE I INTEGER 1;

DECLARE J INTEGER CARDINALITY(InputRoot.[]);
WHILE I < J DO

SET OutputRoot.*[I] = InputRoot.*[I];

SET I =1+ 1;

END WHILE;
END;

END MODULE;

Input message :

<message>
<eleml>
<elemll>valuell</elemll>
<eleml2>
<eleml21>valuel2l</eleml21>
<eleml22>valuel22</eleml22>
</eleml2>
<eleml3>valuel3</eleml3>
</eleml>
</message>

Output message :

<message>
<eleml>
<elemll>valll</elemll>
<eleml2>
<eleml21>VALUE121</elem121>
<eleml22>VALUE122</elem122>
</eleml2>
<eleml3>vall3</eleml3>
</eleml
</message
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Handling large MRM messages:

When an input bit stream is parsed, and a logical tree created, the tree
representation of an MRM message is typically larger, and in some cases much
larger, than the corresponding bit stream. The reasons for this include:

* The addition of the pointers that link the objects together.
* Translation of character data into Unicode that can double the original size.

* The inclusion of field names that can be contained implicitly within the bit
stream.

* The presence of control data that is associated with the broker’s operation

Manipulation of a large message tree can, therefore, demand a great deal of
storage. If you design a message flow that handles large messages made up of
repeating structures, you can code specific ESQL statements that help to reduce the
storage load on the broker. These statements support both random and sequential
access to the message, but assume that you do not need access to the whole
message at one time.

These ESQL statements cause the broker to perform limited parsing of the
message, and to keep only that part of the message tree that reflects a single record
in storage at a time. If your processing requires you to retain information from
record to record (for example, to calculate a total price from a repeating structure
of items in an order), you can either declare, initialize, and maintain ESQL
variables, or you can save values in another part of the message tree, for example
LocalEnvironment.

This technique reduces the memory used by the broker to that needed to hold the
full input and output bit streams, plus that required for one record’s trees. It
provides memory savings when even a small number of repeats is encountered in
the message. The broker makes use of partial parsing, and the ability to parse
specified parts of the message tree, to and from the corresponding part of the bit
stream.

To use these techniques in your Compute node apply these general techniques:

* Copy the body of the input message as a bit stream to a special folder in the
output message. This creates a modifiable copy of the input message that is not
parsed and which therefore uses a minimum amount of memory.

* Avoid any inspection of the input message; this avoids the need to parse the
message.
* Use a loop and a reference variable to step through the message one record at a
time. For each record:
— Use normal transforms to build a corresponding output subtree in a second
special folder.

— Use the ASBITSTREAM function to generate a bit stream for the output
subtree that is stored in a BitStream element, placed in the position in the tree,
that corresponds to its required position in the final bit stream.

— Use the DELETE statement to delete both the current input and the output
record message trees when you complete their manipulation.

— When you complete the processing of all records, detach the special folders so
that they do not appear in the output bit stream.

You can vary these techniques to suit the processing that is required for your
messages. The following ESQL provides an example of one implementation.
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The ESQL is dependant on a message set called LargeMessageExanple that has been
created to define messages for both the Invoice input format and the Statement
output format. A message called AT1Invoices has been created that contains a
global element called Invoice that can repeat one or more times, and a message
called Data that contains a global element called Statement that can repeat one or
more times.

The definitions of the elements and attributes have been given the correct data
types, therefore, the CAST statements used by the ESQL in the XML example are
no longer required. An XML physical format with name XML1 has been created in
the message set which allows an XML message corresponding to these messages to
be parsed by the MRM.

When the Statement tree is serialized using the ASBITSTREAM function the
Message Set, Message Type, and Message Format are specified as parameters. The
Message Type parameter contains the path from the message to the element being
serialized which, in this case, is Data/Statement because the Statement element is a
direct child of the Data message.

The input message to the flow is the same Invoice example message used in other
parts of the documentation except that it is contained between the tags:

<AllInvoices> .... </AllInvoices>

CREATE COMPUTE MODULE LargeMessageExampleFlow_Compute
CREATE FUNCTION Main() RETURNS BOOLEAN
BEGIN
CALL CopyMessageHeaders();
-- Create a special folder in the output message to hold the input tree
-- Note : SourceMessageTree is the root element of an MRM parser
CREATE LASTCHILD OF OQutputRoot.MRM DOMAIN 'MRM' NAME 'SourceMessageTree';

-- Copy the input message to a special folder in the output message
-- Note : This is a root to root copy which will therefore not build trees
SET QutputRoot.MRM.SourceMessageTree = InputRoot.MRM;

-- Create a special folder in the output message to hold the output tree
CREATE FIELD OutputRoot.MRM.TargetMessageTree;

-- Prepare to loop through the purchased items

DECLARE sourceCursor REFERENCE TO OutputRoot.MRM.SourceMessageTree.Invoice;
DECLARE targetCursor REFERENCE TO OQutputRoot.MRM.TargetMessageTree;
DECLARE resultCursor REFERENCE TO OutputRoot.MRM;

DECLARE grandTotal FLOAT 0.0e0;

-- Create a block so that it's easy to abandon processing
ProcessInvoice: BEGIN
-- If there are no Invoices in the input message, there is nothing to do
IF NOT LASTMOVE(sourceCursor) THEN
LEAVE ProcessInvoice;
END IF;

-- Loop through the invoices in the source tree

InvoicelLoop : LOOP
-- Inspect the current invoice and create a matching Statement
SET targetCursor.Statement =

THE (
SELECT

'Monthly' AS Type,
"Full' AS Style,
I.Customer.FirstName AS Customer.Name,
I.Customer.LastName AS Customer.Surname,
I.Customer.Title AS Customer.Title,
(SELECT
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FIELDVALUE(II.Title) AS Title,
II.UnitPrice * 1.6 AS Cost,
II.Quantity AS Qty
FROM I.Purchases.Item[] AS II
WHERE II.UnitPrice> 0.0 ) AS Purchases.Article[],
(SELECT
SUM( II.UnitPrice *
II.Quantity =
1.6 )
FROM I.Purchases.Item[] AS II ) AS Amount,
'Dollars' AS Amount.Currency
FROM sourceCursor AS I
WHERE I.Customer.LastName <> 'White'

)s

-- Turn the current Statement into a bit stream
-- The SET parameter is set to the name of the message set
-- containing the MRM definition
-- The TYPE parameter contains the path from the from the message
-- to element being serialized
-- The FORMAT parameter contains the name of the physical format
-- name defined in the message
DECLARE StatementBitStream BLOB

CAST (ASBITSTREAM(targetCursor.Statement

OPTIONS FolderBitStream

SET 'LargeMessageExample'

TYPE 'Data/Statement’

FORMAT 'XML1') AS BLOB);

-- If the SELECT produced a result (that is, it was not filtered
-- out by the WHERE clause), process the Statement
IF StatementBitStream IS NOT NULL THEN
-- create a field to hold the bit stream in the result tree
-- The Type of the element is set to MRM.BitStream to indicate
-- to the MRM Parser that this is a bitstream
CREATE LASTCHILD OF resultCursor
Type MRM.BitStream
NAME 'Statement'
VALUE StatementBitStream;

-- Add the current Statement's Amount to the grand total
SET grandTotal = grandTotal + targetCursor.Statement.Amount;
END IF;

-- Delete the real Statement tree leaving only the bit stream version
DELETE FIELD targetCursor.Statement;

-- Step onto the next Invoice, removing the previous invoice and any
-- text elements that might have been interspersed with the Invoices
REPEAT

MOVE sourceCursor NEXTSIBLING;

DELETE PREVIOUSSIBLING OF sourceCursor;
UNTIL (FIELDNAME(sourceCursor) = 'Invoice')

OR (LASTMOVE (sourceCursor) = FALSE)

END REPEAT;

-- If there are no more invoices to process, abandon the loop
IF NOT LASTMOVE(sourceCursor) THEN

LEAVE Invoiceloop;
END IF;

END LOOP InvoicelLoop;
END ProcessInvoice;

-- Remove the temporary source and target folders

DELETE FIELD QutputRoot.MRM.SourceMessageTree;
DELETE FIELD QutputRoot.MRM.TargetMessageTree;
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-- Finally add the grand total

SET resultCursor.GrandTotal = grandTotal;

-- Set the output MessageType property to be 'Data’
SET OutputRoot.Properties.MessageType = 'Data';

RETURN TRUE;
END;

CREATE PROCEDURE CopyMessageHeaders() BEGIN
DECLARE I INTEGER 1;

DECLARE J INTEGER CARDINALITY(InputRoot.x*[]);
WHILE I < J DO

SET OutputRoot.*[I] = InputRoot.*[I];

SETI =1+1;
END WHILE;
END;

END MODULE;

Manipulating messages in the JMS domains

This topic provides information specific to dealing with messages that belong to
the JMSMap and JMSStream domains. These messages are parsed by the generic
XML parser.

Messages that belong to the JMS domains are processed by the XML parser, so you
can follow the guidance provided for XML messages in [“Manipulating messages in|
the XML domain” on page 372)in conjunction with the information in
“Manipulating message body content” on page 271

The J]MSMap and JMSStream domains support MapMessage and StreamMessage
messages. Other kinds of J]MS message are supported by other domains. For
further information about using JMS messages with WebSphere Message Broker,
see [WebSphere Broker JMS Transport|

Manipulating messages in the IDOC domain
Use ESQL from a Compute node to copy the incoming IDoc to the outgoing IDoc,
and manipulate the message.

A valid IDoc message flows out of SAP and is sent to the MQSeries link for R/3.

When this IDoc has been committed successfully to the outbound WebSphere MQ
queue, the input node of the message flow reads it from that queue and generates
the syntax element tree.

The Compute node manipulates this syntax element tree and, when it has finished,
passes the output message to subsequent nodes in the message flow. When the
message reaches the output node, the IDOC parser is called to rebuild the bit
stream from the tree.

The message flow must create an output message in a similar format to the input
message.

See [Field names of the IDOC parser structures| for the field names in the DC
(Control Structure) and DD (Data Structure) that are recognized by the IDOC
parser
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Use the following ESQL example from a Compute node:

SET OutputRoot = InputRoot;
SET OutputRoot.IDOC.DC[1].tabnam = 'EDI_DC40 ';
SET OutputRoot.IDOC.DD[2].sdatatag.MRM.maktx = 'Buzzing all day';

The first line of the code copies the incoming IDoc to the outgoing IDoc.
The second line sets the tabname of the first DC.

The third line uses the second DD segment, which in this example is of type
E2MAKTMOO1, and sets the maktx field.

Accessing fields of the IDoc using ESQL:
Use the ESQL editor Content Assist to fill in the SAP-defined fields of the IDoc.

After the sdatatag tag in an ESQL statement, the next tag is MRM, which you must
enter manually, followed by the field name that is to be manipulated. Specify the
name of the field within the message segment here, not the name of the message
segment.

For example, the following code sets the segment name of the IDoc:
SET OutputRoot.IDOC.DD[I].segnam = 'E2MAKTMOO1';

The following example sets the msgfn field within the E2MAKTMOO1 segment:
SET OutputRoot.IDOC.DD[I].sdatatag.MRM.msgfn = '006';

Manipulating messages in the MIME domain

This topic explains how to deal with messages that belong to the MIME domain,
and are parsed by the MIME parser. Use this information in conjunction with the
information in [“Manipulating message body content” on page 271

A MIME message does not need to be received over a particular transport. For

example, a message can be received over HTTP using an HTTPInput node, or over

WebSphere MQ using an MQInput node. The MIME parser is used to process a

message if one of the following conditions applies:

* The message domain is set to MIME in the input node properties.

* You are using WebSphere MQ, and the MQRFH?2 header has a message domain
of MIME.

You can manipulate the logical tree using ESQL before passing the message on to
other nodes in the message flow. A message flow can also create a MIME domain
tree using ESQL. When a MIME domain message reaches an output node, the
MIME parser is called to rebuild the bit stream from the logical tree.

The following examples show how to manipulate MIME messages:
s [‘Creating a new MIME tree”]

* [“Modifying an existing MIME tree” on page 391

+ [“Managing Content-Type” on page 392|

Creating a new MIME tree

A message flow often receives, modifies, and returns a MIME message. In this
case, you can work with the valid MIME tree that is created when the input
message is parsed. If a message flow receives input from another domain, such as



XMLNS, and returns a MIME message, you must create a valid MIME tree. Use
the following ESQL example in a Compute node to create the top-level structure
for a single-part MIME tree:

CREATE FIELD OutputRoot.MIME TYPE Name;

DECLARE M REFERENCE TO OutputRoot.MIME;
CREATE LASTCHILD OF M TYPE Name NAME 'Data';

The message flow must also ensure that the MIME Content-Type is set correctly, as
explained in [“Managing Content-Type” on page 392 The flow must then add the
message data into the MIME tree. The following ESQL examples show how you
can do this. In each case, a Data element is created with the domain BLOB.

¢ A bit stream from another part of the tree is used. This example shows how a bit
stream could be created from an XML message that is received by the message
flow. The flow then invokes the BLOB parser to store the data under the Data
element.
DECLARE partData BLOB ASBITSTREAM(InputRoot.XMLNS);
CREATE LASTCHILD OF M.Data DOMAIN('BLOB') PARSE(partData);
* Instead of parsing the bit stream, create the new structure, then attach the data
to it, as shown in this ESQL example:
DECLARE partData BLOB ASBITSTREAM(InputRoot.XMLNS);

CREATE LASTCHILD OF M.Data DOMAIN('BLOB') NAME 'BLOB';
CREATE LASTCHILD OF M.Data.BLOB NAME 'BLOB' VALUE partData;

Both of these approaches create the same tree structure. The first approach is better
because explicit knowledge of the tree structure that the BLOB parser requires is
not built into the flow.

More commonly, the Compute node must build a tree for a multipart MIME
document. The following ESQL example shows how you can do this, including
setting the top-level Content-Type property.

DECLARE partlData BLOB ASBITSTREAM(InputRoot.XMLNS, InputProperties.Encoding, InputProperties.CodedCharSetId);
SET OutputRoot.Properties.ContentType = 'multipart/related; boundary=myBoundary';

CREATE FIELD OutputRoot.MIME TYPE Name;

DECLARE M REFERENCE TO OutputRoot.MIME;

CREATE LASTCHILD OF M TYPE Name NAME 'Parts';

CREATE LASTCHILD OF M.Parts TYPE Name NAME 'Part';

DECLARE P1 REFERENCE TO M.Parts.Part[1];

CREATE FIELD P1."Content-Type" TYPE NameValue VALUE 'text/plain';
CREATE FIELD P1."Content-Id" TYPE NameValue VALUE 'part one';
CREATE LASTCHILD OF P1 TYPE Name NAME 'Data';

CREATE LASTCHILD OF P1.Data DOMAIN('BLOB') PARSE(partlData);

CREATE LASTCHILD OF M.Parts TYPE Name NAME 'Part';

DECLARE P2 REFERENCE TO M.Parts.Part[2];

CREATE FIELD P2."Content-Type" TYPE NameValue VALUE 'text/plain';
CREATE FIELD P2."Content-Id" TYPE NameValue VALUE 'part two';
CREATE LASTCHILD OF P2 TYPE Name NAME 'Data';

CREATE LASTCHILD OF P2.Data DOMAIN('BLOB') PARSE(part2Data);

Modifying an existing MIME tree

This ESQL example adds a new MIME part to an existing multipart MIME
message. If the message is not multipart, it is not modified.
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SET OutputRoot = InputRoot;

-- Check to see if the MIME message is multipart or not.
IF LOWER(InputProperties.ContentType) LIKE 'multipart/%'

THEN

CREATE LASTCHILD OF OutputRoot.MIME.Parts NAME 'Part';

DECLARE P REFERENCE TO OutputRoot.MIME.Parts.[<];

CREATE FIELD P."Content-Type" TYPE NameValue VALUE 'text/xml';
CREATE FIELD P."Content-ID"  TYPE NameValue VALUE 'new part';
CREATE LASTCHILD OF P TYPE Name NAME 'Data’;

-- This is an artificial way of creating some BLOB data.
DECLARE newBlob BLOB '4f6e652074776f2074687265650d0a";
CREATE LASTCHILD OF P.Data DOMAIN('BLOB') PARSE(newBlob);

END IF;
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Managing Content-Type

When you create a new MIME message tree, or when you modify the value of the
MIME boundary string, make sure that the MIME Content-Type header is set
correctly by setting the ContentType value in the broker Properties subtree. The
following example shows how to set the ContentType value for a MIME part with
simple content:

SET OutputRoot.Properties.ContentType = 'text/plain';

Do not set the Content-Type value directly in the MIME tree or HTTP trees
because the value is ignored or used inconsistently.

Manipulating messages in the BLOB domain

This topic provides information specific to dealing with messages that belong to
the BLOB domain, and that are parsed by the BLOB parser.

You cannot manipulate the contents of a BLOB message, because it has no
predefined structure. However, you can refer to its contents using its known
position within the bit stream, and process the message with a minimum of
knowledge about its contents.

The BLOB message body parser does not create a tree structure in the same way
that other message body parsers do. It has a root element BLOB, that has a child
element, also called BLOB, that contains the data.

You can refer to message content using substrings if you know the location of a
particular piece of information within the BLOB data. For example, the following
expression identifies the tenth byte of the message body:

InputBody.BLOB.BLOB[10]

The following expression references 10 bytes of the message data starting at offset
10:

SUBSTRING (InputBody.BLOB.BLOB from 10 for 10)
Simple example to write a string in the output message:
The following simple example allows you to write some character data in your

ESQL (for example, if you have read some character fields from a database) out as
a BLOB:



CALL CopyMessageHeaders();

-- CALL CopyEntireMessage();

DECLARE mystring CHARACTER;

SET mystring='hello';

SET OutputRoot.BLOB.BLOB=CAST (mystring AS BLOB CCSID 1208);

Using the CALL statement to invoke a user-written routine
The ESQL CALL statement invokes routines that have created and implemented in
different ways.

A routine is a user-defined function or procedure that has been defined by one of
the following statements:

* CREATE FUNCTION

* CREATE PROCEDURE

You can use the CALL statement to invoke a routine that has been implemented in

any of the following ways:

» ESQL.

e Java.

* As a stored procedure in a database.

* As a built-in (broker-provided) function.
(Although you can use CALL to invoke built-in (broker-provided) functions and
user-defined SQL functions, typically you would use their names in expressions
directly.)

For details of the syntax and parameters of the CALL statement, see
statement” on page 1345]For an example of the use of CALL, see the examples in
“CREATE PROCEDURE statement” on page 1368}

Calling an ESQL routine:

A routine is invoked as an ESQL method if the routine’s definition specifies a
LANGUAGE clause of ESQL or if the routine is a built-in function.

An exact one-to-one matching of the data types and directions of each parameter,
between the definition and the CALL, is required.

An ESQL routine is allowed to return any ESQL data type, excluding List and
Row.

Calling a Java routine:

A routine is invoked as a Java method if the routine’s definition specifies a
LANGUAGE clause of JAVA.

An exact one-to-one matching of the data types and directions of each parameter,
between the definition and the CALL, is required.

If the Java method has a void return type, the INTO clause cannot be used because
there is no value to return.

A Java routine can return any data type in the [“ESQL-to-Java data-type mapping]
[table” on page 1320 Note that this excludes List and Row.

Calling a database stored procedure:
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A routine is invoked as a database stored procedure if the routine’s definition has a
LANGUAGE clause of DATABASE.

When a call is made to a database stored procedure, the broker searches for a
definition (created by a CREATE PROCEDURE statement) that matches the
procedure’s local name. The broker then uses the following sequence to resolve the
name by which the procedure is known in the database and the database schema
to which it belongs:

1. If the CALL statement specifies an IN clause, the name of the data source, the
database schema, or both, is taken from the IN clause.

2. If the name of the data source is not provided by an IN clause on the CALL
statement, it is taken from the DATASOURCE attribute of the node.

3. If the database schema is not provided by an IN clause on the CALL statement,
but is specified on the EXTERNAL NAME clause of the CREATE PROCEDURE
statement, it is taken from the EXTERNAL NAME clause.

4. If no database schema is specified on the EXTERNAL NAME clause of the
CREATE PROCEDURE statement, the database’s user name is used as the
schema name. If a matching procedure is found, the routine is invoked.

The chief use of the CALL statement’s IN clause is that it allows the data source,
the database schema, or both to be chosen dynamically at run time. (The
EXTERNAL SCHEMA clause also allows the database schema which contains the
stored procedure to be chosen dynamically, but it is not as flexible as the IN clause
and is retained only for compatibility with earlier versions. Its use in new
applications is deprecated.)

If the called routine has any DYNAMIC RESULT SETS specified in its definition,
the number of expressions in the CALL statement’s ParameterList must match the
number of actual parameters to the routine, plus the number of DYNAMIC
RESULT SETS. For example, if the routine has three parameters and two
DYNAMIC RESULT SETS, the CALL statement must pass five parameters to the
called routine. The parameters passed for the two DYNAMIC RESULT SETS must
be list parameters; that is, they must be field references qualified with array
brackets [ ]; for example, Environment.ResultSet1[].

A database stored procedure is allowed to return any ESQL data type, excluding
Interval, List, and Row.

Accessing broker properties from ESQL

It can be useful, during the runtime of your code, to have real-time access to
details of a specific node, flow, or broker. For an overview of broker properties, see
[“Broker properties” on page 104/

You can use broker properties on the right side of regular SET statements. For
example:

DECLARE mybroker CHARACTER;
SET mybroker = BrokerName;

where BrokerName is the broker property that contains the broker’s name. However,
you cannot use broker properties on the left-hand side of SET statements. This is
because, at runtime, broker properties are constants: they cannot be assigned to,
and so their values cannot be changed by SET statements. If a program tries to
change the value of a broker property, the error message Cannot assign to a
symbolic constant is issued.



Broker properties:

* Are grouped by broker, execution group, flow, and node.

* Are case sensitive. Their names always start with an uppercase letter.
* Return NULL if they do not contain a value.

If your ESQL code already contains a variable with the same name as one of the
broker properties, your variable takes precedence; that is, your variable masks the
broker property. To access the broker property, use the form
SQL.<broker_property_name>. For example: SQL.BrokerName.

[“Broker properties that are accessible from ESQL and Java” on page 1517 shows
the broker, flow, and node properties that are accessible from ESQL and indicates
which properties are also accessible from Java.

Configuring a message flow at deployment time using UDPs

User-defined properties (UDPs) give you the opportunity to configure message
flows at deployment time, without modifying program code.

A UDP is a user-defined constant that you can use in your ESQL or Java programs.
You can give the UDP an initial value when you declare it in your program or
when you use the Message Flow editor to create or modify a message flow.

In ESQL, you can define UDPs at the module or schema level.

After a UDP has been defined by the Message Flow editor, you can modify its
value before you deploy:

1. From the workbench, switch to the Broker Administration perspective.

2. Double click your bar file in the Broker Administration Navigator view. The
contents of the bar file are shown in the Content editor.

3. Select the Configure tab at the bottom of the Content editor pane. This pane
shows the names of your message flows; these can be expanded to show the
individual nodes that are contained in the flow.

4. Click on a message flow name. The UDPs that are defined in that message flow
are displayed with their values.

5. If the value of the UDP is unsuitable for your current environment or task,
change it to the value that you want. The value of the UDP is set at the flow
level and is the same for all eligible nodes that are contained in the flow. If a
subflow includes a UDP that has the same name as a UDP in the main flow,
the value of the UDP in the subflow is not changed.

Now you are ready to deploy the message flow. See [“Deploying a broker archive|
[file” on page 705 |

Using XPath

XPath provides an alternate method to ESQL, of entering expressions in the
property fields of specific built-in nodes.

In addition to ESQL as a message processing transformation language, WebSphere

Message Broker supports the entry of an alternate expression grammar, within
property fields.
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You can use ESQL or XPath expressions in certain built-in nodes in your message
flows, to query or update message trees that are specified as accessible and that
you anticipate being processed by a given node.

The following nodes support XPath in their properties:

* Collector node

* DatabaseRoute node

* DatabaseRetrieve node

* EmailOutput node

* FileOutput node

* HTTPInput node

e JMSInput node

* MQInput node

* Route node

¢ SOAPEnvelope node

* SOAPEXxtract node

¢ SOAPInput node

* SOAPReply node

* SOAPRequest node

* SOAPAsyncRequest node

* SOAPAsyncResponse node

* WebSphere Adapter Request nodes

* WebSphere Service Registry and Repository EndpointLookup node
* WebSphere Service Registry and Repository RegistryLookup node

For more information about the associated properties in the nodes that use XPath,
see [“Multi-language node property fields” on page 397

This section provides information on:

+ [“XPath overview”]

+ [“Namespace support” on page 399

+ [“XPath Expression Builder” on page 401

+ [“Creating XPath expressions” on page 404|

* |“Selecting the grammar mode” on page 405

XPath overview
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The XML Path Language (XPath) is a language used to uniquely identify or
address parts of an XML document. An XPath expression can be used to search
through an XML document, and extract information from the nodes (any part of
the document, such as an element or attribute) in it. XPath can be used alone or in
conjunction with XSLT.

Some of the built-in nodes provided in the Message Broker Toolkit can use XPath
expressions to specify the part of a message that is processed by the node. For
example, you can use an XPath expression to identify fields in a message and
determine if they match a specified value, or to set the field value, updating it with
the results of a database query.

For more information about the fields, in the built-in nodes, that can use XPath in
their properties, see [“Multi-language node property fields” on page 397




For further information on XPath 1.0 see

You can use the XPath Expression Builder to visually build XPath expressions to
set the relevant properties in your nodes. You launch the XPath Expression Builder
from buttons located along side property fields present in the Properties viewer,
for those nodes that support the use of XPath expressions as property values.

The XPath files in WebSphere Message Broker are supplied in three property
editors; see [“XPath property editors” on page 1322 for more details.

The XPath editor supports both content-assist directly on the text field and also an
Edit... button that launches the XPath builder dialog. The dialog gives you a larger
area on which to build your XPath expressions.

The content assist based control contains two different proposal lists in the
following order:

1. Nodes and Variables

2. Functions and Operators

The node and variable proposals are displayed the first time that you use the
XPath editor. In this view, the status bar reads Press Ctr1+Space to show
Function and Operation Proposals.

Selecting Ctrl+Space in the function and operator level proposals selects the Node
and Variable proposals.

Multi-language node property fields

You can use ESQL or XPath expressions to specify the part of a message that is
processed by the node in the properties of some built-in nodes in the Message
Broker Toolkit.

The following list shows the nodes and associated properties that you can set
using ESQL or XPath expressions:

* WebSphere AdapterRequest node
— OutputDataLocation
* Collector node
— Correlation path; there is one for each dynamic input terminal.
* DatabaseRetrieve node
On the Basic tab:
— Value; when ValueType is set to Element.
On the Data Element Table tab:
— MessageElement
* DatabaseRoute node
On the Basic tab:
— Value; when ValueType is set to Element.
On the Filter Expression Table tab:
— filterPattern
* EmailOutput node
— Attachment
* FileOutput node
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— DataLocation
— Request directory property location
— Request file name property location
* HTTPInput, JMSInput, and MQInput nodes
On the Security tab:
— Identity Token location
— Identity Password location
— Identity issued by
* Route node
On the Basic tab:
— filterPattern
* SOAPEnvelope node
— Envelope location
* SOAPExtract node
— Envelope destination
— Destination path mode

e SOAPInput, SOAPReply, SOAPRequest, SOAPAsyncRequest,
SOAPAsyncResponse nodes

On the WSSecurity tab:
— MessagePartReference
* WebSphere Service Registry and Repository nodes
— RegistryLookup node - User properties
— EndpointLookup node - User properties

For further information on these fields, see [“Built-in nodes” on page 762| and
follow the link to the appropriate node.

The categories of field required to support XPath 1.0 and ESQL are:
* Read only path location.

This category is subdivided into:

— Fixed language: ESQL read-only path (field reference) field property.

— Fixed language: XPath 1.0 read-only path (path location) field property.

— Mixed language: ESQL or XPath 1.0 read-only path location field property
* Read write path location.

This category is subdivided into:

— Fixed language: ESQL read-write path (field reference) field property.

— Fixed language: XPath 1.0 read-write path (path location) field property.

— Mixed language: ESQL or XPath 1.0 read-write path location field property
* Expression.

This category is subdivided into:

— Fixed language: XPath 1.0 expression field property.

The mapping between ESQL and XPath for the expression-field property
category is described in [“ESQL-to-XPath mapping table” on page 1321/

A restricted set of expressions is supported by default to enable you to use either
XPath or ESQL; see [“XPath expressions supported by default” on page 399
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If you want to use the full supported capabilities of the runtime in either language
you can change this setting; see “Selecting the grammar mode” on page 405| for
instructions on how to do this.

XPath expressions supported by default
XPath supports the following expressions by default:

Read-only fields
$Root, $Body, $Properties, $LocalEnvironment, $DestinationList,
$ExceptionList, $InputRoot , $InputBody, $InputProperties,
$InputLocalEnvironment, $InputDestinationLlist,
$InputExceptionList,$Environment.

To exclude variables for a node property from the default list, specify a
comma separated string of variables. For example, specifying:
"com.ibm.etools.mft.ibmnodes.editors.xpath.XPathReadOnlyPropertyEditor", "InputRoot ,

InputBody, InputProperties, InputLocalEnvironment, InputDestinationList,
InputExceptionList"

restricts the XPath field to support only:

$Root, $Body, $Properties, $LocalEnvironment, $DestinationList, $ExceptionList’
$Environment

Read-write fields
$InputRoot , $InputBody, $InputProperties, $InputLocalEnvironment,
$InputDestinationList, $InputExceptionList, $OutputRoot ,
$OutputLocalEnvironment, $OutputDestinationList,
$OutputExceptionList, $Environment.

To exclude variables for a node property from the default list, specify a
comma separated string of variables. For example, specifying:
"com.ibm.etools.mft.ibmnodes.editors.xpath.XPathReadWritePropertyEditor", "InputRoot ,

InputBody, InputProperties, InputLocalEnvironment, InputDestinationList,
InputExceptionList"

restricts the XPath field to support only:

$OutputRoot, $OutputLocalEnvironment, $OutputDestinationList, $OutputExceptionList,
$Environment

Expression fields
$Root, $Body, $Properties, $LocalEnvironment, $DestinationList,
$ExceptionList, $InputRoot , $InputBody, $InputProperties,
$InputLocalEnvironment, $InputDestinationList, $InputExceptionList,
$OutputRoot , $OutputLocalEnvironment, $OutputDestinationList,
$OutputExceptionList, $Environment.

To exclude variables for a node property from the default list, specify a
comma separated string of variables. For example, specifying:

"com.ibm.etools.mft.ibmnodes.editors.xpath.XPathPropertyEditor", "InputRoot ,
InputBody, InputProperties, InputlLocalEnvironment, InputDestinationList,
InputExceptionList, OutputRoot , OutputLocalEnvironment, OutputDestinationList,
OutputExceptionList"

restricts the XPath field to support only:

$Root, $Body, $Properties, $LocalEnvironment, $DestinationList, $ExceptionList,
$Environment.

Namespace support
The XPath Expression builder dialog contains a namespace settings table that:
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* Supports simplified expressions that enable qualified namespace matching at
runtime

* Can be auto-generated based on imported schema definitions and generated
expressions (based on selections made in the dialog when you build an
expression)

* Allows you to add your own entries to the table

The table encapsulates deployable data passed to the runtime, as part of the nodes
attribute data, and is used by the node to modify expressions through prefix to
URI substitution. The final expressions support namespace matching as they are
exercised against a target tree when employed by their associated message
processing engine, that is, the XPath 1.0 runtime engine or ESQL runtime engine.

When you enter an ESQL field reference expression in a read-only path or
read-write path field, or an XPath 1.0 path expression in a read-only, read-write
path field or general expression field (general expressions can contain zero or more
path expressions) - WebSphere Message Broker understands the language from the
syntax you use.

XPath is the default for general expression fields that are validated by ensuring
they conform to the XPath 1.0 grammar. For path expression fields XPath is
assumed if the expression is valid and begins with a §$ sign.

Note that the language you can use is dictated by the property editor in use for a
node’s property field.

Namespace prefixes are used in an XPath or ESQL expression to make the
statements shorter and easier to understand, while still supporting the ability to
qualify an element name match by also matching on its associated namespace URI.

For example, consider the message below where namespace prefix 'b” is overridden
through an inner declaration
<b:a xmlns:b='xyz'>
<!-- the namespace of elements 'a' and 'c' using prefix 'b' is xyz -->
<b:c>
<b:d xmlns:b='qrs'>
<!-- the namespace of elements 'd' and 'e' using prefix 'b' is now qrs -->
<b:e>100</b:e>
</b:d>
</b:c>
</b:a>

Note that the scope of a namespace declaration declaring a prefix extends from the
beginning of the start tag in which it appears to the end of the corresponding end
tag, excluding the scope of any inner declarations with the same namespace prefix.
In the case of an empty tag, the scope is the tag itself. >.

To navigate to element ‘e’ in the above message use the following human readable
XPath expression:

/b:a/b:c/b2:d/b2:e

Note, that to prevent the auto-generated prefix to the URI map produced in the
expression dialog overloading the same prefix (in this case b), the inner 'b’ prefix is
appended with a numeric value to distinguish it from the outer ‘b’ prefix. This
strategy is repeated for each prefix name clash.



This notation is similar to the equivalent human readable ESQL expression:
Root.b:a.b:c.b2:d.b2:e

In order to support namespace prefixes within expressions, the XPath Expression
Builder Dialog auto-generates (based on the content of imported schema
definitions, through which expressions are generated) a prefix to a URI namespace
settings table.

Without the use of namespace prefixes to URI mapping data in this table, the
runtime would be forced to resort to a less desirable approach, where portable but
verbose XPath expressions would be required by it in order to provide namespace
matching support.

The previous expression:
/b:a/b:c/b2:d/b2:e

would take the form:

/*[namespace-uri()="'xyz"' and local-name()="a']/*[namespace-uri()="xyz"
and local-name()='c']/*[namespace-uri()="'qrs' and
local-name()="'d"']/*[namespace-uri()="qrs' and Tocal-name()='e']

XPath Expression Builder

You can launch the XPath Expression builder in general, but not in all cases (for
example, the collector node) from any property field that supports or expects
XPath expressions as a value that can be entered into the field. The fields that are
supported by XPath specific property editors are listed in|[“Multi-language node
[property fields” on page 397.

The use of the XPath Expression builder is optional, in that it is an aid to you in
developing message flow applications. The XPath Expression builder helps you to
construct message processing expressions in a given language, either XPath or
ESQL. You are free to enter expressions by hand, or use the XPath Expression
builder to help construct such expressions.

You can populate the fields, regardless of the state of the node; that is whether the
node is detached or connected, or fully, partially, or completely unconfigured.

You launch the XPath Expression Builder from buttons that are within:
* Table cells, located to the right of the text entry field within the cell.

* Add or Edit dialogs used to construct rows within tables, located to right of the
property field concerned.

* Tabs in the property viewer for a node, to the right of a property field.

Variables (or in ESQL terminology, correlation names) provide a list of all message
tree start points that are applicable for the property field concerned from which the
dialog was launched.

If a field is a read-only or a read-write path field, any expression must first start
with such a variable in order to indicate which tree in which message assembly the
path expression is mapping onto.

For XPath the variable names map to existing correlation names found in ESQL
field reference expressions, but to conform to the grammar they are signaled as
variable reference through the prefixing of the § character.
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For example:
ESQL Root.XMLNSC.CUST_DETAILS.NAME

XPATH
$Root/XMLNSC/CUST_DETAILS/NAME

The variable indicates which tree and where in the tree the expression is anchored.

The XPath Expression builder dialog supports validation, which you can turn off
on the XPath preferences page by removing the check from the Validate when
creating XPath expressions check box.

There are three main views when functions are supported.

Note, that what is provided in each view, or whether the view is even displayed, is
dependant on what type of property editor you have used to launch the dialog,
and its tailored settings; for example for path type fields you do not see a
functions pane. What operators are supported is variable as is the list of applicable
variables.

1. Data Types Viewer; this view shows the different schema types, elements, and
attributes that can be used within the XPath expression being created, as well
as the allowable variable references.

2. XPath Function; this view shows four main top level categories, which are:
 String
* Boolean
* Numeric
* NodeSet.

For information on the format of XPath 1.0 expressions see and go to the
appropriate section, as follows:

String section-String-Functions

Boolean
section-Boolean-Functions

Numeric
section-Number-Functions

Nodeset
section-Node-Set-Functions

3. Operators; this view shows a list of all of the available operators that can be
used within the given XPath expression

Namespace settings

If you expand Namespace settings in the XPath Expression Builder dialog you see
a table of Prefix and Namespace pair strings; this table is automatically updated
when XPath expressions are created. If the default prefix generated is not what you
want, you can change it by clicking the Change Prefix button.

To add a prefix and namespace map entry click the Add button and complete the
fields in the dialog.

To edit or delete an entry in the table, select the item and click the Edit or Delete
buttons respectively.


http://www.w3.org/TR/xpath

The Edit button opens another field dialog allowing you to change the prefix and
namespace.

For information on the preferences supplied with the XPath editor, see
feditor preferences.”]

XPath editor preferences
This topic describes the possible options available to you when you use the XPath
editor.

The following lists describe the custom preferences used in the XPath editor.
* Validation option:

Validation when building XPath expressions
Default: checked.

This option is used to perform validation each time you update the
XPath expression. As validation requires re-parsing the expression
against the XML Schema document you can turn this option off, for
example, if you are dealing with very large complex XPath expressions.

* Content Assist display options:

Show XML Schema model groups
Default: not checked.

This option allows you to view XML schema model groups, or not.

Show type in XML Schema tree
Default: checked.

This option allows you to view the <type name> in both the Content
Assist view and the XPath expression builder, or not.

Show function parameters
Default: checked.

This option allows you to have function parameters shown, or not.

Show function return type
Default: checked.

This option allows you to have function return types shown, or not.

Show content assist description
Default: checked.

This option allows you to view the description of a given selected entry
in the Content Assist view, or not..
* Auto-Activation option:

Enable auto activation
Default: checked.

When this option is active, the Content Assist field appears whenever
the cursor is after one of the following:

— / - Forward slash character

[ - left bracket character

( - Left parentheses character

— , - Comma character
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You set the delay time, before the Content Assist field appears, in the
Auto activation delay field. The time is in milliseconds and the range is
a positive number between zero and 9999.

* Content assist color options:

This preference allows you to customize the background and foreground colors
for the Content Assist fields. The default background color is (red, green, blue -
254, 241, 233) and the default foreground color is (red, green, blue - 0, 0, 0) -
black.

Creating XPath expressions

404 Message Flows

A number of built-in primitive nodes have properties that can be specified using
an XPath 1.0 expression; most common is where this language is used to form a
path expression to locate incoming message body elements received by a node.

Other less common node property fields support the entry of general XPath 1.0
expressions that support a wider range of the language to perform more complex
evaluations in the broker’s XPath 1.0 runtime engine.

The XPath Expression Builder provides a tree view of an expected message layout,
and supports the automatic generation of an XPath 1.0 path expression, through
the selection of an element within the given tree.

You can use XPath 1.0 path expressions in your flow to access specific parts of an
incoming message, create or locate parts of an outgoing message, and perform
complex message processing expression evaluations that might involve values
present in message trees accessible by a node. You can then process the message;
for example you can transform, filter or retrieve values from a message.

The Route node applies XPath 1.0 general expressions to the content of message
trees associated with the incoming message assembly for this node. Following
evaluation of an expression the result is cast as a Boolean (true or false) result, and
this in turn is used to determine if a copy of the incoming message is routed down
an output terminal associated with the processed expression.

If you have any XML schema definitions (.mxsd) files present in your workspace,
then any elements, attributes or data types defined in such definitions can be
loaded into the Data types viewer and selected to automatically generate a path
expressions mapping to the definition concerned.

Equally, depending on the XPath expressions supported by the property concerned,
you can select XPath functions and operators to include in an expression or you
can build your own expressions manually.

The Data types viewer contains a list of variables relating to trees that can be
accessed by expressions for the node property concerned.

For example, $InputRoot gives access to the incoming message tree. The fixed
format of standard folders you can expect to exist under this tree, for example,
Properties and MQMD are described without the need to import an .mxsd definition
for them. These structures can be navigated in the viewer and, on selection of an
element within them, a path expressions is built automatically that maps to the
element in question through the XPath 1.0 language.

The Schema Viewer section provides a tree view of the input message. To visually
build your XPath expression follow these steps:



1. Add the relevant node to your message flow

2. In the Properties viewer, enter the correlation name, or press Ctrl + Space to
bring up content assist, or press Edit to use the Expression editor. Content
assist is also brought up by simply typing, for example, $ in cell-based property
fields. See [“Correlation names” on page 66| for further information on
correlation names.

3. Expand the tree, navigate to the field for which you want to build the
expression, and click to select it. A field is either an element, or an attribute.
Double click the field to add it to the XPath Expression below. You can also
drag and drop fields, functions, and operators to the desired spots in the XPath
Expression when using the XPath Expression builder.

4. To set conditions, enter them in as you would a normal XPath Expression.

The complete XPath expression is shown either:
* In the XPath Expression pane if you are using the XPath Expression builder.

The Expression builder dialog is an optional aid to generating expressions that,
once complete, form the value in a node’s property field.

If you do not use the Expression builder dialog, the expressions entered
manually are validated using the property editor.

¢ In the Property field if it is in the node itself.

Note the messages displayed at the top of the XPath Editor window. These
messages alert you to the fact that a path or expression you have entered is not
valid even though the editor allows you to enter the expression, and even save it.

Example

Here is the corresponding XPath expression built in the XPath Expression Builder
to filter the Employee business objects for all employees who are managers:
$Body/getEmployeelnfo/Empl[isManager=true()].

* $Body: The body section of the message, that is, the last child of root.
* /getEmployeelnfo: The name of the operation in the interface.

¢ /Emp: The name of the input message type.

* [isManager=true()]: Checks whether the isManager field is set to true.

In this case the same expression works for both request and response flows,
because the input and output messages for the operation are identical.

See for more information on XPath 1.0.

Selecting the grammar mode

WebSphere Message Broker supports the following field categories:
* Read-only path field

* Read-write path field

* Expression field

Each of these field types can be either fixed or mixed language, that is, ESQL or
XPath.

To see if you can use XPath on a property see [“Multi-language node property|
[fields” on page 397
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If you use XPath syntax and the expressions are not supported for the property
you are using, the syntax is rejected during the validation process.

ESQL and XPath have similar restrictions on the syntax that is permitted for the
first two of these field types. There are restrictions to the third field type as well,
but as this type of field supports general expressions that can be used in either
language, the range of syntax available is greater than the first two.

WebSphere Message Broker uses code assistance in the grammar management of
XPath 1.0 to validate the syntax of expressions entered. This assistance is available,
regardless of the grammar mode you are using.

By default, you are operating in the restricted grammar mode.

Code assistance enables you to construct syntactically correct expressions but it
does not validate those expressions. Validation is performed by property editors in
which such expressions are entered.

If you attempt to use syntax that is not valid the property editor marks those
expressions as such, either from a syntax or schema validation perspective.

You receive error or warning messages depending upon the preference choices you
set in Windows>Preferences>Broker Development>XPath>Validation .

If particular checks are to be marked as errors under the above validation settings
then, when found, error markers are posted under the problems viewer. This
results in a message flow being marked as broken, and the flow is made
unavailable for import and compilation within a deployable bar file using the
broker archive editor.

If you want to use the appropriate unrestricted grammar to input in a specific field
type, property editors will not force a restricted form of ESQL or XPath 1.0
expressions to be entered for such fields that expect them.

Instead, you can enter the full range of syntax in the context of the field category
concerned, namely, path of general expression, without coming across the
validation checks applied. This means that you can deploy the full range of syntax,
if you need to, supported by the ESQL or XPath 1.0 runtime engines. Note,
however, that such expressions might not be in a form that can be converted to the
other language.

To use unrestricted grammar carry out the following procedure:

1. Select the Broker Administration perspective in the workbench.

2. Select Window -> Preferences and expand Broker Development.
3. Expand XPath and click on Grammar.

4. Remove the check from Use XPath and ESQL equivalent grammar.

Note that expressions are still validated for valid syntax appropriate in the context
of the field type, but can now be in the full range of grammar as supported by the
runtime environment.

Developing Java

When you use the JavaCompute node, you customize it to determine the exact
processing that it provides.
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To tailor the behavior of each node, create a Java class file that provides the
processing that you want. You manage Java files through the Java perspective.

You can add any valid Java code to a JavaCompute node, making full use of the
Java user-defined node API to process an incoming message. You can use the Java
editing facilities of the Eclipse platform to develop your Java code. These facilities
include:

* Code completion
¢ Integrated Javadoc documentation
* Automatic compilation

The Java user-defined node API includes some extra methods that simplify tasks
that involve message routing and transformation. These tasks include accessing
named elements in a message tree, setting their values, and creating elements,
without the need to navigate the tree explicitly.

Use the Debug perspective to debug a message flow that contains a JavaCompute
node. When control passes to a JavaCompute node during debugging, the
perspective opens the Java debugger, and you can step through the Java class code
for the node.

This section provides the following information on developing Java:

* ["Managing Java Files”|

* [“Writing Java” on page 411|

Managing Java Files

The Java code that you provide to modify or customize the behavior of a
JavaCompute node is stored in a Java project. WebSphere Message Broker uses the
Eclipse Java perspective for developing and administering Java files.

This section contains topics that describe how to manage these files:

+ [“Creating Java code for a JavaCompute node”]

* [“Opening an existing Java file” on page 408|

+ |“Saving a Java file” on page 408|

+ “Adding Java code dependencies” on page 409|

* |"“Deploying JavaCompute node code” on page 410

Creating Java code for a JavaCompute node

Before you start

To complete this task, you must have added a [‘JTavaCompute node” on page 881| to
your message flow.

To associate code with a Java compute node, use one of the following methods:

* |Use the JavaCompute node wizard to create template code.

+ |Associate a JavaCompute node with an existing Java class that the wizard]
previously generated.|

To generate template code perform the following steps:
1. Right-click the node and click Open Java.
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2. Step through the JavaCompute node wizard until you reach the Java Compute
Node Class Template page. On this page choose one of the following options:

¢ For a filter node template code, choose Filtering Message Class.
* To change an incoming message, choose Modifying Message Class.

¢ To create a new message, choose Creating Message Class.

You have now created template code for your JavaCompute node.

Alternatively, you can associate a JavaCompute node with an existing Java class
that the wizard previously generated. This allows you to share the same Java code
between multiple nodes. To associate a JavaCompute nodes with an existing Java
class perform the following steps:

1. Right-click the JavaCompute node and click Properties.
2. Enter the name of the Java class in the Java Class field.

3. Click OK. You have now associated your JavaCompute node with an existing
Java class.

You can now perform the following tasks:

* |“Opening an existing Java file”|

+ [“Saving a Java file”]

* [“Adding Java code dependencies” on page 409|

Opening an existing Java file

You can add to and modify Java code that you have created in a Java project.
Before you start

Before you start this task, complete the following tasks:

+ Add a[‘JavaCompute node” on page 881|to your message flow.
* |“Creating Java code for a JavaCompute node” on page 407|

To open an existing Java file:
1. Switch to the Java perspective.

2. In the Package Explorer view, double-click the Java file that you want to open.
The file is opened in the editor view.

3. Work with the contents of the file to make your changes.

You can also open a Java file when you have a message flow open in the editor
view. Select the JavaCompute node, right-click and then select Open Java to open
the file.

Next:

You can now perform the following tasks:

+ [“Saving a Java file”]

+ [“Adding Java code dependencies” on page 409|

Saving a Java file

When you edit your Java files, save them to preserve the additions and
modifications that you have made.



Before you start

To complete this task, you must have completed the following tasks:
+ Add a[‘JavaCompute node” on page 881|to your message flow.
+ [“Creating Java code for a JavaCompute node” on page 407

To save a Java file:

1. Switch to the Java perspective.

2. Create a new Java file or open an existing Java file.
3. Make the changes to the contents of the Java file.
4

. When you have finished working, click File » Save or File » Save All to save
the file and retain all your changes.

Next:

You can now perform the following task:

+ [“Adding Java code dependencies”]

Adding Java code dependencies

When you write your Java code for a JavaCompute node, you can include
references to other Java projects and JAR files.

Before you start
To complete this task, you must have completed the following tasks:

+ Add al“JavaCompute node” on page 881 to your message flow.
* [“Creating Java code for a JavaCompute node” on page 407|

The Java code in a JavaCompute node might contain references to other Java
projects in your Eclipse workspace (internal dependencies), or to external JAR files,
for example the JavaMail API (external dependencies). If other JAR files are
referenced, you must add the files to the project class path.

1. Right-click the project folder of the project that you are working on and click
Properties.

2. Click Java Build Path on the left pane.
Click the Libraries tab.
4. Perform one of the following steps:

¢ To add an internal dependency, click Add JARs..., select the JAR file that you
want to add then click OK.

* To add an external dependency, click Add External JARs..., select the JAR file
that you want to add, then click Open. Copy the file to WorkPath/shared-
classes where WorkPath is the full path to the working directory of the
broker. If you do not copy the external dependencies here
ClassNotFoundException exceptions are generated at run time.

w

Tip:

The default value for WorkPath is one of the following values:

« MIITEN For Windows systems, the default workpath is c:\Documents
and Settings\ All Users\ Application Data\IBM\MQSI.

« BIIEN For UNIX systems, the default workpath is /var/mgsi.
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. For Linux systems, the default workpath is /var/mgsi.

You have now added a code dependency.
Deploying JavaCompute node code

The Message Broker Toolkit handles the deploying of JavaCompute node code
automatically. When you create a bar file and add the message flow, the Message
Broker Toolkit packages the compiled Java code and its dependencies into the bar
file.

JavaCompute node classloading

When you include one or more JavaCompute nodes in a broker archive (bar) file,
the JAR files are loaded in a separate classloader. The classloader loads all classes
that are packaged within the deployed bar. These classes override any classes that
are in the shared classes directory or the CLASSPATH environment variable.

The broker uses the following classloader tree:

Bootstrap
l JVM classloaders
System
Common
Broker Shared

EGShared

These components are in the classloader tree:

¢ Common classloader: loads the classes that are shared between the broker and
user code. For example, the classes that are contained in jplugin2.jar are
common to the broker and the user code.

*  Broker classloader: loads the broker internal classes. These classes cannot be
accessed by user classes.

* Shared classloader : loads classes from JAR files that have been placed in the
workpath /shared-classes/ directory, and from the CLASSPATH environment
variable. These are classes that are available to all Java user-defined nodes and
JavaCompute nodes within the broker.

The CLASSPATH environment variable can contain the wildcard character (*) at
the end of a directory path specifier. The wildcard is expanded to include all
files in that directory with the extension .jar or .JAR.

* EGShared classloader: loads all classes that are deployed to the execution group
in the broker archive (bar) file, either by a JavaCompute node or an
ESQL-to-Java mapping.

This is used to support the deployment mechanism for the JavaCompute node.
Each time a BAR file is deployed, a new instance of the EGShared classloader is



created and the old instance is discarded and will be garbage collected. This
allows the JavaCompute node to reload modified versions of the same class
without the need to restart the broker.

The broker uses the following search path to find JavaCompute node classes:
1. The deployed JAR file

2. <WorkPath>/shared-classes/ to locate any JAR files

3. The CLASSPATH environment variable

Writing Java

When you create a message flow, you include input nodes that receive messages
and, optionally, output nodes that send out new or updated messages. If the
processing that must be performed on the message requires it, you can include
other nodes after the input node that are customized in Java to complete the
actions that your applications need.

Some of the built-in nodes allow you to customize the processing that they
provide. In a JavaCompute node, you can provide Java code that controls precisely
the behavior of the node. This set of topics discusses how you can use Java to
customize the JavaCompute node.

Using a JavaCompute node you can check and manipulate message content. You
can:
* Read the contents of the input message

* Construct new output messages that are created from all, part, or none of the
input message

Use the Debug perspective to debug a message flow that contains a JavaCompute
node. When control passes to a JavaCompute node during debugging, the
perspective opens the Java debugger, allowing you to step through the Java class
code for the node.

This section provides more information about writing Java:

* [Manipulating message body data|

+ [Manipulating other parts of the message tree|

* |Accessing broker properties|

* |Accessing user-defined properties|
[“Adding keywords to JAR files” on page 423|

+ [Interacting with databases|

[‘Calling an Enterprise Java Bean” on page 427|

+ [Handling exceptions|
* |[Logging errors|

Manipulating message body data using a JavaCompute node

The message body is always the last child of root, and its parser name identifies it,
for example XML or MRM.

The following topics describe how to refer to, modify, and create message body
data. The information provided here is domain independent:

* [“Accessing elements in a message tree from a JavaCompute node” on page 412

* [“Transforming a message using a JavaCompute node” on page 414|
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+ |“Creating a simple filter using a JavaCompute node” on page 416|

+ [“Propagating a message to the JavaCompute node Out and Alternate terminals”]
on page 41

» |[“Extracting information from a message using XPath 1.0 and a JavaCompute|
node” on page 417|

Accessing elements in a message tree from a JavaCompute node:

Access the contents of a message, for reading or writing, using the structure and
arrangement of the elements in the tree that the parser creates from the input bit
stream.

Follow the relevant parent and child relationships from the top of the tree
downwards until you reach the required element.

The message tree is passed to a JavaCompute node as an argument of the evaluate
method. The argument is an MbMessageAssembly object. MbMessageAssembly
contains four message objects:

* Message

* Local Environment

* Global Environment

* Exception List

These objects are read-only, except for Global Environment. If you try to write to
the read-only objects, an MbReadOnlyException is issued.

This topic contains the following information about accessing elements in a
message tree:

* [“Traversing the element tree”]

* |“Accessing information about an element” on page 413

Traversing the element tree:

The following table shows the Java methods that you can use to access element
trees, and the equivalent ESQL field type constant for each point in the tree.

Java accessor from MbMessageAssembly ESQL field type constant

getMessage().getRootElement() InputRoot
getMessage().getRootElement().getLastChild() | InputBody
getLocalEnvironment().getRootElement() InputLocalEnvironment
getGlobalEnvironment().getRootElement() Environment
getExceptionList().getRootElement() InputExceptionList

Use the following methods to traverse a message tree from an element of type
MbElement:

getParent()
returns the parent of the current element

getPreviousSibling()
returns the previous sibling of the current element

getNextSibling()
returns the next sibling of the current element




getFirstChild()
returns the first child of the current element

getLastChild()
returns the last child of the current element

The following example shows a simple XML message and the logical tree that
would be created from the message. The message has been sent using WebSphere
MQ. The logical tree diagram also shows the methods to call in order to navigate
around the tree.

<document>
<chapter title='Introduction'>
Some text
</chapter>
</document>
N: Root
V:
1 6 ) ) (@
(T)
N: Properties [~ @ N:maMD — G NxvL

V: «@— V «@— Vv

& ]
mn 6 @
v | ¥

N: document
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N: - Name
V: - Value l 4

[
(1) getFirstChild() (l) (f) (5)
(2) getLastChild()

(3) getNextSibling() N: chapter
(4) getPreviousSibling() |_’ Vi
(5) getParent() 1) (5) 5B) (2
v | | ¥
N: title — @)y
V:Introduction | (4)— V:Some text.

The following Java code accesses the chapter element in the logical tree for an
XML message that does not contain white spaces. The XML parser retains white
space in the parsed tree, but the XMLNS and XMLNSC parsers do not.

MbElement root = assembly.getMessage().getRootETlement();
MbElement chapter = root.getLastChild().getFirstChild().getFirstChild();

Accessing information about an element:

Use the following methods to return information about the referenced element:

getName()
returns the element name as a java.lang.String

getValue()
returns the element value

getType()
returns the generic type, which is one of the following types:

* NAME: an element of this type has a name, but no value.
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¢ VALUE: an element of this type has a value, but no name.
* NAME/VALUE: an element of this type has both a value and a name.

getSpecificType()
returns the parser-specific type of the element

getNamespace()
returns the namespace URI of this element

Transforming a message using a JavaCompute node: These topics describe how
to transform messages using a JavaCompute node:

+ [“Creating a new message using a JavaCompute node”]

+ [“Copying a message using a JavaCompute node”]

* |“Setting, copying, and moving message elements using a JavaCompute node” on|

page 415|

* [“Creating new elements using a JavaCompute node” on page 415|

Creating a new message using a JavaCompute node:

Many message transformation scenarios require a new outgoing message to be
built. The Create Message Class template in the JavaCompute node wizard generates
template code for this.

In the template code, the default constructor of MbMessage is called to create a
blank message, as shown in the following Java code:

MbMessage outMessage = new MbMessage();

The headers can be copied from the incoming message using the supplied utility
method, copyMessageHeaders(), as shown in this Java code:

copyMessageHeaders (inMessage, outMessage);

The new message body can now be created. First, add the top level parser element.
For XML, this is:

MbElement outRoot
MbElement outBody

outMessage.getRootElement () ;
outRoot.createElementAsLastChild(MbXMLNSC.PARSER _NAME);

The remainder of the message can then be built up using the createElement
methods and the extended syntax of the broker XPath implementation.

When you wish to create a BLOB message, that is handled as a single byte string
using the BLOB parser domain. The message data is added as a byte array to the
single element named "BLOB" under the parser level element as described below:

String myMsg = "The Message Data";
MbElement outRoot = outMessage.getRootElement();
// Create the Broker Blob Parser element

MbElement outParser

outRoot.createElementAsLastChild(MbBLOB.PARSER_NAME) ;

// Create the BLOB element in the Blob parser domain with the required text
MbElement outBodyE12 = outParser.createElementAsLastChild(MbElement.TYPE_NAME_VALUE, "BLOB", myMsg.getBytes());
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Copying a message using a JavaCompute node:

The incoming message and message assembly are read-only. In order to modify a
message, a copy of the incoming message must be made. The Modifying Message
Class template in the JavaCompute node wizard generates this copy. The following
copy constructors are called:



MbMessage outMessage = new MbMessage(inAssembly.getMessage);
MbMessageAssembly outAssembly = new MbMessageAssembly(inAssembly, outMessage);

The new outAssembly object is propagated to the next node.
Setting, copying, and moving message elements using a JavaCompute node:

Transform elements in the message as it passes through a JavaCompute node in
the message flow.

* [“Setting information about an element”]|

* ["Moving and copying elements”|

The Java API reference information provides details about each of the methods
used in the sections below.

Setting information about an element:

Use these methods to set information about the referenced element:

setName()
Sets the name of the element

setValue()
Sets the value of the element

setSpecificType()
Sets the parser-specific type of the element

setNamespace()
Sets the namespace URI of the element

Moving and copying elements:

Use a JavaCompute node to copy or detach an element from a message tree using
the following methods:

detach()
The element is detached from its parent and siblings, but any child
elements are left attached

copy() A copy of the element and its attached children is created
Use one of four methods to attach an element or subtree that you have copied on
to another tree:

addAsFirstChild(element)
Adds an unattached element as the first child of element

addAsLastChild(element)
Adds an unattached element as the last child of element

addBefore(element)
Adds an unattached element as the previous sibling of element

addAfter(element)
Adds an unattached element as the next sibling of element

Creating new elements using a JavaCompute node:

Use the following methods in a JavaCompute node to create new elements in a
message tree:
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* createElementAsFirstChild()
» createElementAsLastChild()
» createElementBefore()

» createElementAfter()

The method returns a reference to the newly-created element. Each method has
three overloaded forms:

createElement...(int type)

Creates a blank element of the specified type. Valid generic types are:

* MbElement. TYPE_NAME. This type of element has only a name, for
example an XML element.

* MbElement. TYPE_VALUE. This type of element has only a value, for
example XML text that is not contained within an XML element.

* MbElement. TYPE_NAME_VALUE. This type of element has both a name
and a value, for example an XML attribute.

Specific type values can also be assigned. The meaning of this type
information is dependent on the parser. Element name and value
information must be assigned using the setName() and setValue() methods.

createElement...(int type, String name, Object value)
Method for setting the name and value of the element at creation time.

createElement...(String parserName)
A special form of createElement...() that is only used to create top-level
parser elements.

This example Java code adds a new chapter element to the XML example given in
[“Accessing elements in a message tree from a JavaCompute node” on page 412

MbElement root = outMessage.getRootElement();
MbElement document = root.getlLastChild().getFirstChild();
MbElement chapter2 = document.createElementAsLastChild(MbETement.TYPE_NAME,"Chapter",null);

// add title attribute
MbElement title2 = chapter2.createElementAsFirstChild(MbETlement.TYPE NAME VALUE,
"title", "Message Flows");

This produces the following XML output:

<document>

<chapter title="Introduction">
Some text.

</chapter>

<chapter title="Message Flows"/>

</document>

Creating a simple filter using a JavaCompute node:

Before you start

To complete this task, you must have added a [‘JTavaCompute node” on page 881|to
your message flow.

The JavaCompute node has two output terminals, Out and Alternate. To use the
JavaCompute node as a filter node, propagate a message to either the Out or
Alternate terminal based on the message content. Use the JavaCompute node
creation wizard to generate template code for a filter node:



Select the Filtering Message Class template in the JavaCompute node creation
wizard to create a filter node.

The following template code is produced. It passes the input message to the Out
terminal without doing any processing on the message.

public class jcn2 extends MbJavaComputeNode {
public void evaluate(MbMessageAssembly assembly) throws MbException {

MbOutputTerminal out = getOutputTerminal("out");
MbOutputTerminal alt = getOutputTerminal("alternate");

MbMessage message = assembly.getMessage();

[ = mmm
// Add user code below

// End of user code

S —

// The following should only be changed
// if not propagating message to the 'out' terminal

out.propagate(assembly);
}
1

The template produces a partial implementation of a method called evaluate(). The
broker calls evaluate() once for each message that passes through the node. The
parameter that is passed to evaluate() is the message assembly. The message
assembly encapsulates the message that is passed on from the previous node in the
message flow.

Add custom code to the template, and propagate messages to both the Out and
Alternate terminals to create a message filter.

Propagating a message to the JavaCompute node Out and Alternate terminals:

The JavaCompute node has two output terminals, Out and Alternate. Therefore,
you can use the node both as a filter node and as a message transformation node.
After you have processed the message, propagate the message to an output
terminal using a propagate() method. To propagate the message assembly to the
Out terminal use the following method:

out.propagate(assembly);

To propagate the message assembly to the Alternate terminal, use the following
method:

alt.propagate(assembly);

Extracting information from a message using XPath 1.0 and a JavaCompute
node:

XPath is a query language designed for use with XML documents, but you can use
it with any tree structure to query contents.

WebSphere Message Broker uses XPath to select elements from the logical message
tree regardless of the format of the bit stream. The terminology used in this topic is
based on the terminology used in the W3C definition of XPath 1.0. For more
information about XPath and the W3C definition of the XPath 1.0 standard, see
-Pat
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This topic contains the following information:

* [“Using the evaluateXPath method to extract message information”]
+ [“XPath variable binding”|

+ [“XPath namespace support”]

* "Updating a message using XPath extensions” on page 419

Using the evaluateXPath method to extract message information

The evaluateXPath() method is included in the Java user-defined node API. It
supports XPath 1.0, with the following exceptions:

* Namespace axis and namespace node type. The namespace axis returns the
actual XML namespace declaration nodes for a particular element. You can
therefore manipulate XML prefix or URI declarations within an XPath
expression. This axis returns an empty node set for bit streams that are not XML.

* If you use the id() function it throws an MbRecoverableException.

The evaluateXPath() method can be called on a MbMessage object (for absolute
paths), or on a MbElement object (for relative paths). The XPath expression is
passed to the method as a string parameter. A second form of this method is
provided that takes an MbXPath object. This object encapsulates an XPath
expression along with variable bindings and namespace mappings, if these are
required.

The evaluateXPath() method returns an object of one of these four types,
depending on the expression return type:

* java.lang.Boolean, representing the XPath Boolean type
* java.lang.Double, representing the XPath number type
* java.lang.String, representing the XPath string type

* java.util.List, representing the XPath node set. The List interface represents an
ordered sequence of objects, in this case MbElements. It allows direct access to
the elements, or the ability to get an Iterator or an MbElement array.

XPath variable binding

XPath 1.0 supports the ability to refer to variables that have been assigned before
the expression that contains them is evaluated. The MbXPath class has three
methods for assigning and removing these variable bindings from user Java code.
The value must be one of the four XPath 1.0 supported types:

e Boolean
* node set
¢ number

* string
XPath namespace support
For XML messages, namespaces are referred to using a mapping from an

abbreviated namespace prefix to the full namespace URI, as shown in the
following XML example:
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<nsl:aaa xmlns:nsl="http://mydomain.com/namespacel’
xmins:ns2="http://mydomain.com/namespace2'>
<nsZ:aaa>
<nsl:bbb/>
</ns2:aaa>
</nsl:aaa>

The namespace prefix is convenient for representing the namespace, but is
meaningful only within the document that defines that mapping. The namespace
URI defines the global meaning. Also, the concept of a namespace prefix is not
meaningful for documents that are generated in a message flow, because a
namespace URI can be assigned to a syntax element without an XMLNS mapping
having been defined.

For this reason, the XMLNSC and MRM parsers expose only the namespace URI to
the broker and to user code (ESQL or user-defined code). Using ESQL, you can set
up your own mappings to create abbreviations to these potentially long URIs.
These mappings are not related in any way to the prefixes that are defined in the
XML document (although they can be the same name).

Using the XPath processor you can map namespace abbreviations on to URIs that
are expanded at evaluation time. The MbXPath class contains methods to assign
and remove these namespace mappings. The XML example can be addressed using
the following code:

MbMessage msg = assembly.getMessage();

List chapters= (List)msg.evaluateXPath("/document/chapter");
// this returns a list of all chapters in the document (length 1)

MbETement chapter = (MbElement)chapters.get(0); // the first one

// values can also be extracted directly using XPath
String title = (String)msg.evaluateXPath("string(/document/chapter/@title)");

String chapterText = (String)msg.evaluateXPath("string(/document/chapter/text())");
Updating a message using XPath extensions

The XPath implementation in WebSphere Message Broker provides the following
extra functions for modifying the message tree:

set-local-name(object)
Sets the local part of the expanded name of the context node to the value
specified in the argument. object can be any valid expression, and is
converted to a string as if a call to the string function is used.

set-namespace-uri(object)
Sets the namespace URI part of the expanded name of the context node to
the value specified in the argument. object can be any valid expression, and
is converted to a string as if a call to the string function is used.

set-value(object)
This function sets the string value of the context node to the value
specified in the argument. object can be any valid expression, and is
converted to a string as if a call to the string function is used.

To allow for syntax element trees to be built as well as modified, the following axis
is available in addition to the 13 that are defined in the XPath 1.0 specification:

select-or-create::name or ?name
?name is equivalent to select-or-create::name. If name is @name, an attribute
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is created or selected. This selects child nodes matching the specified name,
or creates new nodes according to the following rules:

* ?name selects children called name if they exist. If a child called name
does not exist, ?name creates it as the last child, then selects it.

e ?%name creates name as the last child, then selects it.
* ?Mname creates name as the first child, then selects it.
* ?>name creates name as the next sibling, then selects it.

* ?<name creates name as the previous sibling, then selects it.

Manipulating other parts of the message tree using a
JavaCompute node

The following topics describe how to access parts of the message tree other than
the message body data. These parts of the logical tree are independent of the
domain in which the message exists, and all these topics apply to messages in all
supported domains, including the BLOB domain. You can access all parts of the
message tree using a JavaCompute node, including the Properties tree described in
[“Message tree structure” on page 57)and the [ExceptionList tree| Elements of the
message tree can be accessed in the same way as the message body data, using a
JavaCompute node.

* [“Accessing headers using a JavaCompute node’]

+ “Updating the LocalEnvironment with the JavaCompute node” on page 421

+ [“Updating the Global Environment with the JavaCompute node” on page 422|

Accessing headers using a JavaCompute node:

If an input node receives an input message that includes message headers that the
input node recognizes, the node invokes the correct parser for each header. Parsers
are supplied for most WebSphere MQ headers. The topics listed below provide
guidance for accessing the information in the MQMD and MQRFH2 headers that
you can follow when accessing other headers that are present in your messages.

* |“Copying message headers using a JavaCompute node”|

* [“Accessing the MQMD header using a JavaCompute node”)

* |“Accessing the MQRFH?2 header using a JavaCompute node” on page 421

For further details of the contents of these and other WebSphere MQ headers for
which WebSphere Message Broker provides a parser, see [“Element definitions for]
[message parsers” on page 1259

Copying message headers using a JavaCompute node: The Modifying Message Class
template in the JavaCompute node wizard generates the following code to copy
message headers using a JavaCompute node:

public void copyMessageHeaders(MbMessage inMessage, MbMessage outMessage) throws MbException

MbElement outRoot = outMessage.getRootElement();
MbElement header = inMessage.getRootElement().getFirstChild();

while(header != null && header.getNextSibling() !'= null)

{
outRoot.addAsLastChild(header.copy());
header = header.getNextSibling();
}
1

Accessing the MQMD header using a JavaCompute node:
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WebSphere MQ, WebSphere MQ Everyplace, and SCADA messages include an
MQMD header. You can use a JavaCompute node to refer to the fields within the
MQMD, and to update them.

The following Java code shows how to add an MQMD header to your message:

public void addMgmd(MbMessage msg) throws MbException

{
MbElement root = msg.getRootElement();

// create a top level 'parser' element with parser class name
MbElement mgmd = root.createElementAsFirstChild("MQHMD");

// specify next parser in chain

mgmd. createETementAsFirstChild(MbETement.TYPE_NAME_VALUE,
"Format",
"XMLNS") ;

}

Accessing the MQRFH?2 header using a JavaCompute node:

When you construct MQRFH?2 headers in a JavaCompute node, there are two types
of field:

¢ Fields in the MQRFH2 header structure (for example, Format and
NameValueCCSID)

¢ Fields in the MQRFH2 NameValue buffer (for example mcd and psc)

The following code adds an MQRFH?2 header to an outgoing message that is to be
used to make a subscription request:

public void addRfh2(MbMessage msg) throws MbException
{

MbElement root
MbETement body

msg.getRootETement();
root.getlLastChild();

// insert new header before the message body
MbElement rfh2 = body.createElementBefore("MQHRF2");

rfh2.createElementAsFirstChild(MbElement.TYPE_NAME_VALUE, "Version", new Integer(2));
rfh2.createElementAsFirstChild(MbETement.TYPE_NAME VALUE, "Format", "MQSTR");
rfh2.createElementAsFirstChild(MbETement.TYPE_NAME_VALUE, "NameValueCCSID", new Integer(1208));

MbElement psc = rfh2.createElementAsFirstChild(MbElement.TYPE_NAME, "psc", null);
psc.createElementAsFirstChild(MbElement.TYPE_NAME, "Command", "RegSub");
psc.createElementAsFirstChild(MbETlement.TYPE_NAME, "Topic", "department");
psc.createElementAsFirstChild(MbETement.TYPE_NAME, "QMgrName", "QM1");
psc.createElementAsFirstChild(MbETlement.TYPE_NAME, "QName", "PUBOUT");
psc.createElementAsFirstChild(MbETement.TYPE_NAME, "RegOpt", "PersAsPub");

MbXPath xp = new MbXPath("/MQMD/Format" + "[set-value( MQHRF2 )]", root);
root.evaluateXPath(xp);

}

Updating the LocalEnvironment with the JavaCompute node:

The LocalEnvironment tree is part of the logical message tree in which you can
store information while the message flow processes the message.

The following information shows how to update the LocalEnvironment:

1. Make a new copy of the local environment to update it. Use the full version of
the copy constructor to create a new MbMessageAssembly object, as shown in
the following example:
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MbMessage env = assembly.getLocalEnvironment();
MbMessage newEnv = new MbMessage(env);

newkEnv.getRootETement().createElementAsFirstChild(
MbETement.TYPE_NAME_VALUE,
"Status",
"Success");

MbMessageAssembly outAssembly = new MbMessageAssembly (
assembly,
newknv,
assembly.getExceptionList(),
assembly.getMessage());

getOutputTerminal ("out").propagate(outAssembly);
2. Edit the copy to update the LocalEnvironment.

Updating the Global Environment with the JavaCompute node:

The |Global Environment] tree is always created when the logical tree is created for
an input message. However, the message flow neither populates it nor uses its
contents. You can use this tree for your own purposes, for example to pass
information from one node to another. You can use the whole tree as a scratchpad
or working area.

The Global Environment can be altered across the message flow, therefore do not

make a copy of it to alter. The following Java code shows how to alter the Global
Environment:

MbMessage env = assembly.getGlobalEnvironment();
env.getRootElement().createElementAsFirstChild(MbETement.TYPE_NAME_VALUE, "Status", "Success");

getOutputTerminal ("out").propagate(assembly);
Accessing broker properties from the JavaCompute node

For each broker, WebSphere Message Broker maintains a set of properties. You can
access some of these properties from your Java programs. It can be useful, during
the run time of your code, to have real-time access to details of a specific node,
flow, or broker.

There are four categories of broker property:
* Those relating to a specific node

* Those relating to nodes in general

* Those relating to a message flow

* Those relating to the execution group

[“Broker properties that are accessible from ESQL and Java” on page 1517] includes
a table that shows the groups of properties that are accessible from Java. The table
also indicates if the properties are accessible from ESQL.

Broker properties:

* Are grouped by broker, execution group, flow, and node.

* Are case sensitive. Their names always start with an uppercase letter.
* Return NULL if they do not contain a value.

To access broker properties in a JavaCompute node, call methods on the following
classes:



* MbBroker

* MbExecutionGroup
* MbMessageFlow

* MbNode

For example:
String brokerName = getBroker().getName();

Accessing user-defined properties from a JavaCompute node
Customize a JavaCompute node to access properties that you have associated with
the message flow in which the node is included.

To access these properties from a JavaCompute node, use the
getUserDefinedAttribute(name) method, where name is the name of the property
that you are accessing. The type of the object that is returned depends on the type
of the property that you are accessing. The object has one of a set of types:

* MbDate

* MbTime

* MbTimestamp

* Boolean

* byte][]

e String

* Integer 32-bit values
* Long 64-bit values
* Double

* BigDecimal

* BitSet

Adding keywords to JAR files
If a bar file contains JAR files, you can associate with the JAR files.

1. Add a file called META-INF/keywords.txt to the root of the JAR file.

2. Add your keywords to the META-INF/keywords.txt file, because this file is
parsed for keywords when it is deployed. Keywords have this format:

$MQSI keyword = value MQSI$

For example, a deployed bar file contains compute.jar, and compute.jar contains the
file META-INF/keywords.txt with the following contents:

# META-INF/keywords.txt
$MQSI modified date = 3 Nov MQSI$
$MQSI author = john MQSI$

This content means that the keywords “modified date” and “author” are associated
with the deployed file compute.jar in the Configuration Manager Proxy and in the
Message Broker Toolkit.

You have now added keywords to your JAR file.

Next:

When you have added keywords to your JAR file, you can [see this information|in
the bar file editor.
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Interacting with databases using the JavaCompute node
Access databases from Java code included in the JavaCompute node.

Choose from the following options for database interaction:

* [Broker JDBCProvider for type 4 connections|
+ IMbSQLStatement]

+ DBC API in an unmanaged environment|

- BaL]

If you use JDBCProvider for type 4 connections or MbSQLStatement, the databases
that you access can participate in globally-coordinated transactions. In all other
cases, database access cannot be globally coordinated.

Broker JDBCProvider for type 4 connections:

You can establish JDBC type 4 connections to interact with databases from your
JavaCompute nodes. The broker supports type 4 drivers, but does not supply
them. You must obtain these drivers from your database vendor; supported drivers
are listed in [Supported databases}

Use the broker JDBCProvider for type 4 connections to benefit from the following
advantages:

* Use broker configuration facilities to define the connection, and to provide
optional security, in preference to coding these actions.

* Configure the broker and the databases to coordinate access and updates with
other resources that you access from your message flows, except when the
broker is running on z/OS.

* Use the broker Java API get]DBCTyep4Connection to initiate the connection, and
then perform SQL operations using the standard JDBC APIs. The broker
manages the connections, thread affinity, connection pooling, and life cycle. If a
connection is idle for approximately one minute, or if the message flow
completes, the broker closes the connection.

If the broker is running on a distributed system, you can configure the databases
and the connections to be coordinated with other resource activity. Global
coordination on distributed systems is provided by WebSphere MQ, and can
include interactions with local or remote databases, including remote databases
that are defined on z/OS systems. If you establish a JDBC type 4 connection to a
database from a broker that is running on z/OS, coordination is not provided. For
information about setting up connections and coordination, see

[connections to the databases|

Before you can include this function in the code that you write for the node, you
must configure the required environment. Decide whether your database requires
security of access, and whether you want the database updates to participate in
globally-coordinated transactions. Follow the instructions provided in
[[DBC connections to the databases| for the required and optional tasks.

When you have configured the JDBCProvider, you can establish a JDBC type 4
connection to the database using the get)DBCType4Connection call on the MbNode
interface. The following code provides an example of its use:

public class MyJavaCompute extends MbJavaComputeNode {

{

public void evaluate(MbMessageAssembly inAssembly) throws MbException {
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MbOutputTerminal out = getOutputTerminal("out");
MbMessage inMessage = inAssembly.getMessage();

// create new message
MbMessage outMessage = new MbMessage(inMessage);
MbMessageAssembly outAssembly = new MbMessageAssembly(inAssembly,outMessage);

try {
// Obtain a javax.sql.Connection using a JDBC Type4 datasource - in this example for a
// JDBC broker configurable service called "MyDB2"

Connection conn = getJDBCType4Connection("MyDB2",JDBC_TransactionType.MB_TRANSACTION_AUTO);

// Example of using the Connection to create a java.sql.Statement
Statement stmt = conn.createStatement(
ResultSet.TYPE_SCROLL_INSENSITIVE,
ResultSet.CONCUR_READ ONLY);
ResultSet srsO = stmt.executeQuery(
"SELECT NAME, CITY FROM MyDataBase.MyTable");

stmt.executeUpdate ("UPDATE MyDataBase.MyTable SET CITY = "Springfield" WHERE Name = "Bart");

// Perform other database updates

} catch (SQLException sgx ){
sgx.printStackTrace();

} finally {

// clear the outMessage
outMessage.clearMessage();

}

In this example:
e MyDB2 is the name of the JDBCProvider configurable service. Use the name of
the service that you have created to connect to your database.

e MB_TRANSACTION_AUTO define the level of transaction coordination that is
required by the node. Only this value is supported, and indicates that the
coordination in the node is inherited from that configured at message flow level.

Because the broker is managing the connections, your code must comply with the
following restrictions:

* Do not include any code that performs a COMMIT or a ROLLBACK function.
* Do not close the connection to the database.

Return a code that indicates success or failure of the actions taken by the node
when control is returned.

MbSQLStatement:

The MbSQLStatement class provides full transactional database access using ESQL
and ODBC. The broker resource manager coordinates database access when using
MbSQLStatement. Global coordination is provided by WebSphere MQ on
distributed platforms, and by RRS on z/OS. For information about how to set up
the ODBC resources that are required, see [Enabling ODBC connections to the]
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Create instances of the MbSQLStatement class using the createSQLStatement()
method of MbNode, passing to the method the ODBC datasource, a broker EQSL
statement, and, optionally, the transaction mode.

 Calling select() on this object returns the results of the query.

* Calling execute() on this object executes a query where no results are returned,
such as updating a table.

The following Java code shows how to access a database using MbSQLStatement:

MbMessage newMsg = new MbMessage(assembly.getMessage());
MbMessageAssembly newAssembly = new MbMessageAssembly(assembly, newMsg);

String table = "dbTable";

MbSQLStatement state = createSQLStatement( "dbName",
"SET OutputRoot.XMLNS.integer[] = PASSTHRU('SELECT * FROM " + table + "');" );

state.setThrowExceptionOnDatabaseError(false);
state.setTreatWarningsAsErrors(true);
state.select( assembly, newAssembly );

int sqlCode = state.getSQLCode();
if(sqlCode != 0)

// Do error handling here

}

getOutputTerminal ("out") .propagate(assembly);
JDBC API in an unmanaged environment:

You can access standard Java APIs in the code that you write for your
JavaCompute nodes, including JDBC calls. You can therefore use JDBC APIs to
connect to a database, write to or read from the database, and disconnect from the
database. The broker allows your JDBC connection code to invoke both type 2 and
type 4 JDBC drivers in this environment, but does not supply them. You must
obtain these drivers from your database vendor.

If you choose this method to access databases, the broker does not provide any
support for managing the transactions; your code must manage the local commit
and rollback of database changes. Your code must also manage the connection life
cycle, connection thread affinity, and connection pooling. You must also monitor
the access to databases when you use this technique to ensure that these
connections do not cause any interference with connections made by the broker. In
particular, be aware that type 2 drivers bridge to an ODBC connection that might
be in use in message flows that access databases from ESQL.

SQLJ:

SQLJ is a Java extension that you can use to embed static SQL statements within
Java code. Create SQL]J files using the workbench. The broker resource manager
does not coordinate database access when using SQLJ.

1. Enable SQLJ capability in the workbench:
a. Switch to the Broker Application Development perspective.
b. Select Window > Preferences.
c. Expand Workbench.
d. Select Capabilities.
e. Expand Database Developer.
f. Select SQLJ Development.



g. Click OK.
2. Create a new SQLJ file within a Java project:
a. Right-click the Java project in which you want to create the file.
b. Select New » Other....
c. Expand Data.
d. Expand SQLJ.
e. Select SQLJ File.
f. Click Next.
g

Follow the directions given by the New SQL] File wizard to generate the
SQLJ file.

You can now reference the class in this SQL] file from a JavaCompute node class in
this project or in another referenced project.

Calling an Enterprise Java Bean
This topic describes how to call an Enterprise Java Bean (E]B) from a JavaCompute
node.

Before you start:

* Ensure that all required Java classes are in WebSphere Message Broker’s
shared-classes directory, or are referenced in the CLASSPATH environment
variable. You can use the wildcard character (*) at the end of a directory path
specifier to load all JARs in that directory path.

* Ensure that the user JAR files that are needed for EJB access are referenced in
CLASSPATH.

* If you are using a version of WebSphere Message Broker before Version 6.0 Fix
Pack 3, you must set the context loader by including the following statement in
the node’s Java code before the InitialContext is set:

Thread currentThread().setContextClassLoader(this.getClass().getClassLoader());
The following example shows how to call an E]JB from a JavaCompute node:
public class CallAckNoAckEJB_JavaCompute extends MbJavaComputeNode {
public void evaluate(MbMessageAssembly inAssembly) throws MbException {
MbOutputTerminal out = getOutputTerminal("out");
MbOutputTerminal alt = getOutputTerminal("alternate");
MbMessage inMessage = inAssembly.getMessage();
// create new message

MbMessage outMessage = new MbMessage(inMessage);
MbMessageAssembly outAssembly = new MbMessageAssembly(inAssembly,outMessage);

try {
// Add user code below

String response = null;
String responseMessage = null;

Properties properties = new Properties();

properties.put(Context.PROVIDER_URL, "iiop://Tocalhost:2809");

properties.put(Context.INITIAL CONTEXT_FACTORY, "com.ibm.websphere.naming.
WsnInitialContextFactory");

try {
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Context initialContext = new InitialContext(properties);
Object obj = initialContext.lookup("ejb/com/acme/ejbs/AckNoAckHome") ;
AckNoAckHome ejbHome = (AckNoAckHome)javax.rmi.PortableRemoteObject.

narrow(obj,AckNoAckHome.class);

responseMessage) ;

AckNoAck ackNoAck = ejbHome.create();
responseMessage = ackNoAck.getAck();
response = "Ack";

} catch(Exception e) {
responseMessage = e.getMessage();
response = "NoAck";

}

MbElement cursor = outMessage.getRootElement().getFirstElementByPath("/XML/AckNoAck");
cursor.createElementAsLastChild(MbETement.TYPE_NAME,"Response",null);
cursor.getlLastChild().createElementAsLastChild(MbElement.TYPE_NAME,response,null);
cursor.getlLastChild().getLastChild().createElementAsLastChild(MbETement.TYPE_VALUE,null,

// End of user code

R ——

// The following should only be changed
// if not propagating message to the 'out' terminal
out.propagate(outAssembly);

} finally {
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// clear the outMessage
outMessage.clearMessage();

JavaCompute node Exception handling and the Failure terminal

You do not need to catch exceptions that are thrown in a JavaCompute node. The
broker handles exceptions automatically. If you catch an exception in your code,
throw it again, allowing the broker to construct an exception list and propagate the
message to the failure terminal, if one is connected. If you have not connected the
failure terminal, the exception is thrown back to a Catch node or an input node.

Logging errors with the JavaCompute node

The MbService class contains a number of static methods for writing to the event
log or syslog. Define message catalogs using Java resource bundles to store the
message text.

Three levels of severity are supported:
* Information

* Warning

* Error

The following sample demonstrates the use of resource bundles and logging:

+ JJavaCompute Node sample]

You can view samples only when you use the information center that is integrated
with the Message Broker Toolkit.


/help/livehelp/?pluginID=com.ibm.samplegallery&class=com.ibm.samplegallery.SampleGalleryAction&arg=com.ibm.etools.mft.samples.javacomputenode.doc/doc/overview.htm

Developing message mappings

Message mappings define the blueprint for creating a message. The topics in this
section describe message mappings and explain how to develop them.

Concept topics:

* [“Message mappings overview” on page 430|

* ["Message flows, ESQL, and mappings” on page 45|

» |“Advanced schema structures” on page 431

Task topics:

+ [“Creating message mappings” on page 433|

* |“Creating a message map file in the Broker Development view” on page 433

* [“Creating a message map file from a Mapping node” on page 434|

+ [“Configuring message mappings” on page 435|

* ["“Mapping from source: by selection” on page 435|

+ ["Mapping from source: by name” on page 436|

* [“Mapping a target element from source message elements” on page 437

[‘Setting the value of a target element to a constant” on page 438|

[“Setting the value of a target element to a WebSphere MQ constant” on page 439

* |“Setting the value of a target element using an expression or function” on page|
440

[‘Deleting a source or target element” on page 440

* [“Configuring conditional mappings” on page 441|

* |“Configuring mappings for repeating elements” on page 442|

+ [“Populating a message map” on page 443]

+ [“Configuring the LocalEnvironment” on page 444]

* ["Mapping headers and folders” on page 444|

[“Adding messages or message components to the source or target” on page 446

[“Adding a database as a source or target” on page 446|

[‘Modifying databases using message mappings” on page 448|

+ [“Creating and calling submaps and subroutines” on page 455

[‘Transforming a SOAP request message” on page 463|

+ |“Editing a default-generated map manually” on page 464|

+ ["“Message mapping tips and restrictions” on page 465|

* ["Message mapping scenarios” on page 468|

There is also a section of topics that contain reference information about message
mapping;:
* [“Message mappings” on page 1269

* ["Message Mapping editor” on page 1270|

+ ["“Mapping node” on page 1280|

* |["“Migrating message mappings from Version 5.0” on page 1287

Developing message flows 429



Message mappings overview

430 Message Flows

Message mappings define the blueprint for creating a message, where the created
message is known as the target message. Messages can contain the following
components:

* simple elements and attributes

* complex elements (structures)

* repeating simple or complex elements

* other (embedded) messages

Messages can contain protocol-specific headers, which might need to be
manipulated by WebSphere Message Broker. Dynamic setting of a message

destination (routing) within the WebSphere Message Broker might also be required.
Values for target message elements can be derived from:

* input message elements (the input message is also known as the source
message)

* database tables

* constant values

* WebSphere MQ constants

* functions supplied by the Mapping node

* user-defined functions

The logic to derive values can be simple or complex; conditional statements might

be needed, as might loops, summations and other functions. All of the above
mappings can be achieved using a Mapping node.

You can also create a reusable form of message map known as a submap. Submaps
can be called from message maps and ESQL code.

You must have message definitions for any messages that you want to include in a
message mapping. You can select the messages from your existing message
definitions when you create a new message map. The following message domains
are supported by the Mapping node:

* MRM

* XMLNSC

* XMLNS

* MIME

* JMSMap

e JMSStream

« XML

If you use an unsupported parser to perform mappings, for example IDOC, BLOB
or a user-defined parser, error messages might be generated when messages pass

through your message flow. See [‘Change the target message domain” on page 465
for information about setting the message domain for the target message.

Find out more about jmessage flows, ESQL, and mappings|

This section also contains information about[’Advanced schema structures” on|

Message flows, ESQL, and mappings
A message flow represents the set of actions performed on a message when it is
received and processed by a broker. The content and behavior of a message flow is



defined by a set of files that you create when you complete your definition and
configuration of the message flow content and structure:

* The message flow definition file <message_flow_name>.msgflow. This is a
required file and is created automatically for you. It contains details about the
message flow characteristics and contents (for example, what nodes it includes,
its promoted properties, and so on).

* The ESQL resources file <message_flow_name>.esql. This file is required only if
your message flow includes one or more of the nodes that must be customized
using ESQL modules. You can create this file yourself, or you can cause it to be
created for you by requesting specific actions against a node.

You can customize the following built-in nodes by creating free-form ESQL
statements that use the built-in ESQL statements and functions, and your own
user-defined functions:

— Compute

— Database

— Filter

* The message mappings file <message_flow_name><_nodename>.msgmap. This
file is required only if your message flow contains one or more of the nodes that
must be customized using mappings. You can create this file yourself, or you
can cause it to be created for you by requesting specific actions against a node.
A different file is required for each node in the message flow that uses the
Message Mapping editor.

You can customize the following built-in nodes by specifying how input values
map to output values:

|lnode” on page|
813

Node Usage

[‘DataDelete] Use this node to delete one or more rows from a database table without creating an output

i ode” on page| |message.

[ Datalnsert| Use this node to insert one or more rows in a database table without creating an output message.
|Inode” on page|

810)

[“DataUpdate] Use this node to update one or more rows in a database table without creating an output message.

[“Extract node”]

Use this node to create a new output message that contains a subset of the contents of the input

[node” on page]
14

lon page 826 message. Use the Extract node only if no database is involved in the map.
The Extract node is deprecated in WebSphere Message Broker Version 6.0. Although message flows
that contain an Extract node remain valid in WebSphere Message Broker Version 6.0, where
possible, redesign your message flows so that any Extract node is replaced by a Mapping node.
[“Mapping] Use this node to construct output messages and populate them with information that is new,

modified from the input message, or taken from a database. You can also use the Mapping node to
update, insert or delete rows in a database table.

[“Warehouse]
node” on page

[ioss

Use this node to store all or part of a message in a database table without creating an output
message.

You can use built-in ESQL functions and statements to define message
mappings, and you can use your own ESQL functions.

Advanced schema structures
This section contains information about the following subjects:

* [“Substitution groups” on page 432|

431
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e “Wildcards”|

* ["“Derived types”]
.
.

Substitution groups: A substitution group is an XML Schema feature that
provides a means of substituting one element for another in an XML message. The
element that can be substituted is called the head element, and the substitution
group is the list of elements that can be used in its place.

All possible substitutes of a head element are listed beneath the head element. You
create mappings to or from members of substitution groups in the same way as
you would map other elements.

An abstract head element of a substitution group is not displayed and when
substitution is blocked, the substitution group folder is not displayed.

Wildcards: Any mapping that you perform to or from a wildcard results in a
submap call. Specify the wildcard replacement when you choose the parameter of
a submap call.

A wildcard element or attribute can be instantiated only with another element or
attribute. The Message Mapping editor allows only a global element or attribute as
a wildcard replacement.

Derived types: For an element of a given type, all known types that are based on
it are shown in the Source and Target panes of the Message Mapping editor, and
all attributes and elements of the base and derived types are listed under each type
respectively.

You create mappings to or from a derived type and its contents in the same way
that you would map any type or type content. When you map a derived type
element, the Message Mapping editor generates ESQL code with the appropriate
xsi:type attribute.

List types: A list type is a way of rendering a repeating simple value. The
notation is more compact than the notation for a repeating element and provides a
way to have multi-valued attributes.

You map list type attributes or elements in the same way that you would map any
other simple type attribute or element. Mapping between two list type elements is
the same as mapping between any two simple type elements.

To transform between a list type and a non-list type, such as a repeating element,
write an ESQL function, then package the function as a map. The Message
Mapping editor automatically selects this submap as the default transformation for
the list type.

Union types: A union type is the same as a union of two or more other simple
types and it allows a value to conform to any one of several different simple types.

Use the Message Mapping editor to create mappings to or from union type
attributes or elements in the same way as you would map atomic simple type
attributes or elements, as demonstrated in the following diagram:



<xsd:simpleType name="zipUnion">

<xsd:union memberTypes="USState 1istOfMyIntType"/>
</xsd:simpleType>

<xsd:element name=zip type=zipUnion/>

Creating message mappings

The topics in this section describe how to create message mappings. Most actions
can be achieved either by using the menu bar, or by right-clicking and choosing an
action from a drop-down menu. For consistency, the following topics describe the
menu bar method.

* [“Creating a message map file in the Broker Development view”]

* |“Creating a message map file from a Mapping node” on page 434|

+ [“Configuring message mappings” on page 435

* ["“Mapping from source: by selection” on page 435|

+ ["Mapping from source: by name” on page 436|

+ [“Mapping a target element from source message elements” on page 437|

[‘Setting the value of a target element to a constant” on page 438|

[“Setting the value of a target element to a WebSphere MQ constant” on page 439

* [“Setting the value of a target element using an expression or function” on pagel
440

* |“Deleting a source or target element” on page 440|

+ |“Configuring conditional mappings” on page 441]|

+ [“Configuring mappings for repeating elements” on page 442|

* [“Populating a message map” on page 443)|

* [“Configuring the LocalEnvironment” on page 444

* |["“Mapping headers and folders” on page 444|

[“Adding messages or message components to the source or target” on page 446

[“Adding a database as a source or target” on page 446|

[‘Modifying databases using message mappings” on page 448|

[‘Creating and calling submaps and subroutines” on page 455|

* [“Transforming a SOAP request message” on page 463

[‘Editing a default-generated map manually” on page 464

There are also topics that discuss [message mapping tips and restrictions|, and
[message mapping scenarios}

Creating a message map file in the Broker Development view
You can create a message map file for use in your message flows in the Broker
Development view. If you want to add a database to your message map file, you
must have [created a database definition| for the database.

To create a message map (.msgmap) file in the Broker Development view:

1. From the Broker Application Development perspective, click File > New -
Message Map.

Alternatively, in the Broker Development view, right-click the message flow
project that you want to create the message map in and click New > Message
Map.
The New Message Map wizard opens.

2. Specify the Project, Name and Schema for the message map.

3. Follow the on-screen instructions to complete the New Message Map wizard:
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a. On the Select map kind and its source and target pane, select the type of
map you want to create:

* If you select the option Message map called by a message flow node, a
message map is created that can be accessed from a node. Properties are
associated with any source or target messages, and you can select to
include message headers and the LocalEnvironment with the message
body:.

* If you select the option Submap called by another map, a message map
is created that can be referenced from another message map. This is
known as a submap and can contain components of a message body such
as global elements, global attributes, and global types. A submap does not
contain Properties, message headers or the LocalEnvironment.

b. Select the combination of Messages, Message Components or Data Sources
that you want to use as sources for your map from Select map sources and
select the combination of Messages, Message Components or Data Targets
that you want to use as targets for your map from Select map targets.

If you cannot find the Messages, Message Components, Data Sources or
Data Targets that you expect, select the Show all resources in workspace
check box.

4. Select Finish to create the new message map. The ["Message Mapping editor”|

on page 1270 opens with the selected sources and targets.

After you have created a message map file, [configure the message mappings} You
must also configure the Mapping routine property on your mapping node to
match the name of your new mapping file.

Creating a message map file from a Mapping node
You can use a Mapping node to create a message map with messages and
databases as both sources and targets.

Before creating a message map file, ensure you complete the following tasks:

1. [“Creating a message flow project” on page 205|

2. [“Creating a message flow” on page 208|

3. Define message flow content that includes a Mapping node, see
[message flow content” on page 218 |

To create a message map (.msgmap) file from a Mapping node:

1. Open your message flow from the Broker Application Development
perspective.

2. Double-click the Mapping node, or right-click the Mapping node and click
Open Map. The New Message Map for Mapping Node wizard opens.

3. Select the combination of Messages, Data Sources, or both, that you want to use
as sources for your map from Select map sources. Select the combination of
Messages, Data Targets, or both, that you want to use as targets for your map
from Select map targets.

If you cannot find the Messages, Data Sources or Data Targets that you expect,
select the Show all resources in workspace check box.

4. Click OK to create the new message map. The Message Mapping editor opens
with the selected sources and targets, for more information see

[Mapping editor” on page 1270

After you have created a message map file, you can configure the message
mappings, see [‘Configuring message mappings” on page 435.|




Configuring message mappings

Use the [Message Mapping editor] to configure a message mapping. The editor
provides the ability to set values for:

* the message destination
* message headers

° message content

See the [“Mapping node” on page 914 topic for more information about how to set
the properties of a Mapping node.

Wizards and dialog boxes are provided for tasks such as adding mappable
elements and working with submaps. Mappings that are created with the Message
Mapping editor are validated and compiled automatically, ready to be added to a
broker archive (bar) file, and for subsequent deployment to WebSphere Message
Broker.

Use the Message Mapping editor to perform the following tasks.

Common tasks:

+ ["Mapping a target element from source message elements” on page 437

* ["Mapping a target element from database tables” on page 452|

[‘Setting the value of a target element to a constant” on page 438|

+ |“Setting the value of a target element using an expression or function” on page|
440

+ |[“Configuring conditional mappings” on page 441

+ |“Configuring mappings for repeating elements” on page 442|

Message destination tasks:

+ |“Configuring the LocalEnvironment” on page 444]

Message content tasks:

+ [“Adding messages or message components to the source or target” on page 446|

* [“Adding a database as a source or target” on page 446|

* ["“Mapping headers and folders” on page 444|

Mapping from source: by selection

The following steps describe how to map from source using Map from Source, or
using the drag and drop method.

Using Map from Source

1. Select the source and target elements that you want to map by clicking them.
(Ctrl+click to select multiple source or target elements.)

2. Click Map » Map from Source.

There are four possible scenarios that result in mapping by selection using Map
from Source.

* If more than one mappable source element is selected, the selected sources
are mapped to the selected target.

* If more than one mappable target element is selected, the selected source is
mapped to the selected targets.
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* If one mappable source and one mappable target are selected, and neither
element has any children, the selected source is mapped to the selected
target.

* If one mappable source and one mappable target are selected, where both the
elements have children and the same type definition, the selected source is
mapped to the selected target.

Using the drag and drop method

Drag the appropriate source element or elements onto the target element or
elements (Ctrl+click to select multiple source or target elements.)

When you use the drag and drop method to map from source, mapping by
selection is always performed. You can use the drag and drop method in the
following scenarios:

* More than one mappable source element is selected. In this case, the selected
sources are mapped to the selected target.

* More than one mappable target element is selected. In this case, the selected
source is mapped to the selected targets.

* One mappable source and one mappable target are selected, and neither element
has any children. In this case, the selected source is mapped to the selected
target.

¢ The selected source and target elements have the same type definition, or when

the source type is derived from the target type. In this case the entire structure
below the element is copied.

In other scenarios, when a mapping by selection is not possible, the Map by Name
wizard opens to enable a mapping to be performed instead.
Mapping from source: by name

The Map by Name wizard is used to map complex types by examining the names
of source and target elements to create mappings if the names match. The Map by
Name wizard can also be used to map database columns. The following steps
describe how to map from source using the Map by Name wizard.

Using the Map from Source wizard

1. Select the source and target complex elements, database, schema or table that
you want to map by clicking them.

2. Click Map » Map by Name. The Map by Name wizard opens to allow you to
perform mapping by name.
3. Choose the appropriate option from the Map from Source wizard:

* Map leaves. This option maps only the parts of the structure below the
element that match each other.

* Map immediate children. This option maps only the immediate children of
the source element to the immediate children of the target element that
match each other. This option is available only when the selected source and
target elements have immediate children that are mappable.

4. After selecting the Map leaves or Map immediate children option, specify how
names are matched.

* Map items of same names only. This option matches items of the same
name, and is selected by default. Two names are considered to be the same if



they contain the same alphanumeric characters in the same order. This
comparison is not case sensitive, so FIRST_NAME and FirstName are
considered to be a match.

* Map items of same and similar names. This option matches items with
similar names. Two names are considered to be similar if one name is a
truncation of the other, such as first name and name, or PART_NUMBER
and partNum. Also, if one name is a contraction of another, such as
November and nvmbr, they are considered to be similar.

5. Verify that the mappings are relevant and edit them manually if necessary. You
might need to delete unwanted mappings and add extra mappings.

The Map by Name wizard opens automatically when you use the drag and drop
method to map from source where the source and target are complex types with
different type definitions or where the source type is not derived from the target

type.
Mapping a target element from source message elements

You can map:
* simple source elements to simple target elements

* source structures to target structures (where the source and target are of the
same type)

* source structures to target structures (where the source and target are of a
different type)

* multiple simple source elements to a simple target element

The following sections describe how to perform mapping for these particular
scenarios using the Message Mapping editor.

Mapping simple source elements to simple target elements

In the following example, the source element called Name does not contain the
same children as the target element called Name:

Source Target

Name Name
Title Title
First_name First_names
Middle_name Last_name
Last_name

To map one of the child elements, drag the element from the Source pane onto the
corresponding element in the Target pane; for example, drag the Last_name source
element onto the Last_name target element.

The mapping is represented by a line between the source element and the target
element and an entry for the mapping in Xpath format appears in the Spreadsheet
pane. A triangular icon indicates which elements in the Source and Target panes
have been mapped.

Mapping source structures to target structures (where the source and target are
of the same type)

In the following example, the source element called Name has the same structure
as the target element called Name:
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Source Target

Name Name
Title Title
First_name First_name
Middle_name Middle_name
Last_name Last_name

To map the entire source structure to the target structure, drag the parent element
(Name) from the Source pane onto the corresponding element (Name) in the Target
pane. All the child elements are mapped.

Mapping source structures to target structures (where the source and target are
of a different type)

In the following example, the source element called Name has a different structure
to the target element called DifferentName:

Source Target

Name DifferentName
Title Title
First_name FirstName
Middle_name LastName
Last_name

To map the entire source structure to the target structure, drag the parent element
(Name) from the Source pane onto the corresponding element (DifferentName) in
the Target pane. The Map By Name wizards opens. Select Map leaves and Map
items of same and similar names to map all child elements in the target. The
source element Middle_name will not be mapped, as there is no target element
with the same or a similar name.

Mapping multiple source elements to a simple target element

In the following example, you want to concatenate the First_name and
Middle_name source elements to form a single target element called First_names:

Source Target

Name Name
Title Title
First_name First_names
Middle_name Last_name
Last_name

To map multiple source elements to a simple target element, Ctrl+click the
appropriate source elements (First_name and Middle_name) and the target element
(First_names), then click Map » Map from Source. A concatenate function appears
in the Spreadsheet pane; you can edit this function]to define how the concatenated
target element looks, for example, by adding a white space between the two source
elements.

To customize the target element (for example, to make the target value equal to the
source value plus one), see [’Setting the value of a target element using an|
fexpression or function” on page 440 You cannot map a simple element if one of its
ancestors also has a mapping. For example, you cannot map Properties from
source to target, then map Properties/MessageFormat.

Setting the value of a target element to a constant
To set the value of a target element to a constant:



1. In the Message Mapping editor Target pane, right-click the target element or
attribute and click Enter Expression. If the target element or attribute has a
default value, this value is added to the Edit pane.

2. Enter the required constant in the Edit pane and click Enter. When entering the
constant, observe the following rules:

* Enclose string element values in single quotation marks.
* Enter numeric element values without quotation marks.

* For boolean element values enter 0 for false or 1 for true, without quotation
marks. Alternatively, you can enter the fn:false() function for false, or the
fn:true() function for true.

The Spreadsheet pane is updated with the value that you have defined.
You cannot set a value for a simple element if one of its ancestors also has a

mapping. For example, you cannot map Properties from source to target, then set a
value for Properties/MessageFormat.

A target element can also be set to a WebSphere MQ constant. See [“Setting the

[value of a target element to a WebSphere MQ constant”| for further information.

Setting the value of a target element to a WebSphere MQ
constant

There are two ways to set the value of a target element to a WebSphere MQ
constant, depending on whether the target element has an entry in the Map Script
column of the Message Mapping editor Spreadsheet pane:

* If the target element has an entry in the Map Script column:
1. In the Spreadsheet pane, select the target element.
2. Enter $mq: followed by the WebSphere MQ constant in the Edit pane.
3. Press Enter.
The Spreadsheet pane is updated with the expression for a WebSphere MQ
constant.
e If the target element does not have an entry in the Map Script column:
1. In the Target pane, right-click the target element and click Enter Expression.
2. Enter $mq: followed by the WebSphere MQ constant in the Edit pane.
3. Press Enter.

The Spreadsheet pane is updated with the expression for a WebSphere MQ
constant.

The following examples demonstrate how to enter a WebSphere MQ constant in
the Edit pane:

$mq:MQ_MSG_HEADER LENGTH
$mq:MQMD_CURRENT_VERSION

When the map is saved a warning message is displayed if the expression entered
for the WebSphere MQ constant is incorrect, for example the constant is not
recognized. This is an example of the warning message: The target
"$target/purchaseOrder/comment” is not referencing a valid variable.

Content Assist (Edit »+ Content Assist) provides a list of the WebSphere MQ
constants available.

1. Select $mg: ( MQ constants )
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2. Select Edit » Content Assist again to display a list of the available constants.

WebSphere MQ constants that can be used as values for target elements, grouped
by the parameter or field to which they relate, can be found in the WebSphere MQ
Constants book.

Setting the value of a target element using an expression or
function

There are two ways to set the value of a target element to an expression,
depending on whether the target element has an entry in the Map Script column of
the Message Mapping editor Spreadsheet pane:

* If the target element has an entry in the Map Script column:
1. In the Spreadsheet pane, select the target element.
2. Enter the required expression in the Edit pane.
3. Press Enter.

The Spreadsheet pane is updated with the value or expression.
* If the target element does not have an entry in the Map Script column:

1. In the Target pane, right-click the target element and click Enter Expression.
If the target element has a default value, this value is added to the Edit pane.

2. Enter the required expression in the Edit pane.
3. Press Enter.

The Spreadsheet pane is updated with the value or expression.

The following examples demonstrate techniques for entering mapping expressions
in the Edit pane.

¢ If the target element is derived from a source element, drag the source element
or elements onto the Edit pane; for example:

$source/Properties/MessageSet

* Use [arithmetic expressions] such as:

$source/Properties/Priority + 1

* Use mapping, Xpath or ESQL function names. Content Assist (Edit + Content
Assist) provides a list of [available functions| For example:

esql:upper($source/Properties/Replyldentifier)

* You can perform casting in the Edit pane; for example:
xs:string($source/Properties/CodedCharSetId)

You cannot enter an expression for a simple element if one of its ancestors also has

a mapping. For example, you cannot map Properties from source to target, then set
a value of Properties/MessageFormat.

Deleting a source or target element

The following steps describe how to delete source and target elements using the
[“Message Mapping editor” on page 1270}

* To delete a source path, modify the expression so that it no longer uses the
source value to compute the target.

If this is the last use of the source path, the line linking the source and target is
removed. If the expression no longer has any value, the target becomes
unmapped.

* To delete a target from the click the target and click Delete.
The target structure is preserved if possible.



— If you delete a "for” row, clicking Delete removes the single row.
— If you delete a "condition” or "else” row, clicking Delete:

- removes the entire block if there is at least one other "condition” or "else”
row within the same "if” row

- removes the "if” row and the "condition” or "else” row, but preserves the
content of the "condition” or "else” row when the selected "condition” or
"else” row is the last one within the "if” row

Deleting the "if" row preserves the content of the last "condition” or "else”
row within the "if” row and deletes everything else in the "if” row.

* To delete a database source, click the SELECT statement then remove all
references to the source manually. Alternatively, delete the SELECT source in the
then remove all references to the source manually.

* To delete a database target, delete the INSERT, UPDATE or DELETE statement.
Alternatively, update or delete the statement in the

Configuring conditional mappings
To set the value of a target element conditionally in a Mapping node:

1. In the Spreadsheet pane of the Message Mapping editor, select the target
element and click Map ~» If.

Two rows are added to the Spreadsheet pane, above the target element:

* In the first row, Map Script is set to ‘if". You cannot enter anything in the
Value column of this row.

* In the second row, Map Script is set to ‘condition’. Its value is an expression
that is evaluated to see whether it is true. If true, the target element is set to
the value specified in its “Value’ column. Initially, its Value column is set to
‘fn:true()’, which means that the condition is always met, and the target
element is always set to the Value column.

2. Change the expression in the condition row’s Value column by selecting the
cell, or the condition row, in the Spreadsheet pane and setting the value in the
Edit pane.

Amend the expression in the Edit pane to specify the correct condition for the
statement by performing the following steps:

a. Select any database columns that are pertinent to the condition, and drag
them from the Source pane into the Edit pane.

b. Select any source message elements with values that are pertinent to the
condition, and drag them from the Source pane into the Edit pane.

c. Open Content Assist by clicking Edit » Content Assist and select the
functions to be applied to the condition.

3. Add further conditions by selecting the condition row in the Spreadsheet pane,
and clicking Map » Condition.

Two rows are added to Spreadsheet pane, below the target element:
¢ In the first row, Map Script is set to ‘condition’. Process this as described in
Step 2.

* In the second row, Map Script is set to the target element. Its Value cell is
initially blank. Set this value as described in [“Setting the value of a target|
element to a constant” on page 438 and |“Setting the value of a target]
element using an expression or function” on page 440

4. To set the value of a target element when the ‘If” condition is not true, select
the condition for the target element in the Spreadsheet pane, and click Map -
Else.

Two rows are added to Spreadsheet pane, below the target element:
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* In the first row, Map Script is set to ‘else’. You cannot enter anything in the
Value column of this row.

* In the second row, Map Script is set to the target element. Its value is initially
blank. Set this value as described in [“Setting the value of a target element to|

a constant” on page 438 | and [“Setting the value of a target element using an|

lexpression or function” on page 440.

Configuring mappings for repeating elements

To configure the Mapping node to process repeating elements, use the ‘For’ option
in the Message Mapping editor Spreadsheet pane. The following combinations of
repeating elements are possible:

° Irepeating source and non-repeating targeﬂ

° Inon—repeating source and repeating target|

+ lrepeating source and repeating target|

By default, if the source is a database, it is processed as a repeating source.
Configuring a repeating source and a non-repeating target:

To map a repeating source element to a non-repeating target element, drag
elements between the Message Mapping editor Source and Target panes. The
following items appear in the Spreadsheet pane:

* A ‘for’ row with Value set to the repeating source element.

* An ‘if’ row.

* A ‘condition’ row with Value set to msgmap:occurrence($source/...) = 1.

* A row with Map Script set to the target field and Value set to the source field.

The first occurrence of the source field is mapped to the target field. The ‘for’ row
specifies that a loop is to be iterated for the specified repeating element. The ‘if’
and ‘condition” rows restrict the logic to a single occurrence of the repeating
element (see [“Configuring conditional mappings” on page 441| for more
information on conditional logic in a mapping node).

1. To map an occurrence other than the first, change the expression in the
‘condition” row to msgmap:occurrence(§source/...) = n, where n is the
occurrence that you want to map.

If the repeating source field is within one or more repeating structures, a
hierarchy of ‘for’, ‘if’, and ‘condition” rows is placed in the Spreadsheet pane,
one for each level of repetition.

2. If the source field contains a numeric data type, mapping all occurrences of a
repeating source field to a non-repeating target results in the sum of all the
source elements. Perform this mapping by selecting the source element and
target element and clicking Map » Accumulate.

This action sets the following value in the Spreadsheet pane for the target
element:

fn:sum($source/...)

The result of the accumulate action is a numeric value. If your target has a
different data type, then you must cast the result to the appropriate type for the
selected target. For example, if your target is xs:string type, you must alter the
results of the accumulate action from fn:sum($source/x/y/z) to
xs:string(fn:sum($source/x/y/z)), in order to cast the result to the correct
data type for your target.



You cannot map different occurrences of a repeating source element to different
non-repeating target elements.

Configuring a non-repeating source and a repeating target:

To map a non-repeating source element to a repeating target element, drag
elements between the Message Mapping editor Source and Target panes. The first
occurrence of the target element is set to the value of the source element.

To map to an occurrence other than the first, complete the following steps:

1. If the target element is not shown in the Spreadsheet pane, right-click its lowest
ancestor row, then click Populate. Repeat this action until the target element is
shown.

2. Right-click the target element and click Insert After or Insert Before to select
the location to insert the repeating target elements. The Insert After or Insert
Before options are disabled if there is nothing valid to be inserted at the
selected location. Selecting either of these opens the Insert Statement wizard.

3. Select the element to insert from the list of valid items.

4. Enter the number of instances to be added and click OK. The number of
instances to be added must be less than or equal to the maximum occurrence
specified for the selected element.

The specified number of instances of the repeating target element are added to the
Spreadsheet pane. The inserted statements do not have a mapping expression and
any children are not displayed. Right-click each element, then click Populate to
display any child elements.

By repeating the Insert After and Insert Before action, it is possible to insert more
repeating elements in the target than the maximum occurrence specifies. Verify that
the number of repeating elements is valid, and delete any unwanted entries.

Configuring a repeating source and a repeating target:

To map a repeating source element to a repeating target element drag elements
between the Message Mapping editor Source and Target panes. The following
items appear in the Spreadsheet pane:

* A ‘for’ row with Value set to the repeating source element.
* A row with Map Script set to the target field and Value set to the source field.

All occurrences of the source element are mapped to the respective occurrences of
the target element. You can map repeating source structures to repeating target
structures if the source and target are of the same complex type.

Populating a message map

You can use the Populate wizard to add elements from the Target pane to the
Spreadsheet pane. The Populate wizard creates child structures for the selected
parent structure. When you add a message target to a message map, $target in the
Spreadsheet pane is populated by default with Properties and the message body
root. The Properties fields MessageSet, MessageType and MessageFormat, are
added together with their default values. Other message elements and their
children can be added to the Spreadsheet pane without creating mappings by
using the Populate wizard. The following steps show how to populate the
Spreadsheet pane with other message elements using the Populate wizard:
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Using the Populate wizard

1. Right-click a parent element in the Spreadsheet pane and click Populate. The
Populate wizard is displayed.

2. Select the items you wish to create mappings for. Items required in the target
message are selected by default. The selected items are added to the
Spreadsheet pane.

3. Repeat Populate to add further child elements to the Spreadsheet pane.

If any target elements are missing warning messages are displayed in the Message
Mapping Editor. These warning messages indicate the name and expected position
of the missing elements. You can used the Populate wizard to add the missing
elements.

You can also use the Populate wizard to add target elements to the Spreadsheet
pane when there are existing mappings. Any existing mappings are not altered by
the wizard.

If the target map is a submap the Spreadsheet pane is populated by default with
the selected element or attribute root. You can use the Populate wizard in the
submap to add any child elements to the Spreadsheet pane in the same way.

Configuring the LocalEnvironment

You can set values in the LocalEnvironment in the same way as setting values in
other elements of a message. Add the LocalEnvironment to your message map
using the Add or Remove Headers and Folders dialog as described in
[headers and folders.”| If you set any values in the target LocalEnvironment, set the
mapping mode property for the Mapping node to a value that contains
LocalEnvironment. To do this, select the mapping node in your message flow and
click Properties » Basic > Mapping Mode.

You cannot map Local Environment objects that are not listed.

Mapping headers and folders

The following types of message headers and folders can be included for source
and target messages in a message map (note that a submap does not include
message headers):

* LocalEnvironment

* Properties

* MQ Headers

* HTTP Headers

e JMS Transport Header

If you choose not to map message headers or the LocalEnvironment explicitly in
your message map, then the output message is produced with the same message
headers as the input message. When you Populate the message map, the Properties
folder for the source and target are displayed in the message map, with
MessageSet and MessageType initially set based on the target message.
MessageFormat is set to the default wire format of the message set if the parser
domain is MRM. The other properties are blank initially, and the message headers
are copied from the input message.

Alternatively, if you choose to map any message headers or the LocalEnvironment
in your message map, then no message headers are copied from the input



message. You must add mappings for these headers to ensure that the target
message contains appropriate headers to make a valid output message.

If your target message contains an MQRFH2 header, you must select from either
the MQRFH2 or MQRFH2C parser in the Add or Remove Headers and Folders
dialog. For more information about the MOQRFH2 and MQRFH2C parsers, see
[MQRFH2 and MQRFH2C parsers” on page 1267

Before mapping headers and folders, ensure you do the following:

1. |Create a message flow project]

. [Create a message flow]

2
3. [Define message flow content]
4

. [Create a message map file from the navigator| or create a message map from a
node.

To add message headers or other folders to a message map:

1. Right-click your message map in the Broker Development view and select
Open or right-click your mapping node and select Open Map to open the
[Message Mapping editor]

2. Right-click $source in the Source pane and select Add or Remove Headers and
Folders to add message headers or other folders to the source message. The
Add or Remove Headers and Folders dialog opens.

3. Ensure that Selected headers and other folders is selected. If No folders (map
body element only) is selected your map is a submap, and can not have
headers associated with it. You can change the submap to a message map by
selecting Selected headers and other folders.

4. Select the headers that you want to map from the list. If you want to map MQ
Headers or HTTP Headers, you must select individual headers by expanding
the list. If you are using MQ Headers you must include the MQMD, therefore
this is automatically selected for you.

5. Click OK to add the selected message headers or folders to the message map.

6. Right-click $target in the Target pane and select Add or Remove Headers and
Folders to add message headers or other folders to the output message.

7. Repeat step 3 to 5 to add the headers and folders that you require to the target
message.

8. Configure the message header and folder mappings in the same way as other
mappings.

You can use Add or Remove Headers and Folders to remove message headers or
the LocalEnvironment folder. Right-click on either the $source or the $target to
open the Select Message Headers dialog. Clear the headers or other folders to
remove them from the message map. Removing a message header or other folder
from the message map removes any associated mappings that you have created.
You can remove the Properties folder from the message map, but note that all
built-in parsers require some values in the Properties folder for the output
message.

You can map multiple instances of a header by right clicking on the header in the

Message Mapping editor Spreadsheet pane and selecting Insert Before or Insert
After . Select the header from the Insert Statement dialog.
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Adding messages or message components to the source or
target

You can add additional messages or message components as sources or targets in
your message map. To add a message or message component to a source or target:

1. From the [Message Mapping editor] click Map > Add Sources and Targets

The Add Map Sources and Targets wizard opens.

Alternatively, right-click in the Source pane and click Add Sources or
right-click in the Target pane and click Add Targets.

2. Select messages or message components from the message sets that are in your
Message Broker Toolkit workspace.

If you cannot find the messages or message components that you expect, select
the Show all resources in workspace check box.

If one does not already exist, a project reference is created from your message
flow project to the message set project that contains the selected messages or
message components.

You can also add sources and targets by dragging the resources from the Broker
Development view in the Broker Application Development perspective onto the
source or target pane of your message map. Select resources under Messages or
Elements and Attributes or Types from your Message Definitions and drag them
onto the source or target pane. If you add a message to the message map,
Properties are also added. If you add an element, attribute or type to the to the
message map a global element for a submap is created. Your message map must
use messages, global elements or global types, but not a combination of more than
one type.

A Mapping node can have only one source message, but can have several target
messages. Therefore, you cannot add a source message if one already exists.

Adding a database as a source or target

You can add a database as a source and database tables as targets to message maps
that support database mappings. You must have [created a database definition| for
your database before you can add it or the associated tables to a message map.
There are a number of different ways to add database sources and targets:

* You can specify the databases and database tables you want to use in the New
Message Map wizard when you create a new message map.

1. Create a new message map file in the Broker Application Development
perspective using File > New » Message Map or by right-clicking on your
mapping node and selecting Open Map.

2. From Select map sources, select the Database Sources for your message map.
3. From Select map targets, select the database tables to use as targets in your
message map. If you are not creating a message map from a DataDelete,

Datalnsert or DataUpdate node, expand the relevant database operation and

select from the list of tables. You can select from the following database
operations:

— Table Inserts

— Table Updates

— Table Deletes

If you cannot find the Data Sources or Data Targets that you expect, select
the Show all resources in workspace check box.



* In an existing message map a database can be added as a source and database
tables added as a target using Add Sources and Targets.

1. From the [Message Mapping editor] click Map » Add Sources and Targets.
Alternatively, right-click in the Source pane and click Add Sources or
right-click in the Target pane and click Add Targets.

2. From Select map sources, select the Database Sources for your message map.

3. From Data Targets, in Select map targets, select the database tables to use as
targets in your message map. If you are not creating a message map from a
DataDelete, Datalnsert or DataUpdate node, expand the relevant database
operation and select from the list of tables. You can select from the following
database operations:

— Table Inserts
— Table Updates
— Table Deletes

If you cannot find the Data Sources or Data Targets that you expect, select
the Show all resources in workspace check box.

* Alternatively, in an existing message map, a database can be added as a source
using Select Data Source

1. Select the location to add a database table source to your mapping in the
Spreadsheet pane. For example, select $target.

2. Click Map - Select Data Source. Alternatively, right-click in the Spreadsheet
pane and click Select Data Source. The Select Database As Mapping Source
wizard opens.

3. Select your database from the list. If you cannot find the Data Sources or
Data Targets that you expect, select the Show all resources in workspace
check box.

* You can also add database sources and database table targets to your message
by dragging them from the Broker Development view in the Broker Application
Development perspective onto your message map.

1. From the Broker Application Development perspective, expand your
Database Connections category in the Broker Development view.

2. Open your message map.

3. To add a database as a source in your message map, drag your database file
from Database Connections onto the Source pane. The database file is called
<connectionname_database>.dbxmi. A $db:select is added to the source pane
of your message map.

4. To add a database table as a target in your message map, drag your database
table file from Database Connections onto the Target pane. The database
table file is called <connectionname_schema_table>.tb1xmi. A $db:insert is
added to the target pane of your message map. If you want to perform a
database operation other than insert on your database table, you must
fchange the database operation|of the message map.

When the database has been added to the source:
* The Source pane contains a $db:select entry.
¢ The Spreadsheet pane contains a $db:select entry.

When the database table has been added as a target:
* The Target pane and Spreadsheet pane contain one of the following:
— a $db:insert entry
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— a $db:update entry
- a $db:delete entry

You can change the database operation on a selected table by using the
[Database Operation| dialog.

You cannot add a database as a source or a target to an Extract node.
Modifying databases using message mappings

This following topics describe how to work with databases using message
mappings:

+ |“Adding database definitions to the Message Broker Toolkit”]

* [“Creating a message map file from a Datalnsert node” on page 449

* |“Creating a message map file from a DataUpdate node” on page 450|

* |“Creating a message map file from a DataDelete node” on page 450|

+ |“Change database operation of a message map” on page 451|

+ ["Mapping from a message and database” on page 451|

+ ["Mapping a target element from database tables” on page 452|

* |“Deleting data from a database with a mapping node” on page 454|

+ [“Creating a database to database mapping” on page 454|

+ |“Adding a database as a source or target” on page 446|

Adding database definitions to the Message Broker Toolkit:

Use the New Database Definition File wizard to add database definitions to the
Message Broker Toolkit.

You must have a database definition defined in the Message Broker Toolkit to
create database mappings. Database definitions are also used by other nodes such
as the Compute node to validate references to database sources and tables.
Database definitions are stored in a data design project. You must associate the
data design project with any message flow projects that you want to use the
database definitions with. The following steps describe how to add a database
definition to the Message Broker Toolkit:

1. Switch to the Broker Application Development perspective.

2. Click File » New » Database Definition. The New Database Definition File
wizard is displayed.

3. Select an existing data design project or click New to create a new data design
project.

4. Select the database type and version that you want to connect to from the
Database and Version list. Ensure that you select a supported database from
the list. For a list of supported databases, see [Supported databases}

5. Click Next.

6. Either select to create a new database connection or select a connection to use
from the list of existing connections. If you select to use an existing
connection, the existing database definition is overwritten.

7. Click Next.

8. If you selected to create a new connection:

a. Optional: You can enter a custom value for the Connection Name if you
clear the Use default naming convention check box.



b. Enter values for the Connection to the database, for example, Database
name, Host name and Port number.

c. Enter values for the User ID and Password to connect to the database. You
can use the Test Connection button to verify the settings you have selected
for your database. The default Port number for a DB2 database is 50000. If
the connection fails, you can try to enter other values such as 50001, 50002
and so on, for the Port number, and then test the connection again.

d. Click Next. An error is generated if any of the connection details are
wrong. If you specify a Database that already has a database definition in
the data design project, click Yes in the Confirm file overwrite window to
overwrite the existing database definition.

9. Alternatively, if you selected to use an existing connection:

a. Click Yes in the Confirm file overwrite window to overwrite the existing
database definition.

b. Enter values for the User ID and Password to connect to the database and
then Click Next.

10. Select one or more database schemas from the list and click Next.

11. Click Finish.

12. Add the data design project as a reference to the message flow project:
a. Right-click on the message flow project and click Properties.

b. Click Project References, and select the data design project from the list to
add as a referenced project.

c. Click OK.

A new database definition file is added to your data design project. The database

definition file name has the following format:<database>.dbm. Database definition

files are associated with the Data Project Explorer view and the Database Explorer
view. Tools are available in these views for working with your databases.

Database definition files in the Message Broker Toolkit are not automatically
updated. If a change is made to your database you must recreate the database
definition files.

Creating a message map file from a Datalnsert node:

You can use a Datalnsert node to create mappings to insert new data into a
database from a message, another database or both.

Before creating a message map file, ensure you do the following:

1. |Create a message flow project]

2. |Create a message flow]|

3. [Define message flow content| that includes a Datalnsert node
4. |Create a database definition|

To create a message map (.msgmap) file from a Datalnsert node:

1. From the Broker Application Development perspective, open your message
flow, right-click your Datalnsert node, and click Open Map. The New Message
Map for Data Insert Node wizard opens.

2. Select the combination of Messages, Data Sources or both that you want to use
as sources for your map from Select map sources.

If you cannot find the Messages or Data Sources that you expect, select the
Show all resources in workspace check box.
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3. From the Select map targets pane, select the tables under Table Inserts into
which you want to insert new data. The tables that you select are added to the
new message map as targets.

4. Select OK to create the new message map. The [“Message Mapping editor” on|
page 1270| opens with the selected sources and targets.

After you have created a message map file, you can now [configure the message|

Creating a message map file from a DataUpdate node:

You can use a DataUpdate node to create mappings to update existing data in a
database from a message, another database or both.

Before creating a message map file, ensure you do the following:

1. |Create a message flow project]

2. |Create a message flow|

3. |Define message flow content| that includes a DataUpdate node
4. |Create a database definition|

To create a message map (.msgmap) file from a DataUpdate node:

1. From the Broker Application Development perspective, open your message
flow, right-click your DataUpdate node, and click Open Map. The New
Message Map for Data Update Node wizard opens.

2. Select the combination of Messages, Data Sources or both that you want to use
as sources for your map from Select map sources.

If you cannot find the Messages or Data Sources that you expect, select the
Show all resources in workspace check box.

3. From the Select map targets pane, select the tables under Table Updates in
which you want to update data. The tables that you select are added to the
new message map as targets.

4. Select OK to create the new message map. The [“Message Mapping editor” on|

page 1270| opens with the selected sources and targets.

After you have created a message map file, you can now [configure the message|

Creating a message map file from a DataDelete node:

You can use a DataDelete node to create mappings to delete data from a database
based on information from an input message, another database or both.

Before creating a message map file, ensure you do the following:

1. |Create a message flow project]

2. |Create a 